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Abstract 
 
ORA is a network analysis tool that detects risks or vulnerabilities of an organization’s design structure. 
The design structure of an organization is the relationship among its personnel, knowledge, resources, and 
tasks entities. These entities and relationships are represented by the Meta-Matrix. Measures that take as 
input a Meta-Matrix are used to analyze the structural properties of an organization for potential risk. 
ORA contains over 100 measures which are categorized by which type of risk they detect. Measures are 
also organized by input requirements and by output. ORA generates formatted reports viewable on screen 
or in log files, and reads and writes networks in multiple data formats to be interoperable with existing 
network analysis packages. In addition, it has tools for graphically visualizing Meta-Matrix data and for 
optimizing a network’s design structure. ORA uses a Java interface for ease of use, and a C++ 
computational backend. 
 
The most current version of ORA (3.0.8.5)  software is available on the casos website: 
http://casos.cs.cmu.edu/projects/ora/ 
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Glossary 

A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S 
| T | U | V | W | X | Y | Z  

A | Top 

Action : driving to the mall, eating lunch. Used as a verb. 

Adjacency Matrix : A Matrix that is a square actor-by-actor (i=j) 
matrix where the presence of pair wise links are recorded as 
elements. The main diagonal, or self-tie of an adjacency matrix is 
often ignored in network analysis. 

Aggregation : Combining statistics from different nodes to higher 
nodes. 

Algorithm : A finite list of well-defined instructions for accomplishing 
some task that, given an initial state, will terminate in a defined end-
state. 

Agent : An agent, is an information processing entity that can take 
agent. The most common agents are people. For some research 
questions, however, it may be useful to make these agents decision 
entities characterized by role, e.g., registered nurse and doctor. For 
other research questions, it make make sense to treat the agents as 
decision making units, like alpha=unit. For other research, the agents 
might be specific animals, or robots, or other types of actors. 
Researchers disagree as to whether all agents in the same entity 
class should be at the same level, e.g., all people, or whether 
different levels can be mixed such as people and decision units. The 
key is that an agent is an actor that can act in isolation and is not, for 
the purpose of the resesrch, subdividable into parts nor has 
members. 

Agent-Generic : Agent-generic are general classes of agents. These 
can represent the role or an attribute by which an agent is 
characterized. Examples include american, girl, child, nurse, 
president. 
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Agent-Specific : Agent-specific are specific agents. They are 
generally names entities representing a unique actor. Examples 
include George_Washington, Red_Deer_0001012. 

Asymmetric Networks : Asymmetric are also called Directed 
Networks where there can be a link euv is not necessarily equal to link 
evu and infact this second link need not even exist. 

Attribute : Indicates the presence, absence, or strength of a 
particular connection between nodes in a Matrix. It can also be 
information about the specifics of the agents. These are usually traits 
that agents have in common, each can be slightly different (e.g. 
visible traits like hair colour or intangible traits like religious beliefs). 

B | Top 

Betweenness : Degree an individual lies between other individuals 
in the network; the extent to which an node is directly connected 
only to those other nodes that are not directly connected to each 
other; an intermediary; liaisons; bridges. Therefore, it's the number 
of nodes who an node is connected to indirectly through their direct 
links. 

Betweenness Centrality : High in betweenness but not degree 
centrality. This node connects disconnected groups, like a Go-
between. 

Bimodal Network : A network most commonly arising as a mixture 
of two different unimodal networks*. 

Binarize : Divides your data into two sets; zero or one. 

Binary Network : A binary network is constructed by binary values 
(either 1 or 0) in its network matrix and contains only information 
whether a link between two entities in the network exists. 

Bipartite Graph : Also called a bigraph. It's a set of nodes 
decomposed into two disjoint sets such that no two nodes within the 
same set are adjacent. 

C | Top 

Caesar III : An application for the design of information processing 
and decision making organizations. An application for the design of 
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decision making organizations at the operational and tactical levels; it 
takes into consideration cultural differences in coalitions and of 
adversaries. This tool is under development by George Mason 
University.  

Categorical : An Attribute Type used primarily used for grouping 
nodes. 

Centrality : The nearness of an node to all other nodes in a network. 
It displays the ability to access information through links connecting 
other nodes. The closeness is the inverse of the sum of the shortest 
distances between each node and every other node in the network. 

Centralization : Indicates the distribution of connections in the 
employee communication network as the degree to which 
communication and/or information flow is centralized around a single 
agent or small group. 

Characteristic Path Length : The median of the average shortest 
distances (number of links) connecting each employee to all other 
employees.  

Interpretation : Characteristic path length gives a insight into 
how information spreads. It reflects the communication 
performance of the entire network and is important for diffusing 
information and routing information to the right people. A small 
average path length results in fewer "hops" where individuals or 
groups don't get information. 

Classic SNA density : The number of links divided by the number of 
possible links not including self-reference. For a square matrix, this 
algorithm* first converts the diagonal to 0, thereby ignoring self-
reference (an node connecting to itself) and then calculates the 
density. When there are N nodes, the denominator is (N*(N-
1)). To consider the self-referential information use general density. 

Clique : A sub-structure that is defined as a set of nodes where 
every node is connected to every other node. 

Clique Count : The number of distinct cliques to which each node 
belongs. 

Closeness : node that is closest to all other nodes and has rapid 
access to all information. 
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Clustering coefficient : Used to determine whether or not a graph 
is a small-world network. 

Cognitive Demand : Measures the total amount of effort expended 
by each agent to do its tasks. 

Column Degree : see Out Degree*. 

Complexity : Complexity reflects cohesiveness in the organization by 
comparing existing links to all possible links in all four networks 
(employee, task, knowledge and resource).  

Complementarity : The idea that people seek others with 
characteristics that are different from and complement their own, aka 
the idea that opposites attract. 

Concor Grouping : Concor recursively splits partitions and the user 
selects n splits. (n splits -> 2n groups). At each split it divides the 
nodes based on maximum correlation in outgoing connections. Helps 
find groups with similar roles in networks, even if dispersed. 

Congruence : The match between a particular organizational design 
and the organization's ability to carry out a task. 

Construct : A reduced form of Construct is found in ORA in the Near 
Term Impact Report. 

Continuous : A Attribute Type primarily used for values that are 
numerical so that statistical analysis can be be performed (Average, 
Minimum, Maximum, and Standard Deviation). 

Count : The total of any part of a Meta-Network row, column, 
node, link, isolate, etc. 

CSV : File structure meaning Comma Separated Value. Common 
output structure used in database programs for formatting data. 

D | Top 

Degree : The total number of links to other nodes in the network. 

Degree Centrality : a node with the most connections. (i.e. In the 
know). Identifying the sources for intel helps in reducing information 
flow. 
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Density :  

• Binary Network : The proportion of all possible links actually 
present in the Matrix. 

• Value Network : The sum of the links divided by the number of 
possible links. (i.e. the ratio of the total link strength that 
is actually present to the total number of possible links). 

Disconnected Network : If subsets of nodes are arranged in a way 
that all nodes of group A are unreachable from all nodes from group 
B and vice versa, the network is disconnected. Therefore, there is no 
link connecting any pair of nodes between the subsets of nodes. 

Dyad : Two nodes and the connection between them. 

Dyadic Analysis : Statistical analysis where the data is in the form 
of ordered pairs or dyads. The dyads in such an analysis may or may 
not be for a network. 

Dynamic Network Analysis : Dynamic Network Analysis (DNA) is 
an emergent scientific field that brings together traditional Social 
Network Analysis* (SNA), Link Analysis* (LA) and multi-agent 
systems (MAS). 

DyNetML : DyNetML is an xml based interchange language for 
relational data including nodes, ties, and the attributes of nodes and 
ties. DyNetML is a universal data interchange format to enable 
exchange of rich social network data and improve compatibility of 
analysis and visualization tools. 

E | Top 

Edge : See Link. 

Eigenvector Centrality : Node most connected to other highly 
connected nodes. Assists in identifying those who can mobilize others 

Entity Class (same as Ontology class) : The group of nodes that 
exist in the same domain and are connected to one another. It's a 
simplified wat of viewing the information. 
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Event : Something that happens, especially something of 
importance. Events are usually thought of as a public occasions but 
they can also be clandestine meetings. The number of agents can 
range in the thousands or as few as two agents (e.g. Christmas in 
Times Square or dinner with friends). 

Event-Generic : Something that occurs periodically [i.e. Summer ] 

Event-Specific : One particular instance which may, or may not, be 
re-occuring. [ i.e. Christmas 2011 or the 9/11 attacks ]. 

F | Top 

FOG : (F)uzzy (O)verlapping (G)roups. Gives a better understanding 
of individuals spanning groups. Fuzzy groups are a more natural and 
compelling way of thinking of human social groups. 

G | Top 

General density : The number of links divided by the number of 
possible links including self-reference. For a square matrix, this 
algorithm* includes self-reference (an node connecting to itself) 
when it calculates the density. When there are N nodes, the 
denominator is (N*N). To ignore self-referential information use 
classic SNA* density. 

Geodesic Distance : A generalization of the notion of a straight 
line to curved spaces. In presence of a metric, geodesics are 
defined to be (locally) the shortest path between points on the space. 

Gini coefficient : The measure of inequality of a distribution of 
income. Uses a ratio with values between 0 and 1: the numerator is 
the area between the Lorenz curve of the distribution and the uniform 
(perfect) distribution line; the denominator is the area under the 
uniform distribution line. 

Graph Level Metric : A metric defined for, and gives a value for, the 
network as a whole. The metric is calculated once for the network. 
Examples are Centralization, Graph Hierarchy, and the 
maximum or average Betweenness. 

GraphML : GraphML is a comprehensive and easy-to-use file format 
for graphs. It consists of a language core to describe the structural 
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properties of a graph and a flexible extension mechanism to add 
application-specific data. 

Group : a collection of things (entities, nodes, ties, networks).   A 
group might at times be represented as a meta-node.   Nodes may 
be classified in to groups on the basis of a shared attribute, type, id-
range, label, user selection, etc.   For example, if you have a set of 
people and know their gender, then their might be two groups - men 
and women.   In addition the nodes representing those people could 
be displayed as a meta-node for men and a meta-node for 
women.   Nodes may be classified in to groups on the basis of a 
grouping algorithm.   For example, if you have a network showing 
connections among members of an organization and you run a 
grouping algorithm it will return clusters of nodes that fit together on 
some mathematical criteria.   This cluster is a group and can be 
represented as a meta-node. 

H | Top 

Hamming Distance : Number minimum number of substitutions 
required to change one string into another string of equal length. (i.e. 
"toned" and "roses" is 3.) 

Heidarian Balance : A motivational theory of attitude change 
proposed by Fritz Heider, which conceptualizes the consistency 
motive as a drive toward psychological balance. (Also known as 
Balance Theory) 

Heuristics : Problem-solving by trial and error: a method of solving 
a problem for which no formula exists, based on informal methods or 
experience, and employing a form of trial and error iteration. 

Homophily : (i.e., love of the same) is the tendency of individuals to 
associate and bond with similar others. 

• Status homophily means that individuals with similar social 
status characteristics are more likely to associate with each 
other than by chance. 

• Value homophily refers to a tendency to associate with others 
who think in similar ways, regardless of differences in status. 

HTML : HyperText Makup Language. 

I | Top 
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In-Degree : The sum of the connections leading to an node from 
other nodes. Sometimes referred to row degree. 

Influence network : A network of hypotheses regarding task 
performance, event happening and related efforts. 

Interstitial : An interstitial (something "in between") is a node 
situated within but not restricted to or characteristic of a particular 
group. It provides extra information to the analysis. 

Isolate : any node which has no connections to any other node 

K | Top 

Knowledge : Information learned such as a school lecture or 
knowledge learned from experience (e.g. Excellent knowledge of the 
periodic table or "I know what you did last summer"). 

L | Top 

Latent Semantic Analysis : Latent semantic analysis (LSA) is a 
technique in natural language processing, in particular in vectorial 
semantics, of analyzing relationships between a set of documents and 
the terms they contain by producing a set of concepts related to the 
documents and terms. 

Lattice Network : A graph in which the links are placed at the 
integer coordinate points of the n-dimensional Euclidean space and 
each node connects to nodes which are exactly one unit away from it. 

Least Squares : The minimum of the sum of the squared deviations 
from the observed value, for a set of sums. 

Link : These are the connections among nodes. An example is a 
connection between Deetee and United States indicating that she is a 
citizen of the country. 

Link Analysis : A scientific area focused on the study of patterns 
emerging from dyadic observations. The relationships are typically a 
form of co-presence between two nodes. Also multiple dyads that 
may or may not form a network. 

Link Class : A set of Links of one type. A set of links of one type can 
be represented as a meta-link. 
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Link Confidence : This is a second number associated with the link 
that specifies the degree of confidence in the presence of the link. 

Link Direction : This defines whether the link implies a a source-sink 
relation between the nodes, or is considered a simple link. 

Link Type : This is the name given to this type of link. Link type is 
specified at the network level. An example of a type if friendship. A 
link type is defined by the two Node classes, the Name of the node 
classes, whether the links are directional or not.  

Link Value : The strength of the link. 

Location : An actual physical place. This could be a room in a 
building, a city, or a country (e.g. Pittsburgh, PA or my living room). 

Location-Specific : A Named Entity which is a location [ i.e. The 
Empire State Building ]. 

Location-Generic : A location without a specific reference [ i.e. a 
beach ]. 

Lossy Intersection : Full intersection means that a node/link needs 
to be in 100% of the networks to be in the resulting network. Lossy 
intersection at X% percent means that a node/link needs to be in at 
least X% of the networks to be in the resulting network. Thus, Lossy 
intersection is a generalization of full intersection. 

M | Top 

Main Diagonal : in a square matrix this is the conjunction of the 
rows and cells for the same node. 

Math Terms 

These mathematical terms and symbols are used: Let S be any set: 

• card(S) = |S| = the cardinality of S (the cardinality of the node-
sets is represented as |A|, |K|, |R|, |T|) 

• ℜ denotes a real number 

• Z denotes an integer 
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Matrix Algebra : The part of algebra that deals with the theory of 
matrices. 

Maximum Likelihood Estimation [MLE] : An analytic maximization 
procedure for selecting what probability distribution best fits the 
observed data by selecting the parameters for a model so as to 
maximize the model likelihood. NOTE : The larger the sample, the 
more powerful and precise the method. 

Method of Moments [MOM] : A computational method to obtain an 
approximation to the maximum likelihood estimation (MLE), by 
matching the mean and central moments of the fitted distribution to 
the mean and central moments of the observed distribution. Moments 
are used starting with the lowest order as lower moments are more 
stable. The order of moments is mean, variance, skewness, and 
finally kurtosis. (Pearson, 1985) 

Measure : A measure is a function that maps one or more networks 
to Rn. Measures are often scalar (n=1) or vector valued with n=|V| or 
n=|U|. 

Member Node : A node with a link to a meta-node. 

Meta-Link : The representation of a Group of Links. 

MetaMatrix : See Meta-Network 

Meta-Network : The representation of a Group of Networks. 

Meta-Node : this is a collection of nodes that can be treated as a 
node for purposes of visualization or analysis. For example, Deettee 
and Zebadiah could be combined into a single meta-node that we 
might label as friends. A meta-node can include all the nodes in a 
node class, in which case the meta-node and node-class will in a 
sense be indistinguishable. 

Method of Least Squares [MLS] : The method of least squares 
assumes that, given a set of observations, the best fitting curve is 
the curve that has the minimum sum of the deviations squared from 
the observations; i.e., the least squared errors. This method is 
typically used in regression analysis. 

Monte Carlo : A random optimization of your organization 
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MRQAP - This describes a report in ORA. See Reports for more 
information. For multivariate cases, if your dependent variable is 
continous or count data (like in a negative binomial case), you should 
use MRQAP. If your dependent variable is binary, you should use 
ERGM (P*) which is forthcoming in ORA. One can perform MRQAP on 
data that have a dichotomous dependent variable (basically, this is 
equivalent to using a linear probability model). You do need to 
interpret your results accordingly. 

Multi-Agent System : A loosely coupled network of problem-solver 
nodes that work together to find answers to problems that are 
beyond the individual capabilities or knowledge of each node 

Multi-node : More than one type of node (people, events, 
locations, etc.). 

Multi-plex : Network where the links are from two or more relation 
classes. 

Multimode Network : Where the nodes are in two or more node 
classes. 

N | Top 

Neighbors : nodes that share an immediate link to the node 
selected. 

Network : The representation of a set of nodes (including meta-
nodes) of one type and the links (including meta-links) of one type 
between them. 

A network N is a triple consisting of two sets of nodes, called U and 
V, and a set of links E⊂UxV. Thus, we write N=(U,V,E). An element e 
= (i,j) in E indicates a relationship or tie between nodes i∈U and j∈V. 
A network where U=V and therefore E⊂VxV is called unimodal*; 
otherwise the network is bimodal*. We write G=(V,E) for 
unimodal* networks. For our purposes, unimodal networks will not 
contain self loops, which means that (i,i)∉E for i∈V. 

Network Class : A set of Networks on one type. This can also be 
represented as a Meta-Network. 

Network data format : usually comes in the form of NodeSet 1 
listed vertically in column A starting in row 2 and NodeSet 2 listed 
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horizontally in row 1 starting with column B. All the intersecting cells 
are the links between each of the nodes. 

Newman Grouping : Finds unusually dense clusters, even in large 
networks. 

Node : A representation of a real-world node (a who, what, where, 
how, why item. 

people, agents, organizations, beliefs, expertise, resource, tasks, 
events, or locations. Node the representation of a single node (a who, 
what, where, how why item). 

Node Attribute : Nodes can have a number of attributes. The 
possible attributes are specified at the Node Class level. For each 
attribute the user needs to specify a name, a mathematical type, and 
and the possible values. As an example for the Node Class Agent the 
user specifies the Attribute Gender, and the possible values of Male, 
Female, Mixed, Unknown. Then for the Node Amy, the value for the 
Attribute Gender is Female. 

Node Class : This is the ontological category into which the 
associated node falls. ORA and AutoMap use these primary 
ontological categories - Agent, Organization, Location, Event, Task, 
Knowledge, Resource, Belief. 

Node-Generic : Generic entities are ones for which there are 
multiple instantiations; i.e., they represent a class. 

Node ID : This is the unique to AutoMap/ORA ID of a node. This is 
usually not changed as it is used by ORA internally. 

Node Level Metric : is one that is defined for, and gives a value for, 
each node in a network. If there are x nodes in a network, then the 
metric is calculated x times, once each for each node. Examples are 
Degree Centrality*, Betweenness*, and Cognitive Demand*. 

Node Name : This is the label that the user assigns to a Node. 

Node Set : A set of nodes consisting on one Node Class. 

Node Set Name : This is the label that the user assigns to a Node 
Set. The default is just to use the name of the node class. For 
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example, the user could assign the name people to the node class 
agent. 

Node-Specific : Specific entities are ones for which, within the 
bounds of the research project, there is exactly one entity that can be 
associated with that name. 

Node Type (meta-type) : This is the ontological level of the entity 
within its ontological category. There are ONLY two node types - 
specific and generic. This type applies only to the following 
categories - Agent, Organization, Location and Event. An entity is 
specific if there is one of those entities in the domain of study, 
otherwise it is generic. So Amy is a Node, of Node Class Agent, of 
Node Type Specific. 

Normalized Sum : Otherwise known as the Average. 

Notation: 

The following matrix notation is used throughout the document for an 
arbitrary matrix X: 

• X(i,j) = the entry in the ith row and jth column of X 

• X(i,:) = ith row vector of X 

• X(:,j) = jth column vector of X 

• sum(X) = sum of the elements in X (also, X can be a row or 
column vector of a matrix) 

• dich(X) = dichotomize (make binary) X, so that dich(X)(i,j) = 1 
iff X(i,j) > 0 

• X' = the transpose of X 

• ~X = for binary X, ~X(i,j) = 1 iff X(i,j) = 0 

• X@X = element-wise multiplication of two matrices (e.g. Z=X@Y 
=> Z(i,j) = X(i,j)*Y(i,j)) 

O | Top 

ODBC : (O)pen (D)ata (B)ase (C)onnectivity is an access method 
developed by the SQL Access group in 1992 whose goal was to make 
it possible to access any data from any application, regardless of 
which database management system (DBMS) is handling the data. 
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Ontology : "The Specifics of a Concept". The group of nodes, 
resources, knowledge, and tasks that exist in the same domain and 
are connected to one another. It's a simplified way of viewing the 
information. 

Ontology Class (same as entity class) : The group of nodes that 
exist in the same domain and are connected to one another. It's a 
simplified wat of viewing the information. 

Organization : A group of agents working together for a common 
cause (e.g. The Red Cross or the local chess club). 

Organization-Specific : A Named Entity which is an organization [ 
i.e. The Red Cross ]. 

Organization-Generic : An organization without a specific reference 
[ ]. 

Out-Degree : The sum of the connections leading out from an 
node to other nodes. This is a measure of how influential the node 
may be. Sometimes referred to as column degree. 

P | Top 

Pajek : A visual tool for analyzing large networks (networks having 
thousands of vertices). 

Path : A set of nodes and links that form a single unbroken chain, 
such that no node or link is repeated. i.e. A ⇒ B ⇒ C ⇒ D ⇒ E 

Pendant : Any node which is only connected by one link. They 
appear to dangle off the main group. 

Percolation Theory : The behavior of connected clusters in a 
random network. 

Pythia : Program used to create Influence Nets. Pythia is a timed 
influence net application. This tool can downloaded at the following 
URL: http://sysarch.gmu.edu/main/software/. 

 

 

http://sysarch.gmu.edu/main/software/
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Q | Top 

QAP Correlation : Calculates measures of nominal, ordinal, and 
interval association between the relations in two matrices, and uses 
quadratic assignment procedures to develop standard errors to test 
for the significance of association. 

QAP is designed as a bivariate test (only two variables). Generally, 
QAP is perfectly fine for almost any bivariate network problem. 

R | Top 

Random Graph : One tries to prove the existence of graphs with 
certain properties by assigning random links to various nodes. The 
existence of a property on a random graph can be translated to the 
existence of the property on almost all graphs using the famous 
Szemerédi regularity lemma*. 

Reciprocity : The percentage of nodes in a graph that are bi-
directional. 

Redundancy : Number of nodes that access to the same resources, 
are assigned the same task, or know the same knowledge. 
Redundancy occurs only when more than one agent fits the 
condition. 

Regression Analysis : This is used to understand which among the 
independent variables are related to the dependent variable, and to 
explore the forms of these relationships. In restricted circumstances, 
regression analysis can be used to infer causal relationships between 
the independent and dependent variables. The depend and the 
independent variables can be either network measure or numerical 
attributes of nodes. Used in Visualization/Measure Charts 

Relation : The way in which nodes in one class relate to nodes in 
another class. 

Resource : Can be either a physical or intangible object. Anything 
that can be used for the completion of a job. (e.g. Use a car to drive 
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from point A to point B or use money from a bank account to fund 
something). 

 

Robustness : Two different definitions:  

• Networks : Concerned with the reliability (Kim & MÃ©dard, 
2004) and continued functioning of a network following an 
intervention. The robustness of a network is particularly 
relevant in communication-type and flow-oriented networks. 
The purpose for understanding robustness of a network has 
more of a management of the network connotation. 

• Measures : This meaning has more of a statistical connotation. 
Studying the robustness of a measure of a network can also be 
referred to as conducting a sensitivity analysis on the measure. 
In keeping with the terminology of the most-recently published 
research in this area, in lieu of using the term sensitivity, we 
too will use the robustness term, although the terms can be 
used interchangeably. 
A measure is robust if a slight perturbation in its input 
produces a slight change in its output. 

Role : An agents role can be defined as their job for their employer 
or the part they serve during an event. 

Row Degree : see In Degree*. 

S | Top 

Scale-Free Network : Some nodes act as highly connected hubs 
(high degree), although most nodes are of low degree. Scale-free 
networks' structure and dynamics are independent of the system's 
size N, the number of nodes the system has. A network that is scale-
free will have the same properties no matter what the number of its 
nodes is. 

Self-Loop : An node with a connection to itself. 

Self-Looped Network : Self-Loops are links from a node to itself. A 
self-looped network has therefore non-zero diagonal elements in the 
network matrix. 
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Shapefile : The GIS Visualizer can view overlay a Meta-Network over 
a map. The map is a shapefile: a digital vector storage format for 
storing geometric location and associated attribute information. A 
"shapefile" commonly refers to a collection of files with ".shp", ".shx", 
".dbf", and other extensions on a common prefix name (e.g., 
"lakes.*"). For example, Shapefiles could represent water wells, 
rivers, and lakes, respectively. Each item may also have attributes 
that describe the items, such as the name or temperature. 

Simmelian Ties : Two nodes are Simmelian Tied to one another if 
they are reciprocally and strongly tied to each other and strongly tied 
to at least one third party in common. It's a tie embedded in closed 
triples. 

Simulated Annealing : A method of finding optimal values 
numerically. It's a search method as opposed to a gradient based 
algorithm. It chooses a new point, and (for optimization) all uphill 
points are accepted while some downhill points are accepted 
depending on a probabilistic criteria. 

The term Simulated Annealing draws its inspiration from 
metallurgy, where atoms within a metal are heated thereby 
dislodging them from a metal's internal structure transforming the 
metal into another atomic state. In this way, your organization is 
heated changing its components in the attempt to arrive at an 
optimized state. 

Slow Measures : As the name implies these measures generally 
take longer to run. 

Small-World Network : Small-World Networks will have sub-
networks that are characterized by the presence of connections 
between almost any two nodes within them. 

Social Network Analysis : The term Social Network Analysis (or 
SNA) is used to refer to the analysis of any network such that all the 
nodes are of one type (e.g., all people, or all roles, or all 
organizations), or at most two types (e.g., people and the 
groups they belong to). 

Sphere of Influence : One node's direct relationship with one of it's 
neighbors as a function of specified path length. 
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Standard Deviation : The square root of the variance where 
variance is the average of the squared differences between data 
points. 

.stl file format : This file format is native to the stereolithography 
CAD software created by 3D Systems. STL files describe only the 
surface geometry of a three dimensional object without any 
representation of color, texture or other common CAD model 
attributes and can us both ASCII and binary representations 

Symmetric Networks : Any link in a network will have a reciprocal 
link If there's a link from A to B then there will also be a link 
from B to A. Symmetric Network have symmetric values about its 
diagonal. 

Szemerédi's Regularity Lemma : A fundamental structural result 
in extremal graph theory due to Szemerédi (1978). The regularity 
lemma essentially says that every graph can be well-approximated by 
the union of a constant number of random-like bipartite graphs, 
called regular pairs. 

T | Top 

Table data format : Table data usually contains a column with 
referencing IDs and headers denoting column names. 

Task : A task is part of a set of actions which accomplish a job, 
problem or assignment. Task is a synonym for activity although the 
latter carries a connotation of being possibly longer duration (e.g.) 

Tie : see Link 

Time : Referring to time or circumstances. Can be as broad as a year 
or as pinpoint as the exact time of a particular day (e.g. Last year or 
2:33 PM on March 1st, 2009). 

Topology : The study of the arrangement or mapping of the 
elements (links, nodes, etc.) of a network, especially the physical 
(real) and logical (virtual) interconnections between nodes. 

Total Degree Centrality : The normalized sum of an node's row and 
column degrees. 
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Trail : A set of nodes and links that form a single unbroken chain 
that can revisit nodes but not links. i.e. A ⇒ B ⇒ C ⇒ A ⇒ D 

Transpose : In linear algebra, the transpose of a matrix A is another 
matrix AT (also written Atr, tA, or A') created by any one of the 
following equivalent actions: 

• write the rows of A as the columns of AT 

• write the columns of A as the rows of AT 

• reflect A by its main diagonal (which starts from the top left) to 
obtain AT 

See The Transpose Wikipedia Entry for formulas, examples and 
more information. 

Tuple : An ordered list of elements. Therefore n-tuple is an ordered 
list of n elements. There is also a 0-tuple which is an empty 
sequence. 

U | Top 

Unimodal networks : These are also called square networks 
because their adjacency matrix* is square; the diagonal is zero 
diagonal because there are no self-loops*. 

W | Top 

Walk : A set of nodes and links that form a single unbroken chain 
that can revisit both nodes and links. i.e. A ⇒ B ⇒ C ⇒ B ⇒ D. 

Weighted Network : If the weights of the links are different 
we use the term weighted network. Every link will be 
represented by a real number running continuously from -∞ 
to +∞. It contains not only whether a link exists but also the 
numerical information about that link. 0 indicates there is no 
link between two nodes.  

  

http://en.wikipedia.org/wiki/Transpose
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Getting Started 

Welcome to ORA's Help File system! The ORA Help and examples 
contained herein are written with a specific data set in mind, mostly 
designed specifically for a particular section. 

How to use ORA help 
If you are not familiar with Social Network Analysis we encourage 
you to read through the beginning sections of the help set. The ORA 
help set is broken up into seven primary parts, which are designed 
for varying levels of user expertise. 

Getting Started : Provides an overview of Social Networks and how 
they pertain to ORA. 

General Content : Information that applies to many parts of ORA in 
many different ways. 

The Main Interface : Details working with the data within the 
Networks. This includes loading, saving, merging, performing various 
math functions on the Networks, generating a variety of networks, 
and running reports. 

The Visualizer : Takes these Meta-Networks and turns them into 
graphical representations. There are tools for creating / deleting 
nodes and links, displaying information in different formats, and 
helping to analyze the data. 

GeoSpatial/Loom : Describes the parts of ORA specically designed 
with location functions. 

Measures : Explains the various measures used in ORA. They 
contain a short explanation. It also describes the type, input, and 
output. 

Reports : Contains a description of what each report is and what it 
will tell you about your data. 

Lessons : Designed to teach specific functions and how to carry out 
many types of useful network analytical tasks that can be 
accomplished by using ORA. 
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Student Version 
NOTE : The student version is for academic use only. The student 
version is limited to 2000 nodes, certain reports are not available, 
and batch mode is not available 

 

 

What is ORA? 

An Overview 
ORA is a statistical analysis package for analyzing complex systems 
as Dynamic Social Networks.  

Many complex systems such as organizations, intra-state alliances, 
food webs, etc. can be represented as an ecology of interlinked 
networks. Within ORA any complex system is represented as a 
Network. What follows is a general description of ORA's primary 
capabilities. Specific instruction is provided under the correlating 
folders in this help system. 

See Basic Terms for additional definitions relating to Social 
Networks. 

The ORA Visualizer 
The ORA Visualizer renders conceptual images of social networks. 
Nodes represent real-world Entities like the president of a company, 
driving to the airport, or how to wash your clothes. Nodes which 
share the same attributes can be further grouped together creating 
Nodesets. Links connect nodes that share a direct relationship. Such 
relationships are derived from the Network. ORA's single unit of 
data input, and are referred to as graphs. The ORA visualizer is 
interactive. You can zoom, rotate, isolate, add and remove 
Nodes, and much more. 
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Reports 
ORA can run many reports: Centrality, Correlation, and Sphere of 
Influence to name a few. Multiple organizations can be compared 
against each other, network structure can be optimized, subgroups 
within a network can be identified, and scenarios involving the 
removal of nodes or links can be examined. Reporting capabilities are 
constantly being refined and updated. 

Charts 
Four chart types are available: Bar Chart, Scatter Plot, Histogram, 
and Heat Map. Each one in turn presents a different statistical 
profile of a selected Nodeset. Examples of these reports and how to 
access them can be found under Basic Usages. 

 

 

Overview 

Contact Information 
Kathleen M. Carley 

CASOS, Carnegie Mellon University 

kathleen.carley@cs.cmu.edu 

tel: 412 268 6016 

ORA 
ORA is an analysis tool designed to help the user evaluate one or 
more networks. It can be used to assess the nature of, features of, 
change in, and determinants of complex networks. A large variety of 
networks can be assessed including, but not limited to, social 
networks, activity networks, task networks, knowledge networks, 
supply chains, and communication networks. Using ORA questions 
such as the following can be addressed: what is critical, are there 
groups of interest, are there patterns of interest, how might 
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interventions impact the network, who is critical, are there emerging 
groups, how is the network changing. 

What is a network? In any data there are relations among things such 
as two people are cousins, or a set of people are all members of the 
same club. These networks might be psychological or cultural as 
when two people share the same belief. They might be physical as in 
two resources being in the same location or two computers being 
connected by a line, or they might be social as in people being 
related. There are many reasons why networks exist. Networks are 
ubiquitous. Everyone and everything is constrained and enabled by 
the networks in which they are embedded. Everyone and everything 
is embedded in multiple networks; e.g. you are connected to some 
people due to work, others due to school, others due to your kids, 
and so on. ORA lets you visualize, assess, and reason about these 
networks. 

What kinds of networks? 
ORA can assess any type of network. Anything that can be 
represented as a set of nodes and relations can be assessed. Typical 
networks are: social networks (who interacts with whom), financial 
networks (who lends money to whom); gant charts (what task needs 
to be done before what), supply chains (what resources are needed 
to build what other resources)., semantic networks (what ideas are 
linked to what ideas), proximity networks (what states border on 
what states), and so on. ORA can assess any data that can be 
represented as nodes and relations regardless of what the nodes are 
or what the relations are. 

What if there are many networks? 
ORA can be used to assess the interlocks among networks. For 
examples, imagine that the following networks exist: who works with 
whom; who has what skills, what skills are needed for what tasks, 
who is doing what tasks then ORA can assess whether in fact the 
right people have been assigned to those tasks or where there are 
problems because there is insufficient skills available for the task. 
ORA can assess "multi-mode multi-link" data. 
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What if the networks change? 
ORA can be used to assess change in networks over time. Over time, 
the shape or topology of a network might change; e.g., start up 
companies move from a collaborative to a hierarchical structure, 
terrorists change what weapons they use to attack sites, scholars cite 
different papers, and so on. Consequently, over time, who or what is 
critical in a network might change. ORA can assess change in 
networks, and forecast possible ways in which the network might 
change in the future. 

What if information is incomplete? 
ORA can assess networks even when information is incomplete. ORA 
has been built to gracefully degrade so that it calculates all and only 
those metrics for which there is information. 

Illustrative applications 
ORA has been applied in numerous settings. Examples include the 
following. Assessment of team-x leadership structure at NASA. 
Comparison of terror networks. Identification of vulnerabilities in 
insurgency and terror networks. Assessing change in political elite 
structures in Korea and early identification of emergent leaders. 
Designing teams for wargames. Assessing the impact of turnover and 
retirement on public health organizations in Duchess County, NY. 
Identifying reports with AIS data. Organizations where ORA has been 
used include: AFIT, SOCOM, USMA, CIA, many universities. 

Tool Evolution 
There are still many challenges in the area of dynamic network 
analysis. Key challenges include handling streaming data, locating 
confidence intervals for metrics, uncertainty assessment, and so on. 
As these challenges are met, new algorithms are implemented, tested 
and added to ORA thus further meeting the user's needs. 
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Social Network Analysis (SNA) 

Social Network Analysis is a scientific area focused on the study of 
relations, often defined as social networks.  

In its basic form, a social network is a network where the people 
(entities) and the relations (links) are a form of connection such as 
friendship. Social Network Analysis takes graph theoretic ideas and 
applies them to the social world.  

The term social network was first coined in 1954 by J. A. Barnes 
(see: Class and Committees in a Norwegian Island Parish). 
Social network analysis is also called network analysis, structural 
analysis, and the study of human relations. SNA is often referred to 
as the science of connecting the dots. 

Today, the term Social Network Analysis (or SNA) is used to refer 
to the analysis of any network such that all the entities are of one 
mode (e.g., all people, or all roles, or all organizations), or at 
most two mode (e.g., people and the groups they belong to). 
The metrics and tools in this area, since they are based on the 
mathematics of graph theory, are applicable regardless of the type 
of nodes in the network or the reason for the connections. 

For most researchers, the entities are actors. As such, a network 
can be a cell of terrorists, employees of global company or simply 
a group of friends. However, entities are not limited to actors. A 
series of computers that interact with each other or a group of 
interconnected libraries can comprise a network also. 

Where to find out more on SNA 
• Scott, John, 2000, Social Networks, Sage (2nd edition) 

• Wasserman, S. & K. Faust, 1994, Social Network Analysis: 
Methods and Applications 
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Dynamic Network Analysis 

Dynamic Network Analysis (DNA)* is an emergent scientific field 
that brings together traditional social network analysis (SNA), 
link analysis (LA) and multi-agent systems (MAS)*. There are 
two aspects of this field. The first is the statistical analysis of DNA 
data. The second is the utilization of simulation to address issues of 
network dynamics. DNA networks vary from traditional social 
networks in that are larger dynamic multi-mode, multi-plex networks, 
and may contain varying levels of uncertainty. 

DNA statistical tools are generally optimized for large-scale networks 
and admit the analysis of multiple networks simultaneously in which, 
there are multiple types of nodes (multi-nodes)* and multiple types 
of links (multi-plex)*. In contrast, SNA statistical tools focus on 
single or at most two mode data and facilitate the analysis of only 
one type of link at a time. 

DNA statistical tools tend to provide more measures to the user, 
because they have measures that use data drawn from multiple 
networks simultaneously. From a computer simulation perspective, 
nodes in DNA are like atoms in quantum theory, nodes can be, 
though need not be, treated as probabilistic.  

Whereas nodes in a traditional SNA model are static, nodes in a DNA 
model have the ability to learn. Properties change over time; entities 
can adapt: A company's employees can learn new skills and increase 
their value to the network; Or, kill one terrorist and three more are 
forced to improvise. Change propagates from one entity to the next 
and so on. DNA adds the critical element of a network's evolution and 
considers the circumstances under which change is likely to occur. 

Adequate Survey Response Rate 
Often people try to get 100% response when the full network is 
collected - however, anything above 85%-90% is considered good. 
For ego network data - standard response rate guidelines are 
followed. 

 



27 
 

Where to learn to more: 
Kathleen M. Carley, 2003, Dynamic Network Analysis” in Dynamic 

Social Network Modeling and Analysis: Workshop Summary and 
Papers, Ronald Breiger, Kathleen Carley, and Philippa Pattison, 
(Eds.) Committee on Human Factors, National Research 
Council, National Research Council. Pp. 133-145, Washington, 
DC. 

Kathleen M. Carley, 2002, Smart Agents and Organizations of the 
Future” The Handbook of New Media. Edited by Leah Lievrouw 
and Sonia Livingstone, Ch. 12, pp. 206-220, Thousand Oaks, 
CA, Sage. 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim 
Tsvetovat, 2005-forthcoming, Toward an Interoperable 
Dynamic Network Analysis Toolkit, DSS Special Issue on 
Cyberinfrastructure for Homeland Security: Advances in 
Information Sharing, Data Mining, and Collaboration Systems. 

 

ORA and DNA 

In general, you may want to use ORA in conjunction with other 
computational tools to advance DNA theory. The CMU CASOS tools 
that work with ORA to form tool chains are AutoMap (extracts 
networks from texts) and various DNA simulators including both 
Construct and DyNet. These tools are often used in a number of 
real world applications, including the following areas: 

• Designing adaptive teams for Command and Control Networks 

• Estimating the impact of organizational downsizing 

• Estimating the effectiveness of new structures 

• Evaluating risk in organizational designs 

• Examine impact of IT effectiveness 

• Impact analysis of actions in asymmetric warfare simulation 

• Impact analysis of weaponized biological attacks on cities 
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ORA is interoperable with a number of other SNA and link-analysis 
tools: UCINET, KeyPlayer, and Analyst Notebook. Additional 
information is listed under data import and export. 

Where to learn more about CASOS tools 
and this tool chain: 
Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim 
Tsvetovat, 2004, An Integrated Approach to the Collection and 
Analysis of Network Data, In Proceedings of the NAACSOS 2004 
Conference, Pittsburgh, PA 

Kathleen M.Carley, 2004, Estimating Vulnerabilities in Large Covert 
Networks Using Multi-Level Data, In Proceedings of the NAACSOS 
2004 Conference, Pittsburgh, PA 

Kathleen M. Carley, 2003, Dynamic Network Analysis in Dynamic 
Social Network Modeling and Analysis: Workshop Summary and 
Papers, Ronald Breiger, Kathleen Carley, and Philippa Pattison, (Eds.) 
Committee on Human Factors, National Research Council, National 
Research Council. Pp. 133-145, Washington, DC. 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim 
Tsvetovat, 2005-forthcoming, Toward an Interoperable Dynamic 
Network Analysis Toolkit, DSS Special Issue on Cyberinfrastructure 
for Homeland Security: Advances in Information Sharing, Data 
Mining, and Collaboration Systems. 

CASOS: Center for Computational Analysis of Social and 
Organizational Systems 
(http://www.casos.cs.cmu.edu/index.html) 

 

 

 

 

 

http://www.casos.cs.cmu.edu/index.html
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System Requirements 

ORA performs best on machines that meet or exceed the following 
specifications: 

Spec Windows Mac (running XP) 

System XP OSX 10.4.x 

RAM 256 MB 1GB 

Processor Pentium 4 Intel Core 2 Duo 

Speed 1.0 GHz 2.0 GHz 

Java 6.0 6.0 

Extra   Parallels for Dual Booting 

NOTE : When working with extremely 
large data sets, increasing processing 
speed and RAM is highly recommended. 
 

 

 

 

 

Files Formats 

ORA can read in a multitude of file formats. Below is a list, with 
examples of the code, of those formats. 

DyNetML – .dl – UCINET – comma delimited (.csv) – text files 
(.txt) – Pajek (.net) – GraphML – GMU model (.stl) – 
Pathfinder (.lo). 
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DyNetML (the native ORA xml format): DyNetML is an xml based 
interchange language for relational data including nodes, ties, and 
the attributes of nodes and ties. DyNetML is a universal data 
interchange format to enable exchange of rich social network data 
and improve compatibility of analysis and visualization tools. 

<node id="col_jack_o'neill"> 
  <properties> 
    <property name="ally" type="string" value="yes"/> 
    <property name="gender" type="string" value="male"/> 
  </properties> 
</node> 
<graph sourceType="Agent" source="Agent" 
targetType="Agent" target="Agent" id="agent x agent" 
isDirected="true"> 
  <edge source="A01" target="A11" type="double" 
value="1"/> 
  <edge source="A02" target="A01" type="double" 
value="1"/> 
</graph> 

 

.dl: DL (for "data language") is a very powerful and (fairly) simple 
language that allows the creation of quite complex and large UCINET 
data sets with minimal data entry. DL language files are plain ASCII 
text files that can be created with any editor (be sure to store the 
results as plain text). 

dl n=9, format=edgelist1 
labels: 
    A,B,C,D,E,F,G,H,I 
data: 
    1    1    1 
    1    2    1 
    1    6    1 
          . 
          . 
          . 
    8    7    1 
    9    9    1 

 

.##h and ##d (UCINet): UCINET datasets are stored in a special 
(Pascal) format, but can be created and manipulated using both 
UCINET's and other software tools (text editors and spreadsheets). 
Each UCINET dataset consists of two separate files that contain 
header information (e.g. myfile.##h) and the data lines (e.g. 
myfile.##d). Because of this somewhat unusual way of storing data, 
it is best to create data sets with the internal spreadsheet editor or 
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DL language tools, or to import text or spreadsheet files and save the 
results as UCINET files. 

 

.CSV (comma separated values): The CSV ("Comma Separated 
Value") file format is often used to exchange data between disparate 
applications. The file format, as it is used in Microsoft Excel, has 
become a pseudo standard throughout the industry, even among 
non-Microsoft platforms. File most commonly created from an Excel 
spreadsheet using the Save As… option 

• Each record is one line… but — A record separator may consist of 
a line feed (ASCII/LF=0x0A), or a carriage return and line feed 
pair (ASCII/CRLF=0x0D 0x0A)… but — fields may contain 
embedded line-breaks (see below) so a record may span more 
than one line. 

• Fields are separated with commas. 

• Leading and trailing space-characters adjacent to comma field 
separators are ignored. 

• Fields with embedded commas must be delimited with double-
quote characters. 

• Fields that contain double quote characters must be surrounded 
by double-quotes, and the embedded double-quotes must each 
be represented by a pair of consecutive double quotes. 

• A field that contains embedded line-breaks must be surrounded 
by double-quotes 

• Fields with leading or trailing spaces must be delimited with 
double-quote characters. 

• Fields may always be delimited with double quotes. 

• The first record in a CSV file may be a header record containing 
column (field) names 

,A01,A02,A03,A04 
A01,0,0,0,0 
A02,1,0,0,0 
A03,1,0,0,0 
A04,1,0,0,0 
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.txt (text files): Otherwise referred to ASCII files which contain no 
extemporaneous formating. 

 

.raw:  

 

.net (Pajek): The file format accepted by Pajek provides information 
on the vertices, arcs (directed edges), and undirected edges. A short 
example showing the file format is given below: 

*Vertices 3 
1 "Doc1" 0.0 0.0 0.0 ic Green bc Brown 
2 "Doc2" 0.0 0.0 0.0 ic Green bc Brown 
3 "Doc3" 0.0 0.0 0.0 ic Green bc Brown  
*Arcs 
1 2 3 c Green 
2 3 5 c Black 
*Edges 
1 3 4 c Green 

 

.graphml: GraphML is a comprehensive and easy-to-use file format 
for graphs. It consists of a language core to describe the structural 
properties of a graph and a flexible extension mechanism to add 
application-specific data. Unlike many other file formats for graphs, 
GraphML does not use a custom syntax. Instead, it is based on XML 
and hence ideally suited as a common denominator for all kinds of 
services generating, archiving, or processing graphs. 

<xs:annotation> 
  <xs:documentation 
    source="http://graphml.graphdrawing.org/" 
    xml:lang="en"> 
    Simple type definitions for the new graph attributes. 
  </xs:documentation> 
</xs:annotation> 

 

.stl (GMU model): This file format is native to the stereolithography 
CAD software created by 3D Systems. STL files describe only the 
surface geometry of a three dimensional object without any 
representation of color, texture or other common CAD model 
attributes and can us both ASCII and binary representations 
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An ASCII STL file begins with the line: 
solid {name} 
where name is an optional string. The file continues with 
any number of triangles, each represented as follows: 
facet normal n1 n2 n3 
  outer loop 
    vertex v11 v12 v13 
    vertex v21 v22 v23 
    vertex v31 v32 v33 
  endloop 
endfacet 
where n1-n3 and v11-v33 are floating point numbers in 
sign-mantissa'e'-sign-exponent format and concludes with: 
endsolid {name} 

 

.lo (pathfinder):  

 

 

Network Drives 

If you are running on a network drive then the help system needs a 
drive letter in order to work correctly. There are 2 possible solutions 
to this: 

1. Copy the ORA folder to each local machine. 

2. If at all possible Map a Network Drive. Right click on the shared 
folder and select Map Network drive. 

Mapping a Network Drive 
In an Explorer window select My Network Places. Find the name of 
the network which contains ORA. 
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Go back to My Document. 

 

From the menu select Tools ⇒ Map Network Drive. This brings up 
the dialog box below. 

 

Select the [Browse] button in order to select the network drive. 
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Select the correct network drive and press [OK]. 

 

Select [Finish]. 

 

Your computer now has the Network drive with ORA mapped on the 
desktop. 
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DyNetML Networks 

DyNetML 
DyNetML is an xml based interchange language for relational data 
including nodes, links, and the attributes of these nodes and link. 
DyNetML is a universal data interchange format to enable exchange 
of rich social network data and improve compatibility of analysis and 
visualization tools 

Uni-Modal Networks 
Uni-modal networks are not changed (e.g., an Agent x Agent network 
is NOT symmetrized), but bi-modal networks are symmetrized in 
that the links from two or more networks are combined using the 
maximum method. 

Bi-Modal Networks 
Bi-modal networks are combined. e.g., if there is an Agent x 
Knowledge and a Knowledge x Agent network, then the Knowledge x 
Agent is transposed to Agent x Knowledge (2) and then Agent x 
Knowledge and Agent x Knowledge (2) are unioned with the 
Maximum link weight from each (a,k) or (k,a) being used. 

Network names are normalized to reflect their Node Class, 
i.e., agent x agent, agent x knowledge, etc. 
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ORA QuickStart 

1.0 GENERAL 

1.1 WHAT IS ORA: 
ORA is a network analysis package that helps the user enter, analyze, 
visualize, and forecast changes in networks using graph based and 
statistical based techniques. 

ORA consists of two parts: The Editor, which allows you to work on 
loaded Meta-Networks and the Visualizer, which allows you to see a 
graphic depiction of the Meta-Network. 

1.2 INSTALLATION: 
This is the procedure to install ORA on your computer: 

Go to http://casos.cs.cmu.edu/projects/ora/software.php 

Click the Download link 

Select the [ Yes ] button to agree to terms and click [ Continue ] 

Insert your Information and click [ Continue ] 

Choose your platform. 

Click the link for your system [ 32-bit or 64-bit ] 

After the program is downloaded double click the ORA icon to 
install. Follow installation instructions. 
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QuickStart Editor 

2.0 EDITOR 

2.1 EDITOR GUI 
The ORA interface is organized into three sections which are placed in 
resizable and dockable panes. Each pane will have one or more 
individual parts. On each tab are two buttons: undock and close. In 
the upper right corner of each pane are three buttons: undock, 
maximize, and close. This will allow you to arrange the interface to 
suit your needs. 

 

fig - The ORA Editor Interface 

1) Menu : Source for performing the majority of tasks. The Menu 
Items are separated into categories each with their own functions. 
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2) Toolbar : Buttons for main functions to work with Meta-Networks, 
Nodesets and Networks. 

3) Toolbar Button Adder : Allows you to add menu functions to the 
toolbar. 

4) Meta-Network Manager : This pane displays all currently open 
Meta-Networks. 

5) Editor : This pane displays in multiple tabs information on 
Nodesets and Networks. 

6) Reports : This pane display reports run on Meta-Networks. 

2.2 WHAT’S IN A META-NETWORK: 
Meta-Network : A representation of a Group of Networks.  

Node : A representation of a real-world item (a who, what, where, 
how, why item). 

Nodeset : A collection of nodes. 

Nodeset Name : Name for a Nodeset which the user can change. 

Node Class : Nodes can be classified as "agent, resource, 
knowledge, task, organization, location, event, action, belief, or role." 

Link : A representation of a connection, or relation between any two 
nodes.  

Network : A representation of a set of nodes (including meta-nodes) 
of one type and the links (including meta-links) of one type between 
them. 

Attribute : Additional information about a node. The most common 
agent attributes are age & gender although it can be anything you 
choose. 

2.3 META-NETWOKS, NODE CLASS, AND 
NETWORKS BUTTONS 
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ORA contains tools to Add or Remove Meta-Networks, Nodesets, 
or Networks. The Plus sign denotes adding and the Minus sign 
denotes removing. 

 

To add a Meta-Network, Nodeset, or Network click the 
appropriate button. The new item will appear in the Meta-Network 
Manager. 

To remove a Meta-Network, Nodeset, or Network highlight the 
item and click the appropriate button. 

NOTE : When in the actual program only the applicable buttons will 
be active e.g. if a network is highlighted then only the Network 
buttons are active. All others would be greyed out. 

2.4 CREATING A NETWORK AND NODESET 
FILE 
A Nodeset or Network can be created either in ORA or in an external 
program such as a text editor [NotePad or NotePad++] or a 
spreadsheet program [Excel]. 
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Using a Text Editor 

To create a Network in a Text Editor all information will be separated 
by commas. The lefthand column consists of the FROM nodes and 
the top row consists of the TO nodes. A “"0"” at an intersection 
means there is no link while a non-zero number means there is a 
connection. 

,A01,A02,A03,A04,A05 

A01,0,0,0,0,1 

A02,1,0,0,0,0 

A03,1,0,0,0,1 

A04,1,0,0,0,1 

A05,0,0,0,0,0 

NOTE :  

In the text file above notice the empty value in the top row just to 
the left of the top comma. This corresponds to the empty cell in the 
Excel spreadsheet Column A–-Row 1.  

To create csv files save them as a text file (.txt) but change the 
extension name to .csv. 

Using Excel 

In an Excel Spreadsheet you would place each set of nodes in a 
separate row or columns with each piece of information in a separate 
intersecting cell. To create a csv file select File > Save As…... and 
save it as a comma-delimited file. 
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Excel with the SG-1 Network data 

Links will run from the node in Column A to the node in Row 1. For 
example there is a link from A02 > A01 [cell B3] but there is no link 
from A01 > A02 [cell C2]. 

Again note that the cell [A1] is blank. This is common in all network 
files created in this manner. 

2.5 IMPORT CSV FILES INTO ORA TO 
CREATE NODESET AND NETWORK: 

 With Nodesets and Networks created it is time to import them into 
ORA. For this we use the Data Import Wizard.  

Select Import existing data? > Table Data from Excel of 
delimited formats > Rectangle of link weights (a Matrix). Click 
[ Next > ]. 

Click Create a new neta-network with ID: 

Replace Meta Network with the name for your new MetaNetwork 
then click [ Next > ] 

The Import Data Interface 
Click [ Browse ] and locate the csv file of the agents. 



43 
 

Set Source type and Target type to agent. 

NOTE : For this Network both are set to agent. Depending on the 
data you are importing these may be set to different Nodesets. 

NOTE : Clicking on the Click to import from another file allows 
you to import additional networks. 

Click [ Finish ]. 

To import additional files into the Meta-Network choose Add to the 
existing meta-network instead of Create a new Meta-Network 
with ID:. Then select the Meta-Network to add. 

 

The ORA Editor with the SG-1 network loaded 

2.6 CREATING A NODE TITLE/ATTRIBUTE 
FILE 
CSV files are used to create Nodesets and Network files. These can 
be created in either a text editor or a spreadsheet program. 

In a Text Editor you would place each node on a separate line with 
all information separated by commas. To create csv files same them 
as a text file (.txt) but change the extension name to .csv. For this 
example the file will create Node Titles. This could be used to import 
any attribute. The top row contains the names of the fields that will 
be imported. 

id,title 

A01,col_jack_o’neill 

A02,maj_samantha_carter 
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A03,daniel_jackson 

A04,teal’c 

A05,gen_hammond 

In an Excel Spreadsheet place each node name or attribute into a 
separate row with each piece of information in a separate cell. The 
juxtaposition of the various cells on a row code the relations of 
interest To create csv files Save As…... a comma-delimited file. 

In a Text Editor place each node on a separate line. Save as a text 
file with the .csv externsion. 

NOTE : Only rows with ids which match up to existing nodes will be 
imported unless the Create new nodes option is checked. 

2.7 IMPORT ATTRIBUTES INTO ORA:  
Select Import Excel or text delimited files > Table of node 
attributes. Click [ Next ]. 

Select the Meta-Network to add information. Click [ Next >]. 

Click Browse and navigate to your attribute file. 

Select from the drop down which column to use to identify your node 
IDs. 

For each column a box will appear allowing you to chose which 
attributes to import. Place a check mark next to each attribute you 
want and give it a Type: Text Category, Text, URI, Number Category, 
Number, or Date. An attribute without a check mark will not be 
imported.  

Select the Nodeset to add the attributes. This drop down will contain 
multiple entries if your Meta-Network contains more than one 
Nodeset.  

Click [ Finish ]. 

The A01, A02, etc will be replaced with the titles in the attribute file. 
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NOTE : Only the attributes you check mark will be imported. All 
others will be ignored. 

2.8 ADD/REMOVE NODES IN THE EDITOR: 
Nodes can be added or removed to any Nodeset through the Editor. 
Highlight the Nodeset then use the buttons on the right side of the 
Editor to manipulate the nodes. Some of the functions require that 
you place a check mark next to the node you are working with [i.e. 
deleting a node]. 

Create: Insert new nodes into meta-network 

Move : Move node(s) from one Nodeset to another. 

Delete : Remove node from Node Class 

Merge : Combine two or more nodes into one 

Clean : Condense all references of one person into a single node. 

2.9 CHANGE DISPLAY TO BINARY OR 
NUMERICAL 
The grids in the Editor can display link data as numeric or check 
marks. Binary data is usually done with check marks as it is simply 
on or off. Numerical data [for weighted links] can show a ink as 0 of 
a positive/negative number. 

Click Display Options near the bottom right of the Editor interface. 

Select Binary link values to display data as check marks. 

Select Numeric link values to display data as numbers. 

2.10 ADD/REMOVE LINKS IN THE EDITOR 
TAB [BINARY] 
Click the [ Options…... ] button in the lower right of the Editor. 

Highlight a Network in the Meta-Network panel 
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Select the Editor Tab. 

In the grid find the intersection of the column node and row node. 

To create a link place a check mark in the cell. This can be done by 
clicking the box of pressing the spacebar while the cell is active. 

To remove a link deselect a cell by removing the check mark. 

2.11 ADD/REMOVE LINKS IN THE EDITOR 
TAB [NUMERICAL] 
Highlight a Network 

Select the Editor Tab. 

In the grid find the intersection of the column node and row node. 

To create a link place a non-zero number in the cell. 

To remove a link place a [ 0 ] in the cell. 

2.12 SAVE A META-NETWORK 
It is important to save your work from time to time. If something 
happens to your computer or ORA then all work done since your last 
save will be lost. You have two options. 

File > Save Meta-Network : Saves your work to the file that was 
originally open. 

File > Save Meta-Network As…... : Saves your work to a new file. 
Give the file a new file name when ORA asks. This can be useful if 
you are experimenting with different ideas and do not want to affect 
your original data. 

2.13 PREFERENCES 
Every user will have their own way they want ORA to perform. The 
preferences allow for tweaking those functions. There are many 
parameters that can be set but the important ones to a new user are 
listed for the individual tabs. 
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General : Preferences for the look and feel of ORA such as whether 
tooltips are shown when hovering over items and the size of the 
toolbar icons. 

Data Sets : As a new user concentrate on the three radio buttons 
near the bottom. These allow you to specify what files you want to 
load whenever you restart ORA. To start make sure it is set to 
Restore previously loaded workspace files at startup. This can 
be changed as you learn more about the workings of ORA. 

NOTE : Reports and Custom Reports are for advanced users. 

 
 
 
 
 
 
 

 

QuickStart Visualizer 

3.0 VISUALIZER 

3.1 VISUALIZER GUI: 
Contains the visual representation of your Meta-Network. 
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The ORA Visualizer Interface 

1) Menu :Source for performing the majority of tasks. 

2) Toolbars : Main functions for working with displayed Meta-
Network. 

3) Zoom/Hyperbolic selector : Select the radio button for the 
either the sizing or fish-eye view 

4) Zoom/Hyperbolic controller : Controls degree of function. 

5) Toolbar Button Adder –:Allows you to add menu functions to 
the toolbar. 
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3.2 DISPLAYING META-NETWORK IN 
EDITOR: 
Meta-Networks can be visualized in many ways. 

Highlight a Meta-Network. Note we are back in the main ORA 
interface, not the Visualizer. 

Click the Visualizer button. 

Or from the Editor Menu select Visualizations > View Networks > 
2D Visualization. 

NOTE : The Visualizations menu also contains other display functions 
for your Meta-Networks. Many of which are advanced functions. 

3.3 ADD/REMOVE NODES WITH THE 
VISUALIZER MENUS: 
Actions > Add Node(s) : Allows you to add nodes to existing or 
new Nodesets. 

Tools > Node Status : Displays all the information about the 
selected node. 

Tools > Node Locator : Selecting a node from the dialog box will 
reveal the location of the node in Visualizer. 

Display > Node Shaper : Use this tool to change the size and shape 
of the selected node. 

3.4 ADD NODE IN VISUALIZER WITH NODE 
CREATOR 

 The Node Creator button is in the left toolbar. NOTE : [2] on 
The ORA Visualizer interface. 

In the drop down menu select a Nodeset. 

Place a check mark in the box. ORA will ask for a name for each 
new node 
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Click in the Visualizer to create a new node. 

3.5 ADD LINKS IN VISUALIZER WITH LINK 
CREATOR 

 The Link Creator button in the left toolbar. NOTE : [2] on The 
ORA Visualizer interface. 

Select the Network from the dropdown menu to add a link. 

Select the weight for new links created. 

Click and hold on the source node. 

Drag the mouse to the target node 

Release the mouse to create a new link. 

3.6 REMOVE NODES OR LINKS IN 
VISUALZER WITH LINK ERASER 

 Click Node/Link Eraser is in the left toolbar. NOTE : [2] on The 
ORA Visualizer interface. 

Removes node(s) and link(s) from the Visualizer display. Click on a 
node or a link to remove it from the display and Meta-Network. 

If the Permanently Delete check box is empty ORA will remove the 
node(s) ro link(s) from the display only. The node(s) or links(s) will 
be retained in the Meta-Network. 

If the Permanently Delete check box contains a check mark the 
node(s) or links(s) will be permanently deleted from the Meta-
Network as well. 

3.7 SHOW/HIDE VISUALIZER LABELS, 
LINKS, & ARROWS: 
In the display various items can be shown or hidden. NOTE : [2] on 
The ORA Visualizer interface. 
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 Toggles the display to show/hide the node labels. 

 Toggles the display to show/hide the links. 

 Toggles the display to show/hide the node arrows. 

3.8 CHANGE Nodeset COLOR: 
You can change the color of an entire Nodeset in the Visualizer. 

If the Legend is not visible, open it by selecting Tools > Legend. 

Click on the color node for a Nodeset. 

In the color selector dialog box select a new color. 

Click [ OK ]. 

3.9 DATA REDUCTION STRATEGIES 
At times the Visualizer display can be difficult to read. There are 
multiple ways to reduce unneeded information temporarily from the 
display. 

3.9.1 HIDE ISOLATES 
You can remove Isolates from the display without permanently 
removing them from the Meta-Network. 

From the Visualizer menu select Actions > Isolates > Hide Isolate 
Nodes. 

3.9.2 REMOVE ISOLATES 
You can permantly remove Isolates from a Meta-Network in two 
ways: 

From the Visualizer menu select Actions > Delete Isolates > 
Delete Currently Visible Isolates. This will remove from the Meta-
Network only those nodes that are visible. 
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From the Visualizer menu select Actions > Delete Isolates > 
Delete Underlying Isolates. This will remove all Isolates from the 
Meta-Network. 

3.9.3 HIDE PENDANTS 
You can remove Pendants from the display without permanently 
removing them from the Meta-Network. 

From the Visualizer menu select Actions > Hide Pendant Nodes. 

3.10 ADD ICONS OR PICTURES 
Nodes can be replaced by icons or pictures [50 x 50 pixel max] for 
easier identification. 

Icons 
Right-Click a node and select Appearance Submenu > Set Picture. 

From the drop down menu select a category then click and highlight 
your icon. 

Click [ OK ] when finished, The node will then display the icon 

3.11 CHANGE SIZE/COLOR NODES BY 
METRIC 
Node Appearance > Size Node by Attribute or Measure. 

This will scale the size of all nodes by using the attribute or measure 
selected. 

Numbers for each node value are user adjustable. 

Node Appearance > Node Color > Color Node by Attribute or 
Measure 

This will color all nodes by using the attribute or measure selected. 

Colors for each node value is adjustable. 
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To reset color and size select Node Appearance > Reset Node 
Color and Size. 

 

 

QuickStart Reports 

4.0 REPORTS 
Reports give you information about your Meta-Networks. These are 
the four most important reports. The other reports are more 
specialized. 

Key Entity : Identifies key entities and groups who, by virtue of their 
position in the network, are critical to its operation. 

Networks : agent x agent, agent x knowledge, agent x resource, 
agent x task, agent x event, agent x location, all knowledge 
networks, any resource networks, task x event, task x task. 

Standard Social Network Analysis : Calculates the standard 
network analysis measures. 

Networks : Any square Network [e.g., agent x agent]. 

Sphere of Influence : For each individual, identifies the set of 
actors, groups, knowledge, resources, etc. that influence, and are 
influenced, by that actor. 

Networks : agent x agent, agent x knowledge, agent x resource, 
agent x task, agent x location. 

Locate Sub-Groups : Identifies the subgroups present in the 
network using various grouping algorithms. Most algorithms only 
work on a single network at a time. 

Networks : Networks selected by the user. 

These reports are run from the Editor menu. 

From the menu select Analysis > Generate Report > [ type in 
name of specific report]. 
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In the searchbox at top type in the name of the report. 

You can type in the entire name or select the report from the drop 
down menu. 

Place a check mark next to the Meta-Networks to process and click [ 
Next > ]. 

Place a check mark next to the Nodesets and Networks to process. 
Click the box to remove unwanted check marks. 

Select the number of nodes to display and click [ Next > ]. 

Select the location to save the files and the filename for the report 
and click [ Finish ]. 

The reports will open in the Report tab of the editor in a text format. 
They will also open your browser and display with animated graphics. 

4.1 FOCUS ON ACTOR 
One item you need to discover is who is important in a Meta-
Network. To obtain this information you can run the Key Entity 
report. Go to Analysis > Generate Reports > Locate Key 
Entities > Key Entity. 

 

The report will ask you for the number of nodes to display and if you 
want to use a particular attribute in the calculation. But the most 
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important selection is the Who, How, What, and Where. When 
focusing on actors place a check mark in the Who only. By default 
the report lists the top 10. This can be changed when running the 
report. 

To find out how a particular person is connected run the Analysis > 
Generate Reports > Locate Key Entities > Sphere of Influence 
report. 

 

Begin with placing a check mark next to one or more a Meta-
Networks from the list. Then click [ Next > ]. 

In the second window place a check mark next to the Nodeset(s) to 
analyze. In this case choose Agent. 
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All networks which contain any of the Nodesets selected appear in the 
bottom pane. Having only choosen Agent only the Agent x Agent 
Network appears. Place a check mark next to Agent x Agent. Then 
click [ Next > ]. 

 

Next place a check mark next to the agent(s) to track. Then click [ 
Next > ]. 

Finally place a check mark next to all the nodes to visualize. Then 
click [ Next > ]. 
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The final screen allows you to choose where to sent the results. The 
two most common choices are: Text will display it in the Report Tab 
in ORA. HTML will open a file in your browser. The browser version is 
usually best for presentations as it contains more visual elements. 

4.2 FOCUS ON REGION 
In addition to finding out who the important agents are in a Meta-
Network the Key Entity report can also show you the important 
locations. 

As with Focus on Actor above the check mark should be placed in 
the Where box only. 

Once the key locations are discovered agents connected to that 
location can be analyzed. In time marked data it will also show When 
those agents were in those locations. 

4.3 FOCUS ON TIME 
In the Editor the Measures Over Time allows you to see how a 
network measures changes over multiple time periods. 
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This requires your data to have time data. Highlight a Meta-Network 
and in the Editor pane to Date:. If the area is blank your Meta-
Network does not have time data and the function will not run. You 
can click the [ Click to create… ] button to assign a data to each 
time slice. 

Below is an example of the type of display viewing two meaures over 
nine time periods. 

 

Any Networks included in a Meta-Network can be displayed in the 
fashion. 

In the Visualizer the View Networks Over Time allow you to see 
how Networks change over the specified time periods. 

Each Meta-Network included should contain nodes and networks 
named the same. This is necessary in order for ORA to assess how 
individual items have changed for each time period. If a node has a 
slightly different name then ORA will assume they are not the same 
node. 

The animated sequence will display the selected networks for each 
Meta-Network. 

This display is the normal Visualizer display. 

Refer to the User’s Guide for more information. 
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QuickStart Other 

5.0 MEASURES 
A measure is a function that takes as input a Meta-Network and 
outputs a single value or a vector of values. For more information on 
the measures see the User’s Guide. 

6.0 GEOSPATIAL, LOOM & TRAILS 
These are advanced topics and you should refer to the ORA Users 
Guide for more information 

 

 

QuickStart Information 

7.0 ORA INFORMATION 

7.1 CONTACT INFORMATION 
Carnegie Mellon University 
School of Computer Science 
Institute for Software Research (ISR) 
Center for Computational Analysis of Social and Organizational 
Systems (CASOS) 
5000 Forbes Avenue 
4212 Wean Hall 
Pittsburgh, PA, 15213 

7.2 QUESTIONS, BUGS, AND COMMENTS  
Please contact :Dr. Kathleen M. Carley (kathleen.carley@cmu.edu) 

7.3 COPYRIGHT NOTIFICATION 
COPYRIGHT (c) 2001-2011 Kathleen M. Carley  
Center for Computational Analysis of Social and Organizational 
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Systems (CASOS), 
Institute for Software Research International (ISRI), School of 
Computer Science, 
Carnegie Mellon University,  
5000 Forbes Avenue 
Pittsburgh, PA 15213-3890 

ALL RIGHTS RESERVED. 
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General Content 

These are pages for information on ORA which is general in nature 
and does not pertain to any particular ORA section. 

1, 2, or n Mode Data 

Actions vs Tasks vs Event 

Beliefs 

Change Format 

Delimited Files 

Dynamic Network 

Fast Fourier Transform 

Large Meta-Networks 

Monte Carlo 

Multiple Links in Imported Data 

Network Basics 

Ontology 

Parts of Speech 

Reduced Form Network 

Regression 

Simulated Annealing 

Synchronization 
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Multi-Mode Data 

Ora can handle 1,2 or n mode data. A mode is a set of nodes, i.e., a 
Nodeset. Typical social network analysis handles one mode data (e.g. 
a people to people network). In this case, the metrics identify which 
node in the network are critical. The grouping algorithms cluster the 
nodes, (e.g., the people, into groups). Sometimes you have two 
mode data such as people by events, (e.g. the classic Southern 
Women Study [1]). In this case, you can ask questions like who was 
at the most events or what events were attended by most people to 
create two different one mode networks people to people and events 
to events. With these one mode networks you can again calculate all 
the standard metrics. 

In ORA, however, there are additional special metrics such as 
redundancy, that can be calculated on two mode data. 

With N mode data, you can do all the above, and in ORA there are 
additional special metrics such as cognitive demand that calculate a 
nodes position based on multiple matrices. 

In ORA, Nodesets can be cross indexed as being related to agents, 
organizations, locations, tasks, events, resources, knowledge, beliefs, 
roles. If you do this there are some additional metrics that rely on 
knowing what Nodesets you have that you can take advantage of 
(e.g., with locations you can run the locations reports). 

In general, all metrics that run on agents also run on organizations 
and roles. For tasks and events - there are other special temporal 
metrics. All metrics that run on resources also run on knowledge and 
beliefs. The standard social network measures run on any square one 
mode network - however in ORA - some guidance is provided on how 
to interpret this based on the type of nodes. 
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One-Mode 
A One Mode dataset uses the same Nodeset as source and target 
such as an Agent x Agent network. 

 

Two-Mode 
A Two Mode dataset uses two different Nodesets as source and target 
such as Agent x Knowledge. 
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Multi-Mode 
An N Mode dataset uses multiple Nodesets set in multiple Networks 
and is represented as a DyNetML file. The example below consists of 
three Nodesets: Agent, Knowledge, Resource, etc. with subsequent 
Networks for each. The blanks are where the opposite Network would 
exist if needed [ i.e. the knowledge x agent ]. These are usually 
omited as the information already exists in the first Network. But 
they can be included if there is a need. 
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Measures and Their Modes 

Measure Mode 

Access Redundancy Two-Mode 

Actual Workload Multi-Mode 

Agent Knowledge Needs Congruence Multi-Mode 

Agent Knowledge Waste Congruence Multi-Mode 

Agent Resource Needs Congruence Multi-Mode 

Agent Resource Waste Congruence Multi-Mode 

Agent Socio Economic Power Multi-Mode 

Assignment Redundancy Two-Mode 

Authority Centrality One-Mode 

Average Communication Speed One-Mode 

Betweenness Centrality One-Mode 

Betweenness Centrality Spatial Multi-Mode 

Betweenness Network Centralization One-Mode 

Biological Diversity Index One-Mode 

Bonacich Power Centrality One-Mode 

Burt Constraint One-Mode 

Burt Effective Network Size One-Mode 

Capacity Two-Mode 

Characteristic Path Length One-Mode 

Clique Count One-Mode 

Closeness Centrality One-Mode 

Closeness Centrality Spatial Multi-Mode 

Closeness Network Centralization One-Mode 

Clusterinf Coefficient One-Mode 

Cognitive Demand Multi-Mode 

Cognitive Distinctiveness Two-Mode 
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Cognitive Expertise Two-Mode 

Cognitive Resemblance Two-Mode 

Cognitive Similarity Two-Mode 

Column Breadth Two-Mode 

Column Count Two-Mode 

Column Degree Centrality Two-Mode 

Column Degree Network Centralization Two-Mode 

Column Redundancy Two-Mode 

Commmunication Multi-Mode 

Communication Congruence Multi-Mode 

Communicative Need One-Mode 

Complexity Multi-Mode 

Connectedness One-Mode 

Correlation Expertise Two-Mode 

Correlation Distinctiveness Two-Mode 

Correlation Resemblance Two-Mode 

Correlation Similarity Two-Mode 

Degree Centrality Spatial Multi-Mode 

Density Two-Mode 

Density Classic SNA One-Mode 

Diameter One-Mode 

Diffusion One-Mode 

Edge Betweenness Centrality One-Mode 

Efficiency One-Mode 

Eigenvector Centrality One-Mode 

Eigenvector Centrality Spatial Multi-Mode 

Exclusivity Two-Mode 

Exclusivity Complete Two-Mode 

Fragmentation One-Mode 
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Geodesic Distance One-Mode 

Global Efficiency One-Mode 

Hierarchy One-Mode 

Hub Centrality One-Mode 

In-Degree Centrality Two-Mode 

In-Degree Network Centralization Two-Mode 

Information Centrality One-Mode 

Interdependance One-Mode 

Interlockers One-Mode 

Inverse Closenness Centrality One-Mode 

Isolate Count One-Mode 

Knowledge Actual Workload Multi-Mode 

Knowledge Based Access Index Two-Mode 

Knowledge Task Completion Multi-Mode 

Knowledge Diversity Two-Mode 

Knowledge Exclusivity Two-Mode 

Knowledge Load Two-Mode 

Knowledge Negogiation Multi-Mode 

Knowledge Omega Multi-Mode 

Knowledge Potential Workload Multi-Mode 

Knowledge Redundancy Two-Mode 

Knowledge Under Supply Multi-Mode 

Lateral Link Count One-Mode 

Link Count Two-Mode 

Local Efficiency One-Mode 

Location Relevance Multi-Mode 

Minimum Speed One-Mode 

Network Levels One-Mode 

Node Count One-Mode 
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Node Levels One-Mode 

Organization Agent Knowledge Needs Congruence Multi-Mode 

Organization Agent Knowledge Waste Congruence Multi-Mode 

Organization Agent Resource Needs Congruence Multi-Mode 

Organization Agent Resource Waste Congruence Multi-Mode 

Organization Task Knowledge Needs Congruence Multi-Mode 

Organization Task Knowledge Waste Congruence Multi-Mode 

Organization Task Resource Needs Congruence Multi-Mode 

Organization Task Resource Needs Congruence Multi-Mode 

Organizational Availability Multi-Mode 

Out-Degree Centrality Two-Mode 

Out-Degree Network Centralization Two-Mode 

Overall Role Based Availability Multi-Mode 

Overall Task Completion Multi-Mode 

Performance as Accuracy Multi-Mode 

Personnel Cost Multi-Mode 

Pooled Link Count One-Mode 

Potential Boundary Spanner One-Mode 

Potential Workload Multi-Mode 

Radials One-Mode 

Reciprocal Link Count One-Mode 

Relative Cognitive Dinstinctiveness Two-Mode 

Relative Cognitive Expertise Two-Mode 

Relative Cognitive Resemblance Two-Mode 

Relative Cognitive Similarity Two-Mode 

Relative Expertise Two-Mode 

Relative Similarity Two-Mode 

Resource Actual Workload Multi-Mode 

Resource Based Access Index Two-Mode 
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Resource Based Task Completion Multi-Mode 

Resource Diversity Two-Mode 

Resource Exclusivity Two-Mode 

Resource Load Two-Mode 

Resource Negogiation Multi-Mode 

Resource Omega Multi-Mode 

Resource Potential Workload Multi-Mode 

Resource Redundancy Two-Mode 

Resource Under Supply Multi-Mode 

Role Based Knowledge Availability Multi-Mode 

Role Based Resource Availability Multi-Mode 

Role Based Knowledge Multi-Mode 

Role Resource Availability Multi-Mode 

Row Breadth Two-Mode 

Row Count Two-Mode 

Row Degree Centrality Two-Mode 

Row Degree Network Centralization Two-Mode 

Row Redundancy Two-Mode 

Sequential Link Count One-Mode 

Shared Situation Awareness Multi-Mode 

Simmelian Ties One-Mode 

Skip Link Count One-Mode 

Social Technical Congruence Multi-Mode 

Span of Control One-Mode 

Strict Knowledge Congruence Multi-Mode 

Strict Resource Congruence Multi-Mode 

Strong Component Count One-Mode 

Task Exclusivity Two-Mode 

Task Knowledge Needs Congruence Multi-Mode 
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Task Knowledge Waste Congruence Multi-Mode 

Task Resource Needs Congruence Multi-Mode 

Task Resource Waste Congruence Multi-Mode 

Total Degree Centrality One-Mode 

Total Degree Network Centralization One-Mode 

Triad Count One-Mode 

Transivity One-Mode 

Upper Boundedness One-Mode 

Weak Boundary Spanner One-Mode 

Weak Component Count One-Mode 

Weak Component Memebers One-Mode 

 

 

References 
[1] Davis, A et al. (1941). Deep South. Chicago: University of Chicago 

Press. 

[1] Breiger R. (1974). The duality of persons and groups. Social 
Forces, 53, 181-190. 

 

 

Actions, Tasks, and Event 

There are three Node Classes in ORA where you can depict what a 
particular node might be doing. They might seem a little confusing at 
first. Below are basic explanations of the three. But depending on 
your situation you may find it necessary to alter the definitions to suit 
your needs. 

Action : Small activities, e.g. the employee makes coffee. 
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Task : Designed activities, e.g. it is part of the job description of the 
employee to make coffee. 

Event : One time happening, e.g. the employer made coffee on 
December 12th, 2011. 

These definitions are not set in stone but they can be used as a good 
starting point for your Meta-Network. 

 

 

Aggregation 

Space is continuous and distances can be arbitrarily large or small. 
Networks can contains relations between discrete entities or vast 
neighborhoods. Space, like time, can be discretized to produce 
networks, but you can't forget about it. 

Consider a scientific collaboration network. It could be aggregated by 
the researchers in each city. But there no way to distinguish between 
the researchers at individual universities in Pittsburgh. You could 
have collaborations of Pitt-CMU, Pitt-Pitt, and CMU-CMU. Then there 
are collaboration between Pittsburgh researchers and Boston 
researchers. Again, which university might it be. 

NOTE : You need to remember that in aggregation, order doesn't 
matter. All events happen more or less at the same time. 

Aggregation Issues 
You need to disconnect between space and networks. Locations are 
continuous. Networks are defined between discrete entities. Are two 
locations ten meters apart the same location? 



72 
 

 

Aggregation Can Lose Information 
Original Dataset 

2 5 6 2 

3 5 5 1 

4 5 2 3 

7 4 1 2 
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Some Information Loss 

2.5 5.0 5.5 1.5 

5.5 4.5 1.5 2.5 

Extreme Information Loss 

4.0 4.75 3.5 2.0 

What To Do? 
You can explore many different aggregations or quantify the risk of 
false conclusions. But how much information is not being shown? Is 
there information entropy from Information Theory. The example 
below contains links occurring in three separate time periods [top 
image]. 

 

Below shows these links in a network over time. 

 

Aggregated, all three people appear to have links to each other 
simultanously. 
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Before aggregation, the sequence of actions is clear, but not the 
overall connections. After aggregation, the total network is clear, but 
it's unclear when these things happen. 

NOTE : Aggregation works well with information that is not time 
sensitive. Total links rather than the sequence of events. 

 

 

Beliefs 

Belief Diffusion is the change in beliefs of actors in a social group 
over time. Beliefs cannot be evaluated for truth. Knowledge can 
contribute to or deny a belief. 

Example 1 
Belief : Cats are better house-pets for a family than dogs. 

Supporting Evidence : Cats tend to live longer than most breeds 
of dog. 

Contrary Evidence : Most cats must have explicit socialization 
training early if they are going to be as affectionate as most breeds 
of dogs. 

Example 2 
Fact 1 : Cats damage furniture. 

Fact 2 : Cats are passive aggressive. 

Fact 3 : Cats leave trophies. 

         => I don't want a cat! 
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Change Format 

Description 
NOTE : The first thing to remember is the Change List is for 
modifying Nodes, not Links. 

The Change Format is used when you want to: 

Delete : Remove a node entirely from the Nodeset. 

Split : Split a concept into two or more new concepts. i.e., 
laptop_computer could be split into two concepts: laptop and 
computer. The original concept would remain unaffected 

Add : Create a new node in a Nodeset. 

Merge : Take the information from two separate nodes and 
combine it into one node. Used to clean up nodes with similar, but 
not exact, names. 

Move : Move a node from one Nodeset to another. 

The Columns 
Action : Dictates the action to take on the row. Includes delete 
remove a node from a Nodeset, split create multiple entries from 
one node, add create a new node in a Nodeset, and merge 
combine node names into a single entity. 

Total Degree :  

Frequency : Number of occurrances of a concept. 

TF-IDF : Reflects how important a word is to a document in a 
collection or corpus. 

Current Node Name : Contains the text as it appears in the 
original node. 
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New Node Name : Contains the text you want to use as a 
replacement for the text in the Current Node Name column. If 
the New Node Name is blank that means that it remains the same 
as the Old Node Name. 

Current Node Class : Contains the class as it appears in the 
original node. 

New Node Class : Contains the class you want to use as a 
replacement. 

Current Nodeset Name : Contains the Nodeset Name as it 
appears in the original node. 

New Nodeset Name : Contains the Nodeset Name you want to 
use as a replacement. 

Current Node Type : Used to denote whether the concept is 
specific item [  i.e. President Obama ] or a generic item [  i.e. 
American ] or leave blank. 

New Node Type : Allows the user to change the Node Type of a 
node 

NOTE : ONLY agent, organization, location, event can have a type. 

Generic and Specific Type 
The generic and specific are the two allowed Node Type values. They 
provide the users with some additional information on whether this is 
a universal or general concept or a specific concept. The difference 
between Specific and Generic can be simply put as the difference 
between a and the. 

Specific : Concepts which reference a specific agent, location or 
organization. For example: John Doe is a specific agent, CASOS is 
a specific organization, and USA is a specific location. 

Generic : concepts which are universal and do not point to a 
specific agent, location or an organization. For example: man is a 
generic agent, health fund organization is a generic organization, 
and my room is a generic location. 
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Where To Use This File 
This file is used in the Data Management > Meta-Network 
Clean... function. 

New Change List Support 
Integration of ORA and Automap formats are improved by use of the 
Change Format. Deleting, Merging, and Moving nodes is greatly 
simplified. ORA and Automap both use this format. 

How Is It Used? 
When nodes are deleted, merged, and moved within the Node Editor 
in ORA, these operations are recorded internally in a Change List that 
can then be exported. Also, existing change lists can be loaded and 
applied to the Node Class within the editor. 

There is one change list per meta-ontology. For example, editing the 
Agent : Friends Node Class will modify the change list for the Meta-
Ontology Agent. If you move to another meta-network and edit its 
Agent : Enemy Node Class, then it will also modify the Agent 
change list. You need to manually clear the change list, as otherwise 
the changes are just accumulated. 

Here is the support in the GUI: 

Select a meta-network, expand it in the Meta-Network pane, select 
a Nodeset, and click on the Clean dropdown arrow: 
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These are the different options: 

Deduplication : Opens a dialog that has existed for a while and 
that lets one find nodes that are duplicates based on the similarity 
of their IDs or Titles. The nodes can then be easily merged. 

Apply change list : Prompts for a change list file and applies it to 
the Node Class. 

View changes : View the record of the node Merge, Move, Delete 
operations performed to the current meta-ontology. From within 
this dialog, one can clear the list. 

Save changes : Exports the current changes to the Change List 
format, and this can then be used in Automap or applied later in 
ORA. 

Entire Meta-Network : Opens up the Text Analysis Cleaner 
and allows you to work on the whole Meta-Network. 

NOTE : The Delete, Merge, and Move buttons have been made 
simple buttons. These otherwise have not been changed. 

You can think of the Change List as simply a log of the operations 
performed on the Node Class during the ORA session. 
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Correlation 

Correlation can be found in the QAP/MRQAP Analysis report. 

Below are two networks which contain the same nodes but different 
links. Correlation wshows what needs to be changed to go from one 
network to the other. Then the mean and the standard deviation 
will be presented. 

Network 1 

 

 A B C D E 

A 0 1 1 1 0 

B 1 0 0 0 0 

C 1 0 0 0 1 

D 0 0 0 0 1 

E 1 1 1 1 0 

Network 2 
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 A B C D E 
A 0 0 0 1 0 

B 1 0 0 0 0 

C 1 0 0 0 1 

D 0 0 1 0 0 

E 1 1 1 0 0 

String 
Both networks are converted into strings. The table shows the 
differences between the two strings. 

0111010000100010000111110 

0001010000100010010011100 

Calculation 
The report will give the results for their differences. 

Mean Std. Dev. Correlation 
0.44 0.51 0.60 

0.32 0.48    
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Cube Analysis 

Cube Analysis of communicative power: 
Concept Embedding 
Communication depends on asking questions about how different 
people use words. It is a way of locating Common Ground. 

• Do people use same words 

• Do people use same words in same way 

• Do people evoke the same concepts  

• Do people link the same concepts in the same way 

• Are the same disciplines employed 

• Are the same journals, trade magazines, etc. read 

Three key communicative dimensions. 
Intensity/consensus : Weighted degree or number of graphs of 
individual's mental models or number of reports the tie is present 
in. 

Conductivity : in-degree*out-degree or betweenness 

Density : degree 

Most words will be low on all three dimensions. Words that stand out 
on any one dimension will have extra communicative power. 
Messages containing such words will be more persuasive. 
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The Cube 

 

General: Ordinary Word 
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Factoid 

 

Placeholder 
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Buzzword 
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Emblem 

 

Stereotype 

 

Standard Symbol 
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Allusion 

 

Illustrative Concept 
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Summary of Cube Analysis 
• Texts can be coded as networks 

• Networks represent the mental model 

• Coding texts as mental models focuses on meaning 

• Concepts have position in texts 

• Examining positions focuses on communicative power 

 

 

Delimited Files 

Excel, when reading in a flat file (i.e. txt or .csv), is sensitive to the 
kind of delimiter used. In the American version of excel, it assumes 
that a comma or tab is used to separate columns. In other versions, 
it often assumes that a semicolon or tab is used to separate columns. 
This is because in many other languages the comma is used as a 
period in showing the price of items. 

AutoMap and ORA export data as comma separated and can import 
comma separated. This means if you are reading into or reading from 
a non-American version of excel you may have problems. 
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Reading in the.csv file into Excel that uses something other than 
commas will cause the data to appear as a set of text in column A. 
There are two ways to fix this. 

NOTE : And if you data contains commas change to another 
character before changing the delimiting characters to commas. 

First read the file into a text editor and globally change all the 
delimiting characters to commas. 

Second read the file into excel and use the Text to Columns 
function and use a different delimiter. 

Excel Example 
Let's start with a simple three line file using semicolons as delimiters. 

NOTE : Remember, data can be separated with a variety of 
characters. This procedure allows you to import data with any of 
them. 

100;apple;red 
101;lime;green 
102;lemon;yellow 

Opening this file in Excel will place each line of text into a single cell. 
You need to separate this into individual columns. 

 

Select the cells you want to convert then click the Data tab. Click the 
Text to Columns function. 
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This brings up the Convert Text to Columns Wizard. Make sure 
the Delimited radio button is selected. Then click [ Next > ]. 

 

Under the Delimiters header make sure the Semicolon box 
contains a check mark. In the Data previewarea it will show you 
what your data will look like after the conversion. Click [ Next > ]. 
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Lastly you can do some final tweaks to how your data will be 
converted if you want such as your data format or a different 
destination. In this example we want the data to be inserted back 
into the original starting cell. Click [ Finish > ]. 
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Each piece of data now resides in a separate cell. 

 

The new file can now be imported into ORA through the Data Import 
Wizard. 
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What Is A Dynamic Network 

Networks are ways of connecting the who, what, where, why, how 
and when. Each type of who, what, where, why, how and when is 
called an entity class. The items within them are called nodes or 
entities. The set of networks for three or more of these entity classes 
is called the Meta-network. The entire field of Dynamic Network 
Analysis is based on the concept of the Meta-Network. 

Node 
A Node can literally be anything you can think of; on an abstract 
level, an Entity may be merely a dot in a visual network model. It is 
what we are networking and connecting our ties to and thus looking 
at in detail visually. 

Nodeset 
A Nodeset is a group of similar nodes [i.e. people, places, 
knowledge] 

Network 
A Network shows how the nodes connect to each other. 

Meta-Network 
A Meta-Network incorporates different Nodesets and allow you to 
perform an analysis on the model that way. Such a model is called a 
MetaNetwork. 

A Meta-Network is network composed of multiple networks. A 
MetaNetwork is the sum of all networks we are considering. The 
Meta-Network is the foundation for Dynamic Network Analysis; 

Dynamic Networks 
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• S1 : 2 agents share 1 location 

• S2 : They move apart to 
separate locations 

• S3 : A 3rd connected agent is 
detected at its own location 

• S4 : 2 of the agents meet 

• S5 : The 3rd joins at same 
locale 

• S6 : One agent disappears 

 

The Operational Statistics indicate the number of additions, 
modifications, and removals to the Network. 

Manipulating Keyframes/Deltas 
You can Convert Keyframes to Deltas, Deltas to Keyframes, or 
Aggregate by Day/Week/Month/Year. 
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Over-Time Visualizations 
Visual Comparisons, Animating over time, and Plotting changing 
centrality. 

Qualifications 
If you are attempting to create a Dynamic Network ORA will check for 
incompatibilities between the files. If there are incompatibities 
between different Nodesets which have the same Nodeset Name 
[e.g.,  knowledge : skills and resource : skills ] it will stop the 
process. Also if there's incompatibility in the nodes in identically 
named Nodesets. 

Retrieving KeyFrames from Dynamic Meta-
Network 
If you want the individual KeyFrames to use as regualr Meta-
Networks then 1) Select the Keyframes; 2) Press Control-C to copy 
those KeyFrames; 3) Close the Dynamic Meta-Nework; and 4) Press 
Control-V to copy them into the Meta-Network Manager pane. 

 

 

Deltas and Keyframes 
`  

The difference between Deltas and 
KeyFrames 
The Keyframe acts as a starting point, or a snapshot of what the 
Meta-Network looks like at any given time. It doesn't care what came 
before or will occur after. 

The Delta is a set of instructions on how to change the Meta-
Network. It reviews what came before it, applies a set of changes, 
and displays the revised Meta-Network. 
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Initial State : Nothing    Initial State : 
Nothing  

KeyFrame : 3 nodes, 3 
links  

 

Delta : +3 nodes, +3 
links  

KeyFrame : 6 nodes, 9 
links  

 

Delta : +3 nodes, +6 
links  

KeyFrame : 6 nodes, 6 
links  

 

Delta : -3 links  

KeyFrame : 8 nodes, 12 
links  

 

Delta : +2 nodes, +6 
links  

The biggest advantage of Deltas is it requires less information than 
KeyFrames. KeyFrames are a screenshot of every node and like in 
every time slice. Deltas, on the other hand, require only the 
information about individual changes. 

NOTE : Change in the first KeyFrame do not affect proceeding 
KeyFrames. But with Deltas changes in the initial KeyFrame are taken 
into account by each Delta. 
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Importing Delta key Frame Data 
The easiest way to create a dynamic Meta-Network is to first create a 
number of regular Meta-Networks. Next, import all these neta-
networks into ORA. Select all the Meta-Networks in the Meta-Network 
pane you want to merge and right-click. From the contextual menu 
select Create a Dynamic Meta-Network. This brings up a Dynamic 
Meta-Network importer dialog with all your selected Meta-Networks. 

Next you need to select which Meta-Networks you want to act as 
keyframes. This can be as few as the first Meta-Network or as many 
as all. Then click the [Import] button. You have now created a 
Dynamic Meta-Network. 

Delta KeyFrame and Loom 
The question arise as to whether you need a Delta KeyFrame to run 
this in Loom. No, a Delta KeyFrame Meta-Newwork in not a necessity 
for Loom as long as the Locations/Node Set/node id's match in every 
Meta-Network. 

How can you show only some time periods 
or some locations 
In Loom, only the locations that have entities currently moving 
through them are displayed. Locations with entities moving through 
them cannot be hidden. 

Similarly, there's no way to currently turn off individual time periods. 
The work-around would be to just not include that time-periods Meta-
Network whenever you load up loom. 
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Create Dynamic Network 

A Dynamic Meta-Network is made up of multiple Meta-Networks. 

28 Raiders of the Lost Ark Meta-Networks 

 

I split up The Raiders of the Lost Ark into 28 
parts and created a Meta-Network for each. 
These contain Nodesets for agent, locations, 
resources, knowledge, and tasks. The 
Nodeset Names contained in each Meta-
Network are identical but only appear in 
Meta-Networks where they have active 
links. 
 
Example : Belloq, the evil archaeologist, 
appears in Raiders, peru but is absent until 
eight Meta-Networks later in Raiders, 
cario-bar. 
 
To create a Dynamic Meta-Network highlight 
all the Meta-Networks you want to include. 
Right-Click on any of them and select 
Create Dynamic Meta-Network. 
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In the Dynamic 
Meta-Network 
Importer it lists 
each Meta-
Network, the 
date, and 
whether you 
want it to be a 
Meta-Network 
[check mark] or 
a Delta [no 
check mark]. 
 
An important 
item about the 
date is there can 
not be any 
duplicate dates. 
Also the 
Dynamic Meta-
Network will look 
at each in 
chronological 
order. 
 
The far right 
column is used if 
you find the 
need to remove 
a Meta-Network 
before you move 
on to the 
creation process. 
Click the [ X ] to 
delete a Meta-
Network before 
importing. 
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When finished you will see an new Meta-
Network in the Manager pane. This icon 
has the clock overlay signifying it is a 
Dynamic Meta-Network. 
 
The Keyframe Meta-Networks carry the 
standard Meta-Network icon [the items 
check marked in the Importer window]. In 
the main editor page the statistics will be 
displayed: Source count, Nodeset count, 
Node count, Link count, Network count, 
and Total density. 
 
The Deltas carry the green and orange 
circle icons. In the main editor page the 
Operation Statistics will be displayed 
This consists of additions, modifications, 
and deletions of Nodesets, Nodes, Links, 
and Networks. 

The Info Tab 
When you highlight either a Meta-Network or a Delta you will see 
different information in the Info Tab. A Meta-Network will display the 
exact count of nodes, links, and other network information. 
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The Delta, on the other hand, will display only the changes that 
occurred between itself and the previous Meta-Network/Delta. 
Displayed are the number of items Added, Modified, and removed. 
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Exponential Random Graph Models 
[ERGM] 

Exponential Random Graph Models, also known as p* models, are a 
family of statistical models that help analyze the structure and 
properties of social and other networks. There are other well known 
techniques to describe the structural properties of a network such as 
centrality, density etc. As opposed to these techniques which describe 
only the network for which they are measured, ERGM's try to 
describe all possible networks with the same statistical properties as 
the current one. The other alternative networks may or may not have 
the same structure, but the underlying statistical model that 
generates them is the same as the observed network. 

The networks that are being studied today are substantially larger in 
structure for example, the World Wide Web, Internet, communication 
networks, food web networks, etc which have millions and even 
billions of nodes. It is very hard to visualize the shape and structure 
of such networks, even with modern advances in computing 
technology. In absence of reliable visualization techniques, statistical 
modeling techniques can provide an answer by quantifying large 
networks. Networks with similar properties will have similar statistical 
models. This change in scale also makes traditional questions like, 
which node's removal will affect the connectivity in the network the 
most, largely irrelevant. For large scale networks a question which 
makes more sense is what percentage of nodes when removed would 
significantly affect network connectivity? [1]. Statistical modeling of 
networks will allow us to answer this question. 

ERGMs were initially introduced to study social networks but since 
then have found their application to networks generated from several 
different domains such as epidemiology, telecommunications, political 
science etc. One point to remember while using ERGM models is that 
a network is modeled as a single multivariate observation which 
limits them from being used for modeling networks over time. In 
addition the modeling by ERGM is limited to networks with binary 
edges only. Hence networks with non binary edges should be 
converted to binary valued edges before using ERGM. The coding rule 
for the conversion may not always be obvious. The other major 
limitations of ERGM models are that they are very sensitive to 
missing data and suffer from degeneracy problems. Degeneracy 
occurs when the derived model is highly unlikely to have generated 
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the network hence the ERGM cannot be computed. In many cases 
degeneracy can be circumvented by carefully specifying the 
components of the model to be estimated as opposed to using ERGM 
with the default set of controls. 

Exponential random graph models have the following form: 

       (1) 

Where X is a random graph consisting on n nodes and x is the 
observed graph. The assumption of this model is that the structure of 
the observed graph x can be derived from a known vector of graph 
statistics, s(x) and the associated vector of model parameters θ. The 
parameter c(θ), is a normalizing constant where 

 

All exponential random graph models are of the form in equation (1), 
which describes a general probability distribution of graphs with n 
nodes. The particular probability for observing the graph x is 
dependent on its statistics s(x) and on θt for all configurations in the 
model. Configurations include ties, triads and are these dependence 
assumptions are important because they pick different configurations 
as relevant to the model and also because they constrain the possible 
configurations possible in the model [2]. The simplest dependence 
assumption is the Bernoulli random graph distributions where the 
edges are assumed to be independent whereas more complex ERGMs 
incorporate node level effects in the configurations. This flexibility in 
dependence assumptions allows for greater variability in the 
statistical modeling depending on the requirements and needs of the 
end user using the ERGM technique. 

References 
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Fast Fourier Transform 

What does the Fourier Transform do? Given a color swatch, it 
finds the base colors. 

How? Run the color swatch through filters to extract each base color. 

Why? A list of colors are easier to analyze, compare, and modify 
than the swatch itself. 

How do we get the swatch back? Blend the base colors. 

In essence The Fourier Transform extracts each "cycle ingredient" 
from a time-based signal (the cycle strength, delay & speed), 
resulting in a final "cycle recipe". It changes it from one large amount 
of a mixture to a list of individual ingrediants. 

Filters 
This is a change of persepctive. You change from the notion of a 
single quantity to the amount of of something in something else. 
It changes from What are you looking at? to How was it made? 

In other words, What are the component Parts? 

And why do it this way? Because it is easier to categorize, compare, 
modify, and replicate than the original object in question. 

Let's take a look at a color swatch. You can't tell what colors go into 
making this particualr swatch. You could guess, but it probably 
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wouldn't be accurate. You'd have to guess about the amounts of Red, 
Green and Blue in the swatch. 

 

But if you had a way of filtering out each of the colors used to make 
that swatch, then you could determine exactly what colors went into 
creating it in the first place. Then you could run the original color first 
through the red filter [to reveal the amount of units of red are used], 
then the green, then the blue. 

 

Filters 

Red Filter 

 

54 units of red 

Green Filter 

 

220 units of green 

Blue Filter 

 

136 units of blue 

Now that you have the breakdown of the three colors used, you could 
successfully recreate that swatch color. 

Things To Remember 
Even though this sound simple enough, there are a few things that 
you need to keep in mind. 
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Filters must be independent : The red filter will only find the red 
parts. Adding more green or blue will not affect the amount of red 
it finds. That would only change the starting color. 

Filters must be complete : You need a filter for each part. If the 
blue filter was left out, the resultant colors from the red and green 
filters would combine to create a different color. 

The individual parts must be combineable : Once separated, 
the colors can be re-combined to create that color again with no 
issues. But a cookie run through a set of filters to determine it's 
ingrediants could not be readily re-combined to make a cookie as 
there are other processes that are needed to make the cookie. 

 

 

Folding Math 

Folding a Network means multiplying the network by its transpose. 
And that when one folds a two-mode network (e.g., agent x 
organization) the diagonal gives the number of [organizations] each 
agent has. The off-diagonal contains the organizations which the 
agents have in common. 

NOTE : A network can be folded by highlighting the network in the 
Meta-Manager pane. Right-Click on the network and select Fold 
Network. 

Here is a simple two-mode network agent x organization I have the 
following values: 

Original Network 

  Club A Club B Club C 
Izy 0 2 10 

Jane 5 0 3 

Karl 4 6 0 
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Folded Network 

  Izy Jane Karl 

Izy 104 30 12 

Jane 30 34 20 

Karl 12 206 52 

The question people will have is, "How can Izy have a self loop of 
104, Jane Self Loop of 34, and Karl Self Loop of 52?" 

Tranpose of Original Network 
First you need the transpose of your original network. 

  

  Izy Jane Karl 

Club A 0 5 4 

Club B 2 0 6 

Club C 10 3 0 

And finally, the math. 

Linear Algebra 
It's part of a the linear algebra operation called the inner-dot 
product of the first row and column vector. 

For Izy at row 1 col 1, the value after folding is [0 2 10] * [0 2 10]', 
or 0 * 0 + 2 * 2 + 10 * 10 = 0 + 4 + 100 = 104. 

Now let's take a look at the value from Izy to Jane (30), which is the 
dot product of the 1st row times the 2nd col, or [0 2 10] * [5 0 3]' = 
0 * 5 + 2 * 0 + 10 * 3 = 0 + 0 + 30 = 30. 

This process continues for all cells. 

The short of this is, The self-loop is the sum of the squares of all 
their ties. 
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Hamming Distance 

Hamming Distance is the sum of the difference between networks. 
For binary links, it is how many differences/changes there are 
between two networks. 

Hamming Distance can be found in the Key Entity report. 

Network 1 

 

 A B C D E 

A 0 1 1 1 0 

B 1 0 0 0 0 

C 1 0 0 0 1 

D 0 0 0 0 1 

E 1 1 1 1 0 
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Network 2 

 

 A B C D E 
A 0 0 0 1 0 

B 1 0 0 0 0 

C 1 0 0 0 1 

D 0 0 1 0 0 

E 1 1 1 0 0 

String 
0111010000100010000111110 

0001010000100010010011100 

Calculation 
Distance = 5 

5/20. .25, 25% 
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Inferences Matrices 

Questions and Answers about Inference 
Matrices 
Question : You have a matrix defined as [ AK x AK^T ] and 
end up with an Agent matrix but with inferences based on the 
knowledge matrix. What information can you get from this? 
For example, what if a(ij) = 1. Does that means that agent i 
and agent j are connected by a common knowledge? Are there 
any other uses for the inference matrices? Any deeper 
information we can gather from them? Are there metrics that 
are applicable to them? 

Answer : These often go under two mode metrics. See also 
Command and Control for more information. 

 

Question : If, in the above example, the AK matrix is not a 
boolean, but rather has values from 0 -> n, showing the 
strength of the tie between that agent i and knowledge j. 
When we look at the inference matrix, some of the values in 
the matrix are bound to be > 1. Does this imply that the tie 
between agent i and agent j is greater if there is a value > 1, 
or should the inference matrix be thought of as a boolean (0, 
1) no matter what the value in the matrix after the matrix 
multiplication? 

Answer : It is ok to have cell values greater than 1. It is also 
ok to binarize it. It just depends on what you want to look at. 

 

Question : Are there any affects that need to be watched for 
when multiplying a directed and undirected meta matrix? 

Answer : If you multiply a direct and an undirected it becomes 
directed. 
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Question : Do we lose properties, gain them? Is the resultant 
nectwork directed or undirected (which property is 
dominant)? 

Answer : If you don't want direction to matter you can always 
symmetrize and tell ora to treat it as undirected. 

 

Question : Directed mean it matters which node is the source 
and which is the target. Symmetric means that for any 
network H, Hij=Hji. Assymetric means Hij does not necessarily 
equal Hji. 

Answer : An undirected network is symmetric. A symmetric 
network is not necessarily undirected. A symmetric but 
directed network that contains Hij and Hji are treated as two 
different ties just of the same value. If it is symmetric and 
undirected Hij=Hji and this is treated as a single tie. 

 

 

Large Meta-Networks 

Description 
There's always a question as to the maximum size for a Meta-
Network in ORA. That depends on a number of items. 

First it depends on your machine. Extremely large networks [ 
networks containing 10^6 nodes ] have been run successfully on 64-
bit multi-core machines. 

It is also about the amount of memory in the machine. The more you 
have the better it is. It helps make very big networks are doable. 

Also, if it is taking forever even when running Standard Network 
Analysis, you may want to go to Analysis > Measures Manager... 
and opt out some of the slow metrics, such as information centrality, 
if you are not particularly interested in those. 

 



111 
 

 

MetaOntology 

The Ontology is defined as the group of classes in which almost every 
concept and phrase can be classified depending on the context in 
which the concept/phrase is used in a particular sentence or a 
paragraph. For example: USA can be a location or an Organization, 
depending on the context of the data.  

Standard Node Classes 
In detail, the ten Node Classes can be defined as follows: 

1. Agents are individual decision makers. The most common type of 
decision makers is people. However, this category could also be used 
for other types of actors such as robots or monkeys. A single Agent 
represents any person: a family member, a Roman soldier, 
Soothsayer, Calpurnia, Cicero, any historical figure, a terrorist, or a 
teacher. 

2. Resources are products, materials, or goods that are necessary to 
perform Tasks, Events, and Actions. A Resource could literally be a 
dagger, a cloak, a crown, a short sword, a computer, money, bombs, 
tools, or books.  

3. Knowledge describes cognitive capabilities and skills. Knowledge 
could be Trigonometry, History, English, Economics, the science of 
DNA, or the knowledge about how to perform a surgery or to build 
bombs. 

4. Tasks are well defined procedures or goals. A Task could be any 
process in a company, e.g., product development or administration, 
but also the plan to kill Caesar. 

5. Organizations are collectives of people that try to reach a common 
goal. An Organization could be a specific company, the United 
Nations, or the government of a country. 

6. Locations are geographical positions at any aggregation level that 
describe places or areas. A Location could be 1600 Pennsylvania 
Avenue in Washington, London, Florida, The Middle East, Earth, or 
Mars. 
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7. Events are occurrences or phenomena that happen. An Event 
could be 9-11, the JFK Assignation, the Super Bowl, a wedding, a 
funeral, or an inauguration. Specific events are one time occurrences 
with a specific date. 

8. Actions are specific activities done by agents. An Action could be 
buying a car, writing a letter of recommendation, or flying to Africa. 

9. Beliefs are any form of religion or other persuasion. A Belief could 
be to believe that there is a god, or that there are many gods, or that 
that Earth is flat. Some beliefs are signaled by sentiment such as 
"war is bad." 

10. Roles describe functions of individual decision makers abstracted 
from specific Agents. A Role could be leader of a group, driver of a 
car, or mother of an Agent. 

Groups, also referred to as Meta-Nodes, are any categorization of 
nodes into a cluster. Groups are defined by one or more of the 
grouping algorithms. 

Example 
To repeat the function of these Node Classes are to show their 
differences as well as give a first impression about how these Node 
Classes are connected with each other. For example in Julius Caesar, 
Brutus (Agent) and other senators (Roles) agree that Rome 
(Location) would be a better place without Caesar (Belief). To kill 
Caesar (Task) they form a group of assassins (Organization). To 
accomplish their task they need to know about Caesar's daily routine 
(Knowledge) and how to get their knives (Resources) into the senate. 
Finally, the assassination (Event) takes place because somebody 
actually stabs Caesar (Action). 
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Monte Carlo Network Optimization 

Description 
Monte Carlo methods (or Monte Carlo experiments) are a class of 
computational algorithms that rely on repeated random sampling to 
compute their results. Monte Carlo methods are often used in 
computer simulations of physical and mathematical systems. These 
methods are most suited to calculation by a computer and tend to be 
used when it is infeasible to compute an exact result with a 
deterministic algorithm. This method is also used to complement the 
theoretical derivations. 

In general, Monte Carlo methods are used in mathematics to solve 
various problems by generating suitable random numbers and 
observing that fraction of the numbers which obeys some property or 
properties. The method is useful for obtaining numerical solutions to 
problems which are too complicated to solve analytically. The most 
common application of the Monte Carlo method is Monte Carlo 
integration. 

 

 

Multiple Links in Imported Data 

The Problem 
There has been a question of what to do when there is the possibility 
of multiple links between the same nodes in a file to be imported 
using the Data-Import Wizard > txt Data > Simple Table > 
Networks, Nodes and Node Attributes. 

Normally the weight of the links in the final network which contains 
multiple links will be summed. [ node1 > node2 is 0.4 and node1 
> node2, 0.5 ]. The expected result would be 4.5 but is in fact 
summed and becomes 0.9. 
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The Solution 
If you don't know in advance which nodes have multiple links you 
need to use the Data Import Wizard to create one Network per link 
type. 

 

 

 

Network Basics 

Network Basic Terms 
Networks are contain information with Weighted/Unweighted, 
Symmetric/Asymmetric, Connected Networks/Disconnected 
Networks, and Self Loops. Each makes for a unique network 
structure. Networks which are directed, weighted, unconnected, and 
which even contain self-loops are not unusual in social network 
analysis. 

Binary Networks 
A binary network is constructed by binary values (either 1 or 0) in its 
network matrix and contains only the information whether a link 
between two entities in the network exists or not. In the network 
matrix, 0 in the cell wuv indicates that there is no links from node u to 
node v while 1 indicates that there is a link. Because the weights of 
all links are 1 and therefore equal these networks are also called 
unweighted networks. 

Weighted Networks 
If the weights of the links are different we use the term weighted 
network. In a weighted network every link is represented by a real 
number wuv (continuously from -∞ to +∞) in its network matrix and 
contains not only the information about whether there is a link 
between entities, but also numerical information about the links (e.g., 
how far two entities are distant geographically or how often agents 
interact with each other). In the network matrix, 0 indicates there is 
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no link between two entities while any value other than 0 indicate 
there is a link between the entities. 

Self-Looped Networks 
Self-loops (also called self-links or loops) are links from a node to 
itself. A self-looped network has therefore non-zero diagonal 
elements in the network matrix. Depending on the weight 
representation of the network (either binary network or weighted 
network), these diagonal elements can take the values 1 (in a binary 
network) or it can take any real number (in a weighted network). 

Symmetric/Asymmetric Networks 
In a symmetric network for every edge euv there is also an edge evu. 
All links are therefore reciprocal. In asymmetric networks this is not 
the case. In its matrix representation, a symmetric network has 
symmetric values about its diagonal. Asymmetric networks are also 
called directed networks, while undirected networks are synonymous 
with symmetric networks. In weighted networks the link values of all 
paired symmetric matrix elements have to have the same value in 
order to be symmetric. 

Disconnected Networks 
A path in a network is a subset of nodes and edges which connects 
two nodes without repeating a node or an edge. All nodes which can 
be reached from a specific node using paths are called reachable. If 
subsets of nodes are arranged in a way that all nodes of group A are 
unreachable from all nodes from group B and vice versa, the network 
is disconnected. Therefore, there is no link connecting any pair of 
nodes between the subsets of nodes. These subsets of nodes are 
named components. Every component can be interpreted as a single 
network, but researchers are often interested in treating 
disconnected networks as a single network. In addition, it is 
important to know that even if a network is connected, it is possible 
that there are unreachable nodes for a specific node in case of 
directed networks. 
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Network Characteristics 

 

Changing any of the characteristics above will affect the working of 
your network. Normally the creator of a network knows whether a 
specific network should be directed or undirected when it is created. 
Changing a weighted network from weighted to unweighted will 
remove link weight information and you end up with a binary network 
of 1s and 0s. Changing from a Asymmetric to Symmetric will force 
ORA to create extra links where the original network had none. 

Independently from these network settings ORA offers additional 
options for treating these characteristics when network measures are 
calculated. So, your data can have link weights but it is your decision 
to ignore these link weights when calculating network measures. You 
will learn more about these options in the following section. 

Editor Display Options 

 

Convert Links : This menu item includes different ways to 
manipulate the line weights of your network. You are able to binarize 
all links or just links within a specific range (collapse). Negate 
changes the algebraic sign of the links in the network while absolute 
value turns all line weights to positive numbers. Row-normalize is a 
method to weight the importance of a single link with the number of 
links of a node. 

Remove Links : With these methods you can remove specific links, 
e.g., links with a line value lower or higher than a given value or self-
loops. It is also possible to set the self-loops (diagonals) of a network 
to a designated value. In this menu you can also find ways to 
symmetrize your networks using different methods (maximum, 
minimum, sum, average). 

Highlight : Input a search parameter and all matching nodes will be 
highlighted in the matrix. 
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Hide : Input a search parameter and all matching nodes will be 
hidden in the matrix. 

Display Options : Options for displaying links as binary check boxes 
or numeric values. You are also given the option to display row or 
column sums. 

Measures 
You can add a measure result as an attribute using the Measure 
button in the Info Tab of a Nodeset. After clicking the button you 
specify which Network to use, which measure to run and give it a 
name. The result will display in the Nodeset display under Editor. 
The following are the default settings for measures added. 

Treat as symmetric : Symmetrizes the network for the calculation, 
e.g., if the line weight wuv is larger than wvu than wvu ← wuv. 

Ignore self-loops : All diagonal elements are set to 0. 

Treat as binary : The link weights for all wuv with wuv ≠ 0 are set to 
1. 

Scaling Parameters for Measures 
The results of measures is usually within the range 0 and 1 and is the 
result of scaling. It is used in order to compare networks with 
different sizes. You can change this to a scale of 0 to 100 under 
Preferences > Measures > Scale measures as percentage. 

Network Characteristics on Measures 
The characteristics of a network impact the way measures work, i.e. 
selecting self-loops affect the result of degree and eigenvector 
centrality as well as clustering coefficients. Below is a table with some 
examples. 
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If any option is set to True of False, ORA will add/remove links that 
the property holds in the network. 

 

 

Ontology 

What Is Ontology? 
Ontology has to do with making clear and explicit statement about 
entities in a paricular domain. What kinds of things can exist in this 
world we're trying to explain. What types of relationships do they 
have with each other. It is concerned with what is that and what is 
possible. 

Categorization or Classification : Organizing a set of entities into 
groups based on their essences and possible relations. This assumes 
that for any new items added to the group a place will already exist. 

Characteristics of Networks and their Impact on Measures 

Measure Allow/Ignore 
Self-Loops 

Symmetr
ic/Asym
metric 

Binary/Weig
hted 

Connected/Disconnecte
d 

Degree 
Centrality Yes Yes Yes No 

Betweenness 
Centrality No Yes Yes No 

Closeness 
Centrality No Yes Yes Yes 

Eigenvector 
Centrality Yes (No) Yes Yes 

Clustering 
Coefficient Yes Yes No No 
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Below is the Best Classification chart and I'm sure you recognize it. 

 

The Periodic Table has the most value, both descriptive and 
predictive, of any classification chart. The pink column on the right 
contains the noble gases. It is an odd category, because helium is no 
more a gas than mercury is a liquid. Helium is just a gas at most 
temperatures. 

Even in a nearly perfect categorization scheme, there are these kinds 
of context errors, where people are placing something that is merely 
true at room temperature, and is absolutely unrelated to essence, 
right in the center of the categorization. And the category 'Noble Gas' 
has stayed there from the day they added it, because we've all just 
gotten used to that anomaly as a frozen accident. 

If it's impossible to create a completely coherent categorization, even 
when you're doing something as physically related to essence as 
chemistry, imagine the problems faced by anyone who's dealing with 
a domain where essence is even less obvious. 

What Makes For A Good List? 
Here are the ideal situations you would like to cleanly classify your 
domain. 
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Small corpus 
Formal categories 
Stable entities 
Restricted entities 
Clear edges 

What Makes For Good Participants? 
The other important issue is in regards to who is doing the 
classifying. Here are a few things that help to job go smoother. 

Expert catalogers 
Authoritative source of judgment 
Coordinated users 
Expert users 

 

 

Parts of Speech 

Parts of Speech assigns a single best Part of Speech, such as noun, 
verb, or preposition, to every word in a text. While many words can 
be unambiguously associated with one tag, (e.g. computer with 
noun), other words match multiple tags, depending on the context 
that they appear in. 

CC Coordinating 
conjunction PRP$ Possessive 

pronoun 

CD Cardinal number RB Adverb 

DT Determiner RBR Adverb, 
comparative 

EX Existential there RBS Adverb, 
superlative 

FW Foreign word RP Particle 

IN 
Preposition or 
subordinating 
conjunction 

SYM Symbol 

JJ Adjective TO to 
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JJR Adjective, 
comparative UH Interjection 

JJS Adjective, 
superlative VB Verb, base 

form 

LS List item marker VBD Verb, past 
tense 

MD Modal VBG 
Verb, gerund 
or present 
participle 

NN Noun, singular 
or mass VBN Verb, past 

participle 

NNS Noun, plural VBP 

Verb, non-3rd 
person 
singular 
present 

NNP Proper noun, 
singular VBZ 

Verb, 3rd 
person 
singular 
present 

NNPS Proper noun, 
plural WDT Wh-determiner 

PDT Predeterminer WP Wh-pronoun 

POS Possessive 
ending WP$ Possessive wh-

pronoun 

PRP Personal 
pronoun WRB Wh-adverb 
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Reduced Form Network 

Description 
This is what Reduced Form does and does not do: 

Uni-modal networks are not changed (e.g. an AA is NOT 
symmetrized), but bi-modal networks are symmetrized in that 
the links from two or more networks are combined using the 
maximum method. 

Bi-modal networks are combined: For example, if there is an AK 
and a KA network, then the KA is transposed to AK2 and then AK 
and AK2 are unioned with the Maximum link weight from each 
(a,k) or (k,a) being used. 

Network Names are normalized to their Node Classes, e.g., agent x 
agent, agent x knowledge, etc. 

NOTE : The original networks are changed into their reduced network 
forms. If you want to maintain the originals, you need to work on a 
duplicate of the meta-network. 

 

How and Where ORA does Reduced Form 
Remove self loops : Removes all links that connect a node to 
itself. 

Symmetrize by method : Turns directed or asymmetric network 
data into undirected or symmetric data. All three methods use a 
pair of values from the upper and lower portions of the table (e.g. 
cell 1, 3 is compared to cell 3, 1). If a network had a link from A to 
B but not from B to A then symmetrizing the network would create 
a reciprocal link from B to A. 

Combine networks of the same type using method: : See 
descriptions below. 
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Tranpose networks according to node precedence : 
Tranposes bimodal networks to ensure that certain Node Classes 
appear first. The order is: Agent, Organization, Knowledge, 
Resource, Belief, Event, Task, Location.  

Combine networks of the same type using method: : See 
descriptions below. 

Combination Methods 
Maximum : Compares the values and uses the larger of the 
values. This is called using the strongest value. 

Minimum : Similar to Maximum only it uses the lower, or weaker, 
value. Average takes the two values and averages them. 

Sum : Adds weights of links from all combined networks. 

Binary : Sets link to [ 1 ] if there is a link an any two nodes or 
[ 0 ] if no network contains a link for two nodes. 

Average : Adds all links and divdes by the number of links found. 

 

 

Order of Node Classes 
The Node Classes will be placed in the following order: 

Agent 
Organization 
Knowledge 
Resource 
Belief 
Event 
Task 
Location. 
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Regression Technique 

Regression analysis is also used to understand which among the 
independent variables are related to the dependent variable, and to 
explore the forms of these relationships. In restricted circumstances, 
regression analysis can be used to infer causal relationships between 
the independent and dependent variables.[ 1 ] The dependent and 
independent variables can be either network measure or numerical 
attributes of nodes. 

To test the shape of the distribution or normality of the variables use 
... 

Procedure 
From the main menu select Analysis > Generate Reports... > 
Statistical Procedures and Diagnostics > QAP/MRQAP 
Analysis. Place a check mark next to the Meta-Network(s) to 
analyze. Click [ Next > ]. 
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In the top section select the Nodesets to analyze. In the bottom 
section select the Networks to analyze. Place a check mark in the box 
next to Create a Meta-Network from select nodes and networks 
to create a new Meta-Network. Click [ Next > ]. 
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Under Dependent network: select the Meta-Network and Network 
to use. 

Under Independent network(s): select the Networks to keep 
independent. 

Under Select the algorithms to run: select what to use for 
analysis. 

Under Set the algorithm parameters: set the set and 
permutations. 
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QAP/MRQAP ANALYSIS REPORT 
Input data: Raiders, Tanis - all 

Start time: Mon Dec 12 13:59:48 2011 

Data Description 

Parameters 
The random seed is 0 

The number of permutations is 100 

The dependent network is characters x characters-12 from the meta-
network Raiders, Tanis - all 
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The independent network(s) used from each meta-network:  

characters x characters-12 

characters x characters-14 

characters x characters-15 

characters x characters-16 

The total number of independent networks is 3 

Correlation Results 

     
Network Correlation Significance Hamming 

Distance 
Euclidean 
Distance 

Raiders, Tanis - all 
: characters x 
characters-14 

0.69 0.01 4 2.00 

Raiders, Tanis - all 
: characters x 
characters-15 

0.30 0.21 8 2.83 

Raiders, Tanis - all 
: characters x 
characters-16 

0.39 0.04 16 4.00 

Regression Results 
R-Squared: 0.470588 

     
Variable Coef Std.Coef Sig.Y-

Perm Sig.Dekker 

Constant 0.00  0.04  
Raiders, Tanis - all : characters 
x characters-14 0.50 0.69 0.00 0.00 

Raiders, Tanis - all : characters 
x characters-15 0.00 0.00 0.24 0.45 

Raiders, Tanis - all : characters 
x characters-16 0.00 0.00 0.40 0.39 
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Hanneman & Riddle (2005) argue that predicting and testing 
hypotheses about a node's non-relational attributes can be 
done using a mixture of relational (network) measures and 
non-network measures. This tool allows such tests. An example 
would be to use the entity class agents - such as specific 
people, and then regress their performance on a combination of 
node metrics e.g., degree centrality and non-relational 
attributes e.g. age and gender. This process computes basic 
linear multiple regression statistics by ordinary least squares 
(OLS), and estimate standard errors and significance using the 
random permutations method for constructing sampling 
distributions of R-squared and slope coefficients. 

[ 1 ] Wikipedia  

 

 

Semantic Network 

Semantic Network Union - Input 
Automap outputs one Meta-Network per text. A semantic network is 
a Meta-Network with: Concept Nodeset, Semantic Network 
(Concept x Concept), Dynetml <source> element describing 
Automap processing of the input text. 

You treat Meta-Networks as semantic networks. So you 
combine all Nodesets into a Node sSet : Concept and also 
combine all Networks into one Semantic Network. 

Semantic Union - Output 
Meta-Network called Consolidated. Nodeset : Concept contains 
special attributes: 

Frequency : Sum of the node's frequency attribute across 
Meta-Networks 
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Frequency_distinct : Number of Meta-Networks the node 
was in 

Frequency_isolate : Number of Meta-Networks in which the 
node was an isolate in the semantic network 

Nodeset : Text with attributes: 

One text node per input Meta-Network, corresponding to 
one text processed by Automap. Attributes describe how 
Automap processed the text (these are pulled from the 
<source> Dynetml tag). 

Semantic Network 
A Union of the Semantic Networks can control how link 
weights are combined: sum, minimum, maximum, etc.. 

A Concept x Text network records which texts contain which 
concepts. Link weights are from the node's frequency 
attribute (how many times the node occurred in the text). 

 

 

Simulated Annealing 

Decription 
Simulated annealing is an optimization heuristic (an algorirthm 
designed to solve a really difficult problem for which the best answers 
are computationally difficult to assess). This provides very good 
answers, but not always the best. You may have heard of other such 
algorithms, like the genetic algorithm (GA) or hill-climbing or A-star. 

The method was independently described by Scott Kirkpatrick, C. 
Daniel Gelatt and Mario P. Vecchi in 1983,[ 1 ] and by Vlado Cerný in 
1985.[ 2 ] The method is an adaptation of the Metropolis-Hastings 
algorithm, a Monte Carlo method to generate sample states of a 
thermodynamic system, invented by M.N. Rosenbluth in a paper by 
N. Metropolis et al. in 1953.[ 3 ] 
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Source 
The name and inspiration come from annealing in metallurgy, a 
technique involving heating and controlled cooling of a material to 
increase the size of its crystals and reduce their defects. The heat 
causes the atoms to become unstuck from their initial positions (a 
local minimum of the internal energy) and wander randomly through 
states of higher energy; the slow cooling gives them more chances of 
finding configurations with lower internal energy than the initial one. 

 

[1] Kirkpatrick, S.; Gelatt, C. D.; Vecchi, M. P. (1983). "Optimization 
by Simulated Annealing". Science 220 (4598): 671-680. 
doi:10.1126/science.220.4598.671. JSTOR 1690046. PMID 
17813860. 

[2] Černý, V. (1985). "Thermodynamical approach to the traveling 
salesman problem: An efficient simulation algorithm". Journal 
of Optimization Theory and Applications 45: 41-51. 
doi:10.1007/BF00940812. 

[3] Metropolis, Nicholas; Rosenbluth, Arianna W.; Rosenbluth, 
Marshall N.; Teller, Augusta H.; Teller, Edward (1953). 
"Equation of State Calculations by Fast Computing Machines". 
The Journal of Chemical Physics 21 (6): 1087. 
doi:10.1063/1.1699114. 

 

 

Synchronization 

NOTE : This feature available in version 1.9.5.4.5. and above 

In ORA you can now work in synchronization between ORA's Main 
Interface and ORA's Visualizer.  If you position a network 
visualization window in a manner where you can see the ORA main 
interface and or any of its visualization windows (e.g., Legend), you 
can then make changes directly into the Main Interface (e.g, such as 
changing links in the Editor) and that change will be immediately 
affect the visualization without any further action from the user. 
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WGS84 Maps 

WGS84 
WGS84 is based on satelite measurements. 

Glossary 
DMS : Degrees, Minutes, Seconds. Historicallly, maps have their 
scales in degrees and minutes. To use this with WGS it must be 
converted to decilmal form. 

WGS : Stands for World Geodetic System 

Map Datum : A smooth surface somewhat arbitrarily defined as 
zero elevation, consistent with a set of surveyor's measures of 
distances between various stations, and differences in elevation, all 
reduced to a grid of latitudes, longitudes, and elevations. 

Lat-Long : Stands for latitude-Longitude. For example, 50 
degrees and 29 minutes north, 123 degrees and 50 minutes west. 
Latitude-Longitude coordinates are sometimes referred to as the 
"geodetic grid" which we abbreviate to "Geo". Latitude is written 
first, followed by the longitude 

DMS - Degrees, Minutes, Seconds 
As there is no degree symbol [ ° ] on the keyboard we use a colon to 
separate degrees and minutes 50:27.5. Note can be only one colon. 
Use a dot is to separate the minutes from the seconds. 
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ORA's Main Interface 

The ORA interface is organized into five sections. The menu, the 
main icons, and three re-sizable panes which are dockable. On each 
tab are two buttons: undock and close. In the upper right corner of 
each pane are three buttons: undock, maximize, and close. This 
will allow you to arrange the interface to suit your needs. 

 

1 - The Menu 
The main source for accomplishing your tasks within the editor. It 
contains all the functions for managing the Meta-Networks, 
generating reports and doing analysis. 
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2 - The Icons 
Contains the main functions for adding or deleting Meta-Networks, 
Nodesets, and Networks and importing existing Meta-Networks. 
Clicking the down-facing triangle brings up a window which allows 
you to add buttons to the GUI for the functions you use the most. 

3 - Meta-Network Manager Pane 
This pane contains a tree directory of the current Meta-Network(s) 
loaded into ORA. This contains the Meta-Networks currently active 
plus all their Nodesets and Networks. Clicking on the plus icon will 
expand the Meta-Network showing all the Nodesets and Networks 
and clicking on the minus icon condenses the Meta-Network. 
Hovering the pointer over a graph it will display information about 
that Network. 

 

 

4 - Editor Pane 
Contains the basic information about the highlighted Meta-Network 
such as how many nodes are represented. This panel also allows 
quick access to ORA's Visualizer, Reports and Chart tools. By 
selecting the Visualize button, the currently loaded Network will 
render in the ORA Visualizer, which will load in a separate window. 

With the Meta-Network selected panel 2 displays the information 
regarding the Meta-Network itself. The Meta-Network name and 
pathway at the top. In the bottom, under statistics, are information 
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regarding the actual Meta-Network including source, node, link, and 
network counts. 

When a Meta-Network is expanded it reveals Nodesets and 
Networks. Highlighting any of these will reveal information these 
items. 

The Info Tab : Display relevant information whether a Nodeset or 
Network is highlighted. 

The Editor Tab : Displays the information in a matrix which can 
be edited in either binary or numeric mode. The data can be 
directly manipulated in the grid. Nodes, links, and attributes can be 
added, removed, or edited. 

With the Nodes and Attributes buttons you create, delete, or merge 
nodes and attributes. The Find box assists you in locating particular 
nodes and attributes. 

5 - Reports Pane 
This pane is initially empty when ORA is first started up. As reports 
are run they will be contained within this panel. 

NOTE : All three panes can be resized to your preference. 

 

 

Main Interface Tasks 

There are a number of tasks that are performed from within the Main 
Interface to assist in controlling your Meta-Networks, Nodesets, and 
Networks. These are mostly functions not associated with any of the 
Menu Items. 

Attributes : Adding or Deleting an Attribute and the uses of 
Attributes. 

Attributes Buttons : Controls in the Editor for Attributes. 

Clean Button : Helps combine nodes into a single node with slight 
variances. 



137 
 

Contextual Menus : Right-Clicking of several items brings up a 
contextual menu of additional functions for various items. 

Contextual Menus/Multi-Files : Selecting multiple Meta-
Networks and Right-Clicking. 

Contextual Menus/Network : Selecting Networks and Right-
Clicking. 

Contextual Menus/Dynamic Meta-Networks : Selecting a 
Dynamic Meta-Network and Right-Clicking. 

Creating New Meta-Networks : A brief overview of creating a 
Meta-Network. 

Create From Excel : Create a Meta-Network using Excel 

Dating Meta-Neworks : Attaching a date to your Meta-Network 

Document/URI Attributes : Using Links as Attributes. 

Duplicate Items : How to duplicate a Meta-Network, Nodeset, or 
Network. 

Editor Tab-Networks : Description of items and functions in the 
Editor Tab 

Editor Toolbar : Description of the Editor Toolbar functions.. 

Filters : Setting Filter parameters for searching Nodesets. 

Fold Network : How and Why to Fold a Network 

Hovering ToolTips : A brief overview of the information given in 
the tooltips. 

ID Names : Description of ID Names and why they are important. 

Info Tab-Nodeset : Editor Tabs for Nodesets. 

Info Tab-Networks : Editor Tabs for Networks. 

Info Tab-Networks-Statistics : Description of the statistics 
pane. 
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Network Editor : Working with the Editor tab with a Network. 

Node Buttons : Description of the buttons in the Editor GUI to 
work with nodes. 

Search : Finding information within the Editor. 

Visualize Buttons : The difference between Visualize this 
Network and Visualize Only this Network button. 

 

 

Aggregate KeyFrames 

 

I start out with the Star 
Wars dataset which consists 
of 1 keyframe and 23 deltas. 
Measures can not be run on 
this in its present form. 
 
The dates for this dataset 
run from the arbitrary dates 
10 NOV 2009 to 21 DEC 
2009. This gives up a choice 
on how to aggregate the 
data. The most obvious 
would be in either weeks or 
months. 
 
In this example we'll do it by 
months. 
 
Right-click on the icon with 
the clock to bring up the 
contextual menu and select 
Aggregate which brings up 
the Aggregate dialog box. 
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Select the radio button By 
period, make sure it says 1 
then from the drop down 
select Week [your choice of 
starting day]. 
 
We want to combine by 
Union so all links will be 
retained. 
 
Click [ OK ]. 

 

A new Meta-Network will be 
created containing two 
KeyFrames each containing 
one week of data as 
instructed. 
 
Now each of these 
KeyFrames can be analyzed 
individually with any 
measure.  

 

 

 

Attributes 

Attributes are extra containers that can be attached to an nodes in 
a Node Set. You can add a value to this container. To add an 
attribute to an Node Set right-click on the Node Set Name. This will 
bring up the contextual menu below. 
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Add Attribute 

 

Hightlight a Node Set the right-
click to bring up the menu. Then 
select Add Attribute... 

 

Type in the name for your new 
attribute and select the Type form 
the drop down menu. Your choices 
are Text, Text Category, URI, 
Number Category, Number, or 
Date. 
 
Then click [OK]. Let's say we want 
to add other languages spoken by 
the nodes. 

 

The attribute you added will be 
inserted alphabetically in the 
editor. 

 

You can now assign any text to this 
attribute for any of the rows in the 
Network which can be used later to 
help define your Network.</td 

Edit Attribute 
Click the downward triangle to bring up the filter/edit functions. Click 
the Edit Attribute tab. From here you can edit the Attribute name 
and Attribute type. 
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Delete Attribute 

 

And attributes can be removed just 
as easily by pressing the Delete 
button. The dialog box will present 
you with a list of attributes. Any 
attribute with a check mark next to 
it will be deleted from Meta-
Network. 

Import Attribute 
The [Import] button allows for the quick importing or an attribute(s) 
through the Editor panel. Use a .csv file with rows as nodes and 
columns as attributes. This can be done with, or without, an ID 
column. 
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1. Use the Textbox and Browse button to navigate to the csv file 
with the new attribute(s). 

2. Select the radio button to use either 1) an ID column, or 2) a 
file in the same order as Node Set. 

3. This section contains all the attributes in the file. If one was 
chosen to identify the Node Set then it will be greyed out. For 
attributes NOT greyed out you can chose to make then 
Categorical* or Continuous*. 

4. Select All / Clear All buttons places a checkmark in all 
columns or removes same. 

5. Placing a checkmark in the Create new nodes for 
unrecognized nodes creates new nodes into the select Node 
Set if no node for an attribute currently exists. 

6. Import / Cancel tells ORA to begin the import or cancel the 
operation. 
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Note: Whenever you set a Node Display Attribute for a 
Nodeset, the info is also set as an attribute of the nodeset.  In 
other words, Node Display Attributes are now encoded in the 
data, allowing it to be retained from session to session. 

 

 

Attribute Buttons 

Attribute Buttons 
Used within the Editor to manipulate the attributes of a Nodeset. 

 

Create : You will be asked for the name of the new attribute as well 
as the Type: Text, Text Category, URI, Number Category, 
Number, Date. 

Import : Import attributes from a file in the following format: 
columns contain values for a single attribute, and rows contain values 
for a single node. The first row must be attribute names. 
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Export :  

To a file : Click the [ Browse ] button and select a place to save 
the file. Place a check mark for the parameters Only export 
nodes missing an attribute value or Only export visible 
nodes. The attributes which have a check mark next to them will 
be exported to the file. 
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To a network : This allows you to create a new network. Select a 
property. Next you can either 1] select an existing Nodeset; or 2] 
select a new Node Class. Lastly give this a new Network Name. 
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Delete : Ora will list the attributes. Place a check mark next to the 
attributes you want to delete and remove the check mark from 
attributes you want to keep. 

Measures : Select the measure and input network to compute and 
the name of the new attribute to create. 
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Clean Button 

When large datasets are created people's names are after written 
differently through many different documents. For example you could 
see someone referred to as John in one documents, John Smith in 
another doucments, and John W. Smith in yet another document. 
All three of the these names refer to the same person but in ORA 
they would be considered different individuals. 

The [Clean] function is used to condense all the different referenes 
of one person into a single node. In the example below there are 
three instances for Colonel Jack O'Neill (Colonel Jack O'Neil, Jack 
O'Neil, and Jack), three instances for Major Samantha Carter (Major 
Samantha Cater, Samantha Carter, and Sam), Two instance for 
Doctor Daniel Jackson (Doctor Daniel Jackson and Daniel Jackson) 
and finally two instance for General George Hammond (General 
George Hammond and Hammond). 



148 
 

 

Visualizing this network makes it appear there are quite a few more 
people there actually are in the network (12 as opposed to 5). 
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The Clean Button 
The clean button has multiple functions. Clicking the downward 
triangle will reveal the menu. 

Deduplication 

Find and merge nodes with similar IDs or Titles. Similarity is based 
on edit distance which is the number of characters that would need to 
be changed to convert one string to another. 
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From observing in the Editor 
there are three instances of 
the agent Jack : Colonel Jack 
O'Neill, Jack O'Neil, & Jack. 
With the distance set to 0 the 
only agent visible is Colonel 
Jack O'Neill 

 

Increasing the Min-Edit to 9 
makes visible a second agent, 
Jack O'Neil. The difference 
between the two agents in the 
spelling of the surname (one 
(l) as opposed to two (l)s) and 
the rank. Clicking the 
[ Merge ] button will combine 
these two together into a 
single node. 

Apply Change List 

Apply a previously created Change List to the selected Meta-Network. 

View Changes 

View the current Change List. Click the [ Clear ] button to clear all 
changes. 
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NOTE : The Change File can be edited in either Excel or a text editing 
program. 

Save Changes 

Allows you to save any modifications that have been done to the 
current Change List. 

Entire Meta-Network 

Opens up the Clean Function found on the main menu Data 
Management > Meta-Network Clean... from where you can work 
with all Nodesets. 

The Merge Button 
After running the deduplication and merging any duplicates possible 
the final stage is to use the merge to combine any that may not, for 
various reasons, be caught by the deduplication process. Place a 
check mark in the tickybox next to each node to merge then click 
[ Merge ]. 

When merging nodes you will be asked for a new ID and Titles and 
also how to handle the links. There are four options for combining the 
links of merged nodes. 
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• Sum : Add the weights of all nodes. 

• Minimum : Examines the link weights and uses the smaller 
number found. 

• Average : Examines the link weights and uses the average of all 
the link weights. 

• Maximum : Examines the link weights and uses the largest 
number found. 

• Binary : If any link is a non-zero then the link becomes a [1]. 
Else it uses [0]. 

There is also an option to record the merged nodes as aliases  

After The Clean And Merge 
When you are finished with the Clean & Merge your editor grid will 
reflect the changes. Plus you will see a new columns, alias. This will 
contain all the node Titles/IDs that were eliminated during the 
process. 

 

Final 
After going through the entire Meta-Network and merging all the 
same people into single nodes I have ended up with a total of five 
nodes instead of 12 nodes. 
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Contextual Menus-Meta-Networks  

Right-clicking on any Meta-Network, Nodeset, or Network brings up a 
contextual menu with the functions available such as add or delete. 
And within each contextual menu are specialty functions for Meta-
Networks, Nodesets, and Networks. 

The first four are self-
explanatory. Transform… opens 
up the Meta-Network 
Transform… dialog box. 

 

The first two are self-
explanatory. The Add 
Attribute … item opens up the 
attribute function in order to 
add attributes to a Nodeset.  

Adding and Removing a 
Network are fairly self-
explanatory. Below is a 
description of the other 
functions. 

 

• Set Diagonal… : Used on a square network to set cells 1,1 
through x,x to the same value. In binary view the choice are 1: 
True (+1) 2: True (-1) 3: False (0). In Numeric view you 
can put any value into the diagonal. 
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• Transpose : Rotates axis X 90 degrees clockwise and mirrors 
the image horizontally. 

1 2 
  <- becomes ->   

1 3 

3 4 2 4 

1 2 

  <- becomes ->   

1 3 5 

3 4 2 4 6 

5 6 empt
y 

• Fold Network… : This function creates a new network using 
matrix algebra. Below are four variations of a four x four 
network and the results when each is folded. 

 

• Save Network… : (also called Exporting a Network) Any 
Network can be saved individually to a file in one of the 
following formats: CSV*, DL, DyNetML*, or UNCINET 
(.##h). Also check File Formats for more information 

• Binarize Network : Turns all non-zero numbers to [1] and 
leaving all [0] untouched. 

• Remove Links… : Removes links in accordance to the selection 
in the dropdown menu (as seen in the images below). 
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• Symmetrize… :  

 

 

Contextual Menus-Multi Files 

Includes: Union Meta-Networks, Intersect Meta-Networks, Conform 
Meta-Networks 

There's also a separate contextual menu when you've got two or 
more Meta-Networks selected. Open up multiple Meta-Networks in 
the Main Interface. Load two or more files into Panel 1. We'll 
demonstrate this on two Meta-Networks containing Bob, Carol Ted, & 
Alice. The agents are identical but the tasks in each are different, 
except for driving which appears in both and has slightly different 
values. Inbetween the time of cookingIn and eatingOut Alice's 
feelings for Ted have grown. 

CookingIn and 
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EatingOut 

 

 

Highlight both of them by holding down the [Control] while clicking 
on each file. Then Right-click on one of the files. This brings up the 
contextual menu. 
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The Add New Meta-Network & Remove Selected Meta-Network 
are self-explanatory. 

The Union Meta-Network will create a new Meta-Network using 
one of five actions: sum, binary, average, minimum, or 
maximum. 

 

• Sum : In any identical network all values from all networks are 
added together. (i.e. bob's score of 4.0 in both meta-networks 
are added together for a total of 8.0). 

 

• Binary : Then in the binary option it doesn't matter what 
numbers appeared in either meta-network as it uses only 1 or 
0 as a result. If any cell has a non-zero it will contain a 1 as a 
result. 
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• Average : This option takes the sum of all identical cell 
values and divides them by the number of cells used. In 
cookingInted x alice contained a 2 while in eatingOut the 
value for ted x alice was a 1. This was averaged out to 1.5. 

 

• minimum : This function finds the smallest value in any 
identical cells and uses that in the final result. (i.e. for ted x 
carol and ted x alice both cells use the smaller value of "1" 
even though they are from different meta-networks. 

 

• Maximum : This function finds the largest value in any identical 
cells and uses that in the final result. (i.e. for ted x carol and 
ted x alice both cells use the larger value of "2" and "3" 
respectively, each taken from a different meta-network. 

 

Intersect Meta-Network works similar to the Union function and 
has the same five options. But in creating the new Meta-Network only 
nodes that appear in all Meta-Networks are carried over to the new 
Meta-Network. 
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For example: All four agents appear in both Meta-Networks and are 
brought over into the new Meta-Network. But though there were six 
tasks in the cookingIn and three tasks in eatingOut there is only 
one task (driver) in the new Meta-Network created from the 
intersect function. Only nodes found in all Meta-Networks are brought 
over. 

 

And even though bob has a value for driver in cookingIn only carol 
has a value for driver in both Meta-Networks. 

 

Conform Meta-Network alters the selected Meta-Networks and 
makes them equal. union adds nodes that are found in one Meta-
Network but not the other. intersect removes nodes that are not 
common to both. 

 

 

Contextual Menus-Networks  

Right-clicking on any network brings up the contextual 
menu with a set of functions for working with 
Networks. 

 

Hide selected 
Select one or more rows or columns. Then right-click to bring up the 
contextual menu. Selecting Hide Selected will remove the selected 
rows or columns from the display. 
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NOTE : They are hidden for as long as you have the current network 
viewed. Clicking anywhere else in the Editor then returning back to 
the previous Network will reveal all rows or columns which were 
hidden. 

Sort 

The order which nodes are displayed is the 
default order they were entered. ORA gives you 
four different ways to display these same 
nodes.  

• Ascending by Title A↓Z : Arranges nodes 
in alpha order lowest to highest. 

• Ascending by Link Count : Arranges 
nodes in order of number of links from 
lowest to highest. 

• Descending by Title Z↓A : Arranges 
nodes in alpha order highest to lowest. 

• Descending by Link Count : Arranges 
nodes in order of number of links from 
highest to lowest. 

 

NOTE : Nodes will retain their sort order for the duration they are 
displayed on the screen. Changing this view and returning to a 
network will place the nodes back in their original order. 

Hightlight 

Highlights or clears selected nodes.  
• Clear all : Clears the highlight from all nodes. 

• Clear selected : Clears the highlight from only 
the selected nodes. 

• Hightlight selected : Highlights all nodes 
currently selected. 
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Example 
First I sorted the agents by [Right-Clicking] on any agent and 
selecting Sort > Descending by link count so the nodes with the 
highest numbers of links would rise to the top. I clicked on 
paul_atreides, counted down ten agents, and [Shift-Clicked] on 
thufor_hawat. This selected the ten agents with the most links. 

 

Hovering over any of the selected agents I [Right-Clicked] bringing 
up the contextual menu. I select Hightlight > Highlight selected. 
This placed a yellow highlight over the top ten agents. 

 



162 
 

I wanted the list sorted by name again so I [Right-Clicked] and 
selected Sort > Ascending by title.  

 

NOTE : Highlighting works in the same manner with regards to 
columns. 

 

 

Contextual Menus - Dynamic Meta-
Networks 

The Meta-Network with a Clock signifies a special type of Meta-
Network. 



163 
 

In the Meta-Network Panel click the [+] button to the left of the icon 
to expand the contents. Clicking on any of the just revealed icons will 
display te contents of the individual components. The first one (with 
the regular Meta-Network icon) contains the general data. Each of 
the other components are the individual timeslices within the dataset 
which also contain the same number of Nodesets and Networks. 

Right-clicking on any Meta-Network with the clock icon brings up the 
contextual menu to work with these types of files. 

Contextual Menu for Dynamic Meta-
Network 

Remove Selected : Remove selected Meta-Networks from ORA. 

Import Keyframes... : Merges the new Keyframe into the 
Selected Meta-Network based on the new date. If the new 
Keyframe has no date it will be placed at the beginning of the 
Dynamic Meta-Network. 

Import Keyframes as deltas... :  

Create a new delta... : Add new delta either at the end of the all 
time periods or inserted after a specific date. 

Aggregate... : Combine data from individual parts of Meta-
Network determined by parameters. 

MetaNetwork Transform... : Use to transform each keyframe in 
the Dynamic Meta-Networlk according to the parameters selected. 

Contextual Menu for Keyframe 
Add New Meta-Network : Create Blank Meta-Network 

Remove Selected Meta-Network : Remove Selected Meta-
Networks from ORA. 

Add New Node Class... : Create Blank Node Class in Selected 
Meta-Network.  

Add Blank Network... : Add blank Network to Selected Meta-
Network 
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View Status :  

Meta-Network Transform... : Use to transform each keyframe in 
the Dynamic Meta-Networlk according to the parameters selected. 

MetaNetwork Anonymize... :  

Contextual Menu for Other Deltas 
Insert Keyframe : Inserts new KeyFrame after Selecte Delta. This 
Keyframe will containall the information from the previous Delta 
which can then be modified by additions, Deletions, and 
modifications. 

Convert to Keyframe : Converts a Delta into a Keyframe. 

NOTE : You can not convert a Keyframe into a Delta. 

Create New Delta : Create a new Delta. You can choose to add 
one to the end of the time by various increments or use the 
Custom date function to insert it into the list. The new Delta will 
contain all the information from the previous Delta or Keyframe. 

 

 

Create a New Meta-Network 

What follows are procedures for creating a new Meta-Network. 

There are times you need to run measures on or visualize only part of 
an existing Meta-Network. This section will show you the easy way to 
create sub-sets of an existing Meta-Network. 

First duplicate the Meta-Network. Highlight the Meta-Network 
then from the main menu select Edit > Copy Meta-Network. Then 
from the main menu select Edit > Paste Meta-Networks. It would 
be a good idea to rename this new Meta-Network immediately so as 
to not get it confused with the original. You can do this in the Editor 
tab, see Renaming. 
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Next, expand the Meta-Network you want by clicking the [+] if it 
isn't expanded already. Highlight the Nodeset with the nodes you 
want to remove. 

 

In panel 2 select the Editor tab which brings up the matrix with 
nodes on the vertical and attributes on the horizontal. Below each 
attribute is a <set filter>. Below left is the stargate_summit 
meta-network along with the ally attribute. I wish to make a new 
meta-network of the good guys only. In the dropdown menu under 
ally I select no. These are the nodes I want to remove. 

 

Place a checkmark in the box of each node. Below the matrix in the 
section called Nodes are three buttons. Click the [Delete] button. 
The Nodeset now contains only the nodes that had yes in the 
attribute ally. 
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With this same procedure I created a Meta-Network of only the 
allies. 

 

Create Meta-Network from Excel File 

If you don't have a Network, you can create one from scratch. Below 
is step-by-step instruction on how to do this in Excel. 

We will create an square, agent-by-agent Network. We say it is 
square because all row headings correspond directly to column 
headings. This is important as it relates to specific measures ORA can 
run on a graph. If the graph is not square, some measures will not 
work. 

Open a blank Microsoft Excel work book. In column A we will enter 
the name of all the nodes that make up our social network or 
organization. 

NOTE : When creating your spreadsheet, do not add any additional 
titles, notes, or other headings, which will interfere with the "square" 
properties of the Network. 

 

Next, create column headings using the correlating names as they 
appear in row headings. Again, this will ensure that our Network will 
be square. 
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Next we will create links between each agent. We do this by entering 
a 1 if a direct connection or relationship exists and a 0 if it does not. 
Please note that headings that cross-reference themselves are 
considered redundant and thus are left blank or 0. 

In the example below, Redundant cells [ i.e., the diagonel ] are 
filled in with red strips to illustrate the self-loops. This redundancy 
should continue as a smooth diagonal line from the top left corner of 
your Network to the bottom right. 

 

NOTE : If you don't end up with a diagonal line then your graph is 
not square. 

Using 1s and 0s to establish link, complete your spreadsheet. 

In the Network example, we have assigned links randomly. Within 
your organization or network, however, you can describe any direct 
connections or relationships you are interested in analyzing. For 
instance, you may determine that a direct connection exists if agents 
within your network consult with each other at least once a month; 
literally, it can be anything you decide. 

Below is our completed Network (The red fill illustrates cells that do 
not require input due to their redundancy*). 
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Now that we have essentially built a Network from scratch using 
Excel, the next step is to save it in a compatible file format ORA can 
interpret. For Excel spreadsheets this will be the CSV* file format. 

From the main menu select File ⇒ Save As 

Make sure you save this file as a CSV (comma delimited) 

You have now created a Network from scratch which can be loaded 
into ORA. 

Now return to ORA and load up your new Network. Below is a our 
new Network rendered in the ORA Visualizer. Notice the arrows only 
point from one node to another if there is a 1 in the column for a 
particular node. i.e. There is a "1" in the bob column for ted but 
a "0" in the ted column for bob. So an arrow points from ted 
to bob but NOT from bob to ted. 

 

For a more in-depth explanation for creating Meta-Networks see the 
lessons section under Meta-Network. 
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Create New Node 

With the [Create] button in the editor you can create any number of 
nodes at one time. But there are times you only need to insert a 
single node into a Nodeset. Such as while building a dataset you 
forgot to include it in the original construction. ORA gives you a quick 
method of adding a single node. 

 

Below is the small Star Wars set containing 11 agents. And for some 
reason you needed to include a 12th agent, say Jabba the Hutt. 
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I typed jabba_the_hutt into the Search box and since he's not in 
this set ORA display no nodes. But notice to the right of the Search 
box a [Create a new node] button has appeared. If the node you 
want does not exist this allows you to instantly add it to the Node 
Class. 

 

Upon click the [Create a new node] button the Jabb_the_hutt node 
is added to the bottom of the list. 
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Dating Meta-Networks 

Certain functions require a Meta-Network to have a date attached to 
it. These include: Measures Over Time, Networks Over Time, and 
Loom. To add a date first highlight the Meta-Network. In the Editor 
pane find Meta-Network Date. Click on the [Click to create...]. 

 

Now you can set the parameters for the date which include year, 
month, day, and time. 

Remove Meta-Network date 

 

If, at any time, you need to remove the date from a Meta-Network 
click on the [X] to the right of the date. 

 

 

Delimited Files 

Excel, when reading in a flat file (i.e. txt or .csv), is sensitive to the 
kind of delimiter used. In the American version of excel, it assumes 
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that a comma or tab is used to separate columns. In other versions, 
it often assumes that a semicolon or tab is used to separate columns. 
This is because in many other languages the comma is used as a 
period in showing the price of items. 

AutoMap and ORA export data as comma separated and can import 
comma separated. This means if you are reading into or reading from 
a non-American version of excel you may have problems. 

Reading in the.csv file into Excel that uses something other than 
commas will cause the data to appear as a set of text in column A. 
There are two ways to fix this. 

NOTE : And if you data contains commas change to another 
character before changing the delimiting characters to commas. 

First read the file into a text editor and globally change all the 
delimiting characters to commas. 

Second read the file into excel and use the Text to Columns 
function and use a different delimiter. 

Excel Example 
Let's start with a simple three line file using semicolons as delimiters. 

NOTE : Remember, data can be separated with a variety of 
characters. This procedure allows you to import data with any of 
them. 

100;apple;red 
101;lime;green 
102;lemon;yellow 

Opening this file in Excel will place each line of text into a single cell. 
You need to separate this into individual columns. 
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Select the cells you want to convert then click the Data tab. Click the 
Text to Columns function. 

 

This brings up the Convert Text to Columns Wizard. Make sure 
the Delimited radio button is selected. Then click [ Next > ]. 
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Under the Delimiters header make sure the Semicolon box 
contains a check mark. In the Data previewarea it will show you 
what your data will look like after the conversion. Click [ Next > ]. 

 

Lastly you can do some final tweaks to how your data will be 
converted if you want such as your data format or a different 
destination. In this example we want the data to be inserted back 
into the original starting cell. Click [ Finish > ]. 
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Each piece of data now resides in a separate cell. 

 

The new file can now be imported into ORA through the Data Import 
Wizard. 
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Document/URI Attributes 

The following instruction demonstrates how to add a document 
attribute or a URI to a Node. 

Adding a document links in the Editor 
Load a Meta-Network into ORA. Then expand the Meta-Network using 
the [+] icon to display all the Nodesets and Networks in the Meta-
Network. Then right-click on a Nodeset and this will access the 
contextual menu. From here, select Add Attribute. Give the new 
attribute a name. 

In Pane 2 click the Editor tab to display the matrix and find the new 
attribute just created. All cells will be empty. A new pathway can be 
inserted in the cell at this time. 

Once the node title has been changed, you can now enter a URI 
directly inside the corresponding blank field. This can either be an 
absolute pathway to a document on the user's hard drive or a web 
URL. 

Adding a URI in the Visualizer 
Visualize a Meta-Network, select a node, and right-click to access it's 
contextual menu. From the contextual menu select, choose URI 
submenu > Attach URI. This brings up the Add URI box where the 
new URI can be entered. 

When viewing the Meta-Network in the Editor a new column appears 
with the title you inserted in the field Name:. 

NOTE : When using a absolute path to a document the link will not 
work if the Meta-Network is opened on another computer. It's much 
safer to use URIs from the internet to connect documents. 

The same document pathway can be used for multiple nodes. 

When the Meta-Network is displayed in the Visualizer the document 
URI will appear in the Node Status tooltip. You can go to this URI by 
right-clicking a node and use the URI submenu to Go To URI. A new 
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explorer window will be launched showing the location of the 
document file. It can then be opened with the appropriate program. 

Multiple URIs/URLs 
A node can have multiple URIs and you can still launch from the URI 
SubMenu. The preferred method for launching URIs is through the 
Node Status dialog where you can choose an individual URI to 
launch. 

There's a new URI tab that allows you to view URI's, launch them, 
and add new ones. When adding new ones, the current convention is 
to create a new Attribute with name URI-X, where X is the earliest 
number that doesn't already exist. So, adding a URI to nodes will 
create results such as URI-1, URI-2, etc. Currently, when finding 
URI's to \launch, only those that follow the above convention are 
included, but it will be expanded to include any attribute with URI or 
URL in it anywhere. 

 

 

Duplicate Items 

ORA allows for the quick duplication of Meta-Networks, Nodesets, and 
Networks. It uses the Copy and Paste commands but some aspects 
work in a different manner than most users are familiar with. 

Meta-Network 
Duplicating a Meta-Network can be done with the menu, Edit > Copy 
Ctrl+C then Edit > Paste Ctrl+V. This will create a duplicate of the 
highlighted Meta-Network. And as the menu items show you can also 
use the keyboard shortcuts, Crtl+C and Ctrl+V 

There is also a method for duplicating two or more Meta-Networks 
simultaneously. Hightlight all the Meta-Networks you need to 
duplicate. Press and hold the [Alt] key. Place the mouse cursor over 
one of the highlighted Meta-Networks then Click and hold. Drag the 
cursor into an unused area of the Meta-Network Manager pane and 
release the mouse button. All highlighted Meta-Networks will be 
duplicated. 



178 
 

Nodesets and Networks 
Using the Menu items Edit > Copy Ctrl+C and Edit > Paste Ctrl+V 
work differently with Nodesets and Networks. This can be used to 
either create new Meta-Networks or duplicate Nodesets and Networks 
in existing Meta-Networks. 

This leads to an interesting side benefit. You can highlight Nodesets 
and Networks from different Meta-Networks, Copy, and Paste. This 
will create a new Meta-Network with all the highlighted items. 

Create new Meta-Network : As with Meta-Networks click, hold and 
drag a Nodeset(s) or Network(s) to an unused space in Meta-Network 
Manager pane. Upon releasing the mouse button ORA will create new 
Meta-Networks containing those Nodesets and Networks. 

NOTE : If you highlight two Nodesets or Networks with the same 
name ORA will ask you to give the second one a different name. 

Add to existing Meta-Network : Dragging a Nodeset or Network to 
an existing Meta-Network will add that Nodeset or Network to the 
new Meta-Network. If that Nodeset name is currently in use ORA will 
as you to rename the Nodeset or Network you want to append. 
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Editor Tab-Network 

 

Convert Links :  
This allows you to manipulate the line weights of your network. 

Binarize link weights : (x ≠ 0 ⇒ x = 1) 

Collapse link weights : (a ≤ x ≤ b ⇒ x = 1) 

Negate link weights : (-x) 

Invert link weights : (1/x) 

Logorithm of the link weights : (log10(x)) 

Absolute value of the link weights : (|x|) 

Scale the link weights : (c * x) 

Row-Normalize the link weights : (x/OutDegree) 

Increment the link weightsSubtract the link weights : (c + x) 

Subtract link weights : (c - x) 
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Remove Links :  
Remove all links : As it states, all links will be removed from the 
Network. 

Remove links by value : Allows you to choose a value then the 
method in which to remove links which match. 

Remove self-loops (diagonal) : Removes all links from a node 
to itself. NOTE : Only works on symmetric Networks. 

Highlight :  
Clear all : Clears all highlights from editor. 

Hightlight Isolates : Highlights on yellow any nodes not 
connected to any other nodes in the Network. 

Hide :  
Show all : Displays all hidden nodes and links 

Hide highlighted rows : Any rows that are highlighted yellow will 
be hidden. 

Hide highlighted columns : Any columns that are highlighted 
yellow will be hidden. 

Display Options 
Binary link values : Changes the grid to display check boxes. If a 
link exists, regardless of the weight, a check mark will appear in 
that cell. 

Numeric link values : Changes the grid to display cells. The 
weight of the link will be display as a negative value, 0, or a 
positive value. 

Display row sums : Creates a column to the right of the row 
names and displays the sum of all links in that row. 

Display column sums : Creates a row below the columns names 
and displays the sum of all links in that column. 
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Show List/Show Matrix 
Toggles between displaying the matrix of links with the list of links. 

Search nodes... drop down:  
Search nodes... : Using the AND/OR drop down you can search 
for ALL or ANY of the terms in the box. 

Search nodes... : This doubles the capacity for searching and 
gives you two search boxes and AND/OR options. It allows you to 
make a finer tuned search. 

Find a link... : Select a node from each drop down box and ORA 
will locate the cell corresponding to that link. 

Results drop down :  
Highlight Results : Highlights in yellow the results of your search 

Show Results : Shows only the results of the search. All other 
nodes will be hidden. 

Hide Results : Hides the results of a search showing only nodes 
and links that do not match. 

Highlight Matches 
Highlight Matches highlights the row or column in a pale yellow 
tint. 

Show only matches hides any node which does not match the 
search parameters. 

Hide matches hides any node which does match the search 
parameters. 

 

 



182 
 

 

Editor Toolbar 

 
 

 

To help facilitate your workflow 
ORA allows you to 
mount/unmount tool buttons in 
the Editor's toolbar (and also in 
the Visualizer toolbar). Click the 
down-triangle to open the dialog 
box. 
 
The Configure Toolbar dialog 
box will appear. You will notice 
that some items are already 
checked. These correspond to 
the buttons already present. 
Placing a check mark next to any 
tool instantly mounts it on the 
toolbar. Removing the check 
mark from a button instantly 
removes the button. 

When you are finished click [Close]. 
 
If at any point you can select the [Restore Default] button which will 
remove all the changes you made and restore the toolbar to the buttons 
found in the image at the top. 

NOTE : The buttons appear from left to right in the order you select 
them. You can not re-arrange buttons once they are placed on the 
toolbar. 
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Filters 

Use of this function allows you to reduce the number of nodes that 
appear in the Editor. By clicking the double up-pointing arrows in the 
top right of the Editor pane you will reveal the filtering tabs. Using 
the [+] you can add additional filtering parameters. Likewise you can 
remove filters by using the [X] 

General Filter 

 

The General Filter works across all columns. Think of it as a blunt 
force filter. The terms you are searching for are either In or are not 
in the dataset. 

Attribute Filter 

 

With the Attribute Filter you can do finely tuned searches specifying 
whether a term is foun, or not, within a specific attribute. 

NOTE : At any point you need to backtrack or start over select the 
General Filter tab and click the [Reset] button. 

General Filtering 
Here is the character Nodeset from part 7 of the Foundation dataset. 
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Using the General Filter on the Foundation dataset we'll use it to find 
the military officers on the world Kalgan. Note that Kalgan is in the 
attribute HomeWorld and police is in the attribute profession. After 
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typing kalgan into the search box ORA filters out all entries which do 
not contain the world kalgan. 

 

Next military is typed into the search box. Remember to leave a 
space in-between each word. And since Match all is selected ORA 
filters out all entries with do not include BOTH kalgan and military. 
Only one entry corresponds to both. 

 

Now let's change the conditions from Match all to Match at least 
one. Now every entry which has either kalgan -OR- military shows 
up. 
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Attribute Filtering 
Single Attribute Filter : Click the leftmost drop down and select 
profession. Click the middle drop down and select is one of. Type 
politician or spy into the textbox. Four characters fit this filter and 
are displayed in the Editor. 
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Multiple Filters using AND : The search can be further refined by 
adding additional parameters. Click the [New filter] button to create 
a second filter parameter. It will appear directly beneath your first 
filter. Click the leftmost drop down and select home world. Click the 
middle drop down and select is one of. Type terminus into the 
textbox. This eliminates the character portirat_hart from the search 
as there is no home world specified for that character. 

 

Multiple Filters using OR :  

Leaving the filter parameters the same we'll now change the 
condition from AND to OR. This means that a character will be 
displayed in the Editor if either the profession or home world match. 

 

 

 

Fold Network 

Folding a Network can answer questions about a Network such as 
which agents have the most common knowledge. Folding a 
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Network multiples the network by its transpose. The result is an 
agent x knowledge network whose links are the number of 
knowledges in common for the agents. 

 

Fold a network select the Network in the Meta-Network Manager Pane 
and right-click. From the contextual network select Fold Network. 
From the dialog box select the Fold Method and Compare options. 
In the Network ID give the new Network a unique name. 

 

The new Network is agent x knowledge - Shared Knowledge. 
This will appear in the Meta-Network Manager pane. 
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Examining the Network in the Editor will show the diagonal gives the 
number of knowledges each agent has. The off-diagonal contains the 
knowledge agents have in common. 

Creating a transpose and then doing the multiplcation could also be 
done manually in the Matrix Alegbra tool under Data Management. 
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Hovering - Tooltips 

Hovering the pointer over 
various parts of the panels will 
reveal information about the 
Meta-Network. 
 
Hovering over the parts in Panel 
1 will reveal different 
information about the Meta-
Networks, Nodesets, and 
Networks. 
 
Hovering over the Meta-
Network reveals the name. 
 
Hovering over a Nodeset Name 
reveals the Node Class and size. 
 
Hovering over a Network 
reveals the network's source 
and target and the link count. 

 

 

 

Names 

Working with Names 
Each Meta-Network, Nodeset, and Network can be given a distinct 
Name. At times this can be very helpful when working with multiple 
Meta-Networks it can also cause problems with certain functions. 
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Here I renamed one of the Nodesets to those guys. It is also 
reflected throughout all of Meta-Network Panel. You can rename any 
Meta-Network, Nodeset, or Network for better readability. 

Areas where it's important to maintain 
Name ID integrity 
View Measures Over Time : This function allows an analyst to see 
how a network measures change over multiple time periods. So in 
order to track measures over time it is necessary that the ID Names 
of the Networks are the same in all instances. 

View Networks Over Time : This function allows you to set up 
multiple Networks that encompass various time frames and view 
them in succession. Since you want to see what happens over the 
same Network Over Time it becomes virtually important to make sure 
the ID Names of these Networks are all the same. Else ORA will not 
be able to analyze them correctly. 

Comparing Networks : When ORA runs measures on Networks it's 
sometimes necessary to do have identical Network names. This will 
be listed in the Measures section. 

 

 

Info Tab - Nodeset 

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly 
designed to display information regarding the Meta-Networks, 
Nodesets, and Networks. But this is the area where you can rename 
the Nodeset Name and change the Nodeset Class to a different 
MetaOntology. To rename a Nodeset place the cursor in the box, 
make sure the entire name is highlighted, and type in your new 
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name. The Display nodes by function determines what attribute will 
be displayed when visualized. 

This area also gives you the Node Count of the selected Nodeset as 
well as the Attribute Names contained within the Nodeset. 

The Display nodes by dropdown allows you to select the text that 
will be display for the nodes of this Nodeset in the Visualizer. Each 
Nodeset can be set individually. 

 

The Editor tab contains most of the editing functions. 
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The Search box (with the magnifying glass) is for finding particular 
node(s) in a Nodeset. 

The Set filter (the downward facing triangle) is for displaying only a 
particular sub-set of node(s). 

The Check boxes to designate which nodes to Delete or Merge. 

The Nodes buttons are to Create, Delete, Merge, Move, and Clean 
nodes in a Nodeset. 

The Attributes buttons allow you to Create, Import, Export, Delete, 
and add measure values to a Nodeset. 

The Meta-Network Create button will create a blank Meta-Network 
based on the nodes in the Editor. You can select either or both 
Visible nodes and Selected nodes. This is noted near the bottom 
of the frame. 
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Info Tab - Network 

When a Network is selected there are also two tabs, Info and 
Editor. 

The Info tab contains a textbox, Network ID in which you can 
change the name of any network, The Source and Target Nodesets, 
and whether this network is directed or not, the Link Count, and the 
Density. 

The two buttons underneath allow the choice of Visualize this 
Network which will send the entire Meta-Network to the visualizer or 
Visualize Only this Network which display only the currently 
selected Network. 

Below is an image of InfoTabs and Editor Tabs in ORA.  
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Network ID : Allows you to rename the network. 

Source class : Displays the source Nodeset i.e., the leftmost column 
in the graph. 

Target class : Displays the target Nodeset i.e., the topmost row in 
the graph. 

Network Properties: Symmetric, No Self-
loops, and Binary link weights 
Place a check mark in the box(es) which you want to include. 

Network Statistics 



196 
 

Gives information regarding the selected network. 

When computing measures: 
The purpose of this is to let the user tell ORA what links should be 
used and how they should be interpreted when computing measures, 
as this affects the results. The areas are: Symmetric/Or Not, Self-
loops/Or Not, and Binary/Weighted. 

If you want ORA to treat the data as symmetric if it is symmetric, 
then use Auto-Detect. This option will test if the network is 
symmetric, record the result, and use that result when computing 
measures. The same goes for binary and self-loops. If all the links in 
the network are of weight one, then the network assumed to be 
binary (but if there is a link with a weight other than one, then it is 
assumed weighted). Lastly, if the network has no self-loops, then it is 
assumed it cannot have any. 

If, for example, there just happens to be no self-loops, but there 
could be, and the user wants the measure to take that into account, 
then the user would select TRUE. On the other hand, if are self-loops 
and they should always be ignored, then the user can choose FALSE. 
Note that FALSE does not change the network data in any way, but 
the measures just ignore the loops. 

The Editor tab has two views: Binary and Numeric.  

Binary view is used when you only need to establish a connection 
between two nodes with no weights. It's a simple Yes or No 
arrangement. 
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The Numeric view allows you to treat links between various nodes 
with more or less importance. Notice that all the row nodes have a 
check marked connection to the column containing [yu] in the 
binary mode. This denotes they know one another. But in the 
numeric mode this value is a 0.5 which is used to denote previous 
acknowledgement but is an adversary. 
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The Convert Links button contains options for converting links in a 
Network. 

Binarize link weights ( x 0 -> x = 1) 

Collapse link weights (a=x=b -> x = 1 

Negate link weights (-x) 

Invert the link weights (1/x) 

Logorithm of the link weights (log10(x)) 

Absolute value of the link weights ((|x|) 

Row-Normalize the link weights (x/OutDegree) 

Increment the link weights (c + x) 

The Remove Links buttons deletes all links for the selected condition 
and the value of the links you wanted removed. 

 

Less than 

Less than of equal to 

Equal to 

Not equal to 

Greater than or equal to 

Greater than 
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Info Tab-Network-Statistics 

The Info Tab : Display relevant information whether a Nodeset or 
Network is highlighted. 

 

Network Properties 
Symmetric (undirected links) : Create additional links to maintain 
symmetry of the Network. [e.g. you create a link A > B and ORA 
would automatically create the link B > A of the same weight. 

No self-loops : Disallows a link to be set back to node to itself. 

Binary Link Weights : This will set all link weights that are not [0] 
to [1] 

NOTE : Changing these options for existing networks can have huge 
impact to your data. Changing a network from weighted to 
unweighted will set all link weights wuv to 1.0. These options also 
have implications for the editor. If the option is set to directed 
network then changing the value wuv in the matrix will automatically 
change the value wvu. 
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Select how to treat links when computing 
measures: 
You can use this to control how Links and Properties are handled for 
each individual Network when measures are run on the networks. 

NOTE : These options are "temporary" version of the network 
properties. They do not affect the actual Meta-Network. 

Under Select how to treat the links when computing measures: 
you can select between True, False, and Auto-detect. 

Treat as symmetric : Symmetrizes the network for the 
calculation, e.g., if the line weight wuv is larger than wvu then wvu -
> wuv. 

Ignore self-loops : All diagonal elements are set to 0. 

Treat as binary : The link weights for all wuv with wuv ? 0 are set 
to 1. 

The default setting for these is Auto-detect. If the network is 
symmetric, then when computing measures the network is 
considered as symmetric. Similarly, if the network has only binary 
link weights, then when computing measures the network is 
considered binary. The user can also explicitly set to True or False 
whether the network should be treated as symmetric, without self-
loops, or binary. 

To change the settings, select the network and change one or more 
of the three controls in the info window of a network in the section 
Select how to treat the links when computing measures.  

Whenever ORA calculates a measure (independent from which 
measure calculation you select) a network will be pre-prepared based 
on the settings of these primary measure parameters. These setting 
do not change the original data but the way ORA handles the data 
when calculating measures. To actually convert the data you can 
change the network parameters (see section 2) or use other 
procedures to have more detailed options (e.g. symmetrize by 
minimum value). You can find an introduction into these procedures 
in section 2.7. 
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Link Attributes 

Nodes can have various attributes like their location, gender, or other 
specialized information. Links can also have attributes. When you 
highlight a Network this reveals the Matrix of links. 

 

Click the [ Show list ] button at the top right to reveal information 
on those links. 

 

Click the [ Create ] button under Attributes. You can select the Type 
of attribute from the drop down menu. Give your attribute a name 
then select the type of attribute. 
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In the Editor you will see a new column. You can now enter in 
attributes for each link in the Network. 

 

 

 

Measure Charts 

 Below are examples of each type of ORA charts: Bar Chart, 
Scatter Plot, Histogram, and Regression. 

NOTE : The measures run can be changed by select from the main 
menu Analysis > Measures Manager. 

 

 

 

 



203 
 

Save Measures 

 

Use this button to save results measures to a text file. This file can be 
opened in either Excel or a text editor. ORA will not attach an 
extension to this file and it is suggested to give it either a .txt or 
.csv extension. 

Opening the File 
Opening this file in Excel, making sure to import it as a delimited file, 
will give you the measures it can use and the values associated with 
each node in the Nodeset chosen. You will notice that the names of 
the characters are characters_1, characters_2, and so forth. In 
this particular Nodeset the Node ID contained the text Character_ 
plus a number and the Node Title contained the actual name of the 
character. This function used the Node ID when it exports this 
information. 
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Network Editor  

With a Network highlighted and the Editor tab displayed ORA has 
many functions for working with nodes and links in a network. 

 

Search Nodes... 

 

 

Search type 1 
Using the Search box and the [AND/OR] selector you can refine a 
search on a Network. 
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With the [AND/OR] selector set to AND I type lady into the Search 
box. This results in two rows/columns being highlighted, 
lady_jessica and lady_fenring. 

 

To refine the search I type jessica into the Search box (making sure 
to place a space between the words). This eliminates lady_fenring 
leaving only lady_jessica highlighted. 

 

Without changing anything in the Search box I change the AND to 
OR in the [AND/OR] selector and it now reveals any node with 
either lady OR jessica. 
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NOTE : Idential search results were achieved with different 
parameters. 

Search type 2 
This search is similar as the primary search but with two Search 
boxes for added refinement. 

 

Find a link... 
Chosing two nodes in the two dropdown menus will locate the link in 
the matrix. 

 

NOTE : The box to the right of the node dropdowns is for setting the 
weight of the link. 
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Remove All Links : Removes all 
links from Network. 
 
Remove links by value : Allows 
you to set parameters for the 
values of links which you want to 
remove. 
 
Remove self-loops (diagonel) : 
Removes links connecting a node 
to itself/ 
 
Symmetrize by method : Gives 
for options : Maximum, Minimum, 
Sum, and Average. 

 

 
 
Convert Links : Gives options 
for changing the value of links 
in a Network. 

 

 
 
Clear all : Clears all highlighting 
from rows and columns. 
 
Highlight isolates : Highlights 
rows and columns of any node 
with has no connections to any 
other nodes in the network. 
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Show all :  
 
Hide highlighted rows :  
 
Hide highlighted columns :  
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Node Buttons 

Node Buttons 
Used within the Editor you can manipulate nodes in a Nodeset. 

NOTE : Any changes done to a Nodeset are permanent. There is no 
Undo. 

 

Create : Inserts a new node(s) into the Nodeset. You will be asked 
for the number of new nodes to create and a node ID. If multiple 
nodes are to created then a number will be appended to each new 
node. 

Delete : Removes node(s) and all associated link(s) from the Meta-
Network. There are four sub-options viewable by clicking the 
downward triangle. The nodes deleted are kept in a log which is used 
for creating a delete list. 

Merge : Removes all selected nodes and replaces them with a single 
node with all previous links and attributes. This is used primarily 
when data needs to be consolidated. Example : A Nodeset contains 
two nodes, jack and col_o'neill. These are actually the same 
person. Merge could combine their information into one which could 
be named col_jack_o'neill. 

Move : Move all check marked node(s) to another designated 
Nodeset. ORA will prompt you for the movement of links to other 
Networks that are associated with these node(s). 

NOTE : Information on both deleted nodes and merged nodes is kept 
in a log file which ORA used to create a Change List. 
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Clean : finds all nodes whose IDs are within the edit distance of the 
selected node. An edit is a change of a single character. 

 

 

Search 

Sub-Set of a Nodeset 
With the Search feature you can quickly locate specific nodes. Typing 
a term into the Search box will display all nodes with that term in 
their name or attributes. 

To the right of the Search box is the AND/OR selector. This is a 
boolean search tool. AND requires all terms in the Search box to be 
present in every node. OR will display all nodes with any of the 
Search terms present. 

NOTE : Be aware of how sub-strings work in searches. A search for 
male will find all values of male as well as female because male is 
a sub-string of female. 

Example 
When you start, all nodes will be visible in the Editor. Using the 
wildcards you can reduce and control what is displayed. 
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The [*] wildcard 
The use of the [ * ] tells ORA to find all nodes with the string 
enclosed by the astericks. That string can occur anywhere in the 
name. 

NOTE : Search requires the use of the wildcard character [ * ] both 
before and after the search term. 

 

NOTE : Highlights done to emphasize the search. ORA does not 
highlight these in the actual program. 
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NOTE : The Search functions works on the Nodeset as a whole 
meaning there's no selecting one single attribute to search. A term 
found anywhere marks that node to be displayed. 

The [?] wildcard 
Unlike the asterick the question mark substitutes for only a single 
character. In the example the first node is 3rd Officer Jane Blythe. 
Typing ?rd* tells ORA to search for the string rd which contains any 
one preceeding character and any amount of trailing characters. It 
locates three nodes which match 

 

Adding a second ? tells ORA to search for the string rd which 
contains any two preceeding character and any amount of trailing 
characters. 3rd Officer Jane Blythe is no longer found as there is 
only one character preceeding the rd string. 
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Adding a third ? to the search produces a third set of results. 

 

Filters 
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Filtering allows you to select specific 
nodes to display in the Editor. A check 
mark tells ORA to display a node with an 
equal value. 
 
The [ Clear all filters ] button removes 
the filter parameters from that particular 
column only. It does not affect any other 
filters you have set elsewhere. 
 
Deselecting all except (blanks) will 
display any node which has a null value. 
This is useful when you need to fill in 
attributes for blank nodes. 
 
With Define a custom filter you can 
specific a filter in greater detail. If there 
were three nodes with attributes of city-
1, city-2, and city-3 defining *city* as 
the filter would display all three. This also 
contains the Matching [shows only what 
matches the filter] and Not matching 
[which shows only what does not match 
the filter]. 
 
When finished click the [ Apply ] button 
activate the filter. 

 

You can also set filtering to multiple columns to better define your 
search. This search required the home world to equal trantor and 
also sector to equal dahl. Only nodes with both attributes are 
displayed. 
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Visualize Buttons 

There are two Visualize buttons and they work slightly different.  

 

Visualize this Network 
The Visualize this Network visualizes the chosen Network. In the 
Legend dialog box all Nodesets and LinkSets are available. 
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Visualize Only this Network 
The Visualize Only this Network visualizes the chosen Network. 
But in the Legend only the Nodesets and Link Sets chosen are 
displayed. This is a much quicker means to display a Network. ORA 
only makes computations for the chosen Network. 
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Clicking on the downward triangle brings up the dropdown menu with 
additional options for visualizations: Network Drill Down, Visualizer 
3D, Visualize 2D, Node Cloud, Path Finder, Sphere of 
Influence, and Node Selector 
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File Menu 

Below is an image of the File Menu accessible from ORA's main title bar 
menu. Further below are descriptions of the various tools accessible through 
the File Menu.  

 

Open Meta-Network : opens a single Network with the following 
formats: DyNetML* (the native ORA xml format), .dl, .##h (UCINet), 
.csv* (comma separated values, Excel spreadsheet out), .txt (text 
files), .raw, .net (Pajek), .graphml*, .stl* (GMU model), and .lo 
(pathfinder). 

 

Data Import Wizard : Contains additional options for importing 
Networks such as multiple file importing. See Lessons for more 
comprehensive information regarding this function. 

 

Data Export... : Allows you to export a Meta-Network into a 
different format: CSV, UCINET-Binary, UCINET-DL, Netdraw 
VNA, Text, Pajek, DyNetML, or C3Trace. 

 

Manage CASOS Database...… 

  NOTE : This function only available in the full version. 

 

Open Workspace…Allows you to open an entire workspace that you 
were previously using. A workspace consists of a set of Meta-
Networks that were all open at the same time, and saved as a 
workspace. 

 

CEMAP...Opens up the CEMAP Parser. 

 

CEMAP3...Opens up the CEMAP3 Parser. 

 

AutoMap...Opens up the program AutoMap. 

 

Pile Sort... allows a user to load a series of entities such as concepts 
which can then be organized into a piles. The output will be a 
network in DyNetML format. 
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Data to Model Wizard 

 

Save Meta-Network : This item is initially greyed out. It only 
becomes active when you've made a change to a Network. You can 
use it as an indicator whether you've made a change to the active 
Meta-Network. Notice as you highlight each Meta-Network the icon in 
the toolbar will be greyed out (no changes) or colored (changes 
made to that Meta-Network). 

 

Save Meta-Network As... : Allows you to save the changes in a 
Meta-Network under a new filename. 

 

Save Workspace : Saves the active Meta-Networks into a 
Workspace which can be opened up at a later date. 

 

Exit : Closes the program and gives you two options for the next 
time you open up ORA.  

 

• Meta-Networks have been modified : If you have any Meta-
Networks with unsaved changes you can save them by clicking 
[ Save ] 

• Change lists have been modified : If you have any Change 
Lists with unsaved changes you can save them by clicking 
[ Save ] 

• Restore workspace : If checked, the next time ORA is started 
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it will load any Meta-Networks currently open when it was last 
closed. 

• Restore preferences : If checked, all preferences from Edit > 
Other... will remain in effect. If not then ORA will resort back 
to it's defaults.. 

 

 

Open Files in ORA 

ORA is designed to work with DyNetML files. However, data in a format 
other than DyNetML can be imported and converted. 

 Open Meta-Network 
From the Main Menu select File > Open Meta-Network. to bring up the 
initial open dialog box. Navigate to the folder with your DyNetML file and 
click [OK]. 

 

There are four load options available. After selecting your files, they will 
appear in the Meta-Network Manager pane. 
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 Data Import Wizard 
The Data Import Wizard imports files in a variety of File Formats. The idea 
behind the data import wizard is that users come to ORA with a variety of 
file formats from various different network analytical tools. Very rare is it 
that an analyst has a Meta-Network ready to load. Moreover, network data 
may exist in a separate file or in a variety of file formats, which then need to 
be merged together. 

The Data Import Wizard is used to convert the user data from their native 
format and separate files and convert it into Meta-Networks and then into a 
DyNetML file. 

The files can be in any of the following formats: CSV, UCINET, GraphML, 
or Pajek. ORA uses the file extension to determine the native file format to 
assign to your network. Therefore, if you change a file extension from its 
native extension (e.g., GraphML file such as "example.gml" to 
"example.dot" ORA will not recognize the data format). 

This section will review the basics of the Data Import Wizard. See the lesson 
Creating a Meta-Network for more comprehensive information on 
importing. 

Data Import Wizard is accessed either File > Data Import Wizard or the 
icon in the toolbar. You are presented with a dialog box showing all the file 
format options to import. Each contains a description on the right-side of the 
box. 
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Other Functions Besides Importing 
• Create a meta-network from separate network files: Use this 

option to select multiple networks in one of the several native file 
formats indicated above and pull them into ORA. The file formats don't 
have to match. ORA will then combine all the network files into one 
Meta-Network, which will then be saved as a DyNetML* file (ORA's 
native file format). 

• Create a meta-network from table data: Text files in the form of 
rows of Nodes and columns of Attributes will be used to populate 
existing Nodesets.  
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• Import node attributes from table data: Text files used to import 
Attributes to a Node. 

 

Data Import 

The Data Import function contains many methods for creating new Meta-
Networks or importing data into pre-existing Meta-Networks. 

This section instructs you how to: 

Designing a blank Meta-Network. 

Importing Network matrix data to create a new Meta-Network. 

Importing Attributes into an existing Meta-Network. 

Importing KeyFrame data 

Importing a Simple Table 

Importing data from an Arbitrary Database 

Importing from SQL 

 

 

Create Blank Meta-Network 

ORA allows you to create a blank Meta-Network from the Data Import 
Wizard. This Meta-Network will contain Nodesets and Network which can be 
populated with information either manually or by importing csv file data. 

Select the Import Wizard with File > Data Import Wizard  
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In the left box select Design a meta-network Then click [Next >]. 

This brings up the dialog box for creating a blank Meta-Network. 

 

Following the three steps you can create a blank Meta-Network with any 
number of Nodesets and Networks.  
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Step 1: Specify the name for your new Meta-Network. 

Step 2: Click the [New] button to insert a new Nodesets. 

1. Select a Type from the drop down menu. 

2. Give it a unique ID name. 

3. Specify the size you want your new Nodeset to be. 

NOTE : In the above image two Nodesets were created, Agent and 
Knowledge. 

NOTE : The [Remove] button will remove that particular Nodeset from the 
screen. It will not affect any other Nodesets. 

Continue creating all necessary Nodesets. 

Step 3:  

As with Nodesets this step is for creating all necessary Networks. Click the 
[New] button to insert a new Network. 

1. Select a Source ID and a Target ID from the drop down menus. 

2. Give it a unique Network ID name. 

NOTE : The employee x employee network was called works with while the 
employee x skill was called employee x skill. 

NOTE : The [ X ] button will remove that particular Nodeset from the 
screen. It will not affect any other Nodesets. 

Continue creating all necessary Networks. When you are done click the 
[Finish] button. You will see you newly created Meta-Network in the Meta-
Network Manager Pane 
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When you are finished you can use the ORA Editor to type in information of 
use the Data Import Wizard to import information from externally created 
CSV files. 

 

 

Import Matrix Data 

Data in a Matrix form (In excel or text delimited format) can be imported 
via the Data Import Wizard. Open the wizard by selecting File > Data 
Import Wizard. 

 

Select Rectangle of link weights option then click [ Next > ]. 

 

Select the Create a new meta-network with ID: and give it a new name. 
Then click [ Next > ]. 
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The data in the example is an agent x agent type so the Source Type and 
the Target type are set to Agent. ORA will automatically fill in the 
Network ID as Agent x Agent. You can change this name if you want. 

NOTE : The field, Delimiter: can be use to specify the character for a 
delimited file. It defaults to the [ , ]. 

Click [Finish]. 

 

The Meta-Network Manager Pane now contains a new Meta-Network with 
the imported Network and in the process has created a new Nodeset Set. 
You can examine these in the Editor. For now the Nodeset ID and the 
Nodeset Title will be identical. This can be adjusted when additional 
attributes are imported. 

NOTE : To import additional matrix files follow the above procedure except 
use the Add to the existing meta-Network option as shown below. 
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Click the [Browse] button to select the file{s) to import. Set the Source 
type and the Target type for each file imported. To add more Networks 
click the [Click to import from another file] button to add another 
Network. 

 

When you have imported all your Networks click the [Finish] button. You 
modified Meta-Network can be viewed in the Meta-Network Manager 
Pane. 

 

 

Import Attribute Data 

After a Meta-Network is created and Networks have been imported it's time 
to import Node Attributes. Select File > Data Import. From the dialog 
box select Import existing data? > Table data from Excel or text 
delimited formats > Simple table > Node attributes. Click [Next >]. 
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On the next screen click the Meta-Network to add attributes to. Then click 
[Next >]. 

This brings up the next screen for adding the attributes. 
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Step 1: Click [Browse] and select the file with the attributes for the Meta-
Network. 

Step 2: Select the Use this column for node IDs. The data file should 
contain a first column of node IDs for Agents. Each row should contain the 
attributes for those agents. 

Step 3: Select the attributes to import by placing a check mark next to the 
attribute's name. Next select the Type for each attribute. 

Step 4: Place a check mark next to the Nodesets to add attributes to. 

Click [Finish] to import. 

After the import the nodes in the selected Nodeset will contain new 
attributes. 

 

 

Import Keyframe Data 

Importing GCC Timeline data into ORA 
ORA can import data from a CSV file into a Dynamic Meta Network of 
keyframes. In this example each has an Agent x Resource and an Agent x 
Agent network. The AA = AR * RA network computed using the Matrix 
Algebra Tool. 

Open the Data Import Wizard using File > Data Import Wizard [ Ctrl + W 
]. Then select the option below. 
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Configure the final Data Import Wizard page per the picture below:  
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I import AR and then RA, which contain the same links but transposed so 
that I can then easily multiply to get AA = AR*RA. This is how the Matrix 
Algebra Tool in ORA functions. To multiply by a transpose you must create 
an intermediate transposed matrix. 

Select Data Management > Matrix Algebra menu open the Matrix 
Algebra Tool. Select the options below for each keyframe in the AxA 
network. 
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Select Visualization > Measures Over Time. Plot the density of the AA 
network to see that the networks are not all empty.  
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Import Simple Table Data 

Select File > Data Import Wizard. Then select Import existing data? > 
Table data from excel of text delimited formats > Simple Table > 
Networks, nodes, and node attributes.  
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Import Arbitrary Database 

ORA can import data from other databases such as MySQL. This is done 
through the Data Import Wizard. You will need to configure your database 
via an ODBC[1] connection, and place the jODBC driver into the requisite 
ORA JRE installation folder. 

If you want to write a dynetml file to a database, such as one in MySQL, 
then you would use File Manage CASOS Database. 

The jODBC installer deploys the following files: 

jodbc.dll jBASE ODBC Driver Library 

libjODBCSetup.dll jBASE ODBC Setup Library 

jODBCManager.exe jBASE ODBC Manager 

ACE.dll ACE (Adaptive Communication Environment) Libraries 

ACE_SSL.dll   
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libeay32.dll OPENSSL Libraries 

ssleay32.dll   

icuuc40.dll ICU (International Components for Unicode) libraries 

icudt40.dll   

NOTE : The ODBC installer copies the ODBC driver and setup libraries under 
the Windows\System32 directory. 

ODBC Setup library is a separate library implementing the ODBC Setup API 
required by the driver manager to display graphical components such as 
connection dialogs. Connection dialogs enables users to configure DSNs 
inside Windows' ODBC Manager (odbcad32.exe) or input connection details 
when requested by the driver. 

jBASE ODBC Manager is a small console application used to register the 
ODBC libraries with the system, create/remove DSNs or test a connection to 
a remote jBASE instance. Please run jODBCManager -h to obtain more 
information on how to use this utility. 

Installing the driver 
The ODBC installer will automatically register the ODBC driver and ODBC 
Setup libraries. The registration process is required to inform the ODBC 
Manager about the location of the ODBC driver libraries. The ODBC installer 
will also add the installation directory to the global user environment 
variable PATH. This is necessary since the jBASE ODBC driver depends on 
other shared libraries as e.g. ACE, etc. 

When installing on Windows 7 x64, the following extra steps are required: 

Start a command shell as Administrator. 

Navigate to the directory where you installed the driver then run the 
following 'jodbcmanager' command. 

C:\Program Files (x86)\jBASE ODBC Connector>jodbcmanager -i -
driver="C:\WINDOWS\system32\jodbc.dll" -
setup="C:\WINDOWS\system32\libjODBCSetup.dll" 

Configuring DSNs 
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ODBC applications usually obtain the connection details from DSNs which 
may be configured via Microsoft's ODBC Data Source Administrator (also 
known as ODBC Manager / odbcad32.exe or Control Panel > Administrative 
Tools > Data Sources (ODBC)) 

When installing on a 64 bit client, the version of ODBCAD that should be 
used is the version in c:\windows\syswow64 

If the installation has been successful, the following driver should appear in 
the list of available ODBC drivers: 

jBASE ODBC Driver 

Adding a DSN for this driver will present the following dialog: 
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Most of the parameters shown in the previous picture refer to the connection 
details required by the remote jAgent instance. Server specifies the 
IP/machine name and Port specifies the TCP port of the remote jAgent 
instance. 

Please refer to the jAgent user guide for more information about the 
available options. 

Pressing the test button will attempt to establish a connection to the server 
using the provided user/account credentials. If the driver is not correctly 
registered with the system or the PATH environment variable does not 
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contain the path to the installation directory, the following message box will 
appear: 

 

Connection strings 
Connection strings, as defined by the ODBC SQL CLI, specify the connection 
parameters supplied to the server when attempting to establish a 
connection. All connection attributes are defined in a single string separated 
by semicolons. jBASE ODBC Connector accepts the following attributes: 

DSN Data Source Name 

DRIVER Name of ODBC Driver. Must be jBASE ODBC Driver 

DESCRIPTION DSN Description 

SERVER Server Address 

PORT jAgent Port Number 

UID User ID 

ACCOUNT jBASE Account. User Authentication will be used if this 
field is blank 

PWD User/Account Password 

SCHEMA Schema Name. used. Reserved for future yse 

SSL Enable SSL Encryption (1 = Enable SSL, 0 = Disable 
SSL [default]) 

SSL_CERTIFICATE Path to SSL Certificate File 

SSL_KEY Path to SSL Public Key File 

COMPRESSION Enable Data Compression (1 = Enable comp., 0 = 
Disable comp. [default]) 

COMP_THRESHOLD Compression Threshold. Default = 1024 byte 
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DSN, DRIVER, UID and PWD are attributes defined by the SQL CLI, all other 
attributes are jBASE ODBC Connector specific attributes. Attributes 
highlighted in bold are mandatory attributes. 

Example: 
DSN=T24;SERVER=127.0.0.1;PORT=20002;UID=test;PWD=test 

 

 

Import From Other Tool 

UCINET 
UCINET has been supported for many years, both import and export. 

There are different data formats grouped under term UCINET.  

The DL protocol is a flexible language for describing data and itself 
encompasses a number of different formats. Three of these formats - 
nodelist, edgelist and fullmatrix. nodelist is a file with node desccriptions. 
edgelist is a file with link descriptions. fullmatrix is a file which contains 
both. 

NOTE : The Italicized text is for reference only. 

DL 
FORMAT = FULLMATRIX The type of data 
N = 3 The Number of Nodes 
NM = 1 The Number of Matrices 
LABELS: Node Names 
ALPHA 
BRAVO 
CHARLIE 
 
MATRIX LABELS: Matrix names 
FRIENDS 
 
DATA: The Actual Data 
0 0 1 
1 1 0 
1 0 1 

VNA - NetDraw format 
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Note that the values do not need to be numeric. They should all be 
separated by a comma, space or tab. Values that contain spaces should 
be enclosed in quotes as in "Bill Smith"). 

VNA files are ordinary text files. They consist of sections called star 
sections. Not every file has to have every possible star section, and 
sections can be in any order. At the moment, there are 3 possible star 
sections (soon to be 6). They are:  

*node data : Describes the actors in a network 
*node properties : Descrubes the display characteristics of the node 
*tie data : Contains dydadic data among pairs of nodes 

*node data 
id gender role age 
Alpha male leader 56 
Bravo female follower 22 
Charlie male follower 34 
  
*Node properties 
ID x y color shape size 
Alpha 1094 415 255 1 10 
Bravi 84 742 255 1 10 
Charlie 1224 996 255 1 10 
  
*tie data 
from to friends advice 
Alpha Bravo 1 3 
Bravo Alpha 0 1 
Alpha Charlie 1 2 
Bravo Charlie 0 6 

These formats can be imported via the Data Import Wizard > Data from 
another network analysis tool, and exported with the Data Export tool. 

 

 

Import SQL 

Configure an SQL Server database 
1. Download the JDBC driver for SQL Server from 
http://msdn.microsoft.com/en-us/sqlserver/aa937724. 

2. Install the JDBC driver (which just unzips the file). 
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3. Go to the installation JDBC folder and get these two JAR files:  

sqljdbc.jar and sqljdbc4.jar 

4. Place these two jar files (or the equivalent thereof based on his install) in 
location C:\Program Files\ORA\jre\lib\ext\ 

In Addition 
You can directly connect to an SQL database via an ODBC connection 
using the Data Import Wizard. You then issue a query against the 
database, and then create node classes and networks directly from 
the query result set. 

NOTE : This assumes that the data returned from the SQL query is exactly 
what you want to input into ORA. Some intermediary processing in Python 
might be necessary. 

Another option is to generate intermediary CSV files that can easily 
import into ORA (rather than directly creating dynetml) if you want 
to import the data into other software tools. In addition, separating 
the two steps 1) pulling from the database using Python, and 2) 
importing into ORA - by an intermediary CSV file might make it 
easier to validate the correctness of the overall process. 

NOTE : Having an intermediary format can introduce human errors. 

NOTE : There is a Relax-NG spec of dynetml on our website that serves the 
same purpose as a DTD. It's purpose is to completely describe dynetml. 
Working from example dynetml files, however, might be sufficient. 

 

 

Import Text Into Dynamic Network 

A text file can be imported directly into ORA but a few things needs to be 
understood before performing this funtion. 

What Is Needed 
1] The file needs to be in a Tab Delimited format. 
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2] At least one column needs to be in the date format and this date format 
meeds to contain month, day, and year. Without all three it will not import 
as a Dynamic Network. 

File Format 
AUTHOR PUB DATE ALBUM ARTIST LABEL YEAR SCORE SNM 
Ian Cohen 2010-03-15 00:00:00 Fang Island Fang Island Sargent 
House 2010 8.3 1 

A good way to create this type of file is to place your data into Excel and 
export it as a Text (Tab delimited) (*.txt) format. This assures all the 
data is in the correct format. 

Procedure 

 

Start by opening the Data Import Wizard by hitting Control-W, clicking 
the button on the toolbar, or from the menu File > Data Import Wizard. 
Select Table of network links and click [ Next > ]. 

On the next dialog box select the Create a new meta-network with ID: 
and type in a new name and click [ Next > ]. 
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Step 1: Click the [ Browse ] button and navigate to your text file. This will 
bring up all the node IDs in the next section. 

Step 2 : Place a check mark next to all attributes you want to import then 
select a Type and give it an unique ID:. 

To create a Dynamic Network the check box Dynamic meta-network 
date: must be checked and one attribute is selected which contains the 
date. 

NOTE : Make sure that the Date format in the dialog box matches the 
format of the date in your file. 

Step 3 : Select the Networks tab. Click the [  New ] button which brings 
up a new line in the window above. Use the drop down menus to select your 
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source and target IDs. If you file has a weight attribute select that in the 
Link Weights column. When you are finished click the [ Finish ] button. 

 

A Meta-Network will be created in the Meta-Network pane. Clicking the [+] 
reveals the individual Meta-Networks, one for each PUB_DATE contained in 
the original file. 

 

 

Import Twitter 

The TweetTracker creates Meta-Networks from Twitter data. 

Twitter Company records all tweets sent by anybody in the world, and for a 
price anybody can get access to these tweets. A tweet has a sender, a 
timestamp, one or more hashtags, the number of followers that the tweeter 
had when he sent it, and the actual tweet message, and zero or more other 
tweeters explicitly mentioned. 

TweetTracker is a software from Arizona State that converts these tweet 
data from Twitter Company into CSV files that ORA then can import via this: 
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And the resulting meta-network is in ORA. 

After this, the Twitter Report can be used to analyze this imported meta-
network. 
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Data Export 

ORA can export your Meta-Networks to a variety of formats. 1] Select a 
Meta-Network. 2] Select an Output Format. 3] Click the [ Browse ] button 
to select the destination. When finished click the [ Export ] button. 

 

NOTE : Some of these are all proprietary formats and can only be opened 
with the proper program. 

Analyst Notebook : Exports two .CSV files. One for Entities, and one for 
Links. 

C3Trace : Exports one .xls file. This spreadsheet will contain multiple 
sheets depending on the amount data in your original Meta-Network. 

CMapTools : Exports a single file in the .CXL format 

CSV : Exports one .CSV file for each Nodeset and Network. 

Pajek : Export one file in the .net format for Pajek. 

UCINET - Binary : Exports files int ##d and ##H format for use in 
UCINET. Creates two files for each Nodeset and Network. 

UCINET - Text : Exports one .dl file for each Nodeset and Network. 
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Saving Your Files 

 Save Meta-Network 
This option is initially grayed out when you first load a Meta-Network. This 
signifies that the Meta-Network is currently unchanged. Whenever you make 
ANY change within he Meta-Network the option will become full-color 
indicating it is time save changes.  

After clicking the icon in the toolbar, or selecting the menu item, it will 
become grayed out again till you change your Meta-Network once again. 

No change needs saved in the Meta-Network 

 

Changes made to Meta-Network and need saved 

 

Save Meta-Network As... 
If you need to save a Meta-Network under a different name use select File 
> Save Meta-Network As.... This will leave the original file intact and 
create a new Meta-Network with the new file name. 

 Save Workspace 
While working with multiple Meta-Networks you may want to retain the 
information of what files you had open for later use. Saving your workspace 
creates a file which can be opened later and will recreate your workspace as 
before. 
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From the Main Menu select File > Save Ora Project. After selecting [OK] 
on the initial dialog box the Save Ora Project dialog box will appear. 
Navigate to the folder where you want to save your workspace. 

This Workspace can then be called up with the Load Workspace in a future 
session. 

 

 

CASOS Email Parser 

CEMAP belongs to the family of Extract, Transform, and Load software. It 
is designed to extract data from electronic sources in their native formats 
and make it possible to load into the target software system. 

CEMAP can be used in either Interactive mode or Hands-off Batch mode. In 
the interactive mode, users can design the output datasets in a repetitive 
fashion with minimal effort—the software is designed with the realities of the 
analytic workflow in mind. As a batch process, CEMAP can be set up to 
execute in an automated fashion, for example, to extract one’s email 
network every night at midnight. 

CEMAP separates much of the technical detail from the analytic detail 
allowing the user to use the individual parts of CEMAP which they 
understand. 

The inner workings consist of three vital elements: templates, tablesets, and 
template/tableset mapping. Brought together they form a profile. 

A template describes the endprocess, output files that CEMAP is being 
asked to create for later loading into the downstream or host software. 

A tableset describes the technical elements necessary to extract the raw 
source data. 

The tableset-to-template mapping contained with a profile expresses 
the manner in which the output of the tableset is logically connected to 
the input of the template. Critically, the output of the tableset is a set of 
one or more relational data tables (think excel spreadsheet) and the input 
to the template is a set of one or more relational data tables. The 
mapping simply describes the connection between the tableset output and 
the template input. The profile contains all of this information in one 
logical construct. 



250 
 

CEMAP is an ORA tool that primarily allows you to pull network data in the 
form of emails into ORA. However, the CEMAP tool could be used to convert 
any sources of data in the world into DyNetML, ORA's native file format, for 
analysis.  

Setting up CEMAP is similar to setting up a new ISP mail client. What follows 
are procedures to configure this tool and how to use it.  

IMPORTANT NOTE : Before attempting to download emails from Gmail 
your Gmail account needs to be set up for IMAP. Information on that 
procedure is contained on the Google site. 

Email Dates 
Each email has an identifying number in a long number showing the date, 
for example: [20060308042751s1500bii66e]. The 20060308 is in the 
year/month/day format and says this email was sent on March 8, 2006. 

The CASOS Email Parser (CEMAP) that is launched through AutoMap/ORA 
(http://www.casos.cs.cmu.edu/projects/automap/software.html) enables the 
extraction of different types of network information from emails (e.g. who 
exchanges information, who provides what information, etc.). 

 

 

CEMAP - Interface 

Starting CEMAP 
From the main menu select File > CEMAP.... The following interface will 
appear 
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Profile Mgmt.Menu 
Load Profile : Select a Profile from the built-in list. 

Save profile to original location : Save the currently loaded Profile back 
to it's original location. 

Save profile to file as... : Save a Profile to a new location. 

Reload Active Profile : Not Currently Implemented 

Clear Current profile : Not Currently Implemented 

Reload user's startup profile : Loads the user's Profile 

Load default startup profile : Loads the default Profile 

Save active profile to file as... : Saves the currently loaded Profile. User 
can select new name for this Profile. 
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Options 
Save your user profile :  

Activate CASOS Remote Debugging :  

Activate CASOS Remote Execution :  

Save passwords in Profile saves :  

Help 
 

 

CEMAP Profile 

What is a Profile 
CEMAP contains many built-in profiles. These are sets of instructions for 
extracting data from web site APIs needing onlu minimum information from 
the user. 

Profiles 
You will mostly work with the built-in Profiles for extracting emails and other 
data from web site APIs. CEMAP contains many specialized profiles but also 
many general profiles which can be customized to suit you needs. Let's 
concentrate on some of the more useful profiles. 

Select the Profiles tab. Click the [ + ] next to Build-in Profiles then the [ 
+ ] next to Email. Here is a list of the most common email types.  

EML : Email attachments, IMAP  

IMAP : Internet message access protocol one of the two most prevalent 
Internet standard protocols for e-mail retrieval. This allows users to 
access emails from a remote server. 

MBOX : A generic term for a family of related file formats used for holding 
collections of electronic mail messages. 
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POP3 : Stands for Post Office Protocol 3 which is used by local e-mail 
clients to retrieve e-mail from a remote server over a TCP/IP connection. 

gmailIMAP : Similar to IMAP except specifically geared toward retrieving 
emails from the Gmail server. 

Microsoft Exchange Server : An e-mail-based collaborative 
communications server for businesses. 

Microsoft Outlook Extract : A personal information manager from 
Microsoft, available both as a separate application as well as a part of the 
Microsoft Office suite. 

 

 

Profile Example of Zachary Dataset 

Information on any of the Built-in Profiles > General will be found in the 
Profile Tab. This is the exampleof the information in the profile tab for the 
for the Zachary file. 

 
Background 
A network of friendships between the 34 members of a karate club at a US 
university, as described by Wayne Zachary in 1977.  
References: W. W. Zachary, An information flow model for conflict and 
fission in small groups, Journal of Anthropological Research 33, 452-473 
(1977). 
History 
Original data obtained from: http://www-
personal.umich.edu/~mejn/netdata/  
SEE: 
http://www.casos.cs.cmu.edu/computational_tools/datasets/external/karate
/index.php  

Loading the 
http://www.casos.cs.cmu.edu/computational_tools/datasets/exter
nal/karate/index.php url into your broswer you will get additional 
information about the Zachary dataset.  

Example 
Description 
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The Zachary Dataset. 

Standard Network Analysis 

SNA Report (html | csv) 

File Downloads 

karate.xml (Dynetml) 

karate 2.0.xml (Dynetml 2.0) 

karate.gml (Original format) 

Background 

A network of friendships between the 34 members of a karate club at a US 
university, as described by Wayne Zachary in 1977. 

References 

W. W. Zachary, An information flow model for conflict and fission in small 
groups, Journal of Anthropological Research 33, 452-473 (1977). 

History 

Original data obtained from: http://www-
personal.umich.edu/~mejn/netdata/ 

Procedure 
After selecting a built-In profile by highlighting a profile and clicking [ Select 
Profile ], click the [ Execute ] button. Some profiles will run automatically 
if no further parameters are needed. Others will display a Fields dialog box. 
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The directoryName (*) is the destination you want for your output file. 
You can either click the button or type it in directly. 

The fieldDelimiter (*) 

The fileNamePrefix (*) allows you to give the file a specific name 

The fileNameExztension (*) allows you to change the extension of the 
file. 

When you are ready click the [ Continue ] button. 

Your new Meta-Network will be loaded into the Manager pane and processing 
can begin. 

 

 

CEMAP - Email 

Cemap is an email client. If it fails to download emails that means that one 
or more of these parameters is wrong: (a) the server imap.gmail.com, the 
user id, or the password for the user id. --or-- that the host computer 
(running cemap) simply could not connect to the Internet to get to the email 
server, which doeas happen with any email client rather often. Most email 
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clients will automatically retry this connection process without the human 
even knowing it. CEMAP will not do the auto-retry. 

Procedure 

From the main menu select File 
> CEMAP.... This brings up the 
CEMAP dialog box. 
 
Expand Build-In Profiles then 
expand Email then highlight 
gmailIMAP. 
 
Click the [ Select Profile ] 
button. 

 

Click the Templates tab. Here 
are the optional material which 
can be extracted from gmail. To 
extract this, right-click on any of 
the red-colored entries and 
select Toggle Activation 
Setting. 
 
Click the [ Execute ] button. 
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Fill in your UserID and your password. CEMAP defaults to your INBOX but 
you can change to any folder. When finished click [ Continue ]. 

 

CEMAP will now begin processing. When finished a Parsing Finished alert 
will appear. 

NOTE : Depending on the number of emails it needs to extract the process 
could take a fair amount of time. 

The resulting XML file can be opened up directly in ORA. 

 

 

CEMAP Profile 

CEMAP can obtain data from Facebook using APIs from the Facebook 
platform. With it it can create an Ego-Network of the subject's friends. 
CEMAP's purpose is to transform real-world data into relational network 
data. You use the interactive interface to create a profile. Then you can 
tweak that profile for your needs. Finally you can save that profile for future 
use. The use indicates the source of the data and that is made available to 
CEMAP to create a Tableset. 
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In Your Browser 
Go to the CEMAP Facebook site: http://cemap4ora.com/facebook/. 

Follow directions to allow permissions: 
http://www.cemap4ora.com/facebook/grantAccess.html. 

NOTE : This is important for first time CEMAP users. Facebook requires you 
to grant access first. 

NOTE : This does not function in Internet Explorer. You will need to switch 
to an alternate browser to perform this funtion. 

Click the connect button to get your key: 

<<<< Click here to obtain your special key 

If you are not logged into Facebook a login screen will appear. Type in your 
Email and Password. 

A window will appear with a User Session code [This example has the code 
blurred on purpose]. 

 

Copy this code for use in CEMAP. 

In ORA 
Open CEMAP in ORA File > CEMAP... 
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In the CEMAP window highlight Built-In Profiles -> General -> facebook. 
Then click the [ Select Profile ] button. To run the function click the 
[ Execute ] button in the lower right of the window. 

Fields Editor -- DIALOG [1] 
NOTE : This dialog will appear only the first time you access this function. 

Click the [ Location to Store Network File ] button. Navigate to the 
location you want to store the file and type in a name in the textbox. 

NOTE : You need to type in the .XML extension. 

Click [ Continue ]. 

Fields Editor -- DIALOG [2] 
Leave both apiKey/secretKey as default. 

Paste your userSessionId you obtained from the web page into the 
userSessionID field. 

Click [ Continue ]. 

CEMAP will start Parsing the data from Facebook. When it is finished a new 
Meta-Network will appear in the Meta-Network Pane titled Facebook 
Profile. 

The Meta-Network is ready to be used the same as any other Meta-Network. 

Example of a Facebook Network 
NOTE : When you click continue, ensure that 1) You have no tab/window 
open to Facebook; 2) You are logged in; and 3) The window with the session 
key is open. 
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Pile Sort 

The PileSort module allows a user to load a series of entities such as 
concepts or people's names. These entities are displayed in a deck, which 
can then be organized and grouped into a pile, which will contain entities 
that are similar to one another. The output of the PileSort module will be a 
network in DyNetML format. 

The user can use either a text editor of a spreadsheet to create a two-
column comma-separated file (i.e. a .csv file). The first column contains 
the concept and must not be blank. The second column is optional and can 
contain metadata. 

NOTE : Concepts can not contain embedded commas. 

Pile Sort GUI 

 

Pile Sort Interface : consists of two panes: The Side Deck and the Canvas. 
The Side Deck displays cards that have not been organized into piles, such 
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as initially when the input file in read. The Canvas contains the piles where 
the cards are placed from the Side Deck. 

Pile Sort Menus 

 

File > Load a File : Navigate to a directory with a new Pile to Sort. 

 

File > Exit : Leave the Pile Sort program. 

 

Edit > Add an Empty Pile : Creates an additional empty pile on the 
canvas. 

 

Generate > Create a Network DyNetML File : Creates a DyNetML 
file from the current state of organization. All cards in a pile are fully 
connected and cards remaining in the deck are isolates. 

 

Help > Show Help Topics : Accesses the ORA Help files 

Other Functions 

 

Add Card : takes the concept that has been filled into the text field 
next to the [Add] button and creates a card with that name at the 
end of the card deck. 

 

Transfer All Cards to Another Pile : Click and hold the icon of a 
pile and drag it to another pile. All cards in the first pile will be 
transfered to the new pile. 

 

Cycle Through the Cards in the Pile : Rotates the cards in a pile 
that the card currently beneath the currently highlighted card 
becomes highlighted. The newly highlighted card becomes the pile's 
representative. 

 

Return Cards to the Side Deck : Removes all cards from a pile and 
returns them to the side deck. 

 

Mark a Card as a Pile's Representative : marks the currently 
highlighted card as a pile's representative. 
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Move Card to Another Pile : Click and hold a card in a pile and 
drag it to another pile. 

 

Click to Add a Title : allows the entire pile to be given a name. 
Either click on the title bar or use the drop down menu item. 

 

Drag and Drop Here : allows the user to drag cards from the side 
deck onto a pile. 

Loading a list of concepts :  
All piles are initially empty. The concepts appear in the side deck to the left. 
A scrollbar will appear if the number of concepts is greater than the screen 
length. An empty pile contains the banner drag and drop here signifying 
an empty pile. Once a concept is placed in a pile it will all concepts will be 
displayed in it's window. 

NOTE : To have duplicate concepts in more than one pile requires the 
creation of duplicate cards. 

NOTE : You can leave cards in side deck. Any card not so placed will become 
an isolate in the resulting network. 
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Viewing in ORA 
Saving a sorted Pile : Sorted piles are saved to the DyNetML format. 
Networks are formed from the individual piles which include the metadata 
from each card. 

Viewed in the Editor you can see all the saved information from Pile Sort. 
The column containing_pile is the name you gave the pile into which a 
card was placed. meta-information is the optional second column from the 
.CSV file originally loaded into Pile Sort. If that was empty, then the meta-
information cell would also be empty. 



264 
 

 

Clicking the [Visualize this Network] button displays your Pile in the ORA 
Visualizer. How networks are formed is based upon the cards placed in each 
pile. The four cards not placed into a pile (cuttlefish, seal, sea horse, and 
shark) became isolates in the Visualizer. 

 

  



265 
 

 

Data-to-Model 

What is Data-to-Model? 
Data-to-Model (D2M) is a heuristic procedure for extracting network data 
from a set of source texts and subsequently analyzing it; source material 
may include but is not limited to newspapers, magazines, tribune reviews, 
works of prose, and email. Automap is used to clean and extract the 
networks from the texts, which can then be analyzed in ORA. (Carley et al., 
2010) The analysis made from the report generated by ORA helps identify 
the influential people, the intervening agents and implicated locations. 

In addition, it helps forecast a situation and identify key actors (Carley et al., 
2010). This analytical document is important for policy makers and people 
interested in the social, political and structural evolution of a situation. Data-
to-Model has been used in the case of Sudan Conflict, Singapore and Haiti. 
There are three degrees of modal that can be obtained: Basic Model, 
Refined Model and Advanced Model. 

 

 

Basic Model 

Basic Model (AutoMap) 
The first step to construct a model is to develop a basic model from texts. 
This basic model will use the most appropriate routines and techniques and 
databases requiring limited interaction from the user. The networks in the 
basic model include a concept network and a semantic network. 

To reduce the number of concepts in this network, especially multiple 
concepts that express an identical meaning, a depluralization thesauri is 
constructed focusing on nouns and verbs to take these concepts to their 
base form such as present tense and singular form. 

Established databases are used to identify and process known entities such 
as the names of countries and major cities as well as the names of 
current and recent world leaders. 
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Procedures 

Step 1 : Create a Project Directory 
Prior to uploading your data, you need to create a workspace (folder) where 
all your input and output files will be stored. This helps in organizing your 
files and in preventing any loss. You may copy in some standard files such 
as Generic Delete File, Standard Thesauri. Information in the Generic Delete 
List consists of things that have been considered irrelevant in precedent 
encounters and therefore saved into a Delete List. There may be information 
that are already pre-existing in our data base that you want to make use of. 

Example : CASOS Group has standard thesauri that contains some pre-
defined knowledge. 

Step 2 : Import your text files into AutoMap 
When you click on the File > Import Text Files you will be prompted to 
choose the files you want to upload from your directory. Your files will be 
uploaded as they are, however you may change the text settings. AutoMap 
can guess your files encoding but it is not all accurate. It is better to choose 
your text encoding if you know it before resorting to the automated choice. 
Other languages settings will require you to change the font to be able to 
read it. Since your files are from multiple sources, it is certain that your files 
have different encoding. To facilitate this you can save your files in word as 
a text file. Due to the huge number of files it takes a lot of time to identify 
the encoding for each individual text. 

Step 3 : Cleaning the Text 
There are many concepts and words and structures that are part of your 
data set but which are not necessary for the purpose of your project. 
Therefore this need to be deleted from your text. This is selected under 
Preprocess > Perform All Cleaning. This cleaning gets rid of extra 
whitespace, fixes common typos, coverts British to American spelling, and 
expands contractions and abbreviations. You can actually perform all this at 
once but if you do not wish to remove extra space for example you can do 
the manual cleaning for each step. The individual functions can be found 
under Preprocess > Text Cleaning. 

NOTE : This cleaning doesn't affect the meaning of your text. 
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Step 4 : Generating some thesauri 
You are generating these thesauri early because they rely on the Part of 
Speech, thus very important. Before you start manipulating your files it is 
important to extract the essential knowledge. Proper nouns and verbs have 
a tremendous importance in your project. For any generation procedures 
select them from the Generate Menu and scroll down to what you want to 
generate from the menu list. 

a) Suggested Names Thesauri 
Generate the Named Thesauri from the data. This is automatically 
executed and it is saved in the project folder where the user can review it 
when necessary. To generate the Names thesauri, select Generate > 
Named Entities. The Named Entities Thesauri consist of names of agents, 
organizations and locations. It will be saved in the project directory in 
Standard Format. You may open it in Excel or Word to edit. You may delete 
some entries that you deem irrelevant and add some from other sources. 

NOTE : Gazetteer is a source where you can obtain names of locations to 
expand your thesauri. 

You may generate multiple Name Thesauri and compare them. This thesauri 
has everything that the part of speech has identified as proper noun. There 
may be inaccurate facts where some parts of speech are mistakenly 
identified as nouns but that are not. It is important to know that the system 
is giving you more information instead of less because it is easy to go 
through and delete what you don't want than add new things. Factual errors 
stem also from the structure of the text itself. For instance Sudan Bishop 
accuses Oil Companies, which has been identified by the computer as a 
name because most of it starts with a capital letter and the computer is not 
able to differentiate nouns from other parts of speech not because of the 
way it is presented in the text. The system also gives you a guess of 
ontological classes (organization, location, agents). 

In addition, in AutoMap there is a Location Distillation that gives you a 
thesauri based on the location you specify. If you specify the name of the 
location the system will suggest all synonyms and spelling variants for that 
location. You may use those to expand your thesauri. In default everything 
is classified as agent. 
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b) Generate a Suggested MetaNetwork 
Thesauri 
From the menu select Generate > Suggested Metanetwork Thesauri. 
This assigns an ontological class for each individual concept. It tells whether 
this concept is an agent, location, source, or any other category. This 
automatic categorization is not always right, therefore you may find some 
obvious proper names classified as locations. This may be due to the 
structure of the text. The good thing is that you, as a user, can access this 
thesauri from your project folder and change some classification that you 
think are not right or just for the purpose of this particular project you may 
want to classify some obvious names of locations as source or agent. 

Example : United States of America is a location but it can also be 
considered as agent in some cases where the United States Government has 
taken some actions. 

c) Depluralization Thesauri 
Depluralization is the elimination of plurals forms which consequently 
reduces the verbs or nouns to its base form. It uses the part of speech. The 
Depluralization Thesauri is a list of nouns and verbs in their base forms 
automatically generated by the Data to Model wizard and saved in the 
project folder where it can be reviewed anytime. This also includes 
detensying (reducing verbs to their base forms). 

From the main menu select >Generate > Generalization Thesauri > 
Context- Stemming Thesaurus. This procedure applies stemming to 
nouns and verbs. Proper nouns will remain unchanged. Exception has been 
drawn on proper nouns because the stemming system doesn't work well 
with proper nouns. 

Example : CASOS becomes CASO which really reduces the meaning or may 
even refer to something else than what was intended. 

We also focus on nouns and verbs because they are the most important part 
of speech you use in your thesauri. Sometimes due to the text there are 
some irregularities, irrelevant entries can get involved but you can access it 
and edit from your directory folder. 

NOTE : These are in Master format which refers to the four format thesauri. 
See Master Format page for more information. 
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After generating the Context-Sensitive Thesaurus, apply it to your text. All 
nouns and verbs except proper nouns will be reduced to their base forms. It 
will depluralize and detense most nouns and verbs. 

Data Preparation  
At this stage you have already extracted the thesauri that rely on the part of 
speech. You can now manipulate your texts knowing that you have already 
obtained some essential information. 

Step 5 : Pronoun Resolution 
The pronoun resolution is done from the Preprocess tab>Text 
Preparation>pronoun resolution. It consists of replacing all pronouns with 
their relative nouns. 

Example: John went to the bakery, he bought some bread 

The he will be replaced with John. 

Some pronouns will still remain after this process; all remaining pronouns 
will be automatically deleted. It also removes prepositions, verbs of noise 
(verbs of being, verbs of helping), converts all concepts to lower case except 
proper nouns and names of Organizations and also converts N-grams (two 
word concepts that appear meaningfully together). Their separation distorts 
the meaning. 

Example : The terms civil war, white house, United States have a 
commonly known meaning being put together. However, each word taken 
away will have a completely difference meaning. So by converting n-grams, 
the wizard associates those concepts. 

NOTE : It is important that you lower case your text with caution because it 
may change the ontological classes of the concepts. Not everything needs to 
be lower case, especially proper nouns. 

Step 6 : Apply the Delete List 
To apply Delete List select from the menu Preprocess > Text Refinement 
> Apply Delete List. Applying the Delete List will remove all concepts 
already in the Delete List and a Filtered List of concepts will be generated. 
This application should be Rhetorical which replaces all deleted concepts 
with XXX. Whereas the Delete option will simply apply deletion. 
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There are cases where you don't want to use the standard delete because 
some texts are very sensitive. This is not an issue in media files because the 
idea can still be inferred even after deletion of noise words. However, court 
documents are very word sensitive, deleting prepositions like the or a may 
drastically change the meaning of that word. A good example is: 

He shot him with a gun 

He shot him with the gun 

He shot him with XX gun  

These sentences have different meaning and may affect the meaning and 
purposes intended in a court. 

Step 7 : Merging 
Merge all Depluralization Thesauri, Named Entities Thesauri, and Suggested 
Thesauri to form a project based thesauri. From the main menu select 
Procedures > Master Thesauri procedures > Master Thesauri Merge. 
You may also view this list and edit it to fit your project. You are merging 
them together to have a more expanded knowledge about agents, locations, 
sources. You will have all this information organized in one file. 

Under Procedures > Thesuari Procedures you can change your thesauri 
from Master format to Standard format or visa versa. Under Thesauri 
Procedures you can also merge thesauri together by specifying the change 
thesauri and the standard thesauri. You have access to this merged format 
and may edit it to your liking. Merging the thesauri can also be done 
manually by copying and pasting them together. At this stage you are the 
master of your project therefore you can choose to manually modify your 
thesauri and tailor it your project. However, you can also execute this 
automatically under Master Thesauri procedures and in case of conflicts the 
system will identify the conflict and will prompt you to choose one 
preference. 

Step 8 : Generalization Using Name Thesauri 
(project thesauri) 
This procedure is under the drop list of the Preprocessing tab. Go to 
Preprocess>Text Refinement>Apply Generalization Thesauri. At the prompt, 
select the name thesauri and apply it. People, locations and things can have 
various names. Creating general thesauri will consolidate each of these 
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names into a uniform name (See AutoMap Help). Below is an example: 
Concept, Key Concept 

Barack Hussein Obama, Barack_Obama 

United States, United_States_of_America 

USA, United_States_of_America  

Step 9 : Generate a Concept List with 
MetaNetwork Tag 
From the main menu select Generate > Concept List > Concept List 
with MetaNetwork Tags. This extracts a list of concept from your data 
using your Standard Thesauri. From the menu select Procedures > 
Thesaurus Procedures > Convert Master Thesauri to MetaNetwork 
Thesauri. Use this concept list for any future modifications. 

Step 10 : Create an Uncategorized Thesauri 
From the main menu select Generate > Concept List > Concept List (Per 
Text). The Concept List will be extracted from your data. Those concepts 
have not yet been categorized, in other words there are yet unknown. An 
ontology will be automatically for each concept found based on part of 
speech. Merge these concepts to your already existing thesauri. Verbs are 
classified as tasks and all remaining concepts (except nouns and verbs) as 
knowledge. You have already classified nouns as agents and location. You 
can merge this one back to your project thesauri. 

Step 11 : Generate DyNetML (Use 
Metanetwork) 
It is now time to generate a DyNetML file. From the main menu select 
Generate > Metanetwork > MetaNetwork DyNetML [(Per Text) / 
(Union Only)]. The DyNetML is the model you have been aiming for by 
refining and manipulating your data. You will be prompted to choose a 
DyNetML from each text or a Union DyNetML which will create one file using 
concepts from all files. Choose a window size based on your average 
sentence length in order to have an adequate view of your DyNetML. 
Windows size 8 is often used. 

Step 12 : Start ORA 
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Load these files already saved in your project folder to ORA. Generate key 
entity report using union. Upon generation of the key entity report, you may 
review the report. If your report appears to be lacking for the analysis of 
your project, you may always go back to the thesauri and tailor it to your 
project purposes. Depending on your satisfaction of the results generated by 
ORA you can always go back to refine your Project Thesauri and generate a 
new DyNetML and then a new ORA report. It is the refinement process. 

 

 

Refined Model 

Refined model 
The refined model allows the user to evaluate the automated choice 
selections. For instance, in the depluralization thesauri concepts are taken to 
their base form. This technique uses part of speech analysis to find only 
nouns and verbs, specifically excluding proper nouns. However, an 
occasional proper noun may be identified as a common noun especially in 
the case of incorrect grammar usage in texts. 

The names thesauri use proper names to identify instances of agents. While 
it is common for the proper names found in a text corpus to refer to an 
agent, a proper name could refer to an organization. The names thesauri 
would be reviewed to change the categorization to organization where 
appropriate. To review the names thesauri you can access it from your 
project folder. The category agent can be substituted with organization or 
location. As a user, if you feel that the entry does not correspond to agent, 
organization, or location, one of the other categories can be used such as 
event, resource, knowledge, or task. If an entry does not fit any of those 
categories the entry can be deleted from the thesauri. 

 

 

Advanced Model 

Advanced Model 
In the advanced Model the user is well acquainted with the data and with the 
procedures. Therefore, you may use more expertise to execute procedures 
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without the wizard because you now understand the purpose and the under-
belly of the data to Model wizard. 

 
 
 
 
 

 

Analysis 

Analysis 
This steps calls for your knowledge of the subject you are dealing with and 
also knowledge about the actor's level measures and the network level 
measures. This includes but is not limited to degree centrality, hub 
centrality, click counts, authority centrality etc (ORA Glossary, 2010). Prior 
to the analysis, you have already obtained your Model which is the DyNetML. 
This is only the analytical part, no more automated procedure is involved, 
and this should be done after all satisfactory refinements. 
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Edit Menu 

The Copy/Paste functions are dynamic in nature. ORA understands what 
you have highlighted and will copy it onto the clipboard. Whatever is 
currently in the clipboard can be copied back into ORA any number of times. 

The first two options are to Copy/Paste Editor values. 

 

Copy : The copy function will place a copy of whatever is currently 
highlighted into the clipboard. That will remain until another item is 
copied. 

 

Paste : The Paste function will create a copy of whatever is stored in 
the clipboard. This can be repeated as many times as necessary. 

NOTE : ORA's menus change as different items are highlighted.. They also 
change after something has been copied. If a Nodeset had previously been 
copied the menu item will change to Paste Nodeset. If you then copy a 
Meta-Network the menu item will change to Paste Meta-Network. 

 

Find Entities : Search all selected Meta-Networks for named node. 

 
 

 

Find Entities 

You can do a quick search of any loaded Meta-Network for a name of an 
individual node. Remember : The name must be spelled exact or the search 
will fail. 

Standard Search 
Place a check mark next to the Metwork-Networks to search. Above this box 
are three check boxes, Search node IDs, Search node titles, and Search 
attributes. First we will srearch only IDs and titles. 
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Type in the name of a node to search for. Make sure it is spelled correctly or 
ORA will find no results. IN the pane at the bottom it display the Meta-
Network, name of the node, and size for each occurance. 

 

Next we do a search for robot. In this instance ORA finds no match. But 
knowing this dataset I know it exists. In this case you need to place a check 
mark in the check box Search attributes in order for ORA to search the 
entire dataset. 
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And the result is one entry. 
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Preference Menu 

The View Menu shows a log of all activity performed in ORA. 

 

Defaut Layout : Resets the Editor GUI layout to its default panes 
position. 

 

Change Font : Allows you to change the GUI font to any font on 
your system. Be careful with the font chosen as some fonts are built 
more for custom design rather than readability. 

 

Load Font : Add font to use for the ORA display. ORA will ask 
whether to make this the default font. If Yes the the GUI will be 
displayed with the new font. These loaded fonts can be found in 
C:\Documents and Settings\{username}\Ora Fonts. 

NOTE : Some fonts may make reading the GUI difficult. Take note of your 
previous font before making any changes. 

 

 

Event Log : The log maintains a list of all actions performed in ORA. 
This allows you to review steps that were taken during a particular 
time. 

NOTE : The report pane must be visible in the GUI to view the log. This 
pane can be reinstalled by selecting View > Default Layout. 

 

Measure Preferences : Allows you to select the type of measures 
to run. 
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Use only fast measures :  

Do not use slow measures :  

Scale measures as percentages (like UCINET) :  

 

All Preferences : Contains settings for controlling the environment 
for working within ORA. 

General 

 

Enable tooltips toggles whether the tooltips are shown when you hover 
over an object. 

Restore docking window layout will restore any changes you've made to 
the GUI layout. Unchecked at time of closing will result in ORA going back to 
it's default layout. 

Look and Feel Classname  

Large toolbar icons  
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Datasets 

 

Maximum Meta-Networks to fully load  

Load DyNetML sources  

Load DyNetML link properties  

Specify set of files to load at startup gives three options. 1) Do not 
load any files at startup starts ORA with an empty Meta-Network pane. 2) 
Restore previously loaded workspace files at startup loads the files 
stored in the Workspace file. 3) Load specified files below allows you to 
pick which files you want loaded the next time you start ORA. 
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Reports 

 

Select reports display as list of all reports available. Check marked reports 
will be used in the report generator. Report names can be changed by right-
clicking a report and typing a new name. There is a Reset report names 
button which changes all names back to their default. 
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You can type in text for the header and footer of your reports. It will 
appear on all pages. The Decimal precision controls the number of decimal 
places for all numbers. 

Custom Reports 



283 
 

 

Allows you to name, describe, and set up the measures to be used. If there 
are variable parameters for a measure they can be set also. If you have 
created any previous Custom Reports they will appear in this window. This 
is where they can be Modified or Deleted. 
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Preferences Panes 

 Preferences are global variations which control aspects of how ORA 
works. 

 

General 
Enable tooltips Toggles whether tooltips are shown when you hover over 
an object. 

Restore docking window layout Restores the layout to the default 
settings. Any changes you've made to the GUI layout will be removed. If it 
unchecked at time of closing the program ORA startup in the defulat 
arrangement. 

Look and Feel Classname : Sets the style of the ORA GUI. 

Large toolbar icons : Placing a checkmark toggles between using the 
16x16 or 24x24 icons. 
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Data Sets 

 

Maximum Data Files to Load : Tells ORA the maximum number of files to 
load upon start-up. The checkboxes let you select what to load from the 
individual Meta-Networks. 

Load DyNetML sources :  

Load DyNetML link properties : Unchecking will stop ORA from loading in 
Attributes for all links. 

Load DyNetML properties : Unchecking stops ORA from loading in 
Attributes for all nodes. 

Load DyNetML networks : Unchecking stops ORA from loading any 
Networks. 
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What To Load : You have three options for loading files when ORA is 
started up. 

Do not load any files at startup : Ignores any files that were loaded 
during the last session. 

Restore previously loaded workspace at startup : Loads the files that 
were current when ORA was last shutdown. 

Load specified files below: Loads the files specified in the box below 
the option. 

Reports 

 

Selecting Reports to Display : Any reports with a checkmark will appear 
in the report generator window. Check marked reports will be used in the 
report generator. Report names can be changed by right-clicking a report 
and typing a new name.  

Reset report names : Resets the names of all reports back to their default 
names. 
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Import/Export Settings : These two buttons are used if multiple people 
work on the same computer. Each individual can use the Export Settings 
button to export the settings they are using at the end of a session then use 
the Import Settings when they return to the computer. 

 

 

You can type in text for the header and footer of your reports. It will 
appear on all pages. The Decimal precision controls the number of decimal 
places for all numbers. 

Decimal Precision : Sets the precision to which results are calculated. 

Enable Flash Charts : Toggles whether Flash charts will be rendered in 
reports. 
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Custom Reports 

 

The Create, Modify and Delete buttons. 

Allows you to name, describe, and set up the measures to be used. If there 
are variable parameters for a measure they can be set also. If you have 
created any previous Custom Reports they will appear in this window. This 
is where they can be Modified or Deleted. 
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Data Management 

These sets of menu items enable you to control the addition or removal of 
Meta-Networks, Nodesets, and Networks as well as adding Attributes to a 
Nodeset. 

Matrix Algebra, Meta-Network Transform, and Meta-Network Union... also 
create new Meta-Networks, Nodesets, and Networks but do it with 
Mathematical operations. 

 

Matrix Algebra... : Performs mathematical operations on two Meta-
Networks. 

 

Meta-Network Transform... : Cleans up a visualizer display making 
it easier to read. 

 

Meta-Network Clean... :  

 

Meta-Network Anonymize... : Resets the NodeID (and optionally 
the Node Title) to anonymous values. 

 

Meta-Network Union... : Creates a single Meta-Network from two 
(or more) existing Meta-Networks. 

Meta-Network 

 

Add New Meta-NetworkUsed for adding or removing Meta-
Networks from use. 

 

Remove Selected Meta-Network : Removes any Meta-Network 
which is currently selected. 

Nodeset 

 

Add New Nodeset... : Enables you to add, remove Nodesets, as 
well as, change the size of the Nodeset. You can also add an 
Attribute to an existing Nodeset. Depending on what you have 
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selected different options may be greyed out. 

 

Remove Selected Nodeset : Removes all selected Nodeset from 
the Meta-Network along with any associated Networks. 

 

Add Attribute... : Creates a new attribute in a Nodeset. You need to 
give the attribute a name and also what type of attribute it is: Text, 
Text Category, URI, Number Category, Number, Date. 

Network 

 

Add Blank Network... : Similar to Nodeset in that you can add or 
remove Networks. This function also enables you to Set the 
Diagonal of a graph to either -1, 0 or +1. Useful for setting 
consistent values on an agent-by-agent Network. 

 

Remove Selected Network : Removes all selected Networks from 
the Meta-Network. 

 

Set Diagonal : Allows user to constant values to the diagonal of a 
square network. If Binary View is chosen you can pick True (+1), 
False (0), or True (-1). If Numeric View is chosen you can set the 
diagonal to any value. 

 

Attribute Partition Tool : Creates new Meta-Networks from 
existing Meta-Networks using a node attribute. 

Infer Links... 

 

Infer Links > Beliefs :  

  NOTE : This function only available in the full version. 

 

Randomize Links : A new Meta-Network is created with identical 
Nodesets, and with Networks of the same size and density, but with 
links distributed randomly according to Erdos-Renyi. 

  NOTE : This function only available in the full version. 

-->  
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Network Algebra 

 Network Algebra allows you to perform mathematical operations on 
two Meta-Networks. The options in ORA are addition, subtraction, and 
multiplication. These functions help spot strong and weak connections 
within a Meta-Network. 

NOTE : The term Network Algebra is synonymous with Matrix Algebra in 
computational parlance. Also, the following images display Matrix Algebra 
in the title bar. This may or may not be the case for the most recent version 
of ORA. 

Matrix Algebra Definitions 
Matrix Multiply : Technically this is the outproduct.  

Inner Product : This is a form of matrix multiplication, sometimes 
referred to as the dot product. Both matrices must be of the same 
dimensions - e.g, both 10 x 5. The resulting matrix will be of the same 
dimensions. For the inner product each term is simply multiple by it's 
corresponding term in the other matrix.  

Procedure 
In the Meta-Network pan highlight the Meta-Networks to analyze. Then 
select Data Management > Matrix Algebra.... If you want to include any 
additional Meta-Networks place a check mark next to ehri names. When 
finished click [ Next > ]. 
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The Network Algebra dialog appears. 
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The Select an operation dropdown menu contains the various ways to 
manipulate your networks. The Select the input networks section allows 
you to select networks from your Meta-Networks. 

NOTE : Only Networks which are the same size will show up in the 
dropdowns. 

• Add Networks: Adds together corresponding cells of two different 
Networks. 

• Subtract Networks: Subtracts corresponding cells of two different 
Networks. 

• Multiply Networks: Multiplication is slightly different than the add or 
subtract. The number of rows in the first Meta-Network must equal 
the number of columns in the second. A Meta-Network can be 
multiplied by itself to help reveal specific strong and weak areas. 

• Add a Scalar to existing links:  

• Add a Scalar (dense matrix operation):  

• Subtract a Scalar from existing links:  

• Subtract a Scalar (dense matrix operation):  

• Multiply by a Scalar:  

• Divide by a Scalar:  

• Dot Products Networks:  

• Set the Diagonal:  

• Transpose:  

Select Network 1: 

Next select the first Network you want to work with. 

Select Network 2: 

Then select the second Network in order to perform the algebra. 

Name for the output network: 

If you wish, you can change the default name for the newly created 
Network. 
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Click [ Run ] to create you new Network. You can then create more 
Networks if desired. When done, select [Cancel] to remove the dialog 
box from the screen. 

Your new Network will now appear in the box with your Meta-Network. 
Next highlight the Network you just created. 

Visualize The Networks 
The Meta-Network example has one Agent Nodeset with ten agent nodes. 
Then three Agent x Agent Networks were generated using Erdos-Reyni. 
Below are the three networks. The bi-directional links are shown. 
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Add 

 

Subtract 
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Meta-Network Transform 

Select Files 

 On some occasions the display in the Visualizer is too cluttered to make 
much sense of your network model. ORA offers a variety of ways to clean up 
the display in order to make it easier to view your data. 

In the main menu select Data Management > Meta-Network 
Transform…. 

 

Place a check mark next to the Meta-Networks you want to perform a 
transformation on. 

General 
Click the [ General ] button and place a check mark next to any transforms 
to apply to the selected Network(s) These transformations will be performed 
in order from top to bottom. 
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NOTE : To perform transformations in a different order select a 
transformation then click the [ Apply ] button. Deselct that transformation 
and click the [ Apply ] button again. Repeat until you have performed all 
necessary transformation. 

 

The "Whole Meta-Network" tab 
This tab contains funtions which work on all Nodesets and Networks. 

Remove isolates based on : Remove isolates based on selection of Meta-
Network or individual Networks. 

Remove pendants based on : Remove pendants based on selection of 
Meta-Network or individual Networks. 

Remove self loops : Remove self loops (diagonal) in Networks 

Symmetrize by method : Turns all links bi-directional by adding or 
removing uni-directional links. 
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Maximum Compares the values and uses the larger of the values. This is 
called using the stronest value. 

Minimum Similar to Maximum only it uses the lower, or weaker, value. 

Sum Adds all values together 

Average Takes the two values and averages them. 

Binarize (set link weights to one) :Takes all links weighted greater than 
[0] and make them all equal to [1]. All links will be either [1 or 0]. 

Remove Links :When using weighted links this functions allows for links 
to be removed based on link weight. You can choose from six options for the 
removal of links. 

• Less Than :  

• Less than or equal to :  

• Equal to :  

• Not equal to :  

• Greater than or equal to :  

• Great than :  

Create union networks : Creates new networks that are the union of all 
networks of the same type. If the Meta-Network had two Agent x Agent 
Networks, then using this feature would create a new Agent x Agent 
Network which would contain all the links that were present in the original 
two Networks. 

NOTE : The input networks are NOT deleted. 

Create implicit locations and networks : For a Meta-Network without a 
location Node Class but with Agents or Organizations having latitude and 
longitude attributes this will 1) create a location Nodeset populated with 
Agents and Organizations and 2) Create Networks linking each Agent and 
Organization to its location. 

Create partition Networks by attribute :This partitions the Nodeset 
according to the values of the specified entity attribute and then creates a 
group of new graphs based on the partitioned Meta-Node. This kind of 
grouping is often done in network analysis to understand how some Meta-
Nodes are embedded in various social roles or how they interact within 
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larger Meta-Nodes. The dropdown menu will contain all the attributes in the 
meta-network. 

Example, if you have an Agent Meta-Node that has a gender attribute for 
each node that takes on values male and female, then using this feature 
four new Agent x Agent Networks would be created that contained links from 
males to males, males to females, females to males, and females to 
females. No new Meta-Node is created and no data is changed. 

Create a meta-network from selected nodes and networks : Creates a 
new Meta-Network with a single Nodeset and a single Network. The nodes 
are prefixed with the name of the Nodeset they were taken from. 

Say you have a network with three networks, Agent x Agent, Agent by 
Organization, and Organization x Organization and you want to 
combine these into one nodecass and network. Highlight the Meta-
Network, place a check mark in this box, and click [ Transform ]. ORA 
will create a new Meta-Network which conatins all the nodes in a single 
Nodeset and will combine all the networks. In the Node ID it will preface 
each with the original nodeclass . 

Network 
This tab allows you to Choose one or more networks to transform by 
placing a checkmark in the box. All marked netowrks will be processed. 
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Remove links : removes links based on one of six options. 

• Less Than :  

• Less than or equal to :  

• Equal to :  

• Not equal to :  

• Greater than or equal to :  

• Great than :  

Binarize (set link weights to one) : Take all weighted links greater than 
[0] and make them all equal to [1]. 

Symmetrize by method : turns directed or asymmetric network data 
into un-directed or symmetric data. All three methods (maximum, 
minimum, average) use a pair of values from the upper and lower portions 
of the table (e.g. cell 1, 3 is compared to cell 3, 1) 

Transpose the network : writes the rows of network [A] as the columns of 
network [AT] and writes the columns of network [A] as the rows of network 
[AT]. It literally rotates the network 90° then mirrors the image horizontally. 

Remove self loops :  
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Reduced Form 
Used for removing clutter and making sure Nodesets are arranged in proper 
order. 

Transposes networks to their ontological order, i.e.,if there is an Agent x 
Location Network and a Location x Agent Network, then a single Agent x 
Location Network is created by combining the edges from both Networks. 

 

Unimodal Network Options 

Remove self loops : Removes all links that connect a node to itself 

Symmetrize by method : Turns directed or asymmetric network data 
into undirected or symmetric data. All three methods use a pair of values 
from the upper and lower portions of the table (e.g. cell 1, 3 is 
compared to cell 3, 1). If a network had a link from A to B but not from 
B to A then symmetrizing the network would create a reciprocal link from 
B to A. 

• Maximum Compares the values and uses the larger of the values. 
This is called using the strongest value. 
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• Minimum Similar to Maximum only it uses the lower, or weaker, 
value. 

• Average takes the two values and averages them. 

Combine networks of the same type using method: :  

Sum : Adds weights of links from all combined networks 

Binary : Sets link to [ 1 ] if there is a link an any two nodes or [ 0 ] if 
no network contains a link for two nodes. 

Average : Adds all links and divdes by the number of links found. 

Minimum : Uses the lowest link weight found in any network. 

Maximum : Uses the highest link weight found in any network. 

Bimodal Network Options 

Tranpose networks according to node precedence : Tranposes 
bimodal networks to ensure that certain nodeclasses appear first. The 
order is: Agent, Organization, Knowledge, Resource, Belief, Event, 
Task, Location. 

Combine networks of the same type using method: : See 
descriptions above 
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Delta Operations 

 

Miscellaneous 
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Change keyframe to date pattern: : Set the format for dates used in 
your Meta-Network 

Set image folder name: : Set location which contains images for nodes. 

Retain only nodes from this class that match: : Select the Nodeset to 
use. 

having an attribute with ID: and value: : From the above Nodeset, 
nodes need to have the particular names and values. 

Remove all node properties : Wipe the slate clean of all attributes. 

 

 

Meta-Network Anonymizer 

 Meta-Network Anonymize tool removes IDs (and optionally Titles) 
from any chosen Nodeset. This is particularly helpful if you are discussing 
sensitive network information about real people and wish to remove their 
names from the network model.  

The Visualizer 
Visualizer Before Anonymizing : When you load your network model into 
the Visualizer, you will see (by default) the names of your agents or 
applicable Nodesets. You may, for a number of confidentiality reasons, wish 
to hide this information from your audience yet still show them visually what 
the network can reveal.  
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Visualizer After Anonymizing : None of the nodes have recognizable 
names and only the link and network information is known. 
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Meta-Network Anonymizer dialog 
From the main menu select Data Management > Meta-Network 
Anonymize.... 

The Meta-network Anonymizer tool will appear in a pop-up window. Here 
you can select a number of parameters pertinent to the Nodesets you wish 
to anonymize.  
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1. Select a Meta-Network : All active Meta-Networks appear in the 
drop-down menu. Select the Meta-Network to anonymize. 

2. Friendly names : The user can create a list for each Nodeset of 
names that will not be anonymized. 

3. Anonymizer values :  

4. Options :  

o Remove alias attribute :  

o Remove latitude/longitude attributes : Removes geospatial 
attributes from the Meta-Network. 

o Anonymize only titles :  

o Create anonymized name attribute : If you would like to use 
descriptions other than Names, you can generate your own 
terms. This is intended to be used with the friendly anonymizer 
tool but can be used for whatever reasons you deem fit. To do 
so, be sure the create Name Attribute is checked then enter 
your own term. 
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5. Anonymize button : Click the button when you are ready to crate an 
anonymized file. 

Writing an Anonymized file : When the [Anonymize] button is selected 
ORA writes a .CSV file. The Save box allows the user to navigate to a 
directory to save the file. 

Encoded ID,Original ID 
A-1,A01 
A-2,A02 
A-3,A03 
A-4,A04 

Node Title : If the Anonymize node title is selected then ORA will also 
write the original Title to the file. 

Encoded ID,Original ID,Title 
E-1,E01,revanna_meeting 
E-2,E02,summit_meeting 
E-3,E03,revanna_bombardment 
E-4,E04,sgc_meeting 
 

 

Meta-Network Clean 

When large datasets are created people's names are after written differently 
through many different documents. For example you could see someone 
referred to as John in one documents, John Smith in another doucments, 
and John W. Smith in yet another document. All three of the these names 
refer to the same person but in ORA they would be considered different 
individuals. 

This function provides additional cleaning for text analysis. The user can 
select and operate on multiple meta-networks at once. The new dialog is 
under the Data Management main menu item. The following functions are 
available. Select from the main menu Data Management > Meta-
Network Clean... 
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Functions 
Convert LexisNexis meta-network to our standard meta-ontologies. 

Apply Change Lists 

Create Blank Change Lists. 

Workflow 
Load LexisNexis data called Afghanistan.xml, which is a dynamic meta-
network in the LexisNexis format typical from Juergen's analyses. Open 
the Text Analysis Cleaner dialog. Select all of the meta-networks in the 
dynamic meta-network. Click [ Next ]. 

 

Apply A Change List 
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Next a Change List is applied to the Agent and Knowledge Node Classes. 
These meta-ontologies are standard, and the Node IDs are standard. You 
should expect the Change Lists to apply well. Click on the Apply Change 
Lists tab. Click the [ Browse ] button and navigate to your change list file. 
Click the [ Run ] button. 

 

Create A Change List 
You can now export empty (or blank) change lists that can then be loaded 
into Excel and edited for an iterative cleaning process. Click the Create 
Change Lists tab and place a check mark next to all Nodesets to export. 
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This will create a union all of the selected Afghan meta-networks to create 
combined Nodesets. It will also create a single file per Nodeset by 
appending _agent, _knowledge, _task to the base filename. The 
Frequency column of the newly created (blank) change lists will be 
populated according to this rule: if the node has a frequency attribute, 
then its value is used (it will be summed across meta-networks); 
otherwise the node's total degree is used. 

NOTE : This can easily be misleading, for example, suppose a node exists 
in all the meta-networks, but only in the first one has the "frequency" 
attribute. This frequency value will be used, even though it is based on 
only one meta-network. 
 
NOTE : Only CSV files are currently used; Excel (.xlsx) will be supported 
shortly. 
 
NOTE : This dialog could be combined with the Meta-Network Transform 
dialog or perhaps that is not a good idea? Suggestions welcome. 

Lexis Nexis 

 

Click [ Run ]. The following transformations are made: 
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1] Node IDs need to be converted to standard node IDs. What happens 
is: 

Nodes are all converted to Lowercase. 

All punctuation is removed. 

Spaces converted to underscores. 

2] Node Class meta-ontologies are changed to those used in Automap. 

3] The meta-networks are made Reduced Form, which means: 

Uni-modal networks are symmetrized. 

Bi-modal networks are combined into a single direction (e.g. AK and 
KA are combined into a single AK. Order is defined by precedence. 

Self-loops are removed 

The Results Log of the transformation is available but at this time is not very 
interesting. This becomes more important when a Change List in applied. 

 

 

Meta-Network Union 

 Meta-Network Union is used to combine two or more Meta-Networks 
together. There are tools to select which Meta-Networks to use or exclude 
and how to combine the link weights. ORA can save out the result as an 
entirely new Meta-Network file.  
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Select Files 

 

Place a check mark next to all Meta-Networks you want to select Networks 
from for the new Union Meta-Network. You can also select the radio button 
to Union the meta-networks files (.xml) in the directory and navigate 
to a folder. 

Here I selected all three of the current Meta-Networks. You can chose any 
set to union. 

Select Networks 
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Place a check mark next to all Networks you want to place into the new 
Union Meta-Network. 

I deselected all but the agent and knowledge Nodesets. I could have also 
deselected any of the Networks  
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General Union 

 

The Link Options allow you to select the meta data that will be ported into 
the union. You can also select whether to add the new union to the Meta-
Network pane or save it out to a file. Choose to combine the link options 
with: sum, average, maximum, minimum, and binary values. 
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Select how to handle both numeric and text attributes. For numeric 
attributes chose from keep first value, overwrite values, keep all 
values, sum values, average values, keep maximum value, keep 
minimm value. For text attributes you can chose from keep first value, 
overwrite values, or keep all values. 

 

For custom attributes select for each one how to transfer their values from 
keep first value, overwrite values, keep all values, sum values, 
average values, keep maximum value, keep minimm value. 
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Automap Union 

 

Select how to transfer your link values from the Automap file, sum, 
average, maxmum, minimum, or binary values. 

You can also chose to add the union to the Meta-Network pane or save it to 
a file. 
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Examples 
The Foundation-Union 

 

 

I started out with three Meta-Networks 
from the Foundation dataset. I selected 
all three, right-clicked on them and 
selected union. I deselected all the 
Nodesets except agent and 
knowledge. Then clicked the 
[ Compute ] button. 
 
ORA combined these three Meta-
Networks into one combining only the 
Nodesets and Networks that were 
selected. 
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Attribute Partition Tool 

 To create new Meta-Networks which are a subset of nodes use the 
Attribute Partition. Select a Nodeset(s), select the Attribute set, then 
select the individual attribute(s) to form a new Meta-Network. 

 

There are four sections to the dialog box: 

Select a Meta-Network: The dropdown menu lists all the currently open 
Meta-Networks 
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Select Nodeset(s): Place a checkmark in the box(es) of the Nodesets you 
want included. 

Select an attribute: This drop-down menu shows all the attribute(s) 
contained within the selected Nodeset(s). If you change the Nodeset(s) the 
choice of attribute(s) will be reflected in this dropdown. 

Attribute Value: Place a checkmark in the box(es) of the attributes you 
want included in the new Meta-Networks. Each attribute check marked will 
create a separate Meta-Network. 

When you click the [Compute] button ORA will tell you how many new 
Meta-Networks were created and you will see them in pane 1 of the GUI. 

Create New Meta-Network Example 
Using the Doctor Who Companion Network I selected the gender attribute. 
In the value section I placed check marks in all three boxes in order to 
create three new meta-networks. When I click the [Compute] button ORA 
creates three new meta-networks. 
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Males 

 

Females 
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Robots 

 

 

Randomize Existing Network 

NOTE : This function only available in the full version. 

 Randomizing Links is commonly done to test a hypothesis about a 
given network. If after conducting experiments, there is no significant 
difference between a hypothesis and a random graph, the evidence 
supporting the hypothesis could be weak. 

A Random Graph : is obtained by starting with a set of n nodes and 
adding Links between them at random. Different random network models 
produce different probability distributions on networks. 

The theory of random networks studies typical properties of random 
networks, those that hold with high probability for networks drawn from a 
particular distribution. For example, we might ask for a given value of n and 
p what the probability is that G(n,p) is connected. In studying such 
questions, researchers often concentrate on the limit behavior of random 
networks-the values that various probabilities converge to as n grows very 
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large. Percolation theory characterizes the connectedness of random 
networks, especially infinitely large ones. 

Random networks are widely used in the probabilistic method, where one 
tries to prove the existence of networks with certain properties. The 
existence of a property on a random network implies, via the famous 
Szemerédi regularity lemma, the existence of that property on almost all 
networks.  

Creating a Random Graph : is a function which randomizes the Links in a 
Network. From the main menu select Data Management > Randomize 
Links. From the dialog box select from the drop-down menu. A new Meta-
Network will appear in Pane 1 and it's name will denote it has been 
randomized. 

 

The original Meta-Network is selected and the Network agent x agent is 
chosen. From the Info Tab in the Editor the button is 
clicked. This displays the Network as it appears in the original Meta-Network. 
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Now select the newly created randomized Network and select the agent x 
agent Network. From the Info Tab in the Editor the 
button is clicked. This displays the Network as it appears in the randomized 
Meta-Network. 

As shown in the visualizer the links have been randomized. 
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Generate Network 

 

Create New Meta-Network : Creates a new blank Meta-Network. 

 

Influence Network Generator : Creates an Influence Network file 
for use in the external program Pythia. 

NOTE : This function only available in the full version. 

 

Command and Control Structure Generator : Creates Network 
files for use in the external program Caesar III. 

NOTE : This function only available in the full version. 

 

Create New Meta-Network In Visualizer : Creates a blank Meta-
Network in the Visualizer which can be populated with Nodesets and 
Networks from scratch. 

 

Create Stylized Network : Generates new Networks using various 
Mathematical formulas including Erdős-Rény, Core-Periphery, Scale-
Free, Cellular, Lattice, and Small-World Networks 
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Create Expected Interaction Network : Predicts the expected 
interaction of a network given known tasks and other available 
network data. You can create: Expertise Correlation, Similarity 
Correlation, Distinctiveness Correlation, and Resemblance Correlation 
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Influence Network Generator 

NOTE : This function only available in the full version. 

Influence Network : is a hypotheses regarding tasks, performance, 
event happening, and related events. This functions covers how to 
generate an influence network from a social network using ORA and 
examines the probability of event happenings based on the state and 
influence of supporting nodes. 

The Influence Network Generator tool in ORA takes a Meta-Network and 
outputs an influence network that is readable by another software program, 
Pythia. Pythia, a software tool developed by George Mason University, has 
the ability to reason about an influence network's structure extracted by 
ORA. Therefore, ORA and Pythia can work in conjunction to perform an 
influence network analysis. Essentially, ORA generates the network and 
Pythia tells you something about it.  

ORA generates influence nets for Pythia from Meta-Networks. ORA can also 
read in a Pythia influence net and assess its structure. After ORA generates 
an influence network, the user then has to work with Pythia and a SME 
(subject matter expert) to get the probability distributions to make sense. 
The key advantage is by inferring the influence network from the meta-
network via ORA you save a lot of the start-up time in performing an 
influence network analysis. 

The ORA file generated by this function is directly loadable in Pythia. It is not 
a complete influence network and the user will need to make adjustments to 
the generated networks. It uses basic ontological interpretations and 
inferred baseline probabilities where the user specifies positive/negative 
probability. 

We create an influence network based on: Extracting a task network which 
directs the target task to analyze. Then examine the complexity, 
importance, personnel/resource/expertise assignment of the tasks. 

The examinations become influence network nodes containing ontological 
interpretation when: The task is done — the task is complex — the task is 
important — there are sufficient actors associated with the task — resources 
are available — expertise is available. 
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Then links are created as in the task network and background hypotheses 
nodes link to a task node. 

Running the Routine : From the main menu: File > Influence Network 
Generator. This brings up the Influence network step by step creation 
dialog box. There are three options: Task Based, Event Based, and Belief 
Based.  

 

After selecting the creation type and clicking [Next] you will be presented 
with a number of steps depending on what information needs created. 

 

Information on the thresholds you want and other data will be input in the 
dialog boxes until the final screen is reached. 
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When all the information is input a dialog box with the results will display. 
This is the final check before clicking the [Convert] button and saving the 
file. 

Il-Chul Moon, Destabilization of Adversarial Organizations with Strategic 
Interventions, PhD Thesis, School of Computer Science, Carnegie Mellon 
University 

 

 

Extracting a Task Network for the 
Influence Network Generator 

NOTE : This function only available in the full version. 

What follows are procedures to extract a Task Network for the Influence 
Network Generator. 

In a Meta-Network there is an event-to-event network and a task-to-task 
network. Choose one task to analyze. 
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Here we look at bomb preparation. Find the tasks that need completed to 
accomplish the objective. Then trace from provide_money, get_money, 
purchase_oxygen.  

 

The complexity of the task depends on three items. Resources / Expertise 
required and number of person required.  
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• Very Low (default baseline=1.0): 0 resource/expertise required / 1 
person required. 

• Low (default baseline=0.9): 1 resource/expertise required / Less 
than 3 persons required. 

• Medium (default baseline=0.8): Less than 4 resource/expertise 
required / Less than 4 persons required. 

• High (default baseline=0.7): Less than 8 resource/expertise 
required / Less than 7 persons required. 

• Very High (default baseline=0.6): More than 7 resource/expertise 
required / More than 6 persons required. 

 

The importance of the task is determined by using standardized degree 
centrality and betweenness (ranging (0~1): 

• Very Low (default baseline=0.4): Not connected to other tasks 

• Low (0.5): Low out-degree density and low betweenness in task 
network 

• Medium (0.6): Medium out-degree density and low betweenness in 
task network 

• High (0.7): High out-degree density or medium betweenness in task 
network 

• Very High (0.8): High out-degree density in task network 
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The actor assignment of the task is determined by sufficient actors, which 
are associated with the task. 

• No personnel (default baseline=0): No assigned actors 

• Insufficient (0.25): Only 75% of resources/expertise are covered by 
assigned actors. 

• Almost sufficient (0.5): More than 75% of resources/expertise are 
covered by the assigned actors. 

• Sufficient (0.7): At most one person associated with each resource 
and each expertise connected to the task. 

• More than sufficient (0.8): More than one person associated with 
some resources and expertise connected to the task. 

 

Resource / Expertise availability 
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Finds if Expertise and Resource are directly accessible. The availability is 
determined as follows: 

• Redundantly available/accessible baseline probability=0.75): 
More than one person with the expertise associated with the task. 

• Available/accessible (0.6): One person with the expertise/resource 
is associated with the task. 

• Unavailable/unaccessible (0.25): No person with the 
expertise/resource is associated with the task. 

Learn more... 

Il-Chul Moon, Kathleen M. Carley, and Alexander H. Levis, Inferring and 
Assessing Informal Organizational Structures from an Observed Dynamic 
Network of an Organization, Management Science, 2008, Submitted and 
under review 

Il-Chul Moon, Kathleen M. Carley and Alexander H. Levis, Vulnerability 
Assessment on Adversarial Organization: Unifying Command and Control 
Structure Analysis and Social Network Analysis, SIAM International 
Conference on Data Mining, Workshop on Link Analysis, Counter-terrorism 
and Security, Atlanta, Georgia, Apr. 26, 2008 

 

 

Pythia 

NOTE : This function only available in the full version. 

Pythia is a timed influence net application. Conversely, data from Pythia can 
be loaded into ORA using the Data Import Wizard.  

In conjunction with the Pythia application from George Mason University, 
data from ORA can be loaded into Pythia to create organizational displays.  

What follows is a brief example of creating an organizational display using 
ORA with Pythia.  

Start from an ORA Task Network (shown below) 
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The data can be loaded into Pythia to create an organizational display. 
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Reference at the George Mason University web site: 
http://sysarch.gmu.edu/main/software/ 

Contact George Mason at the above URL for instructions on downloading 
Pythia and additional instructions on how to use the tool.  

Learn more... 

Il-Chul Moon, Destabilization of Adversarial Organizations with Strategic 
Interventions, PhD Thesis, School of Computer Science, Carnegie Mellon 
University 

  

  

  

http://sysarch.gmu.edu/main/software/
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Command and Control Structure 
Generator 

NOTE : This function only available in the full version. 

C2 Structure and Meta-Network 
A Meta-network is a representation of a complex adaptive system. This 
system it has agents, expertise, resources and tasks. And inherent in this 
data are Meta-networks that contain the C2 structure of an organization, 
which are the links of a social network among commanders represented in 
the following ways: 

• Command chains 

• Information sharing relations 

• Result/response sharing relations 

However, meta-networks may only have one commander-to-commander 
network without classifying the nature of links. An analyst oftentimes needs 
a method to infer the nature of relations among commanders based on a 
given meta-network. That is where this tool can help. ORA uses the task 
assignment and communication directions to infer the nature of a link. 

C2 structure in CAESAR III : Design View and Analysis View can be 
generated from a series of matrices describing the communications among 
decision makers (agents). The goal should be producing the matrices out of 
a social network. The analysis view has cognition aspects The nature of a 
link is determined by the timing of communication during the decision 
making process. 

Meta-Network : Network among people (, knowledge, resources, tasks, 
etc). Data for statistical analysis, not exactly an analysis tool. Reveal the 
organizational structure, influence propagation, command and control 
structure, etc. Widely used in organizational science, counter-terrorism, 
structure reformation, etc. 

C2 structure extraction in ORA : ORA provides a function, Command and 
Control Structure Generator. Automatic generation of C2 structure based on 
a target task and a social network among decision makers. Generated 
influence network is directly loadable in CAESAR III. It is not a complete C2 
structure but a reasonable inference (or approximation). 
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C2 Structure Generation Procedure 
Determine a target task to analyze. Extract the task network of the target 
task. Extract the related (assigned) agents of the task network. The other 
agents are aggregated and represented as the outside world (IN and OUT). 
Regard the agent-to-agent network as a information sharing network. 
Determine the network level based on the link directions and network 
topology. Then, extract a command chain from links bridging different 
network level. Determine the result sharing requirement based on the task 
network (i.e. the link direction between the two tasks indicate the result 
sharing requirement) Then, create a result sharing network based on the 
requirements. 

 

 

Extracting a Task Network for the 
Command and Control 

NOTE : This function only available in the full version. 

What follows are procedures and an overview of extracting a task network 
for command and control analysis using ORA in conjunction with Caesar III, 
an external software tool for task network analysis.  

In a Meta-Network, there are event-to-event networks and task-to-task 
networks contained in most data sets. We select one task to analyze and use 
ORA's command and control tool to discover the steps needed to complete 
this task from beginning to completion.  

In the images below, we are extracting a task network needed for the 
bomb_preparation task node. 

The idea is to find how tasks should be completed to accomplish the 
objective, bomb_preparation (e.g., find the trace to a purchase_oxygen 
task. Provide_money —> get_money —> purchase_oxygen). 
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Assigned Agents 
Identify the task network. Find all the assigned agents. Agents directly 
linked to a task in the task network. 
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Approximated Information Sharing Network 
Just the agent-to-agent network in a meta-network. 

 

Inferred Command Chain 
Determine the network level. Find the inferred hierarchy of the organization. 
Find the command chain from the hierarchy. 
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Red arrows are command chains. Purple arrows are social network links. 

 

Inferred Result Sharing Network 
The task network defines the task prerequisites. Then, the result of a task 
should be informed to the agents doing the next task. Create a result 
sharing network by using the above inference rule. 
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Ahmed_ghallani should inform the result of purchase_oxygen to the agents 
doing bomb_preparation. Purchase_oxygen is a prerequisite of 
bomb_preparation. 

Visualization by CAESAR III 
Generated by ORA. Target task : surveillance. Design view and analysis view 
in CAESAR III. 

 

Learn more... 
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Il-Chul Moon, Kathleen M. Carley, and Lee W. Wagenhals, Estimating Task 
Success Likelihood by an Influence Network Generated from an 
Organizational Structure, Organization Science, 2008, Submitted and under 
review 

Il-Chul Moon, Eunice J. Kim and Kathleen M. Carley, Automated Influence 
Network Generation and the Node Parameter Sensitivity Analysis, 
International Command and Control Research Technology Symposium 
(ICCRTS’08, DOD CCRP conference), Bellevue, WA, Jun 17-19, 2008 

  

 

Caesar III 

NOTE : This function only available in the full version. 

Caesar III is a software application for the design of decision making 
organizations at the operational and tactical levels; it takes into 
consideration cultural differences in coalitions and of adversaries. What 
follows in overview of how Caesar III and ORA can work together.  

ORA can import data from Caesar III. See the Data Import Wizard for 
detailed instructions.  

The Design View and Analysis View can be generated from a series of 
matrices describing the communications among decision makers (agents). 
The goal should be producing the matrices out of a social network. The 
analysis view has cognition aspects. The nature of a link is determined by 
the timing of communication during the decision making process. 
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Meta-Networks are generated by ORA. Then through Caesar III's Design 
and Analysis Views their structure is analyzed. 

Reference at the George Mason University web site: 
http://sysarch.gmu.edu/main/software/ 

Contact George Mason University at the above URL for instruction on 
downloading Caesar III data. 
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New Meta-Network in Visualizer 

From the main menu select Generate Networks > Create New Meta-
Network in Visualizer. This does two things: 

1) It creates an empty Meta-Network in the Meta-Network Manager Pane. 

2) It brings up an empty Visualizer window to create a Meta-Network. 

NOTE : The Main Interface and the Visualizer are linked. What you do in one 
is reflected in the other. 

The Windows  

 

Your work area contains, from left to right, Meta-Network Designer, 
Visualizer window, and Legend. 
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The Meta-Network Designer Window 

 

The Designer box contains four areas. 
 
The Nodes Button : Displays the graphic 
representation of the selected Nodeset 
 
The Links Button : Allows you to change 
the link weight. 
 
The Agents Drop Down menu : Used to 
select a Nodeset for placing a new Node. 
 
The Avatars Drop Down menu :  
 
The Icon Display Area : Shows the 
current group of icons available. 
 
The New Nodeset Button : This menu 
starts out empty until you create u.a 
Nodeset. Once Nodesets are created they 
will appear in this men 

Creating New Nodes 
To create a new node select a Nodeset, select a link weight, then click, and 
hold, an icon and drag it into the Visualizer window. 
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Creating New Links 

 

In the Designer window click the [Links] 
button. This brings up buttons to set the 
weight of new links. 
 
The drop down at the bottom defaults to 
Auto-Find and Create Networks. 
 
If you place a check mark in the Auto-
Create Bidirectional Links when you 
create a link. (e.g. You create a link from 
Node A to Node B) ORA will automatically 
create a complementary link (e.g. a link 
from Node B to Node A will be added). 
 
To create links, click and hold the left 
mouse button on a node. Then drag the 
cursor to another node and release the 
button.  
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Final Network 
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Create Stylized Networks 

Stylized Networks are models built upon common network structures evident 
in many real world environments. 

Erdős-Rényi Network : A model for generating random graphs by setting 
an Link between each pair of nodes with equal probability, independently of 
other Links. 

Core-Periphery Network : The core-periphery structure of the network 
has a dense central core of key agents and a large periphery of marginal 
agents. 

Scale-Free Network : Some nodes act as highly connected hubs (high-
degree), although most nodes are of low degree. Scale-free networks' 
structure and dynamics are independent of the system's size N, the number 
of nodes the system has. In other words, a network that is scale-free will 
have the same properties no matter what the number of its entities is. 

Cellular Network : Highly connected cells connected by a few links. 

Lattice Network : A Lattice Network is a large-world network. 

Small-World Network : Where most nodes are NOT neighbors but can be 
reached from every other node by a small number of hops or steps. 

Fixed Degree-Distribution Network : A random graph is constructed by 
specifying as input: (a) the number of nodes in the network, and (b) the 
number of link for each node. The graph is random according to the input, 
however it should be noted that not all degree sequences are illogical so this 
algorithm may produce an empty graph as a result. read more… 
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Cellular Network 

 

General 
A small number of tight clusters with few links between clusters. 

Properties 
Large distances. 

High local structure [clustering]. 

Dialog Box 
Number of Cells : How many groups [clusters] for the network. 

Inner Density : How dense should the network within each cell be? 

Outer Density : How dense should the connections between cells be? 



351 
 

 

 

 

Core Periphery 

 

The core-periphery structure is an ideal typical pattern that divides both the 
rows and the columns into two classes. One of the blocks on the main 
diagonal (the core) is a high-density block; the other block on the main 
diagonal (the periphery) is a low-density block. The core-periphery model is 
indifferent to the density of ties in the off-diagonal blocks. 

When we apply the core-periphery model to actor-by-actor data 
(Core/Periphery), the model seeks to identify a set of actors who have high 
density of links among themselves (the core) by sharing many events in 
common, and another set of actors who have very low density of ties among 
themselves (the periphery) by having few events in common. Actors in the 
core are able to coordinate their actions, those in the periphery are not. As a 
consequence, actors in the core are at a structural advantage in exchange 
relations with actors in the periphery. 

There are Two kinds of nodes 
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Core of interconnected nodes. 

Periphery of pendants with single connection to Core. 

Properties 
Short distances 

Some local structure (core vs non-core) 

Dialog Box 
Proportion of core nodes :  

Density of core nodes : How dense should the within-core network be? 

 

 

Erdos-Reyni Network 

 

General 
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Networks are purely random 

They are the most commonly form studied. 

Properties 
Short distances. 

No local structure (clustering). 

Very different than real-world networks. 

Dialog Box 
Input : Approximate density of resulting network. 

 

 

Ring Lattice Network 
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Nodes are placed at the integer coordinate points of the n-dimensional 
Euclidean space and each node connects to nodes which are exactly one unit 
away from it. (i.e. if the lattice is two dimensional and the length of 
the lattice is 2 along the first and 2 along the second dimension, 
then it has 4 nodes and they're placed at coordinates (1,1), (1,2), 
(2,1), (2,2)) The two nodes are connected if the difference of one of their 
coordinates is one or minus one and all their other coordinates are exactly 
the same. 

General 
Nodes laid out in a circle and connected to their K closest neighbors. 

Properties 
High clustering. 

High average path length 

Dialog Box 
Number of agents : Network size. 

Number of neighbors : Number of neighbors each node is connected to 
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Scale Free Network 

 

Their most distinguishing characteristic is that their degree distribution 
follows a power law relationship, \mathbf{P(k) \sim k^{- \gamma}}, 

 

Where the probability P(k) that a node in the network connects with k other 
nodes was roughly proportional to , and this function gave a roughly good 
fit to their observed data. The coefficient may vary approximately from 2 to 
3 for most real networks. 

Process 
New nodes more likely to connect to existing nodes with high degree. 
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Properties 
Short Distances. 

No local structure. 

Dialog Box 
Density : How dense should the resulting network be?. 

Initial network : How big should the simple (erdos-renyi) seed network 
be? 

Initial density : How dense should the simple (erdos-renyi) seed 
network be? 

 
 

 

Small World Network 
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A type of graph in which most nodes are NOT neighbors of one another, but 
most nodes can be reached from every other node by a small number of 
hops or steps. A small world network, where nodes represent people and 
links connect people that know each other, captures the small world 
phenomenon of strangers being linked by a mutual acquaintance. 

The small-world behavior is characterized by the fact that the distance 
between any two inks is of the order of that for a random network and, at 
the same time, the concept of neighborhood is preserved. 

A Small-World Network is a regular network with a degree of random long 
range connections. It is rarely disrupted by the elimination of one node. 

Creation in Three Steps 
Begin with a lattice, e.g., 2D grid with k nearest neighbors connected. 

Randomly remove connections. 

Randomly add long distance connections. 

Properties 
High local structure (clustering). 

Short maximum distances 

Dialog Box 
Number of neighbors : Dimensionality of embedding space/lattice. 
Alternatively, average degree. 

Probability of removing a neighbor : Remove any local structure? 

Probability of adding a neighbor : Add long-range connections? 

Power law exponent : How much should long-range connections ignore 
local structure? 
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Fixed Degree-Distribution Network 

Create Fixed Degree Distribution : creates a random graph constructed 
by specifying as input: (a) the number of nodes in the network, and; (b) 
the number of links for each node. The graph is random according to the 
input, however it should be noted that not all degree sequences are illogical 
so this algorithm may produce an empty graph as a result. 

 

Allow self-loops : Checked allows the generation of a node tied to itself. 
Unchecked disallows the generation of a node tied to itself 

Construct directed-tie network : Checked generates directed network. 
Unchecked generates an undirected network 

If directed, then count is inbound, else outbound : Checked the 
degree list is incoming ties. Unchecked the degree list is outgoing ties 

Degree list : Enter the degree listing – in the desired node order. The input 
for the degree sequence is a comma delimited list of the number of edges. 
Correspondingly, the number of nodes is determined by the number of 
parameters entered.  

To facilitate simplified entry, a shortcut can be made by specifying the 
number of nodes at a specific number of edges. Further, the node id in the 
generated graph will correspond with the position in the input string. 

Degree sequences that are illogical will be impossible to generate, e.g., 
2@20 (two nodes with 20 ties each; impossible because the maximum ties a 
node can have in this network of size two is 1 tie.) Further, some networks 
can be difficult to produce due to the specific degree distribution and the 
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random process used to construct the network, so the algorithm is designed 
to make up to 10 separate attempts at constructing the exact distribution. 
After 10 attempts, the algorithm will return the error meta-network. The 
user may chose to resubmit the same request for another up-to-10 attempts 
at making the network. 

For example, the following are valid input strings (with self-loops off and 
undirected): 

• 1,5,3,0,1 - produces a 5 node network with one isolate and 2 
pendants, etc. 

• 3@2, 0, 0 - produces a 5 node network with 2 isolates and 3 nodes 
with 2 edges. 

• 10@5,10@3 - will produce a 20 node network 

The following are valid input strings but illogical: 

• 100,0,1 - is illogical and will produce a null meta-network named with 
an error message 

• 3@2,1 - is illogical and will produce a null meta-network named with 
an error message 

• 10@5,10@3,1 - is illogical will produce a null meta-network named 
with an error message 

 

 

Create Expected Interaction Networks 

NOTE : This function only available in the full version. 

Below is an image of the Expertise Correlation tool in ORA and 
procedures on using the various options it contains: 
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Below are links to the Measures section pertaining to each 
Correlation. 

  Expertise Correlation… : Measures the complementarity of two 
agents based on their knowledge. 

 

  Similarity Correlation  

Measures the degree of similarity between agents based on the 
number of knowledge bits they both have. 
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  Distinctiveness Correlation… : Measures how distinct are two 
agents based on the number of knowledge bits they hold oppositely. 

 

  Resemblance Correlation… : Measures the degree of 
resemblance between agents based on the number of knowledge bits 
they both have or both do not have. 
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Analysis Menu 

 

Generate Reports : Top level for all the ORA reports. These are 
further grouped into similar reporting groups to make it easier to 
find the particular report you want. 

 

Measures Manager : The option allows you to choose which 
measures are to be used in generating reports for the selected 
Meta-Networks. The dropdown menu allows you to chose 
measures lists which divide them up into categories such as: 
Slow Measures, Critical Risk Employees, and Resource 
Allocation Risk. 

 

Batch Mode Console : Opens a console window that lets the user 
to type commands and execute in a non-graphical way. It is an 
advanced menu item. 

 

Topic Analysis : Analysis using the LDA [Latent Dirichlet 
Allocation] and LSA [Latent Semantic Analysis] Clustering functions. 

 

Correspondence Analysis : Runs a correspondence analysis on 
the selected network to find patterns in the row and column entries. 

 

Geary-C & Moran-I Analysis... : This function performs Moran's I 
test using phylogenetic and spatial link matrix (binary or general). 
It uses neighbouring weights so Moran's I and Geary's c 
randomization tests are equivalent. 

 

 

Generate Reports 

 Creates reports on the selected Meta-Networks. These reports are 
detailed in the Reports Section. 

You can choose an individual report from the drop-down menu or use 
the By Category drop-down menu which forms them into groups by 
function. All measures are in both drop-downs. 
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After choosing a report from the drop down menu a description and 
output format will appear beneath it. 

The next section allows you to chose which Meta-Networks to run the 
report on. Place a check mark next to all reports to use. 

Clicking on the downward poiting double arrow reveals the 
Transform section which allows you to select the method the Meta-
Networks are changed prior to running the report. 

• General mathematical transformation :  

• Remove node :  

• Partition nodes into separate Meta-Networks by attribute 
value :  
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Click [Next] 

This next screen will differ depending on which report was chosen. 
For some reports you will be taken directly to the print screen. For 
others there will be additional information you need to specify. 

The Final Print Screen : allows you to chose whether to write the 
file to a Text, HTML, CSV, or PowerPoint file and tell ORA where to 
save it. You can also choose to use a different filename for all the 
reports written. 

 

 

All Measures Report 

There are several different ways to get network measures in ORA. 
The normal way is by using reports. Reports are collections of 
measures based on different research questions. The Standard 
Network Analysis report includes all measures. 

The All Measures Report defaults to running all measures in the 
system. But you can define this report to only run specific measures 
using The Measures Manager. From the main menu select 
Analysis > Measures Manager. 
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From this box you can select or unselect all/some measures. 
Notice that each measure has a First and Last name. This is to 
assist in finding specific measures. There is also a search filter and 
drop down AND/OR box will also aid in this task. 

NOTE : For faster selection you can use the [Select] or [Un-Select] 
buttons. 

Example : If you want to find degree and betweenness 
centrality, we can first select centrality in the last name field and 
then select degree centrality and betweenness centrality in the 
window. When you are finished with selecting the measure, close 
the window to save the options. When next you select the All 
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Measures Report only the measures you selected in the Measures 
Manager will be calculated. 
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Measures Manager 

 Before you run any measures on a Meta-Network you can use 
the Measures Manager to set exactly the measures you wish to 
compute. 

Form the main interface menu select Analysis > Measures 
Manager. 

 

NOTE : You can sort the measures by clicking on any of the headers. 

The dialog box has multiple sections: 
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Filter Commands : 
This section comprises two radio buttons (Match at least one filter 
| Match all filters) which allow for complex filtering, a [Reset 
Filters] button, and a Search text box used for inputting your 
search. Whatever searches you input in this section are reflected in 
the Tabbed Window below. It will display only the nodes which 
match the search(es). 

Item(s) Selected | Visible | Total 
When first called up the All Measures tab defaults to showing every 
measures available. When started there were 137 item(s) selected, 
137 visible, 137 total. 

Selecting the Slow Measures tab this changes to 16 item(s) 
selected, 16 visible, 16 total. 

Typing Cognitive into the search text box reduces this to 16 
item(s) selected, 8 visible, 16 total showing that only 8 out of the 
16 Slow Measures contain the word Cognitive. 

Furthermore you can unselect measures by removing the checkmark 
next to the measure's name. With each measure deselected the 
number of selected items will reduce by one. 

With these tools you can select only the measures you want to run 
reports on. 

Buttons 
• Reorder 

• Select All : Selects (puts a checkmark in the box) all visible 
measures 

• Clear All : De-Selects (removes check marks) from all visible 
measures. 

Tabbed Window 
This section contains tabs which sort the measures into various 
categories. 
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Each of the nine tabs sorts out the measures in different categories. 
This is very useful for large Meta-Networks when you'd prefer not 
run, say the Slow Measures* cause it would put too much a drain 
on your machine. By removing the check boxes for the Slow 
Measures they are taken out of the mix and the reports will 
effectively ignore them. You can turn them back on when you're 
finished by placing a checkmark back in the box. 

In the Tabbed Window there are four columns: 

1. Last Name : Deals the general type of measure (Congruence, 
Exclusivity, Cognitive...). Most entries in this column will 
display one row as they are singular in what they need to show. 
Others will display two rows as it's nearly the same measure 
run on both knowledge and resources. Then a few (like 
Centrality) will display quite a few rows the types of measures 
written for that type of measures are somewhat varied. 

2. First Name : Deals with the category of the measure 
(Betweenness, Closeness, Centrality...). This is a 
secondary factoring. 

3. Graph Level : Graph Level* produces a single number as 
output. 

4. Entity Level : Entity Level* produces one number per entity. 

Drop-Down Menu 
Gives the user the ability to select which currently active Meta-
Network to run the measures on, as well as, which individual 
networks. 
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Groupings of Reports 

This chart shows the groupings for the reports in ORA 

 

 

Groups and Which Reports They Contain 

Groupings  Reports  
Dynamics  Belief Propagation 

Change in Key Entities 
Immediate Impact 
QAP/MRQAP Analysis 
Statistical Change Detection 

Geospatial  Geospatial Assessment 
Key Entity 
Trails 

Groups  Core Network 
Local Patterns 
Locate Subgroups 

Knowledge Networks & 
Network Text Analysis  

Communicative Network 
Assessment 
Communicative Power 
Group Talk 
Hot Topics 
Large Scale 
Part of Speech 
Semantic Network 

Locate Key Entities  Change in Key Entities 
Communicators 
Critical Sets 
Key Entity 
Management 
Simmelian Ties Analysis 
Sphere of Influence 
Standard Network Analysis 
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Locate Key Relations  Shortest Path 

Specialty  Capabilities 
Drill Down 
Influence Net 
Merchant Marine 
Optimizer 
Public Health 
Rules of Engagement 
Tactical Insight 
Trails Analysis 

Statistical Procedures and 
Diagnosics  

Context 
Missing Links 
Potential Errors 
QAP/MRQAP Analysis 
Statistical Change Detection 
Statistical Distribution 

Show Me Everything    
 

 

 

Reports In Which Group 

ORA contains many reports for data analysis. The table below shows 
all the reports and into which groups they fall. 

Reports and the Groups In Which They 
Belong 

Report  Group(s)  
Belief Propagation Dynamics 

Capabilities Specialty 

Change in Key Entities Dynamics 
Locate Key Entities 

Communicative Network 
Assessment 

Knowledge Networks & Network 
Text Analysis 
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Communicative Power Knowledge Networks & Network 
Text Analysis 

Communicators Locate Key Entities 

Context Statistical Procedures and 
Diagnosics 

Core Network Groups 

Critical Sets Locate Key Entities 

Drill Down Specialty 

Geospatial Assessment Geospatial 

Group Talk Knowledge Networks & Network 
Text Analysis 

Hot Topics Knowledge Networks & Network 
Text Analysis 

Immediate Impact Dynamics 

Influence Net Specialty 

Key Entity Geospatial 
Locate Key Entities 

Large Scale Knowledge Networks & Network 
Text Analysis 

Local Patterns Groups 

Locate Subgroups Groups 

Management Locate Key Entities 

Merchant Marine Specialty 

Missing Links Statistical Procedures and 
Diagnosics 

Optimizer Specialty 

Part of Speech Knowledge Networks & Network 
Text Analysis 

Potential Errors Statistical Procedures and 
Diagnosics 

Public Health Specialty 

QAP/MRQAP Analysis Statistical Procedures and 
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Diagnosics 
Dynamics 

Rules of Engagement Specialty 

Semantic Network Knowledge Networks & Network 
Text Analysis 

Shortest Path Locate Key Relations 

Simmelian Ties Analysis Locate Key Entities 

Sphere of Influence Locate Key Entities 

Standard Network Analysis Locate Key Entities 

Statistical Change Detection Statistical Procedures and 
Diagnosics 
Dynamics 

Statistical Distribution Statistical Procedures and 
Diagnosics 

Tactical Insight Specialty 

Trails Geospatial 

Trails Analysis Specialty 
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Topic Analysis 

LSA and LDA come from alternate schools of thought that attempt to 
link together documents based on shared content, which is construed 
in aggregate as shared “themes”. To get these themes, both methods 
use a bag of words approach that, unlike the methods described 
above, does not look at adjacency as the sole definer of context. 
Rather each document is seen as one indiscriminate context. 
Correlations between all the words in documents are considered to 
determine underlying correlations that go beyond immediate context. 

Latent Semantic Analysis 
Latent Semantic Analysis (LSA) is a technique in natural language 
processing, in particular in vectorial semantics, of analyzing 
relationships between a set of documents and the terms they contain 
by producing a set of concepts related to the documents and terms. 
It finds correlations between particular words in documents and, from 
this, particular correlations between the documents by mapping the 
documents to a vector space of reduced dimensionality, the latent 
semantic space. After running LSA, an analyst will possess a number 
of correlations between terms of particular strengths and a number of 
correlations between documents dependent on the strengths of these 
term correlations. The method has been applied to a variety of 
different data; notable examples include looking at the 
communications of the ICA for information about relations within the 
discipline, and looking at presidential debates for salient features 
shared by election winners. 

Latent Dirichlet Allocation 
Latent Dirichlet Allocation (LDA) is a topic modeling algorithm first 
introduced in Blei et al, 2003. It takes a collection of Meta-Networks 
as input and uses a set number of topics to locate. Each Meta-
Network models a document and the Nodesets are combined to 
create a single list of concepts with frequencies determined by an 
attribute called Frequency. The algorithm assigns a probability that 
a topic belongs to a document and a probability that a concept 
belongs to a topic. For each topic the ten concepts with the highest 
probability of belonging to that topic are report. It is a method for 
attempting to determine the words that make up a set of topics 
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covered by a corpus of documents. LDA assumes that documents 
consist of a mixture of topics, and that the constituent words of the 
document are, individually, each members of particular topics. LSA 
attempts to find the strongest correlations between particular words. 
LDA, in contrast, uses probabilistic methods to identify which words 
are most closely linked in a topic. 

Although LDA was invented for document analysis in reality it can be 
used on any two mode data. Traditionally this was documents by 
words; however, it can be applied to other data such as people by 
locations. 

LDA is a latent space model that represents the first Nodeset in a 
much more compact set of hidden variable; e.g., representing a set 
of documents interms of a set of topics. In a typical LDA model a 
document is represented as a set of words or concepts, where each 
concept is assumed to belong to one or more of the hidden topics. 
Thus, the first Nodeset can be described by considering for each node 
its connections to nodes in the second Nodeset and the strength of 
their association to the hidden variables; in turn these variables can 
be described by the clusters of nodes in the second mode. For 
example, documents (mode 1 - first Nodeset) can be described by 
their association to topics (hidden variables) based on the words 
(mode 2 - second Nodeset) in the document and the topics can be 
described by the associated words. By considering nodes in the first 
Nodeset which are highly associated with the same hidden variable, 
we can begin to understand "clusters" (or groups) of nodes. 

A benefit of LDA as a clustering routine is that it supports 
characterization of nodes in one class by the distribution of their ties 
to nodes in another set. 

A shortcoming of LDA, is that an arbitrary number of hidden variables 
need be chosen by the user. To do this in ORA, Sensitivity analyses 
should be run to determine the right number of variables. 

Data Pruning 
For most clustering routines, especially with two mode clustering 
routines, common practice is to prune the data. Specifically nodes in 
mode 1 that are are connected to very few nodes in mode 2 (low out 
degree) are often removed before the clustering is run. For example, 
this is typically done with LDA and LSA. 
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Regarding Your Input Network 
The input daya needs to be a concept by text matrix if you want to 
do topic analysis. You can import a .csv file also if you want where 
the rows are concepts and columns are texts. You can also generate 
a concept by text matrix when you generate a semantic network from 
AutoMap. 

Example 
This is the 20040101union_timeInterval Meta-Network before 
processing. As you can see it is not very informative. 

 

We will process it with the LSA and LDA functions. 
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LSA 

 

 

Number of Topics 
determines the 
number of groups of 
concepts in the final 
Meta-Network. 
 
From the Editor's 
menu select 
Analysis > Topic 
Analysis. This 
brings up the Topic 
Analysis dialog. 
Select the Use 
Existing Network 
tab and select the 
Meta-Network. From 
the Network menu 
select Concept x 
Text. 
 
In the CHoose an 
algorithm and set 
its parameters: 
make sure the 
Latent Semantic 
Network tab is 
active. For the 
number of topics 
select 10. 
 
In the Which topic 
members should 
be returned? select 
the Only members 
with values in the 
top (rank): and set 
this to 10. 
 
Click the 
[ Computer ] 
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button.  

A new Meta-Network will be added to the Manager Pane. Expand this 
by clicking the [+]. Select the Topic x Concept network. The click 
the [ Visualize ] button. 

Network clustered using LSA 
Each of the numbered nodes represent a group. And in this 
example each of the groups contains 10 links as per the parameters 
set. 
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LDA 

 

 

The Select how to 
input... and Which 
topic members... 
sections are the 
same as in the LSA. 
 
The parameters for 
the LDA are more 
indepth than the 
LSA. You have: 
 
Number of Topics 
: The number of 
groups you want in 
the final display 
Number of 
iterations : The 
number of runs 
performed. 1,000 is 
the minimum. A 
higher number 
refines the results 
but will take longer 
to compute 
Step size : The 
number of iterations 
after which the 
model parameters 
are recomputed. 100 
is the minimum 
recommened. A 
higher step size will 
compute faster but 
will reduce accuracy. 
Beta : determines 
how heavily the 
empirical predictive 
distribution of a 
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multinomial Dirichlet 
is smoothed. Its 
default value is 0.1 
and can be altered 
to give the desired 
resolution in the 
resulting 
distribution. 

Network clustered using LDA 
Each of the numbered nodes represent a group. And in this 
example each of the groups contains 10 links as per the parameters 
set. 

 

References 
D. M. Blei, A. Y. Ng, and M. I. Jordan. Latent dirichlet allocation. J. 

Mach. Learn. Res., 3:993-1022, Mar. 2003. 
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Correspondence Analysis 

General Purpose 
Correspondence analysis is a descriptive/exploratory technique 
designed to analyze simple two-way and multi-way tables containing 
some measure of correspondence between the rows and columns. 
The most common kind of table of this type is the two-way frequency 
crosstabulation table. For a comprehensive description of this 
method, computational details, and its applications (in the English 
language), refer to the classic text by Greenacre (1984). 

Applies to categorical rather than continuous data. It provides a 
means of displaying or summarising a set of data in two-dimensional 
graphical form. All data should be nonnegative and on the same scale 
for CA to be applicable, and the method treats rows and columns 
equivalently. 

  Smoking Category   

Staff 
Group 

(1) 
None 

(2) 
Light 

(3) 
Medium 

(4) 
Heavy 

Row 
Totals 

(1) Senior Managers 
(2) Junior Managers 
(3) Senior Employees 
(4) Junior Employees 
(5) Secretaries 

4 
4 
25 
18 
10 

2 
3 
10 
24 
6 

3 
7 
12 
33 
7 

2 
4 
4 
13 
2 

11 
18 
51 
88 
25 

Column Totals 61 45 62 25 193 

Mass : To continue with the simpler example of the two-way table 
presented above, computationally, the program will first compute the 
relative frequencies for the frequency table, so that the sum of all 
table entries is equal to 1.0 (each element will be divided by the 
total, i.e., 193). You could say that this table now shows how one 
unit of mass is distributed across the cells. In the terminology of 
correspondence analysis, the row and column totals of the matrix of 
relative frequenciesare called the row mass and column mass, 
respectively.  
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Inertia : The term inertia in correspondence analysis is used by 
analogy with the definition in applied mathematics of "moment of 
inertia," which stands for the integral of mass times the squared 
distance to the centroid (e.g., Greenacre, 1984, p. 35). Inertia is 
defined as the total Pearson Chi-square for the two-way divided by 
the total sum (193 in the present example). 

According to the well-known formula for computing the Chi-square 
statistic for two-way tables, the expected frequencies in a table, 
where the column and rows are independent of each other, are equal 
to the respective column total times the row total, divided by the 
grand total. Any deviations from the expected values (expected under 
the hypothesis of complete independence of the row and column 
variables) will contribute to the overall Chi-square. 

Eigenvalues and Inertia for all Dimensions 
Input Table (Rows x Columns): &nbsp5 x 4 
Total Inertia = .08519 Chi2 = 16.442 

No. of 
Dims 

Singular 
Values 

Eigen- 
Values 

Perc. of 
Inertia 

Cumulatv 
Percent 

Chi 
Squares 

1 
2 
3 

.273421 

.100086 

.020337 

.074759 

.010017 

.000414 

87.75587 
11.75865 
.48547 

87.7559 
99.5145 
100.0000 

14.42851 
1.93332 
.07982 

 

References 
Correspondence Analysis. Retrieved on Spember 27, 2011, from 

http://www.statsoft.com/textbook/correspondence-analysis/. 
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Correspondence Analysis Example 

From the Editor Menu select Analysis > Correspondence Analysis. 

 

The Corresondence Analysis box will appear with a list of all currently 
loaded Meta-Networks. Place a check mark next to the Meta-
Network(s) to analyze. For Select an input network: select the 
network to analyze. When you are finished click [Compute]. This 
brings up the Scatter Plot. 
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The buttons at the bottom are navigation buttons: 

[ |<< ] Go To First Graph 

[ << ] Go To Next Graph 

[ >> ] Go To Previous Graph 

[ >>| ]Go To Last Graph 

The number in the middle of the buttons tells you which graph is 
currently displayed. 
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Moran-I and Geary-C 

Description 

 Moran's-I : The measure of spatial autocorrelation to study 
stochastic phenomena which are distributed in space in two or more 
dimensions. The values of Moran's I range from +1 meaning strong 
positive spatial autocorrelation, to 0 meaning a random pattern to -1 
indicating strong negative spatial autocorrelation. 

This particular statistic is designed for the measurement of global 
spatial autocorrelation of ordinal, interval or ratio data. 

 Geary's-C : Based upon a paired comparison of juxtaposed map 
values and ranges between 0 and 2. Positive spatial 
autocorrelation is found with values ranging from 0 to 1 and negative 
spatial autocorrelation is found between 1 and 2. However, values 
can be found greater than 2 on occasion (Griffith, 1987). As similar 
values are in juxtaposition the numerator which measures the 
absolute difference squared between juxtaposed values will tend 
toward zero. Whereas, as non-similar values become juxtaposed the 
statistic will tend toward larger values in the numerator and thus 
toward its maximum value of two. 

This particular statistic is designed for the measurement of local 
spatial autocorrelation of ordinal, interval or ratio data. 

Example 

 Moran's I Geary's C 
A 0.9 .04 

B 0.2 0.9 

C -.8 1.8 

A has positive global spatial autocorrelation and local spatial 
autocorelation. 

B is random with respect to space. 
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C has negative global and local spatial autocorrelation. 

 

Select Proximity Network : Select a Meta-network from the first 
dropdown menu. The second dropdown menu will contain all the 
networks in the selected Meta-Network. 

Create Values Vector : There are three ways to select a value 

1. Use the values of attributes : uses an attribute within the 
Meta-Network. 

2. Load values from file : browses for a file previously 
constructed. 

3. Use combined degree centrality of the networks : Place a 
checkmark for one (or more) networks within the selected 
Meta-network to use. Combines the centrality to use in the 
formulas. 
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Results : Displays the Moran-I and Geary-C results. 

  

 

Reference 
Geary, R. C. (1954). "The Contiguity Ratio and Statistical Mapping". 

The Incorporated Statistician (The Incorporated Statistician) 5 
(3): 115-145. 

Moran, P. A. P. (1950). "Notes on Continuous Stochastic 
Phenomena". Biometrika 37 (1): 17-23. 
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Simulations 

 

Near-Term Analysis : The Near Term Analysis (NTA) is a tool 
that allows for the removal of nodes from a given organizational 
structure to evaluate how the organization will likely perform as a 
result. 

 

OrgAhead : OrgAhead is an organizational learning model designed 
to test different forms of organizations under a common task 
representation. Each member of the organization receives 
information from a subordinate or from the environment, makes a 
decision based on the information and what he or she has learned 
so far, and provides superiors with an answer to the decision. These 
decisions are either yes/no or yes/maybe/no; again, we're 
dealing with an intellective model. 

 

Micro Simulations : Micro Simulation allows you to run some basic 
simulations on the curretly loaded visualization. Link weights are 
important as once they are normalized, they correspond to the 
probablity of a transmission. 
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Near Term Analysis 

The Near Term Analysis (NTA) is a tool that allows for the removal 
of nodes from a given organizational structure to evaluate how the 
organization will likely perform as a result. The Near Term Analysis 
tool uses a multi-agent model as input, Dynet ML*. 

The goal is to provide an answer to the question on how an 
organization will behave and change after considering a sequence of 
strategic interventions or personnel loss by way of agent removal. In 
other words, we want to know what happens when we remove nodes 
from an organization, be they people, places, resources, knowledge 
sets or other common Nodesets. 

This example will use the Stargate dataset (SG-1). This dataset is 
included with the version of ORA downloaded and can be found on-
line at the following url: 
http://www.casos.cs.cmu.edu/projects/ora/sample.php. 

From the menu bar select File > Open Meta-Network then select 
SG1.xml. 

In this example, we will remove two agents: daniel_jackson and 
maj_samantha_carter  

1. Open the SG1 Meta-Network into ORA. 

2. Highlight the SG1 Meta-Network before starting NTA in the 
ORA Meta-Network Manager panel. 

3. From the main menu select Simulations > Near-Term 
Analysis. 

NOTE : If your dataset contains an 
Organization Node Class ORA will display 
the NTA main window. If not, it will ask 
for you to chose a substitute Organization 
Nodeset. 
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When a Meta-Network is first loaded into ORA's the Near Term 
Analysis, a pop-up may appear asking for a location node. Select 
Cancel and proceed with the Near Term Analysis. 

 

The NTA main window consisted of four sub panels: Input Data, 
Settings, Simulation time line and Cases to simulate. Below is a 
brief description of each panel:  
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1. Input Data 
In this section is the file name of the Meta-Network loaded. 

2. Settings (Global Parameters) 
In the Setting area are two text boxes. The first, The Number of 
replications informs ORA how many times to run the simulation. 
The second, The number of simulated time-points defines the 
range in the section Simulation time line.  

In the settings area, there are two critical factors: 1) the number of 
replications and 2) the number of simulated time points. 

Why is this important? 

The number of replications if set at a higher versus lower value, will 
result in more experiments being conducted on the scenario the tool 
is presented. Therefore, the more replications the more likely the 
results will mirror those in a real world example. 
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The number of time points determines the length of the Near Term 
Analysis iterations. If this number is also set to a relatively high 
value, the simulation will take longer.  

NOTE : Be mindful of any memory 
considerations when running high value 
replications or time points. 

3. Simulation time line 
This are of the Near Term Analysis tool shows a visual representation 
of the time points selected in Settings area above. 

4. Cases to simulate 
After the settings (global parameters) are set, the virtual 
experiment cells need set. 

Initially, there is a pre-defined simulation cell, the Baseline. The 
Baseline is the cell without any entities removed as is the control 
situation when the organization does not experience any 
interventions. Besides Baseline, any other cells need set up. Start by 
selected Add new simulation instances, the leftmost of the four 
buttons. 

Add new simulation cases 
To run a Near Term Analysis, we will begin by selected the Add new 
simulations cases button from the main Near Term Analysis Tool 
(see area highlighted in red ellipse below).  
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After selecting Add new simulation instances button, a dialog box 
titled Near Term Analysis– Simulation scenario create wizard 
will appear. This wizard supports the creation of virtual experiment 
cells in three different ways. The First allows for the most freedom of 
choice. The second and the third options will ask for a set of criteria 
for selecting important agents in the network and make experiment 
cells according to the selection. Therefore, the first option gives full 
flexibility to users, and the second and the third option provides a 
systematic analysis setup method. To proceed this demonstration, 
select the first option and select [Next]. 
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There are four options: 
The next section explores all four of the Near Term Analysis Options: 

Run the Step-by-Step Wizard – This process will help walk through 
setting up a near term analysis experiment on the Meta-Network 
loaded into the Near Term Analysis tool. 

Create one simulation case – In this simulation experiment, 
events and user-specified time can be applied to agents. 

Create a set of cases by isolating agents – This scenario isolates 
one agent and perform an experiment. Then the experiment can be 
performed again with the agent removed. 

Create a set of cases by isolating a set of agents relating to a 
specific measure. – Based on measures contained in the ORA intel 
report, a set of agents can be isolated and a simulation case can be 
created. 
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Near Term Analysis Menu 

 

File Menu 
Save the current simulation setting: Brings up a save box where 
you can navigate to a directory and save all the current simulation 
settings. 

Load a simulation setting from a file: Navigate to a directory to 
load a previously saved simulation setting. 

NOTE : This will remove any settings that are currently active. 

Close: Closes the Near Term Analysis window. 
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Simulation Menu 
Execute simulation cases: Begins running the simulation. Same 
function as the [Execute] button at the bottom of the window. 

Show the add simulation wizard: Brings up the creation window. 
same as the [Add new simulation cases] button. 

Add ORA-Intel report based simulation cases: Same as [Add 
ORA-Intel report based simulation cases] button. 

Edit the highlighted case: Brings up the dialog box to edit 
parameters for selected event. 

Remove the selected cases: Removes selected event from 
simulations. 

Remove all of the cases: Same as the [Remove all the 
simulations] button. 

 

Output Options 

 

These menu items will display in the Near Term Results menu:  

Generate evolved Interaction Matrix:  

Generate evolved Agent-to-Agent Matrix: Displays how agents 
interact with one another. 

Generate evolved Agent-to-Knowledge Matrix: Displays how 
knowledge is diffused within the agent network 

Generate evolved Agent-to-Task Matrix: Display how tasks are 
used within a network. 
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Near Term Impact Option 1 

Step-by-Step wizard 
Selecting the first option brings up the step-by-step creation dialog 
box. 

 

Under Options select whether to isolate an agent, knowledge, or 
resource. We'll leave it at agent. Then select the [Next] button. 

 

Under Options select the agent to isolate. Here we select 
daniel_jackson. The select the [Next] button. 
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Under Options select the time-step to isolate the agent. For this 
simulation we select 5. The select the [Next] button. 

 

At this point you are asked if you want to add more events to the 
simulation or not.  

You can add as many eventsas you wish. But for this example we'll 
only use only one event. Select [No] to continue. 

 

Now repeat the steps above and add a second simulation. But this 
time let's remove daniel_jackson at time-step 25. 
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Now proceed to Analysis Results. 

 

 

Near Term Impact Option 2 

Apply events to specified agents 
The second option for creating simulation files is to create one 
simulation case and apply events to specified agents, knowledge, or 
resource nodes. 

Select the [Add new simulation cases] button to bring up the 
wizard. 
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1. Type in a search criteria to highlight only the agents to work 
with (i.e. typing in dan brought up only daniel_jackson. 

2. Place a checkmark on the line. Notice that when you placed a 
checkmark in the box the Event automatically changed to 
Isolation. 

3. Double-click in the Timing cell to select it and type in a 
number from 0 to the highest number you selected for your 
simulation. In this case we'll repeat with the timing of "5". 

4. Select the [Add events] button. This places the event in the 
Simulation event edit list section. 

5. If there were more events to add you could continue with the 
same procedure. When you are done, select the [Add a 
simulation] button at the bottom. 

The two buttons beneath the Simulation event edit list section to 
remove events from the list. The [Remove all the events] button 
obviously removes everything in the Simulation event edit list but 
the Remove the selected events from the event list only 
removes the events with a checkmark beside them.  
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The [Reset selection] button removes all check marks placed in the 
bottom table and sets the Event to No Event. 

The [Previous] button returns to the main Wizard screen. 

When you have finished you will have created the same two 
simulations as in Option 1. 

 

Now proceed to Analysis Results. 

 

 

Term Impact Option 3 

Create set of cases using Measures 
Option 3 allows for selecting agents/knowledge/resources based on 
their ranking when certain measures are run on them. 
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Here are three examples run with the same Isolation Time and 
Cut-offs. Only the measures were changed. 

Centrality, Total Degree 

 

Cognitive Demand 

 

Clique Count 



404 
 

 

When you have run the measures proceed to Analysis Results. 

 

 

Near Term Impact Option 4 

A set of agents by a set of cases by 
measure(s). 

 

Option 4 allows the addition of adding Time gaps between the 
isolations and whether to isolate them in descending, Ascending, or 
Random order. 

Now proceed to Analysis Results. 
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Near Term Impact Results Menu 

Save the Construct launch scripts : Information on Construct can 
be obtained at the following URL: 
http://www.casos.cs.cmu.edu/project/construct/index.html. 

Show text report on the ORA main window : Displays the report 
in Panel 3 of the ORA Main Interface. 

Save the completely evolved Meta-Networks : Will save as an 
ORA Meta-Network any of the simulation cases with a checkmark in 
the Select column. 

Save the html report : Navigate to a directory to save an html file 
that can be displayed in a browser. 

Save the text report : Navigate to a directory to save an text file. 

Save the Knowledge Diffusion line chart : Saves the chart as a 
.png file that can be used in other documents. 

Save the Task Accuracy line chart : Saves the chart as a .png file 
that can be used in other documents. 

Save the Energy Task line chart : Saves the chart as a .png file 
that can be used in other documents. 

Save the Knowledge Diffusion result CSV file : Saves the results 
as a .csv file that can be used in other programs. 

Save the Task Accuracy result CSV file : Saves the results as a 
.csv file that can be used in other programs. 

Save the Energy Task result CSV file : Saves the results as a .csv 
file that can be used in other programs. 

Close :  
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Copy the chart in the clipboard : Copies the window to the 
clipboard that can be pasted into other programs. 

 

 

Standard Deviation ranges : Standard Deviations* displays the 
range of values for a particular instance. 

Grid lines in the chart : Displays the grid lines for values. 

Legends in the chart : Displays the legend underneath the chart. 

Event annotations in the chart : Displays the event annotations 
within the chart. 
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Deviation from the baseline : Using the baseline numbers the 
chart shows the offset for the simulation. 

Show actual values : Uses he actual calculated values in the chart. 

 

Background color : choose the background color of the chart of 
either white or gray. 
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Near Term Impact Results 

Now we're ready to Execute the simulations. But before that you 
must select the type of Output Options you want. From the Near 
Term Analysis menu select Output Options ⇒ {any or all of the 
four options}.  

 

Now select the [Execute] button in the bottom-right corner. This will 
bring up two dialog boxes asking you to confirm you're selected 
output options and then an alert telling you that, this may take a 
while with a large Meta-Network and a lot of simulation runs. 

 

An alert box will display advising you that the near term calculation 
may take a long time depending on settings of your experiment.  

 

After selected [Execute] the Processing Near Term analysis 
dialog will show you the progress. 
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Next will be displayed the Near Term Analysis results window. 

 

The results of the experiment will compare against the baseline data 
established prior to the removal of any isolated agents. In the 
example above, we can see how the network was impacted in the 
time line when we isolated daniel_jackson and removed this node 
from the data set. 

Further information can be obtained form 
the following references: 
For knowledge diffusion and energy task 

Schreiber, C. (2006) Human and Organizational Risk Modeling: 
Critical Personnel and Leadership in Network Organizations, PhD 
Thesis, Carnegie Mellon University, CMU-ISRI-06-120 
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For binary task accuracy 
Lin, Z., K. Carley. 1997. Organizational response: The cost 
performance trade-off. Management Sci. 43(2) 217-234. 
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Micro Simulations 

The Micro Simulation exists in both the Editor and in the Visualizer. 
The difference is the Visualizer version is mainly used to visualize as 
it happens. The Editor version is used to create simulation data. 

Procedure 
The first thing it requests is a Nodeset. After that it will give you a 
choice the square networks comprised of that Nodeset. This creates a 
new meta-network consisting of a single Nodeset with the same 
nodes as the input Nodeset, and a single network with the same 
links present in the selected networks. If multiple networks are 
selected and multiple links from node A -> node B are present, the 
resulting link from A -> B has a weight equal to the sum of all A -> B 
links. 

 

Once a new Meta-Network is defined it takes all the links and 
normalizes them between zero and one. The link weight then 
corresponds to the probability that a transmission will occur down 
that link. This means that both Link Direction and Link Weight 
play an important role. 
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The Simulations 
The Simulations are Disease, Money, Information, and 
Technology and are types of flows. At any given timepoint, any 
node that has one of those things is going to try to give it to 
someone else. And each flow has its own rules. 

Types of Simulation Flows 
Disease : An entity can not re-get the disease, and an entity can 
only give out the disease while it has the disease. The entity can also 
give out a disease to multiple other entities. After a user-specified 
number of time periods, the entity loses the disease. 

Money : Once an entity gives away the money, he cannot give the 
money to anyone else. There is no limit on re-getting the money. 

Information : Once an entity gets information, they cannot lose it. 
They also never stop giving out the information. 

It's important to understand how these transmissions occur. During 
the transmission phase ORA looks at every node that has a 
resource. It then iterates through all outgoing links, trying to give 
that resource through that link ( in the case of money, since it can 
only go through one link, we randomize the order links are tested ). 
When looking at a link, if checks to see if the transmission can occur 
based on the link weight. Another check is made to see if the 
transmission can overcome the transmission resistance. 

These checks are continued based on the rules outlined above for the 
user specified number of time periods. Then a dynamic meta-network 
is generated that shows for any given time period what node was 
associated with a resource. 

Adoption of Technology : is a unique simulation. A node is more 
likely to adopt a piece of tech if it has many neighbors trying to 
convince it to adopt the tech. A node is more likely to un-adopt a 
piece of tech if the node has fewer neighbors also using the tech. 
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OrgAhead 

NOTE : This function only available in the full version. 

Description 
An organization should be capable of estimating its short-range 
performance. ORGAHEAD is an organizational learning model 
designed to test different forms of organizations under a common 
task representation. Each member of the organization receives 
information from a subordinate or from the environment then makes 
a decision based on the information and what he or she has learned 
so far. They then provide their superiors with an answer to the 
decision. These decisions are either yes/no or yes/maybe/no. 
ORGAHEAD falls in the class of intellective models; it is not designed 
to simulate exact behavior, but capture dynamics, important from a 
theoretical standpoint. 

Structure 
ORGAHEAD tests a single quasi-hierarchical organization containing 
up to three levels which run from top to bottom" CEO, Manager, 
and Analyst. The organization does not have to take a pure 
hierarchical form as the information or reporting has to travel 
upward from the task to CEO. For instance, an Analyst can report 
directly to the CEO, but can never report to another analyst. 
Similarly, a CEO can have a direct link to a task bypassing any 
managers or analysts. 

 

 

OrgAhead Initial Format 

NOTE : This function only available in the full version. 

Input Format for Initial Org Arguments 
Each of these arguments takes a quote-enclosed string. The string 
given should consist of words separated by spaces, each word 
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indicates the resources to give to a person. For example a 0b cd 
means create 3 people, the 3rd gets two resources, and the others 
each get one. 

Each word should consist of characters indicating the resources given 
to this new person. For example, the string abc means the new 
person gets the first 3 resources of the immediate lower level (i.e. 
CEO gets managers who get analysts who get tasks). Each character 
may have a modifying digit preceding it. The modifying digit can be 
'0' for task, '1' for analyst, or '2' for manager. Case is not important. 
This indicates that the level of the resource the person sees is not 
necessarily the default level for the person. For example 0b indicates 
the person gets task B, even if the person is a manager or CEO. a1bc 
means the person gets resources A and C of the default level, and 
analyst B. (Of course, if the person is a manager, saying abc would 
have been the same as a1bc.) A - indicates a person with no 
resources (who has to randomly guess at the answer), and a . 
indicates no person (a silly thing to input, but nonetheless, it can be 
done). Passing an empty string indicates that there shall be no 
members on the level associated with the argument; however, if all 
three arguments get empty strings (-analysts, -managers, -ceos ), 
then a random org is created for each simulation. 

In addition, the -president switch indicates if the org should have a 
President, who oversees all CEOs and any unsupervised managers or 
analysts. 

Output format for Organizations (seen if -print_organization is 
specified) 

This format specifies the org's structural hierarchy, who supervises 
whom. If -print_organization is specified, it is printed once before 
simulation starts, once at the end, and every time a change to the 
org is made. Here is what a sample org might look like: 

Organizational structure is: President: abc 

a1a0a b1b0b 1c0c 
abcgi defh 
a b c d e f g h i 

The bottom line indicates that the first analyst sees task A, the 
second analyst sees task B, and so on. The next line up shows 2 
managers; the first one supervises the first, second, third, seventh, 
and ninth analysts, and the second manager oversees the other ones. 
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The top line depicts three CEOs. The first one oversees the first 
manager (A), as well as the first analyst (1A) and ask (0A). The 
second one sees the second manager, analyst and task. The third one 
oversees the third analyst and task. Finally, the first line indicates 
that this org has a President, who supervises the three CEOs. 

Orgstat reads orgs from a file or stdin in this same format. It only 
reads orgs whose preceding line reads Final Organizational 
structure is. This way you could pipe output of orgsim to orgstat, 
and orgstat will ignore initial and intermediate orgs, using only final 
orgs, one for each simulation performed. 

Output format for People (seen if -print_person is specified) 

This format specifies the experience of every person in the org. If-
print_person is specified, this data is printed for every person after 
each efficiency check. Here is what a single person's experience 
might look like: 

-------------- 

Manager #1 has resources: A1 T2 Eff: 43.00% (Recent: 43%) from 
400 tasks. For pattern: 1 1 

42 = 41 1 0 | 31 0 0 8 0 0 10 0 0 = 49 
13 = 12 1 0 | 12 1 0 1 0 0 6 0 0 = 20 
3 = 3 0 0 | 3 0 0 1 0 0 0 0 0 = 4 

For pattern: 1 2 

From the top line, we see that the first manager oversees the first 
analyst and the second task. He has an overall efficiency of 43.00, 
and a 43% relative efficiency from the last efficiency check. And he's 
seen 400 tasks. Then we will see a listing of each pattern he may 
see; only his output for pattern (1 1) is shown above. The data is 
collected into 4 3x3 matrices, and they indicate his absolute, initial, 
relative, and old relative experience, from right to left. The rows 
indicate what the correct answer was (top=1, middle=2, bottom=3), 
and the columns indicate what he guessed (left=1, middle=2, 
right=3). So, in the full 400 tasks, where the pattern (1 1) emerged, 
the answer was 1 42 times, and 41 of those times he guessed 1. 
However, when he started off (initial experience) there were 31 1's 
and he guessed correctly every time. Since the last efficiency check, 
there were 8 1's, and he guessed them all, and in the previous 
efficiency check, there were 10 1's and he guessed them all correctly 
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again. The numbers on the left and right sides are sums, the right 
ones are useful in judging how he will react the next time he sees (1 
1) Since the answer was 1 42 times (from the left side), we figure 
he'd be best to guess 1. That's what he'll do, because the right 
number (49) isgreatest on the right side. 

 

 

OrgAhead Output 

NOTE : This function only available in the full version. 

Output format for Organizations (seen if -
print_organization is specified) 
This format specifies the org's structural hierarchy, who supervises 
whom. If -print_organization is specified, it is printed once before 
simulation starts, once at the end, and every time a change to the 
org is made. Here is what a sample org might look like: 

Organizational structure is: President: abc 

a1a0a b1b0b 1c0c 
abcgi defh 
a b c d e f g h i 

The bottom line indicates that the first analyst sees task A, the 
second analyst sees task B, and so on. The next line up shows 2 
managers; the first one supervises the first, second, third, seventh, 
and ninth analysts, and the second manager oversees the other ones. 
The top line depicts three CEOs. The first one oversees the first 
manager (A), as well as the first analyst (1A) and ask (0A). The 
second one sees the second manager, analyst and task. The third one 
oversees the third analyst and task. Finally, the first line indicates 
that this org has a President, who supervises the three CEOs. 

Orgstat reads orgs from a file or stdin in this same format. It only 
reads orgs whose preceding line reads Final Organizational 
structure is. This way you could pipe output of orgsim to orgstat, 
and orgstat will ignore initial and intermediate orgs, using only final 
orgs, one for each simulation performed. 
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Output format for People (seen if -
print_person is specified) 
This format specifies the experience of every person in the org. If-
print_person is specified, this data is printed for every person after 
each efficiency check. Here is what a single person's experience 
might look like: 

-------------- 

Manager #1 has resources: A1 T2 Eff: 43.00% (Recent: 43%) from 
400 tasks. For pattern: 1 1 

42 = 41 1 0 | 31 0 0 8 0 0 10 0 0 = 49 
13 = 12 1 0 | 12 1 0 1 0 0 6 0 0 = 20 
3 = 3 0 0 | 3 0 0 1 0 0 0 0 0 = 4 

For pattern: 1 2 

From the top line, we see that the first manager oversees the first 
analyst and the second task. He has an overall efficiency of 43.00, 
and a 43% relative efficiency from the last efficiency check. And he's 
seen 400 tasks. Then we will see a listing of each pattern he may 
see; only his output for pattern (1 1) is shown above. The data is 
collected into 4 3x3 matrices, and they indicate his absolute, initial, 
relative, and old relative experience, from right to left. The rows 
indicate what the correct answer was (top=1, middle=2, bottom=3), 
and the columns indicate what he guessed (left=1, middle=2, 
right=3). So, in the full 400 tasks, where the pattern (1 1) emerged, 
the answer was 1 42 times, and 41 of those times he guessed 1. 
However, when he started off (initial experience) there were 31 1's 
and he guessed correctly every time. Since the last efficiency check, 
there were 8 1's, and he guessed them all, and in the previous 
efficiency check, there were 10 1's and he guessed them all correctly 
again. The numbers on the left and right sides are sums, the right 
ones are useful in judging how he will react the next time he sees (1 
1) Since the answer was 1 42 times (from the left side), we figure 
he'd be best to guess 1. That's what he'll do, because the right 
number (49) isgreatest on the right side. 

Output format for Tasks (seen if -
print_task is specified) 
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This format specifies what happens for each task, what everyone 
decides, what the org decides, and what the correct answer was. If -
print_task is specified, this is printed for each task. Here is what a 
single task might look like: 

3 
2 2 1 
1 2 2 2 2 1 2 2 
2 2 2 2 2 2 2 2 A: 3 D: 3 

The bottom line shows that all the task bits were 2. The next line up 
indicates that the first (leftmost) and 6th analysts guesed 1; the 
others guessed 2. The next line shows that the first two managers 
guessed 2 while the third guessed 1. The top line shows that the CEO 
guessed 3. At the end of the bottom line, one can see that the 
answer was 3, and so was the decision. 

Output format for Efficiency (seen if -
print_efficiency is specified) 
This format specifies what happens for each efficiency check, how 
everyone is doing, and how well the org is doing. If -print_efficiency 
is specified, this data is printed out during each efficiency check, 
before any orgal changes take place. A sample efficiency check might 
look like: 

Organizational Efficiency: 53.00% Overall: 54.03% 
54.00 54.00 37.00 54.00 54.00 54.00 54.00 45.00 
54.00 45.00 54.00 50.00  
37.00 53.00 48.00 45.00 47.00 51.00 56.00 47.00 

The org's overall efficiency is 54.03%, while its relative efficiency 
(since the last efficiency check) is actually 53%. From the bottom 
line, we see the analysts all had efficiencies ranging from 37-56%. 
The managers, one line above, ranged from 45-54%, and the CEOs 
ranged from 37-54%. 

Output Format for Orgstat 
This section describes the output orgstat generates. A sample output 
might look like this: 

Data Organizational structure is: 



419 
 

ab c - - - - - - - 
abc def ghi - - - - - - 
a b c d e f g h i 
Connectivity = 0.5257 Hierarchy = 1.0000 ... 

Data Organizational structure is: 

AVG: 1.0000 SD: 0.0000 MIN: 1.0000 MAX: 1.0000 Connectivity 
AVG: 1.0000 SD: 0.0000 MIN: 1.0000 MAX: 1.0000 Hierarchy 

Central Graph Organizational structure is: 

ab - - - - - - - - 
abc def ghi - - - - - - 
a b c d e f g h i 
Connectivity = 0.1648 Hierarchy = 1.0000 ... 

Hamming distribution (for nonparametric confidences): 

1th: 1 
2th: 1 
... 
10th: 7 
Confidence at 90% = 4 
Confidence at 95% = 7 
Confidence at 98% = 7 

First, orgstat prints out each org it just read in (after the org has 
been 'reduced' by orgstat's congruence algorithm.) After each org, it 
prints out some statistics about the directed-graph represented by 
the org's hierarchical structure. It prints out the means and standard 
deviations of the statistics. It then prints out the central graph of the 
'data' orgs, along with statistics about the central graph. Then it 
optionally does the bootstrap analysis; in this case we used 
nonparametric random graphs. It creates a list of Hamming metrics, 
sorts the list, and prints it out. There were 10 samples used here, 
and the largest one was 7. Then it prints the 90% confidence metric, 
as well as the 95% and 98%. 

Orgstat can also take as input a set of adjacency matrices, in which 
case the output will also be represented as adjacency matrices. There 
is also a -matrix switch to orgstat which forces it to output matrices 
even if orgs were read in. 
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OrgAhead Experience  

NOTE : This function only available in the full version. 

Experience; How each Member Learns 
Each person has a set of resources, which may be tasks, or the 
decisions of his inferiors (or both). From these resources, he sees a 
'pattern', a single vector of numbers ranging from 1-3, and he must 
guess if the true answer is 1, 2, or 3 based on this pattern. He does 
this by storing experience matrices for every possible pattern. So 
when he next sees that pattern, he knows what the answer has been 
recently, and therefore can make a good educated guess on what the 
answer will be this time. 

For each pattern, he stores 4 matrices. The first one, known as the 
initial matrix, records all of his experience while he is being trained. 
(He is in training as long as he has less than 500 tasks, this number 
is passed to the program under the paremeter Training_Period). 
When he is no longer in training this matrix ceases to be 
incremented. 

He also stores relative experience and old relative experience. 
Assuming an efficiency check occurs every 100 tasks (the default), 
his relative experience will encompass all tasks he has seen since the 
last efficiency check (which will be less than 100 tasks). After the 
next efficiency check, his relative experience matrix gets copied to his 
old relative experience matrix, and then gets zeroed. So his old 
relative experience matrix records his guesses for the last 100 tasks 
before the last efficiency check. 

The fourth matrix records his absolute experience, it gets updated for 
every task he views, but he does not use it in making decisions; it 
mainly exists to examine his efficiency. 

Each matrix is a 3x3 matrix indicating how many times the member 
guessed 1,2, or 3 and how many times the answer was 1, 2, or 3. 
Whenever a person receives feedback, he increments a single index 
in his relative and absolute matrices, as well as his initial experience 
if he is still in training. As long as a person's resources don't change, 
his matrices give an accurate history of what tasks have 
transgressed. 
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When his resources change, then the numbers of his matrices will be 
altered to reflect the change. If he loses a resource, then the 
matrices that represent patterns only differing by that resource are 
summed together. When he adds a new resource, all his matrices are 
triplicated and divided by 3. Thus, adding and then deleting a 
resource should leave experiene matrices close to their initial values 
(there will be precision errors from discarded remainders when 
dividing numbers by 3). 

 

 

OrgAhead Change 

NOTE : This function only available in the full version. 

Making a Change in the Org 
Org change is handled very formally, and has different meanings in 
orgsim and orgahead. However, both treat change very similarly, so 
we will look at their similarities first, and then the difference in org 
change that distinguishes orgsim from orgahead. 

Orgsim and orgahead conduct org change differently, but they may 
only change the org at specific points in the simulation. Periodically 
they stop simulation and attempt a change...if a change succeeds, 
the simulation continues with the changed org, otherwise, the original 
org continues until the next time for changing comes up. 

There are five ways to change an org: hire someone new, fire 
someone, add a connection between two members, or a member and 
a task, change a connection, and delete a connection. Each of these 
may be done several times at once, but all the times must apply to 
the same level (or levels). For example the org can hire 3 new 
analysts, or change 2 connections between managers and tasks, but 
it may not hire an analyst and a manager at the same time. 

Once a specific type of change is requested, orgsim and orgahead 
both proceed with the type of change in the same way. First they 
decide how many such changes can occur. This can be specified as 
either a constant (hire 2 people), or the program can be instructed to 
randomly decide how many changes to do based on a Poisson 
distribution. 
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Next, the programs pick a level of the org (for hiring and firing), or 
they pick a superior and inferior level (for add/change/delete 
connections). 

Then they must decide which people on the levels picked are 
influenced. Usually there are parameters to decide this, and the 
options will be adjectives like best, worst, busiest, laziest, and 
random. Specifying best means use the person on that level with 
the highest relative efficiency, and worst means the person on that 
level with the lowest relative efficiency. Similarly busiest means the 
person on that level with the most tasks and laziest means the 
person with the least tasks. Finally, random means pick anyone on 
that level without regard to their efficiency or resources. 

At this point the idiosyncracies of each change come into play. The 
behavior of each change is described below: 

For hiring, the level chosen indicates at what level the new member 
will exist in the org. If that level is full of members (the number of 
members meets a limit variable set by the program), no one may be 
hired on that level. The new person can receive no resource, or a 
random task or inferior person to supervise. Or he can receive 
resources from a 'mentor', a colleague on that same level. Like all 
members chosen, you can elect to use the busiest, laziest, best, 
worst, or random person to be a mentor. The mentor gives half his 
tasks to the new person. You may elect to have the mentor continue 
to supervise the resources he gave away, or to drop them. Finally a 
superior on the next level is assigned to supervise the new person 
(unless the new person is a CEO). 

The above scenario is typical for when a person is hired on a level 
that already has people on it (who could serve as mentors). When a 
person is hired on a level with no current people on it, the program 
behaves slightly differently, depending on the level. When a CEO is 
added to an org with no CEOs, he supervises all the managers, or all 
the analysts if there are no managers. When a manager is added to 
an org with no managers, he supervises all the analysts, and the 
CEOs that were (presumably) supervising the analysts drop them. Or 
the manager supervises all the tasks if there are no analysts. When 
an analyst is added to an org with no analysts, he gets all the tasks 
his supervisor is currently overseeing. One final note: instead of a 
person supervising all the resources on a level, the program can be 
directed to give him one resource at random on that level instead. 
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For firing, the level chosen indicates what level the 'victims' occupuy. 
A victim must be chosen from the level, and all his resources are 
given to one of his colleagues. It is possible to fire the last member 
on a level, but only if other members exist on other levels... you 
cannot fire the last person in an org. As with hiring, the programs 
behave slightly differently when the last person on a level gets fired. 
When the last CEO gets fired, his resources go to anyone that can 
supervise them (keeping mind that a supervisor must be on a higher 
level than a resource he must supervise). When the last manager 
gets fired, his task resources go to the analysts, and his analyst 
resources go to the CEOs if the CEOs were supervising the manger. 
When the last analyst gets fired, his tasks get distributed amongst his 
supervisors, or the existing managers, if no one is supervising the 
analyst. 

When adding a connection, two levels must be chosen, the level of 
the superior and the level of the inferior, and someone on the 
superior level winds up supervising someone (or something) on the 
inferior level. The program first deciides if the inferior resource must 
be an 'orphan' resource, that is, the resource is currently not 
supervised by anyone on the superior level. Then it picks an 
appropriate inferior resource, and superior person, and directs the 
superior to supervise the resource. (It ensures that the superior is 
not already supervising the resource.) 

Changing connections also requires a superior and inferior level, and 
it is not possible to change a connection from level A to level B if 
there is no connection there in the first place. For example, you 
cannot change a manager-task connection if no managers are 
supervising tasks. First it picks a person on level A and resource on 
level B on which a connection exists. Then, it picks, either a second 
person on level A, or a second resource on level B, depending on 
whether it has been instructed to change the connection on the 
superior side or the inferior side, and makes the change. 

Compared to the above, deleting connections is quite simple. A 
member on the superior level is found, who contains a resource on 
the inferior level chosen, and he loses that resource. Easy, isn't it? 

Orgsim and orgahead differ in how they decide what kind of change 
to make Orgsim assigns for each change, a threshold. As long as the 
relative efficiency does not change by more than that change's 
threshold, the org will not undergo that change. Also, if a change is 
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successful, the org cannot be changed for a period of time depending 
on the type of change. 

Orgahead ignores thresholds. It uses simulated annealing to 
determine what kind of change would be profitable...if a particular 
change improves the org, or at least, does not worsen the org 
significantly, that change is implemented, and the new org continues 
simulating, otherwise the old org continues until the next opportunity 
for change. 

 

 

OrgAhead Murphies 

NOTE : This function only available in the full version. 

How To Handle Murphies 
In organizational jargon, a 'murphy' is an event that embodies 
Murphy's Law; i.e. it is some catastrophe that afflicts orgs. A murphy 
can be represented as a person being lost, due to the person leaving 
the org, or disappearing. Or it can be represented as a line of 
communication that breaks, where one person cannot contact 
another, although both people are functioning perfectly fine in all 
other aspects. 

Orgsim and the other programs provide flexible enough parameters 
to handle murphies, although they aren't implicitly aware of what a 
'murphy' is. Here is how you would specify murphies to orgsim: 

A murphy that destroys a person can be simulated in orgsim by firing 
a random number of people at a random level at a random time. 
Unlike normal firing, the org doesn't plan the action, so it does 
nothing (immediately) to reallocate resources. So the victim's 
resources are not immediately allocated to other colleagues. Of 
course, orgsim cannot destroy the last person in an org. Murphies 
should be used with hiring enabled, which simulates an org losing 
people at random intervals and having to patch itself up by hiring 
new people. 

There is another type of murphy; it destroys a communication line 
between two people, leaving them otherwise intact. This is identical 
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to deleting a random connection between two random people at two 
levels. This can be done with adding and changing connections 
enabled, which simulates an org trying to compensate for losing 
communication lines at random intervals. 

 

 

OrgAhead Task Problems 

NOTE : This function only available in the full version. 

Task Problem Specification 
The task problem determines how to determine the actual solution 
from the task bits. Generally, you can use a decomposable problem 
(where each task bit has the same weight as any other), or a 
nondecomposable one. You can also determine that the task should 
be biased (lean heavily towards an answer of 3) or unbiased (equal 
probability on all answers). These can be specified by the 
nondecomposable and -biased switches. 

First a total is determined from the task bits, and then it is compared 
against two cutoffs. If the total is less than the first cutoff, the 
answer is 1, if it is less than the second cutoff the answer is 2, 
otherwise the answer is 3. The -nondecomposable flag affects the 
cutoff points, and so does the -biased flag. Additionally, you can 
tweak the -cutoff_friendly and -cutoff_hostile flags to introduce 
whatever level of bias you please. 

If a decomposable problem is used, the total is the product of the 
task bits. Otherwise, the following formula is used: 

Total = 2*t1*t2*t3 + 2*t4*t5 + t6 + t7 + 2*t7*t8*t9 

If the cutoffs are not specified, the following cutoff values will be 
used: 

Friendly Biased Unbiasd Hostile Biased Unbiased 
Decomposable 71 109 Dceomposable 287 432 
Nondecomposable 28 34 Nondecomposable 42 49 
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Visualization 

 

Measure Charts : When run this function will plot the three 
graphs, Bar Chart, Scatter Plot, and Histogram on the chosen 
Network. 

 

View Measures Over Time : Requires multiple Networks. First 
plots points for measure selected on each of the Networks active 
with the option to see a direct line from the earliest to the latest 
point. 

 

View Network Over Time : Requires multiple Networks. Displays 
nodes and links for each of the active Networks. 

 

Network Drill-Down: Allows for quick, plotting of nodes connected 
to a chosen node. 

 

Node Cloud : Create an image with higher used concepts showing 
up in larger font sizes. 

 

Color Grid : Creates a colored grid representing the networks. 
White cells represent no connections. 

 

Network Block :  

 

GeoSpatial Networks : Analyze, forecast, and visualize a wide 
variety of spatial interactions and networks within a global-scale. 
See GeoSpatial/Loom > GeoSpatial for more information 

 

View Trails : Works with nodes moving between places over time. 
Requires the use of a trailset.See Loom for more information 

 

View Trails in GIS :  

View Networks 

 

3D Visualization : Visualizes the selected network in the 3D 
Visualizer 
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2D Visualization : Visualizes the selected network in the 2D 
Visualizer 

 

Path Finder : is used to find, not only, the shortest path between 
two nodes but also paths to other nodes when particular situations 
occur. 

 

Sphere of Influence : Each node within a network has a unique 
Sphere of Influence or Ego Network. Essentially it's a direct 
relationship with it's neighbors as a function of specified path 
length. The ORA Visualizer allows you to focus on this relationship 
by creating an Ego Map centered on any particular node you 
choose. 

 

Key Set Selector : uses information input by the user to create a 
simplified visualization. 

 

Blank Visualization : Opens the Visualizer with no active Meta-
Network. Allows you to create Nodesets and Networks from scratch. 
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Measure Charts 

 Below are examples of each type of ORA charts: Bar Chart, 
Scatter Plot, Histogram, and Regression. 

NOTE : The measures run can be changed by select from the main 
menu Analysis > Measures Manager. 

Save Measures 

 

Use this button to save results measures to a text file. This file can be 
opened in either Excel or a text editor. ORA will not attach an 
extension to this file and it is suggested to give it either a .txt or 
.csv extension. 

Opening the File 
Opening this file in Excel, making sure to import it as a delimited file, 
will give you the measures it can use and the values associated with 
each node in the Nodeset chosen. You will notice that the names of 
the characters are characters_1, characters_2, and so forth. In 
this particular Nodeset the Node ID contained the text Character_ 
plus a number and the Node Title contained the actual name of the 
character. This function used the Node ID when it exports this 
information. 
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Bar Chart 

Bar Chart 
A bar chart contains horizontal bars representing the individual 
nodes in the set. These rectangular bars are usually proportional to 
the magnitudes or frequencies of what they represent.  

Bar charts are used for comparing two or more values. The bars 
can be horizontally or vertically oriented. Sometimes a stretched 
graphic is used instead of a solid bar. 
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Use with Two-Mode data 
When you have two-mode data you can get the Nodes of one 
Nodesets that are connected to the most nodes of the second 
Nodeset using measures charts. When using Measure Charts, first 
choose which Nodeset you want to get values for then choose the 
measure. 
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Scatter Chart 

Scatter Plot 
A scatterplot uses Cartesian coordinates to display values for two 
variables. The data is displayed as a collection of points, each 
having one coordinate on the horizontal axis and one on the vertical 
axis. 

A scatterplot does not specify dependent or independent variables. 
Either type of variable can be plotted on either axis. Scatterplots 
represent the association (not causation) between two 
variables. 

A scatterplot can show various kinds of relationships, including 
positive (rising), negative (falling), and no relationship. If the 
pattern of dots slopes from lower left to upper right, it suggests a 
positive correlation between the variables being studied. If the 
pattern of dots slopes from upper left to lower right, it suggests a 
negative correlation. A line of best fit can be drawn in order to study 
the correlation between the variables. An equation for the line of best 
fit can be computed using the method of linear regression. 
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Histogram Chart 

Histogram 
In statistics, a histogram is a graphical display of tabulated 
frequencies. A histogram is the graphical version of a table which 



433 
 

shows what proportion of cases fall into each of several or 
many specified categories. The histogram differs from a bar chart 
in that it is the area of the bar that denotes the value, not the height, 
a crucial distinction when the categories are not of uniform width 
(Lancaster, 1974). The categories are usually specified as non-
overlapping intervals of some variable. The categories (bars) must 
be adjacent. 

The word histogram is derived from histos and gramma in Greek, the 
first meaning web or mast and the second meaning drawing, record 
or writing. A histogram of something is thus, etymologically speaking, 
a drawing of the web of this something. 
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Regression Chart 

Regression 
Regression analysis is also used to understand which among the 
independent variables are related to the dependent variable, and to 
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explore the forms of these relationships. In restricted circumstances, 
regression analysis can be used to infer causal relationships between 
the independent and dependent variables. 

The dependent and independent variables can be either a network 
measure or numerical attributes of nodes. 

Calculating linear regression 
The equation y = mx + b algebraically describes a straight line for a 
set of data with one independent variable where x is the independent 
variable, y is the dependent variable, m represents the slope of the 
line, and b represents the y-intercept. If a line represents a number 
of independent variables in a multiple regression analysis to an 
expected result, the equation of the regression line takes the form 
y=m1x1+m2x2+...+mnxn+b in which y is the dependent variable, x1 
through xn are n independent variables, m1 through mn are the 
coefficients of each independent variable, and b is a constant. 

Calculating exponential regression 
Unlike linear regression, which plots values along a straight line, 
exponential regression describes a curve by calculating the array of 
values needed to plot it. The equation that describes an exponential 
regression curve is 

y = b * m1
x1 * m2

x2 * . * mn
xn 

If you have only one independent variable, the equation is 

y = b * mx 

Output - Regression Statistics 
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R-Squared : The coefficient of determination, R2, is the proportion of 
variability in a data set that is accounted for by a statistical model. 
There is no consensus about the exact definition of R2. Only in the 
case of linear regression are all definitions equivalent. In this case, R2 
is simply the square of a correlation coefficient. 

Adjusted R-Squared : Unlike R2, the adjusted R2 increases only if 
the new term improves the model more than would be expected by 
chance. The adjusted R2 can be negative, and will always be less than 
or equal to R2. 

Standard Error : The Standard Error is an estimate of the standard 
deviation of the coefficient, the amount it varies across cases. It can 
be a measure of the precision with which the regression coefficient is 
measured. If a coefficient is large compared to its standard error, 
then it is probably different from 0. 

Num Observations : Number of nodes in the Nodeset. 

Output - Residual Output 
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Predicted Y Value : In the scatterplot, a point is plotted as (X , Y) 
The regression line will give the predicted Y value. 

Residuals : The difference between the Predicted-Y value and the 
actual value. 

Output - ANOVA 
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ANOVA : Information about levels of variability within a regression 
model and form a basis for tests of significance. 
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View Measures Over Time 

 Using the View Measures Over Time on a Network allows an 
analyst to see how a network measures change over multiple time 
periods. If you use non-dated data, ORA will alert you if your Meta-
Networks are not dated. 

 

Highlight all the Meta-Networks and selectr from the main menu 
Visualizations > View Measures Over Time... 

NOTE : Measures Over Time will only be run on the selected Metw-
Networks. 

Computation Parameters 
First, the Computation Parameters dialog window appears. Here you 
can select the measures to use and whether to combine or transform 
the datasets. When done, click the [Compute] button to continue to 
the analysis. 

 

Measures tab : gives you control over the measures used in the 
computation. With the Custom option you can select as many or few 
measures to use. 
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• All measures :  

• Fast measures :  

• Centrality measures : Uses only the Network Centralization 
measures. 

• Custom : Calls up a dialog box which allows you to selectively 
pick which measures to use. Place a check mark next to any 
measure you want to use. You can also use the [Search] 
textbox to find a measure(s). 

 

Aggregate tab : Combines multiple dates into one entry. If you have 
one meta-network for each day of the year, aggregating by month 
would reduce the 365 meta-networks into 12 meta-networks (the 12 
would contain the 30 meta-networks for each day of the month 
unioned together). 

Transform tab : The Conform using method makes the Node 
Classes indential across Meta-Networks. Union adds isolate nodes, 
and Intersect removes isolate nodes. 

NOTE : Measure values computed on conformed Meta-Networks may 
differ from those computed on non-comformed data. 
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Measures Over Time window 

 

This window is divided into three panes. 

The Measure Selector Pane contains tabs for all Node Classes in 
addition to a Network Level tab. If the Network Level tab is selected 
you can choose which measure(s) to apply to the entire Meta-
Network. If a Node Class tab is chosen you can choose which 
Node(s) to view and in the Select a measure: text box select the 
measure to apply to them. All actions are instantly updated in the 
Charts Pane. 
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The Restrictor Pane allows you to set the beginning and ending 
time periods and additionally you can skip any number of 
intermediary steps. 

The Charts Pane contains three tabs and a legend at the bottom 
showing the colors associated to which nodes. Each pane is further 
described on their own pages. 

 

 

Measure Selector Pane 

 

The Network Level tab is a list of 
all the measures used in the 
current operation. Place a check 
mark next to any measure you 
want to use. 
 
The [AND/OR] drop down allows 
for boolen operations on the 
measures. 
 
The [Select All / Unselect All] 
buttons can be used as a starting 
point to select mostmeasures or 
only a few measures. 
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All the individual Node Class tabs 
work identically. Like the Network 
Level you place a check mark next 
to the nodes you want to use and 
it also contains the [AND/OR] 
drop down. 
 
The Measure: and Networks: 
drop downs allow you to hone you 
selections. 
 
The [Select All / Unselect All] 
buttons can be used as a starting 
point to select mostmeasures or 
only a few measures. 

 

 

 

Restrictor Pane 
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The Restrictor Pan allows you to set the Starting and Ending Meta-
Network to use and also to skip a number of Metaworks in the 
middle. 

 

 

Over Time-Measures Tab 

 

Displays the charting of plotted measures over time denoting each by 
an individual color. 
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Over Time-Fast Fourier Tab 

 

Frequencies 
Fast Fourier Transform : Transform measures values to identify 
cycles in a temporal situation. Doesn't plot measure values. It plots 
strength of cycles. (i.e. traffic patterns could have a heavy/light 
traffic pattern or a weekly pattern, heavy on weekdays and light on 
weekends). Defines cycles of different lengths. 

Dominant Frequencies : Selecting Dominant Frequencies on the 
radio button to the lower right, displays only the statistically 
significant frequencies. 

Plots 
Original Plot :  

Period Plot :  
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Filtered Plot :  

Original and Filtered :  

 

Over Time-Change Detection Tab 

 

CUSUM 
Keeps track of cumulative total of deviation across time. No matter 
how small the change. 

Networks in Control : Number of Networks to use as a control 
group 

NOTE : If your change time is in the "Networks in control" bunch 
then you'll never see the change. 

Standardized Change :  

Set sensitivity to false alarm 
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Decision interval :  

Risk : Higher risk numbers will possibly give more false alarms. 

Observations :  

EWMA 
Exponentially Weighted Moving Average. Check Wikipedia. 
Incorporates historical data but places more emphasis on recent 
data. 

Networks in Control : Number of Networks to use as a control 
group 

Risk : Higher risk numbers will possibly give more false alarms. 

Weight : Shows the weight of the newer observations over the 
older observations. Start and Finish is for which network to use. 

Shewhart X-Bar 
Show how different the current observation is from the baseline. 
This only takes into account the current observation. 

Networks in Control : Number of Networks to use as a control 
group 

Risk : Higher risk numbers will possibly give more false alarms. 
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Networks Over Time 

Networks are ways of connecting the who, what, where, why, how 
and when. Each type of who, what, where, why, how and when is 
called an entity class. The items within them are called nodes or 
entities. The set of networks for three or more of these entity classes 
is called the meta-network. The entire field of Dynamic Network 
Analysis is based on the concept of the MetaNetwork. 

Terminology 
Identity Crisis : Different entities with the same name could get 
confused. Bob #1 gets connected to Alice. Bob #2 gets connected 
to Carol. Alice and Carol get angry at their respective Bobs. 

Meta-Network : A Meta-Network incorporates different Node 
Classes and allow you to perform an analysis on the model that way. 
Such a model is called a MetaNetwork. 

A Meta-Network is network composed of multiple networks. A 
MetaNetwork is the sum of all networks we are considering. The 
Meta-Network is the foundation for Dynamic Network Analysis; 

Network : A Network shows how the nodes connect to each other. 

Node : A Node can literally be anything you can think of; on an 
abstract level, an Entity may be merely a dot in a visual network 
model. It is what we are networking and connecting our ties to and 
thus looking at in detail visually. 

Node Class : A Node Class is a group of similar nodes [i.e. 
people, places, knowledge] 

Node Occurrence Transparency : Easily see which nodes 
appear in the most timeslices. 

Timeslice : A view of the data at a particular point in time. 
Often, one timeslice = one meta-network, but maybe a 
day/week/month-long snapshot. 
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Typos/Multiple IDs (think email addresses) : Bob is assigned 
task Driver. bob is given resource Truck. ORA can't find a way 
for that task to be completed. 

Vector Mapping : Views how measures and/or Attributes 
affect each other as the time moves on. 

Dynamic Networks 

 

• S1 : 2 agents share 1 location 

• S2 : They move apart to 
separate locations 

 
• S3 : A 3rd connected agent is 

detected at its own location 

 
 

• S4 : 2 of the agents meet 

 
 

• S5 : The 3rd joins at same 
locale 

 

• S6 : One agent disappears 

Dynamic Meta-Network in ORA 
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The Clock icon indicates a Dynamic Network. 

The Deltas contain changes to a Network at a point in time. 

 

The Operational Statistics indicate the number of additions, 
modifications, and removals to the Network. 

Manipulating Keyframes/Deltas 
You can Convert Keyframes to Deltas, Deltas to Keyframes, or 
Aggregate by Day/Week/Month/Year. 

Over-Time Visualizations 
Visual Comparisons, Animating over time, and Plotting 
changing centrality. 

 



451 
 

 

View Network Over Time 

 View Network Over Time : Uses all selected Meta-Networks for 
analysis in various time frames. Select all the Meta-Networks to use 
in the analysis. 

NOTE : It is of the utmost importance that the Networks in all Meta-
Networks are named the same. If not, the Over Time function will not 
work correctly. 
 
NOTE : Meta-Networks for use in the Over-Time tool are required to 
have date information. If they do not a warning box will appear 
telling you of the missing information.  
 
NOTE : Menu options and right click context menus apply to what is 
currently selected. If an entire dynamic meta network is selected 
[ the parent item ] it applies to each snapshot/delta, otherwise it 
only applies to the currently selected snapshot/delta. 

 

Now select from the menu Visualizations > View Network Over 
Time This will bring up the visualizer along with the Networks Over 
Time window. 
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The Animation Tab controls the workings of the animation. It also 
contains the Play/Stop buttons. 

The Timeslices Tab contains check boxes for all active Meta-
Networks. Placing a check mark in the boxes will use that particular 
Meta-Network. 

The Clustering Tab allows you to set the time frame for clustering 
by day, week, month, or year. 

Animating the Display 
Pressing the Play button will start the animation. Below are the five 
agent x agent Networks. In different time slices new nodes appear 
and the connections between the agents changes. 
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Change Detection (Over-Time Viewer) 

Description 
The View Measures Over-Time is used to find out how quickly you 
can identify changes in a network to exploit subtle organization 
change, And also to facilitate improved command and control subject 
to a specifid risk of false alarm. Various measures of a network are 
taken at different points in time. You need to identify a) that a 
change did occur and b) when did that change occur. 

NOTE : It is important to note that this is not predicting change. But 
rather it is detecting that a change has occurred quickly and be able 
to make some inference about the actual time of change. 

Example of Change Detection 
Change Detection may offer you a tool to operate inside the normal 
decision cycle. The following figure represents some measure of 
interest over time. It could be the revenue of a company, the combat 
power of an enemy, or a measure of interest from a social network. 
When do you conclude from this measure that a change may have 
occurred? Let's assume that by conventional methods you can detect 
a change in organizational behavior as of today, the vertical line. 
This time point might be too late to take preventative or mitigating 
action. In other words, this could be the point of inevitable 
bankruptcy for the company, or the successful culmination of a 
terrorist attack. Identifying that a change occurred by time period E 
might allow the analyst to respond to the change before it is too late; 
get inside the decision cycle. 



457 
 

 

Change detection is more challenging than it may seem at first. The 
sudden change in the measure between time D and time E, 
however, may look very similar to the peak at time A. Furthermore, 
if you assert that a change in fact occurs at time A, there may exist a 
large amount of time periods to investigate for the cause of any 
change. If you can identify more likely points in time where change 
may have occurred, you can reduce the costs in terms of time and 
resources to search for the potential causes of change. Identifying 
the likely time that a change may have occurred is called Change 
Point Identification. 

Another problem you face is detecting the change as quickly as 
possible after the change occurred. Can you improve the ability to get 
inside the decision cycle by detecting the change at time D, or even 
better at time B? This is called Change Detection. 

NOTE : It is important that you use at least 10 time periods for an 
accurate simulation. 

 

 

The Three Procedures 
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The Shewhart X-bar Control Chart 
This is simple and easy to implement and provides a Proof of Concept. If 
calculates a samle average of observations and measures of a process. The 
decision interval indicates whether the observation is in the tail of the 
disbtribution. 

 

Cumulative Sum (CUSUM) 
Other statistical schemes increase power (faster detection, given the same 
probability for false alarm). The CUSUM considers previous values of the 
observed process. It can take a long time to detect small changes. 
Intuitively, we can see change earlier. How to detect it? 

 

Cumulative Sum is good at detecting small changes in mean over time and 
has good buildt-in change point detection. 

The Load data and use CUSUM option. CUSUM has an additional 
parameter. This is equivalent to ? in the equation presented earlier. It is an 
optimality parameter for the CUSUM approach that will make this approach 



459 
 

the uniformly most powerful for a change in the social network measure of ?. 
As a rule of thumb this is usually set to 1. 

There are three ways to set the risk of a False Alarm. 

1. The user can specify the decision interval. 

2. The user can specify a probability as in the Shewhart approach. 

3. The user can specify the average number of in-control networks 
expected before a false alarm. 

This is due to the nested conditional probability inherent in the CUSUM. 

The CUSUM signals a change, when the statistic exceeds the decision 
interval. The most likely point in time that the change actually occurred is 
interpreted as the point that the CUSUM was last equal to 0. In this case, 
the time period is 19, which is one time point before the actual change. This 
is where an analyst would begin to look for explanations of change in the 
group. There are two separate charts plotted. One is for increases (red) in 
the social network measure, and the other is for decreases (blue) in the 
measure. 

Exponetially Weighted Moving Average  
This chart requires two items. 

• A definition of what normal behavior is. 

• What is the risk of false alarm. (This is a trade-off between speed and 
mistakes). 

 

 

Change Detection GUI 

GUI 
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1) Recompute measures button : Runs the calculations. Allows you to 
change the measures used and obtain other results. 

2) Measure Selector pane : In the left pane you can choose the particular 
measures that you want to analyze in either Network or agent level. 
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3) Restrictor pane : Allows you to set the dates which the Over-Time 
Viewer will work and also if you want to set a skip interval. 

4) Chart pane : Area for displaying the final results. This area contains four 
tabs: 

Measures Values :  
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Fast Fourier : Charts the results of the selected measures after applying 
the Fast Fourier Transform [FFT]. 

 

Change Detection : Used to quickly determine that a changed has 
occurred. Find the change point to detemine the exact date. 

 

Distribution : Display this information in a color grid. The darker boxes 
signal higher values. 
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5) Function Buttons :  

• Display Options : Allows you to Rename the X-Axis, Y-Axis, or both, 
recolor the measures lines, change the width of the lines on the graph 
for better visibility. 

• Save Chart As... : Navigate to a directory, give the chart a name and 
click [ Save ] 

• Date markers... : A one or more dates to the graph which will place a 
vertical line on the chart. 

• Close : Close the dialog box. 

 

 

Over Dependence 

Over Time Dependence 
One major obstacle to the study of network dynamics is periodicity or 
over-time dependence in longitudinal network data. For example, if we 
define a social network link as an agent sending an email to another, we 
have continuous time stamped data. Intuitively, we can imagine that 
individuals are more likely to email each other at certain times of the day, 
days of the week, etc. If the individuals in the network are students, then 
their email traffic might follow the school's academic calendar. Seasonal 
trends in data are common in a variety of other applications as well. When 
these periodic changes occur in the relationships that define social network 
links, social network change detection methods are more likely to signal a 
false positive.  
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A False Positive : This occurs when the social network change detection 
method indicates that a change in the network may have occurred, when in 
fact there has been no change. 

To illustrate, assume that you are monitoring the density of the network for 
change in hourly intervals. The density of the network measured for the 
interval between 3 A.M. and 4 A.M. might be significantly less than the 
network measured from 3 P.M. to 4 P.M. because most of the people in the 
network are asleep and not communicating between 3 A.M. and 4 A.M. This 
behavior is to be expected, however, and it is not desireable for the change 
detection algorithm to signal a potential change at this point. Rather, it 
would be ideal to control for this phenomenon by accounting for the time 
periodicity in the density measure. Only then can real change be identified 
quickly in a background of noise. 

Periodicity can occur in many kinds of longitudinal data. Organizations may 
experience periodicity as a result of scheduled events, such as a weekly 
meeting or monthly social event. Social networks collected on college 
students are likely to have periodicity driven by both the semester schedule 
and academic year. Even the weather may introduce periodicity in social 
network data, as people are more or less likely to email, or interact face-to-
face. 

Spectral Analysis provides a framework to understand periodicity. Spectral 
analysis is mathematical tool used to analyze functions or signals in the 
frequency domain as opposed to the time domain. If we look at some 
measure of a social group over time, we are conducting analysis in the time 
domain. The frequency domain allows us to investigate how much of the 
given measure lies within each frequency band over a range of frequencies. 

For example, the figure below shows a notional measure on some made-up 
group in the time domain. It can be seen that the measure is larger at points 
B and D corresponding to the middle of the week. The measure is smaller at 
points A, C, and E. 
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If that signal is converted to the frequency domain as shown in the figure 
bwlow, you can see how much of the measure lies within certain frequency 
bands. The negative spike corresponds to 7 days, which is the weekly 
periodicity in the notional signal. The actual frequency signal only runs to a 
value of 8 on the x-axis. The frequency domain signal after a value of 8 is a 
mirror image, or harmonic of the actual frequency signal. 
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The frequency domain representation of a signal also includes the phase 
shift that must be applied to a summation of sine functions to reconstruct 
the original over-time signal. In other words, we can combine daily, weekly, 
monthly, semester, and annual periodicity to recover the expected signal 
over-time due to periodicity. For example, the next figures represent 
monthly, weekly, and sub-weekly periodicities. If these signals are added 
together, meaning that the observed social network exhibits all three of 
these periodic behaviors, the resulting signal is shown in Sum of the 
Signals. 
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If the periodicity in the signal is not accounted for, it appears that there may 
be a change in behavior around time period 20, where the signal is 
negatively spiked. In reality, this behavior is caused by periodicity. If you 
transform the signal to the frequency domain you can see the weekly 
periodicity at point B and the sub-weekly periodicity at point A. 
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Spectral Analysis applied to social network measures over time will identify 
periodicity in the network. The next procedure will transform an over time 
network measure from the time domain to the frequency domain using a 
Fourier transform. Then the significant periodicity will be identified in the 
over-time network and present two methods for handling the periodicity. 

The over time dependence analysis is accessed by selecting the Fast 
Fourier Transform tab in the Over Time Viewer. This displays the 
frequency plot of the data. 

You can use the Over Time Viewer to help determine which frequencies are 
significant. 

The [Dominant Frequencies radio button], displays only the statistically 
significant frequencies. 

The [Fourier Transform radio button] uses the normal distribution in 
order to transform data from the time domain to the frequency domain. 
Therefore, the normal distribution is an appropriate distribution to fit to the 
frequencies plotted in the frequency plot. All frequencies that are within two 
standard deviations of the mean are then set equal to zero for the dominant 
frequency plot, revealing only the dominant frequencies. 
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NOTE : A dominant frequency is a potential source of periodicity, as 
opposed to random noise in the over time signal. 

The analyst will often want to transform the statistically significant 
frequencies from the frequency domain back into the time domain so that 
he/she can make better sense of them. To do this, the analyst must select 
the radio button on the lower left called Period Plot. 

The [Period Plot radio button] shows the analyst the expected periodicity 
in the over-time data. In the example, you can see weekly periodicity. The 
peaks and valleys in the period plot occur approximately every 7 days. At 
this point, the analyst may wish to merge the daily data into weekly 
networks. This would average out the effects of weekends and evenings that 
are likely to affect the properties of daily networks. Another approach is to 
simply look at the networks departure from what is expected. 

The [Filtered Plot radio button] will create an over-time plot of how the 
measure deviates from what is expected, based on the periodicity of the 
measure. You can also plot the filtered measure with the original measure to 
see the difference as shown below. 

 

 

Procedure 

Your Dataset 

 

Load your dataset which you need to run the 
Change Detection on into ORA. This should be 
a dataset with multiple time periods. Measures 
will be run on all the time periods and this will 
determine IF a change has happened. 
 
Highlight the Meta-Network. 
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Start Measures Over Time Function 
From the Editor's main menu select Visualizations > View Measures 
Over Time... to start the process. In the dialog box select Centrality 
measures radio button. The measures for Change Detection you are mostly 
concerned about are the Closeness and Betweenness measures. But this will 
not always be the case. 

Finally click [Compute]. 

Set Parameters For Trigger 
False Alarm vs. Fast Detection : You need to determine which type 
detection you are looking for. This will help you set the trigger point. Where 
you set the risk bar has an effect on triggering alarms. Set it too low and it 
will trigger an alarm quite frequently possibly giving too many false alarms. 
Set it too high and you might not see the trigger until it's too late. 

Example 
I select Network Centralization, Row Betweenness : A-03 

Next I click the Change Detection tab abd select CUSUM from the drop 
down menu. 

I then set the Risk to 0.17 and click [Compute]. 
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Setting the Risk to 0.17 sets the trigger line in the chart (1). 

The datapoint at (2) is a major spike but has not set off the alarm yet. 

After a slight decrease the next jump at datapoint (3) is still under the 
trigger point but very close. and the following datapoint sets off the alarm 
Sep-2009. Tracing backwards the point of change is Jul-2009 when the 
upward trend began. 

NOTE : There are two separate charts plotted. One is for increases (red) in 
the social network measures, and the other is for decreases (blue) in the 
measure. 
 
NOTE : When a change signals in both increasing and decreasing directions, 
it is likey a false alarm. 
 
NOTE : Once a signal occurs the CUSUM is no longer plotted over time. 
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Early Detection/False Alarm 

 

Setting parameters to different values can make changes in the alarm rate. 
Changes in the parameters (1) are Networks in control increase to 4 and 
Risk increases to 0.193. This lowers the alarm trigger point to 0.7 (2). 

(3) shows that the alarm is triggered in Aug-2009, a month earlier than 
the previous example although the upward trend is also Jul-2009. 

Had the Risk been risen any more the alarm would have been triggered in 
Jun-2009 and the changed point would be taken as May-2009, a full two 
months earlier than the previous example. 

The question would be is May-2009 the true change point or is it merely a 
false alarm given the parameters set to detect it. 
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Drill Down 

 DrillDown allows for any path to be followed. 

From the drop down textbox select the node you wish to start with. Here 
we'll begin with daniel_jackson. 

 

The dialog box below will appear confirming you want to discontinue your 
last drill-down session. 
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Click on the node and a contextual menu will appear with all the links it has 
to other nodes. I select <event> (5 nodes). 

 

This shows the five events the daniel_jackson was at. 

 

Next I select summit_meeting and from the contextual menu select 
<resource> (4 nodes).  
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It drills down showing the five links to resource nodes connected to the 
summit_meeting. 

 

This can be continued for as long as you need. 

The [+] and the [-] buttons increase and decrease the font size. 
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Node Cloud 

 In ORA you can opt to visualize your data as a word cloud. A word cloud 
can loosely be described as a visual representation of words that appear 
within your data by displaying words that appear with the most common 
frequency as the largest. Below is a screen image of the SG1 data set as 
visualzed in ORA's word cloud feature. 

 

Word Cloud Tools and Settings 
File : By accessing the File Menu you can open a previously saved Meta-
Network, Save an Image to the clip board, and close your Meta-Network 
word cloud. 

Options : In options, you can choose the measure you wish to apply to your 
word cloud visualization. 
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Horizontal Words : You can use this slider to set the ratio of the horizontal 
words visualized to the vertical word display (e.g, changing this setting to 
100% would result in all horizontal word visualizations and no vertical 
words. Conversely, changing this setting to zero has the opposite effect.  

Select a layout : Choose either word cloud layout (default) or a square 
layout. The square layout will attempt to visual your word cloud in 
approximate equal ratio of width and height.  

Min. Font Size : Sets the parameter for the smallest font size to display. 
Note: if you change this setting, click "run" to have the new setting applied.  

Max. Font Size : Sets the parameters for the largest font size to display. 
Note: if you change this setting, click "run" to have the new setting applied.  

Max Words : Sets a limit on the maximum amount of words to visualize 
(e.g., if you set this at 10, the word cloud will only visualize the words that 
appear in the top ten in terms of frequency.  

Run : Click [Run] to apply any changes to the settings. 

 

 

Color Grid 

The Color Grid is designed to allow you to quickly see what connections are 
in a network. Whereas the Editor either uses numbers in it's numeric view or 
check boxes in it's binary view the colored blocks used in the COlor Grid 
make it easier to discern who has a connection to whom. 

The color ranges from White : no connection; Yellow : few connections; 
Red : the most connections. 
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Menus 
File > Save Image As... Creates a color image (JPG or PNG) of the 
currently display grid. 

 

File > Save Image As... (Greyscale) Creates a greyscale image (JPG or 
PNG) of the currently display grid. 

 

Options > Toggle Headers : Toggles on/off the display for the headers 
and reduces the size of the grid. 
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Region Viewer 

NOTE : Before you start make sure you dataset contains both Latitude and 
Longitude data in order for information to be plotted and that it is in a 
numeric format. 

From the main menu select Visualizations > Region Viewer. You will be 
presented with a dialog asking you to select a Shapefile. Click the [ Load ] 
button and navigate to the shape file to use. These files contain the 
extension .shp After selecting a file click the [ Run ] button. 

File Type 
NOTE : The Region Viewer only works with WGS84-projected maps 

Region Viewer 

The Region Viewer and Legend will appear on the 
screen. The Region Viewer with the ShapeFile you loaded 
and the Legend with the Node Class containing the 
Latitude and Longitude attributes. Currently there are no 
values. This needs to be assigned. 

Shape Legend 

Using the Shape Legend you can color individual shapes. 
Click on a color box and choose a color. After hitting 
[ OK ] the shape will take on that color. 

The Menu 

File 

Save Screenshot : Options for saves a screenshot in 
either the .PNG of .JPG format. 

Close : Closes the Region Viewer 
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Action 

Color All Shapes... : Brings up the Select an Entity Color 
dialog. All shapes will be colored. 

Color All Occupied Shapes... : Will put selected color in 
shape which contains a node within the shape's 
boundaries. 

Color All Unoccupied Shapes... : Will put selected color 
in shape which does not contain a node within the 
shape's boundaries. 

 

Color Shapes by Attribute... : Select an attribute from 
the drop down. All shapes will be colored based on the 
value of that attribute 

NOTE : The attibute choosen needs to be a numeric value. 
Text values will not be shown in the drop down. 

Color Shapes by Measures : Runs the selected measure 
on the Meta-Network and colors shapes from the min 
and max values. 

Color Shapes Using Existing Value : With the Position 
tool deselected click on the color square and select a 
new color. Each shape clicked will be given this new 
color. 
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The Toolbar 

 

The first three tools are straight forward. The far-right 
tool needs a slighly longer explanation. 

Zoom In : Clicking this button will zoom in the map 
based on the the center of the map 

Zoom Out : Clicking on this button will Zoom Out based 
on the center of the map. 

Position : Clicking this button will toggle the Center 
function and the Color function. When highlighted 
clikcing anywhere on the map will make that the 
current center. The map will redraw based on the new 
center. When unhighlighted the Colorize tool is 
activated. 

Colorize : When the Position button is not selected this 
function is available by virtue of the small circle to the 
left of the color patch. 

 

 

View Trails 

 Tracks agents as they travel from location to location finding when 
various agents were co-located in the same area. 
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The Person Pane allows you to choose which Trail(s) you want to 
visualize, as well as what color to use. 

The Location Pane acts as more of a legend, showing you the currently 
active targets, while providing a way to change colors. 

The Trail Pane is where the trails are actually visualized. The Y-Axis 
corresponds to time. 

Trails Data 
The data to be used is known as TAVI. It tracks persons as they move 
around, with their position decided by which camera locates that person for 
any given time. As such, at any given point in time, each person is only 
associated with one location TAVI makes use of a relatively new data format 
known as the Dynamic Meta Network. The Dynamic Meta Network allows for 
creation and usage of multiple time slices, while keeping file size complexity 
to a minimum. In TAVI's case, it works with around 2700 different time 
slices, tracking about 20 agents over the course of two years. 
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After a Trails dataset is loaded you can view the individual time slices in the 
Meta-Network pane. To view this is Loom select Visualizations > View 
Trails. 

The Focus of Activity are figuring out where people tend to go and 
guessing what they do there? 

It always involves both subjects and locations. 

Unlike a network, subject may revisit location. 

The time stream is an integral part of the data. 

Subjects exist at one location at a time (but longer relationships may 
be implicit in repeated visits). 

Loom is primarily concerned with how specific entities move or evolve 
through other entities. In the most basic case, this involves Agents as they 
move through Locations, which is what we'll be looking at today. More 
abstract examples include Agents moving through Beliefs or Beliefs moving 
through Locations. When you first start Loom, you are prompted for a 
Network. The target nodes in the Network dictate what they're moving 
through. The source nodes are who/what is doing the moving. Once started, 
Loom goes through all time slices, and looks at the connections in that 
network only. It sets up a series of way points based on what connections 
are made at that time slice, upon which it constructs a trailset. Classically, 
we restrained Loom such that for any time slice, any source node could 
appear in at most one target, but now we allow for a source node to occupy 
multiple targets at a time (Agents having multiple beliefs, for example). 

Notes on Trails : Everything is scaled according to time. This can lead to 
some interesting behavior. In this example, we see a horizontal line. This 
doesn't mean an entity occupied two targets at that time, but rather, is 
because of the scale. The change may have taken only minutes or hours 
when the entire thing looks at two years. 

Procedure 
The Trails Report : To access the Trails Report use the Report Manager. 
The trails report can be found either through the drop down menu or in the 
Geospatial category 

Input : The report requires an input of at least two meta-networks with 
similar network structure (for the network we're interested in). Since TAVI is 
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dynamic, we can get all the meta-networks we need from it. However, 2700 
meta-networks will take quite a bit of time to work on, so we can aggregate 
by month to reduce it to a much more manageable number. 

Selecting a Trail(s) : The next window is perhaps the most important. 
While it doesn't ask for a specific Network, is does ask for nodes to track and 
a node class to track through. 

In other words, we're selecting the Subjects (trails) up top, and the targets 
on the bottom. Since we've been looking at Person X Location, that is what 
has been selected. 

Finish : Select the format for output, the directory in which to save it, and 
an optional extension. 

 

 

Export Matrices 

Importing 
You will need a Meta-Network with location data. 

Benefits and Drawbacks 
It's good to understand what different information visualizations of trail data 
give you. The Over-Time Visualizer displays data in individual time 
periods. The GIS visualizer displays all data simultaneously regardless of 
time. The Loom displays paths agents take to locations chronologically. 

Cluster Similar Trails 
Use Loom to cluster similar trails. It is a high level concept display for who 
was where when. 

Procedure 
Take your Dynamic Meta-Network and view them in Loom. From Loom 
menu select File > Export to Ora NetScenes > 
Transition/Colocation/Visit Matrix.... ORA takes the entire trailset and 
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outputs a single meta-network. It takes all the data from the multiple time 
periods and aggregates them into a single Meta-Network. 

Colocation : An edge is created between nodes if they ever existed at the 
same place at the same time. 

Visit Matrix : An edge is created between a location and node if the 
location was the site of an event. 

Transition : An edge is created between locations if a agent traveled to 
that location. 

Visitation Frequency Matrix Location 
The export operates from what is visible. It counts the total number of visits 
to all locations. The Matrix is similar to the Transition matrix. 

Example 
CLick the [ + ] to expand the Dynamic Meta-Network then click the [ + ] to 
expand the first time period. There are two nodesets, Agent [with one node] 
and Location [with one node], and an Agent x Location network. This 
represents the winner of the first World Series. As the time period progress, 
more trophies are added as various sports add trophies. 

Load your Dynamic Meta-Network and make sure it is ighlighted. Either click 
the [ View Trails ] button or select from the menu Visualizations > View 
Trails. 

 

This Loom image displays all the winning cities of the World Series. Each 
stopping point represents one year. The other three looms are for Football, 
Hockey and Basketball. As each sports developed their own final game, an 
additional agent and location are added to the time period. 

The display in Loom for the Baseball trophy is readable. 
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But adding in the other three creates a hard to decipher display. 

 

Colocation Network 
An edge is created between nodes if they ever existed at the same place at 
the same time. 
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Transition Network 
An edge is created between a location and node if the location was the site 
of an event. 
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Visit Network 
An edge is created between locations if a agent traveled to that location. 

 

  



489 
 

 

Help Menu 

The Help Menu contains information which is beneficial in running ORA. 

 

Help Contents : Calls up this Help File System 

 

System Monitor :  

 

 

About Ora : Contains information regarding this software, the 
institute of origin, permissions and warranties, version and build 
dates, and Java usage. 
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The ORA Visualizer 

The ORA Visualizer produces a graphical model of a Meta-Network 
comprised of Links and Nodes. Moreover, you can interact with your Meta-
Network model by removing key actors, isolating certain links, 
focusing on any particular relationship between two nodes using 
tools such as the Path Finder.  

You can apply a host of grouping algorithms, look at node's Sphere of 
Influence, Locate Nodes, which may be hidden in complex clusters of nodes 
and links. 

The Visualizer Interface 
Below is a visualized Meta-Network displayed with the current tools available 
in the Visualizer. In this view all nodes and links are visualized. Note the 
different palette areas and options available from the Visualizer.  
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NOTE : If a Meta-Network contains more than 400 nodes then all node 
labels will be hidden. If a Meta-Network contains more than 1000 links then 
all links will be hidden also. The labels and links still exist and still factor into 
the layout, but just aren't drawn. The user still has the option to toggle them 
back on using the corresponding buttons on the Visualizer. 

Closing the Visualizer 
When you close the Visualizer you will be asked [Save Visualizer 
options?]. Selecting [Yes] will maintain the current state this Meta-Network 
is in. i.e. If you have hidden any nodes they will not appear the next time 
this Meta-Network is opened. 
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Synchronization 
Synchronization allows you to work in the Editor and instantly see those 
effects in the Visualizer (or visa versa). Adding or removing a link in the 
Editor will place that link on the screen in the Visualizer. 

The ORA Layout Algorithm uses a standard spring embedder algorithm. 
For large data sets, this has been enhanced using the Barnes-Hut Simulation 
for calculating the force of repulsion between any two nodes. 
Reference :Nature 324, 446 - 449 (04 December 1986); 
doi:10.1038/324446a0, A hierarchical O(N log N) force-calculation 
algorithm, Josh Barnes & Piet Hut 
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Visualizer Basics 

Contained in this section are some basics to the visualizer. Many are small, 
yet important aspects to the visualizer. 

 

 

Add Deltas 

Importing deltakey frame data 
The easiest way to create a dynamic Meta-Network is to first create a 
number of regular Meta-Networks. Then select all the Meta-Networks you 
want to merge into a dynamic Meta-Network. Right-Click on one of the 
highlighted Meta-Networks in the editor tree. Select Create a Dynamic 
Meta-Network from the contextual menu. 

This brings up a Dynamic Meta-Network importer dialog containing all Meta-
Networks you had selected. Next you need to select which Meta-Networks 
you want to act as keyframes. This can be as little as just the first Meta-
Network or as many as all the Meta-Networks. Click the [ Import ] button at 
the bottom of the screen. A Dynamic Meta-Network will be created. 

Does data have to be in deltakeyframe to run 
Loom 
No. It can be run with multiple Meta-Networks as long as the Node IDs in 
the locations Nodesets match in all Meta-Networks. In the zip file I sent for 
Star Wars, I included the regular meta-networks. Select all of 'em, and go 
the "visualizers -> view trails" route. It'll prompt for the network, and open 
up Loom. 

Can you show only some time periods or some 
locations 
In Loom, only the Locations that have entities currently moving through 
them gets shown. If an entity is currently moving through a location, that 
location cannot be hidden. 
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Similarly, there's no way to currently turn off a time period. The work-
around would be to just not include that time-periods meta-network 
whenever you load up loom. I'm anticipating this being something I'm going 
to get to implement.  

Danger of Creating Many Meta-Networks 
In a Meta-Network that uses Deltas, each time period only contains the 
changes to be made (add, delete, move nodes and links). But if your Meta-
Network is very large (i.e., the TAVI dataset has over 2,700 time period) 
exporting the imformation out would create over 2,700 separate Meta-
Networks. This can overwhelm a computer system in very short order. 

 

 

Dotted-Line Links 

You can set this parameter to change certain links from solid lines to dotted 
lines by setting the parameter on the toolbar. 

 

Change the dropdown menu from Hide links with weight: to Change to 
dotted-lin links:. Then set the trigger [Less Than, Equal To, Greater Than], 
and then set the value. 

Any link which matches these parameters will be converted to a dotted line. 

The Nodeset contains multiple links between agents most of which are a 
weight of 1. But five of the links are greater than 1. These links exist in the 
middle as we shall see. 
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Here is the entire network. For ease of viewing I used Display > Link 
Appearance > Show Multiple Links Between Nodes to show the 
bidirectional links. 

 

I change the option to Change to dotted-link links: and set the paramters 
to Less than 1.1 and change the And to Or. All links with a weight less 
than 1.1 become dotted links. 

 

The group of solid links in the middle are the links from matrix.  

 

 

Link Thresholds 

ORA attempts to find the link underneath the cursor. But as the number of 
links increases it becomes more difficult for to acquire the correct link. 

A threshold limit of 5,000 has been set. ORA will not attempt to locate the 
link under the cursor when viewing a Meta-Network with more than this 
number. 
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Link Status 

Why Link Attributes Exist 
Sometimes Link Weight isn't sufficient to hold all the necessary info about 
a link. You probably don't want to create 40 different Agent X Agent 
networks for each of the type of agent x agent links. But because you or 
your client made their data have link attributes you will have to support 
them 

Link Status Dialog 
You can see link attributes easily enough though through the Visualizer's 
Link Status Window. This is done by right-clicking or double-clicking a 
link. 
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Coloring 
Links can also be given specific colors by selecting Display > Link 
Appearance > Link Color > Color Links by Attribute. Clicking on one 
of the color boxes will bring up the color picker. All links with this 
attribute will then be color the same. 

 

 

Labels 
You can select any attribute as your links labels by selecting Display 
> Link Appearance > Link Labels > Show Attribute... 
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Selecting Nodes 

There are times you need to have a set of nodes selected in order to work 
on them. Instead of clicking on each node individually you can use the 
Marquee tool. 

Selecting a Set of Nodes 

  With The Marquee Tool you can select a set of nodes to work with. To 
select your nodes, Click and Hold the mouse button, drag the pointer to 
select the nodes, and release the button. 
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The Visualizer Toolbar 

This section explains the function of each of the toolbar's default buttons. 
The user can add or remove buttons from the toolbars. These are explained 
in other sections of this help. 

When you first load a Meta-Network you will see the pause button 
depressed in the Visualizer tool bar. You can layout the Meta-Network by 
clicking the play button. The visualization will space apart across the screen. 
This is called laying out a Network. The Visualizer is separating nodes and 
links that, at first, appear on top of each other. You can pause this process 
again when you think the Meta-Network is satisfactorily spaced apart or you 
can let ORA lay out the entire Meta-Network. Your computer speed, as well 
as the complexity of Meta-Network, will determine how long this takes.  

 

Copy / Paste : This feature allows you quickly capture a 
visualization and save it to be pasted into another document later. 

  

Play / Pause : The Play Pause function works very similar to the 
play pause feature on any device. The pause button (two vertical 
bars) is depressed, the Visualizer stops laying out a Meta-Network. 
When the play button is depressed (right pointed triangle) ORA 
Visualizer begins laying out the Meta-Network as described above. 
The red ellipse highlights on the tool bar where this feature is 
located and accessible. 

 

Magnifying / Maximizing : The Magnifying Glass icon with the 
plus sign inside it, allows you to instantly fill the Visualizer window 
pane with the currently rendered Meta-Network. The red circle in 
the screen shot above highlights where to access this feature on 
the Visualizer tool bar. 

If there are any nodes off screen, clicking the button once will bring all the 
nodes into view on the screen. 

NOTE : This function works well when selecting a small part of your overall 
Meta-Network and magnifying it to fill the visualizer screen. 

 

Rotating The Visualization : To Rotate your visualization 
look for the word next to the Noon-pointing sundial icon in 
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the tool bar. This feature is another way to manipulate your 
visualization to fill the entire visualizer window pane. 

NOTE : Use this feature in conjunction with the magnifying glass function to 
work your visualization into largest size possible. 

 

Show Labels : The Show Labels button allows you to toggle the 
labels on & off in the visualizer. Default is is ON. 

 

Show links : The Show Links button allows you to toggle the links 
on & off in the visualizer. Default is is ON. 

 

Show Arrows : The Show Arrows button allows you to toggle the 
arrows on & off in the visualizer and show directional data. Default is 
is OFF. 

 

Font Size : The Font Size allows for setting the size of the 
font in the visualizer. This allows you to change the size of 
the font to suit you needs for each individual visualizer set. 
It ranges from 4, which is almost unreadable, to extremely 
large numbers, which can also be unreadable by virtual of 
overcrowding. So pick the size of font that best suits your 
screen. 

 

 

Node Size : The Node Size allows for changing the node 
size, larger or smaller by increments of one. Four is the 
smallest size possible and creates a very small, almost 
indistinguishable dot. As the number increases is becomes 
easier to see the individual nodes until the number gets to 
a point where is can simply overpower the screen. But this 
gives you the ability to customize the entity size to suit 
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your needs. 

 

NOTE : This also affects the size of the nodes in the Legend. 

  
Link Width : Allows for changing the general width of the line, larger 
or smaller. And as the options before you can pick the exact size which 
best suits your needs for the display. 

 

 

Meta- Size : Use the Meta Node Manager to handle creating and 
removing Meta-Nodes. 

 

Node Sizes : The Toggle Node Size button rotates through three 
sizes for the nodes (as seen below). 
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Hide Links by Weight : Use the Hide Links with Weight to select which 
links to display. As long as there are links with different values you can hide 
links of smaller values leaving only the more important links visible. This can 
assist in seeing links that might normally be too cluttered to view. Below left 
is a Meta-Network with all links in view. Below right is the same Meta-
Network with links less than 2.0 hidden. 

 

 

Drag : Used to move the view around the Meta-Network to see 
different parts. Press and hold the left mouse button and move the 
pointer around to view various parts of the Meta-Network. 
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Marquee : Click and drag the marquee over nodes to select them. 

After releasing the mouse button the set of selected nodes will remain 
enlarged enclosed in a dashed line. 

 

After selecting a group of nodes they can be moved all together. Press the 
[Pause] button on the toolbar, switch to the [Move] tool, then grab and 
move the group. This is useful in creating displays of small portions of the 
visualizer. 
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NOTE : Only one set of nodes can be selected at a time. Creating a second 
selection negates the first nodes selected. 

 

The Paint Tool : The Visualization Paint tool allows you to draw 
on the visualization.  You can select a brush size and a brush color 
via a small pop-up menu that appears whenever paint mode is 
selected.  Nodes are also selected whenever you stop drawing, 
using the shape drawn (plus a line from the endpoints of the 
drawing) as a giant polygon, which selects nodes based on whether 
or not they’re inside the polygon.  There’s also a “clear” button that 
removes all paint. “painting” works similar to using a marker on 
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your computer screen – no matter how much you zoom/pan/do 
whatever to the visualization, the marks will remain in the same 
place. 

 

Node Creator : You can create new nodes within pre-existing 
Nodesets or create them in a new Nodeset. 

 

Link Creator : Click on one node then drag the pointer to a second 
node. A link between the two will be created. 

 

Node / Link Eraser : While the Eraser tool is active any node or 
link clicked will be removed from the Meta-Network,/tr>  

 
 

 

Visualizer Toolbar 

 

 

To help facilitate your workflow ORA allows you to mount/unmount 
tool buttons in the Visualizer's toolbar. The Visualizer contains two 
toolbars for this function. One on the top and another along the left 
side. Either of these toolbars can be placed in the horizontal or 
vertical position. Click the down-triangle to open the dialog box. 
 
The grey-out buttons are the default set. The buttons at 100% are 
the ones I added to my GUI. 
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NOTE : Buttons without graphic images are placed on the toolbar using 
words. When placing a toolbar vertically it will expand to the width of the 
largest button. 

 

The Configure Toolbar dialog 
box will appear. You will notice 
that some items are already 
checked. These correspond to the 
buttons already present. Placing a 
check mark next to any tool 
instantly mounts it on the toolbar. 
Removing the check mark from a 
button instantly removes the 
button from the toolbar. 
 
When you are finished click 
[Close]. 
 
If at any point you can select the 
[Restore Default] button which 
will remove all the changes you 
made and restore the toolbar to 
the buttons found in the image at 
the top. 

NOTE : The buttons appear in the order you select them. You can not re-
arrange buttons once they are placed on the toolbar. 

 

 

Hide Links By Weight 

ORA can visualize your network with only the more weighted links 
displayed. Below are procedures to accomplish this task.  

You can select to hide links either Less Than or Greater Than a certain 
value. Below is an agent x location network. And there are three tooltips 
displayed for jacob_carter for the values of 1.0, 2.0, and 3.0. We'll keep the 
hiding style as Less Than. 
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First we'll increase the value to 1.1 hiding all lower values. The link to the 
hasaraSystem_spaceStation is removed from view. The others, however 
are still on the screen. 
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Now let's increase the value to 2.1. This removes the link from jacob_carter 
to revanna. 

 

If we increases to value to 3.1 then all of the links would be removed. 

In this way you can remove links which are of lesser important to 
concentrate on a smaller set of data. 

 

 

Hyperbolic View 

The Hyperbolic function creates a bulge within your visualization adding a 
sense of depth. By moving the slider from right to left, you can increase or 
decrease this bulge effect and create different depth-added views. By 
moving the network around the window you can create the view you need. 
The Hyperbolic radio button and slider can be found at the bottom of the 
window. 

This tool is useful when nodes may be very tight on screen such as the ones 
in the following images. Using the Hyperbolic tool you can help space them 
out for easier viewing. Here is how to do so: 
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NOTE : The Hyperbolic function, when selected, converts the slider to this 
feature. This is also true of using the zoom and rotate functions. Use all 
three in conjunction to get your visualization just the way you want it. Scroll 
down below this screen shot for another when viewed with the Hyperbolic 
feature. 

 

Select the Hyperbolic tool and move the slider to the right. Then click-and-
hold on some part of the white background and move the entire network to 
the left. You will notice the space between the nodes begins to increase the 
closer them come to the center of the screen. 
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Now the nodes are able to be read much easier. 

NOTE : It is useful to use this tool in conjunction with the Rotate and 
Magnify tools to obtain just the view you desire. 
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Visualizer Paint Tool 

 The Visualization Paint tool allows you 
to draw colored lines on a visualization. You 
can select a brush size and a brush color via a 
small pop-up menu that appears whenever 
paint mode is selected. 
 
Nodes are also selected whenever you stop 
drawing, using the shape drawn (plus a line 
from the endpoints of the drawing) as a giant 
polygon, which selects nodes based on whether 
or not they're inside the polygon. There's also a 
clear button that removes all paint. Painting 
works similar to using a marker on your 
computer screen - no matter how much you 
zoom/pan/do whatever to the visualization, the 
marks will remain in the same place.  

From the Paint Palette you can select a brush size by adjusting the slider. 
Then choose a color by clicking a pre-set colour or clicking the [Custom 
Color] button and select any color. Clicking the [Clear] button sets 
everything back to default. Once brush size and color are selected, you can 
draw on the Visualization. 

To undo your drawing click the [Clear] button. 

NOTE : If you pan the visualization, the paint drawing will remain stationery 
on the screen. It does not move with the visualization.  

 

 

Rotating A Visualization 

You can rotate a visualization with the slider bar at the bottom of the 
interface or from the tool bar at the top. To do this from the slide bar, click 
the rotate option toward the bottom of the interface. This activates the 
rotate feature.  
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As you move the slider from the left to right, your visualization will rotate 
correspondingly. From the tool bar, you can click inside the rotate icon, 
which will turn the visualization depending on exactly where you clicked.  

In the screen shot below, the yellow ellipses highlight where to access ORA's 
rotate tool both at the bottom and top of the visualizer interface. 

NOTE : Use the rotate feature in tandem with the magnifying glass to find a 
visualization's maximum screen size. 

 

 

 

Show/Hide Labels 

 Node labels, which often prove helpful in describing Networks, can 
sometimes clutter a visualization. Thus, it may be necessary to eliminate 
labels from your visualization. To remove labels go to Visualizer tool bar and 
find the Show Labels button. 

This initial screen shot shows the visualizer with all the labels. 
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When you click the Label button on the Visualizer tool bar ORA toggles the 
labels on and off. Note that now a much more clearer conceptual picture of 
the network is produced. You can flip between the two views. 

Hide Single Nodeset Label 
In ORA you can hide the labels of one Nodeset but show the labels of 
another. You might want to do this, for example, if you want to show the 
names of organizations but not those of people (the agents). In order to do 
this you can do either of the following: 

1) Turn on all labels. In the Legend, right click on the Nodeset whose 
labels you want to hide. The Node Formatter Dialog will appear. Under 
Label are options for Hide Nodeset Name(s) and Show Nodeset 
Name(s). 

2) Turn on all labels. Under Tools select Node Selector. In the top part, 
select the tab of the Nodeset whose labels you want to hide. Select the 
Select Visible option. This selects all nodes in that Nodeset (and only 
that Nodeset). Below that, Select the Node Appearance tab. Uncheck 
the Show Label(s) checkbox and click the Set Labels button to the right 
of it. 

 

 

Zooming 

At the bottom of the Visualizer interface is a sliding zoom bar (image below).  

You can drag the scrollbar left (to zoom out) or right (to zoom in).  
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In the screen shot below the zoom bar has been set to the far left, the 
absolute zoom out possible. At this point very little is distinguishable. 

 

In the next shot the zoom bar has been placed almost to the far right, 
absolute zoom in. It allows for extreme closeups of various parts of the 
Meta-Network. 
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NOTE : Clicking on the Magnifying glass in the Visualizer tool bar will set 
the view to include all visible nodes. 
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File Menu 

 

Open Meta-Network : This opens an Open File dialog box so you 
can navigate to a directory and open a Meta-Network into the 
Visualizer. 

 

Open Ora-Image :  

 

Save Image to File : This opens a Save As... dialog box and allows 
you to save an image of the current Visualizer in one of the following 
formats: PNG, JPEG, SVG (scalable vector), or PDF. 

 

Save Meta-Network to File : After you've made changes to the 
information you can save the current status of the Meta-Network into 
a new file in a DyNetML* format. 

Save Special :  

 

Save Meta-Network (Only Selected Nodes) : Saves a new Meta-
Network file which will contain only nodes currently selected, i.e. a 
subset of the currently loaded Meta-Network. 

 

Save Grouping to New Meta-Network :  

 

Save Meta-Network (No Dotted Links) :  

 

Save Meta-Network (Only Dotted Links) :  

 

Copy Image to Clipboard : Similar to the Save Image to File... 
only saves it to the clipboard where you can paste it into an image-
editing program. 

 

Record Movie :  

 

Add Meta-Network to ORA : Save the currently visible network 
into a new Meta-Network titled, New Meta-Network. This new 
Meta-Network can be renamed accordingly. 
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Add Grouping to Current Meta-Network :  

 

Add Meta-Nodes to Current Meta-Network :  

 

Visualize in 3-D :  

 

GeoSpatial Networks :  

 

Node Cloud :  

 

Close : Close the Visualizer and returns to the Main Interface. 

 
 

 

Save Image to File 

An image can be captured from the Visualizer and saved in one of four 
formats: 

• PDF : This format us usable with Adobe's Acrobat and Reader 
programs. 

• JPEG : A standard compressed format for image editing. 

• PNG (Portable Network Graphics). PNG is a bitmapped image format 
that employs lossless data compression. PNG was created to improve 
upon and replace the GIF format. 

ORA Images are functional in regards to PNGs. Whenever you save a PNG, 
relevant information about the visualization gets stored inside the image. 
This makes saving a little longer, but not so long that you'd notice if you 
were not looking for it. These images Node Colors, Node Location, 
Screen Center, and Zoom Value. 

Loading images into a visualizer will re-create the image inside the 
visualizer. Loading an image is as simple as dragging-dropping it onto the 
visualizer.  

SVG : Stands for Scalable Vector Graphics. SVG is an XML specification 
and file format for describing two-dimensional vector graphics, both static 
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and animated. SVG can be purely declarative or may include scripting. 
Images can contain. 

Selecting Image Resolution on Save 
After choosing a format form the drop-down menu and specifying a filename 
press [Save]. A dialog box will appear asking for the quality of the image. 
The 1.0 saves the image in the same resolution. A higher number will result 
in a higher resolution image. 

 

Below are examples of an image saved with a scale of 1.0 (on the left) and 
then saved with a scale of 5.0 (on the right). Use a number higher than 1.0 
if there is a need for a higher resolution image. 

 

NOTE : Values less than 1.0 are ignored when scaling images. 
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Saving New Meta-Networks 

Occasionally you need to select only a portion of the visible Meta-Network 
and save them to a new Meta-Network. Using the Marquee tool and 
Control-Clicking individual nodes you can select exactly which nodes you 
need to create a new Meta-Network. 

From the main menu select File > Save Special > Save Meta-Network 
(only Selected Nodes). Navigate to the directory to save the new Meta-
Network and click [ Save ] 

This new Meta-Network can be loaded into ORA and viewed independent of 
the original Meta-Network. 

Save Selected Sub-Network 
Ability to save selected sub-Meta Network/Network comprised of dotted-
links/network comprised of non-dotted links, ability to launch into GIS (if 
network has locations with appropriate data) 
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Views 

This section of the help contains a description of the functions of the View 
Menu: 

 

Change Font : Allows you to change the GUI font to any font on 
your system. Be careful with the font chosen as some fonts are built 
more for custom design rather than readability. 

 

Log Hidden Nodes to Event Log :  

 

Log Hidden Nodes to File :  
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Actions 

This section of the help contains a description of the functions of the Action 
Menu: 

 

Undo : Undoes a variety of actions performed in the Visualizer. 

 

Add Node(s) : Function for adding Nodes directly into the Visualizer. 
These can be added to existing Nodesets or within newly created 
Nodesets. You also have the option of the number of nodes to create. 

 

Add Node (with links or attributes) : Allows you to add a Node 
directly into the Visualizer. In addition you can create links and 
assign weights to these new links. You can also select attributes and 
assign values to these attributes. 

 

Add Link : Allows you to create new links in a Meta-Network in the 
Visualizer. Then select the source and target nodes and then select 
the network. You have the option of creating a new network for this 
link. Lastly you can select the weight of the new link. 

Notes on Display of Multiple Edges : If your Meta-Network contains 
graphs with multiple edges between two nodes ORA will display the 
edges as curved lines so as to allow visualization of overlapping 
Edges. This is to say that if there is represented two nodes with four 
edges coming from four different graphs. 

Please note that Tool tips are currently handled by math looking at the 
edge as if it were a straight line. Since our line is not straight anymore, it 
will only be highlighted if the cursor's in the middle - nowhere near the edge. 
But otherwise, you should still see tool tips. 

 

Delete Isolates... : Allows you to remove Isolate nodes in two 
ways. 

 

Delete Pendants : Allows you to remove Pendant nodes in two 
ways. 
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Delete Currently Visible Isolates/Pendants : Currently Visible 
is exactly as it sounds. If it has no visible link on the screen, 
it's an isolate. It does not matter if there's a link that is 
hidden, it's an isolate/pendant. 

Delete Underlying Isolates/Pendants : Underlying ignores was 
is currently set to visible and hidden. It looks at the data 
itself. If the Data says it's an isolate/pendant, then it's an 
isolate/pendant and is removed. 

WARNING : These actions DELETE the nodes from the Meta-Network. 
Saving the Meta-Network will permanently remove the nodes. 

 

Pin All Nodes : Set all nodes as unmovable 

 

Unpin All Nodes : Release all nodes and allow them to be moved 
independently. 

Show Motifs 

 

Show Isolates : Nodes which have no connection to any other 
node. 

 

Show Dyads: Nodes which have a connetion to only one other 
node 

 

Show Triads : Nodes which have a connection to two other 
nodes 

 

Show All-In-All Cliques : A group in which every node is 
connected to every other node in the group 

 

Show Stars : A central node with connections to all other nodes 
in the group. The pendant nodes are not connected to each other. 

 
Show Long Chains : Seeks out links which are nodes with only 
two neighbors. 
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Show Cycles : A cycle exists if for any node in the group, there is 
a path back to that same node. 

NOTE : Cycles is the only motif that really looks at link direction. 

Isolates 

 

Hide Isolated Nodes : Remove any node which has zero links 
connecting it to other nodes. 

 

Periphery : Moves Isolates back to their original position. 

 

Combine into MetaNode : Collects all the Isolate nodes into a 
Meta-Node. 

 

Move into Column : Moves all isolates to the right side of the 
screen in a column. The isolated nodes can be moved back using the 
Periphery option. 

 

Hide Pendant Nodes : Remove any node which has only one edge 
connecting it to another node. 

 

Recursively Hide Pendants : This function will run the both the 
Hide Pendant routine until there are no more Pendants. 

 

Recursively Hide Pendants and Isolates : This function will run 
both the Hide Pendant and Hide Isolate routines until there are 
no more Pendants or Isolates. 

 

Hide Nodes by Degree: You are asked for a degree (visible 
neighbors) a node has and will hide all of these. 

 

Recursively Hide Nodes by Degree: Works similar to Hide Nodes 
by Degree but continues processing until no mode nodes can be 
hidden. 

 

Show All Nodes: Any nodes that were previously hidden will be 
revealed. 
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Show All Nodes Except Isolates : Reveal any nodes that were 
previously hidden with the exception of nodes that have no links 
connecting them to another node. 

 

Compute Standard Measures for Visible Network : Compute 
Standard measures computes the following collection of measures on 
the visible network: Total Degree Centrality, Betweenness Centrality, 
Eigenvector Centrality, Cognitive Demand, Resource Exclusivity, Task 
Exclusivity, Knowledge Exclusivity. The measure values can then be 
viewed within the Entity Status Window. 

 
 

 

Hide Pendants 

Pendants share links with only one other node. Their linkage is tangential 
and therefore isolated from the core linkages you may be interested in 
examining. Pendant Nodes, like Isolated Nodes, can be hidden. 

From the drop down menu in the Visualizer select Tools > Hide Pendant 
Nodes.  

Below is a Before/After screen shot of the visualization before showing the 
removal of the pendant nodes. 

 

 

 

 



526 
 

 

Add Node 

IMPORTANT NOTE : Changes done using Add Node(s) and Add Link(s) are 
transient. Be sure to use either the File > Save Meta-Network As... (to 
save the entire Meta-Network with additions) or File > Add Meta-Network 
to Ora (to create a new Meta-Network using only the currently visible 
nodes). Changes can not be saved back to the currently open Meta-Network. 

The Add Node(s) function allows addition of nodes to the current Visualizer. 
These added Nodes are not added to the currently open Meta-Network. If 
there is a need to save the Meta-Network with the added nodes then use the 
menu item File > Save Meta-Network to File... and create a new Meta-
Network. 

Below is the NodeSet for Stargate with the original 16 node NodeSet. 

 

From the main menu select, Actions > Add Node(s) which brings up the 
Add Node(s) dialog box. 
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1. Use an Existing Nodeset :  

allows for for a NodeSet selectable in option 2 or Use a new nodeset 
creates a new empty NodeSet. 

2. This dropdown gives the option for selecting a pre-existing NodeSet to 
place the new node. 

3. The Node ID: textbox is used for giving the new node an ID. 

4. The Number to Create: specifies the number of new nodes. 

NOTE : If the Number to Create is larger than 1 then the text placed in 
section 3 for Node ID will be used as a prefix for all new nodes crated. 

After inputting the information to add node A17, the Visualizer will now 
display the new node as A17 with no connections. In order to display this 
node with a title will require saving the Meta-Network and changing the 
information within the ORA Editor. 
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Adding Multiple Nodes 
The procedure for adding multiple nodes is similar to adding a single node. 
The exception is the text in the Node ID: textbox. When adding multiple 
nodes only use a prefix. ORA will attach numbers, starting at 1, for each 
node. 

Here's the addition of three new nodes and the prefix A will be used. Three 
nodes, A_1, A_2, and A_3 are created on screen. 

NOTE : You can only use a prefix ONCE. ORA will not accept any previously 
used prefixes a second time. 

 

To add additional nodes use a different prefix. 
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NOTE : Now either save the altered Meta-Network using the File > Save 
Meta-Network As... to a new filename or continue with Add Link(s). 

 

 

Add Link 

Allows you to create links between nodes in the Visualizer and place them in 
an existing Nodeset or create a new Nodeset. You can also set the weight for 
the new link. 
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NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be 
sure to use either the File > Save Meta-Network As... (to save the entire 
Meta-Network with additions) or File > Add Meta-Network to Ora (to 
create a new Meta-Network using only the currently visible nodes). Changes 
can not be saved back to the currently open Meta-Network. 

1. Start node : The start of a directed link. 

2. End node : The end of a directed link. 

3. Insert Nodes as they're clicked : Fills in the text boxes for Node. 
The first click adds the node in the Start node section. The second 
click adds the node to the End node section. Any further clicks will 
make the previous End node the start node and the newly clicked node 
becomes the new End node. 
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4. Use an Existing network : will place the links within the chosen 
network form the dropdown menu and Use a new network creates a 
new network from the name in option 5. 

5. New Network ID : is the name for the new network from option 4. 

6. Network : allows you to choice the Network to create the link in. 

7. Link Weight : The weight to assign the link between the nodes. 

NOTE : Since this function creates directed links a second link would need 
created for reciprocal action. 

Example : If a connexion was made starting with A to B, a second 
connexion would need to be made starting with B to A. 

Adding a Missed Link 
If after the Meta-Network was constructed and it's noticed an link is missing 
(e.g. janet_frazier should have been connected to gen_hammond), the 
missing link can be added immediately without returning to the editor. 

 

From the Visualizer menu select Actions > Add Link(s). 
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Be sure that the Insert Nodes as they're clicked has been check marked 
and that Use an existing network is selected with the correct network is 
visible in the dropdown. Then select the [Create Link] button. 

 

The two nodes are now connected with a directed link. 

NOTE : this created a directional link from janet_frazier to 
gen_hammond but not the other way. To make it go both ways, a second 
link from gen_hammond to janet_frazier would need to be created. 



533 
 

 

 

Color Nodes By Attribute 

When the agent-by-agent network is opened all the nodes default to the 
color red. ORA has default colors for all the various Node Classes. But ORA 
can also color the nodes based on their individual attributes. Here's the 
default agent-by-agent Node Class in red. 

 

From the Visualizer main menu select Actions > Color Nodes by Attribute 
or Measure. This brings up the Node Color Selector dialog box. 

 

Selecting the down arrow for Select an Attribute:. Highlight an attribute 
from the list. ORA gives default colors to the nodes. 
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In some instances the color distinction isn't highly visible. And for 
presentation purposes a good contrast is necessary. 

To bring up the Color Selector click on the color you want to change. 

 

Note: By hovering over the measure or attribute, you can bring up detailed 
tool tips. 

Select a new color from the swatches. Then select [OK] 
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Your new color choice is now reflected in the dialog box. 

 

And the nodes with the attribute you selected are now a new, and brighter, 
color. 
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Compute Standard Measures 

This functions runs four standard measures: 

Cognitive Demand: Cognitive Demand measures the total amount of effort 
expended by each agent to do its tasks. Individuals who are high in 
cognitive demand value are emergent leaders. Removal of these individuals 
tends to be quite disruptive to networks. 

Centrality, Betweenness: Betweenness tells us which node is the most 
connected to other parts of a network. For example, Betweenness can tell us 
which person in a network is the most central to the network as a whole. 
Betweenness measures the number of times that connections must pass 
through a single individual to be connected. 

Centrality, Eigenvector : Eigenvector Centrality reflects one's connections 
to other well-connected people. A person connected to many isolated people 
in an organization will have a much lower score in this measure then those 
that are connected to people that have many connections themselves. This 
would be true even if such a WHO might have a high amount of actual 
connections (i.e. high degree centrality). 

Centrality, Total Degree: Degree Centrality tells us the relative number of 
direct connections a WHO might have in a network; the higher the score the 
more likely a WHO might be likely to receive and potentially pass on critical 
information that flows through the organization. 

These values can be viewed either by hovering over a node and revealing 
the tooltip or double clicking a node and bringing up the Node status dialog 
and selecting the Measures tab. 

 

Isolates 

Periphery 
Places isolates that were moved into column back to their original positions. 
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Hide Isolate Nodes 
To further simply a visualization, it may prove useful to remove isolated 
nodes from the visualization.  

Isolated nodes are not directly linked or connected to other nodes, which 
share direct links with each other. In the screen shot below, the red ellipses 
highlights an isolated nodes which need removed. 

 

Select from the Main Menu: Actions > Hide Isolated Nodes. 

In the screen shot below, after removing isolated nodes, the visualization is 
further simplified.  

 

Combine into Meta-Node 
This option will combine all the Isolates into one Meta-Node. This can be 
expanded right-clicking to bring up the contextual menu. 

Move into Column 
This function is used to move isolate nodes from the main viewing area to 
move easily view the connected nodes. These will be lined up on the left side 
of the screen. 
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NOTE : The original dataset was changed in order to create the isolates. 

NOTE : If the names are not viewable and off the screen, change the 
position of the labels 

The isolates can be returned to the original position using the Periphery 
options. 

:  

 

 

Add Network From Scratch 

This function also allows the creation of Networks from Scratch. First, 
remove the check marks from all the Nodesets in the Legend to remove 
them from the screen. 

 

The DataSet 
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Next prepare your data for inclusion. Here is a small, five , Nodeset. 

A01 col_jack_o'neill 

A02 maj-samantha_carter 

A03 daniel_jackson 

A04 teal'c 

A05 gen_hammond 

From the main menu select Actions > Add Node(s). 

In the dialog box activate the Use a new Nodeset radio button. 
Underneath, in the Type: dropdown menu, select the type of Nodeset. Then 
in the New Nodeset ID: textbox give it a name. Then select the [Create 
Node(s)] button. 

 

The five nodes will appear in the Visualizer with the prefix and attached 
numbers. Now it's time to connect the nodes. 
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From the Visualizer menu select Actions > Add Link(s). 

 

After selecting [Create Link] a new link will be drawn in the Visualizer. 
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Now switch the Nodeset to use to Use an existing network, select the 
newly created Nodeset in the dropdown, and create the rest of the links. 

 

All of the links are now complete. 

 

Save the Meta-Network with either Save Meta-Network As… or Add 
Meta-Network to Ora and use the ORA editor to add in titles and 
attributes. 
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Resize Nodes By Attribute 

Resize by Attribute uses the numerical value of an attribute to size the 
nodes. Sizes will be scaled accordingly. Below is an attribute created for this 
example.  

The numbers range from 0 to 10 and denote approximate rank. 10 denoting 
general/leader down through the ranks to 5 for civilians and finally 0 for 
persons not involved. 

 

From the main menu select Actions > Size Nodes by Attribute or 
Measure. Then select the attribute to use for the sizing. When finished, 
select [Close]. 

NOTE : Sizing nodes by attributes only works 
with attributes of numerical content. Alpha 
content will have no affect on the size of the 
nodes. 
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Each node will now be displayed according to the value in the chosen 
attribute. 

NOTE : The numerals are not displayed in ORA 
and are shown only for display purposes. 
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Resize Nodes By Measure 

ORA has the capability to visualize nodes by scaling them relative to each 
other in relation to common SNA Measures or Attributes as selected within 
the ORA Visualizer.  

The key benefit to sizing nodes by Measure or Attribute is the ability to 
conceptually capture which nodes in your network figure more prominently 
in terms of measures by simply gauging their size visually and intuitively. 

First, visualize one of your networks. Below is the Stargate agent x event 
network to find the agent with expertise regarding events in the scenario. 

 

From the main menu select Actions > Size Nodes by Attribute or 
Measure. 
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From the bottom textbox I selected Cognitive Expertise. Each of the nodes 
in turn grows to reflect it's value from that measure. 

 

The display now changes to reflect each node's value by size. 

 

We'll compare two nodes: daniel_jackson and teal'c.  
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daniel_jackson's cognitive expertise value is 0.2400 and is displayed with a 
large red circle while teal'c's value is 0.1556 is displayed by a much smaller 
red circle. The values can be read in the Node Status dialog box. 

Cognitive Measure for daniel_jackson 

 

Cognitive Measure for teal'c 
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Visualizer Tools 

The ORA Visualizer provides a suite of tools to visually analyze your Meta-
Network. The Visualizer Tools can be located accessed from within 
Visualization mode on the main menu bar (image below):  

 

Legend : Allows for toggling visibility of nodes and links on the fly. 

 

Drill Down : With the ORA Drill-Down Wizard you can quickly 
visualize ego networks by overall Node Class knowledge, tasks, 
resources, agents) or by choosing individual nodes from a 
checklist. The ORA Drill-Down Wizard is only accessible through the 
Visualizer: 

 

Node Status : The Node Status Window is selected by default. It 
first pops-up when you select any node in the Visualizer. This window 
provides you with a snapshot of the currently selected node by 
displaying that nodes unique Attributes, Measures, and Neighbors. 

 

Attribute/Measure Viewer : Selecting an Attribute will group 
nodes by the selected Attribute. Selecting a Measure groups nodes 
by the selected Measure value. 

 

Node Selector : You can use the Node Selector to simply complex 
visualizations. 

 

Link Selector : In a complex network it may be difficult to locate 
one particular link. The Link Selector allows you can chose to work 
with One Node or Two Nodes, pick which is the Source/Target node, 
and the appearance of the link in the Visualizer. 

 

Path Finder : The Path Finder allows you to focus or drill down on 
a particular node, or multiple nodes, that you may be interested in 
analyzing in greater detail. 

 

Sphere of Influence : Each node within a network has a unique 
Sphere of Influence or Ego Network, essentially it's direct 
relationship with it's neighbors as a function of specified path length. 
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Backward Influence : Used to view how a node influences other 
nodes. 

 

Block Maps : Block Maps display varying intensities of data by 
displaying "blocks" correlating to the value of data. For instance, a 
block map displaying node centrality values would reserve the largest 
block for the node highest in that value. Color is used to as well to 
visualize different values with the the darkest color reserved for the 
highest value. Block Maps can also be referred to as heat maps.  

 

Node Locator : Brings up a window with the Meta-Network in a 
collapsible tree structure. Selecting any node within this tree will 
highlight the node, enlarge it, and bring it to the center of the 
display. 

 

Micro Simulation : Micro Simulation allows you to run some basic 
simulations on the curretly loaded visualization. LInk weights are 
important as once they are normalized, they correspond to the 
probablity of a transmission. 

 

Pie Nodes : Use multiple colors for nodes taken from attributes or 
measures. 

 

 

Meta-Network Designer : Allows you to create, or add icon nodes, 
to a Meta-Network display. Select a Nodeset then Drag and drop 
icons onto the display. 

 

 

Networks Over Time : Allows you to view a version of your network 
across multiple time periods.  

 

Vector Maps :  
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Attribute Measure Viewer 

The Attribute/Measure Viewer allows you to view multiple variations 
instantly of grouping nodes by attribute or running various measures on 
nodes to create Meta-Nodes.  

 

We start with a Meta-Network containing agents, knowledge, or whatever 
yours contains. 
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Under Select an attribute: I chose gender which is one of the agent 
attributes. This created four Meta-Nodes for male, female, robot, and 
lacks an Attribute value. Yes, this is a science fiction dataset. 

 

Next under Select a measures: I chose Total-degree centrality. This 
gave each node it's centrality value in the display regardless of Nodeset. At 
thie point we're unable to distinguish which node is which. For this 
information double-click on a node to bring up the Node status dialog box. 
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This will display the information about the selected node. Under components 
it will display the Nodeset and the name of the node. 

 

 

 

Backward Influence 

Interface 
Select a number of Levels:  

Allow Self Links: Shows any link links from a node back to iteself. 

Allow Cycles: Shows cycles that appear in the influence flow 

Allow Readjustments for Direct Paths: Options that appear in 
consecutive levels will be streamlined by placing nodes that occur on two 
consecutive levels on the further back one and sliding nodes around based 
on that. 
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Example 
The network we use is a simple four-node network with limited links. Note 
that node C has no out links though others nodes have links TO that node. 

 

For this example we select all four nodes as well as the Allow Self Links 
and Allow Cycles. If you have multiple Nodesets in your Meta-Network you 
can choose nodes from all of them. 

 

Visualization Example of a Network. 
Here is the example network visualized. 
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Select (a), Cycles, No Direct Path Adjustment (NDPA) 

 

Select (a), No Cycles, No Direct Path Adjustment (NDPA) 
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Select (c), Cycles, No Direct Path Adjustment (NDPA) 

 

Select (c), Cycles, 3 Degrees 
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With Direct Path Adjustment, (a) on Degree 1 and (a) on Degree 2 merge(c) 
On Degree 2 and (c) on Degree 3 merge  

 

 

Drill Down Wizard 

With the ORA Drill-Down Wizard you can quickly visualize ego networks by 
overall Nodeset (knowledge, tasks, resources, agents) or by choosing 
individual nodes from a checklist. The ORA Drill-Down Wizard is only 
accessible through the Visualizer: 

From the ORA Visualizer Main Menu select Tools > Drill Down. 

The following window box will appear. 
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The top sections allows you to chose the nodes for use. The bottom tabs 
allow for choosing specific nodes within a set. 

Drill Down Wizard Example 
Using the Embassy Meta-Network, we will render the various Nodesets using 
the Drill-Down Wizard Tool. The screen shot below displays the Embassy 
Meta-Network as it should first appear in the Visualizer. 
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From the Main Menu select Tools > Drill Down. 

This will bring up the Drill Down dialog box as shown below). 
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Here, select the Nodeset Knowledge by selecting the Knowledge check 
mark box. The screen shot below, displays the end result that you should 
now see in the Visualizer. 
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Next, with the Knowledge box checked, add the Nodeset Task. The screen 
shot below displays the end result. 



560 
 

 

Next use the search bar feature of the Drill-Down Wizard to narrow the 
search. 

Enter the word Bombing in the Visualizer search field below. Then select the 
check box on the bombing row. The screen should now reflect your new 
search parameters. Everything not associated with bombing has been 
turned off. 
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Drill Down Wizard Explained 
The ORA Drill Down Wizard can be broken down into three primary sections 
of input: 

1. Section 1: enables you choose individual Nodesets or combination of 
Nodesets to display in the Visualizer. 

2. Section 2: of the Drill Down Wizard enables you to search for a 
particular node within your Meta-Network. This can be handy when 
you dealing with large Nodesets and the one you are interested in 
finding is not easily located. 

3. Section 3: enables you check mark an individual node within your 
Meta-Network by Nodeset if so desired. 
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Legend 

The Legend dialog box allows you to quickly hide and reveal nodes and links 
in the visualizer.  

Use the check boxes to change a Nodesets visibility. When you first call up 
the Visualizer all the boxes will contain checkboxes... 

 

...and in the Visualizer all nodes and links are revealed. A little hard to make 
heads or tails of something like that. 
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By using the Legend check boxes you can selectively show/hide nodes 
and links. Deselect the checkbox to the left of Agent. Instantly all of the 
Agent nodes are hidden along with any connections they had with the rest of 
the nodes. The node structure is a little easier to see now. 
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Next think about a particular set of connexions you'd like to see, say a task 
x task network and how the agents relate to the tasks. 

 

From the Legend box menu select Control > Hide All nodes Then again 
from the menu Control > Refresh Legend. Now place check marks in the 
check boxes for agent, task, and task x task. All the tasks will be linked 
together as per your network and all the agents will have connexions to the 
tasks they are associated with. 
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Another example is how knowledge relates to specific tasks. From the 
Legend menu select Control > Hide All Nodes. Now place check marks 
next to knowledge, task, and the Knowledge x task network. 
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Now the Visualizer reveals which knowledge is required for which specific 
tasks. 

 

The legend also reflects the size, shape, and color of the nodes in the 
Visualizer. 
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Legend Edit Menu 

Below is an image of the Legend Edit Menu and a description of this tool: 

 

Copy Legend Image to Clipboard : Copies an image of the entire legend 
that can be pasted into an image-editing program. 

Save Color Scheme 
Here is a network of agents, knowledge, and tasks. 

 

Open a visualization. Select Node Appearance > Attribute/Measure 
based Options. In this example I set it to Color node(s) and color those 
nodes using the Centrality, Total Degee. You'll notice at the bottom of the 
dialog box there is a panel with the range for the measure. This can be 
copied and pasted into a document you're working on. 
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The nodes have now been colored according to the measure. 

 

From the dialog Box menu, select File > Copy Legend to Clipboard. This 
places a copy of the legend onto the clipboard which you can paste into your 
paint program of choice. 
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Furthermore, you can adjust any of the colors by clicking on the color well. 
This brings up the color picker where you can change the color of the range. 

 

 

Legend Control Menu 

Below is an image of the Legend Control window: 

 

Show All Nodes : Will bring into view all entities in the Meta-Network. Good 
to use if you need to make a fresh start. 

Hide All Nodes: Hides every node. Good starting point when you only wish 
to display a small subset of nodes. 



571 
 

Refresh Legend : After using the menu items above and/or using the check 
boxes this item will bring the visualizer up to date. 

 

 

Node Color 

The color of a Nodeset can be changed in the Visualizer. In the Legend 
window click on the colored node of a Nodeset. This will bring up a color 
selector box. Select a new color and click [OK]. All the nodes of that 
Nodeset will change colors. 

NOTE : This color change is in effect for as long as the Visualizer is open. If 
you close and re-open the Visualizer the colors will revert to their default 
colors. 

Here is a section with the default colors of red for agents and cyan for 
tasks. 

 

Open the Legend window (if it's not open already) and click once on the 
Nodeset you want to change. This will bring up the Color Change dialog 
window. 
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Select [OK] and the new color will be displayed for the chosen Nodeset. 

 

The newly selected color appears in both the Visualizer and Legend windows. 
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Legend Contextual Menu 

With the Legend displayed clicking on either a Nodeset or a network will 
bring up the color picker which allows you to change the color of the node or 
link. But right-clicking on either of these will bring up other options. 

Node Formatter 
There are two ways to select nodes. 1] You can Control-Click on each node 
separately in the Visualizer. 2] You can use the Selector tool and lasso a 
group of nodes. When you have the nodes selected righ-click to bring up the 
Node Formatter dialog box. 

Appearance Tab : Controls the color, transparency, and labels of the 
Node(s) selected. 

Node Color : Control the color of individual nodes. 

Match Nodeset Color : Resets the color of the node(s) back to the default 
color of the Nodeset. 

Choose a Custom Color : Click the color box. From the color the selector 
palette select a new color and click [ OK ]. In the Node Formatter box click [ 
Apply ]. 

Node Transparency : Set the Node Transparency from 0 [transparent] to 1 
[visible]. 

Node Size : Set the Node Size from 4 [small] to 25 [large] 

Visibility Tab : Controls visibility of nodes. 

Hide Node(s) button Removes nodes from the display. 

Show Node(s) button puts the nodes back into the display. To bring back 
Nodes of a Nodeset which have been hidden you can toggle the check box in 
the Legend off and on and all nodes of a Nodeset will reappear. 

Label Tab : Set the label size from 1 [small] to 25 [large]. You can also 
show or hide the labels of the selected Nodeset. 

Label Size : Change the size of the label from 1 [small] to 25 [large]. 
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Hide Node Label(s) button Removes label from the display. 

Show Node Label(s) button Puts the label back into the display. 

NOTE : The Node Formatter works only with the node(s) originally selected. 
To change the parameters for another node(s) you must close the Node 
Formatter dialog box, select another node(s), then perform your changes. 

Link Formatter 
Right-Clicking on a Link in the Visualizer brings up the Link Formatter.  

Appearance Tab : You can color the selected links by Source node, Target 
node, or pick a custom color. You also have the option of using solid or 
dashed lines. 

Node Color : Control the color of individual nodes. 

Color by Source Node : Sets the color of the link(s) to the color of the 
Source Node. 

Color by Target Node : Sets the color of the link(s) to the color of the 
Target Node. 

Choose a Custom Color : Click the color box. From the color the selector 
palette select a new color and click [ OK ]. In the Link Formatter box click [ 
Apply ]. 

Visibility Tab :  

Hide Link(s) button Removes link from the display. 

Show Link(s) button Puts the Link back into the display. 

NOTE : If after you hide a link and close the Link Formatter dialog box the 
only way to bring that link back a link you have hidden is to use the menu 
item Actions > Show All Nodes. But remember, this will also undo any 
other hidden nodes and links you have. 
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Link Selector 

In a complex network you may find it difficult to locate one particular link. 
This is where the Link Selector will help.You can chose to work with One 
Node or Two Nodes, picking which is the Source/Target node, and the 
appearance of the link in the Visualizer. 

 

 

1. One or Two Nodes : Chose to specify links using methods for One 
Node (shows all nodes linked to node picked) or Two Nodes (where 
you specify the exact two links to use) or  
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2. Node Area : In One Node you pick the node and ORA shows you all 
the links. In Two Nodes you pick two nodes the chose one of three 
direction options : From First to Second, From Second to First, Goes 
Either Direction. This last one is handy in order to change the 
apprearance of bi-directional links. 

3. Link Area : Displays all links that meet the parameters in the Node 
Area. Beneath this are the [Select All] and [De-Select All] buttons. 

4. Appearance/Visibility : This allows you to control the look of the 
links. Appearance allows you to change link color and make then 
dotted or continuous lines. Visibility allows you to Hide or Show 
links. 

5. Link Color : The drop down menu has three options : Color by Source 
node, Color by Target Node, or Choose a Custom Color. 

6. Dotted/Continuous Lines : Allows you to choose the style of line. 

The Original Network 

 

NOTE : For these examples I changed the color of the location nodes to light 
blue for better visibility during changes. See Node Color for procedure 
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Link Selector-One Node 

In [Area 1] Select the [One Node] tab. In [Area 2] select a node from the 
drop down menu. To the right select from the other drop down menu 
whether you want this to be a source or a target node. All links associated 
with this node will be displayed in [Area 3]. Click on links you want 
highlighted. Click the [Appearance] tab in [Area 4]. Select [Choose a 
Custon Color] from the drop down menu in [Area 5]. In the Color Select 
dialog box select a complementary color and click [OK] then click [Apply]. 

Example : I select the node Greedo and place checkmark in both boxes. 
Under the tab Appearance I select [Choose a Custom Color] from the 
drop down menu. A distinctive dark blue color is selected then I click 
[Apply]. 
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You can further enhance this information by 
use of the [Make Link(s) Dotted-Lines] 
button. 
 
Notice that in this example the link Greebo 
to Mos Eisley is a clearly defined dotted-
line. The link Greebo to Han Solo is a blue 
dotted line but the link Han Solo to Greebo 
is still the default red and could obscure it in 
a more densely packed network. 
 
Caution should be observed when working 
with a large network. 

When finished you can, from the main menu, select Display > Link 
Appearance > Link Color and chose either Match Source Node or Match 
Target Node to reset your colors. Another choice is to select the particular 
links and change the colors via the method described above. You can also 
change any dotted-lines back using the [Make Link(s) Continuous LInes] 
button. 

17 APR 11 

 

 

Link Selector-Two Nodes 

Two Nodes 

 

In [Area 1] Select the [Two Nodes] tab. In [Area 2] select a node from 
both of the drop down menus. Between these menus is another drop down 



579 
 

menu about whether you want this to be a From First to Second, From 
Second to First, or a Goes Either Direction. Choosing either of the first 
two will result in a single link. Choosing Goes Either Direction will give you 
one link (if the link is bi-directional) or two links (if the link is bi-directional). 
The links will be displayed in [Area 3]. Click on links you want highlighted. 
Click the [Appearance] tab in [Area 4]. Select [Choose a Custon Color] 
from the drop down menu in [Area 5]. In the Color Select dialog box select a 
complementary color and click [OK] then click [Apply]. 

 

 

Two nodes have been selected, Darth Vader 
and Luke Skywalker, with the option [Goes 
Either Direction. A check mark is placed next 
to both links. At present both links are their 
default color, red. 



580 
 

 

 

Under the appearance tab select from the drop 
doen menu [Choose a Custom Color]. Click 
the color block to the right and select a 
complementary color. For example, Fuchsia. 
CLick the [Apply] button and the links then 
take on that color. 
 
You can see how well they stand out now. 
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Notice here that a check mark is placed only 
next to Luke Skywalker. When the [Make 
Link(s) Dotted Lines] is clicked the dotted 
line is obscured by the continuous line from 
Darth Vader to Luke Skywalker. 

 

 

Making them both Dotted Lines helps clarify 
the connection. 

NOTE : You can also revert these changes by using the drop down menu to 
select Color by Source Node or Color by Target Node which will remove 
any custom color. Clicking [Make Link(s) Continuous Lines] will revert 
any selected links back to one solid link. 

17 APR 11 
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Micro Simulation 

Micro Simulation allows you to run some basic simulations on the curretly 
loaded visualization. LInk weights are important as once they are 
normalized, they correspond to the probablity of a transmission. 

ORA Micro-Simultation Overview 

  I can give it 
to others 

I keep it after 
sharing 

I lose it after 
some time 

I can get 
it back 

Ideas Yes Yes No N/A 

Disease Yes Yes Yes No 

Money Yes No No Yes 

Technology Yes Yes Sometimes Yes 

General Thoughts on MicroSims 
The simulations themselves are not that complex. Typically Disease, Money, 
and Information can be described as types of flows. At any given 
timepoint, any entity that has one of those things are going to try to give it 
to another node, with each flow having their own rules. 

Ideas : Once an entity gets information, they cannot lose it. They also never 
stop giving out the information. 

Disease : An entity can not re-get the disease, and an entity can only give 
out the disease while it has the disease. The entity can also give out a 
disease to multiple other entities. After a user-specified number of time 
periods, the entity loses the disease. 

Money : Once an entity gives away the money, he cannot give the money to 
anyone else. There is no limit on re-getting the money. 

Technology Adoption : How quickly a new technology might spread 
through a network. 

It's important to understand how these transmissions occur. During the 
transmission phase, it looks at every node that has a resource. Then it 
iterates through all outgoing links trying to give that resource through that 
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link ( in the case of money, since it can only go through one link, we 
randomize the order links are tested ). When looking at a link, it first does a 
check to see if the transmission can occur based on the link weight. Then it 
does another CHECK to see if the transmission can beat the transmission 
resistance. 

These transmissions continue based on the rules outlined above for the user 
specified number of time periods. Then it generate a dynamic meta-network 
that shows for any given time period what entity was associated with a 
resource. 

Diffusion of Ideas 
NOTE : Negative weight links are ignored. 

 

In the drop down box you are prompted 
to selected a Square Network for the 
simulation. If the Nodeset you select is 
in multiple square networks, then all 
will be displayed below. Place a check 
mark next to the network to use. 
 
This will create a new meta-network 
consisting of a single Nodeset with the 
same nodes as the input Nodeset, and a 
single network with the same links 
present in the selected networks. In the 
event multiple networks are selected 
and multiple links from node A -> node 
B are present, the resulting link from A 
-> B has a weight equal to the sum of 
all A -> B links. 
 
Click [Next] 

NOTE : Once a new meta network is created, it takes all the links and 
normalizes them between zero and one. The link weight then corresponds to 
the probability that a transmission will occur down that link. This obviously 
means that both Link Direction and Link Weight play a pretty important role 
here. 
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In the Node Selector box you 
chose a node(s) where an idea 
begins. I typed romana into the 
search box which displayed two 
choices. I placed a check mark to 
chose the romana_I node. When 
you've made your select, click 
[Next] 

Two main controls 
Transmission Resistance : ranges from 0.0 to 1.0. The higher the 
resisitance the less likely a node will accept what is offered. Setting this to 
[0] allows for perfect transmission and the target node will accept 
whatever is offered. 

Increase nodes size as it is hit : helps in seeing which nodes have 
been activated. Nodes get progressively bigger with each hit. 
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We'll leave the Simulation to 
Diffusion of Ideas. Say we don't 
want ideas to spread 
automatically but want the nodes 
to have a little resistance. So the 
Transmission Resistance it 
increased to 0.3. I also placed a 
check mark in the Increase node 
size as it is hit box so it will 
show the amount of hits a node 
gets. 
 
When you are finished, click 
[Next]. 

Below is an animated example 
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Micro Simulation-Ideas 

Ideas 
• An agent can give away information it has access to. 

• An agent retains information even after giving it away. 

• An agent never looses information it gains. 

• An agent never stops giving away information. 
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Micro Simulation-Disease 

Diffusion of Disease 
This function has two additional parameters: 

Number of periods nodes remain contagious : After a node gets 
infected it will stay infected for a set number of periods before it then 
becomes immune. After that it can no longer spread the disease. 

Percent nodes immune at start : You can set a percentage of nodes to 
be immune from the start. These nodes will be colored yellow. 

Information for disease simulation. 
• An agent can not re-get the disease. 

• An agent can only give the disease while it is infectious. 

• An agent can give the disease to multiple other entities 

• An agent loses the disease after a user-specified number of time 
periods. 

 

 

Micro Simulation-Money 

Dispersion of Money 
This mode asks for the amount of money units to start with then makes 
them travel around the network. The amount of money stays constant. 

• An agent can give away money it posses (all or nothing). 

• Once given, an agent cannot give away the same money. 

• An agent can re-acquire money previously given away. 

• There is no limit to the amount of money an agent can receive/hold. 

• Agents pick randomly the order of neighbor(s) to give away money to 
in effort to reduce endless loops. 
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Micro Simulation-Technology 

Adoption of Technology 
The Transmission Resistance determines how easily technology is adopted 
by the network. This is a unique simulation. A node is more likely to adopt a 
piece of tech if it has many neighbors trying to convince it to adopt the tech. 
A node is more likely to un-adopt a piece of tech if the user has fewer 
neighbors also using the tech. 

• An agent may adopt technology if enough of its neighbors use the 
technology. 

• An isolated agent will flip a coin to adopt a technology. 

• An agent can stop using a technology, especially if its neighbors are 
not using the technology. 

• An agent can re-start using a technology. 

• An agent has a user-adjustable level of resistance to using new 
technology. 
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View Networks Over Time 

The Networks Over Time loads multiple Meta-Networks into the Visualizer 
and displays them as Time Slices. 

NOTE : Data that is not dated will be loaded in the order it was selected, not 
the order it is in the tree and not the order it was loaded in. This only 
happens when the data has no dates associated with it. 

Procedure  

Highlight the Meta-Networks to load into the Visualizer. For this example I 
divided the whole Stargate Summit network into four distinct phases. 1) The 
meetings; 2) What was supposed to happen; 3) What did happen; 4) The 
attack on the Tok'ra homeworld. These are Summit 1-4. 

 

Start the Visualizer. Then select Tools > Networks Over Time 

The dialog box appears to verify you've chosen the correct Meta-Networks. 
Place a checkbox in the ones you want or Check All. Then select [View]. 
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To control the Over Time function from the main menu, select Tools > 
Networks Over Time. 

 

The Phase Duration has two controls. Transition Phase duration sets 
the amount of time in milliseconds for the fading out of the previous set and 
the fading in of the new set. The Display Phase duration sets the amount 
of time in milliseconds that a set will be displayed before moving to the next 
set. 

Constant maintains a node's position throughout all Timeslices. 
Determined by Timeslice allows you to move a node independently in 
each Timeslice. 

Record Node Locations upon Exiting a Meta-Network maintains a 
node's position when changing Timeslices. NOTE: It does not maintain the 
node's positions after you exit the Visualizer. Upon returning to the 
Visualizer all nodes will be in default positions. 

The Slider bar controls which Timeslice is displayed. The buttons at the 
bottom, [Play] and [Stop] control the motion display. 

Summit-1 
The initial meetings between the SGC and the Tok'ra 
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Note: You can select multiple nodes by simply clicking on them. You do not 
need to depress any other keys (i.e., ctrl+shift, etc.).  

Summit-2 
The plan as it was supposed to go 
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Summit-3 
What really happened when Osiris showed up unexpectedly. Instead of 
poisoning the Summit daniel_jackson decides to forgo that action after 
hearing the information from Osiris. He's almost found out but still escapes. 

 

Summit-3 
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What was happening back on Revanna while daniel_jackson was at the 
Summit. 

 

NOTE : Measures and reports run on these multi-Meta-Neworks are for all 
connexions, not the individual Meta-Networks. 

Time Clustering 
Time clustering is available via the Over Time dialog in the visualizer. It's a 
fairly simple panel - there's a ComboBox to select which period you want to 
cluster by (by Day, by Week, by Month, by Year), and two radio buttons to 
select what a week begins with (only used when clustering by week). Finally, 
there's a simple button to cluster. 
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Clusters are fairly straightforward. It looks at the start date (earliest date 
available in a set of timeslices) and the end, and grabs snapshots at the 
given interval, looking at the beginning of that interval. So, if you cluster by 
month, it'll move through each month, grabbing a snapshot of the 1st day. If 
no Timeslices exist for that day, it just uses the Timeslice with a date closest 
to that day without going over. 
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Node Locator 

 

The Node Locator is a tool palette 
that allows you quickly zero in and 
find a node that may be obscured 
in a complex visualization. 
Essentially, when you click on a 
node in the Node Locator tool, the 
Visualizer will then pan over to the 
node centering on it. Below are 
procedures for using the node 
locater. 
 
From the ORA Visualizer: Tools > 
Node Locator. This brings up the 
Node Locator dialog box. It 
contains to folders in it's root, 
Alphabetical Order and 
Categorical Order.</td 

Alphabetical Order : Contains one folder for each set of nodes divided 
into letter groups. All nodes beginning with the same letter will contained 
in one folder. 
 
Categorical Order : Divides the nodes into Node Categories. There were 
four Nodesets in this example and it created four folders under Categorical 
Order. 
 
Notice how the nodes for Accounts_Payable and also for 
Accounts_Receivable appear in both areas. 
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Selecting a Node 

Whenever you select a node in the Node Locator dialog box that node will be 
highlighted. Since it's hard to see with a white background this example uses 
the black background. Notice the white circle around the accounts_payable 
node denoting it has been selected. If you select a new node the previously 
selected node will return to normal and the new node will be highlighted. 

 

 

 

Node Selector in Visualizer Tool 

Note : A slightly different version of this tool is available in the ORA Main 
Menu interface (i.e., non-Visualizer tool). 

You can use the Node Selector to simply complex visualizations. The Node 
Selector tool is accessible from the Visualizer menu: Tools > Node 
Selecter. 
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Node Selector 
Search : Displays only nodes which have matching content. To the right is 
the AND/OR dropdown box where you can select whether to make ORA 
search for entries with all terms in the box or terms in the box. 

Node Class tabs : Contains a tab for each Node Class in a Meta-Network. 

Node Display Area Displays all the nodes for the currently active tab. The 
checkbox to the left allows you to select/deselect nodes to work with. 

Select Visible/Un-Select Visible buttons : This works on all nodes 
currently displayed in the Node Display area. If places a checkmark [selects] 
or removes a checkmark [deselects] on al items visible. 
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Visibility 
Show Only Checked Items : Shows only nodes which have a checkmark 
next to their names. 

Show All But Checked Items : Shows only nodes without a checkmark 
next to their names. 

Add Checked Items : Adds to the visualizer display (if they are not already 
visible) any nodes which have a checkmark to the left of their names. 

Remove Checked Items : Hides in the visualizer display (if they are not 
already hiddne) any nodes which have a checkmark next to their names. 

Node Location 
Move to the Left : All selected nodes will be moved to a column to the left 
side of the screen. 

Move to the Right : All selected nodes will be moved to a column to the 
right side of the screen. 

Node Appearance 
Show Label(s) : Works in co-ordination with the [Set Labels] button and 
all selected nodes. Will make the lables visible [checkmarked] or hidden [no 
checkmark]. 

Set Labels button : Clicking this button activates your choices with the 
Show Label(s) option. 

Node Color : Brings up a color palette to chose a color. 

Change Color button : The color of any node(s) selected will be changed to 
the new Node Color. 

Other 
Create Meta-Node : Creates a Meta-Node from all selected nodes. 

Highlight Checked Items : Draws an outline around all nodes selected. 
This functions with nodes of all sizes. 
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Node Selector Examples 
Following is a short example of the KeySet Selector. It covers the main 
aspects of the tool only. 

In the Filter Commands textbox the word poison is typed which causes all 
nodes with poison in any attribute to be revealed. Pressing the [Select All] 
button places a check mark in all the nodes. Lastly in the Visualizer 
Commands pressing the [Show Only Checked Items] button hides all 
but the checked items. 

 

The [Clear All] button is pressed to clear all the check marks. poison is 
replaced in the Filter Commands with the word sg-1. Be aware that even 
though only nodes with sg-1 are to be added the two nodes with sg-17 also 
appear as sg-1 is a sub-string of sg-17. SO instead of using the [Select All] 
button check marks are manually placed in the check boxes desired. 

The [Add Checked Items] button is pressed and the four new nodes are 
added to the visualizer. 
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With the four nodes of sg-1 still check marked press the [Highlight 
Checked Items]. The four nodes are now displayed in a larger format. 

 

The last button, [Create Meta-Node] will cull nodes into a Meta-Node. 

Move Left/Right 
If a set of nodes needs "pulled out" of the display the Move Left/Move 
Right buttons can help. Below is a normal display. The nodes for SG-1 are 
quite difficult to see. 



601 
 

 

From the Node Selector dialog select the nodes to be highlighted and place a 
check mark in the box. 

 

Press the [Move to the Right] button. This brings the selected items 
toward that side of the display. 
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Pressing the button again will move the selected nodes farther in that 
direction. 

 

 

 

Node Status 

The Node Status Window is used to reveal pertinent information about 
one selected node. The window can be brought up by either selecting it from 
the main menu, Tools > Node status or by double-clicking the node in the 
visualizer. The dialog box below will appear.  
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The top of the box will contain general information about the selected node. 
Underneath there are five tabs available which will display the node's 
information. You can switch nodes by selecting any other node in the 
visualizer. ORA will automatically change the display. 

The Node Title: box allows you to change the title of the selected node. 

Tabs 
Neighbors : displays the nodes which are linked to the selected node. It 
also displays the weight of each link. 

Sources :  

URIs : If there are any URIs attached to the node they are display under 
this tab. 

Attributes : Types and Values of all attributes are displayed under this tab. 
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Measures : If Measures were run on the Meta-Network their values are 
displayed under this tab. 

Attribute Button 
This dialog box allows you to add attributes to a node. Click the Add 
Attribute button. 

 

The drop down menu on the left contains all the current attributes for the 
node. You can select a pre-exising attribute, enter a value, the click the Add 
Attribute button. 

This also allows you to create New Attributes. Scroll down to the bottom of 
the drop down menu and select <Enter New Attribute ID:>, enter a 
Value, and click the Add Attribute button. Your new attribute will appear in 
the Meta-Network. 

Show This Window check box 
When a check mark is placed in this box it causes this dialog box to appear 
whenever you click a node in the Visualizer. 

 

 

Path Finder 

The Path Finder is used to find, not only, the shortest path between two 
nodes but also paths to other nodes when particular situations occur. Below 
is an image of the The Path Finder tool and a description of its various 
elements.  
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The interface contains four sections: 
Start node : Select the Nodeset/Node to begin the path. 

End node : Select the Nodeset/Node to end the path. 

Options : Options regarding link parameters and which Nodesets to use. 

Advanced Options : Options regarding whether, and how, to use one 
particular node within the Nodeset. 

Using only Agent nodes (tolerance = 0) 
Using only the Agent Nodeset the pathway requires three intervening nodes. 



606 
 

 

NOTE : For this example the values in the 
Network have been altered from the regular 
values. 

Tolerance of "1", nothing else checked. 
Shortest path: 1 

 

There is the direct link from gen_hammond to 
col_jack_o'neill and the secondary pathway 
with teal'c in the middle. 

Use link direction 
Shortest path: 2 

The path direction must lead from the source to the target. 
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The link from gen_hammond to col-jack-o'neill 
is removed as it's a directional link in the 
wrong direction. The shortest link is "2". 

Use link weight (Remove links with negative 
values) 
Shortest path: 6 

Use link weights finds the shortest path from A 
to B using minimal weights as opposed to 
minimal number of links. Also the shortest 
path is the total of the link weights — not the 
number of links total. 

 

The shortest path is from col_jack_o'neill to 
teal'c (5) then from teal'c to gen_hammond 
(1) for a total of "6". 

Use link weight (Convert negative links to 
positive values) 
Shortest path: 3 

Uses the absolute values of numbers. A negative number becomes a 
positive number. 
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Use link direction and link weight with 
absolute values 
Shortest path: 3 

 

 

Pie Nodes 

You can color nodes with individual colors based on Measures or Attributes. 
From the Visualizaer Main Menu select Tools > Pie Nodes. This brings up 
the Pie Nodes dialog. You can select up to four values to color your nodes 
each using either a measure or an attribute. The bottom section shows the 
values which correspond to the colors. 
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When you have your values selected and whether they will be attributes of 
measures, click the [ Run ] button. 

The nodes will change colors depicting the amount of values you chose. 
Notice that Value A is represented in the top right and continue in a 
clockwise direction. 
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These values can be altered and redrawn by clicking the [ Run ] button. 
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Sphere of Influence/Ego Network 

The Sphere of Influence tools helps show how nodes are interconnected 
by displaying links to other nodes. You can also control the size of the 
Sphere of Influence. 

It is important to understand that Sphere of Influence is similar to 
Reverse Influence but not identical. Sphere of Influence ignores 
directionality and looks at both in and out degress for each node. Sphere of 
Influence answers the question What other nodes are connected to the 
ego network. By using both in and out degrees it finds the sphere 
surrounding a node. Cycles are an endemic part of a Sphere of Influence and 
are not highlighted. 

Reverse Influence only looks at the in-degree and answers the question 
what nodes influence the ego node. As such, cycles can be critical, leading to 
never ending chains, as when A influence B, B influences C and C influences 
A. The Cycle and self-loop options enable the user to stop backward chaining 
when a loop or cycle is encountered. 

 

 

Sphere of Influence 

Each node within a network has a unique Sphere of Influence or Ego 
Network. Essentially it's a direct relationship with it's neighbors as a 
function of specified path length. The ORA Visualizer allows you to focus on 
this relationship by creating an Ego Map centered on any particular node 
you choose. This mapping ignores directionalty and counts equally both in 
and out degrees it finds to the sphere surrounding the node. Cycles afre an 
andemic part of a Sphere of Influence and are not highlighted. 

From the Visualizer's Main Menu select Tools > Sphere of Influence. 

The following dialog box will then appear. From here you can select the Size 
of your sphere's influence, the Nodesets, and Key Sets to use. 



612 
 

 

Select a sphere of influence radius 
The drop down box allows you to choose the path length for a particular 
node(s). The value starts out at 0. Below is an example of a radius of 0, 1, 
2, and 3. In many other cases the links will branch out as you increase the 
radius. 
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Auto-Zoom : Maximizes your ego network within the Visualizer. 

Auto-Center : Keeps the visualized Ego Network centered within the 
visualizer display. 

Hide connections between levels : Removes any connections between 
nodes that do not have a connection to any node in the filter. 

There is a simple step that often gets forgotten when using ORA's sphere of 
influence feature. When you are about to click run make sure you have 
checked the box which reads hide connections between levels. Failing to 
click this, ORA will give you all connections between all nodes in the 
network. For instance, if you want to look primarily at a single node, but you 
fail to click this box, ORA will show how all nodes are connected to all other 
nodes. In summary, just make sure that the hide connections between 
levels box IS checked unless you have a need for viewing those other 
connections. 

The top image has connections hidden. The bottom image has connections 
visible. 
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Node selection table : Allows the selection of individual nodes for 
visualization. Place a check mark next to the node(s) you want in the 
Visualizer. 
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Rings 

What are node rings in the visualizer? 
Rings help you keep track of which nodes have been selected in a Sphere of 
Influence. Right-Clicking on a node allows you to toggle the ring on and off. 

 

They're not much more than rings around a node but rather they are used to 
help accentuate node(s) amongst other nodes. Currently, the only use they 
have is for Sphere of Influence, where the node(s) whose Sphere of 
Influence we're looking at get a ring around them. 
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Visualizer Layout Menu 

 

Run Active Layout : Turns on the motion and allows ORA to 
attempt to sort out the positioning of the nodes. 

 

Stop Active Layout : Turns off the motion and stops all nodes from 
moving. This allows you to move individual nodes around without 
disturbing the rest of the Meta-Network. 

 

Spring Embedded Layout : This layout operates fine in datasets of 
approximately under 500 nodes. Much higher than that and the 
layout gets sluggish. A single layout iteration could take two minutes 
or longer. Not really practical. 

 

Spring Embedded (with enhancements for large data) : The 
enhanced layout with large datasets. It uses the same basic 
algorithm but has some optimizations built in. With 10k nodes or so, 
a single layout iteration takes 10 seconds or so. 
 
It treats large clusters of nodes as blocks to help in reducing 
computations. In decreases the time for the final computations but 
the display loses flexibility in the process. 

NOTE : Now you're probably asking "if this new algorithm is so 
good, why not keep it on all the time?" Reason: If you pick up and 
drag a node, and as such drag an entire meta-network, the display will 
look jittery and confusing. So, whenever you load in under 500-nodes, 
the normal version is enabled. More than that, it uses the enhanced 
version. 

 

Run MDS Layout : The purpose of Multidimensional Scaling [ MDS ] 
is to provide a visual representation of the pattern of proximities 
(i.e., similarities or distances) among a set of objects. Given a matrix 
of perceived similarities between objects, MDS plots these on a map 
such that those nodes that are perceived to be very similar to each 
other are placed near each other on the map, and those nodes that 
are perceived to be very different from each other are placed far 
away from each other on the map. 

 

Run Tree Layout : This is a hierarchical stylewhich attempts to find 
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the root node (a node with an in-degree of 0). It then builds the 
network down from there. 

 

Run Circle Layout (Pendants to Outside): Takes all pendants and 
puts them in a circle. All Nodes connected to a pendant are on a 
circle inside the pendant circle. Repeat until all nodes are in some 
circle, with the inner most nodes being the farthest from any 
pendant. 

 

Run Circle Layout (Center is High Betweenness) : Calculate the 
Centrality-Betweenness for the graph. Take the node(s) with the 
highest value. Place them in the center. All nodes connected to those 
nodes get put on a circle surrounding the center. Repeat as 
necessary. 

 

Run Circular Layout for Groups : NOTE : You must set Meta-
Nodes > Meta-Node Appearance > Show Component Node 
Membership for this to display properly. 

 

Run Hierarchical Layout : Tries to layout the network in a pyramid 
formation so that all arrows either point up or point down. 

 

Run Box Layout : More of a Polygon Layout, really. You select 1-4 
groups of nodes (either by Nodeset or by Node Class). Each group is 
then laid out as one edge of a polygon. 1 Group = circle, 2 Groups = 
2 parallel lines. 3 Groups = Triangle, 4 Groups = square 

 

Attribute/Measure Layout : Uses the input attribute and/or 
measure as the x,y coordinates of the nodes. 

 
 
 
 
 
 
 
 
 

 

Hierarchical Layout 
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 Run Hierarchical Layout : 
The Hierarchical layout option 
allows for two different layout 
styles. 
 
The Pyramid style looks at level 
0 as being the peak of the 
pyramid. Level 1 being the one 
beneath that, and so on. A 
level's width is equal to the level 
number (with the distance 
between levels being a 
constant). This gives it the 
appearance of a pyramid. This is 
the one that's been implemented 
for ages now. 
 
Variable style Variable Style is 
similar in that the distance 
between levels is still constant, 
but the width of a level is now 
variable. Instead of being based 
on the level number its based on 
the number of nodes in that 
level. If you look at top-heavy 
networks, you'll learn the appeal 
of this layout. 

You will be prompted for a square network (including the Visible meta-
network, since technically it's square), and then for a node to use as the 
peak node. 
 
Finally, you must choose the desired build direction. This refers to Link 
direction, since a link could mean reports to just as easily as it could 
mean commands. 

NOTE : This layout typically works well with non-circular networks. i.e. 
networks were links have links going only one direction. Using circular 
layouts can create problematic displays. 
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Regular Layout : showing links between resources and the office staff. 

 

Automatic 
The Automatic buttons will take the most direct path in creating a 
hierarchy. Whichever node has no links out will most likely become the top 
node. You can chose [Auto Layout (Top to Bottom)] or [Auto Layout 
(Bottom to Top)]. 

Arrows always try to maintain their direction meaning, in the event of cycles, 
for example, we try to minimize the number of arrows that go "against the 
current", so to speak. It will also warn you should you try to input a 
symmetrical network, as those don't really have bosses or subordinates. 

Hierarchical Layout (Top to Bottom) : which places both staff and 
resources in a top to bottom pyramid. This view makes it much easier to 
detect which resources are used by which staff member. 
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Automatic - Ignore Link Direction 
Automatic - Ignore Link Direction Layout : Allows you to chose the node 
you want at the top. Notice in the image the direction of the arrows are not 
in the same direction. 
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Automatic - by Attribute 
This layout is based on the attributes of the ndoes. It requires all relevant 
nodes to have some number-based attribute. The lower the value of the 
attribute, the higher in the hierarchy it will be. Think of 0 as being the 
top...level 1 is one below, and so on. 

 

 

Box Layout 
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 Run Box Layout : This 
layout allows you to chose 
from one to four Node 
SubSets and will arrange 
they depending on how 
many are choosen. The 
default is to use individual 
Nodesets. i.e. This would 
allow you to choose different 
agent Nodesets for different 
sides of the shape. 

  

Use Node Types 

  

Using this option allows you 
to choose all Node Sets 
which are the same Node 
Class, e.g., all Nodesets of 
the Node Class agent, at the 
same time. It selects all of 
them for a single side of the 
shape. 

Regular Layout 

Here's a Meta-Network as originally display in ORA. 
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Box Layout (Two Nodesets) 

Running the Box Layout lines up the Node Classes opposite each other with 
their links displayed between them. 

 

Box Layout (Three Nodesets) 
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Adding a third Node Class would form a triangle with each Node Class on one 
of the three sides. 
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Circle Layout (Pendant to Outside) 

 Run Circle Layout (Pendants to Outside) :  

Regular Layout 

 

Circle Layout (Pendants to the Outside) 
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Here we see the spreadsheet and the desktop computer are at the center of 
the circle as they have multiple connections. You can also see the pendants 
(executive washroom, laptop, catered lunch, corner office, leather chair, and 
blackberry comprise the outer circle. Lesser connected nodes drift to the 
outer circle. 

 

 

Circle Layout (Center is High 
Betweenness) 

 Run Circle Layout (Center is High Betweenness) :  

Regular Layout 
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Circle Layout (Center is High Betweenness) 
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This example shows how the Office Manager is the most connected node 
being responsible for two nodes under him and reporting to the CEO.  

 

 

Circular Layouts For Groups 

Used to display Meta-Network done in various Grouping styles. 

NOTE : You must have Meta-Nodes > Meta-Nodes Appearance > Show 
Component Nodes by Membership for this to display correctly. 

Newman : Used to find clusters in a network. 

Girvan-Newman : This is a hierarchical clustering method where all nodes 
start off in the same group and are split off into new groups based on 
maximum betweenness scores. 

MST :  

Cliques : The number of distinct cliques to which each node belongs. 
Individuals or organizations who are high in number of cliques are those that 
belong to a large number of distinct cliques. A clique is defined as a group of 
three or more actors that have many connections to each other and 
relatively fewer connections to those in other groups. The scientific name of 
this measure is clique count and it is calculated on the agent by agent 
matrices.  

CONCOR : oncor recursively splits partitions and the user selects n splits. (n 
splits -> 2n groups). At each split it divides the nodes based on maximum 
correlation in outgoing connections. Helps find groups with similar roles in 
networks, even if dispersed. 

Johnson : This is a Hierachical Clustering based on Similarity Standard 
hierarchical approach that builds groups based on similarity scores. 

K-Means : This clustering aims to partition n observations into k sets (k ? n) 
S = {S1, S2, ., Sk} so as to minimize the within-cluster sum of squares. 

K-Fog : Works with either one-mode or two-mode networks to form nodes 
into groups (clusters or communities) and show which nodes share the 
secondary functions.  
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Procedure 

 

From the main menu select Meta-Nodes > Create Meta-Nodes by Node 
Class. All nodes of one Node Class are now represented by one Meta-Node. 
But you have no information about the individual nodes within each Meta-
Node. 

 

From the main menu select Meta-Nodes > Meta-Node Appearance > 
Show Component Node Membership. This will display the individual 
nodes for each Meta-Node. 



630 
 

 

 

 

Attribute Layout Measure 

Once you create a specific visualization there are ways to save the 
information so that you can use it in the future. From the Visualizer menu 
select Layouts > Attribute/Measure Layout. 
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Placement of Nodes 
When you have the nodes of your Network you can save your coordinates 
for a future session. The layout will mirror the positions you were using at 
the time of the saving. 

Set the X-Attribute to X-Axis and the Y-Attribute to Y-Axis and click [ Save 
Coordinates ]. The next time you need to work with this layout set the X 
and Y Attributes back to the Axis attributes and click the [ Run Layout ] 
button. 

Node Color 
After coloring NodeClasses, and even individual nodes, you can save these 
colors as an attribute. From the Visualizer menu select Node Appearance 
> Node Color > Save/Load Node Color to/from Attributes, which 
allows for saving and loading node colors. 

NOTE : In less new versions, the same functions are stored under Node 
Appearance > Node Color > Save Node Color to Attributes and Node 
Appearance > Node Color > Load Node Color from Attributes. 
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Full Image 
NOTE : Early Prototype Version 

There is an early prototype for visualization saving called the ORA - PNG. 
This encodes node visibility/color/layout inside the image that gets saved. 

Save a visualization using File > Save Image to File... and select the 
ORA-NetScenes-PNG format format. Close your visualization and Meta-
Network. Reopen your Meta-Network then visualize it as normal. 
Drag/Drop the ora-png into the visualizer, and it should load in. 
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Meta-Nodes 

Meta-Nodes 
A Meta-Node contains multiple nodes collapsed into one. You can create 
Meta-Nodes based on the Nodesets in your organization, or you can create 
Meta-Nodes based on the attributes of the nodes. From the main menu 
select Meta-Nodes. This brings up the Meta-Node dialog box. 

Menu 
Meta-Node Appearance  

  NOTE : To view these options you must create Meta-Nodes first. 

Hide Component Nodes : Resets these to their defaults 

Show Component Node Membership :  

Show Component Node with Bounding Box :  

Show Component Node with Bounding Polygon :  

Compute Meta-Link Weight By...... :  

Proportion of the maxmum possible links : Takes the total 
number of links in the Meta-Nodes and divides this by the totasl 
possible number of links. 

Absolute count of links : Counts any link from any node in the 
Meta-Nodes to any other node as 1.0. Uses this as the total 

Block model links and weights : Uses two terms. A) The 
Proportion of the maximum possible links (as calculated above); and 
B) The total number of links in a Meta-Network divided by the total 
number of possible links in a Meta-Network. If (A) is higher than (B) 
then the value used equals (A). If (A) is lower then the value is 0. 

 

Pin All Meta-Nodes : Immobilizes all nodes in place. 
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Expand All Meta-Nodes : Restores all nodes to individual display. 

 

Color Nodes by Meta-Node Membership : Colors the Meta-Nodes 
to the Nodeset color set by the Meta-Network. 

 

Increase Link Rigidity Between a Meta-Node's Component 
Nodes : In a Meta-Node, there are nodes. If a link exists between a 
pair of nodes in the same meta-node, that link has its rigidity 
increased so that when meta-nodes are expanded/destroyed, the 
nodes in the same meta-node will band together via the layout. 

 

 

Create Meta-Nodes by NodeClass : Creates one Meta-Node per 
NodeClass. 

 

Create Meta-Nodes by Node Association : After selecting a 
Nodeset will create Meta-Nodes and their connections. 

 

Create Meta-Node by Grouping... : Allows you to choose from any 
of the installed grouping schemes. 

 

Create Meta-Node by Attribute/Measures : You can create Meta-
Nodes using either any Attribute or collected by measure value.  

 

 

Meta-Nodes... : Calls up the Meta-Node dialog box. 

 

 

Meta-Nodes Basics 

Display Meta-Node in Own Window 
Right-Click on a Meta-Node in the Visualizer and select Open Meta-Node 
Components in New Visualizer. This allows you to view the contents and 
connections of a Meta-Node on its own. 
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View Meta-Node Information 
This item displays in a box all the information for the selected Meta-Node 
including: 

Meta-Node Details : The Id, Label and Type 

Meta-Node Density :  

Component Nodes : The Ids, and Titles of all contained nodes 

Component Edges : The Source and Target of every Link. 
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Meta-Nodes Dialog 

Meta-Nodes Dialog 

 

The dialog box consists 
of four sections : 
 
Expand all meta-
nodes : Returns to the 
default display 
 
Select how to create 
links : see main page 
above for more details. 
 
Meta-Node Creation : 
Choose from creating by 
Node Class, Most Recent 
Grouping, Attribute, or 
Multiple Attributes. 
 
Select an attribute : 
Choose an attribute from 
any Node Class. Only 
those nodes connected 
to those attributes will 
be displayed. 
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Base Meta-Network Display 

 

First call up the Meta-Node dialog box from the main menu Meta-Nodes > 
Meta-Nodes which will display the dialog box shown above. 

Create By Attribute 
Make sure the section, Select an attribute: is visible. If not then click the 
[ By Attribute ] button. In the drop down select an attribute. The display 
will create Meta-Nodes corresponding to your choice. Below I chose my 
attribute gender. 

 

 

 



638 
 

Show Nodes By Meta-Nodes 
By itself this is of little use. To reveal the nodes which are contained in these 
Meta-Nodes use the function Meta-Nodes > Mets-Node Appearance > 
Show Component Node Membership. Now there are two Meta-Nodes 
with the pendants being the nodes associated via that attriutes. 

 

Reset 
I reset the display with Actions > Show All Nodes to display all nodes. 

Funnel Nodes Without Attribute 
Another important function on the Meta-Node Dialog is the check box, 
Funnel nodes without this attribute into a new Meta-Node. Instead of 
just hiding any node without information in the specified attribute these 
nodes will become part of Meta-Node labeled None. To funnel these nodes 
place a check mark in the box near the bottom of the dialog box. 

Here I change the attribute to robot and any node with Yes in that attribute 
belongs to the Yes Meta-Node. All others without a value in that attribute 
are grouped within the None Meta-Node. 
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But in this instance it's rather unweildly, and unnecessary, to show all the 
nodes as the only Node Class with this attribute is the Agent Node Class. 
Using the Legend you could deselect any Node Class. Here I deselect all 
except the Agent Node Class. 
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Multiple Attributes 
Click the [ By Multiple Attributes... ] button to call up the dialog box. 
From the drop down menu shoose an attribute i.e. gender. This gives the 
two regular attribute choices, male or female, and a third choice - Lacks an 
Attribute Value. This will collect any node which does not contain a value 
for that attribute. 
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Place a check mark in all the boxes you want to use. For this I marked all 
three. Then click the [ Create Branch ] button. 

 

The left hand box now display how the Meta-Nodes will be created. Click the 
[ Create Meta-Nodes ] button. 

NOTE : For easier viewing I made only the three Meta-Node names visible. 
Then I double-clicked on them and used the Node Status box to rename 
them. 
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This collects all nodes, no matter what their NodeClass, into the None Meta-
Node 

If you give each node one or more attributes then you can change the 
appearance of nodes based on the attributes. Illustative attributes are 
gender (female,male) or the type of organization (hierarchy, matrix, team 
...). 

 

Meta-Node - Create By 

Using the By Node Class button separate all nodes into Meta-Nodes based 
on their Node Class. 
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Start by visualizing a Meta-Network. 

 

Create Meta-Nodes by Node Class 

 

This creates one Meta-Node per Node Class in your Meta-Network. 
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Create Meta-Nodes by Node Association 

 

Choose a Nodeset for display. The Meta-Nodes consist of all nodes with a 
connection to any of the nodes in that Nodeset. These components can be 
found by double-clicking any Meta-Node to bring up the Node Status 
dialog. Click on the Component tab and the sub tabs will display which 
Node Classes contain any nodes within. 
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Create Meta-Nodes by Grouping 

 

Creates Meta-Nodes based on the grouping style choosen. The Meta-Nodes 
consist of all nodes with a connection to any of the nodes in that Nodeset. 
These components can be found by double-clicking any Meta-Node to bring 
up the Node Status dialog. Click on the Component tab and the sub tabs 
will display which Nodeset contain any nodes within. 
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Node Status Example 

 

The Node Title will reflect the Meta-Node choosen with the information below 
it containing other relevant information. The tabs contain the rest of the 
information for the Meta-Node. 
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Meta-Node Appearance 

Meta-Nodes by Component Nodes 
This is similar to the Create Meta-Nodes by NodeClass. The center of the 
cluster is the Meta-Node and the pendants are the individual nodes 

 

Meta-Nodes by Bounding Box 
This shows all nodes in a Meta-Network with the Meta-Node names displayed 
near the Meta-Node. All nodes in that Meta-Node are contained within their 
box. 
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Meta-Nodes by Bounding Polygon 
Each Meta-Node is contained within their individual colored polygons. 
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Other View Srtles 
There are many ways to display your network in ORA. Below are a few 
examples showing the diverse styles available 

By Organization 



650 
 

 

Organization with Components 

 

Links To A Meta-Node 
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Links To Other Meta-Nodes 
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Group Viewer 

The Group Viewer helps separate nodes into distinct groups.  

We'll use one of the networks for each of the groups to further examine the 
breakdown. 

There are six groupings which can be called up: 

Clique :  

CONCOR :  

Johnson :  

Newman : Used to find clusters in a network. 

FOG :  

Alpha-FOG :  

ORA implements the newman algorithm presented in the following paper: 

Finding community structure in very large networks, Aaron Clauset, M. E. J. 

Newman, and Cristopher Moore, Phys. Rev. E 70, 066111 (2004). The 
algorithm uses link weights. It is not the Newman-Girvan algorithm based on 
betweenness centrality. 

Please note, Newman developed this algorithm as it scales better than the 
Newman-Girvan for large networks. 
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Group Viewer-Newman 

Description 

 

The Newman grouping is used to find clusters in a network. I began 
increasing the number of groups to view until the larger cluster began to 
break up. Newman's Algorithm starts with each node as its own group, and 
then combines groups in a hierarchical manner until only one group remains 
(e.g. it is agglomerative hierarchical clustering). At each step, which two 
groups to merge is based on what will maximize the modularity value - or 
group community structure value. 
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Newman with 4 groups 
In the Group Viewer window set the Number of froups to view: to 4. 
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The Newman grouping is used to find clusters in a network. I began 
increasing the number of groups to view until the larger cluster began to 
break up. 

Newman with 10 groups 

 

Newman with 4 groups - Colored 
Ora can also color-code each group for easier viewing. 
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Clauset, A., M.E. Newman, et al. (2004). Finding community structure in 
very large networks. Physical Review 70 SP - EP 

 

 

Group Viewer-Girvan Newman 

Description 
Girvan-Newman is divisive hierarchical clustering (all nodes start off in the 
same group and groups are split until each node is its own group). Groups 
are split by choosing from the edges that remain the one with the maximum 
edge betweenness score. 
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Girvan Newman with 4 groups 
In the Group Viewer window set the Number of groups to view: to 4. 
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Group Viewer-Cliques 

The defaults for Cliques for this network are set to Minimum clique size: 
3 and Number of groups to view: 25. This produces an unreadable 
display. Increase the number of groups until the number of groups becomes 
viewable. In this case Minimum clique size: 6 and Number of groups to 
view: 5. 
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Examining a Meta-Node 
To view a list of the components of a Meta-Node, double click the node. 
Select the Components tab for a list of the nodes. 
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Group Viewer-CONCOR 

Below is an image of the Group Viewer window and procedures for using this 
tool. This is a Structural Equivalence/Clique which can be used on one or two 
mode data, and one or a set of networks at once. 

 

Parameters 
Use out-links (matrix rows)? The links leading out of the chosen node 
into another node. 

Use in-links (matrix columns)? The links leading into the chosen node 
from another node. 

Number of groups to view:  
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Example 

 

The example uses the network Star Wars dataset. For each of the three 
possibilities in, out, both the display is shown with the number of groups 
set to 4. The resulting displays show how the in and out links affect the 
groupings. 
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Use out-links 

 

Use in-links 
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Use both in-links and out-links 

 

 

Group Viewer-Johnson 

Below is an image of the Group Viewer Johnson window and procedures for 
applying the Johnson algorithm. This is a Hierachical Clustering based on 
Similarity Standard hierarchical approach that builds groups based on 
similarity scores. 
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Johnson - Similarity, Single Links 

 

Johnson - Similarity, Complete Links 
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Johnson - Similarity, Average Links 

 

 

Group Viewer - K-FOG 

FOG (or Fuzzy Overlapping Groups) works in either one-mode (NodeSet-
1 x NodeSet-1) or multi-mode (NodeSet-1 x NodeSet-2). The multi-mode is 
the more natural procedure. It's prime function is to form nodes into groups 
(clusters or communities) and show which nodes share the secondary 
functions. 

REMEMBER : Groups produce tasks - people participate in tasks. 

Select a Network: The same in both. The dropdown menu lists all the 
available networks in the selected Meta-Network. Which network you 
choose will determine the dialog that is present. 

One-Mode 
These are square networks [i.e., characters x characters] 
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Select the number of trees per node : The number of sample events to 
generate. 

Select the tree size : The number of people involved in each group 

Number of groups to view :  

Multi-Mode 
These use two different networks [i.e., characters x locations]. 
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Select Nodeset to Cluster : Select which network in this multi-mode 
network to form clusters. 

Links 
The thickest link is usually the leader of the group. The question to ask is 
WHY is that particular person the strongest link. It is important to look at 
the composition of the group(s) involved. 

If the weights are Lopsided (many strong and/or weak links) the analyst 
needs to look at the association of the interstitial* actors whose 
information will assist in analyzing the groups. 

If a node is connected to only one group and that group has few actors then 
it is considered somewhat insular. 
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Node Appearance 

Node Appearance 

 

Label Style > Default : Sets the label to appear to the right of the 
node. This is the default position for labels. 

 

Label Style > On Right of Node : Sets the label to appear to the 
right of the node. 

 

Label Style > On Left of Node : Sets the label to appear to the left 
of the node. 

 

Label Style > On Top of Node : Sets the label to appear on top of 
the node. 

 

Label Style > On Bottom of Node : Sets the label to appear 
beneath the node. 

 

Label Style > Centered on Node : Sets the label to appear directly 
centered on the node. 

 

 

Node Style > Toggle Node Size : Rotates between the three sizes 
and styles for the display of the nodes. 

 

Node Style > Spot : Sets the size of all nodes to a small colored 
circle. 

 

Node Style > Small Shapes : Sets all nodes to a colored shape 
(circle, square, triangle, pentagon, diamond, hexagon). 

 

Node Style > Large Shapes : Sets shape of nodes to a colored 
shape only large enough to contain the label. 

NOTE : Meta-Network must be saved in the Editor in order for colors 
to be reloaded the next time the Meta-Network is loaded. 
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The Nodesets retain their default color in the Legend dialog. i.e. all 
agent NodeClasses will default to red. 

 

 

Node Color > Show Node Occurrance Transparencies :  

 

 

Node Color > Color Nodes by Attribute or Measures : ALlows 
you to chose an attribute or measure to run on a Meta-Network and 
will color the nodes in specific groups. 

 

Node Color > Color Nodes by Componant :  

 

Node Color > Color Nodes by Concor Grouping : Divides and 
colors nodes according to the Concur Grouping 

 

Node Color > Color Nodes by Newman Grouping : Divides and 
colors nodes according to the Newman Grouping 

 

 

Reset Node Color and Size : Sets the color and size of all node to 
the default values. 

NOTE : Primarily used to resetting size after using Size Nodes by 
Attribute or Measure. The size set on the toolbar is the default 
size. 

 

Size Nodes by Attribute or Measure : Allows you to chose an 
attribute or measure to run on a Meta-Network and will size all nodes 
accordingly. 
 
Performing measure-based operations is not dependent on having 
previously run a report. 
 
A Meta-Network asks if a measure can be run. If so, it is added to 
the list. That is why you may not see all measures appear in the 
dropdown menu. 

 

Apply Log Scale to Current Sizing :  
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Show Labels : Toggles the names of the nodes on and off. 

 

Load Node Images : If nodes have image files attached to an 
attribute this will display the picture instead of the node icon. 

 

Remove Node Images : Removes all images from the visualizer 
and returns all nodes to their icon status.  

 

 

Node Shaper : Allows you to chose the size and/or shape of any set 
of nodes. The set is not just one particualr Nodeset but can be 
created from individually choosen nodes from any Nodeset. 

 

Attribute Measure related Options :  

 
 

 

Link Color 

In ORA you can color links according to several preferences. Below are the 
procedures for doing so.  

 

NOTE : For this example all the nodes are colored black so as to decrease 
the color confusion. 

NOTE : For this example the link weights have been drastically altered from 
the original values to assist in display purposes. 

NOTE : Below is a warning for the placement of the Min and Max sliders. 
When the sliders are set to the absolute left and right positions this causes 
all the colors to be set to red. Move the sliders in to prevent this. 

Default Colors 
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When ORA starts out all agent nodes are red with red links. There is nothing 
to distinguish the weights of the links. 

For clarity I will split the links using Display > Link Appearance > Show 
Multiple Links Between Nodes > Split Bidirectional Links so we can 
see the change in colors of the birectional links. 

 

Now to distinguish the links by their weights select Display > Link 
Appearance > Link Color > By Link Weight. There are two options for 
coloring link weights. 

Even Distribution 
The colors used are evenly distributed across the chosen spectrum. Using a 
Nodeset with weights of 1, 2, 3, 4, & 9 would have five colors chosen at 
evenly spaced intervals across the spectrum. 
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Limiting the spectrum too small might cause some of the numbers to contain 
very similar colors. This might make it difficult to tell the various shades of 
blue apart. Use this only when there are a very limited number of values. 
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Scale to Weight 

 

Notice that values for 1.0 and 9.0 remain the same as the outer limits but 
the distribution for 2.0, 3.0, and 4.0 vary slightly. 

Link Values 
Notice that most of the colors are now in the blue to blue-green range and 
then a large gap over to yellow for the link weight of 9. These are scaled by 
the weight. 

NOTE : When a link is bi-directional and the weights of the links are not the 
same the Visualizer will color the link that was drawn last. Sometimes it 
makes it difficult to tell the actual link color. 

Change link Color 
After setting the type Even Distribution/Scale by Weight 
the color of the links can be set manually through the color 
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changer. Click on the color box of any of the links to bring up 
the color change dialog box. Select a new color and select 
[OK]. 
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Node Shaper 

The Node Shaper allows you to change the size of individual node(s) 
or assigning pictures. Below is an image of the Node Shaper widow 
and a description of how to change the shape of the nodes in your 
model.  
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1. Select a Style : Select from three Node Style Sizes or use an 
image in it place of the node. 

2. Select a Shape : An optional shape can be used instead of the 
Nodeset's default shape. The node will retain it's default 
Nodeset color. 

3. Select Node to Re-Shape : The bottom section contains the 
controls for selecting which nodes to work with. Typing 
anything in the Find textbox will automatically filter out non-
matching nodes. 

4. Nodeset tabs : Select which Nodesets to view. ALL shows 
every node or the tabs will show only their individual Nodesets. 

5. Check boxes : Place a checkmark in the box next to the nodes 
you want to change. 

6. Filters : Use for filtering based on individual attributes. You can 
filter on more than one attribute at at time. An example can be 
found in Create a new Meta-Network 

7. Select/Clear All buttons : Will either Select or Clear all 
VISIBLE nodes. If a check marked node has been filtered out 
and is currently NOT visible when the Clear All button is 
pressed, then that node will retain it's checkmark and be 
affected by future changes. 

8. Apply/Load Changes : After any changes have been made to 
the top portions selecting the [Apply Changes] buttons will 
cause them to be displayed int he Visualizer. 

9. Close :  

 

 

How The Node Shaper Changes The 
Nodeset 

What follows are examples of how the Shaper changes the Nodeset. 

Whenever the Node Shaper is called and a node is assigned 
something other than it's default shape new attributes will be added 
to Every Nodeset, not just the Nodeset you're working with. 
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• Drawing Type : This will define what type of node is to be 
drawn, shape of image. There are three options for size (small, 
medium, and large) and one option for image. 

• Nodes Shape : There are four large shapes (circle, rectangle, 
ellipse, and hexagon), eight medium shapes (circle, hexagon, 
down triangle, pentagon, diamond, square, up triangle, and 
octagon), and one small shape. 

• Image : Contains the name of the file associated with that node. 

Changing one node will create these three attributes and place 
the default value in every node in every Nodeset. Any of these 
attributes can be manually changed from within the Main Interface 
Editor. 

This is useful if you have changed many nodes and want to restore 
them all to their defaults quickly and easily. The quickest way is using 
the Copy and Paste method. 

 

Column "1" contains the modified values. In column "2" three values 
of medium are highlighted and copied using Ctrl-C. In column "3" the 
cursor is moved to the top cell and Ctrl-V is used to paste those 
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three values in. In column "4" this is repeated until all values are 
back to their defaults. 

If the Image attribute contained a filename then changing Drawing 
Type to image will relink that file to the picture. Any of the four 
Drawing Type values can be placed in this column. 

 

 

Node Shaper Examples 

Original agent x agent Network 
Below is the agent x agent network in the normal medium sized 
nodes.  

We start out with the stargate agent x agent Node Class set to 
medium size nodes. 

 

Changing a few nodes 
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From the Visualizer menu select Display > Node Appearance > 
Node Shaper. Click the tab marked [agents]. Place a check mark 
next to col_jack_o_neill, maj_samanatha_carter, 
daniel_jackson, and teal_c. Select the Large Node Style. 

 

When you are finished click the [Apply Changes] button. 
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Now the four members of SG-1 stand out represented by larger 
nodes. 

Select Nodes to Re-Shape 
You can also use the Search box, in conjunction with the tabs, to 
bring up specific nodes in the grid. It's predictive so as you begin 
typing the grid will change. Continue typing until you see the node(s) 
you need. I wanted the two characters with the rank of major and 
knew their rank was a prefix. I typed maj into the search box and 
the two nodes were singled out. 
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Attribute/Measure Based Options 

ORA allows you to alter the appearance of the nodes in a multitude of 
ways as seen from the drop down menu below. We'll take a look at 
two of these items which will give you an understanding of how they 
work. 

 

Let's take a look at a few of these. 

Here is a Network with all nodes set to the spot style and are all the 
same size to begin with. It contains agent, knowledge, resource, 
location, event, and task Node Classes.  



684 
 

 

Scaling Nodes 
Setting the controls to Scale Nodes and selecting Centrality, Total 
Degree it now scales the nodes to reflect the number of in and out 
links each node has. The bigger the node, the more links it has. 
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I reset the nodes to their default settings with Display > Node 
Appearance > Reset Node Color and Size. Changing the top drop 
down to Color node(s) colors the nodes in a sliding color scale. 

NOTE : If you do not reset the node color and size they will remain 
the same size as before but only change their color. 

Coloring Nodes 
You can click the double downward facing angles to reveal further 
options. For coloring nodes click any color box which brings up the 
color picker. This allows you to pick your exact colors for each level. 
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Next you can select only particular values to be display. Here I 
selected to show only the top six values for the measure. The display 
is to the right. 



687 
 

 

Color By Attribute 
The Agent x Agent network defaults to all agents being red. 
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The display can reflect agents by individual attributes. First select 
Color Nodes then select an attribute [i.e., gender]. Click [ Apply 
Changes ]. 
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The display now shows all Males as green, one Female as yellow, and 
the Robot of the story as blue. 
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Link Appearance 

Link Appearance 

 

Reduce Visualization Complexity : Turns off links and labels, 
resets nodes to spot style, and hides nodes with less than two 
neighbors. 

 

 

Link Labels > Show Link Labels : Toggles on/off the display of 
the labels of the links. 

 

Link Labels > Show Weight Value Labels : Toggles on/off the 
display of the weight of the links 

 

Link Labels > Show Weight Sign Labels : Sets the label and 
shows whether their weight is positive or negative. 

 

 

Link Color > Default : Removes all custom link coloring and resets 
all links to default. 

 

Link Color > By Link Weight : You can set a range of colors to 
represent the weight of links. A dialog box allows you to chose the 
colors for the minimum and maximum weights. 

 

Link Color > Match Source Node : Colors the link the same as 
the source. 

 

Link Color > Match Target Node : Colors the link to match the 
target. 

 

 

Retain Bidirectional Links : When two nodes have links to each 
other only one link will be displayed. 

 

Split Bidirectional Links : When two nodes have links to each 
other only both links will be displayed. These links will be rendered 
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as curved links between the nodes. 

 

 

Show Links : Toggles on/off the display of links between nodes. 

 

Scale Link Width to Weight : Toggles on/off the display of links 
between nodes. 

 

Scale Link Width to Number of Links Between Nodes : Adjusts 
the width of the link to represent the weight of the link. 

 

Show Arrows : Toggles on/off the display of the arrows of the 
links. 

 

Show Self Links (Loops) : Shows whether there is a connection 
between a node and itself. It is designated with a circle pointing 
back to itself. 
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Display 

 

Reduce Visual Complexity : Hides links, hides isolate, and sets 
node shape to small circle. 

Comments 

 

Set Comments Font : Sets the font used in Visualizer comments. 

 

Set Comments Color : Sets the color used in Visualizer comments. 

Title 

 

Title Location > Top : Sets the Title to the top of the Visualizer 
window. 

 

Title Location > Bottom : Sets the Title to the Bottom of the 
Visualizer window. 

 

Title Location > Left : Sets the Title to the left of the Visualizer 
window. 

 

Title Location > Right : Sets the Title to the right of the Visualizer 
window. 

 

Title Location > Center : Sets the Title to the center of the 
Visualizer window. 

 

Set Title : Create a title for a screen shot. The title will remain a 
static size and retain its position regardless of the zoom of 
movement of the display. 

 

Set Title Font : Set the font used in the title of the screen shot 

 

Show Title : Toggle visibility of the title. 
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Allow Click to Edit Node Title :  

 

Show Mouse Overs : Toggles the information boxes on and off 
whenever you hover the mouse over a node or link in the visualizer. 

 

Autozoom : Zooms the display either In or Out to bring all nodes 
into view. 

Background Color 

 

Background Color > Black : Sets the Visualizer background to 
black. 

 

Background Color > White : Sets the Visualizer background to 
white. 

 

Background Color > Custom : Brings up the color picker which 
allows you to chose any color for the background. 

NOTE : Some of the possible background colors can make it difficult 
to view the visualizer. Your best choice is black (although white is 
used in the examples for easier printing). 

Background Image 

 

Background Image > Load : Allows you to chose a .jpg, .gif, or 
.png to use as a background. 

 

Background Image > Clear Image : Removes the image and 
returns the background to the last background color used. 

NOTE : Some pictures may make viewing the network somewhat 
difficult. 

 

Black and White Only : Removes all colors form the visualizer. 

 

Grayscale : Removes the hue from all nodes and links displaying 
them as shades of gray. If any of the nodes are difficult to read try 
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changing the background color to a darker or lighter color. A black 
background works very well for grayscale images. 

 

Reset Node/Link Options : Resets all node and link colors back to 
default. 

 

 

 

Comments 

While in the Visualizer Comments can be added to the display. 
Right-click a node and from the contextual menu select Add 
Comment. The comment is placed in a colored box with a dashed 
arrow connecting them to the original node. 

NOTE : These comments are not saved when exiting the Visualizer. 

NOTE : The main use of these comments would be in creating screen 
shots for display in order to add commentary for a report. 

Below is a section of the Stargate scenario with the unexpected 
appearance of Osiris. 

 

Adding a Comment 
A comment is added stating Osiris's arrival changes the plan. 
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From the main menu, under the Tools item, the font size and color, 
as well as the color of the box, can be changed. 

 

Adding Multiple Comments 
It is also possible to add multiple comments to the same node. 
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NOTE: These comments are not saved when exiting the Visualizer. 

Deleting a Comment 
A comment can be deleted by first selecting that comment. A right-
click brings up the contextual menu. From this menu select Delete 
Selected Node(s). 

 

 

Mouseovers 

NOTE : To access the contextual menu the option must be checked. 

Go to Display >  Show Mouse Overs and make sure the option 
is check marked. 

When the pointer is passed over any Node in the visualizer a yellow 
tooltip box will appear showing information on links to other nodes 
as well as values for measures than have been run. Below is a screen 
shot comparing two mouseovers. 
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If an Attribute is eompty ORA will leave a blank line for that 
attribute. Only if the attribute has a value will it be displayed. 
Neighbors are all the links to other nodes. 

Mouseover Display Limit 
With the mouseover display active ORA will attempt to display which 
node or link you have the pointer hovering over. But there is a limit 
of 5,000 links when ORA no longer attempts to dusplay the link. It 
will, however, still attempt to dusplay which node the pointer is 
hovering over. 

 

 

Multi Color Links 

There may be an instance when you would want to differentiate links 
between the same nodes. This is done by creating separate Networks 
for each instances. In the following example there are two Nodesets 
with three nodes each. We want to show different relationships 
between these two Nodesets. 
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We do this by creating individual Networks for each separate 
instance. Two for abc x def and two for def x abc. 

 

When first visualized all nodes are red as are their links. 

 

To show one set of links differently click on the arrow next to one of 
the Networks and the color picker will appear. Pick a new color and 
click [ OK ]. Notice how only the links in that Network turned blue in 
the Visualizer. You can then continue this for all Networks you want 
to reveal. 
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The third Network was turned green and the fourth Network was 
tuend orche. It is now easy to find which links belong to which 
Network in the Visualizer. 

 

 

 

Node Images 

Nodes can be replaced with various symbols or pictures to make it 
easy to identify individual nodes. There are a few items to note. 
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All images should be reduced to approximately 50 x 50 pixels 
before using in ORA. Bigger images will be reduced in size on the 
display and the image quality may possibly be degraded. 

If a picture is placed on a background with the color R=255, B=0, 
G-192 the background will be changed to the color of the node. 

Setting a Image Folder 
The Set Picture option is designed with modularity in mind, with 
adding new images as easy as putting a folder with images in the 
include\OraFiles\images\visualizer\node folder. The dialog will 
automatically read that folder for subfolders, use the subfolder names 
as categories, and the images inside the subfolders as the images for 
each category. 

Set Picture 
Right-click any node and select from the contextual menu 
Appearance Submenu > Set Picture. The Node Selector dialog 
box will appear. The drop down menu contains various types of node 
images. With a node selected a custom image can be applied. Nodes 
with Images will scale.  
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Custom 
The Custom option allows for the inclusion of a user's own icons. 

The custom category is used for images that have been previously 
loaded in the current meta-network. Clicking OK applies the currently 
selected node's image to all nodes selected in the visualizer.  

Additional information can be found in the Node Shaper section. 

The [New Image] button brings up a navigation box from which to 
navigate any directory and select an image file. The picture types can 
be jpg/jpeg, gif, or png. These will all be collected into the Custom 
section. 

NOTE : Remember to reduce the picture size BEFORE importing it 
into ORA. 

To set a new image right-click the node and select Set Picture. This 
brings up the picture dialog box. Locate the appropriate picture and 
select it. A black border will appear around the image. Select [OK] 
will set the picture to the node. 
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Links By Weight 

There will betimes when you need to see the differences in link 
weights in the Visualizer. This is accomplished using Display > Link 
Appearance > Scale Link Width to Weight. 

This network contains links of varying weights but at a link weight set 
to 1 that is not visible on the screen. 

 

Using Display > Link Appearance > Scale Link Width to Weight 
will set the links to increasing widths depending on the link weight. 
But with the default link weight set to 1 the differences is negligible. 

 

To be able to see these differences increase the default link weight up 
[here I set it to 20. and now you can plainly see the differences in 
the link weight. But you must be aware that in a bidirectional network 
the links may have different weights. 
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The center wide link has one link weight of 4 and the other link 
weight of 9. In this mode only the weight of 9 is visible. The same 
goes for the bottom links which contain a 2 and a 3 weight. 

 

Using the Display > Link Appearance > Show Multiple LInks 
Between Nodes > Split Bidirectional Nodes you can see that 
links between two nodes are different weights. Using this function 
displays all nodes with no overlapping. 
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Visualizer Contextual Menus 

The Contextual Menu is displayed by right-clicking an a Node or Link. 
It contains many standard uses in manipulating nodes and links. 

Node Menu 

Pin SubMenu : 
Pin All Nodes : Globally pins all nodes. Nodes are unaffected by the 
[Play] button or the movement of other nodes. 

Unpin all Nodes : Frees all nodes from being pinned. 

Pin Selected Node(s) : All selected nodes will become pinned 

Unpin Selected Node(s) : All selected nodes will become 
unpinned. 

URL SubMenu :  
Attach URI : You can attach a URI to the selected node. 

Go To URI : Activates your browser and goes to the URI associated 
with this node. 

Appearance Submenu :  
Set Picture : You can replace the node shape with a picture. 

Set Node Size : You can numerically set the Node Size of an 
individual node. 

Set Node Color :  

Set Font Size : You can numerically set the Font Size for an 
individual node. 

Enlarge : Increases the size of the selected node in the Visualizer 

Shrink : Decreases the size of the selected node in the Visualizer 
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Brighten : Lightens the shade of the color of the selected node 

Darken : Darkens the shade of the color of the selected node. 

Hide Labels : Hides the label of the selected node. 

Show Labels : Reveals the label of the selected node. 

Show Ring(s) : Places a highly visible ring around the selected 
node(s). 

Hide Rings(s) : Removes ring from selected node(s) 

Visibility Submenu :  
Hide Node(s) : Removes the selected node (along with all links) 
from view in the Visualizer. 

NOTE : This does not delete the node from the Meta-Network. 

Hide Adjacent Node(s) : Hides all nodes that are linked to the 
selected node. The selected node remains visible. 

Other :  
Color Adjacent Edges : Allows you to chose the color for all links 
associated with the selected node. Only works on one node at a time. 

Select Node : Registers the node as selected when Ora affects 
multiple nodes. 

Center Node : Brings the selected node to the center of the 
visualizer. 

Pin Node : Pins node to background so it is unaffected by the 
movement of other nodes. 

Expand Node : Shows all nodes and links connected to the selected 
node. 

Combine into Meta-Node : Multiple nodes can be selected and 
combined into a Meta-Node which will contain links to all the nodes 
that the individual nodes had. The four large circles of SG-1 are 
selected. The and green circles show which tasks are associated with 
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these agents. Press, and hold, the Control key while selecting each 
node for the Meta-Node. Then without releasing the Control key, 
right-click one of the nodes to bring up the contextual menu. Select 
Combine into Meta-Node. 

 

After combining the task nodes that were linked to the individual 
nodes are now linked to the sg-1 Meta-Node. 

 

NOTE : If additions or deletions of Nodesets needs done expand the 
Meta-Node before proceeding. 

Add Comment : Attaches a comment to the currently selected 
node. Good for making notes for display purposes. Comments can be 
toggled to be shown or hidden form the Display menu. The color and 
font of the comments are also controlled from the Display menu. 
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Spread Out : Finds the center for the currently selected nodes. Then 
calculates a ray from that center through the nodes current location, 
and pushes the node along that ray by (currently) 40 units. 

Delete Selected Node(s) : Allows for the deletion of nodes form a 
Meta-Network from within the Visualizer. 

NOTE : This deletion is permanent once the Meta-Network is saved. 
If there is any question regarding the deletion then remove the Meta-
Network from ORA before saving and reload the Meta-Network. 

Link Menu 
Link Status : Brings up the Link Status box with information on its 
weight, the network, source and target nodes, source and target 
Nodeset. 

Hide Link : Hides the link. This does not delete the link. 

Set Value : Set a new value for a link. 

Reverse Direction : Reverses the Source and Target aspects of 
the link. 

Delete Link : Removed the link from the Network. 

Empty Space 
Pin All Nodes : Globally pins all nodes. Nodes are unaffected by the 
[Play] button or the movement of other nodes. 

Unpin all Nodes : Frees all nodes from being pinned. 

Pin Selected Node(s) : All selected nodes will become pinned 

Unpin Selected Node(s) : All selected nodes will become 
unpinned. 

Add Comment : Attaches a comment to the currently selected 
node. Good for making notes for display purposes. Comments can be 
toggled to be shown or hidden form the Display menu. The color and 
font of the comments are also controlled from the Display menu. 
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Spread Out : Finds the center for the currently selected nodes. Then 
calculates a ray from that center through the nodes current location, 
and pushes the node along that ray by (currently) 40 units. 

Format Nodes : Brings up the Node Formatter dialog box. 

 

 

Comments 

Add Comment : Attaches a comment to the currently selected 
node. Good for making notes for display purposes. 

 

 

 

Node and Link Formatter 

Node Formatter 
There are two ways to select nodes. 1] You can Control-Click on each 
node separately in the Visualizer. 2] You can use the Selector tool 
and lasso a group of nodes. When you have the nodes selected righ-
click to bring up the Node Formatter dialog box. 
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Appearance Tab : Controls the color, transparency, and labels of 
the Node(s) selected. 

Node Color : Control the color of individual nodes. 

Match Node Set Color : Resets the color of the node(s) back to the 
default color of the Nodeset. 

Choose a Custom Color : Click the color box. From the color the 
selector palette select a new color and click [ OK ]. In the Node 
Formatter box click [ Apply ]. 

Node Transparency : Set the Node Transparency from 0 
[transparent] to 1 [visible]. 

Node Size : Set the Node Size from 4 [small] to 25 [large] 

Visibility Tab : Controls visibility of nodes. 

Hide Node(s) button Removes nodes from the display. 

Show Node(s) button puts the nodes back into the display. To 
bring back Nodes of a Nodeset which have been hidden you can 
toggle the check box in the Legend off and on and all nodes of a 
Nodeset will reappear. 

Label Tab : Set the label size from 1 [small] to 25 [large]. You can 
also show or hide the labels of the selected Nodeset. 

Label Size : Change the size of the label from 1 [small] to 25 
[large]. 

Hide Node Label(s) button Removes label from the display. 

Show Node Label(s) button Puts the label back into the display. 

NOTE : The Node Formatter works only with the node(s) originally 
selected. To change the parameters for another node(s) you must 
close the Node Formatter dialog box, select another node(s), then 
perform your changes. 
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Link Formatter 
Right-Clicking on a Link in the Visualizer brings up the Link 
Formatter.  

Appearance Tab : You can color the selected links by Source node, 
Target node, or pick a custom color. You also have the option of 
using solid or dashed lines. 

Node Color : Control the color of individual nodes. 

Color by Source Node : Sets the color of the link(s) to the color of 
the Source Node. 

Color by Target Node : Sets the color of the link(s) to the color of 
the Target Node. 

Choose a Custom Color : Click the color box. From the color the 
selector palette select a new color and click [ OK ]. In the Link 
Formatter box click [ Apply ]. 

Visibility Tab :  

Hide Link(s) button Removes link from the display. 

Show Link(s) button Puts the Link back into the display. 

NOTE : If after you hide a link and close the Link Formatter dialog 
box the only way to bring that link back a link you have hidden is to 
use the menu item Actions > Show All Nodes. But remember, this 
will also undo any other hidden nodes and links you have. 

 

 

Node Contextual Menu 

Right clicking any node in the Visualizer brings up a menu of the 
most useful tasks concerning nodes.  

The Pin Node Submenu : Allows you access various function 
involving pinning and unpinning nodes in the visualizer 
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The URI Submenu : Allows you to attach a URI to a node or go to a 
URI already attached to a node. 

The Appearance submenu : You can enlarge or shink the size of a 
node, brighten or darken it's color, set its color or size, attach a 
picture to a node, or give it a display ring for easier visibility 

Label submenu : Individual labels can be hidden or displayed and 
the font size can be altered 

Visibility submenu : You can either hide the selected node or hide 
the adjacent nodes. 

Color Adjacent Edges : Sets the color of adjacent links of the 
selected node. 

Select Node : Makes the node selected. 

Center Node : Center the selected node to the center of the window 

Combine into Meta-Nodes : After selecting two or more nodes you 
can combine them into a single Meta-Node and give that Meta-Node a 
name. If necessary you can also Expand that Meta-Node into its 
individual nodes. 

Add Comment : You can add or delete comments for any node in 
the Meta-Network. 

 

Spread Out : Puts mode space between node around the selected 
node. 
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Delete Selected Node(s) : Removes selected node(s) from display 

Format Nodes : Calls up the Node Formatter 

 

 

Removing Nodes In The Visualizer 

You can remove nodes directly from the ORA Visualizer by right 
clicking on a node and selecting Hide Node. Below is an example of 
removing an node using the Hide Node tool.  

Find the node you want to hide. Here we will hide ren'al.  

 

Place the cursor over the node and right-click on the node to bring 
up the contextual menu. Highlight Hide node ren'al and the four 
task nodes are now separated from the rest of the network. 
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Set Node Picture 

In addition to changing the size of nodes in the visualizer you can 
also assign nodes individual pictures. This example is my Raiders of 
the Lost Ark set from Peru. 

NOTE : This example uses only standard icons found in ORA. 
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I Right-Clicked on The Bullship node and selected Appearance Menu 
> Set Picture. This brings up the Set Picture dialog. I clicked the 
downward triangle and selected the Resource - Generic folder. I 
then selected the colored cubes icon. 
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Clicking [ OK ] assigns that picture to the selected node. 
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You can replace any number of nodes with icons. 
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Your Own Icon Set 
You can create your own set of icons. Place all your personnal icons 
in a folder and place that folder in the following directory. The next 
time you use ORA you will be able to select icons from your own 
folder. 

 

NOTE : Be aware that very large icons will make viewing the display 
difficult. Small distinct icons work better. If using pictures of 
individuals it's advised to resize them to 50 x 50 pixels. 
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Motifs 

This is a list of common motifs that can make it easier to find various 
clusters as the underlying structure of your network.  

No Links 

 

2-Group 

 

Bowtie 

 

Chain 

 

Circle 

 

Star 
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Cognitive 
Demand 

 

Degree 
Centrality 

 

Eigenvector 
Centrality 

 

High 
Betweenness 
and No 
Degree 

 

Exclusivity 
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Visualizer 3D 

The 3D Visualizer uses the same Meta-Networks as the standard 2D 
Visualizer, only it projects them into a three dimensional setting. It 
can be called up either by selecting from the main menu 
Visualizations > View Networks > 3D Visualizations or in the 
editor by clicking the dowward triangle on the [ Visualize ] button. 
This will visualize the highlighted Meta-Network. 

As with the 2D visualization the Legend controls which NodeClasses 
are visible in the display. 

Controls 
The display at the bottom of the visualizer denotes working with a 
three-button mouse. When working with trackpad the controls are 
similar, left button to rotate and righ tbutton to translate. The zoom 
is accessed by using your finger on the side of the trackpad to zoom 
in and out. 

Three Button Mouse 
Rotate : Using the Left Button you can spins the display in 
whatever direction you move the mouse. You can move the mouse 
left/right and forward/backward. 

Translate : Using the Right Button you can move the display 
laterally left/right or up/down. You can move the mouse left/right and 
forward/backward. 

Zoom : Using the Middle Button you can affect how close-in or far 
away the display is. The zoom works by moving the mouse in the 
forward/backward direction only. 

Using a Trackpad or a Two-Button Mouse 
The Rotate and Translate function exactly the same. To use the 
Zoom function press and hold the Alt key then click the Left 
Button. Then move the mouse or your finger on the trackpad.n 
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3D Visualizer GUI 

In the 3D visualizer - you can size nodes by standard social network 
metrics. This is one of the options under visualize nodes. You can also 
color the nodes by attribute. Performing measure-based operations is 
not dependent on having previously run a report. 

The standard flow for using measures goes something like this. 

1) User calls size nodes by attribute/measure. Dialog loads in the 
current meta-network. 

2) For each measure that's been defined, the Meta-Network asks if 
it can run it. If it can, it gets added to a list. 

3) User selects the measure, runs, and the visualizer calls the 
ORA-backend to compute the measure. 
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2D display 
Herre is the normal view in the 2D Visualizaer. 
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3D display 
Here is the same network viewed in the 3D Visualizer. 

 

The menus for the 2D and 3D Visualizer are nearly identical. The 
Layout menu, as well as other selected controls, are disabled in the 
3D version. 

Pinning Nodes 
Currently pinning nodes in the 3D view is not available. 

Nodes Hidden From View 
As you move around your network you may notice some nodes 
disappear. In this view you need to be aware of working in 3D Space. 
In this first view the camera is far from the network and all the nodes 
are visible. 
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But as the camera is moved in it passes some nodes and they end up 
behind the camera. 
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2D 3D Differences 

There are a number of functions available in the 2D Visualizer which 
are not available in the 3D Visualizer mostly due to being designed 
for the 2D space. Below is a list of these functions. 

File 
Open ORA-Image, Save Special, Add Grouping to Current Meta-
Network, Add Meta-Nodes to Current Meta-Network, Visualize in 
3D, GeoSpatial Networks 

View 
Change Font... 
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Actions 
Pin All Nodes, Unpin All Nodes 

Tools 
Node Status, Backward Influence, Pie Nodes, Meta-Network 
Designer, Networks Over Time, Vector Maps 

Layouts 
All menu items inactive. 

Meta-Nodes 
Create Meta-Nodes by Grouping..., Create Meta-Nodes by 
Attribute/Measure, Meta-Nodes 

Node Appearance 
Label Style, Node Style, Node Color > Show Node Occurrence 
Transparencies 

Link Appearance 
Link Labels, Show Multiple LInks Between Nodes 

Display 
Allow Click to Edit Node Title 

 

 

Color By Attribute or Measure 

As in the 2D Visualizer nodes can accept coloring by various means. 

I start out by hiding all Nodesets except Agents. If the Legend dialog 
is not visible select from the main menu Tools > Legend then from 
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the Legend menu Control > Hide All Nodes. Then select the Agents 
Nodeset. This will display all Agent nodes in their default red color. 

 

Using the Select an attribute will allow you to assign individual 
colors to each attribute. Click on color well and choose your colors. I 
assigned the three homeworlds red, green, and blue and the Lacks 
an Attribute value was set to yellow. Click the [ Apply Changes ] 
button. 
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From the Select a measure: drop down select a measure to run. 
This will assign values to each node some of which could be equal. 
As with the attributes you can assign individual colors to each value. 

The two nodes in the red circles are the same color, 0.46153846. 
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3D Contextual Menu 

While in the 3D Visualizaer right-clicking brings up a different 
contextual menu. There are different menus for clicking a node or a 
link. 

Right-Click a Node 
Add Node : Clicking on a node will add a link to a new node 

Add Link : Right-click a node and select Add Link. Click a second 
node and a link is created between those two nodes. 

Center Node : Brings the selected node to the center of the screen 
and zooms in. 

Delete : Deletes selected node from Nodeset 

Drag : Selected node turns yellow indicating it is selected. Right-click 
and hold and you can drag the node to a new position. When you are 
finished click the [ Done ] button at the bottom of the visualizer. 
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Fixed Position : Sets a node's position in space while other 
functions are performed. The node turns light blue and a check mark 
indicates this is active. When finished selecting this function 
unselected the node. 

Set Label... : Allows the user to give a node a new label. 

Set Colour... : Calls up the color palette and allows the user to give 
the selected node a new color. 

Set Radius : Allows the user to manually resize a node. 

Hide : Hide the selected node form the display. 

NOTE : Hidden nodes can only be recalled using the Action > Show 
All Nodes function.  

Show Details... :  

Right-Click a Link 
Delete : Seletes selected link 

Hide : Hides selected link 

Radius... : Changes selected link to new radius 

Weight... : Changes weight of the selected link. 

NOTE : Weight of link can be set between 0 and1.0 

Set Colour... : Calls up colour selector and sets link to that colour. 

Reverse Direction : Reverses the direction of the link. 

NOTE : To show the current direction of the links click the Show 
Links button on the toolbar. 

NOTE : If after reversing the direction of a link the direction does not 
change, toggle the Show Links button off and of 

Show Details... :  
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GeoSpatial Network 

ORA provides tools to visualize Geospatial Information Systems: GIS 
Visualizer and GIS Visualizer 3D. When working with the GIS 
Visualizer your Meta-Network must include location information. 

 GeoSpatial is concerned with plotting who or what was where on 
a global basis. It plots nodes on a map and then connects those 
nodes. 

 

 Loom also deals with nodes in locations but is keyed on the 
timeframes in which nodes appear. There are locations in which two 
agents appear in but which were there at different times and never 
met. 
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GIS 

The GeoSpatial Visualizer differs from the 2D Visualizer as it places 
nodes on a representative map whereas the regular visualizer allows 
the nodes to float freely in a non-space. 

Many Geospatial information system (GIS) products apply the 
term geospatial analysis in a very narrow context. In the case of 
vector-based GIS this typically means operations such as map 
overlay (combining two or more maps or layers according to 
predefined rules), simple buffering (identifying regions of a map 
within a specified distance of one or more features, such as towns, 
roads or rivers) and similar basic operations. The Geospatial Network 
tool in ORA allows for the plotting of a Meta-Network on a map of the 
globe using longitude and latitude for placing the nodes. 

This longitude and latitude is associated with a location Node 
Class. Then other Node Classes are associated with the location Node 
Class. This information is used to place people and items on the map. 

Below is the default map included with ORA's GIS tool. 
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NOTE : Other maps, or layers, can be added and loaded into the GIS 
Visualizer. The GIS Visualizer generally can load geospatial maps 
based on the Shapefile format. 

The ORA Geospatial Visualizer can be accessed from either the main 
menu bar: Main Menu Bar > Visualization > Geospatial 
Networks or by clicking the triangle on the Visualizer button in the 
Editor. 

Geospatial Networks attributes 
The Meta-Network MUST contain a location Node Class and that 
Nodeset MUST contain longitude and latitude data. Below is an 
example of a Location Node Class information that contains 
Longitude and Latitude as attributes. 

 

Location COUNTRY POP CAP LONGITUDE LATITUDE 

Murmansk Russia 468000 N 33.0860405 68.96355 

Arkhangelsk Russia 416000 N 40.6461601 64.52067 

Saint Petersburg Russia 5825000 N 30.4533272 59.95189 

Magadan Russia 152000 N 150.780014 59.571 

Perm' Russia 1160000 N 56.2324638 58.00024 

Yekaterinburg Russia 1620000 N 60.6101303 56.84654 

Nizhniy Novgorod Russia 2025000 N 43.94067 56.28968 

Glasgow UK 1800000 N -4.26994753 55.86281 

Kazan' Russia 1140000 N 49.1454659 55.73301 

NOTE : The columns which are necessary to build a Location Node 
Class are highlighted in Blue. In this example below, COUNTRY, POP, 
and CAP are not necessary, though they can be added, as additional 
attributes. Further below this chart, we will display how a location 
Nodeset will appear in ORA's editor. 

Longitude and Latitude Format : The longitude and latitude use 
the degree.minute format. Longitude begins at the prime meridian 
which runs through Greenwich Village and run eastward 360 degrees. 
You can also denote the longitude values with positive or negative (-) 
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numbers between 0 and 180. Latitude uses a 0-point which begins 
at the equator and runs to 90 to the north and -90 to the south. 

Location data example 

 

 

 

GeoSpatial Network Toolbar 

 The GUI contains tools to work with the GIS maps. You can also 
customize the toolbar with functions from the menu. 

Standard Toolbar 

 

Copy Image to Clipboard : Places a copy of the current map in 
the clipboard which can be pasted into another program. 

 

Pan Map : Place the cursor on the map and click the button. The 
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map will re-center on those co-ordinates. 

NOTE : Right-Click on the map to center view on that area. 

 

Select Place : Click and drag to capture nodes for information to 
display in an information window. This information will be displayed 
in an expanding tree format. Click and drag the cursor to include 
the nodes to display. 

 

A pop-up window will display information for all the nodes captured 
by the cursor. 
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Zoom In : Zoom In works in two ways. 1) Click and drag to select 
the area you want to zoom in on. The selected area will fill the GIS 
window. 2) Click the map once and the view will zoom in centering 
on the clicked area. This can be repeated until you zoom in as close 
as needed. 

 

Zoom Out : Place the cursor on the map and click the button. the 
map will zoom out and re-center on those co-ordinates. 

 

Show Labels : Toggle the labels on & off. 

 

Show Links : Toggle the links on & off. 

 

Show Arrows : Toggle the arrows on & off. 

 

Font Size : Increase or decrease font size using the up & down 
arrows. 

 

Node Size : Increase or decrease node size using the up & down 
arrows. The size of the node is proportional to the number of 
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entities in a location. 

 

Link Width : Increase or decrease link width using the up & down 
arrows. 

 

 

 

GeoSpatial File Menu 

 The GeoSpatial file menu allows you to open, add, and save map 
data. 

 

Open Meta-Network… : Opens a NEW Meta-Network file into the 
Geospatial map. REMEMBER: The new file needs to have both 
longitude and latitude data. 

 

Open Trailset… :  

 

Save Screenshot : Saves the currently map to the .PNG format. 

Add GIS Data… :  

 

Add CSV : You can load a .csv file and specify which columns 
contains the longitude/latitude data. 
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Add KML (Google Earth) : KML is a file format used to display 
geographic data in an earth browser (e.g. Google Earth). A KML file 
is processed in much the same way that HTML (and XML) files are 
processed by web browsers. Like HTML, KML has a tag-based 
structure with names and attributes used for specific display 
purposes. 

 

Add e00 : Contains Geographic Information Systems (GIS) 
mapping data exported by ArcGIS software. ORA can import this 
style of vector data and convert it for use in the GeoSpatial tool. 

 

Add ERSI Shapefile : An ERSI shapefile is a digital vector storage 
format for storing geometric location and associated attribute 
information. Shapefiles spatially describe geometries: points, 
polylines, and polygons. 

  NOTE : This format lacks the capacity to store topological 
information. 

 

Add Shapefile (using Openmap) :  

 

Add Shapefile (using Geotools) :  

Save Map… :  

 

Save Map To PNG : Saves the currently map to the .PNG format. 

 

Save Map To SHP : Saves the currently map to the .SHP format. 

 

Save Map To KML : Saves the currently map to the .KML format. 

 

Save Map To DyNetML : Saves the current map to the DyNetML 
format with the added Node Class ClusterLocation--
ClusterLocation. This records changes affected by the Network 
Aggregator in grouping locations into regions. 
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Save Map To Loom Trailset : Saves the currently map to the 
Loom format. 

Current GIS Layers 

 

 
Open From Defaults : Opens what is currently saved as the 
default Dynamic Network and GIS layers. 

 

 
Open from a File : Uses the information saved in the choose file 
to set the Dynamic Network and GIS layers. 

 

 
Save As Default : Saves the currently selected Dynamic Network 
and GIS layers as the default. 

 

 
Save to a File : Saves the currently selected Dynamic Network 
and GIS layers to a file. 

Current Meta-Network Locations 
Configurations 
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Open From a File :  

 

 
Save to a File :  

 

 
Create Meta-Network From Visible Network... 

 

 

Copy Image To Clipboard : Saves a picture of the current map 
to the clipboard which can be pasted into another program for use 
in demonstration purposes. 

 

 
Close 

 

 

 

GeoSpatial Modify Menu 

 GeoSpatial Actions Menu. 

 

Replace Current Meta-Network : Allows you to open a new 
geospatial file without closing the GIS visualizer. 

 

Create New Spatial Relation :  

 

Create New Spatial Nodeset :  

 

Generate Distance Network : Creates a new Network of distances 
in the selected Meta-Network using the location Nodeset. 
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GeoSpatial Analyze Menu 

 GeoSpatial Actions Menu controls color and size of location nodes. 

 

Reset Map Zoom : Reset the display of the map to it's default size. 

 

Reset Nodes Colors and Size : Returns on nodes to their default 
colors and sizes. 

  NOTE : If the colors do not reset, click on the map with Pan tool to 
force the reset. 

 

Size Nodes by Attribute or Measure : Sizes nodes using 
numerical data. 

  NOTE : You can not size by an attribute using non-numerical data. 

 

Size Links by Value : Adjusts the weights of links in proportion to 
all links. 

 

Color Nodes by Attribute or Measure : Currently the colors are 
assigned automatically, with "Blue" corresponding to a high value 
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and "Red" corresponding to a low value. The screen may not update 
automatically, so you may have to force a refresh by 
recentering/zooming/etc. 

  
NOTE : If the display does not reflect your new colors you can force 
a re-evaluation by zooming in and out. Another method is using the 
Get/Set View which will not change your framing. 

 

Color Nodes by Component :  

 

Color Nodes by Concor Grouping : Colors nodes using Concor 
Grouping*. 

 

Color Nodes by Newman Grouping : Colors nodes using 
Newman Grouping* 
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GeoSpatial Tools Menu 

 Tools is a set of controls for adjusting how nodes and links are 
displayed. 

 

Layer Manager : Controls the visibility of the Nodeset(s), 
Network(s), and Shape layers on the map by checking or 
unchecking the boxes. 

 

Network Aggregator : Controls the groupings of nodes which are 
displayed together as separate regions. 

 

Get/Set View :  

 

Configure Meta-Network Locations :  
 

 

Layer Manager 

The GIS Layer Manager controls what is displayed in the GeoSpatial 
Visualizer. This includes all Node Classes and Shape layers. It is 
similar to the Legend in the regular Visualizer. 
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Selecting or Unselecting a Node Class or GIS Layer will remove it 
from the display. It does not remove it from the dataset. 

The Move Up and Move Down buttons adjust the display position of 
the SHAPE files. These buttons have no affect on the Network Layers. 

Layer Manager Menus 
Layers 

Add New Layer : You can add additional map files to the display. 

Remove Selected Layer : You can remove any selected map 
layer that has a checkmark next to it from the display. 

Show All Network Layers : Displays all node information on the 
map 

Hide All Network Layers : Removes all Network information form 
the map. The Information is still available through the Layer 
Manager. 

NOTE : If you have more than one map layer loaded you can arrange 
how they are stacked. 
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Change Layer Position > Move Layer Forward :  

Change Layer Position > Move Layer Backward :  

Change Layer Position > Move Layer To Front :  

Change Layer Position > Move Layer To Back :  

Add Layer As Nodeset :  

Options 

Set Current Map Data As Default :  

Reset Map With Default Data :  

 

 

Network Aggregator 

The Network Aggregator looks at regions instead of individual 
locations. Using the slider you can control how dense each region will 
be. Increasing the density groups more locations into a region. 
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Using a sliding scale, which in turn represents network information 
retention (or loss) depending on the level of the adjusted slider. A 
value can also be entered manually in the numeric field box. 

When the network bar is fully red it indicates full network resolution 
and therefore network information is preserved and displayed in the 
GIS Visualizer. Conversely, when lower network resolution figures are 
entered network detail can be sacrificed. This bar graph is intended to 
show the level of such loss. 

Scrolling all the way to the left to a value of 0.0 will remove all but 
the most basic level of aggregation. Basic level being any time where 
two locations occupy the exact same point. By default, GIS loads up 
with a small level of aggregation in order to handle potential issues 
with rounding (in cases where data's generated by scripts). If the 
little bar doesn't do much, try typing the value (0.0) directly into the 
text field there and hitting enter. After a little wait as it recalculates 
things, absolutely all locations should be shown. 

It is best to experiment with the slider at varying values and 
observing GIS visualization for optimum balance of data resolution 
and visual relevancy. This is a useful tool when you have many noisy 
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or cluttered locations. The grouping assists you in seeing the 
connections easier. 

Keeping Separate Agents In The Same 
Location 
If you are having problems with aggregating your data you should 
check your data. Depending on the source, you could have incidents 
where all locations within a city are given the same 
latitude/longitude, or even all locations within a country. It all 
depends on what the data origin thought the data would be used for. 
Sometimes they skimp on the details/accuracy to save time which 
could cause problems in the final display. 

NOTE : You need to remember that in aggregation, ORA is plotting 
locations, not agents. If two agents have the same latitude/longitude, 
then ORA will plot then as one point on the map. 

NOTE : And there is also the ability to view this in the 2D or 3D 
Visualizaer which will display all nodes regardless of the similar 
lat/long attributes. 

Example 
You have 15 agents in London and want to see the links between 
them. In order to see the individual agents they will all need different 
Latitude and Longitude values. The GIS is plots locations, and not 
Agents. Thus, if there is only a single location node for all 15 agents, 
they will be represented as a single node, with no links. The best way 
to do this would be to select these nodes out and visualize them in 
the regular network visualizer. Any perturbations to their Latitude 
and Longitude values would be random. 

GeoSpatial with no aggregation 
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GeoSpatial using Network Aggregation 
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GeoSpatial Network Toolbar 

Add... :  

Add ESRI ShapeFile : Load a shapefile into the GIS Visualizer. 

Add ShapeFile (using Openmap) :  

Add ShapeFile (using Geotools) :  

Color Shapes by Links... :  

Color Shapes by Internal Links : Value determined by number 
of links within a single shape. 

Color Shapes by External (Outgoing) Link Count : Color value 
deteremined by Out-Degree of Node. 

Color Shapes by External (Outgoing/Incoming) Link Count : 
Color value deteremined by Total-Degree of Node. 

Color Shapes by Internal/External Link Ratio : Color value 
determined by  

Color Shapes with No External Links : Colors shapes which 
contain no links 

Color Shapes by Node Count : Color Value determined by number 
of nodes contained in a shape 

Color Shapes by Attribute/Measure : Color Value deteremined by 
selected attribute or by results from measure. 

 

 

General Content About ShapeFiles 
`  

ShapeFiles are used in the GeoSpatial Visualizer and allow you to 
color code map details from data in your Meta-Networks. 
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NOTE : Geospatial Distance does calculate distances taking the 
curvature of the Earth into consideration. 

Finding ShapeFiles 
The GeoSpatial tool can use various ShapeFile formats. This 
shapefiles can be obtained from the following locations : 

World Shape files : 
http://thematicmapping.org/downloads/world_borders.ph
p 

number of different USA based shapefiles : 
http://www.census.gov/geo/www/tiger/shp.html 

Other shapefiles : http://maplibrary.org/ 

Download, and if necessary, unzip these files. Place these files in a 
folder on your computer. 

General Suggestions 
Default Map Colors : Before using the coloring functions on 
shapefiles I have found it advantageous to set the default color of the 
shapes to a neutral grey. Go to the Layer Manager. If it is not 
visible call it up by selecting Tools > Layer Manager. Click on the 
colored box next to the checkbox. The dropdown allows you to 
change the fill color and the border color. When the color picker 
appears pick one of the middle grey tones (or any other color you 
prefer]. 
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If you do not set a default color to your shapefile the color will be 
taken from the color spectrum range. This could possible be different 
each time you run and select your colors. Also the grey, being 
neutral, helps define shapes which are not included in the data. 
Below is the same map which was not given a default grey color. 
Makes some of the colors harder to distinguish. 

 

 
 



754 
 

 

ShapeFiles 
`  

Default 

The default GIS renderer is 
known as OpenMap. Through 
OpenMap you can aggregate 
locations, add shapefiles, and 
perform basic visualization.  

 

 

NASA WorldWind 

Once the data has been 
loaded into GIS, under options 
you can select the 3D 
visualization, which uses Nasa 
Worldwind. Any feature 
available in the 2D version is 
available in the 3D version, 
albeit it may operate a tad 
differently 3D Version 
operates primarily as a 
sphere, but a flat map version 
can be toggled on.  

 

 

Google Earth 
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Google Earth is not integrated 
with ORA, but the GIS is 
capable of producing a .kml 
file for use with Google Earth. 
The command to do so is 
located under File -> Save 
Map. The output will have the 
same nodes and links.  

 

 

Customizing 

Shapefiles allow you to 
customize the map with 
custom political boundaries, 
highways, whatever you can 
find Shapefiles are imported 
via the File -> Add GIS Data. 
menu. Both the fill color and 
border color can be changed 
via the GIS Legend. All 
shapefiles must be in WGS84 
Projection Screenshot shows a 
shapefile of the political 
boundaries of the states of 
Sudan, as downloaded from 
MapLibrary.org  

 

 

 
 

 

Load ShapeFile 
`  

Load Meta-Network Into GeoSpatial 
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You can load a Meta-Network into the GeoSpatial Visualizer in three 
ways. 

In the Main Interface hightlight the Meta-Network. Select from the 
main menu Visualizations > GeoSpatial Networks... 

In the Main Interface hightlight the Meta-Network. Click the 
downward triangle on the Visualize button and select GeoSpatial 
Networks... 

From the GeoSpatial Visualizer select from the Main Menu File > 
Open Meta-Network... 

Load ShapeFile Into GeoSpatial 

 

When started the GeoSpatial tool will display a world map with, if 
selected, your Meta-Network locations shown. From the GIS Menu 
select Shapefiles > Add... > Add ESRI Shapefile. Navigate to the 
location to which you saved this file. Highlight the file and click 
[ Open ]. 

You will notice the outlines appear to have gotten bolder. This is due 
to the second set of country outlines. In the Layers Manager deselect 
the default shapefile leaving only your newly loaded shapefile. 
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Color A ShapeFile 
`  

A ShapeFile can be colored by various methods. By Node Count, Link 
Count, and Attibute/Measure. 

Color Shapes by Links... 
There are three options for links, Color Shapes by Internal Link 
Count, Color Shapes by External Link Count, and Color Shapes by 
Internal/External Link Ratio. 

Color Shapes by Node Count 
You can color the shapes accounting for the number of nodes in any 
location. The color bar allows you to set the color for the minimum 
and maximum. In this case I selected ultramarine for the minimum 
[which essentially means any country with zero nodes] up to the 
maximum which is colored orange. 
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Color by Attribute/Measure 
For this example I took the population numbers of the U.S. States 
and territories. I set the high number to be yellow, going through the 
dark to light blues to green and ending up at white for the least 
populated. 

 

Next I added an attribute to the U.S. population file and called it 
timezone which includes the lower 48 states plus the Atlantic 
territories. I assigned a number for each timezone and added entries 
when a state used multiple timezones. 

NOTE : When adding attributes to use in this manner you need to 
make sure they are created as numeric. Text attributes will not work. 
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Add GIS Data To Meta-Network 
`  

 

Open file in GeoSpatial Visualizer by selecting Visualizations > 
GeoSpatial Networks.... If there is no Latitude/Longitude data in 
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the Meta-Network ORA will inform you there is no location 
information. That's fine, just click [ OK ]. 

NOTE : How can ORA tell whether location data exists? It looks in the 
attributes for names which contain the substrings lat or lon. If so it 
will post those as possible geospatial attributes. 

The Configure Locations dialog will appear asking you to select 
Nodesets and attributes to use as locations. Ignore this and click 
[ Next ]. A second Configure dialog will appear but you need to 
ignore this box also so click [ Finish ]. An empty GIS map will 
appear. 

From the menu select File > Add GIS Data... > Import locations 
from ERSI ShapeFile. Navigate to the shapefile which contains the 
latitude/longitude data for your network. Your locations will now 
appear on the map. 

NOTE : For this example my Meta-Network contained information on 
the population of states. The ERSI file I used contained the 
latitude/longitude for the U.S. states. Make sure that the ERSI file 
you use contained the lat/lon data for your Meta-Network. 

This procedure will add Nodesets and Networks as needed to your 
Meta-Network. The Nodeset will contain the location data from the 
ERSI ShapeFile  

 

Things To Be Aware Of 
To assure that the latitude and longitude data are properly imported 
into your Meta-Network the Node ID must match the information 
from the ERSI file. If not ORA will not match up the nodes and data 
will not be imported. 

NOTE : For those so inclined this data is retrieved from the 
ShapeFile's DBF file which can be opened with Excel. 
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GeoSpatial Network Toolbar 

Add... :  

Add ESRI ShapeFile : Load a shapefile into the GIS Visualizer. 

Add ShapeFile (using Openmap) :  

Add ShapeFile (using Geotools) :  

Color Shapes by Links... :  

Color Shapes by Internal Links : Value determined by number 
of links within a single shape. 

Color Shapes by External (Outgoing) Link Count : Color value 
deteremined by Out-Degree of Node. 

Color Shapes by External (Outgoing/Incoming) Link Count : 
Color value deteremined by Total-Degree of Node. 

Color Shapes by Internal/External Link Ratio : Color value 
determined by  

Color Shapes with No External Links : Colors shapes which 
contain no links 

Color Shapes by Node Count : Color Value determined by number 
of nodes contained in a shape 

Color Shapes by Attribute/Measure : Color Value deteremined by 
selected attribute or by results from measure. 

 
  



762 
 

 

Loom/View Trails 

Description 
Loom is primarily concerned with how specific entities move or evolve 
through other entities. In the most basic case, this involves Agents as 
they move through Locations. More abstract examples include Agents 
moving through Beliefs or Beliefs moving through Locations. 

When you first start Loom, you are prompted for a Network. The 
target nodes in the Network dictate what they're moving through. 
The source nodes are who/what is doing the moving. 

Once started, Loom goes through all timeslices, and looks at the 
connections in that network only. It sets up a series of waypoints 
based on what connections are made at that timeslice, upon which it 
constructs a trailset. 

Classically, we restrained Loom such that for any timeslice, any 
source node could appear in at most one target, but now we allow for 
a source node to occupy multiple targets at a time (Agents having 
multiple beliefs, for example). 

NOTE : Loom can also display things like persons through beliefs 
showing how a person make change their mindset over time. 

A Loom file in .csv is a bit of a misnomer. A loom dataset is a 
dynamic meta-network. A dynamic meta-network is just a bunch of 
single meta-networks. For a beginner, that's a good place to start. 
Take multiple csv's to bring in multiple meta-networks, combine them 
in ORA (select all meta-networks, right click, Convert to Dynamic 
Meta-network), and load in Loom. 

Caveat : Loom works best when Agents or whatever occupy a single 
location at a time. It can handle multiple locations, it just gets messy. 

Before you Start 
Before starting you need a dataset that can be used within the Loom. 
One such dataset is the TAVI dataset. Use File > Open Meta 
Network to open TAVI.xml 
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The clock icon in the Meta-Network Panel means that it is a dynamic 
meta network and that there are continuous-time updates (deltas, 
which are listed below the top-level network) indicating how the 
network changes over time. 

 

To analyze the data you must have a relation that A) changes over 
time and B) stays many:one (e.g., a person must have only one 
location at any given time). Usually this is Agent x Location, but in 
theory you can select other relations. 

In the main ORA screen, open the Visualizer > View Trails. Select 
the Person x Location input network. 

At the top left is a list of Agents; the bottom left is a list of locations. 
Activating the check-box next to an agent will cause its trail to 
appear in the right hand panel. The large vertical strips correspond to 
locations, and the path moving between them is the trail indicating 
the agent's location at each point in time. 
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Open Loom : Highlight the TAVI dataset in the Meta-Network pane. 
From the drop down menu select Visualizations > View Trailsets. 
In the dialog box select Persons x Locations. The Loom window will 
appear with the chosen Network. 

 

1. Person Pane : Lists all persons in the meta-networks. This 
pane contains a check box to the left of next to each person to 
control which persons are visible. To the right is a color 
designation 

2. Location Pane : Lists the locations in the meta-networks. To 
the right is a color designation. 

3. Loom Pane : Displays the persons as they travel through the 
locations. 

Selecting one person you can easily see where they've been (Left 
window). But when you select multiple people, it can quickly get 
impossible to view the trails right window). 
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Making the Display more Readable : can be done in several ways. 
Clicking the color circle representing the individual node brings up the 
color changer. You can then select a color which stands out better for 
viewing. 
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Loom File 

 Loom File Menu 

 

Open … : Opens up DyNetML file which contains location and time 
data. 

 

Save as… : Saves currently open DyNetML file under a new 
filename. 

 

Export > DyNetML : Saves the Loom data as a DyNetML file. 
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Save Image as… : Saves an image of the current Loom state. Can 
be saved as a png, jpeg, pdf, svg, or tiff file. 

 
 

 

Loom Options 

 Loom Options Menu 

 

Anti-Aliasing : Used to smooth out rough edged lines. 

 

Grayscale : Removes all colors from image and is good when 
printing black and white images. 

 

 

Show Timeline : Displays the timeline markers on the left of the 
Loom. 
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Stretch Vertical : You can select a percentage to enlarge the 
height of the Loom. Good when many nodes are situated in a small 
area. 

 

 

Bar Width : Widens the individual locations. Good when many 
nodes are situated in a small area. 

 

 

Allow Multiple Waypoints per Period : If unchecked a node will 
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appear only in the most weighted position. If checked then the 
node will be placed in all locations. 
Example : A main location also contains three separate rooms. An 
agent can be listed to be in the main location but can also be listed 
as moving between the individual rooms. If this option is checked, 
the agent will be shown to be in all locations which can lead to it 
appearing an agent is in two places at once. 

NOTE : The dotted line denotes a node which disappeared from all 
locations then reappeared later on. 
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Trail Clustering 

What Trail Clustering can do: 
Classification : Given a set of trails, the algorithm can classify trails 
based on the underlying patterns of observed location visits. 

Level of Similarity : The degree of similarity in the classified trails 
can be increased or decreased according to user need by varying the 
specified depth of the PFSA. 

Approximate similarity : Further, trails that have a subset of 
similar patterns of location visits, while also displaying differences by 
visiting other non common locations can also be identified by 
specifying a threshold for the similarity. 

Noise Insensitivity : Approximate clustering also provides an inbuilt 
imperviousness to measurement noise in the trails. Occasional 
incorrectly identified location in a trail will not prevent it from being 
classified correctly according to the other correctly identified 
locations. 

Pre-specification of number of clusters : The use of 
agglomerative clustering eliminates the need of pre-specifying the 
required number of clusters. Thus, this removes the risk of assigning 
trails to clusters they do not necessarily belong to (such as in cases 
where the number of final clusters is less than that necessitated by 
the dataset) 

The Clustering Tool 
The clustering tool clusters trails based on similar patterns of 
visitation to (specific) locations.  

One trail that visits location A and B in the pattern ABABAB and 
another trail that visits location C and D in the pattern CDCDCD 
would both be clustered because of their alternating natures. But with 
no overlap the two trails would not be clustered together. But two 
trails that have the following visit patterns ABCABCABC and 
BCABCABCA will definitely get clustered. 
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Trail Pattern Depth 
Consider two trails that have the following visit patterns 
AABAABAAB and ABAABABAA. For a pattern length of 1, the above 
two trails will definitely get clustered because of they both visit 
locations A and B with the same frequencies (2:1). When you 
increase the pattern length, you can get more specific with 
transitions. Now for a pattern length of two, the trails still have 
similar transitions AB, BA, AA but with slightly different frequencies of 
occurence. (Ex: AA occurs thrice in trail 1 and twice in trail 2). 

They may still get clustered together. But when you increase the 
pattern length to three that's when things get interesting. You have 
in trail 2 the pattern BAB that never occurs in trail 1. So they will not 
get clustered together. This also is the reason why in the Star Wars 
dataset Han Solo and Chewbacca get grouped together for a trail 
pattern of 5 because they are almost always colocated throughout 
the movie. 

Cluster Quality 
With a value of 1.0, it will only return clusters where every sequence 
of entries is exactly the same. Lower that, it gives some wiggle room. 
0.7, you'll get entries that are mostly alike, 0.3, you'll get entries that 
have a number of similar event strings. 

Minimum Similarity 
For a little more flexibility in the clustering algorithm you can use the 
minimum similarity feature. If that value is less than 1, for 
example 0.75, then the clustering algorithm will consider trails which 
have 75% of the locations in common, i.e. a trails that visits locations 
A,B,C,D and a trail that visits location B,C,D,E will be compared for 
similar patterns of visitation to locations B, C and D. If they visit 
these common locations similarly then they will be clustered 
together. 

The Loom Dataset 
A Loom dataset is a dynamic meta-network. A dynamic meta-network 
is a group of single meta-networks. For a beginner, that's a good 
place to start. Take multiple csv's to bring in multiple meta-networks, 
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combine them in ORA (select all meta-networks, right click, Convert 
to Dynamic Meta-Network), and load in Loom. 

NOTE : Loom works best when Agents, or nodes, occupy a single 
location at a time. It can handle multiple locations, but you may 
encounter problems reading the display. 

 

 

Trail Cluster Creation 

After loading a Loom ready DyNetML set (e.g. The Star Wars dataset) 
You can show how the characters are clustered. Below is the Loom 
with entire Star WArs characters set displayed. With this example we 
are interested in the Aunt Beru/Uncle Owen and Han Solo/Chewbacca 
pairings. Both pairs followed, for the most part, the similar path. 

NOTE : The Loom lists characters in alphabetical order which may, or 
may not, correspond to the order of the characters in a dataset. 
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From the menu call up Trail Clustering by selecting Clustering > 
Show Similar Trails. Leaving most at their defaults I increase the 
Trail pattern length to four. Clicking [Compute] will display the 
four characters selecting in the Loom. 

NOTE : In this example Uncle_Owen = character_5, Aunt_Beru = 
character_6, Han_Solo = character_9, and Chewbacca = 
character_10. 
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Increasing the Trail pattern length to five removes Uncle Owen 
(character_5) and Aunt Beru (character_6). If you look at the Loom 
image below both these nodes appear in only four time slices. When 
the length is increased to five they are removed form the display. 
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Trail Cluster Analysis 

Trail Clustering using Symbolic Time 
Series Analysis 
The objective of the Trails Cluster Analysis is to find similar behaviors 
in large networks. This can be described as a network trail generated 
by an agent over a period of time. This tracking can be used to 
predict that agent's behavior. 

This methodology is fast and flexible and can be applied to several 
different Node Classes. It views each trail as a sequence of discrete 
symbols where each symbol is a visited location. Clustering is 
performed using a model based approach where a representative 
Probabilistic Finite State Automata model [PFSA] is derived for 
each trail. Each trail is treated as temporal sequence generated by an 
underlying Markovian process. The process is assumed to be 
Markovian of length D; the current location of each agent is 
influenced only by the past D locations visited by the agent 

The trail clustering is a two-step approach. The first step is a coarse 
clustering stage where each trail's representative PFSA model is 
derived using the D-Markov algorithm [Ray, 2004]. The value of D 
significantly affects the granularity of the analysis. A value of 1 for 
the depth D implies that agents visit the same locations with similar 
frequencies, though not necessarily in the same order. A higher value 
of depth implies that agents are clustered based on visiting locations 
in the same order with similar frequencies. After the models are 
derived, the trails are grouped into coarse clusters where the cluster 
membership is determined based only on the locations that the 
agents visit and not on the frequencies with which these locations are 
visited. The second step of the trail clustering algorithm is cluster 
refinement where hierarchical clustering is performed on each of the 
coarse clusters to form groups of trails where each of the trails visit 
locations with similar visit probabilities. 



777 
 

 

Figure 1 : Trail Clustering Menu in LOOM 

Sometimes it's necessary to look beyond trails which do not visit all 
the same locations but do visit many of them. For this a cluster 
quality index is used. It finds which percentage of locations are 
common amongst the coarse trails. 

A cluster quality of [ 1 ] implies that trails which visit the exact same 
locations are only grouped together into coarse clusters. A cluster 
quality of [ 0.5 ] implies that all the trails in a coarse cluster have at 
least 50% of locations in common. The cluster refining step then 
groups the trails in the coarse cluster based on probability of visiting 
these common locations with similar frequencies. 

The Clustering Tool is integrated into the LOOM Visualization tool. It 
requires two inputs: 

1 : The trail pattern depth for the generation of PFSA. 

2 : The cluster quality. 

Trail clustering allows for the extraction of groups of trails that 
demonstrate similar behavior. [ i.e. visiting the location in the same 
order though not necessarily at the same time ]. LOOM allows 
several different options for these visualizations. 
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Figure 2 : Cluster Visualization Options 

In addition to showing all the trails in each cluster and only the 
longest trail, LOOM also allows the visualization of the longest 
common subsequence amongst all the trails in a cluster. Trails 
belonging to the same cluster will have more sequences of locations 
visited in the same order (not necessarily consecutively) than trails 
belonging to different clusters. The longest common subsequence in a 
cluster depicts the most common behavior pattern amongst the 
agents that led to their being grouped together. The five different 
approaches to visualization of clusters provided by LOOM allows the 
end user different viewpoints of the clustered trails based on the 
analysis requirement. 

Cluster Quality 
First and foremost, it is only concerned with the sequence of 
transitions. It doesn't care when they occurred, only that they 
occurred. Trail depth indicates how many entries in a sequence it 
looks at. 

Assuming trails a->b->a->a->c->d->a->b->c 

Trails depth of two creates the following entries 
(ab)(ba)(aa)(ac)(ad)(da)(bc). Trails depth of three create 
(aba)(baa)(aac)(acd)(cda)(dab)(abc) And so on, and so on. 

Cluster Quality is likely where your issue is with creating clusters. 
With a value of 1.0, it will only return clusters where every sequence 
of entries is exactly the same. Lower that, it gives some wiggle room. 
0.7, you'll get entries that are mostly alike, 0.3, you'll get entries that 
have a number of similar event strings. 
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Loom Events 

 Loom Events Menu 

 

Load Events from File : Load csv file containing two columns 
(date,events) 

 

Group Events By… :  

 

Don't Group : Makes each line correspond to one event. 

 

Day : Each line will correspond to a summation of all events for a 
day 

 

Month : Each line will correspond to a summation of all events for a 
month 

 

Year : Each line will correspond to a summation of all events for a 
year 

 

Show Events : A toggle to show/hide event lines. 

 
 

 

Make Loom Dataset 

Multiple Meta-Networks can be combined into a single Meta-Network 
usable in Loom. 

Pre-Requisites 
To create a dataset usable in Loom it requires multiple Meta-
Networks containing the exact same Nodes/Nodesets/Networks. What 
changes between the multiple Meta-Networks is which Nodes and 
Links are present in each timeslice. 
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NOTE : Every Nodeset needs to contain identical nodes in every 
Nodeset. No exceptions. 

 

What differs is the Networks created from these agent and location 
Nodesets. Below shows the difference between the first three time 
slices of the Star Wars set. Identical characters and locations but 
each network changes as to which characters are listed in individual 
locations. 

Star Wars - Time Slice 1 
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Star Wars - Time Slice 2 

 

Star Wars - Time Slice 3 

 

Creating a DataSet 
Load all Meta-Networks into ORA. Highlight all these Meta-
Networks. Right-Click to bring up the contextual menu. 
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Select Create Dynamic Meta-Network. This brings up the Create 
dialog box. 
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Clear check marks under Import as keyframe from all instance 
except the first. Then click the Create button. 
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Creates Meta-Network with Clock 

 

Now you have a Dynamic Meta-Network that can be viewed in Loom. 
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MGRS Coordinates 

MGRS coordinates consist of an even number of characters. It starts 
off identifying a Grid Zone, and then as more characters are added 
the location becomes more precise. 

To implement, create an Attribute called the Military Grid 
Reference System [MGRS] in your location Node Class. Unlike 
Lat/Lon, it only requires a single attribute. Populate each location 
with it's corresponding MGRS, and so on. Apart from it's separate 
conventions, it operates much the same as the Lat/Lon, in terms of 
adding it to your data. 

NOTE : In terms of Priorities, GIS looks for Lat/Lon data first, then 
attempts to find MGRS. 

Example 
An example of an MGRS coordinate, or grid reference, would be 
4QFJ12345678, which consists of three parts: 

• 4Q (grid zone designator, GZD), 

• FJ (the 100,000-meter square identifier), and 

• 12345678 (numerical location; easting is1234 and northing is 
5678, in this case specifying a location with 10m resolution). 
These map coordinates are read from west to east first 
(easting), then from south to north (northing). 

4QFJ15 is the square occupied by Honolulu. The 1 and 5 are the 
first digits of each of the four-digit combinations. The rest of the 
digits are used as refinement to the location. 
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NOTE : Common mnemonics include in the house, up the stairs, 
left-to-right, bottom-to-top and Read Right Up. 

Image Licensing : Image map of Hawaii licensed under the Creative 
Commons Attribution-Share Alike 3.0 Unported license. 
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Create Lat/Long Data From Shapefile 

 

Select either a Network that does not contain location data or create 
a new Meta-Network. From the Editor main menu select 
Visualizations > GeoSpatial Networks... Using a network with no 
location data will bring up a n Alert telling you no location information 
was detected. Click [ OK ]. 

NOTE : Use the menu item not the dropdown in the button. This 
allows you to open up a Met-Network that does not contain lat/long 
data. 

From the GeoSpatial menu select File > Add GIS data... > Import 
Locations From ESRI Shapefile. This will prompt you to select a 
shapefile. This focuses on the DBF file and its attributes. It find 
attributes with the saubstrings of lat and lon and makes them the 
location coordinate. 

NOTE : The DBF file can be opened in Excel and examined if you are 
curious. 
 
NOTE : If it finds no appropriate attribute ORA will prompt you to 
select one or you can skip and go to the next step. 
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Using the buttons you can either Remove GIS Attribute or Add 
GIS Attribute. 

Add GIS Attribute : Click the Add button. From the dropdown menu 
select one of the four type of GIS data: Latitude_Longitude, 
MGRS, UTM, or Carteesian. Each of the types will ask you to select 
an attribute(s) to use as the GIS data. 

NOTE : This only works if you have an attribute(s) in the correct 
numeric format. If you have no attributes that can be used keep the 
selection at <Select Coordinate type> 

Remove GIS Attribute : This allows you to remove any GIS data 
which is currently in the Meta-Network. 

Click [ Next ] 

Next is Select Location Node Classes and Attributes.  

 

 

Add GIS Data To Meta-Network 

Open file in GeoSpatial Visualizer by selecting Visualizations > 
GeoSpatial Networks.... If there is no Latitude/Longitude data in 
the Meta-Network ORA will inform you there is no location 
information. That's fine, just click [ OK ]. 
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NOTE : How can ORA tell whether location data exists? It looks in the 
attributes for names which contain the substrings lat or lon. If so it 
will post those as possible geospatial attributes. 

The Configure Locations dialog will appear asking you to select 
Nodesets and attributes to use as locations. Ignore this and click 
[ Next ]. A second Configure dialog will appear but you need to 
ignore this box also so click [ Finish ]. An empty GIS map will 
appear. 

From the menu select File > Add GIS Data... > Import locations 
from ERSI ShapeFile. Navigate to the shapefile which contains the 
latitude/longitude data for your network. Your locations will now 
appear on the map. 

NOTE : For this example my Meta-Network contained information on 
the population of states. The ERSI file I used contained the 
latitude/longitude for the U.S. states. Make sure that the ERSI file 
you use contained the lat/lon data for your Meta-Network. 

This procedure will add Nodesets and Networks as needed to your 
Meta-Network. The Nodeset will contain the location data from the 
ERSI ShapeFile  

 

Things To Be Aware Of 
To assure that the latitude and longitude data are properly imported 
into your Meta-Network the Node ID must match the information 
from the ERSI file. If not ORA will not match up the nodes and data 
will not be imported. 

NOTE : For those so inclined this data is retrieved from the 
ShapeFile's DBF file which can be opened with Excel. 
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ORA Measures 

ORA contains over 100 measures.  

What is a Measure 
A measure is a function that takes as input a Meta-Network and 
outputs a single value or a vector of values. Consider the measure 
Density. The output for this measure is a single number used to 
analyze an organization. By default, all measures are run on a Meta-
Network. To view which measures are available, go to the Tools 
menu and select the Measures Manager. 

ORA Measures Manager 
The Measures Manager categorizes measures in the following 
ways: Entity Level, Graph Level, and Risk Category. 

Entity Level Measure is one that is defined 
for, and gives a value for, each entity in a 
network. If there are x nodes in a 
network, then the metric is calculated x 
once each for each node. 

Examples are Degree Centrality, Betweenness, and Cognitive 
Demand. 

Graph Level Measure is one that is defined 
for, and gives a value for, the network as a 
whole. The metric is calculated once for 
the network. 

Examples are Centralization, Graph Hierarchy, and the 
maximum or average Betweenness 

Some reports use a predefined set of measures, and these are not 
affected by the Measure Manager selections (for example, the 
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Intel, Context, Located SubGroups, Sphere of Influence, and 
Immediate Impact reports). The Risk Report, however, uses 
only the measures selected in the Measure Manager. 

The following sets of entities (with their abbreviated symbol) are 
used throughout the document: Agent (A), Knowledge (K), 
Resource (R), and Task (T). The following networks defined on 
these entity sets are used throughout the documentation. 

 

Symbol Entity Sets Name 

 U V   

AA Agent Agent Communication Network 

AK Agent Knowledge Knowledge Network 

AR Agent Resource Capabilities Network 

AT Agent Task Assignment Network 

KK Knowledge Knowledge Information Network 

KR Knowledge Resource Training Network 

KT Knowledge Task Knowledge Requirement Network 

RR Resource Resource Resource Substitute Network 

RT Resource Task Resource Requirement Network 

TT Task Task Precedence Network 

Input: 
This lists each of the Networks that are required as input to the 
measure. If a measure takes as input a specific network from the 
Meta-Network, such as the Agent x Knowledge (AK) matrix, 
then it is listed. If the measure runs on any square (unimodal) 
network then N is given. A measure can require more than one 
input matrix. 

1. Each input matrix can have one or 
more of the following requirements:  
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a. square: the matrix must have 
the same number of rows as 
columns 

b. binary: it must be binary data 
(i.e. any links in the network are 
assumed to have a weight of one) 

c. symmetric: the network must be 
undirected 

2. ORA does the following when a 
network does not meet one or more of 
the above requirements: 

a. square: measure is not 
computed 

b. binary: measure is computed, 
and edge weights are ignored (all 
edges are given value one) 

c. symmetric: measure is computed, 
and the matrix is first symmetrized 
using the union method 

A complete list of all measures available in ORA, along with 
references, input and output specifications, can be found in the 
following ORA Measures sections. 

Significant digits 
By default ORA shows only three significant digits after the decimal 
place. With very large networks it is not uncommon for various 
measures, e.g. closeness to be quite small. As such, with only 
three significant digits after the decimal place they will appear as 
zero. 

You can change the number of decimal places reported by setting 
your ORA preferences. From the main menu select Preferences > 
All preferences.... In the Ora Preferences dialogue box that 
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opens: Select Reports in tree on the left then select the 
Formatting tab. Set Decimal precision dial widget to the 
precision you want. 
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Measures Content Page 

Significant Digits 
By default ORA shows only three significant digits after the decimal 
place. With very large networks it is not uncommon for various 
measures, e.g. closeness to be quite small. As such, with only three 
significant digits after the decimal place they will appear as zero. 

You can change the number of decimal places reported by setting 
your ORA preferences. From the main menu select Preferences > 
All preferences.... In the Ora Preferences dialogue box that 
opens: Select Reports in tree on the left then select the Formatting 
tab. Set Decimal precision dial widget to the precision you want. 

Link Weight as Distance vs. Strength 
ORA defaults using link weights as distance so a larger link weight 
equals a farther distance. But in some instances you need to use link 
weights with closeness centrality and betweenness centrality to 
reflect that the relationship is stronger and the path shorter. This is 
different than the default calculation which treats weights as distance 
for closeness and betweenness. 

As a general rule, can one simply use the convert links option in the 
matrix editor pane and invert the link weights in a matrix for those 
two centrality measures? 

Network vs. Node Level Results 
The Network Level measures in ORA are measures that output 
scalar values. The Agent/Knowledge/Task level measures, by 
contrast, produce vector output (one value per node) and that is why 
one must select individual nodes to get a line chart. For example the 
Betweenness Centralization measure produces a single value per 
network, and it measures (roughly) the variance of the Betweenness 
Centrality measure values across all the nodes. All of then 
Centralization measures are like this. 
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Mode Table 

2-Mode Measures 
Quantity : Quantity measures count or average the entries of a 
matrix. 

Degree - Counting the row or column entries of a two mode 
network. 

Level: Node 
Reference: Freeman (1979), Wasserman and Faust (1994), Borgatti and 
Everett (1997) 
Current ORA measures: columnDegreeCentrality, inDegreeCentrality, 
outDegreeCentrality, row-DegreeCentrality, columnCount, rowCount, 
edgeCount, capability 

Load-On network level, a single value for the entire network is 
calculated through averaging link values. 

Level: Network 
Reference: Carley (2002) 
Current ORA measures: knowledgeLoad, resourceLoad, density, 
rowBreadth, columnBreadth. 

Variance : Variance measures create network level indices that 
describe the distribution of connections in networks. 

Centralization - On way to describe the variance in a network is 
through calculating network centralizations based on the results of 

centrality measures. 

Level: Network 
Reference: Freeman (1979) 
Current ORA measures: columnDegreeCentralization, 
inDegreeCentralization, outDegreeCentralization, rowDegreeCentralization 

Diversity - Diversity is a group measure and results in a single 
value for the whole network. 

Level: Network 
Reference: Hirschman (1945) 
Current ORA measures: knowledgeDiversity, resourceDiversity 
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Correlation : Correlation measures create a matrix A that describe 
similarities/dissimilarities between all pair of agents. 

Similarity - The degree of similarity between two agents based on 
shared knowledge. 

Level: Node 
Reference: Carley (2002) 
Current ORA measures: relativeCognitiveSimilarity, cognitiveSimilarity, 
relativeSimilarity, correlationSimilarity 

Distinctiveness - Measures the degree to which each pair of agents 
(i; j) has complementary knowledge, expressed as the percentage 

of total knowledge. 

Level: Dyad 
Reference: Carley (2002) 
Current ORA measures: relativeCognitiveDistinctiveness, 
cognitiveDistinctiveness, correlationDistinctiveness 

Resemblance - Measures the degree to which each pair of agents 
has the exact same knowledge. 

Level: Dyad 
Reference: Carley (2002) 
Current ORA measures: relativeCognitiveResemblance, 
cognitiveResemblance, correlationResemblance 

Expertise - The degree of dissimilarity between agents based on 
shared knowledge. Each agent computes to what degree the other 

agents know what they do not know. 

Level: Node 
Reference: Carley (2002) 
Current ORA measures: relativeCognitiveExpertise, cognitiveExpertise, 
relativeExpertise, correlationExpertise 

Specialization : These measures identify agents that have either 
exclusive or redundant connections to other node class entities. 

Exclusivity - Detects agents who are exclusively connected to 
elements of other node classes. 

Level: Node 
Reference: Ashworth and Carley (2006) 
Current ORA measures: knowledgeExclusivity, resourceExclusivity, 
taskExclusivity, exclusivityComplete, exclusivity 
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Redundancy - Knowledge is redundant if there are di 
erent agents sharing the same knowledge. 

Level: Network 
Reference: Carley (2002) 
Current ORA measures: columnRedundancy, rowRedundancy, 
knowledgeRedundancy, accessRedundancy, resourceRedundancy, 
assignmentRedundancy 

Access - An access index identifes connections to critical 
knowledge, resources, etc. 

,td>Level: Node 
Reference: Ashworth and Carley (2006) 
Current ORA measures: knowledgeAccessIndex, resourceAccessIndex 

Multi-Mode Measures 
Quantity :  

Degree - Total number of people reporting to an agent, plus its total 
knowledge, resources, and tasks can be considered as Personnel 

Costs. 

Level: Network 
Reference: Wasserman and Faust (1994) 
Current ORA measures: complexity 

Coherence : Coherence measures analyze to what extent 
requirements are accomplished by the actual allocation of agents to 
tasks. 

Congruence - Measures the similarity between what Knowledge is 
assigned to tasks via agents, and what Knowledge is required to do 

Tasks. Perfect congruence occurs when Agents have Knowledge 
when and only when it is needful to complete their Tasks. 

Level: Network 
Reference: Carley (2002) 
Current ORA measures: communicationCongruence, 
knowledgeCongruence, resourceCongruence, socialTechnicalCongruence (2 
mode) 

Needs - Task Knowledge Needs compares the Knowledge 
requirements of each Task with the Knowledge available to the 

Task via Agents assigned to it. 
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Level: Node, Network 
Reference:Lee and Carley (2004) 
Current ORA measures: communicativeNeeds (communication), 
congruenceAgentKnowledgeNeeds, congruenceOrgAgentKnowledgeNeeds, 
congruenceOrgTaskKnowledgeNeeds, congruenceTaskKnowledgeNeeds, 
congruenceAgentResourceNeeds, congruenceOrgAgentResourceNeeds, 
congruenceOrgTaskResourceNeeds, congruenceTaskResourceNeeds, 
knowledgeUnderSupply, resourceUnderSupply 

Waste - Waste measures focus on the missing part of congruence. 
Level: Node, Network 
Reference: Lee and Carley (2004) 
Current ORA measures: congruenceAgentKnowledgeWaste, 
congruenceOrgAgentKnowledgeWaste, 
congruenceOrgTaskKnowledgeWaste, congruenceTaskKnowledgeWaste, 
congruenceAgentResourceWaste, congruenceOrgAgentResourceWaste, 
congruenceOrgTaskResourceWaste, congruenceTaskResourceWaste 

Performance - Knowledge Based Task Completion calculated the 
percentage of tasks that can be completed by the agents assigned 

to them, based solely on whether the agents have the requisite 
Knowledge to do the Tasks. 

Level: Network 
Reference: Carley (2002) 
Current ORA measures: resourceTaskCompletion, overallTaskCompletion, 
knowledgeTaskCompletion, performanceAsAccuracy 

Workload - Workload measures look for the Knowledge or Resource 
an Agent uses to perform Tasks to which it is assigned. 

Level: Node 
Reference: Carley (2002) 
Current ORA measures: knowledgeActualWorkload, 
resourceActualWorkload, actualWorkload, knowledgePotentialWorkload, 
resourcePotentialWorkload, potentialWorkload 

Substitution : This group is rather diverse and include concepts and 
measures describing to which extent Agents can be substituted base 
on identical Roles or Agents need to negotiate with each other as well 
as Knowledge and Resources that is used or reused to perform Tasks. 

Availability - Availability measures use the node class Roles. Role 
Based Knowledge Availability computes the number of roles that an 

agent is qualiied to have based on knowledge requirements. 
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Level: Network 
Reference: Behrman 
Current ORA measures: roleKnowledgeAvailability, 
roleResourceAvailability, knowledgeBasedRoleAvailability, 
organizationalAvailability, resourceBasedRoleAvailability, 
overallRoleAvailability 

Reuse - Knowledge utilization can be calculated with Reuse 
measures of Knowledge or Resources. 

Level: Network 
Reference: Carley et al. (2000) 
Current ORA measures: knowledgeOmega, resourceOmega 

Negotiation - The extent to which Agents need to negotiate with 
each other because they lack the Knowledge to complete their 

assigned Tasks. 

Level: Network 
Reference: Carley (2002) 
Current ORA measures: knowledgeNegotiation, resourceNegotiation 

Control : Control measures are the most complex measures as they 
combine a couple of calculations into a single measure. Control 
measures describe to which extent an Agent is either important 
(central) for an entire meta-network or Agents have similar 
perspectives of the network. 

Demand - Cognitive Demand measures total amount of cognitive 
effort expended by each agent to communicate, performs its tasks, 

etc. 
Level: Node 
Reference: Carley (2002) 
Current ORA measures: cognitiveDemand 

Awareness - A dyadic cognitive concept is Awareness. Share 
Situation Awareness measures the degree to which an Agents as 
similar, based on social interaction, physical distance, and socio-

demographic data. 

Level: Node, Dyad 
Reference: Graham et al. (2004) 
Current ORA measures: sharedSituationAwareness 
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Computational Speeds 

Measure Speeds 
Slow : These measures do geodesic computations or multiple 
matric multiplcations. 
e,g, Betweenness measures, Closeness measures, and 
Relative Cognitive measures. 

Medium : These multiply matrices 
e.g. Cognitive Demand, Congruence measures, and 
Workload measures. 

Fast : Are usually measures that basically count very fast  
e.g. In-Degree Centrality, Row and Columns Count, and 
Capability . 

 

 

Fast Measures 

Measure Level Uses Link Weights 

Access Redundancy Network False 

Agent Socio Economic Power Node False 

Assignment Redundancy Network False 

Burt Effective Network Size Node True 

Capability Node True 

Classic SNA Density Network False 

Column Breadth Network False 

Column Count Network False 

Column Degree Centrality Node True 

Column Redundancy Network False 

Complexity Network False 

Density Network False 
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Diagonal Node True 

Efficiency Network False 

Exclusivity Node False 

Exclusivity Complete Node False 

Gini Means Difference Column Node True 

In-Degree Centrality Node True 

In-Degree Network Centralization Network True 

Interdependence Network False 

Interlockers Node False 

Isolate Count Network False 

Knowledge Based Access Index Node False 

Knowledge Diversity Network False 

Knowledge, Exclusivity Node False 

Knowledge Load Network False 

Knowledge Redundancy Network False 

Lateral Link Count Network False 

Link Count Network False 

Node Count Network False 

Out-Degree Centrality Node True 

Out-Degree Network Centralization Network True 

Personnel Cost Node False 

Pooled Link Count Network False 

Radials Node False 

Reciprocal Link Count Network False 

Resource Based Access Index Node False 

Resource Diversity Network False 

Resource Exclusivity Node False 

Resource Load Network False 

Resource Redundancy Network False 
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Row Breadth Network False 

Row Count Network False 

Row Degree Centrality Node True 

Row Redundancy Network False 

Sequential Link Count Network False 

Span of Control Network False 

Task Exclusivity Node False 

Total Degree Centrality Node True 

Total Degree Network Centralization Network False 
 

 

 

Medium Measures 

Measure Level Uses Link 
Weights 

Actual Workload Node False 

Agent Knowledge Needs Congruence Node False 

Agent Knowledge Waste Congruence Node False 

Agent Resource Needs Congruence Node False 

Agent Resource Waste Congruence Node False 

Authority Centrality Node True 

Average Distance Network True 

Average Speed Network True 

Bonacich Power Centrality Node True 

Boundary Spanner Node False 

Burt Constraint Node True 

Cognitive Demand Node False 

Communication Node False 



804 
 

Communication Congruence Network False 

Connectedness Network False 

Diameter Network True 

Eigenvector Per Component Centrality Node True 

Fragmentation Network False 

Geodesic Distance Dyad False 

Hub Centrality Node True 

Knowledge Actual Workload Node False 

Knowledge Negogiation Network True 

Knowledge Omega Network False 

Knowledge Potential Workload Node False 

Knowledge Based Task Completion Network False 

Knowledge Under Supply Network False 

Minimum Speed Network True 

Network Levels Network True 

Organization Agent Knowledge Needs 
Congruence Network False 

Organization Agent Knowledge Waste 
Congruence Network False 

Organization Agent Resource Needs 
Congruence Network False 

Organization Agent Resource Waste 
Congruence Network False 

Organization Task Knowledge Need 
Congruence Network False 

Organization Task Knowledge Waste 
Congruence Network False 

Organization Task Knowledge Need 
Congruence Network False 

Organization Task Knowledge Waste 
Congruence Network False 
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Overall Task Completion Network False 

Performance As Accuracy Network False 

Potential Workload Node False 

Relative Expertise Node False 

Relative Similarity Node False 

Resource Actual Workload Node False 

Resource Negiogiation Network False 

Resource Potential Workload Node False 

Resource Based Task Completion Network False 

Resource Under Supply Network False 

Shared Situation Awareness Node, Dyad False 

Simmelian Ties Node False 

Skip Link Count Network False 

Social Technical Congruence Network, 
Dyad False 

Strict Knowledge Congruence Network False 

Strict Resource Congruence Network False 

Strong Component Count Network False 

Task Knowledge Needs Congruence Node False 

Task Knowledge Waste Congruence Node False 

Task Resource Needs Congruence Node False 

Task Resource Waste Congruence Node False 

Transitivity Network False 

Triad Count Node False 

Weak Component Count Network False 

Weak Component Members Node False 
 

 

Slow Measures 
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Measure Level Uses Link 
Weights 

Betweenness Centrality Node True 

Betweenness Centrality Spatial Node True 

Betweenness Network 
Centralization Network True 

Clique Count Node False 

Closeness Centrality Node True 

Closeness Network Centralization Network True 

Closeness Centrality Spatial Node True 

Clustering Coefficient Density Network, 
Node False 

Cognitive Distrinctiveness Node, Dyad False 

Cognitive Expertise Node, Dyad False 

Cognitive Resemblance Node, Dyad False 

Cognitive Similarity Node, Dyad False 

Degree Centrality Spatial Node True 

Diffusion Network False 

Distinctiveness Correlation Node, Dyad False 

Eigenvector Centrality Spatial Node True 

Expertise Correlation Node, Dyad False 

Global Efficiency Network False 

Hierarchy Network False 

In-Closeness Centrality Node True 

In-Closess Network Centralization Network True 

Information Centrality Node True 

Inverse Closeness Centrality Node True 

Local Efficiency Network False 

Location Relevance Node True 

Potential Boundary Spanner Node False 
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Relative Cognitive Distinctiveness Dyad False 

Relative Cognitive Expertise Dyad False 

Relative Cognitive Resemblance Dyad False 

Relative Cognitive Similarity Dyad False 

Resemblance Correlation Node, Dyad False 

Resource Omega Network False 

Role Based Knowledge Availability Node False 

Role Resource Availability Node False 

Similarity Correlation Node, Dyad False 

Upper Boundedness Network False 
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Access Redundancy 

 

Description 
Average number of redundant agents per resource. An agent is 
redundant if there is already an agent that has access to the 
resource. 

NOTE : This measure works on the Agent x Resource matrix and 
needs to be in the binary format [ 0 or 1 ]. 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. "Summary of Key Network Measures for 

Characterizing Organizational Architectures." Unpublished 
Document: CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : ℜ ∈[0,(|A|-1*|R|]. 

Computational Time 
Fast 

Input and Output 
Input :  
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Network Data Type 

Agent by Resource Binary 

Output :  

 

Level Data Type 

Graph Real 

 

This is the Column Redundancy of matrix AR. 

 

 

Actual Workload 

 

Description 
The knowledge and resources an agent uses to perform the tasks to 
which it is assigned. Individuals or organizations that are high in 
workload are those that are doing more complex tasks and have the 
resources and knowledge or expertise to do those tasks. Tasks are 
more complex if they require more expertise and/or more resources. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Resource, Agent x Task, Knowledge x Task, Resource x Task 
and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, employees have access to certain knowledge 
(e.g., fix computers) and resources (e.g., computer parts). This 
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measure would compute a value to reflect the overall level of 
organizational access within the network.  

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. "Summary of Key Network Measures for 

Characterizing Organizational Architectures." Unpublished 
Document: CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Agent by Resource Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Resource by Task Binary 
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Output :  

 

Level Type Data Type 
Node Level Agent Real 

Actual Workload for agent i is defined as follows: 

 

 

 

Agent Knowledge Needs Congruence 

 

Description 
The number of knowledge that an agent lacks to complete its 
assigned tasks expressed as a percentage of the total knowledge 
required for the assigned tasks. 

Works primarily on the Agent x Knowledge matrix and also uses 
those two Node Classes working with the task Node Class. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, and Knowledge x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
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Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 

 

Agent Knowledge Needs compares the knowledge needs of the 
agent to do its assigned tasks, with the actual knowledge of the 
agent. 

Let N = AT*KT' = knowledge needed by agents to do 
assigned tasks. 



813 
 

for Resource replace KT with RT 

We need to sum the knowledge needed but not available. 

Then, Agent Knowledge Needs for 

 

Agent Resource Needs is analogous, replacing AK with AR, and 
KT with RT. 

 

 

Agent Knowledge Waste Congruence 

 

Description 
The number of knowledges that an agent has that are not needed by 
any of its tasks expressed as a percentage of the total knowledge of 
the agent. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, and Knowledge x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
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Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 

 

Agent Knowledge Waste compares the knowledge of the agent with 
the knowledge it actually needs to do its tasks. Any unused 
knowledge is considered wasted. 
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Let N = AT*KT' = knowledge needed by an agent to do its 
assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge the agent has but which is not 
needed. 

Then, Agent Knowledge Waste for 

 

The equation for Agent Resource Waste replaces AK with AR, 
and KT with RT. 

 

 

Agent Resource Needs Congruence 

 

Description 
The number of resources that an agent lacks to complete its assigned 
tasks expressed as a percentage of the total resources required for 
the assigned tasks. 

NOTE : This measure works on the Agent x Resource, Agent x 
Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 
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Agent Knowledge Needs compares the knowledge needs of the 
agent to do its assigned tasks, with the actual knowledge of the 
agent. 

Let N = AT*KT' = knowledge needed by agents to do 
assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge needed but not available. 

Then, Agent Knowledge Needs for 

 

Agent Resource Needs is analogous, replacing AK with AR, 
and KT with RT. 

 

Agent Resource Waste Congruence 

 

Description 
The number of resources that an agent has that are not needed by 
any of its tasks expressed as a percentage of the total resources of 
the agent. 

NOTE : This measure works on the Agent x Resource, Agent x 
Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 
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Agent Knowledge Waste compares the knowledge of the agent 
with the knowledge it actually needs to do its tasks. Any unused 
knowledge is considered wasted. 

Let N = AT*KT' = knowledge needed by an agent to do its 
assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge the agent has but which is not 
needed. 

Then, Agent Knowledge Waste for 

 

The equation for Agent Resource Waste replaces AK with AR, 
and KT with RT. 

 

 

Agent Socio Economic Power 

 

Description 
A measure of actor power based on access to knowledge, resources, 
and tasks in the organization. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Resource, and Agent x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Example 
An individual within an organization that has the most connections, 
hence access, to knowledge (special skills), resources (unlimited 
funding) and tasks (has the most important tasks). Such an agent 
would rank high in the SocioEconomic Power measure. 

Informal Name 
None 

Citation 
Kathleen M. Carley, 2004 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Agent by Resource Binary 

Agent by Task Binary 
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Output :  

 

Level Data Type Type 
Node Real Agent 

 

Let N = [AK AR AT], that is, the concatenation of the input 
matrices. 

Then, Agent Socio Economic Power is the row degree centrality 
of N. 

 

 

Assignment Redundancy 

 

Description 
Average number of redundant agents assigned to tasks. An agent is 
redundant if there is already an agent assigned to the task. 

NOTE : This measure works on the Agent x Task matrix. 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : ℜ ∈[0,(|A|-1*T] 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 

Agent by Task Binary 

Output :  

 

Level Data Type 

Graph Real 

 

This is the Column Redundancy of matrix AT. 
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Authority Centrality 

 

 

Description 
A node is authority-central to the extent that its in-links are from 
nodes that have many out-links. Individuals or organizations that act 
as authorities are receiving information from a wide range of others 
each of whom sends information to a large number of others. 
Technically, an agent is authority-central if its in-links are from 
agents that have are sending links to many others. The scientific 
name of this measure is authority centrality and it is calculated on 
agent by agent matrices. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc]. 

Informal Name 
None 

Citation 
Kleinberg, Jon M. (1998). Authoritative sources in a hyperlinked 
environment. Paper presented at the SODA '98 Ninth Annual ACM-
SIAM Symposium on Discrete Algorithms, San Francisco, CA. Latria 
and Marchiori, 2001 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Square Real 

 

Output :  

 

Level Data Type 

Node Real 
 

 

 

Average Communication Speed 

 

Description 
The average speed with which any two nodes can interact. This is 
based on the inverse of the shortest path lengths between node 
pairs. 

NOTE : This measure works Square Matrices [i.e. Agent x Agent, 
Location x Location, etc.] and needs to be in the binary format [ 0 or 
1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Example 
In an organization that any two individuals have an average of 3.4 
connections between them would approximate the average speed at 
which an a communication might spread throughout the organization. 
Naturally, the lower the average links, the higher the organizational 
speed. 

 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Square Real 
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Output :  

 

Level Data Type 
Graph Real 

 

Average Speed is the average of the Inverse Closeness 
Centrality for the network entities. 

 

 

Betweenness Centrality 

 

Description 
The Betweenness Centrality of node v in a network is defined as: 
across all node pairs that have a shortest path containing v, the 
percentage that pass through v. Individuals or organizations that are 
potentially influential are positioned to broker connections between 
groups and to bring to bear the influence of one group on another or 
serve as a gatekeeper between groups. This agent occurs on 
many of the shortest paths between other agents. The scientific 
name of this measure is betweenness centrality and it is calculated 
on agent by agent matrices. 

NOTE : This measure works Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 
1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
This measure indicates the extent that an individual is a broker of 
indirect connections among all others in a network. Someone with 
high Betweenness could be thought of as a gatekeeper of information 
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flow. People that occur on many shortest paths among other People 
have highest Betweenness value. Betweenness is one of the key 
measures used by those interested in networks. 

Informal Name 
None 

Citation 
Freeman, Linton C. (1979). Centrality in social networks I: 
Conceptual clarification. Social Networks, 1(3), 215-239. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type<  
Square Real 

 

Name Data Type Label<  

Radius RealNeighbor Radius   
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Output :  

 

Level Data Type 
Node Real 

Let G=(V,E) be the graph representation for the network. Let 
n=|V|, and fix an entity . 

For , let be the number of geodesics in G 
from u to w. 

If , then set . 

Define the following: 

let 

 

let  

Then Betweenness Centrality of the entity 
.  

NOTE : If G is not symmetric, then between is normalized by (n-
1)(n-2). 
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Betweenness Network Centralization 

 

Description 
Network centralization based on the betweenness score for each node 
in a square network. This measure is defined for directed and 
undirected networks. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Freeman, Linton C. (1979). Centrality in social networks I: 
Conceptual clarification. Social Networks, 1(3), 215-239. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 
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Input and Output 
Input :  

 

Network Data Type 

Square Binary 

Output :  

 

Level Data Type 
Node Real 

 

Let G=(V,E) represent the square network, and let n = |V| 

let di = Betweenness Centrality of node i 

let d = max{di | 1 < i < n } 

Then Network Betweenness Cent. = . 
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Biological Diversity Index 

 

Description 
The mathematical knowledge that helps is that the log of a product is 
the sum of the logs, e.g. ln(4!) = ln(1)+ln(2)+ln(3)+ln(4). 
Otherwise it is impossible to calculate the index for larger data. So, 
the implementation is just simple loops:  

Informal Name 
None 

Citation 
Anne E. Magurran, Measuring Biological Diversity. Wiley-Blackwell, 
2003. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

float brillouin=0; 

for (int i=1; i<=N; i++) 

brillouin = brillouin + log(i); 

  

for (int s=1; s<=number_of_groups; s++) 
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for (int i=1; i<=n[s]; i++) 

brillouin = brillouin - log(i); 

brillouin = brillouin / N 

[ln(N!) - ∑ ln(ni!)] / N where ni is the number of elements in a 
specific group and N is the sum of all ni. 

An issue of the Brillouin index is the lack of normalization, so there is 
no defined value range. The idea is that larger environments are 
more diverse even if the distribution of the elements is the same. 
Nevertheless the results look always similar because of the /N. 

Input and Output 
Input :  

 

Data Type 
Binary 

Output :  

 

A Single Value Showing Distribution 
 

 

 

Bonacich Power Centrality 

 

Description 
The Bonacich Power Centrality computes the centrality of each entity 
based on the centrality of its neighbors. Beta should be chosen such 
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that its absolute value is less than the reciprocal of the larges 
eigenvalue of N. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, this meausre can tell us who is connected to 
the most powerful (e.g., other highly connected agents) people. 

Informal Name 
None 

Citation 
Bonacich P., 1987 "Factoring and weighing approaches to clique 
identification" Journal of Mathematical Sociology, 2 (January, 1972), 
113-120. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 
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Input and Output 
Input :  

 

Network Data Type Directed 
Square Real No 

 

Output :  

 

Level Data Type 

Node Real 

 

Let A = adjacency representation of the network N. Then 
Bonacich Power Centrality for the network is the solution c to the 
following system of linear equations: 

, where I is the identity matrix, and e a vector 
of ones. 

NOTE : If beta is 0, then c is simply equal to the row degree of each 
entity. 

The values of c are not normalized. 
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Boundary Spanner 

 

Informal Name 
None 

Citation 
Cormen, Leiserson, Rivest, Stein 2001. "Introduction to Algorithms" 
Second Edition. Cambridge, MA: MIT Press, 2001. 

Minimum and Maximum Values 
Minimum : 0 

Maximum : 1 

Description 
An node which, if removed from a network, creates a new 
component. 

This is often called a Gate Keeper node. It consists of High 
Betweeness and Low Centrality. A Boundary Spanner is an 
articulation point of N, as defined in the referenced book. 

Example : An employee with few direct connections, but if removed 
from the network will result in an unconnected sub-group. 

Input :  

Agent by Agent : DataType=binary and Direction=No. 

Output 

Node Level : DataType=Binary. 
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A Boundary Spanner is an articulation point of N, as defined in the 
referenced book. 

 

 

Burt Constraint 

 

Description 
The degree to which each node in a square network is constrained 
from acting because of its existing links to other nodes. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Bob is given a certain task, but that task requires certain links, which 
Bob does not have. Bob is constrained in the sense he does not have 
the links to complete the task. This measure computes a value for 
such relationships as they distributed across the whole network. 

Informal Name 
None 

Citation 
Burt, Ronald. Structural Holes: The Social Structures of Competition. 
Cambridge, MA: Harvard University Press, 1992. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 



837 
 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Square Real 

Output :  

 

Level Data Type 
Node Real 

 

This is the Constraint measure described by Equ. 2.4 on pg. 55 
of Burt, 1992. 

NOTE : The matrix Z is the adjacency matrix representation of the 
network N. 

 

 

Capability 

 

Description 
Detects entities with high or low degree relative to other entities. The 
formula discounts for the fact that most agents have some 
connections and assumes that there is a general discount to having 
large numbers of connections. 
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NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Kathleen M. Carley, Dave Columbus, Matthew DeReno, Jeff Reminga 
and Il-Chul Moon, 2007, "ORA User's Guide 2007," Carnegie Mellon 
University, School of Computer Science, Institute for Software 
Research, Technical Report, CMU-ISRI-07-115. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 
Real 

Output :  

 

Level Data Type Type 
Node Real Row 
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Let RD = the vector of row degrees for each entity in the 
network. Scale RD by dividing each element by the largest value 
in RD. 

Then the Capability of node i is:  

NOTE : For the most connected entity, this value tends to 1.0, for 
the least connected node it tends to 0, and for the average connected 
entity it tends to 0.5. 

 

 

Characteristic Path Length 

 

Description 
The average shortest path length between nodes, excluding infinite 
distances. 

Example 
In a given organization, this measure computes the average amount 
of connections between any two members in the organization. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and N ], inclusive. 

Informal Name 
None 
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Citation 
NetStat 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Square Real 

Output :  

 

Level Data Type 

Graph Real 

 

Let G=(V,E) represent a square network. Define a set S of all 
pairs (i,j) of entities such that i can reach j. Then average the 
shortest paths. 

let S = {(i,j) | j is reachable in G from j } 

Then, 
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Closeness Centrality 

 

Description 
The average closeness of a node to the other nodes in a network. 
Closeness is the inverse of the average distance in the network 
between the node and all other nodes. 

Closeness reveals how long it takes information to spread from one 
individual to others in the network. High scoring individuals in 
Closeness have the shortest paths to all others in the network. It 
would follow such individuals could monitor the information flow in an 
organization better than most others that have a lesser Closeness 
value. The ones with the highest value in this measure will often 
times have the best picture of what is happening in the network as a 
whole. 

In short, Closeness is the inverse of the average distance in the 
network between any given node and all other nodes. 

NOTE : This measure uses both link weights and link direction in its 
calculations. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Closeness reveals so-called people in the know. Closeness measures 
the path length from one person to another in a network. It tells us 
which person is central to an organization. 
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Informal Name 
None 

Citation 
Freeman, L.C. (1979). "Centrality in Social Networks I: Conceptual 
Clarification." Social Networks, 1, 215-239. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input :  

Input and Output 
Input :  

 

Network Data Type 
Square Real 

Output :  

 

Level Data Type 

Node Real 

Let G=(V,E) be the graph representation of the square network. 

Fix 
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let 

 

if i is unreachable from v. 

Then Closeness Centrality of node . 

 

 

Closeness Network Centralization 

 

Description 
Network centralization based on the closeness centrality of each node 
in a square network. This is defined only for connected, undirected 
networks. 

Example 
An organization has employees, computers, benchmarks, and 
products. How central these entities exist within the connections of 
the network, which is defined by the connections they have 
throughout the network, is loosely what is network centralization. 
This measure computes a value for the centrality of these entities. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 
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Citation 
Freeman, L.C. (1979). Centrality in Social Networks I: Conceptual 
Clarification. Social Networks, 1, 215-239. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Square Real 

Output :  

 

Level Data Type 
Graph Real 

 

(if N connected) 

Let G=(V,E) represent the square network, and let n = |V| 

let 

 

let 
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Then 

 

 

 

Clustering Coefficient 

 

Description 
Measures the degree of clustering in a network by averaging the 
clustering coefficient of each node, which is defined as the density of 
the node's ego network. 

The clustering coefficient gives a sense of the local characteristics of 
the network--how information spreads by means of employee groups. 
A higher clustering coefficient supports local information diffusion as 
well as a decentralized infrastructure because employees are likely to 
share information and know what is happening in their work group. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
The average of the proportion of links between each employee and 
his or her direct neighbors divided by the number of links that could 
possibly exist between them. 
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Informal Name 
None 

Citation 
Watts DJ, Strogatz SH "Collective dynamics of 'small-world' 
networks" NATURE 393 (6684): 440-442 JUN 4 1998.  

Minimum and Maximum Values 
Values for both Graph Level and Node Level 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 

Node Real 

Graph Real 

Graph Level:  

Entity Level:  
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let G=(V,E) be the graph representation of a square network. 

Define for each node its Clustering Coefficient :  

let Gv = ego network of entity v 

Then Clustering Coefficient for entity: 

 

Then Clustering Coefficient for graph: 

 

 

 

Cognitive Demand 

 

Description 
Measures the total amount of cognitive effort expended by each 
agent to do its tasks, need to move, connecting others, and so on. 
Such individuals may never become the formal leader of a group. 
Emergent leaders are identified in terms of the amount of cognitive 
effort that is inferred to be expended based on the individual's 
position in the meta-network. Individuals who are strong emergent 
leaders are likely to be not just connected to many people, 
organizations, tasks, events, areas of expertise, and resources; but 
also, are engaged in complex tasks where they may not have all the 
needed resources or knowledge and so have to coordinate with 
others, or have other reasons why they need to coordinate or share 
data or resources. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
Emergent Leader 

Citation 
Carley, Kathleen M. & Yuqing Ren, 2001, "Tradeoffs Between 
Performance and Adaptability for C3I Architectures." In Proceedings 
of the 2001 Command and Control Research and Technology 
Symposium, Annapolis, Maryland, June, 2001. 

Carley, 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Agent Binary 

Output :  

 

Level Type Data Type 
Node Agent Real 
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The Cognitive Demand for an agent i is an average of terms, 
each of which measures an aspect of its cognitive demand. Each 
term is normalized to be in [0,1]. The number of terms depends 
on the input networks. The computation of each term for agent i 
is detailed below: 

x1 = normailzed count of all agents with which agent i interacts. 

 

x2 = normalized count of tasks to which i is assigned 

 

x3 = normalized sum of agents assigned to the same tasks as i  

 

x4 = normalized count of resources managed by i 

 

x5 = normalized count of total knowledge known by i 

 

x6 = normalized sum resources needed by i for all of its tasks 
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x7 = normalized sum of knowledge i needs for all its tasks 

 

x8 = normalized sum of resource negotiation needs i has for its 
tasks 

 

x9 = normalized sum of knowledge negotiation needs 

 

x10 = normalized sum of agents that i depends on or that 
depend on i 

w = colsum([AT]) 

s = (T+T')•w 

v = [AT]•s 

 

Then Cognitive Demand for agent i is the average of the above 
terms. 
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Cognitive Distinctiveness 

 

Description 
Measures the degree to which each pair of agents has 
complementary knowledge, expressed as the percent of total 
knowledge. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 
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Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 
Node Real Agent 

Dyad Real Agent by Agent 

 

For each pair of agents (i,j) compute the number of knowledge 
bits they have exactly opposite. Then normalize this sum by the 
total number of knowledge bits. In effect, this is the exclusive-
OR of their knowledge vectors. 

 

NOTE : The CD output matrix is symmetric. 
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Cognitive Expertise 

 

Description 
Measures the degree to which each pair of agents has 
complementary knowledge, expressed as a percentage of the 
knowledge of the first agent. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
If one person in an organization knows how do perform X but can't do 
Y. Whereas another individual can do Y but not X, such individuals 
would rank highly in this measure. 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 
Node Real Agent 

Dyad Real Agent by Agent 

 

For each pair of agents (i,j) compute the number of knowledge 
bits that j knows that i does not know. Then normalize this sum 
by the total number of knowledge bits that agent i does not 
know. 

 

NOTE : The CD output matrix is NOT-symmetric. 
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Cognitive Resemblance 

 

Description 
Measures the degree to which each pair of agents has the exact same 
knowledge. Each value is normalized by the row sum. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In an given organizational network, let us say that Bob has the 
knowledge to perform X, Y, and Z. Whereas Sally also has the 
knowledge to perform X, Y and Z. This measure would rank this pair 
(i.e., dyad) high in Cognitive Resemblance. 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 
Node Real Agent 

Dyad Real Agent by Agent 

 

For each pair of agents (i,j) compute the number of knowledge 
bits they have in common - whether known or unknown. Then 
normalize this sum by the total number of knowledge bits. 

 

NOTE : The CR output matrix is symmetric. 
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Cognitive Similarity 

 

Description 
Measures the degree to which each pair of agents have overlapping 
knowledge. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 

Example 
With an organization where Bob has the knowledge of X, Y and Z and 
Sally has the knowledge of Q, R and Z. The Cognitive Similarity 
mesure would compute a value for Bob and Sally's overlapping 
knowledge of Z. 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum : 0 

Maximum : 1 
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Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 
Node Real Agent 

Dyad Real Agent 

 

For each pair of agents (i,j) compute the number of knowledge 
bits they have in common. Then normalize this sum by the total 
knowledge between them. 

 

NOTE : The CS output matrix is symmetric. 
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Column Breadth 

 

Description 
The fraction of entities with column nodes with degree greater than 
one. 

NOTE : This measure works on all Networks and can be any 
number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, we have the following entities: employees 
(agents), computers (resources), benchmarks (tasks). This measure 
tells us on how many links greater than one exist within these entity 
types. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 
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Input and Output 
Input :  

 

Data Type 
Binary 

Output :  

 

Level Data Type 
Graph Real 

 

Let d = the Column degree vector of the network N 

Then, the Column Breadth of N is: 

 

NOTE : Row breadth is identical, except that d is defined using the 
row degree, rather than the column degree. 
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Column Count 

 

Description 
The number of column nodes in a network. 

NOTE : This measure works on a Network and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a integer between [ 0 and the total number of 
columns ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Number of Columns 

Computational Time 
Fast 

Input and Output 
Input :  

 
 



862 
 

Data Type 

Binary 

Output :  

 

Level Data Type 

Graph Integer 

Result: Z > 0 

 

 

Column Degree Centrality 

 

Informal Name 
See In Degree Centrality 

 

 

Column Degree Network Centralization 

 

Description 
A centralization based on the degree of the column nodes of a 
network. 

NOTE : This measure works on Any Matrix and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 
Also called InDegree Network Centralization 

Citation 
NetStat 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 

Binary 

Output :  

 

Level Data Type 

Graph Real 

 

Let N be a network with n column entities. 

let 
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let 

 

Then 

 

 

 

Column Rendundancy 

 

Description 
The mean number of column node links in excess of one. 

NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and the number of 
redundant columns ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M. 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : ℜ ∈[0,(m-1)*n] 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 

Binary 

Output :  

 

Level Data Type 

Graph Real 

 

Let M be the matrix representation for a network N of dimension 
m x n. 

let 

 

for 

 

this is the number of column entries in excess of one for 
column j. 

Then 
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Communication 

 

Description 
Measures the communication need of agents to complete their 
assigned tasks. 

NOTE : This measure works on the Agent x Agent, Agent x Task, 
Agent x Resource, Resource x Task, and Task x Task matrices 
and needs to be in the binary format [ 0 or 1 ]. 

Example :  
In a given organization Bob is assigned a task which is dependant 
upon his social links to other individuals in the network. The measure 
would compute a value for how dependent Bob is on the links to the 
other individuals to complete the task. A higher value would indicate 
Bob must possess a greater number of connections to complete any 
given task he is assigned. Conversely, a low value would indicate 
relatively few linkages are necessary to complete certain tasks. 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
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Manju K. Ahuja, Dennis F. Galletta and Kathleen M. Carley, 2003, 
"Individual Centrality and Performance in Virtual R&D Groups: An 
Empirical Study," Management Science, 49.1:21-38. 

Minimum and Maximum Values 
Minimum : 0 

Maximum : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Agent Binary 

Agent by Task Binary 

Agent by Resource Binary 

Resource by Task Binary 

Task by Task Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 

 

Communication uses the concepts from Communication 
Congruence: Handoff, Co-Assignment, and Negotiation. 

let H, C, and N be defined as in Communication Congruence. 



868 
 

let M(i,j) = [AA + (H+H') + C + (N+N')](i,j) > 0, and M(i,i) = 
0 

NOTE : The transpose of H and N is used to make the communication 
reciprocal. 

let d = sum(M(i,:)) 

let d = d / (|A|-1), normalizing d to be in [0,1] 

Then Communication for agent i is d. 

 

Communication Congruence 

 

Description 
Measures to what extent the agents communicate when and only 
when it is needful to complete tasks. Perfect congruence requires a 
symmetric Agent x Agent network. 

One of the following pairs of matrices must exist: Agent x 
Knowlage/Knowledge x Task -OR- Agent x 
Resource/Resource x Task. If both exist, then the measure first 
concatenates them into [Agent x Knowledge/Agent x Resource], 
[Knowledge x Task/Resource x Task] and uses them. 

Communication Congruence = 1 if agents communicate when and 
only when it is needful to complete their tasks. There are three task 
related reasons when agents i and j need to communicate: 

(a) Handoff: if i is assigned to a task s and j is assigned to a task 
t and s directly precedes task t. 

(b) Co-Assignment: if i is assigned to a task s and j is also 
assigned to s. 

(c) Negotiation: if i is assigned to a task s and j is not, and there 
is a resource r to which agents assigned to s have no access but j 
does. 
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The three cases are computed as follows: 

(a) let Handoff = Agent x Task * Task x Task * Agent x Task' 

(b) let Co-Assignment = Agent x Task * Agent x Task' 

(c) let Negogiation = Agent x Task * Z * Agent x Resource', where 
Z(t,r) = [Agent x Task * Agent x Resource - Resource x 
Task](t,r)<0 

NOTE : Co-Assignment is always symmetric, but Handoff and 
Negogiation are not necessarily symmetric. 

NOTE : This measure works on the Agent x Agent, Agent x Task, 
Agent x Resource, Resource x Task, and Task x Task matrices 
and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

let Q(i,j) = [ (H+H') + C + (N+N')](i,j) > 0. 

Communication Congruence requires reciprocal communication, 
explaining the transposes of H and N to make them symmetric. 
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let d = hamming distance between Q and AA, which measures the 
degree to which communication differs from that which is needed 
to do tasks. 

The maximum value for d is d_max = |A|*(|A|-1) 

Then Communication Congruence = 1 - (d /d_max), which is in [0,1]. 

Input and Output 
Input :  

 

Network Data Type 

Agent by Agent Binary 

Agent by Task Binary 

Agent by Resource Binary 

Resource by Task Binary 

Task by Task Binary 

Output :  

 

Level Data Type 

Graph Real 
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Communicative Need 

 

Description 
Measures the percentage of reciprocal links in a network. This is also 
called Reciprocity. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
See Reciprocal Link Count for full description 

Citation 
Carley Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 
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Input and Output 
Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 
Graph Real 

 

 

Complexity 

 

Description 
The density of the meta-network as a whole. 

NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Wasserman, Stanley, & Faust, Katherine. (1994). Social Network 
Analysis: Methods and Applications: Cambridge University Press. 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 
Binary 

Output :  

 

Level Data Type 

Graph Real 
 

 

 

Connectedness 

 

Description 
Measures the degree to which a square network's underlying 
(symmetrized) network is connected. Individuals or organizations 
that connect groups are those that are connecting disconnected 
groups. The individual or organization may be connected to only one 
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or a few members of each groups. This is a composite measure that 
is high when the agent is potentially influential but is not in the know. 
This is calculated as the ration of betweenness centrality to total 
degree centrality and is calculated on agent by agent matrices. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by 
Carley, Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence 
Erlbaum Associates, 1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Square Binary 
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Output :  

 

Level Data Type 
Graph Real 

 

 

 

Distinctive Correlation 

 

Description 
Measures the degree to which each pair of rows has complementary 
data, expressed as the percent of total data. 

NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Input and Output 
Input :  

 

Data Type 
Binary 

Output :  

 

Level Data Type Type 
Node Real Row 

Dyad Real Row by Row 
 

 

Degree Centrality Spatial 

 

Description 
The total distance from a node to its neighbors 

NOTE : This measure works on the Agent x Agent and Agent x 
Location matrices and needs to be [ any number ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic 
and Network Analysis of Drug Interdiction Information. Paper 
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presented at the Twenty Ninth International Sunbelt Social Network 
Conference, San Diego, CA. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

< 

Input and Output 
Input :  

 

Network Data Type 
Agent by Agent Binary 

Agent by Location Binary 

Output :  

 

Level Data Type  
Node RealAgent   
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Density 

 

Description 
The ratio of the number of links versus the maximum possible links 
for a network. 

Density compares existing links to all possible links in the employee 
communication network. It reflects the social level of organizational 
cohesion. This measure must be interpreted in relation to the size of 
the group and the type of work performed. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

NOTE : There can not be any self-loops in any of the matrices 

Informal Name 
None 

Citation 
Wasserman, Stanley and Katherine Faust. Social Network Analysis: 
Methods and Applications. Cambridge: Cambridge University Press, 
1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Unimodel Binary 

Output :  

 

Level Data Type 
Graph Real 

 

Let M be the adjacency matrix for the network of dimension m x 
n. 

If the network is unimodal, then m=n and M has a zero 
diagonal, and therefore 

Density = sum(M)/(m*(m-1)). 

For rectangular networks 

Density = sum(M)/(m*n). 
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Density Classic SNA 

 

Description 
The ratio of the number of links versus the maximum possible links 
for a square network. Self-loops are ignored. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 

Square Binary 
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Output :  

 

Level Data Type 
Graph Real 

 

Let M be the adjacency matrix for the network of dimension m x 
n. 

If the network is unimodal, then m=n and M has a zero 
diagonal, and therefore 

Density = sum(M)/(m*(m-1)). 

For rectangular networks, Density = sum(M)/(m*n). 

 

 

Diameter 

 

Description 
The maximum shortest path length between any two nodes in a 
unimodal network G=(V,E). If there exist i,j in V such that j is not 
reachable from i, then |V| is returned. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and Total Number of 
Nodes ], inclusive. 

Informal Name 
None 
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Citation 
Wasserman, Stanley and Katherine Faust. Social Network Analysis: 
Methods and Applications. Cambridge: Cambridge University Press, 
1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Square Real 

Output :  

 

Level Data Type 

Graph Integer 

 

The diameter of G=(V,E) is defined as: 

 

That is, the maximum shortest directed path between any two 
vertices in G. If there exists i and j such that j is not reachable 
from i, then |V| is returned. 
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Diffusion 

 

Description 
Computes the degree to which something could be easily diffused 
(spread) throughout the network. This is based on the distance 
between nodes. A large diffusion value means that nodes are close to 
each other, and a smaller diffusion value means that nodes are 
farther apart. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M. (2002). Smart agents and organizations of the 
future. In Leah Lievrouw, and Sonia Livingstone (Ed.), The Handbook 
of New Media (pp. Chapter 12, 205-220). Thousand Oaks, CA: Sage. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 
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Input and Output 
Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 
Graph Real 

Let N = number of nodes. 

Let K = number of pairs of nodes that are unreachable (note 
that G is not required to be symmetric. 

For each pair of unreachable nodes we record a distance of N, 
which is beyond the maximum distance for a binary network. 

Let TotalDistance =  

Let AverageDistance = TotalDistance / (N*(N-1)), which is the 
average distance between nodes 

Then Diffusion = N/(N-1) * [1 - AverageDistance/N], which is 
the average distance from 1 and normalized so that cliques get a 
score of 1 
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Distinctive Correlation 

 

Description 
Measures the degree to which each pair of rows has complementary 
data, expressed as the percent of total data. 

NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Input and Output 
Input :  

 

Data Type 
Binary 
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Output :  

 

Level Data Type Type 
Node Real Row 

Dyad Real Row by Row 
 

 

 

Edge Betweenness Centrality 

 

Description 
The Edge Betweenness Centrality of an edge e in a network is defined 
as: across all node pairs that have a shortest path containing e, the 
percentage that pass through e. 

NOTE : This measure works on the Agent x Resource matrices and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Freeman, Linton C. (1979). Centrality in social networks I: 
Conceptual clarification. Social Networks, 1(3), 215-239. 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Square Real 

 

Name Data Type Label<  

Radius RealNeighbor Radius   

Output :  

 

Level Data Type 

Dyad Real 

 

This is the Column Redundancy of matrix AR. 
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Efficiency 

 

Description 
The degree to which each component in a network contains the 
minimum links possible to keep it connected. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In an organization, let us say Bob has a connection to the computer, 
Sales, Event, and Goal. This measure computes a value for the 
minimum number of links entities such as Bob must have for the 
network to maintain its network status. Therefore, this is a network 
level measure. In other words, if Bob had one less link, then then the 
entities would cease to constitute the original network. 

Informal Name 
None 

Citation 
Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by 
Carley, Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence 
Erlbaum Associates, 1994. 

Minimum and Maximum Values 
Minimum : 0 

Maximum : 1 
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Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type Directed 
Square Binary No 

Output :  

 

Level Data Type 
Graph Real 

 

Let G=(V,E) be the graph representation of a square, 
undirected network. 

let 

 

let 

 

let 

 

let 
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Then Efficiency = 1 - penalty/maxPenalty 

 

 

Eigenvector Centrality 

 

Description 
Calculates the principal eigenvector of the network. A node is central 
to the extent that its neighbors are central. Leaders of strong cliques 
are individuals or organizations who are connected to others that are 
themselves highly connected to each other. In other words, if you 
have a clique then the individual most connected to others in the 
clique and other cliques, is the leader of the clique. Individuals or 
organizations who are connected to many otherwise isolated 
individuals or organizations will have a much lower score in this 
measure then those that are connected to groups that have many 
connections themselves. This would be true even if such a WHO 
might have a high amount of actual connections (i.e. high degree 
centrality). 

It calculates the eigenvector of the largest positive eigenvalue of the 
adjacency matrix representation of a square network. A Jacobi 
method is used to compute the eigenvalues and vectors. 

Hub-Centrality and Authority-Centrality measures are generalizations 
of the Eigenvector Centrality measure and take into account directed 
links. 

NOTE : This measure works on the Agent x Agent matrix and can 
be in [ any number ]. The result will be a number between [ 0 and 
1 ], inclusive. 
 
NOTE : When a network has multiple components the Eigenvector 
Centrality measure is known to behave at times unintuitively. For 
example, all nodes in one component might get value zero. 
 
NOTE : Eigenvector centrality and Eigenvector Centrality Per 
Component both operate on a symmetric network with no self-loops, 
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and all values are output in the range [0,1]. 
 
NOTE : Eigenvector never uses self-loops. 
 
NOTE : If multiple components are involved, the default is to do each 
component separately and if the user wants these adjusted by 
component size it adjusts to keep the value between 0 and 1. 

Example 
It follows that a person well-connected to well-connected people can 
spread information much more quickly than one who only has 
connections to lesser important people in a network. People with 
higher scores of Eigenvector Centrality could be critical when rapid 
communication is needed. 

Furthermore, individuals or organizations that are connected to man 
other otherwise isolated groups will have a much lower score in this 
measure than those that are connected to groups that have many 
connections themselves.  

Informal Name 
None 

Citation 
Bonacich, Phillip. (1972). Factoring and weighting approaches to 
status scores and clique detection. Journal of Mathematical Sociology, 
2, 113-120. 

Bonacich, Phillip. (1972). Technique for Analyzing Overlapping 
Memberships. In H. Costner (Ed.), Sociological Methodology (pp. 
176-185). San Francisco: Jossey-Bass. 

Minimum and Maximum Values 
Minimum : 0 

Maximum : 1 
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Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type Directed 
Square Real No 

Output :  

 

Level Data Type 
Node Real 

Calculates the eigenvector of the largest positive eigenvalue of 
the adjacency matrix representation of a square network. A 
Jacobi method is used to compute the eigenvalues and vectors. 

 

 

Eigenvector Centrality Per Component 

 

Description 
Calculates the principal eigenvector of the network. A node is central 
to the extent that its neighbors are central. Each component is 
extracted as a separate network, Eigenvector Centrality is computed 
on it and scaled according to the component size. The scores are then 
combined into a single result vector. 

Eigenvector Centrality Per Component runs the Eigenvector Centrality 
metric on each component of the network individually, scales the 
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values according to the number of nodes in the component (larger 
components get larger values), and then combines the values into a 
single vector to return. The final vector has all values in the range 
[0,1]. 

NOTE : Eigenvector centrality and Eigenvector Centrality Per 
Component both operate on a symmetric network with no self-loops, 
and all values are output in the range [0,1]. 

Informal Name 
None 

Citation 
Bonacich, Phillip. (1972). Factoring and weighting approaches to 
status scores and clique detection. Journal of Mathematical Sociology, 
2, 113-120. 

Bonacich, Phillip. (1972). Technique for Analyzing Overlapping 
Memberships. In H. Costner (Ed.), Sociological Methodology (pp. 
176-185). San Francisco: Jossey-Bass. 

Minimum and Maximum Values 
Minimum : 0 

Maximum : 1 

Computational Time 
Unknown 

Input and Output 
Input :  

 

Network Data Type Directed 
Square Real No 
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Output :  

 

Level Data Type 
Node Real 

 

 

Eigenvector Centrality Spatial 

 

Description 
The sum of the eigenvector centralities of all nodes located at a 
place. Intuitively, the likelihood of arriving at a node at a particular 
location in a random walk. 

NOTE : This measure works on the Agent x Resource, Agent x 
Agent and Agent x Location matrices and can be [ Any Number ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic 
and Network Analysis of Drug Interdiction Information. Paper 
presented at the Twenty Ninth International Sunbelt Social Network 
Conference, San Diego, CA.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Agent Binary 

Agent by Location Binary 

Output :  

 

Level Data Type Type 
Node Real Location 

 

 

 

Exclusivity 

 

Description 
Detects entities that have ties that comparatively few other entities 
have. Individuals or organizations that are high in complete 
exclusivity for knowledge are those that have expertise or are 
connected to types of knowledge that no one else has. The scientific 
name of this measure is complete exclusivity and it is calculated on 
agent by knowledge matrices. 
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• Individuals or organizations that are high in complete exclusivity 
for location are those that have frequented locations that no 
one else has. 

• Individuals or organizations that are high in complete exclusivity 
for resources are those that have resources or are connected to 
types of resources that few others have. 

• Individuals or organizations that are high in complete exclusivity 
for tasks are those that are engaged in or assigned to tasks or 
activities for which no one else is engaged in or assigned to. 

NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Ashworth, Michael J., & Louie, Marcus A. (2002). Alignment of the 
Garbage Can and NK Fitness Models: A Virtual Experiment in the 
Simulation of Organizations. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 
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Input and Output 
Input :  

 

Data Type 
Binary 

Output :  

 

Level Data Type Type 
Node Real Row 

 

 

 

Exclusivity Complete 

 

Description 
Detects entities that have ties that no other entity has. Individuals or 
organizations that are high in complete exclusivity for events are 
those that attend or are supposed to attend an event that no one else 
does. The scientific name of this measure is complete exclusivity and 
it is calculated on agent by event matrices. 

NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Example 
Individuals or organizations that are high in complete exclusivity for 
events are those that attend or are supposed to attend an event that 
no one else does.  

Informal Name 
None 

Citation 
Ashworth, M. and Carley, K. (2006). Who you know vs. what you 
know: The impact of social position and knowledge on team 
performance. Journal of Mathematical Sociology, 30(1):43{75. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 

Binary 

Output :  

 

Level Data Type Type 
Node Real Row 
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This is a variation of the Exclusivity measure that weights the 
edges of an entity as follows: if no other entity has a connection 
to the entity, then its weight is one, otherwise it is zero. 

Thus, the Complete Exclusivity value for node i is: 

 

The value is then normalized by dividing by |K|. 

 

Expertise Correlation 

 

Description 
Measures the degree to which each pair of rows has complementary 
data, expressed as a percentage of the data of the first row. 

NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen, M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Slow 

Input and Output 
Input :  

 

Data Type 
Binary 

Output :  

 

Level Data Type Type 
Node Real Row 

Dyad Real Row by Row 
 

 

Fragmentation 

 

Description 
The proportion of nodes in a network that are disconnected. 

Example 
In a given organization 25 out of 400 sales agents are disconnected 
from the resources and knowledge that exists at the company 
headquarters because they travel more frequently and are thus 
disconnected from the rest of the network. The attribute of this 
disconnection expressed as a property of the entire organization is its 
computed disconnected measure.  
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NOTE : This measure works on Any Matrix and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Borgatti, S.P. 2003. The Key Player Problem. Dynamic Social Network 
Modeling and Analysis: Workshop Summary and Papers, R. 

Breiger, K. Carley, & P. Pattison (Eds.) Committee on Human Factors, 
National Research Council, 241-252. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type Directed 

Square Binary No 
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Output :  

 

Level Data Type 
Graph Real 

 

Consider a square, symmetric network G=(V,E). 

let 

 

let 

 

Then, 

 

 

Geodesic Distance 

 

Description 
Computes the length of the shortest path between all node pairs, 
where length is the number of links, ignoring link weights. If no path 
exists between two nodes, then a distance of zero is given. The 
distance from a node to itself is also zero. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
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The result will be a number a between [ 0 and the number of 
columns - 1 ]. 

 

Informal Name 
None 

Citation 
Wasserman, Stanley, & Faust, Katherine. (1994). Social Network 
Analysis: Methods and Applications: Cambridge University Press. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Number of columns - 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Square Binary 

Output :  

 

Level Data Type 

Dyad Integer 
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Hierarchy 

 

Description 
The degree to which a unimodal network exhibits a pure hierarchical 
structure. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Let us say in an organization Sue is the president. Under Sue, we 
have 4 vice presidents, whom all in turn have 5 or 10 direct reports, 
who all have 2 or 3 managers working for them. To such a degree 
that this architecture is present in the organzation is its computed 
Krackhardt Hierarchy value. 

Informal Name 
None 

Citation 
Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by 
Carley, Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence 
Erlbaum Associates, 1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 



905 
 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 
Graph Real 

 

Let N be a square network. The Hierarchy of N is the Reciprocity 
of the Reachability Network for N. 

 

 

Hub Centrality 

 

Description 
A node is hub-central to the extent that its out-links are to nodes that 
have many in-links. Individuals or organizations that act as hubs are 
sending information to a wide range of others each of whom has 
many others reporting to them. Technically, an agent is hub-central if 
its out-links are to agents that have many other agents sending links 
to them. The scientific name of this measure is hub centrality and it is 
calculated on agent by agent matrices. 
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NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Kleinberg, Jon M. (1998). Decision algorithms for unsplittable flow 
and the half-disjoint paths problem. Paper presented at the Thirtieth 
Annual ACM symposium on Theory of Computing, Dallas, TX. 

Kleinberg, Jon M. (1998). Authoritative sources in a hyperlinked 
environment. Paper presented at the SODA '98 Ninth Annual ACM-
SIAM Symposium on Discrete Algorithms, San Francisco, CA. Latria 
and Marchiori, 2001 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Square Real 
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Output :  

 

Level Data Type 
Node Real 

Let G be the adjacency matrix. 

Hub Centrality = eigenvectorCentrality(G*G') 

Authority Centrality = eigenvectorCentrality(G'*G) 

 

In Degree Centrality 

 

Description 
The In Degree Centrality of a node is its normalized in-degree. For 
any node, e.g. an individual or a resource, the in-links are the 
connections that the node of interest receives from other nodes. For 
example, imagine an agent by knowledge matrix then the number of 
in-links a piece of knowledge has is the number of agents that are 
connected to. The scientific name of this measure is in-degree and it 
is calculated on the agent by agent matrices. 

For any node, e.g. an individual or a resource, the in-links are the 
connections that the node of interest receives from other nodes. 

NOTE : This measure works on the Agent x Agent matrix and can 
be [ Any Number ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
An agent by knowledge matrix with a number of in-links. A piece of 
knowledge has is the number of agents that are connected to. 
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Informal Name 
None 

Citation 
Wasserman, Stanley and Katherine Faust. "Social Network Analysis: 
Methods and Applications." Cambridge: Cambridge University Press, 
1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 

Real 

Output :  

 

Level Data Type Type 

Node Real Column 

 

Consider the matrix representation X of a network with m rows 
and n columns. Each column j is assigned an in-degree centrality 
based on the sum of entries in its column. 
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The In-Degree Centrality for column j 

 

NOTE : This measure is also called Column Degree Centrality. 

 

 

In Degree Network Centralization 

 

Description 
A centralization of a square network based on the In-Degree 
Centrality of each node. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, all employees have many incoming links to 
other employees. This is their In degree connections. This measure 
computes a value for the entire organization as a whole as to how 
central these connections are within the organization.  

Informal Name 
None 

Citation 
NetStat 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 
Real 

Output :  

 

Level Data Type 

Graph Real 

 

Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 
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where D = (n-2) if N is undirected, and (n-1) otherwise. 

 

Information Centrality 

 

Description 
Information centrality is a network metric that accounts for indirect 
as well as shortest (geodesic) paths among entities. Information 
centrality is similar to betweenness, except that betweenness 
considers only shortest paths geodesics, whereas information 
centrality also considers more circuitous paths weighted by the 
inverse of the path length (the number of links along the path). 

Calculates the Stephenson and Zelen information centrality measure 
for each entity. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Entities high in information centrality are more likely to get more 
information and to get information faster. 

Informal Name 
None 
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Citation 
Wasserman, Stanley and Katherine Faust. "Social Network Analysis: 
Methods and Applications." Cambridge: Cambridge University Press, 
1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow, with High Space requirements 

Input and Output 
Input :  

 

Network Data Type Directed 

Square Real No 

Output :  

 

Level Data Type 

Node Real 

 

Calculates the measure described on pg 195-6 of Wasserman and 
Faust. Isolates (entities with no edges) are first removed from 
the network, and the measure computed on the resulting sub-
graph. The isolates are given centrality value 0. 
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Interdependence 

 

Description 
The percentage of links in a unimodal network that are Pooled or 
Reciprocal. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
A reciprocal link is one that is bidirectional. Let us say Bob has a link 
to Sue and Sue has a link back to Bob This is a reciprocal link. 
However, if Bob had a lot of links to Sue and others, which were not 
reciprocated, that is bidirectional, than Bob would be said to rank 
higher in radial links, which linked in one direction. The extent that a 
network exhibits these relationships is computed as the 
Interdependence and Radial value for the network.  

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 
Graph Real 

 

Let G=(V,E) be the graph representation of a square network. 

Let a = Pooled Edge Count and b = Reciprocal Link Count 
of the network. 

Then Interdependence = (a+b)/|E| 

 

 

Interlockers 

 

Description 
Interlocker are nodes that have a triad count (the number of triads 
each node is in) that is greater than the mean plus one standard 
deviation. 
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NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be in the binary format [ 0 or 1 ]. 

Example 
A typical corporate board of directors is a good example of an 
interlocking architecture. Whereas a predominant amount of board 
members - perhaps close to 70-percent - might serve on one board 
only, it is often common that the remaining 30-percent may serve on 
3 or more other boards. These directors that serve on the other 
boards constitute the interlocking agents that connect all these 
typical boards together. The Interlockers and radial measures 
compute a value for such relationships as they exist in the network at 
the entity, that is agent (e.g., "board member"), level. 

Informal Name 
None 

Citation 
Laumann, 1973 Edward O. Laumann, Bonds of Pluralism: The Form 
and Substance of Urban Social Networks, Wiley-Interscience, New 
York (1973). 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 
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Input and Output 
 

Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 
Node Binary 

Let N=(V,E) be a square network. 

Let 

= Triad Count for node i,  

Let 

= the mean of  

Let 

= the variance of  

Then, 

if , then agent k is an interlocker. 

If , then agent k is a radial. 
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Inverse Closeness Centrality 

 

Description 
The average closeness of a node to the other nodes in a network. 
Inverse Closeness is the sum of the inverse distances between a 
node and all other nodes. Nodes high in closeness centrality are more 
likely to communicate faster and operate more efficiently. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Wasserman, Stanley and Katherine Faust. Social Network Analysis: 
Methods and Applications. Cambridge: Cambridge University Press, 
1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 
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Input and Output 
Input :  

 

Network Data Type 
Square Real 

Output :  

 

Level Data Type 
Node Real 

 

Let G=(V,E) be the graph representation of the square network. 

For  

let 

 

if i is not reachable from v. 

Then, Inverse Closeness Centrality of entity v = 
dist/(|V|-1). 
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Isolate Count 

 

Description 
The number of isolate nodes in a unimodel network. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be [ the total number of isolates ]. 

Informal Name 
None 

Citation 
Carley, Kathleen, M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Number of nodes in the network 

Computational Time 
Fast 

Input and Output 
Input :  
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Network Data Type 

Square Binary 

Output :  

 

Level Data Type 

Graph Integer 

 

Let N=(V,E) be a square network. 

An isolate is a node v in V such that no edges are incident upon 
it. The number of such nodes is returned. 

 

Knowledge Actual Workload 

 

Description 
The knowledge an agent uses to perform the tasks to which it is 
assigned. 

NOTE : This measure works on the Agent x Knowledge, 
Knowledge x Task, and Agent x Task matrices and needs to be in 
the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 
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Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Knowledge by Task Binary 

Agent by Task Binary 

Output :  

 

Level Type Data Type 

Node Level Agent Real 
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Knowledge Based Access Index 

 

Description 
Boolean value which is true if an agent is the only agent who knows a 
piece of knowledge and who is known by exactly one other agent. 
The one agent known also has its KAI set to one. 

An node level measure that computes the average shortest path 
length between entities, excluding infinite distances. This is known as 
the Knowledge Access Index (KAI) value. 

NOTE : This measure works on the Agent x Agent and Agent x 
Knowledge matrices and needs to be in the binary format [ 0 or 
1 ]. 
 
The result will be a binary number [ 0 or 1 ]. 

Example 
Let us imagine a social network where 50 employees have many 
connections to each other. The average number of connections per 
employee is the Access Index.  

Informal Name 
None 

Citation 
Ashworth, M. and Carley, Kathleen M., 2003, "Critical Human 
Capital", Working Paper, CASOS, Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 



923 
 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Agent by Agent Binary 

Agent by Knowledge Binary 

Output :  

 

Level Type Data Type 
Node Level Agent Binary 

The Knowledge Access Index (KAI) for agent i is defined as 
follows: 

let 

 

Then 
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Knowledge Task Completion 

 

Description 
The percentage of tasks that can be completed by the agents 
assigned to them, based solely on whether the agents have the 
requisite knowledge to do the tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, and Knowledge x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Bob is assigned 10 Tasks to complete which require a certain amount 
of knowledge to finish. However, on average only 10-percent of this 
knowledge will be available to Bob for him to complete the tasks 
given. This measure would compute a value for the likelyhood that 
Bob would be able to complete any given task. 

NOTE : Task Completion Overall is a combination of the Task 
Completion Knowledge and the Task Completion Resource. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type 

Graph Real 

 

Find the tasks that cannot be completed because the agents 
assigned to the tasks lack necessary knowledge. 

let 

 

let 

 

Knowledge Based Task Completion is the percentage of tasks 
that could be completed = (|T|-|S|) / |T| 
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Resource Based Task Completion is analogous, replacing AK 
with AR and KT with RT. 

 

Knowledge Diversity 

 

Description 
The distribution of difference in idea sharing. This is the Herfindahl-
Hirshman index applied to column sums of AK. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Characterizes the network in terms of how the items in a knowledge 
network (who knows what) are non-uniformly distributed across 
employees 

Informal Name 
None 

Citation 
Hirschman A. O., 1945. National Power and the Structure of Foreign 
Trade. Berkeley: University of California Press. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Fast 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type 
Graph Real 

 

This is the Herfindahl-Hirshman index (economics: sum of the 
squares of each firm's market share) applied to the normalized 
column sums of AK. This measures the degree to which 
knowledge is equally known. 

let 

 

let 

 

Then 
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Knowledge Exclusivity 

 

Description 
Detects agents who have singular knowledge. 

Example 
A key piece of knowledge that supports an entire organization is only 
accessible through one person. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Ashworth, M. and Carley, K. (2006). Who you know vs. what you 
know: The impact of social position and knowledge on team 
performance. Journal of Mathematical Sociology, 30(1):43{75. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
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Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 
Node Real Agent 

 

The Knowledge Exclusivity Index (KEI) for agent i is defined 
as follows: 

 

The Knowledge Exclusivity Index (KEI) for agent i is defined 
exactly as for Knowledge Based Exclusivity. 

 

 

Knowledge Load 

 

Description 
Average number of knowledge per agent. 

NOTE : This measure works on the Agent x Knowledge matrices 
and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Output :  

 

Level Data Type 

Graph Real 

 

 



931 
 

Resource Load is defined analogously, replacing AK with AR. 

 

 

Knowledge Negotiation 

 

Description 
The extent to which agents need to negotiate with each other 
because they lack the knowledge to complete their assigned tasks. 

NOTE : This measure works on the Agent x Task, Agent x 
Knowledge, and Knowledge x Task matrices and needs to be in 
the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, Bob does not have knowledge needed to 
complete a certain task but Sue does have it. Bob must negotiate 
with Sue to gain that knowledge to complete the task. The extent to 
which others in the organization must negotiate for knowledge that 
others have is the organization's knowledge negotiation value. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Task Binary 

Agent by Knowledge Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type 

Graph Real 

 

Compute the percentage of tasks that lack at least one 
knowledge (or Resource): 

let 

 

for Resource replace AK with AR and KT with RT 

let 

 

Then Knowledge (or Resource) Negotiation = |S| / |T| 
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Knowledge Omega 

 

Description 
The degree to which agents reuse knowledge while doing their tasks. 

NOTE : This measure works on the Agent x Task, Knowledge x 
Task, and Task x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Sue has X amount of tasks within her company. How many of those 
tasks that require a knowledge that can be used for one or more of 
her other tasks is omega knowledge. This measure computes a value 
for such relations to knowledge sets at the network level.  

Informal Name 
None 

Citation 
Carley, K, Dekker, D., Krackhardt, D (2000). How Do Social Networks 
Affect Organizational Knowledge Utilitization.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Task Binary 

Knowledge by Task Binary 

Task by Task Binary 

Output :  

 

Level Data Type 
Graph Real 

 

Let TAT = TA*TA' 

Let N = ((T'@TAT)*KT')@KT' 

for resource replace KT with RT 

Then Knowledge Based Omega = sum(N)/sum(KT) 

for resource replace KT with RT 
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Knowledge Potential Workload 

 

Description 
Maximum knowledge an agent could use to do tasks if it were 
assigned to all tasks. 

NOTE : This measure works on the Agent x Knowledge and 
Knowledge x Task matrices and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, let us say Bob is assigned all task that exist 
in the organization. This measure would compute a value expressing 
Bob's potential to carry out all the tasks based on his connections to 
the resources and knowledge needed for the tasks.  

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible: 0 

Maximum Possible : 1 

Computational Time 
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Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type Type 
Node Real Agent 

 

Potential Knowledge Workload for agent i = 
sum((AK*KT)(i,:))/sum(KT) 

for Resource replace AK with AR and KT with RT 

 

 

Knowledge Rendundancy 

 

Description 
Average number of redundant agents per knowledge. An agent is 
redundant if there is already an agent that has the knowledge. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : ℜ ∈ [0,(|A|-1)*|K|] 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Output :  

 

Level Data Type 

Graph Real 

 



938 
 

This is the Column Redundancy of matrix AK. 

 

Knowledge Under Supply 

 

Description 
The extent to which the knowledge needed to do tasks are 
unavailable in the entire organization. 

NOTE : This measure works on the Agent x Task, Agent x 
Knowledge, and Knowledge x Task matrices and needs to be in 
the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
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Input :  

 

Network Data Type 
Agent by Task Binary 

Agent by Knowledge Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type 
Graph Real 

 

This is the number of required knowledge not available to tasks 
based on the current agent task assignments normalized by the 
number of tasks. 

Knowledge Under Supply = sum(dich( KT - AK'*KT)) / |T| 

Under Resource Supply is analogous, replacing AK with AR, 
and KT with RT. 

 

 

Lateral Link Count 

 

Description 
The percentage of lateral links in a unimodal network. Fixing a root 
node x, a lateral link (i,j) is one in which the distance from x to i is 
the same as the distance from x to j. 
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NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Fixing a root entity x, a lateral edge (i,j) is one in which the distance 
from x to i is the same as the distance from x to j. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible: 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 

Square Binary 

Output :  
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Level Data Type 

Graph Real 

 

Let G=(V,E) be the graph representation of a network. And fix an 
node x∈V to be the root node. 

Let 

 

Then Lateral Edge Count = |S| / |E| 

 

 

Local Efficiency 

 

Description 
Normalized sum of the Global Efficiency of each node's ego network 
(here, the ego network for entity i does not include entity i). 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In an organization, Bob has a connection to the computers, Sales 
Data, Events, Goals. This measure computes a value for the 
minimum number of links to entities such as Bob must have for the 
network to maintain its network status. Therefore, this is a network 
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level measure. If Bob had one less link, then then the entities would 
cease to constitute the original network. 

Informal Name 
None 

Citation 
Latria and Marchiori (2001), Efficient behavior of small-world 
networks. Physical Review Letters, volume 87, issue 19, The 
American Physical Society. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 

Graph Real 
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Local Efficiency is the normalized sum of the inverse closeness of 
the ego networks (here, the ego network for entity i does not 
include entity i). 

Let G = (V,E) be any square, symmetric network with |V| = N 
entities. 

let 

 

let 

 

to 

 

define 

 

Then, 
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Location Relevance 

 

Description 
The extent to which location influences a particular persons 
connections. 

NOTE : This measure works on the Agent x Agent, and Agent x 
Location matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic 
and Network Analysis of Drug Interdiction Information. Paper 
presented at the Twenty Ninth International Sunbelt Social Network 
Conference, San Diego, CA. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  
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Network Data Type 

Agent by Agent Binary 

Agent by Location Binary 

Output :  

 

Level Data Type Type 
Node RealLocation   

 

 

 

Minimum Speed 

 

Description 
The maximum shortest path length between node pairs (i,j) where 
there is a path in the network from i to j. If there are no such pairs, 
then Minimum Speed is zero. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In an organization, we have Bob and Sue with numerous paths 
between them. The shortest path between this entity pair would be 
Bob and Sues (Bob/Sue) minimum speed. One might also say that if 
there were numerous links between Bob and Sue and that the 
average linkage was in the neighborhood of 5 paths (e.g., links) 
when every person in the organization is taken as a whole, the 
shortest linkage between them would be the minimum speed at 
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which Bob and Sue might communicative. If Bob and Sue had direct 
links, minimum speed would be 0.  

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

NOTE : Minimum Speed = 1 / (Levels for the Network) 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Square Real 

Output :  

 

Level Data Type 

Graph Real 

 



947 
 

Minimum Speed = 1 / (Levels for the Network) 

 

 

Network Levels 

 

Description 
The Network Level of a square network is the maximum Node Level 
of its nodes. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and the number of node 
levels - 1 ]. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Z∈[0,|V|-1] 

Computational Time 
Medium 

<  
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Input and Output 
Input :  

 

Network Data Type 
Square Real 

Output :  

 

Level Data Type 
Graph Real 

 

Let G=(V,E) be the graph representation of a square network 
and fix an entity v. 

Then 

 

 

 

Node Count 

 

Description 
The number of nodes in a unimodal network. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
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The result will be a number between [ 0 and the number of nodes 
in the Network ]. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Number of nodes in the network 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Square Binary 

Output :  

 

Level Data Type 

Graph Integer 
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Node Levels 

 

Description 
The Node Level for a node v in a square network is the longest 
shortest path from v to every node v can reach. If v cannot reach any 
node, then its level is 0. 

The Network Level of a square network is the maximum Node Level 
of its nodes. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and the number of nodes 
- 1 ]. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Number of nodes in the network - 1 

Computational Time 
Medium 

Input and Output 
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Input :  

Square matrix : DataType=real. 

Output :  

Graph Level : DataType=integer. 

 

Let G=(V,E) be the graph representation of a square network 
and fix a node v. 

Node Level : DataType=integer 

 

If v cannot reach any nodes, then its level is 0. 

 

Organization Agent Knowledge Needs 
Congruence 

 

Description 
Across all agents, the knowledge that agents lack to do their assigned 
tasks expressed as a percentage of the total knowledge needed by all 
agents. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, and Knowledge x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 



952 
 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type 

Graph Real 

 

As in Agent Needs, let N = AT*KT' 

Then 
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Organization Agent Knowledge Waste 
Congruence 

 

Description 
Across all agents, the knowledge that agents have that are not 
required to do their assigned tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, and Knowledge x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Medium  

Input :  

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type 

Graph Real 

 

As in Agent Waste, let N = AT*KT' 

Then 
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Organization Agent Resource Needs 
Congruence 

 

Description 
Across all agents, the resource that agents lack to do their assigned 
tasks expressed as a percentage of the total resources needed by all 
agents. 

NOTE : This measure works on the Agent x Resource, Agent x 
Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
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Input :  

 

Network Data Type 
Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 

Level Data Type 
Graph Real 

 

As in Agent Needs, let N = AT*RT' 

Then 

 

 

 

Organization Agent Resource Waste 
Congruence 

 

Description 
Across all agents, the resources that agents have that are not 
required to do their assigned tasks. 
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NOTE : This measure works on the Agent x Resource, Agent x 
Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  
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Level Data Type 

Graph Real 

 

As in Agent Waste, let N = AT*RT' 

Then 

 

 

Organization Task Knowledge Needs 
Congruence 

 

Description 
Across all tasks, the knowledge that tasks lack expressed as a 
percentage of the total knowledge needed by all tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, and Knowledge x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
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Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Example : An organization needs many skills to meet it's 
organizational objectives. However, not all of the skills are present 
within the organizational network. This measure computes a value 
for this lack of skills as it is distributed across the organization as a 
whole.  

Output :  

 

Level Data Type 
Graph Real 

 

As in Task Needs, let S = AT'*AK 
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Then 

 

 

Organization Task Knowledge Waste 
Congruence 

 

Description 
Across all agents, the knowledge that agents have that are not 
required to do their assigned tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, and Knowledge x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 

Level Data Type 
Graph Real 

 

As in Task Waste, let S = AT'*AK 

Then 
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Organization Task Resource Needs 
Congruence 

 

Description 
Across all tasks, the resources that tasks lack expressed as a 
percentage of the total resource needed by all tasks. 

NOTE : This measure works on the Agent x Resource, Agent x 
Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
An organization needs many resources to meet it's organizational 
objectives. However, not all of the resources are present within the 
organizational network. This measure computes a value for this lack 
of resources as it is distributed across the organization as a whole.  

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
MediumFast 

Input and Output 
Input :  

 

Network Data Type 
Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 

Level Data Type 
Graph Real 

 

As in Task Needs, let S = AT'*AR 

Then 

 

 

 

 



964 
 

 

Organization Task Resource Waste 
Congruence 

 

Description 
Across all agents, the resources that agents have that are not 
required to do their assigned tasks. 

NOTE : This measure works on the Agent x Resource, Agent x 
Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A 
Computational Model of Organizational Learning and Decision Making. 
Pittsburgh, PA: Carnegie Mellon University, School of Computer 
Science, Institute for Software Research International, Technical 
Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
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Input :  

 

Network Data Type 
Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 

Level Data Type 
Graph Real 

 

As in Task Waste, let S = AT'*AR 

Then 
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Organizational Availability 

 

Description 
An organization is available to do a task if it has the required agents 
and the required resources.Computes the degree to which 
organizations are available to do tasks based on their access to 
resources and roles that are needed to do the tasks. 

NOTE : This measure works on the Agent x Organization, Agent x 
Task, Organization x Resource, and Resource x Task matrices 
and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  
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Network Data Type 

Agent by Organization Binary 

Agent by Task Binary 

Organization by Resource Binary 

Resource by Task Binary 

Output :  

 

Level Data Type Type 
Node Real Organization 

 

 

 

Out Degree Centrality 

 

Description 
For any node, (e.g. an individual or a resource), the out-links are the 
connections that the node of interest sends to other nodes. For 
example, imagine an agent by knowledge matrix then the number of 
out-links an agent would have is the number of pieces of knowledge 
it is connected to. 

The scientific name of this measure is out-degree and it is calculated 
on the agent by agent matrices. Individuals or organizations who are 
high in most knowledge have more expertise or are associated with 
more types of knowledge than are others. If no sub-network 
connecting agents to knowledge exists, then this measure will not be 
calculated. The scientific name of this measure is out degree 
centrality and it is calculated on agent by knowledge matrices. 
Individuals or organizations who are high in "most resources" have 
more resources or are associated with more types of resources than 
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are others. If no sub-network connecting agents to resources exists, 
then this measure will not be calculated. The scientific name of this 
measure is out degree centrality and it is calculated on agent by 
resource matrices. 

NOTE : This measure works on the Agent x Agent matrix and needs 
to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Wasserman, Stanley and Katherine Faust. "Social Network Analysis: 
Methods and Applications." Cambridge: Cambridge University Press, 
1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 
Real 

Output :  
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Level Data Type Type 

Node Real Row 

  (If N is binary) 

Consider the matrix representation X of a network with m rows 
and n columns. Each row i is assigned an out-degree centrality 
based on the sum of entries in its row. 

The Out-Degree Centrality 

 

NOTE : This measure is also called Row Degree Centrality. 

 

Out Degree Network Centralization 

 

Description 
A centralization of a square network based on the Out-Degree 
Centrality of each node. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, all employees have so many links to other 
employees. This is their out degree connections. This measure 
computes a value for the entire organization as a whole as to how 
central these connections are within the organization.  

Informal Name 
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None 

Citation 
NetStat 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Data Type 

Real 

Output :  

 

Level Data Type 

Graph Real 

 

Let N be a unimodal network with n nodes. 

let 

 

let 
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Then 

, 

where D = (n-2) if N is undirected, and (n-1) otherwise. 

 

 

Overall Role Based Availability 

 

Description 
Computes the degree to which agents are available to do tasks based 
on their access to knowledge and resources and roles that are needed 
to do the tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Resource, Knowledge x Role, Resource x Role, and Task x Role 
matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
  

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Resource Binary 

Agent by Knowledge Binary 

Resource by Role Binary 

Knowledge by Role Binary 

Task by Role Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 
 

 

Overall Task Completion 

 

Description 
The percentage of tasks that can be completed by the agents 
assigned to them, based solely on whether the agents have the 
requisite knowledge and resources to do the tasks. 
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NOTE : Task Completion Overall is a combination of the Task 
Completion Knowledge and the Task Completion Resource. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Resource, Agent x Task, Knowledge x Task, and Resource x 
Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible: 0 

Maximum Possible: 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Agent by Resource Binary 

Agent by Task Binary 

Knowledge by Task Binary 
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Resource by Task Binary 

Output :  

 

Level Data Type 

Graph Real 
 

 

 

Performance as Accuracy 

 

Description 
Measures how accurately agents can perform their assigned tasks 
based on their access to knowledge and resources. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Task, Agent x Resource, Knowledge x Task, and Resource x 
Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
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Minimum Possible: 0 

Maximum Possible: 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Agent by Resource Binary 

Knowledge by Task Binary 

Resource by Task Binary 

Output :  

 

Level Data Type 

Graph Real 

 

One of the following pairs of matrices must exist: AK/KT, AR/RT. 
If both exist, then the measure first concatenates them into [AK 
AR], [KT RT] and uses them. 

Accuracy is computed based on the binary classification 
problem. It is computed in one of two ways: 

(1) Knowledge based: Let b be a binary string of length |K|, 
let N=KT', and let S=AK. Fix a task t. 

let 
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which is the correct classification of b with respect to task t. 

Now, let I={ i | AT(i,t)=1}. 

let 

 

This is agent i's classification of b with respect to t. 

The group of agents classify b using majority voting. 

That is, 

 

Then, if group_answer = answer, then the group was 
accurate, otherwise not. 

This is repeated multiple times for each task, and across all 
tasks. The percentage correct is Performance as Accuracy. 

(2) Resource based: let N=RT' and S=AR in the analysis of 
case (1). 
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Personnel Cost 

 

Description 
Total number of people reporting to an agent, plus its total 
knowledge, resources, and tasks. 

Personnel Cost is the sum of the in-degree centrality of all AA 
matrices in the graph (this computes the number of agents reporting 
to each agent), plus the out-degree centrality of any AK, AR, and AT 
graphs. 

NOTE : This measure works on the Agent x Agent, Agent 
Knowledge, Agent x Resource, and Agent x Task matrices and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, five employees report to Sue. All of the 
knowledge, resource and tasks connections attributed all the 
employees and Sue constitute Personnel Cost. This measure then 
computes a value for Sue based on all these connections of her 
employees. 

Informal Name 
None 

Citation 
Ashworth, M. and Carley, Kathleen, M., 2003, "Critical Human 
Capital, Working Paper, CASOS" Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 
Minimum Possible: 0 
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Maximum Possible: 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Agent by Agent Binary 

Agent by Knowledge Binary 

Agent by Resource Binary 

Agent by Task Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 

 

Personnel Cost is the sum of the in-degree centrality of all AA 
matrices in the graph (this computes the number of agents 
reporting to each agent), plus the out-degree centrality of any 
AK, AR, and AT graphs. 

This sum is scaled so that each entity gets a score in [0,1]. 
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Potential Boundary Spanner 

 

Description 
Individuals or organizations that connect groups are those that are 
connecting disconnected groups. The individual or organization may 
be connected to only one or a few members of each group. This is a 
composite measure that is high when the agent is potentially 
influential but is not in the know. This is calculated as the ration of 
betweenness centrality to total degree centrality and is calculated on 
agent by agent networks. 

Locates nodes that are high in betweenness centrality, but low 
in total degree centrality, and therefore potentially act as links 
between groups of entities. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
This measures finds an individual who could likely have great 
potential to interact with other parts of an organization based on their 
exisiting connections. 

Informal Name 
None 

Citation 
Cormen, Leiserson, Rivest, Stein 2001. "Introduction to Algorithms" 
Second Edition. Cambridge, MA: MIT Press, 2001. 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type Directed 
Square BinaryNo   

Output :  

 

Level Data Type 

Node Real 

For each node in the network, its Potential Boundary Spanner is 
its Betweenness Centrality divided by its Total Degree Centrality. 
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Potential Workload 

 

Description 
Maximum knowledge and resources an agent could use to do tasks if 
it were assigned to all tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x 
Resource, Knowledge x Task, and Resource x Task matrices and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  
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Network Data Type 

Agent by Knowledge Binary 

Agent by Resource Binary 

Knowledge by Task Binary 

Resource by Task Binary 

Example : In a given organization, Bob is assigned all task that 
exist in the organization. This measure would compute a value 
expressing Bob's potential to carry out all the tasks based on his 
connections to the resources and knowledge needed for the 
tasks.  

Output :  

 

Level Data Type 

Node Real 
 

 

Radials 

 

Description 
Radial are nodes that have a triad count (the number of triads each 
node is in) that is less than the mean minus one standard deviation. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be in the binary format [ 0 or 1 ]. 

Informal Name 
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None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 

Square Binary 

Output :  

 

Level Data Type 

Node Binary 
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Reciprocal Link Count 

 

Description 
The percentage of links in a unimodal network that are reciprocated. 
A link (i,j) in the network is reciprocated if link (j,i) is also in the 
network. 

NOTE : This measure works on Square Matrices [i.e. Agent x 
Agent, Location x Location, etc] and needs to be in the binary format 
[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  
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Network Data Type 

Square Binary 

Output :  

 

Level Data Type 
Graph Real 

 

Let G=(V,E) be the graph representation of a network. 

Let S=card{(i,j)∈E|i<,(j,i)∈E} 

Then Reciprocral Link Count = |S| / |E| 

 

 

Relative Cognitive Distinctiveness 

 

Description 
Measures the degree to which each pair of agents has 
complementary knowledge, expressed as the percent of total 
knowledge. Each value is normalized by the row sum. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 
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Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 

Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 

Dyad Real Agent by Agent 

For each pair of agents (i,j) compute the number of knowledge bits 
they have exactly opposite. Then normalize this sum by the total 
number of knowledge bits. In effect, this is the exclusive-OR of 
their knowledge vectors. 
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NOTE : Note that the CD output matrix is symmetric. 

Relative Cognitive Distinctiveness normalizes each element of CD 
as follows: 

 

Thus, the elements of the ith row are normalized by the ith row 
sum. 

 

Relative Cognitive Expertise 

 

Description 
Measures the degree to which each pair of agents has 
complementary knowledge, expressed as a percentage of the 
knowledge of the first agent. Each value is normalized by the row 
sum. Individuals or organizations that are high in specialized 
knowledge are those that have expertise or are connected to types of 
knowledge that few others have. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 

Dyad Real Agent by Agent 

For each pair of agents (i,j) compute the number of knowledge 
bits that j knows that i does not know. Then normalize this sum 
by the total number of knowledge bits that agent i does not 
know. 

 

NOTE : Note that the CD output matrix is NOT-symmetric. 
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Relative Cognitive Expertise normalizes each element of CE as 
follows: 

 

Thus, the elements of the ith row are normalized by the ith row 
sum. 

 

 

Relative Cognitive Resemblance 

 

Description 
Measures the degree to which each pair of agents has the exact same 
knowledge. Each value is normalized by the row sum. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 

Dyad Real Agent by Agent 

 

For each pair of agents (i,j) compute the number of knowledge bits 
they have in common - whether known or unknown. Then 
normalize this sum by the total number of knowledge bits. 

 

NOTE : The CR output matrix is symmetric. 

Relative Cognitive Resemblance normalizes each element of CR as 
follows: 
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Thus, the elements of the ith row are normalized by the ith row 
sum. 

 

Relative Cognitive Similarity 

 

Description 
Measures the degree to which each pair of agents have overlapping 
knowledge. Each value is normalized by the row sum. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 
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Input and Output 
Input :  

 

Network Data Type 
Agent by Agent Binary 

Output :  

 

Level Data Type Type 
Dyad Real Agent by Agent 

For each pair of agents (i,j) compute the number of knowledge 
bits they have in common. Then normalize this sum by the total 
knowledge between them. 

 

NOTE : The CS output matrix is symmetric. 

Relative Cognitive Similarity normalizes each element of CS as 
follows: 

 

Thus, the elements of the ith row are normalized by the ith row 
sum. 
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Relative Expertise 

 

Description 
The degree of dissimilarity between agents based on shared 
knowledge. Each agent computes to what degree the other agents 
know what they do not know. Individuals or organizations that are 
high in specialized knowledge are those that have expertise or are 
connected to types of knowledge that few others have. The scientific 
name of this measure is relatively unique and it is calculated on 
agent by knowledge matrices. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen. (2003). Dynamic Network Analysis. 133-145. 
Committee on Human Factors, National Research Council. 
http://www.casos.cs.cmu.edu/publications/temp/hope110922160731
/carley_2003_dynamicnetwork.pdf. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 
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Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 
Graph Real Agent 

 

 

Relative Similarity 

 

Description 
The degree of similarity between two agents based on shared 
knowledge. Each agent computes to what degree the other agents 
know what they know. 

NOTE : This measure works on the Agent x Knowledge matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen. (2003). Dynamic Network Analysis. 133-145. 
Committee on Human Factors, National Research Council. 
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http://www.casos.cs.cmu.edu/publications/temp/hope110922160731
/carley_2003_dynamicnetwork.pdf. 

Minimum and Maximum Values 
Minimum : Possible 0 

Maximum : Possible 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Knowledge Binary 

Output :  

 

Level Data Type Type 
Graph Real Agent 
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Resource Actual Workload 

 

Description 
The resources an agent uses to perform the tasks to which it is 
assigned. 

NOTE : This measure works on the Agent x Resource, Resource x 
Task, and Agent x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  



997 
 

 

Network Data Type 

Agent by Resource Binary 

Resource by Task Binary 

Agent by Task Binary 

Output :  

 

Level Type Data Type 
Node Level Agent Real 

 

 

 

Resource Based Access Index 

 

Description 
Boolean value which is true if an agent has exclusive access to a 
resource and who is known by exactly one other agent. The one 
agent known also has its KAI set to one. 

An node level measure that computes the average shortest path 
length between entities, excluding infinite distances. This is known as 
the Resource Access Index (RAI) value. 

NOTE : This measure works on the Agent x Agent and Agent x 
Resource matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be in the binary format [ 0 or 1 ]. 

Example 



998 
 

Let us imagine a social network where 50 employees have many 
connections to each other. The average number of connections per 
employee is the Access Index.  

Informal Name 
None 

Citation 
Ashworth, M. and Carley, Kathleen M., 2003, "Critical Human 
Capital", Working Paper, CASOS, Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Agent by Agent Binary 

Agent by Resource Binary 

Output :  

 

Level Type Data Type 

Node Level Agent Binary 
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The Resource Access Index (RAI) for agent i is defined as 
follows: 

 

let 

Then 

 

 

 

Resource Based Task Completion 

 

Description 
The percentage of tasks that can be completed by the agents 
assigned to them, based solely on whether the agents have the 
requisite resources to do the tasks. 

NOTE : This measure works on the Agent x Resource, Agent x 
Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Bob is assigned 10 Tasks to complete which require a certain amount 
of resources to finish. However, on average only 10-percent of those 
resources will be available to Bob for him to complete the tasks 
given. This measure would compute a value for the likelyhood that 
Bob would be able to complete any given task. 

NOTE : Task Completion Overall is a combination of the Task 
Completion Knowledge and the Task Completion Resource. 
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Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 

Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 

Level Data Type 

Graph Real 

Find the tasks that cannot be completed because the agents 
assigned to the tasks lack necessary knowledge. 
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let Need = [(AT'*AR) - KT'] 

let S = { i | , j : Need(i,j) < 0 } 

Knowledge Based Task Completion is the percentage of tasks 
that could be completed = (|T|-|S|) / |T| 

 

 

Resource Diversity 

 

Description 
The distribution of difference in resource sharing. This is the 
Herfindahl-Hirshman index applied to column sums of AR. 

NOTE : This measure works on the Agent x Resource matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Characterizes the network in terms of how the items in a resource 
network (who has what) are non-uniformly distributed across 
employees 

Informal Name 
Who Has What 

Citation 
Hirschman A. O., 1945. National Power and the Structure of Foreign 
Trade. Berkeley: University of California Press. 

Minimum and Maximum Values 
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Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 

Agent by Resource Binary 

Output :  

 

Level Data Type 

Graph Real 

 

This is the Herfindahl-Hirshman index (economics: sum of the 
squares of each firm's market share) applied to the normalized 
column sums of AK. This measures the degree to which 
knowledge is equally known. 

let 

 

let 
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Then 

 

 

 

Resource Exclusivity 

 

Description 
Detects agents who have singular resource access. 

NOTE : This measure works on the Agent x Resource matrix and 
needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
A key resource that supports an entire organization is only accessible 
through one person. 

Informal Name 
None 

Citation 
Ashworth, M. and Carley, K. (2006). Who you know vs. what you 
know: The impact of social position and knowledge on team 
performance. Journal of Mathematical Sociology, 30(1):43{75. 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 

Network Data Type 
Agent by Resource Binary 

Output :  

 

Level Data Type Type 

Node Real Agent 

 

The Resource Exclusivity Index (REI) for agent i is defined as 
follows: 

 

The Resource Exclusivity Index (REI) for agent i is defined 
exactly as for Resource Based Exclusivity. 
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Resource Negotiation 

 

Description 
The extent to which agents need to negotiate with each other 
because they lack the resources to complete their assigned tasks. 

NOTE : This measure works on the Agent x Task, Agent x 
Resource, and Resource x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, Bob does not have access to the resources 
needed to complete a certain task but Sue does have it. Bob must 
negotiate with Sue to gain those resources. The extent to which 
others in the organization must negotiate for resources that others 
have is the organization's resource negotiation value. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: 
CMU 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Medium 

Input and Output 
Input :  

 

Network Data Type 
Agent by Task Binary 

Agent by Resource Binary 

Resource by Task Binary 

Output :  

 

Level Data Type 
Graph Real 

 

 

 

Resource Omega 

 

Description 
The degree to which agents reuse resources while doing their tasks. 

NOTE : This measure works on the Agent x Task, Resource x Task, and 
Task x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
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Sue has X amount of tasks within her company. How many of those tasks 
that require a resource that can be used for one or more of her other tasks 
is omega knowledge. This measure computes a value for such relations to 
the resources at the network level.  

Informal Name 
None 

Citation 
Carley, Kathleen M., Dekker, D., Krackhardt, D (2000). How Do Social 
Networks Affect Organizational Knowledge Utilitization.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Task Binary 

Resource by Task Binary 

Task by Task Binary 

Output :  

 
Level Data Type 

Graph Real 
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Let TAT = TA*TA' 

Let N = ((TT'@TAT)*KT')@KT' 

 

 

Resource Potential Workload 

 

Description 
Maximum resources an agent could use to do tasks if it were assigned to all 
tasks. 

NOTE : This measure works on the Agent x Resource and Resource x 
Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In a given organization, let us say Bob is assigned all task that exist in the 
organization. This measure would compute a value expressing Bob's 
potential to carry out all the tasks based on his connections to the resources 
and knowledge needed for the tasks.  

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible: 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Resource Binary 

Resource by Task Binary 

Output :  

 
Level Data Type Type 
Graph Real Agent 

Potential Knowledge Workload for agent i = sum((AK*KT)(i,:))/sum(KT) 

 

 

Resource Rendundancy 

 

Description 
Average number of redundant agents per resource. An agent is redundant if 
there is already an agent that has the resource. 

NOTE : This measure works on the Agent x Resource matrix and needs to 
be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. "Summary of Key Network Measures for 
Characterizing Organizational Architectures." Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : [(|R|-1)*|T|] 

Computational Time 
Fast 

Input and Output 
Input :  

 
Network Data Type 

Agent by Resource Binary 

Output :  

 
Level Data Type 

Graph Real 

 

This is the Column Redundancy of matrix RT. 
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Resource Under Supply 

 

Description 
The extent to which the resources needed to do tasks are unavailable in the 
entire organization. 

NOTE : This measure works on the Agent x Task, Agent x Resource, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
In an organization where Bob needs to complete Task A, he needs access to 
Resource B, which in this case might be a computer. However, what would 
happen if Resource B were simply unavailable? Say the computer was offline 
50-percent of the time. This computer would likely under supply the task of 
completing Task A. This measure would compute a value to the effect that 
this under supply factor affected the ability to perform the task at hand.  

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 
Level Data Type 
Graph Real 

This is the number of required knowledge not available to tasks based 
on the current agent task assignments normalized by the number of 
tasks. 

Resource Under Supply = sum(dich( RT - AR'*RT)) / |T| 
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Role Based Knowledge Availability 

 

Description 
Computes the number of roles that an agent is qualified to have based on 
knowledge requirements. 

Agent by Knowledge x Knowledge by Role = Agent by Roleresource 
subject to the additional constraint: 

If Max(Knowledge by Rolej)=0 (i.e. role j requires no knowledge) 
then Agent by Rolej=1 

A link Agent by Roleij indicates that agent i has no access to the 
knowledge needed for role j. 

NOTE : This measure works on the Agent x Knowledge and Knowledge x 
Role matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Behrman, Robert; forthcoming; "Network Analysis of the Structure and 
Capacity of Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Slow 

Input and Output 
Input :  

 
Network Data Type 

Agent by Knowledge Binary 

Knowledge by Role Binary 

Task by Role Binary 

Output :  

 
Level Data Type Type 
Node Real Agent 

 
 

 

Role Based Resource Availability 

 

Description 
Computes the number of roles that an agent is qualified to have based on 
Resource requirements. 

Agent by Resource x Resource by Role = Agent by Roleresource 

A Link Agent by Roleij indicates that agent i has the skills to use the 
resource required by role j. 

NOTE : This measure works on the Agent x Resource and Resource x 
Role matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 
None 

Citation 
Behrman, Robert; forthcoming; "Network Analysis of the Structure and 
Capacity of Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 
Network Data Type 

Agent by Resource Binary 

Resource by Role Binary 

Task by Role Binary 

Output :  

 
Level Data Type Type 
Node Real Agent 
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Role Based Knowledge 

 

Description 
Computes the degree to which agents are available to do tasks based on 
their access to knowledge and roles that are needed to do the tasks. 

NOTE : This measure works on the Agent x Knowledge, Knowledge x 
Role, and Task x Role matrices and needs to be in the binary format [ 0 or 
1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Behrman, Robert; forthcoming; "Network Analysis of the Structure and 
Capacity of Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  
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Network Data Type 

Agent by Knowledge Binary 

Knowledge by Role Binary 

Output :  

 
Level Data Type Type 
Node Real Agent 

 
 

 

Role Resource Availability 

 

Description 
Computes the number of roles that an agent is qualified to have based on 
resource requirements. 

NOTE : This measure works on the Agent x Resource and Resource x 
Role matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Behrman, Robert; forthcoming; "Network Analysis of the Structure and 
Capacity of Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 
Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 
Network Data Type 

Agent by Resource Binary 

Resource by Role Binary 

Output :  

 
Level Data Type 
Node Real 

 
 

 

Row Breadth 

 

Description 
The fraction of entities with row nodes with degree greater than one. 

Example : In a given organization, we have the following entities: 
employees (agents), computers (resources), benchmarks (tasks). This 
measure tells us on how many links greater than one exist within these 
entity types. 

NOTE : This measure works on Any Matrix and needs to be in the binary 
format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 
Data Type 

Binary 

Output :  

 
Level Data Type 
Graph Real 

 

Let d = the Row degree vector of the network N 

Then, the Row Breadth of N is: 
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NOTE : Column breadth is identical, except that d is defined using the 
column degree, rather than the row degree. 

 

 

Row Count 

 

Description 
The number of row nodes in a network. 

NOTE : This measure works on Any Matrix and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be [ The number of rows in a matrix ]. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Number of rows in the network 

Computational Time 
Fast 
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Input and Output 
Input :  

 
Data Type 
Binary 

Output :  

 
Level Data Type 

Graph Integer 

Result: Z > 0 

 

 

Row Degree Centrality 

 

Informal Name 
see Out Degree Centrality 

 

 

Row Degree Network Centralization 

 

Description 
A centralization based on the degree of the row nodes of a network. 

NOTE : This measure works on Any Matrix and needs to be in the binary 
format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
Also called OutDegree Network Centralization 

Citation 
NetStat 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 
Data Type 

Binary 

Output :  

 
Level Data Type 
Graph Real 

 

Let N be a network with n row nodes. 

let 
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let 

 

Then 

 

 

 

Row Redundancy 

 

Description 
The mean number of row node links in excess of one. 

NOTE : This measure works on Any Matrix and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be [ the average of links ]. 

Example 
Let us say in our organizational matrix, we have Bob who multiple links to 
Sue. Let us say this is multiple linkages has an average of 2.5 per employee 
to the same manager Sue or another. The measure computes a value for 
this average which is considering row redundancy.  

Informal Name 
None 
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Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : [(N-1)*M] 

Computational Time 
Fast 

Input and Output 
Input :  

 
Data Type 

Binary 

Output :  

 
Level Data Type 
Graph Real 

for N dimension m x n 

Let M be the matrix representation for a network N of dimension m x n. 

let 

 

for 
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this is the number of column entries in excess of one for row i. 

Then 

 

 

Sequential Link Count 

 

Description 
The percentage of links in a network that are neither Reciprocal Links nor 
Pooled Links. Note that an link can be both a Pooled and a Reciprocal link. 

NOTE : This measure works on Any Matrix and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
The percentage of edges in a network that are neither Reciprocal Edges nor 
Pooled Edges. Note that an edge can be both a Pooled and a Reciprocal 
edge. Self-loops are ignored. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 
Network Data Type 

Square Binary 

Output :  

 
Level Data Type 
Graph Real 

 

Let G=(V,E) be the graph representation of a network, and let X = set 
of Pooled edges of G, and let Y = set of Reciprocal edges of G. 

Then Sequential Edge Count = | E-X-Y| / |E| 
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Shared Situation Awareness 

 

Description 
Individuals or organizations that are high in group awareness are those that 
by virtue of their connections to others, what resources they use, what 
knowledge there is, what tasks there are - have a better understanding of 
what others are doing. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number of [ shared assets with other nodes ]. 

Example 
If we take any given pair of actors in an organization, this measure 
computes a value for how similar they are to each other based on their 
relationships (i.e., links) to others in the same organization. 

Informal Name 
None 

Citation 
Graham, J. M., Schneider, M., & Gonzalez, C. (2004). Report Social Network 
Analysis of Unit of Action Battle Laboratory Simulations: Ft Leavenworth 
2003 & Ft Lee 2004 (No. DDML Technical Report CMU-SDS-DDML-04-01): 
Carnegie Mellon University, Social & Decision Sciences, Dynamic Decision 
Making Laboratory. 

John Graham, 2005, "Dynamic Network Analysis of the Network-Centric 
Organization: Towards an Understanding of Cognition & Performance," 
Carnegie Mellon University, School of Computer Science, Institute for 
Software Research, Computation, Organizations and Society, June 20, 2005. 
Doctor of Philosophy. 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Unscaled real number 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Agent Binary 

Output :  

 
Level Data Type Type 
Node Real Agent 

Dyad Real Agent 

Both Node and Dyad are not scaled:  

Formula :  

Let 

 

Let A = Agent x Agent interaction/communication network. 

Let P = Agent x Agent physical proximity network. 

Let S = Agent x Agent social demographic similarity network. 

Let e = eigenvector centrality measure computed on A. 
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Let G = geodesics between agents computed on A. 

Then the SSA measure between agents i and j is: 

 

 

 

Similarity Correlation 

 

Description 
Measures the degree to which each pair of rows have overlapping data. 

NOTE : This measure works on Any Matrix and needs to be in the binary 
format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen, M., 2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 
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Input and Output 
Input :  

 
Data Type 
Binary 

Output :  

 
Level Data Type Type 

Node Real Row 

Dyad Real Row by Row 
 
 

 

Simmelian Ties 

 

Description 
The normalized number of Simmelian ties of each node. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
Described informally as ties embedded in cliques and are often associated 
with brokers inside such cliques such that if Bob and Susan only know of 
each other becuase of Chan and now all of them, Bob, Susan and Chan, now 
know each other. Chan, Bob, Susan now have simmelian ties to each 
other. 



1031 
 

Informal Name 
None 

Citation 
Krackhardt, David. 1998. "Simmelian Tie: Super Strong and Sticky." In 
Power and Influence in Organizations., edited by Roderick M. Kramer and 
Margaret Neale, pp. 21/38. Thousand Oaks, CA: Sage. 

Simmel, Georg. 1950. "The Sociology of Georg Simmel." New York: Free 
Press, 1st free press paperback edition. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Square Binary 

Output :  

 
Level Data Type 
Node Real 
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let N be a square network with n entities. The Simmelian Tie value for 
entity i is computed as follows: 

let NS = network N symmetrized using the Intersect (Minimum) 
method. 

All cliques of size >= 3 are computed on NS and clique membership 
is recorded. Let be the number of entities that are in a clique with 
entity i. 

Then the Simmelian Ties value for emtity i is . 

 

Skip Link Count 

 

Description 
The fraction of links in a unimodal network that skip levels. An link (i,j) is a 
skip link if there is a path from node i to node j even after the link (i,j) is 
removed. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
The fraction of edges in a unimodal network that skip levels. An edge (i,j) is 
a skip edge if there is a path from entity i to entity j even after the edge (i,j) 
is removed. 

Informal Name 
None 

Citation 
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Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible: 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 
Square Binary 

Output :  

 
Level Data Type 

Graph Real 

 

A skip link in a network G=(V,E) is an link (i,j)∈E such that j is reachable 
from i in the graph G'=(V,E\(i,j)), that is, the graph G with link (i,j) 
removed. Skip Count is simply the number of such links in G normalized 
to be in [0,1] by dividing by |E|.  
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Social Technical Congruence 

 

Description 
Social technical congruence represents the proportion of coordination 
requirements that were satisfied through some type of actual coordination 
activity carried out through some means of communication. 

NOTE : This measure works on the Agent x Agent, Agent x Task, and 
Task x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Cataldo, Marcelo, Wagstrom, Patrick, Herbsleb, James, & Carley, Kathleen 
M. (2006). Identification of Coordination Requirements: implications for the 
design of collaboration and awareness tools. Paper presented at the 2006 
Conference on Computer Supported Cooperative Work, Banff, Alberta. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
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A representation of the coordination requirements among the different 
workers is obtained by multiplying AT, TT and transpose of AT matrices. This 
product results in a people by people matrix where a cell ij indicates the 
extent to which person i works on tasks that share dependencies with the 
tasks worked on by person j. In other words, the resulting matrix represents 
the Coordination Requirements or the extent to which each pair of people 
needs to coordinate their work. 

Formally, the Coordination Requirements (CR) matrix is determined by the 
following product: 

Let, CR = AT * TT * transpose(AT) 

Given a particular CR matrix constructed from relating product dependencies 
to work dependencies, we can compare it to an Actual Coordination (CA) 
matrix that represents the interactions workers engaged in through different 
means of coordination. 

Diff (CR, CA) = card { diffij | crij > 0 & caij > 0 } 

|CR| = card { crij > 0 } 

We have, 

Congruence(CR, CA) = Diff (CR, CA) / |CR| 

Input and Output 
Input :  

 
Network Data Type 

Agent by Agent Binary 

Agent by Task Binary 

Task by Task Binary 

Output :  

 
Level Data Type Type 

Graph Real   
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Dyad Real Agent 

 

The Coordination Requirements (CR) matrix is determined by the 
following product: 

Let, CR = AT * TT * transpose(AT) 

Given a particular CR matrix constructed from relating product 
dependencies to work dependencies, we can compare it to an Actual 
Coordination (CA) matrix that represents the interactions workers 
engaged in through different means of coordination. 

Diff (CR, CA) = card { diffij | crij > 0 & caij > 0 } 

|CR| = card { crij > 0 } 

We have, 

Congruence(CR, CA) = Diff (CR, CA) / |CR| 

 

 

Span of Control 

 

Description 
The average number of out links per node with non-zero out degrees. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be the [ average number of out links for all non isolate 
nodes ]. 

Example 
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Bob has 5 out degree links to 5 other personnel in his company and of those 
5 personnel, the average non-zero (i.e., people that make up that personnel 
that have out-degree links of there own) is 4. Whereas Sue might have 5 
personnel out degree links, but those personnel have 3 out-degree links 
themselves on average. It would figure that Sue might have a greater span 
of control, since the people she connects do, don't have as many 
connections as those that Bob connects to does. This measure would 
compute a value for such relationships called Span of Control. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : ∈ ℜ [0,|V|-1] 

Computational Time 
Fast 

Input and Output 
Input :  

 
Network Data Type 
Square Binary 

Output :  

 
Level Data Type 
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Graph Real 

 

let S = set of entities in V that have positive out-degree 

let 

 

Then 

 

 

Strict Knowledge Congruence 

 

Description 
Measures the similarity between what knowledge are assigned to tasks via 
agents, and what knowledge are required to do tasks. Perfect congruence 
occurs when agents have access to knowledge when and only when it is 
needful to complete tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, 
and Knowledge x Task matrices and needs to be in the binary format [ 0 
or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
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Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Knowledge Congruence = 1 if agents have knowledge when and only when it 
is needful to complete their tasks. Thus, we compute the knowledge 
assigned to tasks via agents, and compare it with the knowledge needed for 
tasks. 

Input and Output 
Input :  

 
Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 
Level Data Type 
Graph Real 

Knowledge Congruence = 1 iff agents have knowledge when and only 
when it is needful to complete their tasks. Thus, we compute the 
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knowledge assigned to tasks via agents, and compare it with the 
knowledge needed for tasks.  

let KAT = dich(AK'*AT) 

let 

 

let <d = d / (|K|*|T|), which normalizes d to be in [0,1] 

Then Knowledge Congruence = 1 - d 

 

 

Strict Resource Congruence 

 

Description 
Measures the similarity between resources assigned to tasks via agents, and 
what resources are required to do tasks. Perfect congruence occurs when 
agents have resources when and only when it is needful to complete tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 

Citation 
Carley, Kathleen M., 2002. Summary of Key Network Measures for 
Characterizing Organizational Architectures. Unpublished Document: CMU 
2002. 
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Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Knowledge Congruence = 1 if agents have knowledge when and only when it 
is needful to complete their tasks. Thus, we compute the knowledge 
assigned to tasks via agents, and compare it with the knowledge needed for 
tasks. 

Input :  

 
Network Data Type 

Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 
Level Data Type 
Graph Real 

Resource Congruence = 1 iff agents have knowledge when and only 
when it is needful to complete their tasks. Thus, we compute the 
resource assigned to tasks via agents, and compare it with the resource 
needed for tasks.  

let RAT = dich(AK'*AT) 

let 
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let <d = d / (|K|*|T|), which normalizes d to be in [0,1] 

Then Resource Congruence = 1 - d 

 

 

Strong Component Count 

 

Description 
The number of strongly connected components in a network. The network 
can be directed or undirected. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ]. 

Informal Name 
None 

Citation 
Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Medium 

Input and Output 
Input :  

 

Given a square network G=(V,E), the Strong Component Count is the 
number of strongly connected components in G. This is computed directly 
on G, whether or not G is directed.  

 
Network Data Type 
Square Binary 

Output :  

 
Level Data Type 

Graph Integer 

 

Given a square, symmetric network G=(V,E), the Strong Component 
Count is the number of strongly connected components in G. This is 
computed directly on G, whether or not G is directed.  

 

Task Exclusivity 

 

Description 
Detects agents who exclusively perform tasks. Individuals or organizations 
that are high in complete exclusivity for tasks are those that are engaged in 
or assigned to tasks or activities for which no one else is engaged in or 
assigned to. The scientific name of this measure is complete exclusivity and 
it is calculated on agent by task matrices. 
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NOTE : This measure works on the Agent x Task matrix and needs to be in 
the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
A key task that supports an entire organization is only accessible through 
one person. 

Informal Name 
None 

Citation 
Ashworth, M. and Carley, K. (2006). Who you know vs. what you know: The 
impact of social position and knowledge on team performance. Journal of 
Mathematical Sociology, 30(1):43{75. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 
Network Data Type 

Agent by Task Binary 

Output :  
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Level Data Type Type 

Node Real Agent 

 

The Task Exclusivity Index (KEI) for agent i is defined as follows: 

 

The Task Exclusivity Index (TEI) for agent i is defined exactly as for 
Task Based Exclusivity. 

 

 

Task Knowledge Needs Congruence 

 

Description 
The number of knowledge not supplied to a task, but required to do the 
task, expressed as a percentage of the total knowledge required for the 
task. 

Task Knowledge Needs compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the under supply of 
knowledge to tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, 
and Knowledge x Task matrices and needs to be in the binary format [ 0 
or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 
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Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational 
Model of Organizational Learning and Decision Making. Pittsburgh, PA: 
Carnegie Mellon University, School of Computer Science, Institute for 
Software Research International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 
Level Data Type Type 
Node Real Agent 

 

Task Knowledge Needs compares the knowledge requirements of each 
task with the knowledge available to the task via agents assigned to it. 
It is similar to Knowledge Congruence, but quantifies only the under 
supply of knowledge to tasks. 
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Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge required but not supplied. 

Thus, 

 

The equation for Agent Resource Needs replaces AK with AR, and KT 
with RT. 

 

 

Task Knowledge Waste Congruence 

 

Description 
The number of knowledge supplied to a task via agents that are not required 
by it expressed as a percentage of the total knowledge required for the task. 

Task Knowledge Waste compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the over supply of 
knowledge to tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, 
and Knowledge x Task matrices and needs to be in the binary format [ 0 
or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 
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Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational 
Model of Organizational Learning and Decision Making. Pittsburgh, PA: 
Carnegie Mellon University, School of Computer Science, Institute for 
Software Research International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Knowledge Binary 

Agent by Task Binary 

Knowledge by Task Binary 

Output :  

 
Level Data Type Type 
Node Real Task 

 

Task Knowledge Waste compares the knowledge requirements of each 
task with the knowledge available to the task via agents assigned to it. 
It is similar to Knowledge Congruence, but quantifies only the over 
supply of knowledge to tasks. 
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Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge supplied but not required. 

Thus, 

 

The equation for Agent Resource Waste replaces AK with AR, and KT 
with RT. 

 

 

Task Resource Needs Congruence 

 

Description 
The number of resources not supplied to a task, but required to do the task, 
expressed as a percentage of the total resources required for the task. 

Task Knowledge Needs compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the under supply of 
knowledge to tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 
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Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational 
Model of Organizational Learning and Decision Making. Pittsburgh, PA: 
Carnegie Mellon University, School of Computer Science, Institute for 
Software Research International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 
Level Data Type Type 
Node Real Agent 

 

Task Knowledge Needs compares the knowledge requirements of each 
task with the knowledge available to the task via agents assigned to it. 
It is similar to Knowledge Congruence, but quantifies only the under 
supply of knowledge to tasks. 
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Let S = AT'*AR = resource supplied to tasks via assigned agents 

We need to sum the resources required but not supplied. 

Thus, 

 

The equation for Agent Resource Needs replaces AR with AK, and RT 
with KT. 

 

 

Task Resource Waste Congruence 

 

Description 
The number of resources supplied to a task via agents that are not required 
by it expressed as a percentage of the total resources required for the task. 

Task Knowledge Waste compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the over supply of 
knowledge to tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
None 



1052 
 

Citation 
Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational 
Model of Organizational Learning and Decision Making. Pittsburgh, PA: 
Carnegie Mellon University, School of Computer Science, Institute for 
Software Research International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 

Agent by Resource Binary 

Agent by Task Binary 

Resource by Task Binary 

Output :  

 
Level Data Type Type 
Node Real Task 

 

Task Knowledge Needs compares the knowledge requirements of each 
task with the knowledge available to the task via agents assigned to it. 
It is similar to Knowledge Congruence, but quantifies only the under 
supply of knowledge to tasks. 
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Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge required but not supplied. 

Thus, 

 

The equation for Agent Resource Needs replaces AK with AR, and KT 
with RT. 

 

 

Total Degree Centrality 

 

Description 
The Total Degree Centrality of a node is the normalized sum of its row and 
column degrees. Individuals or organizations who are "in the know" are 
those who are linked to many others and so, by virtue of their position have 
access to the ideas, thoughts, beliefs of many others. Individuals who are In 
the know are identified by degree centrality in the relevant social network. 
Those who are ranked high on this metrics have more connections to others 
in the same network. The scientific name of this measure is total degree 
centrality and it is calculated on the agent by agent matrices. 

Individuals or organizations who are In the know are those who are linked 
to many others and so, by virtue of their position have access to the ideas, 
thoughts, beliefs of many others. Individuals who are "in the know" are 
identified by degree centrality in the relevant social network. 

Square Matrices [binary] - between 0,1  
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NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
In The Know 

Citation 
Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 
Network Data Type 
Square Real 

Output :  

 
Level Data Type 

Node Real 
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Consider the matrix representation X of a square network with n 
entities. Each entity is assigned a value based on the sum of its row 
and columns. 

The Total Degree Centrality for 

 

NOTE : The diagonal values are ignored. 

 

 

Total Degree Network Centralization 

 

Description 
A centralization of a square network based on the Total-Degree Centrality of 
each node. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example :  

An organization has a sales team, computers, sales data and a marketing 
team. How central all of these entities are within the organization is its total 
degree network centralization value. 

Informal Name 
None 

Citation 
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Freeman, L.C. (1979). Centrality in Social Networks I: Conceptual 
Clarification. Social Networks, 1, 215-239.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Fast 

Input and Output 
Input :  

 
Network Data Type 

Square Real 

Output :  

 
Level Data Type 

Graph Real 

 

Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 
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Triad Count 

 

Description 
The number of triads centered at each node in a square network. A triad is a 
relationship amongst three nodes such that they constitute a distinct and 
important relationship which is deemed relevant to network architecture. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and the number of triads ]. 

Informal Name 
None 

Citation 
NetStat 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Integer (N-1) (N-2) 

Computational Time 
Medium 

Input and Output 
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Input :  

 
Network Data Type 

Square Binary 

Output :  

 
Level Data Type 

Node Integer 

  for N dimension n. 

Let G=(V,E) represent a square network with n entities. 

And let Triad be a matrix of dimension n x n. 

 

Then 

 

 

 

Transitivity 

 

Description 
The percentage of link pairs {(i,j), (j,k)} in the network such that (i,k) is 
also an link in the network. 
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NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
The percentage of pairs in the employee communication network where 
employee A is linked to B and B is linked to C and C is also linked to A 

Informal Name 
None 

Citation 
NetStat 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 
Square Binary 

Output :  

 
Level Data Type 
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Graph Real 

 

Let G = (V,E) be the graph representation of the square network. 

let 

 

let 

 

let 

 

Then 

 

 

 

Upper Boundedness 

 

Description 
The degree to which pairs of agents have a common ancestor. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
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In a given organization, if Bob and Ahmed were both hired by Pedro this 
measure would compute a value correlating to this shared ancestry or 
linkage that both have to Pedro. 

Informal Name 
None 

Citation 
Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal 
Organizations. In Computational Organization Theory, edited by Carley, 
Kathleen M. and M.J. Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 
1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Slow 

Input and Output 
Input :  

 
Network Data Type 

Square Binary 

Output :  

 
Level Data Type 
Graph Real 
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Weak Boundary Spanner 

 

Description 
A node which if removed from a network creates a new component. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be in the binary format [ 0 or 1 ]. 

Informal Name 
None 

Citation 
Corman, Thomas H., Leiserson, Charles E., Rivest, Ronald L., & Stein, 
Clifford. (2001). Introduction to Algorithms (2 ed.). Cambridge, MA: The MIT 
Press.  

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
Medium 

Input and Output 
Input :  
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Network Data Type Directed 

Square Binary No 

Output :  

 
Level Data Type 

Node Level Binary 

Input :  

Square matrix : DataType=binary and Directed=No. 

Output :  

Node Level : DataType=binary. 

 

Weak Component Count 

 

Description 
The number of weakly connected components in an undirected (symmetric) 
network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and the number weakly 
connected nodes ]. 

Informal Name 
None 

Citation 
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Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Integer Value 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type Directed 

Square Binary No 

Output :  

 
Level Data Type 

Graph Integer 

 

Given a square, symmetric network G=(V,E), the Weak Component 
Count is the number of connected components in G. Such components 
are called weak because the graph G is undirected. 

 

Weak Component Members 

 

Description 
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Computes the component to which each node belongs in the underlying, 
undirected network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, 
Location x Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and the number of weak 
components ]. 

Example 
Given a square, symmetric network G=(V,E), the Weak Component 
Member for a entity is the weak component to which the entity belongs. The 
components are numbered from 1 to the number of weak components 
(Weak Component Count). 

Informal Name 
None 

Citation 
Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods 
and Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 
Minimum Possible : 0 

Maximum Possible : Any Integer Value 

Computational Time 
Medium 

Input and Output 
Input :  

 
Network Data Type 
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Square Binary 

Output :  

 
Level Data Type 

Node Integer 

 

Given a square, symmetric network G=(V,E), the Weak Component 
Member for a entity is the weak component to which the entity belongs. 
The components are numbered from 1 to the number of weak 
components (Weak Component Count). 
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Reports and Measures Tables 

Go to Reports by Measure Table  

Measures by Report 
To use this table look up the Report in the left hand column and the 
Measures used in that report are listed in the right hand column. Some 
of the Reports list no measures as they are calculated using other means. 

Report Measures 

All Measures 
Computes a collection of 
measures and generates output 
in categories. Each category 
analyzes a particular aspect of 
the meta-network structure. 

Does not used predefined 
measures. This report allows you 
to choose which measures to run. 

Assessing Change In Plan 
Analyzes the similarity between 
a given network and a collection 
of other networks. 

Communication Congruence 

Belief Propagation 
Estimates belief propagation 
through social networks 

Betweenness Centrality, Closeness 
Centrality, Total Degree Centrality 

Capabilities 
Analyzes the knowledge, 
resource, and task capabilities of 
agents and organizations in the 
network. 

Communication Congruence, 
Organization Agent Knowledge 
Needs Congruence, Organization 
Agent Knowledge Waste 
Congruence, Organization Agent 
Resource Needs Congruence, 
Organization Agent Resource 
Waste Congruence, Organization 
Task Knowledge Needs 
Congruence, Organization Task 
Knowledge Waste Congruence, 
Organization Task Resource Needs 
Congruence, Organization Task 
Resource Waste Congruence, 
Socio Technical Congruence, Strict 
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Knowledge Congruence, Strict 
Resource Congruence 

Change in Key Entities 
Analyzes the changes over time 
of the agents that score highest 
in measure values 

Agent Level : Actual Workload, 
Betweenness Centrality, Clique 
Count, Cognitive Demand, 
Eigenvector Centrality, 
Eigenvector Centrality Per 
Component, Exclusivity, 
Exclusivity Complete, Potential 
Boundry Spanner, Row Degree 
Centrality, Total Degree Centrality 

Communication Network 
Assessment 
This report assesses a 
Communications network. As 
information on speed of 
information transmittal becomes 
available it will be updated. This 
report takes a resource by 
resource network (preferably 
one where the nodes are 
Communications devices and the 
links are the speed or reliability 
of the link). 

Failure : Boundry Spanner, 
Potential Boundry Spanner, 
Exclusivity 
Reliability Injected : 
Eigenvector Centrality, Total 
Degree Centrality 
Reliability Relaying : 
Betweenness Centrality 

Communicative Power 
Analyzes one or more semantic 
networks to classify concepts by 
measure values. 

Betweenness Centrality, Density, 
Link Count, Node Count, Total 
Degree Centrality 

Communicators 
Analyzes the Communication 
network (agent by agent) and 
gives high level statistics on its 
structure. 

Node Level : Betweenness 
Centrality, In Degree Centrality, 
Out-Degree Centrality 
Graph Level : Clique Count, 
Clustering Coefficient, Density, 
Node Count 

Context 
Compares measured values 
against various stylized forms of 
networks in an effort to 
characterize network topology. 

Average Distance, Betweenness 
Centrality, Burt Constraint, 
Closeness Centrality, Clustering 
Coefficient, Cognitive Demand, 
Connectedness, Efficiency, 
Fragmentation, Hierarchy, 
Information Centrality, Inverse 
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Closeness Centrality, Total Degree 
Centrality, Upper Boundedness 

Core Network 
Computes the core network and 
reports general statistics. 

Betweenness Centrality, Density, 
Node Count, Total Degree 
Centrality 

CPOF 
Analyzes the creation and 
modification of events and tasks 
and agent collaboration over 
time. 

Complexity, Density, In-Degree 
Centrality 

Critical Sets 
Finds critical sets of nodes in a 
network that best reach all other 
nodes, or whose removal 
maximally disrupts a network. 

Fragmentation 

Custom 
Computes a custom report with 
user selected measures and 
output tables, pictures, and 
figures. 

Whatever measures are selected 
by the user. 

Detect Spatial Patterns 
Find out whether a node 
attribute is clustered spatially, 
such that nodes are similar to 
nearby others. 

  

Drill Down 
Computes the drill down from a 
selected organization and then 
to a selected agent. 

  

GeoSpatial Assessment 
Finds nodes that are co-located 
based, and counts the number of 
nodes that appear at location 
pairs. 

Degree Centrality, Location 
Relevance, Spatial Betweenness 
Centrality, Spatial Closeness 
Centrality, Spatial Degree 
Centrality 

Group Talk 
Analyzes the relationship 
between agents and knowledge. 

Row Degree Centrality 

Hot Topics (Content Analysis) 
Analyzes semantic network   
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output from AutoMap. 

Immediate Impact 
Computes the key actors of the 
network, and then isolates them 
individually to determine the 
effect on measure values. 

Node Level : Betweenness 
Centrality, Cognitive Demand, 
Total Degree Centrality 
Impact : Average Distance, 
Average Speed, Clustering 
Coefficient, Communicaton 
Congruence, Complexity, Density, 
Diffusion, Fragmentation, Isolate 
Count, Knowledge Congruence, 
Overall Fragmentation, Overall 
Node Count, Performance as 
Accuracy 

Influence Net 
Displays the influence network 
and gives high level statistics on 
its structure. 

Betweenness Centrality, In Degree 
Centrality 

K-Centrality 
Calculates the geodesic 
centrality measures for various 
rdius values k, which 
approximates the geodesic 
computation by only considering 
neighbors within the radius 
distance. 

  

Key Entity 
Identifies key entities and 
groups who by virtue of their 
position in the network are 
critical to its operation.  

Agent Level : Actual Workload, 
Authority Centrality, Betweenness 
Centrality, Clique Count, 
Cognitivie Demand, Edge 
Betweenness Centrality, 
Eigenvector Centrality, 
Eigenvector Centrality Per 
Component, Exclusivity, 
Exclusivity Complete, Hub 
Centrality, Potential Boundry 
Spanner, Row Degree Centrality, 
Shared Situation Awareness, Total 
Degree Centrality 
Organizational Level : Authority 
Centrality, Betweenness 
Centrality, Column Degree 
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Centrality, Eigenvector Centrality, 
Exclusivity, Exclusivity Complete, 
Hub Centrality, Potential Boundry 
Spanner, Row Degree Centrality, 
Total Degree Centrality 
Knowledge Level : Betweenness 
Centrality, In-Degree Centrality, 
Row Degree Centrality, Total 
Degree Centrality 
Resource Level : Row Degree 
Centrality, Total Degree Centrality 
Location Level : Authority 
Centrality, Column Degree 
Centrality, Exclusivity Complete, 
Hub Centrality, Location 
Relevance, Row Degree Centrality, 
Spatial Eigenvector Centrality, 
Total Degree Centrality 
Event Level : Authority 
Centrality, Column Degree 
Centrality, Exclusivity Complete, 
Hub Centrality, Row Degree 
Centrality, Total degree Centrality 
Task Level : Authority Centrality, 
Column Degree Centrality, 
Exclusivity Complete, Hub 
Centrality, Row Degree Centrality, 
Total degree Centrality 
Performance Level : Average 
Speed, Communication 
Congruence, Complexity, Density, 
Fragmentation, Knowledge 
Congruence, Performance as 
Accuracy 

Large Scale 
Computes all network analysis 
measures. 

  

Local Patterns 
Find link patterns in a network, 
such as Star, Checkerboard, and 
Clique. 

Special, Clique Count 

Locate Subgroup Betweenness Centrality, Clique 
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Identifies the subgroups present 
in the network using various 
grouping algorithms. 

Count, Clustering Coefficient, 
Density, Total Degree Centrality 

Management 
Identifies over- and under-
performing individuals and 
assesses the state of the 
network as a functioning 
organization. 

Agent Level : Actual Workload, 
Authority Centrality, Cognitive 
Demand, Exclusivity, Exclusivity 
Complete, Hub Centrality, Shared 
Situation Awareness 
Knowledge Level : In-Degree 
Centrality 
Resource Level : In-Degree 
Centrality 
Location Level : In-Degree 
Centrality 
Performance Level : Column 
Breadth, Complexity, Knowledge 
Congruence, Resource 
Congruence, Shared Situation 
Awareness 
Potential Problems : Actual 
Workload, Cognitive Demand, In-
Degree Centrality, Shared 
Situation Awareness, Simmelian 
Ties  

MedHealth 
Analyzes health department data 
to find potential problems. 

Interaction : Density, Clustering 
Coefficient, Clique Count, 
Diffusion, Eigenvector Centrality, 
Hierarchy, In-Degree Centrality, 
Node Count, Out Degree 
Centrality, Simmelian Ties, Total 
Degree Centralization, Triad Count 
Node Level : Boundry Spanner, 
Total Degree Centrality 

Merchant Marine Vessel 
Analyzes the relationships 
between crew members, owners, 
vessels and locations of the 
Merchant Marine Vessel data. 

Betweenness Centrality, Column 
Degree Centrality, Eigenvector 
Centrality, Row Degree Centrality, 
Total Degree Centrality 

Missing Links 
Compute possible missing links 
in a network. 

Node Level : Betweenness 
Centrality, Total Degree Centrality 
Impact : Average Distance, 
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Average Speed, Clustering 
Coefficient, Communication 
Congruence, Density, Diffusion, 
Fragmentation, Isolate Count, 
Overall Complexity, Overall 
Fragmentation, Performance as 
Accuracy 

Network Distribution 
Analyzes a collection o Meta-
Networks and calculates their 
common nodes and links 

 

Optimizer 
Adapt the link structure of a 
meta-network to maximize or 
minimize selected measure 
values. 

User selects the Measures to run 

Part Of Speech 
Describe the distribution of 
concepts by part of speech in 
one or more networks. 

Betweenness Centrality, Total 
Degree Centrality  

Potential Errors 
Detects potential errors in agent 
to agent interactions based on 
the expected interactions from 
Cognitive Similarity and 
expertise. 

Cognitive Expertise, Cognitive 
Similarity 

Public Health 
Anayzes health department data 
to find potential problems. 

Access Redundacy, Assignment 
Redundacy, Average Distance, 
Clustering Coefficient, Density, 
Total Degree Centralization 

QAP/MRQAP Analysis 
Computes QAP and MRQAP 
Correlation and Regression 
(Dekker and Y-Permutation 
methods) on input networks. 

  

Role View 
For each individual, finds some 
important measures and facts 
about the actor in relation to 
their network 

Betweenness Centrality, Closeness 
Centrality, Complete Exclusivity, 
Eigenvector Centrality, Exclusivity, 
In-Degree Centrality, Out-Degree 
Centrality, Row Redundancy  
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Rules of Engagement 
This report analyzes the trails 
that are found in the Trails 
Viewer. 

Special 

Semantic Network 
Analyzes one or more semantic 
networks, computing the central 
networks and key concepts and 
links. 

Betweenness Centrality, Clustering 
Coefficient, Density, Diameter, 
Link Count, Node Count 

Shortest Path 
Computes the shortest path 
between two entities and 
general statistics on the paths. 
The sphere of influence of each 
entity is also computed. 

In Degree Centrality, Out Degree 
Centrality, Total degree Centrality 

Simmelian Ties 
Calculates the number of 
Asymmetric, Sole-Symmetric, 
and Simmelian Ties in unimodal 
networks computes standard 
measures on them. 

Node Level : Betweenness 
Centrality, Potential Boundry 
Spanner, Total Degree Centrality 
Graph Level : Density, 
Connectedness, Efficiency, 
Hierarchy, Link Count, Upper 
Boundedness 

Sphere of Influence 
For each individual, identifies 
the set of actors, groups, 
knowledge, resources, etc. that 
influence and are influenced by 
that actor. 

Actual Workload, Betweenness 
Centrality, Clique Count, Cognitive 
Demand, Eigenvector Centrality, 
Exclusivity, Exclusivity Complete, 
Potential Boundry Spanner, 
Shared Situation Awareness, Total 
Degree Centrality 

Standard Network Analysis 
Calculates the standard network 
analysis measures (Degree 
Centrality, Betweenness 
Centrality, etc). 

Node Level : Authority Centrality, 
Betweenness Centrality, Closeness 
Centrality, Eigenvector Centrality, 
Clique Count, Clustering 
Coefficient, Hub Centrality, In 
Closeness Centrality, Information 
Centrality, In-Degree Centrality, 
Out Degree Centrality, Simmelian 
Ties, Total Degree Centrality 
Graph Level : Average Distance, 
Betweenness Centrality, Clique 
Count, Closeness Centrality, 
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Clustering Coefficient, Column 
Count, Communicative Need, 
Connectedness, Density, 
Efficiency, Eigenvector Centrality, 
Fragmentation, Hierarchy, Isolate 
Count, Link Count, Network 
Levels, Row Count, Total Degree 
Centralition, Upper Boundedness, 
Weak Component Count 
Table : Betweenness Centrality, 
Closeness Centrality, Eigenvector 
Centrality, In-Degree Centrality, 
Out Degree Centrality, Total 
Degree Centrality 

Statistical Change Detection 
Analyzes the changes in 
network-level measures over 
time using a Statistical Process 
Monitoring (SPM) control chart. 
Control limits are determined 
based on a user defined level of 
risk. 

Betweenness Centrality, Closeness 
Centrality, Density  

Statistical Distribution User selects the measure to run 
for the analysis 

Tactical Insight 
 
Fits statistical distributions to a 
network based on measure 
values. Analyzes the top agent 
nodes across time periods, 
tracking locations and measure 
values. 

Betweenness Centrality, Total 
Degree Centrality 

Topic Analysis 
Finds topic clusters in a 
collection of text meta-networks 
using the LDA and LSA 
algorithms. 

 

Trails 
Analyzes the trails that an entity 
class makes through another 
entity class, for example, how 
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vessels pass through ports. 

Trails Analysis 
This report analyzes the trails 
that are found in the Trails 
Viewer. 

Agent Level : Betweenness 
Centrality, Clique Count, 
Eigenvector Centrality, Exclusivity, 
Potential Boundry Spanner, Row 
Degree Centrality, Total Degree 
Centrality 

Go to Measures by Report Table  

Reports by Measure 
To use this table look up the Measure in the left hand column and the 
Reports it is used in are in the right hand column. Some of the measures 
list All Measures meaning they are not standard in any report but can be 
be optionally selected. 

Measure Used by Report 

Access Redundancy All Measures 

Actual Workload All Measures, Changes in Key Entities, Key 
Entity, Management, Sphere of Influence 

Agent Knowledge 
Needs Congruence All Measures 

Agent Knowledge 
Waste Congruence All Measures 

Agent Resource 
Needs Congruence All Measures 

Agent Resource 
Waste Congruence All Measures 

Agent Socio 
Economic Power All Measures 

Assignment 
Redundancy All Measure 

Authority Centrality All Measures, Key Entity, Management, 
Standard Network Analysis 

Average Speed All Measures, Immediate Impact, Key Entity, 
Missing Links 
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Betweenness 
Centrality 

All Measures, Changes in Key Entities, 
Communication Net Health, Communications 
Network Assessment, Communicative Power, 
Communicators, Core Networks, Immediate 
Impact, Influence Net, K-Centrality, Key 
Entity, Missing Links, Part of Speech, Role 
View, Semantic Network, Simmelian Ties, 
Sphere of Influence, Standard Network 
Analysis, Statistical Change Detection, Tactical 
Insight, Trails Analysis 

Bonacich Power 
Centrality All Measures 

Boundary Spanner All Measures 

Burt Constraint All Measures 

Capability All Measures 

Characteristic Path 
Length 

All Measures, Immediate Impact, Missing 
Links, Standard Network Analysis 

Classic SNA Density All Measures 

Clique Count 

All Measures, Changes in Key Entities, 
Communication Net Health, Communicators, 
Key entities, Sphere of Influence, Standard 
Network Analysis, Trails Analysis 

Closeness Centrality 
All Measures, K-Centrality, Role View, 
Standard Network Analysis, Standard Network 
Analysis, Statistical Change Detection 

Closeness Network 
Centralization 

All Measures, K-Centrlaity, Standard Network 
Analysis 

Clustering 
Coefficient 

AllMeasures, Communicators, Immediate 
Impact, Missing Links, Semantic Network, 
Standard Network Analysis 

Cognitive Demand 
All Measures, Changes in Key Entities, 
Immediate Impact, Key Entity, Management, 
Role View, Sphere of Influence 

Cognitive 
Distinctiveness All Measures 

Cognitive Expertise All Measures, Potential Errors 
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Cognitive 
Resemblance All Measures 

Cognitive Similarity All Measures, Potential Errors 

Column Breadth All Measures, Management 

Columns Count All Measures, Standard Network Analysis 

Column Degree 
Centrality All Measures, Key Entity 

Column Degree 
Network 
Centralization 

All Measures 

Column Redundancy All Measures 

Communication All Measures 

Communication 
Congruence 

All Measures, Immediate Impact, Key Entity, 
Missing Links 

Communicative Need All Measures, Standard Network Analysis 

Complexity All Measures, Immediate Impact, Key Entity, 
Management 

Connectedness All Measures, Simmelian Ties Analysis, 
Standard Network Analysis 

Correlation 
Distinctiveness All Measures 

Correlation Expertise All Measures 

Correlation 
Resemblance All Measures 

Correlation 
Similarity All Measures 

Density 

All Measures, Communicative Net Health, 
Communicative Power, Communicators, Core 
Networks, Immediate Impact, Key Entity, 
Missing Links, Semantic Network, Simmelian 
Ties, Standard Network Analysis, Statistical 
Change Detection 

Diameter All Measures, Key Entity, Semantic Network 

Diffusion All Measures, Immediate Impact, Missing 
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Links 

Edge Betweenness 
Centrality All Measures, Key Entity 

Effective Network 
Size All Measures 

Efficiency All Measures, Simmelian Ties Analysis, 
Standard Network Analysis 

Eigenvector 
Centrality 

All Measures, Changes in Key Entities, 
Communications Net Health, Communications 
Network Assessment, Key Entity, Sphere of 
Influence, Standard Network Analysis, Trails 
Analysis 

Eigenvector 
Centrality Per 
Component 

All Measures, Changes in Key Entities, Key 
Entity, Standard Network Analysis 

Exclusivity 

All Measures, Changes in Key Entities, 
Communications Network Assessment, Key 
Entity, Management, Role View, Sphere of 
Influence, Trails Analysis 

Exclusivity Complete 
All Measures, Changes in Key Entities, Key 
Entity, Management, Role View, Sphere of 
Influencev 

Fragmentation All Measures, Immediate Impact, Key Entity, 
Missing Links, Standard Network Analysis 

Geodesic Distance All Measures 

Global Efficiency All Measures 

Hierarchy All Measures, Simmelian Ties, Standard 
Network Analysis 

Hub Centrality All Measures, Key Entity, Management, 
Standard Network Analysis 

In Degree Centrality 

All Measures, Communication Net Health, 
Communicators, Influence Net, Key Entity, 
Management, Role View, Standard Network 
Analysis 

In Degree Network 
Centralization All Measures 
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Information 
Centrality All Measures, Standard Network Analysis 

Interdependence All Measures 

Interlockers All Measures 

Inverse Closeness 
Centrality All Measures 

Isolate Count All Measures, Immediate Impact, Missing 
Links, Standard Network Analysis 

Knowledge Acess 
Index All Measures 

Knowledge Actual 
Workload All Measures 

Knowledge 
Congruence 

All Measures, Immediate Impact, Key Entity, 
Management 

Knowledge Diversity All Measures 

Knowledge 
Exclusivity All Measures 

Knowledge Load All Measures 

Knowledge 
Negotiation All Measures 

Knowledge Omega All Measures 

Knowledge Potential 
Workload All Measures 

Knowledge 
Redundancy All Measures 

Knowledge Task 
Completion All Measures 

Knowledge Under 
Supply All Measures 

Lateral Link Count All Measures 

Link Count 
All Measures, Communicative Power, Semantic 
Network, Simmelian Ties, Standard Network 
Analysis 

Local Efficiency All Measures 
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Location Relevance GeoSpatial Assessment, Key Entity 

Minimum Speed All Measures 

Network Levels All Measures, Standard Network Analysis 

Node Count 
All Measures, Communcation Net Health, 
Communicative Power, Communicators, Core 
Networks, Semantic Network 

Organization Agent 
Knowledge Needs 
Congruence 

All Measures 

Organization Agent 
Knowledge Waste 
Congruence 

All Measures 

Organization Agent 
Resource Needs 
Congruence 

All Measures 

Organization Agent 
Resource Waste 
Congruence 

All Measures 

Organization Task 
Knowledge Needs 
Congruence 

All Measures 

Organization Task 
Knowledge Waste 
Congruence 

All Measures 

Organization Task 
Resource Needs 
Congruence 

All Measures 

Organization Task 
Resource Waste 
Congruence 

All Measures 

Out Degree 
Centrality 

All Measures, communcation Net Health, 
Communicators, Role View, Standard Network 
Analysis 

Out Degree Network 
Centralization All Measures 

Overall Task All Measures 
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Completion 

Performance as 
Accuracy 

All Measures, Immediate Impact, Key Entity, 
Missing Links 

Personnel Cost All Measures 

Pooled Link Count All Measures 

Potential Boundary 
Spanner 

All Measures, Changes in Key Entities, 
Communication Net Health, Communications 
Network Assessment, Key Entity, Simmelian 
Ties, Sphere of Influence, Trails Analysis 

Potential Workload All Measures 

Radials All Measures 

Reciprocity All Measures, Standard Network Analysis 

Relative Cognitive 
Distinctiveness All Measures 

Relative Cognitive 
Expertise All Measures 

Relative Cognitive 
Resemblance All Measures 

Relative Cognitive 
Similarity All Measures 

Relative Expertise All Measures 

Relative Similarity All Measures 

Resource Access 
Index All Measures 

Resource Actual 
Workload All Measures 

Resource 
Congruence All Measures, Management 

Resource Diversity All Measures 

Resource Exclusivity All Measures 

Resource Load All Measures 

Resource 
Negotiation All Measures 
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Resource Omega All Measures 

Resource Potential 
Workload All Measures 

Resource 
Redundancy All Measures 

Resource Task 
Completion All Measures 

Resource Under 
Supply All Measures 

Row Breadth All Measures 

Row Count Standard Network Analysis 

Row Degree 
Centrality 

All Measures, Changes in Key Entities, Group 
Talk, Key Entity, Trails Analysis 

Row Degree Network 
Centraliztion All Measures 

Row Redundancy All Measures, Role View 

Sequential Link 
Count All Measures 

Shared Situation 
Awareness 

All Measures, Key Entity, Management, Sphere 
of Influence 

Simmelian Ties Management, MedHealth, Standard Network 
Analysis 

Skip Link Count All Measures 

Social Technical 
Congruence Capabilities 

Span of Control All Measures 

Spatial Betweenness 
Centrality GeoSpatial Assessment 

Spatial Closeness 
Centrality GeoSpatial Assessment 

Spatial Degree 
Centrality GeoSpatial Assessment 

Spatial Eigenvector 
Centrality Key Entity 
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Strict Knowledge 
Congruence Capabilities 

Strict Resource 
Congruence Capabilities 

Strong Component 
Count All Measures 

Task Exclusivity All Measures 

Task Knowledge 
Needs Congruence All Measures 

Task Knowledge 
Waste Congruence All Measures 

Task Resource Needs 
Congruence All Measures 

Task Resource 
Waste Congruence All Measures 

Total Degree 
Centrality 

All Measures, Changes in Key Entities, 
Communication Net Health, Communications 
Network Assessment, Communicative Power, 
Core Networks, Immediate Impact, Key Entity, 
Missing Links, Part of Speech, Simmelian Ties, 
Sphere of Influence, Standard Network 
Analysis, Tactical Insight, Trails Analysis 

Total Degree 
Network 
Centralization 

All Measures, Standard Network Analysis 

Transitivity All Measures 

Triad Count All Measures, Communication Net Health  

Upper Boundedness All Measures, Simmelian Ties Analysis, 
Standard Network Analysis  

Weak Boundary 
Spanner All Measures  

Weak Component 
Count 

All Measures, Communicators, Standard 
Network Analysis  

Weak Component 
Members All Measures  
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Report General Content 

This section contains content relevant to the reports but not specific to any 
one report. New information will be added as it received. 

 

 

Statistical Comparison 

Some reports support Statistical Comparison. For example, in the Key Entity 
report and the Standard Network Analytic reports bootstrapping techniques 
are used to assess statistical differences between statistics drawn from 
different networks. Two techniques are used: 

1. Random Reassignment : "Shuffle" the links in a network around - 
and thereby keep same size and density. 

2. Bootstrapping : Remove a small percentage of nodes and their 
attached links. 

To compare the metrics a t-statistic[ 1 ] is then calculated. Note that when 
the number of samples is large (> 100) the distribution for the t-statistic 
becomes the normal distribution. 

  

 

[ 1 ]t-statistic is a ratio of the departure of an estimated parameter from its 
notional value and its standard error.  

7 NOV 11 

 

 

Context In Reports 

Context attempts to address the question, "There's the measure values, 
but are they what I should expect? Are they low or high? I'm not 
sure what I should be seeing.". 
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The Context the user needs from their measure values is comparing their 
measure values with the measure values that would result from a random 
network of the same size and density. This is somewhat helpful in 
addressing the questions, but by no means complete. It essentially answers 
how different the user's network is from a random network, and this may, or 
may not, be that useful to some users. 

Most reports that use tables, which is nearly all of them, would show 
Context. 

If you run a report on a single meta-network, then the some of the tables 
you see would show the Context. Not all measures have it, only some of 
them. 

Example 

In-the-Know (total degree centrality) 
The Total Degree Centrality of a node is the normalized sum of its row and 
column degrees. Individuals or organizations who are "in the know" are 
those who are linked to many others and so, by virtue of their position have 
access to the ideas, thoughts, beliefs of many others. Individuals who are "in 
the know" are identified by degree centrality in the relevant social network. 
Those who are ranked high on this metrics have more connections to others 
in the same network. The scientific name of this measure is total degree 
centrality and it is calculated on the agent by agent matrices. 

Input network: characters x characters (size: 6, density: 0.466667) 

Rank Characters Value Unscaled Context* 

1 indiana_jones 1.00 5.00 2.62 

2 barranca 0.40 2.00 -0.33 

3 belloq 0.40 2.00 -0.33 

4 natives 0.40 2.00 -0.33 

5 satipo 0.40 2.00 -0.33 

6 jake 0.20 1.00 -1.31 

* Number of standard deviations from the mean of a random network of the 
same size and density 
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Mean:  0.47 Mean in random network:  0.47 

Std.dev:  0.25 Std.dev in random network:  0.20 

 
 

 

Why Use A Report 

NOTE : Red shaded reports are available only in the full version. 

Assessing Change 
in Plan 

Use this report to compare the Meta-Network of 
a plan [i.e. the anchor Meta-Network] with Meta-
Network that occur during the execution of the 
plan. 

Belief Propagation 
This report runs a simulation of the belief (or 
attitude) propagation based on the Friedkin 
model from the social influence theory.  

Capabilities This is used to assess an individuals' or 
organizations' capability to perform tasks. 

Change in Key 
Entities 

This report provides information on the overall 
structure of a complex network and identifies, for 
each type of node, which nodes stand out. 

Communications 
Network 
Assessment 

This report evaluates the effectiveness of a 
computer network, with the computer nodes 
being represented as resources. The computer 
network represents the physical layer of 
connections between machines. Effectiveness 
takes into account the placement of nodes in the 
network 

Communicative 
Power --- 

Communicators 

When characterizing network topologies, it is 
important to consider the role of errors and 
incomplete data in the network. This report will 
provide additional analysis on network topologies 
and actors, respectively. 

Context This report uses the Context function as a 
comparison of the user's input network with that 



1089 
 

of a random network of the same number of 
nodes and density. This is an attempt to address 
a frequent user question, "Well, okay, I see the 
measure values, but are they what I should 
expect? Are they low or high? I don't know 
what I should be seeing". 

Core Network 

Good for extracting the big giant connected 
component in real life networks that have 
multiple disconnected small subcomponents and 
a big, giant connected component. 

CPOF 
Use this to analyze the creation and modification 
of events and tasks and agent collaboration over 
time. 

Critical Sets 
This report has two functions. Find a set which 1) 
would fracture the Meta-Network the most or 2) 
which reaches the maximum number of nodes. 

Custom 

The custom report allows a user to be able to 
design a report to meet a specific need by 
identifying the metrics that should be calculated 
on an input network. The custom report would be 
used when a specific set of metrics or measures 
are needed routinely as opposed to simply 
producing the metrics directly each time.  

Detect Spatial 
Patterns --- 

Drill Down --- 

Geospatial 
Assessmenet --- 

Group Talk --- 

Hot Topics 

This report will identify the most frequently 
mentioned concepts in a text set. The networks 
are typically formed from AutoMap with a 
frequency attribute on each concept node. It can 
operate on any network (meta-network, 
semantic network, or concept network) as it 
makes use of only the nodes of the network. 

Immediate Impact This report to allow you to perform one of two 
types of evaluation against the base network. 
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The two types of analysis are : Impact analysis 
and Replication analysis. 
Impact analysis : One or more of the nodes 
identified in the Key Entities report are deleted 
as part of an assessment of the degradation in 
the network if those nodes were no longer in the 
network. This is a more precise version of impact 
analysis for node removal than random node 
removal. The report then shows the differences 
in values between the original and modified 
networks' at both the node and network measure 
levels. 
Replication analysis : Set a random number of 
nodes to delete, then the report will show the 
differences in values between the original and 
modified network's. Unlike impact analysis, the 
nodes are selected at random. The user also 
selects the number of iterations to execute, 
allowing a research to assess the vulnerability of 
a network to random node deletions. This is the 
more general impact analysis than the impact 
analysis discussed above. 

Influence Net --- 

Key Entity 

This is a go-to report to identify the important 
(or "key") who, what, where, when, and why. 
The input would be a social network in meta-
network form using all of the ORA ontological 
categories (agents, organizations, etc.). If only a 
subset of the categories are represented, the key 
entity report will show a subset of the who, what, 
where, when, and why. 

K-Centrality --- 

Large Scale --- 

Local Patterns --- 

Locate Subgroups --- 

Management 
Use this report to locate strongest and weakness 
parts of a Meta-Network and also the most well 
connected nodes. 

MedHealth --- 
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Merchant Marine --- 

Missing Links --- 

Network 
Distribution --- 

Optimizer --- 

Parts of Speech 

This report will identify the part of speech from 
the concepts in a text set. The networks are 
typically formed from AutoMap with a part of 
speech (pos) attribute on each concept node. It 
can operate on any network (meta-network, 
semantic network, or concept network) as it 
makes use of only the nodes of the network. 

Potential Errors --- 

Public Health --- 

QAP/MRQAP 

Compares multiple networks to understand how 
two different networks relate using one network 
as dependent and the other as an independent 
network. Also useful for predicting the future of a 
network if there are multiple snapshots of the 
same network. 

Role View --- 

Rules of 
Engagement 

This report is used to aid individuals in 
understanding rules of engagement. A rule of 
engagement (ROE) is a document describing how 
to behave in an engagement situation. This ROE 
report can operate on a law document as well as 
an ROE. 

Semantic Network 

The report outputs the nodes and edges in the 
intersection, offset, and union. Performing map 
comparison can help to answer questions such 
as: 
Do different people use the same words and 
themes in the same way? 
Do different people link concepts and themes in 
the same way? 
Do different people share the same knowledge? 
How similar or different are the analyzed texts? 

Shortest Path --- 
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Simmelian Ties 
Analysis --- 

Sphere of 
Influence 

The Sphere of Influence report will provide 
information relative to one particular node in the 
network. This report is used when the impact of 
an individual (person, organization, location, 
etc.) and what the individual is directly 
connected to. 

Statistical Network 
Analysis 

This report calculates the standard network 
analysis subset of all the measures possible for a 
network. This report is often used for 
convenience of calculating the measures that 
may be reported separately from the report, such 
as when writing a journal paper. Unlike many of 
the other reports that put the measure into the 
context of the need, this report produces 
measures suitable only for people who 
understand social network analysis.  

Statistical Change 
Detection --- 

Statistical 
Distribution --- 

Tactical Insight --- 

Topic Analysis --- 

Trails --- 

Trails Analysis 

Good for tracking and visualizing individual 
actors' geographic movements across a discrete 
space set over discrete time steps. Good for 
identifying trends like 1) is there any 
resemblence between different actors' moves? 2) 
are some locations more popular than others? 3) 
Is there a certain time range during which a big 
movement was triggered? 
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All Measures 

Description :  
Computes a collection of measures and generates output in categories. 
Each category analyzes a particular aspect of the meta-network structure. 

Why Use This Report 
This report calculates all the measures possible on a network. This report 
is often used for convenience of calculating the measures that may be 
reported separately from the report, such as when writing a journal paper. 
Unlike many of the other reports that put the measure into the context of 
the need, this report produces measures suitable only for people who 
understand the measures calculated by ORA. 

Input :  
Uses Nodesets and Networks from selected Meta-Networks. 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Choose to either Display all nodes or select the 
number of top ranked nodes. 
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Output :  
Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 

 

Assessing Change in Plan 

NOTE : This report only available in the full version. 

Why Use This Report 
Use this report to compare the Meta-Network of a plan [i.e. the anchor 
Meta-Network] with Meta-Network that occur during the execution of the 
plan. 

Analyzes a collection of Meta-Networks and show what has changed in 
terms of nodes and links when going from A to B. It is summerized in the 
following table. 

Uninvolved/Unattached nodes and links in A that are not 
in B A - B 

Common nodes and links in A and are also 
in B 

B intersect 
A 

New nodes and links not in A and in B B - A 
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Actor Analysis agent x agent, agent x organization, organization x 
organization 

Expertise and 
Resource Analysis 

agent x knowledge, agent x resource, organization 
x knowledge, organization x resource 

Task and Event 
Analysis 

agent x event, agent x task, organization x event, 
organization x task 

Input 
Requires at least two networks. To obtain a complete report the following 
Networks need to be in the Meta-Network. 
  

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : This contains two tabs: 

Ranked Entity Table :  

Measure Means Testing :  
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Output :  
Single Meta-Network, multiple Meta-Network comparison. 

 

 

Belief Propagation 

Why Use This Report 
This report runs a simulation of the belief (or attitude) propagation based 
on the Friedkin model from the social influence theory. 

Estimates belief propagation through social networks. This report contains 
the most common beliefs shared by most people, the beliefs with the 
highest GINI coefficient, the most strongly held beliefs, the most likely to 
change beliefs, the most neutral individuals, and the most opinionated 
individuals. 
  

Betweenness Centrality 

Closeness Centrality 

Total Degree Centrality 

NOTE : This report requires the Meta-Network to analyze contains a Belief 
Node Class. 

Input 
Requires a Belief Node Class 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 
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Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 

 

In addition you can set the Friedkin Algorithm Parameters and select the 
alpha measure. 

Finally you can set how contentious (likely to cause an argument) a belief 
is and choose the top ranked nodes. 

Output :  
Single Meta-Network, multiple Meta-Network comparison. 
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Capabilities 

NOTE : This report only available in the full version. 

Why Use This Report 
This is used to assess an individuals' or organizations' capability to 
perform tasks. 

Analyzes the knowledge, resource, and task capabilities of agents and 
organizations in the network. 

Congruence 

Communication Congruence, Organization 
Agent Knowledge Needs Congruence, 
Organization Agent Knowledge Waste 
Congruence, Organization Agent Resource 
Needs Congruence, Organization Agent 
Resource Waste Congruence, Organization 
Task Knowledge Needs Congruence, 
Organization Task Knowledge Waste 
Congruence, Organization Task Resource 
Needs Congruence, Organization Task 
Resource Waste Congruence, Strict Knowledge 
Congruence, Strict Resource Congruence, 
Social Technical Congruence  

agent x knowledge, agent 
x resource, agent x task, 
agent x resource, 
knowledge x task, 
resource x task, task x 
task, 

Agent Capability Analysis 

Overall Capability Index agent x knowledge, agent 
x resource, agent x task 

Capability Index in Expertise agent x knowledge 

Capability Index in Resources agent x resource 

Capability Index in Tasks agent x task 

Organization Capability Analysis 

Overall Capability Index organization x resource 

Capability Index in Resources organization x resource 

Task Requirement Analysis 
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Overall Requirement Index task x knowledge, task x 
resource 

General Requirement Index in Expertise task x knowledge 

General Requirement Index in Resources task x resource 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. 

 

Output :  
Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 
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Change In Key Entities 

Why Use This Report 
This report provides information on the overall structure of a complex 
network and identifies, for each type of node, which nodes stand out.  

Analyzes the changes over time of the agents that score highest in 
measure values. 

A complex network typically is a meta-network with multiple types of 
entities such as people, expertise, resources and locations. Overall 
structure is defined using meta-network metrics such as Overall 
Complexity, Social Density, Social Fragmentation, Communication 
Congruence, Knowledge Congruence, Performance as Accuracy, and 
Average Communication Speed. Key entities within each of the component 
networks are identified in terms of metrics such as Degree Centrality, 
Cognitive Demand, Specialization, and Redundancy. Separate key-entity 
pages are produced for each type of entity. For example, if there are 
people and resources - then key people and key resources are both 
identified. If the user selects two or more networks, this report will 
compare the results. 

  

Workload agent x knowledge, agent resource, agent 
x task, knowledge x task, resource x task 

Betweenness Centrality 
[Potentially Influential] agent x agent 

Clique Count agent x agent 

Cognitive Demand [Emergent 
Leader] agent x agent 

Eigenvector Centrality [Leader 
of Strong Clique] agent x agent 

Relatively Unique [Knowledge] agent x agent 

Complete Exclusivity 
[Knowledge] agent x knowledge 
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High Betweenness/Low 
Degree agent x knowledge 

Row Degree Centrality agent x agent 

Total Degree Centrality agent x knowledge 

Input 
At least two Meta-Networks. 
  

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. 

 

Output :  
Single Meta-Network. 
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Communications Network Assessment 

Why Use This Report 
This report evaluates the effectiveness of a computer network, with the 
computer nodes being represented as resources. The computer network 
represents the physical layer of connections between machines. 
Effectiveness takes into account the placement of nodes in the network. 

This report assesses a communications network. As information on speed 
of information transmittal becomes available it will be updated. This report 
takes a resource by resource network (preferably one where the nodes 
are communications devices and the links are the speed of reliability of 
the link). 
  

All reports resource x resource 

NOTE : This report uses the Context function as a comparison of the 
user's input network with that of a random network of the same number of 
nodes and density. This is an attempt to address a frequent user question, 
"Well, okay, I see the measure values, but are they what I should 
expect? Are they low or high? I don't know what I should be seeing". 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 
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Output :  
Single Meta-Network 

 

 

Communicative Power 

Why Use This Report :  
Use this report to analyze one or more semantic networks to classify 
concepts by measure values. 
  

NOTE : Also see Cube Analysis in General Content section. 

  

Betweenness Centrality 

Density 

Link Count 

Node Count 

Total Degree Centrality 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 
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Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 

 

Communicators 

Why Use This Report 
When characterizing network topologies, it is important to consider the 
role of errors and incomplete data in the network. This report will provide 
additional analysis on network topologies and actors, respectively. 

Analyzes the communication network (agent by agent) and gives high 
level statistics on its structure. 
  

In-Degree Centrality agent x agent 

Out-Degree Centrality agent x agent 

Betweenness Centrality agent x agent 

Node Count" agent x agent 

Weak Component Count agent x agent 

Clique Count agent x agent 

Density agent x agent 

Clustering Coefficient agent x agent 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 
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Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network, side-by-side comparison. 

References 
"Relating Network Topology to the Robustness of Centrality Measures", 

CASOS Technical Report, Terrill L. Frantz, Kathleen M. Carley May 
2005. 

"On the robustness of centrality measures under conditions of imperfect 
data", Borgatti, Carley, Krackhardt. /Social Networks/ 28 (2006) 124-
136. 

 

Context 

Why Use This Report 
NOTE : This report uses the Context function as a comparison of the 
user's input network with that of a random network of the same number of 
nodes and density. This is an attempt to address a frequent user question, 
"Well, okay, I see the measure values, but are they what I should 
expect? Are they low or high? I don't know what I should be seeing". 

Input 
Compares measured values against various stylized forms of networks in 
an effort to characterize network topology. 

NOTE : Works on Square Networks Only 

Summary 

Erdos-Remy, Core Perophery, Cellular All Square Networks 

Topology 

Betweenness Centrality, Closeness random networks of various 
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Centrality, Inverse Closeness 
Centrality 

topologies with identical size and 
density 

Values Context 
Average Distance 

agent x agent 

Betweenness Centrality 

Closeness Centrality 

Clustering Coefficient Density 

Cognitive Demand 

Connectedness 

Burt Constrain 

Efficiency 

Fragmentation 

Hierarchy 

Information Centrality 

Inverse Closeness Centrality 

Total Degree Centrality 

Upper Boundedness 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network. 
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Core Network 

Why Use This Report 
Good for extracting the big giant connected component in real life 
networks that have multiple disconnected small subcomponents and a big, 
giant connected component. 

Computes the core network and reports general statistics. The Core 
Network is the largest component (sub-graph) in the graph. 
  

Centrality 
Set of selected networks 

Potentially Influential (Betweenness Centrality) 

NOTE : This report uses the Context function as a comparison of the 
user's input network with that of a random network of the same number of 
nodes and density. This is an attempt to address a frequent user question, 
"Well, okay, I see the measure values, but are they what I should 
expect? Are they low or high? I don't know what I should be seeing". 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network, side-by-side comparison. 
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CPOF 

NOTE : This report only available in the full version. 

Why Use This Report 
Use this to analyze the creation and modification of events and tasks and 
agent collaboration over time. 

This report finds out: 

Who are the top two busiest agents across time in terms of the total 
number of events and tasks modified or created? 

What is the busiest time period in terms of average agent activity? 

Which pairs of events are most likely to occur together? 

The co-occurence analysis requires that the networks be conformed so 
that entity sets are identical across networks. 

Which pairs of tasks are most likely to occur together? The co-
occurence analysis requires that the networks be conformed so that 
entity sets are identical across networks. 

Key Geo-Stickies 
In-Degree Centrality event x location 

Overall Complexity  
Collaboration Density agent x agent 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 
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Output :  
Single Meta-Network, multiple Meta-Network comparison. 

 

 

Critical Sets 

NOTE : This report only available in the full version. 

Why Use This Report 
This report has two functions. Find a set which 1) would fracture the 
Meta-Network the most or 2) which reaches the maximum number of 
nodes. 

Finds critical sets of nodes in a network that best reach all other nodes, or 
whose removal maximally disrupts a network. 
  

Parameters 

Fragmentation Selected Networks 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : The main items to choose here are the network to explore 
and the type of critical set you want to find. These are 1) A set whose 
removal will most fragment the network or 2) A set that most reaches 
other nodes in the network. 
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Secondly you need to set the size of your critical set and the number of 
iterations to perform. 

Lastly place a check mark in the box if you want to create a new Meta-
Network based on this critical set. 

Output :  
Single Meta-Network. 

 

 

Custom 

Why Use This Report 
The custom report allows a user to be able to design a report to meet a 
specific need by identifying the metrics that should be calculated on an 
input network. The custom report would be used when a specific set of 
metrics or measures are needed routinely as opposed to simply producing 
the metrics directly each time. 
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Computes a custom report with user selected measures and output tables, 
pictures, and figures. 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
A single Meta-Network. 

 

 

Detect Spatial Patterns 

Why Use This Report 
This report will find out whether a node attribute is clustered spatially, 
such that nodes are similar to nearby others. 
  

Network Properties Set of Selected Networks 

Input 
NOTE : Requires a Location Node Class with Latitude and Longitude 
attributes. 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 
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Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select a Location and an Agent Nodeset and the Network 
where links are located at. 

 

Place a check mark next to any of the attributes you want analyzed. 

Place a check mark in the Add a meta-network box to add this new 
meta-network to ORA. 
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Output :  
Single Meta-Network 

 

 

Drill Down 

Why Use This Report 
Computes the drill down from a selected organization and then to a 
selected agent. 

Input 
Whatever node(s) you want to analyze. 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select two nodes from any Nodeset to expand. In the 
bottom section you can limit which Nodeset will be displayed in the display 
by removing any of the check marks. 
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Output :  
A single Meta-Network. 

 
 

 

Geospatial Assessment 

Why Use This Report 
This report finds nodes that are co-located based, and counts the number 
of nodes that appear at location points. 
  

agent x location 

Parameters 
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Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select a Location Nodeset. 

 

You have two choices for determining the distance between locations. 1) 
distances from Latitude/Longitude and 2) Distance from attribute in 
Nodeset. 

All Networks containing the Location Nodeset will appear. Select the 
one(s) to analyze by placing a check mark next to their name. 

Select the number of links to list. 
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Select whether or not to group the links. 

Finally place a check mark in the box if you want to create a new Meta-
Network. 

Output :  
A single Meta-Network. 

 
 

 

Group Talk 

Why Use This Report 
When you need to find either the most prevelant knowledge or the 
greatest amount of agents discussing one particular knowledge. 

Analyzes the relationship between agents and knowledge. 
  

agent x agent, agent x knowledge, agent x role 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
A single Meta-Network. 

X[i] = X[i] / sum(X) 

Then the entropy is computed as: 
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Entropy is (-1 * (sum of (X[i] * log(X[i]))/ log (2.0) 

Entropy: 
Entropy is measured using Shannon's Entropy measure (Shannon, 1948; 
Shannon, 1951). It is a measure of uncertainty. ORA takes the data 
vector, converts in to a probability distribution and then applies Shannon's 
formula. 

Given a vector X (e.g. the vector of out-degrees for the AK graph) 

NOTE : It only applies to measures with non-negative values. 

The overall approach used is to: 

1. compute a measure with non-negative values: x1, x2, ..., xN  

2. divide each xi by the sum(x1, x2, ..., xN) - to create a probability 
distribution - and so create: p1, p2, ..., pN 

3. Shannon Entropy is then calculated as the -sum_over_i(pi * 
log_base_2(pi)). 

The density of a network is defined as: The number of edges divided by 
the number of possible edges. 

References: 
Shannon, Claude E.. A Mathematical Theory of Communication. Bell System 

Technical Journal, July/October 1948. 

Shannon, Claude E.: Prediction and entropy of printed English, The Bell 
System Technical Journal, 30:50-64, January 1951. 

 

 

Hot Topics 

Why Use This Report 
This report will identify the most frequently mentioned concepts in a text 
set. The networks are typically formed from AutoMap with a frequency 
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attribute on each concept node. It can operate on any network (meta-
network, semantic network, or concept network) as it makes use of only 
the nodes of the network. 

This report analyzes semantic network output from AutoMap and provides 
standard content analysis information. When you have semantic network 
data or lists of concepts, networks derived from email content, or texts or 
documents of any sort. 

It outputs the most frequent concepts and the least frequent concepts. 
Given a semantic network, this report displays statistics on the concepts 
and links in the map, and the distribution of concept frequencies. This 
report takes unstructured information into account. Running the hot topics 
report is similar to performing content analysis [1]. The user can vary the 
number of highest scoring terms to output. 
  

Concept Frequency one attribute 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of Ranked Entities to display 



1119 
 

 

Select an attribute that specifies the number of times the concept 
occurred in the text. 

Finally place a check mark in the box if you want to add this new network. 

Output :  
Single Meta-Network, multiple Meta-Network comparison. 

[1]    Carley, K.M., Content Analysis, in The Encyclopedia of Language and 
Linguistics, R.E. Asher, Editor. 1990, Pergamon Press: Edinburgh. p. 
725-730.  

 

 

Immediate Impact 

Why Use This Report 
This report to allow you to perform one of two types of evaluation against 
the base network. The two types of analysis are : Impact analysis and 
Replication analysis. 
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Impact analysis : One or more of the nodes identified in the Key 
Entities report are deleted as part of an assessment of the degradation 
in the network if those nodes were no longer in the network. This is a 
more precise version of impact analysis for node removal than random 
node removal. The report then shows the differences in values between 
the original and modified networks' at both the node and network 
measure levels. 

Replication analysis : Set a random number of nodes to delete, then 
the report will show the differences in values between the original and 
modified network's. Unlike impact analysis, the nodes are selected at 
random. The user also selects the number of iterations to execute, 
allowing a research to assess the vulnerability of a network to random 
node deletions. This is the more general impact analysis than the 
impact analysis discussed above. 

Computes the key actors of the network, and then isolates them 
individually to determine the effect on measure values. 

This report allows the user to engage in what if analysis about the 
immediate impact of removing one or more nodes. Comparative statistic 
techniques are used to assess the network with and without the nodes in 
question. 

The user identifies a network, identifies which node or nodes to remove, 
and then ORA computes the consequent changes in the network by 
removing those nodes in terms of overall network structure and key 
entities. A feature of this report is that the user can save the meta-
network with the removed nodes and then assess the modified network 
with any of the other reports. 

The Immediate Impact report is designed to help users understand how 
the removal of certain nodes, or a certain number of nodes, can effect a 
network. An Impact Analysis allows users to select specific nodes in the 
network to remove, and then compare various metrics between the 
original network and the network where these specific nodes are removed. 
In a Replication Analysis, users specify a specific number of random 
nodes to remove from a network. Users can then compare metrics of the 
original network with the average of a series of networks from which the 
set number of random nodes has been removed. 
  

Betweenness Centrality agent x agent 
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Total Degree Centrality agent x agent 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 

 

Impact Network [optional] : Specify one or more nodes to add or 
remove from a Meta-Network. 

Replication Analysis [Number of Replications] : Repeatedly remove a 
specified number of nodes uniformly at random from the meta-network. 

Output :  
Single Meta-Network. 
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Influence Net 

Why Use This Report 
Displays the influence network and gives high level statistics on its 
structure. 

NOTE : This report uses the Context function as a comparison of the 
user's input network with that of a random network of the same number 
of nodes and density. This is an attempt to address a frequent user 
question, "Well, okay, I see the measure values, but are they what 
I should expect? Are they low or high? I don't know what I should 
be seeing". 

Input 

Betweenness 
Centrality agent x agent, task x task 

In Degree 
Centrality 

agent x agent, agent x location, agent x profession, agent 
x task, agent x event, agent x knowledge, event x 
location, knowledge x task, task x event, agent x 
organization, atsk x task, knowledge x profession, task x 
profession, organization x resource, resource x task, 
resource x profession, agent x resource 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 
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IMPORTANT : If your Network consists of more than one Nodeset and 
one Network you must place a check mark in the Transform the input 
network into an inference network before proceeding. 

Lastly place a check mark in the Add inference network to create a new 
Metw-Network. 

Output :  
Single Meta-Network. 

 

 

Key Entity 

Why Use This Report 
This is a go-to report to identify the important (or "key") who, what, 
where, when, and why. The input would be a social network in meta-
network form using all of the ORA ontological categories (agents, 
organizations, etc.). If only a subset of the categories are represented, 
the key entity report will show a subset of the who, what, where, when, 
and why. 
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Identifies key entities and groups who by virtue of their position in the 
network are critical to its operation. 

This report performs a network-level report to find Overall Complexity, 
Social Density, Social Fragmentation, Communication Congruence, 
Knowledge Congruence, Performance as Accuracy, and Avg 
Communication Speed. (Replaces the Event Analysis, Intelligence, and 
Location Analysis Reports). 

Input 

Who Analysis 

Cognitive Demand [Emergent 
Leader] agent x agent 

Total Degree Centrality [In-The-
Know Leader] agent x agent 

Clique COunt [Number of Cliques} agent x agent 

Row Degree Centrality [Most 
Knowledgable} agent x knowledge 

Row Degree Centrality [Most 
Resources] agent x resource 

Eigenvector Centrality per 
Component [Leader of Strong 
Cliques] 

agent x agent 

Hub Centrality [Act as a Hub] agent x agent 

Authority Hub [Act as an 
authority] agent x agent 

Betweenness Centrality 
[Potenitally Influential Leader] agent x agent 

High Betweenness/Low Degree 
[Connects Groups] agent x agent 

Relatively Unique [Specialization - 
Knowledge] agent x knowledge 

Complete Exclusivity [Knowledge] agent x knowledge 

Relatively Unique [Resource] agent x resource 

Complete Exclusivity [Resource] agent x resource 
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Relatively Unique [Task] agent x task 

Complete Exclusivity [Task] agent x task 

Relatively Unique [Event] agent x event 

Complete Exclusivity [Event] agent x event 

Relatively Unique [Location] agent x location 

Complete Exclusivity [Location] agent x location 

Actual Workloads 
agent x knowledge, agent x resource, 
agent x task, knowledge x task, 
resource s task 

Shared Situation Awareness 
[Group Awareness] agent x agent 

  

How Analysis - Knowledge 
Total Degree Centrality [Dominant 
Knowledge] 

All networks based on 
knowledge 

Row Degree Centrality [Most Needed] knowledge x task 

Betweenness Centrality [Supply Chain 
Criticality] knowledge x knowledge 

  

How Analysis - Resource 
Total Degree Centrality [Dominant 
Knowledge] 

All networks based on 
resource 

Row Degree Centrality [Most Needed] resource x task 

  

What Analysis - Event 

High Concentration of Actors agent x 
event 

High Concentration of Tasks task x event 



1126 
 

Actors at the Most events agent x 
event 

Tasks at the Most events task x event 

Events Where There Are Actors That Are Not At Other 
Events 

agent x 
event 

Events Where There Are Tasks That Are Not At Other 
Events tasks x event 

  

What Analysis - Task 
Central Tasks task x task 

Acts as a Hub task x task 

Acts as an Authority task x task 

High Concentration of Actors agent x task 

High Concentration of Knowledge knowledge x 
task 

High Concetration of Resources resource x task 

High Concentration of Tasks task x task 

High Knowledge Complexity knowledge x 
task 

High Resource Consumption resource x task 

Actors at the Most Tasks agent x task 

Knowledge at the Most Tasks knowledge x 
task 

Resource at the Most Tasks resource x task 

Tasks at the Most Tasks task x task 

Tasks Where There Are Actors That Are Not at Other 
Tasks agent x task 

Tasks Where There Are Knowledge That Are Not at 
Other Tasks 

knowledge x 
task 

Tasks Where There Are Resources That Are Not at Other 
Tasks resource x task 
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Tasks Where There Are Tasks That Are Not at Other 
Tasks tasks x task 

  

Where Analysis 

Most Active Locations For Events event x location 

Highest Concentration Of Actors agent x location 

Actors At The Most Locations agent x location 

Locations Where There are Groups Of 
Actors 

agent x agent, agent x 
location 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 
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In addition you can select which entity to analyze: Who, How, What, or 
Where. 

Output :  
Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 

 

K-Centrality 

Why Use This Report 
When working with large networks this measure limits the surrounding 
neighborhood. 

Calculates the geodesic centrality measures for various radius values k, 
which approximates the geodesic computation by only considering 
neighbors within the radius distance. 
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Input 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. 

 

Output :  
Single Meta-Network. 
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Large Scale 

Why Use This Report 
Computes all network analysis measures. 

Input 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network. 

 

 

Local Patterns 

Why Use This Report 
Helps reveal which nodes are in which pattern motifs and also shows the 
number of motifs in a Meta-Network. 

Finds link patterns in a network, such as Star, Checkerboard, and Clique. 

Input 

Clique Count agent x agent 

Parameters 
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Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select one Network to analyze. 

 

In the Report mode you can choose to find selected patterns or only the 
patterns for a single selected node. 

In the bottom section define your pattern using the four parameters. 

Finally place a check mark in the box if you want to add the networks to 
Meta-Networks to the Meta-Network Manager pane. 
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Output :  
Single Meta-Network. 

 

 

 

Locate SubGroups 

Why Use This Report 
Identifies the subgroups present in the network using various grouping 
algorithms. Most algorithms only work on a single network at a time 

Input 
Will analyze the networks selected by the user. 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : In Step 1 select the types of transformation to apply. This 
deals with, among other paramters, isolates and pendants. Place a check 
mark next to all the transformations you want to apply. 
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In Step 2 you can choose any or all algorithms to run. Each will have it's 
own parameters such as the number of groups in Newman, the minimum 
number of cliques in Cliques, or the relationship types and link method in 
Johnson. 
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Dialog Box 4 : Finally you select the type of output you want. Again, 
place a check mark next to all the algorithms you want in the output. 

Create group membership network : Divides nodes into groups 
based on the algrithm selected. 

Create block diagram - silo betwork : A diagram of a system, in 
which the principal parts or functions are represented by blocks 
connected by lines, that show the relationships of the blocks. 

Create Hierarchical clustering diagram : Place objects into group 
suggested by the data such that objects in a given cluster tend to be 
similar to each other in some sense, and objects in different clusters 
tend to be dissimilar. 

Create dendrogram : A tree diagram frequently used to illustrate the 
arrangement of the clusters produced by hierarchical clustering. 



1135 
 

 

Create measure value distribution : Computes and displays 
information about each group. Measure calculations are performed on 
the sub-network defined the group, e.g. the group member nodes and 
the links between them. 

Create attribute value distributions : This table shows the 
percentage of group members that have each attribute value. These are 
categorical attributes, which means they are text or numeric category 
values, such as 'Gender' or 'Years Experience'. 

Group Sub-Network Measures 
This section computes and displays information about each group. Measure 
calculations are performed on the sub-network defined the group, e.g. the 
group member nodes and the links between them. Information for each 
group includes Size, Density, EI-Index, Clustering Coefficient, and 
Characteristic Path Length. 

Cluster Analysis Metrics 
Newman Modularity Value : Measure the strength of division of a 
network into groups. High modularity means dense connections between 
nodes within the groups but sparse connections between different groups. 

Davis-Bouldin Index : Evaluates clustering algorithms where validation 
of the clustering i smade using quantities and features inherent to the 
dataset. NOTE: This doesn't necessarily imply the best information was 
used in the dataset. 

Dunn Index : Identifies sets of clusters that are compact with small 
variance between members of the cluster and the mean of different 
clusters is far apart. 
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Output :  
Single Meta-Network 

 

 

Management 

Why Use This Report 
Use this report to locate strongest and weakness parts of a Meta-Network 
and also the most well connected nodes. 

Identifies over- and under- performing individuals and assesses the state 
of the network as a functioning organization. 

Like some of the other key-entity reports, the Management Report uses a 
multi-modal network to consider various aspects of an organization and 
report both organizational-level metrics as well as node-measures. This 
report includes identification of both top-ranked actors and knowledge, 
but also least-ranked actors. Thus, this report provides answers to 
questions such as: 

Which actors are most central to the organization? 

What knowledge comprise the organization's core competencies? 

Which actors have access to the least knowledge? 

Which actors are not well-integrated socially? 

How much of the knowledge is unique to only one actor (across all actors)? 

Input 

Key Entities: Agent - Who 

Cognitive Demand agent x agent 

Hub Centrality agent x agent 

Authority Centrality agent x agent 
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Workload agent x knowledge, agent x resource, agent 
x task, knowledge x task, resource x task 

Shared Situtation 
Awareness agent x agent 

Role Knowledge Availability agent x knowledge, knowledge x profession 

Role Resource Knowledge agent x resource, resource x profession 

Specialization - Knowledge 
(Relatively Unique) agent x knowledge 

Complete Exclusivity - 
Knowledge agent x knowledge 

Specialization - Resource 
(Relatively Unique) agent x resource 

Complete Exclusivity - 
Resource (Complete 
Exclusivity) 

agent x resource 

Specialization - Task 
(Relatively Unique) agent x task 

Complete Exclusivity - Task 
(Complete Exclusivity agent x task 

Simmelian Ties   

Core Competency 

Knowledge agent x knowledge 

Resource agent x resource 

Tasks agent x task 

Performance Indicators 

  
agent x agent, agent x knowledge, agent x 
task, knowledge x task, agent x resource, 
resource x task 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 
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Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 

 

Output :  
Single Meta-Network, multiple Meta-Network comparison. 

 

 

MedHealth 

NOTE : This report only available in the full version. 

Why Use This Report 
Analyzes a collection of Meta-Network that represent nursing units. 

Input 

Interaction 

Betweenness Centrality  

Clique Count  
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Clustering Co-effeicient  

Density  

Diffusion  

Eigenvector Centrality  

Hierarchy  

In-Degree Centrality  

Node Count  

Out-Degree Centrality  

Simmelian Ties  

Total Degree Centrality  

Triad Count  
Node Level 

Boundary Spanner  

Total Degree Centrality  

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network, multiple Meta-Network comparison 
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Merchant Marine 

NOTE : This report only available in the full version. 

Why Use This Report 
Analyzes the relationship between crew members, owners, vessels, and 
locations of the Merchant Marine Vessel data. It is used with a special 
data-set developed by CASOS.  

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 

The bottom box contains two tabs: [Crew] all of the agents in the Meta-
Networks and [Vessels] placed in the Resource Node Class. 

Output :  
Single Meta-Network. 
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Missing Links 

NOTE : This report only available in the full version. 

Why Use This Report 
Compute possible missing links in a network 

Any one chosen square network in the Meta-Network. If multiple Meta-
Networks are chosen then your choice is only from the networks they 
have in common. 
  

Network Level 
Measures 
[square 
network] 

Average Communication Speed, Betweenness Centrality, 
Characteristic Path Length, Clustering Coefficient, 
Communication Congruence, Diffusion, Fragmentation, 
Isolated Agents, Social Density, Overall Complexity, 
Overall Fragmentation, Performance As Accuracy, Total 
Degree Centrality 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select a network to analyze. 
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Next choose the algorithms to run on the network. 

Select the input networks. 

If you desire to run multiple replication analysis place a check mark in the 
bottom box. Then select the Number of replications and the Percent of 
links to remove. 
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Output :  
Single Meta-Network. 

 

 

Network Distribution 

Why Use This Report 
Analyzes a collection of Meta-Networks and calculates their common 
nodes and links 

Input : 
At least two networks. 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. Lastly select which 
Meta-Network to use as an anchor. 
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You can choose an anchor network which can be included or excluded in 
the comparison. 

The lossy percentage sets the threshold for ndoes and links to be 
included. 

Symmetric Differences allows you to add these to either the ORA Meta-
Network pane or write to disk. 

Next is whether to use Euclidean or Hamming distance. 
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Computing the distances between all pairs of input networks can be a 
time-consuming process. 

Output : 
Single Meta-Network, side-by-side comparson, multiple Meta-Network 
comparison. 

 
 

 

Optimizer 

Why Use This Report 
Adapt the link structure of a Meta-Network to maximize or minimize 
selected measure values. 

Input :  
Any network in the selected Meta-Networks, with or without isolates. 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the networks to optimize. 
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Next select the Network and Node measures to run. For each you can 
choose either minimum or maximum. 



1147 
 

 

Output :  
Single Meta-Network. 

 

 

Part of Speech 

Why Use This Report 
This report will identify the part of speech from the concepts in a text set. 
The networks are typically formed from AutoMap with a part of speech 
(pos) attribute on each concept node. It can operate on any network 
(meta-network, semantic network, or concept network) as it makes use of 
only the nodes of the network. 
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Describe the distribution of concepts by part of speech in one or more 
networks. 
  

Semantic Network Betweenness Centrality and Total Degree Centrality 

Input :  
Any network in the selected Meta-Networks which contains an attribute 
named Frequency and that that attribute contains numeric values. 

NOTE : The Nodeset to analyze needs an attribute which contains the parts 
of speech. This is usually titles pos. 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network, multiple Meta-Network comparison. 

 

 

Potential Errors 

NOTE : This report only available in the full version. 

Why Use This Report 
Detects potential errors in agent to agent interactions based on the 
expected interactions from cognitive similarity and expertise. 
  

Homophilly Cognitive Similarity, Cognitive Expertise 
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Input :  
agent x agent  

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network. 

 

 

Public Health 

NOTE : This report only available in the full version. 

Why Use This Report 
Analyzes health department data to find potential problems. 

Input :  

Organizational Level Measures 

Communication Centralization, Communication Density, 
Clustering Coefficient, Characteristic Path Length,  

agent x 
agent 

Ranked Centrality Measures 

Betweenness Centrality, Degree Centrality, Potential Boundary 
Spanner 

agent x 
agent 

Task, Knowledge, Resource Networks 
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Silo Analysis 

Internal Links (same group) and External (different groups) agent x 
agent 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select an attribute to use for the analysis. 

 

Next select the tis for you input network. 

Output :  
Single Meta-Network. 
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QAP/MRQAP Analysis 

Why Use This Report 
Compares multiple networks to understand how two different networks 
relate using one network as dependent and the other as an independent 
network. Also useful for predicting the future of a network if there are 
multiple snapshots of the same network. 

Computes QAP and MRQAP Correlation and Regression (Dekker and Y-
Permutation methods) on input networks. 

MRQAP : Used for multivariate cases if your dependent variable is 
continuous or count data (like in a negative binomial case), you should 
use MRQAP. If your dependent variable is binary, you should use ERGM 
(P*) which is forthcoming in ORA. One can perform MRQAP on data that 
have a dichotomous dependent variable (basically, this is equivalent to 
using a linear probability model). You do need to interpret your results 
accordingly. 

The MRQAP report is setup to compare the networks within a single 
MetaNetwork: e.g. communication vs department membership. However, 
you can also select multiple MetaNetworks for MRQAP, but you can not do 
regression of a network in one MetaNetwork vs a network in a different 
MetaNetwork. 

You can do a regression using networks in the same and or different 
meta-networks. Moreover, you can take a vector and create a repeated 
column or repeated row network and use that network in the regression 
as well. 

QAP Analysis : Computes QAP Correlation and Regression (Dekker and 
Y-Permutation methods) on input matrices. QAP is designed as a bivariate 
test (only two variables). Generally, QAP is perfectly fine for almost any 
bivariate network problem. 

Input :  
Define the independent matrices as well as the dependent network used in 
the QAP calculations. This is also given a random number seed and 
number of permutations to run.  
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Lastly you can set to run any of the following: QAP Correlation, Dekker 
Regression, or Y-Permutation Regression analysis. 

NOTE : QAP can use either directed or undirected data. 
 
NOTE : When comparing Networks both Networks seend to be the same 
size. 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 
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Output :  
Single Meta-Network. 

See Also 
Regression 

 
 

 

Role View 

Why Use This Report 
For each individual, finds some important measures and facts about the 
actor in relation to thier network. 

Input 

In-Degree Centrality agent x agent 

Out-Degree Centrality agent x agent 

Betweenness Centrality agent x agent 

Eigenvector Centrality agent x agent 

Exclusivity [knowledge] agent x knowledge 

Exclusivity [resource] agent x resource 

Exclusivity [task] agent x task 

Exclusivity [location] agent x location 

Closeness Centrality agent x agent 

Complete Exclusivity [knowledge] agent x knowledge 

Complete Exclusivity [resource] agent x resource 

Complete Exclusivity [task] agent x task 

Complete Exclusivity [location] agent x location 

Row Redundancy [agent] agent x agent 



1154 
 

Row Redundancy [task] agent x task 

Row Redundancy [resource] agent x resource 

Row Redundancy [knowledge] agent x knowledge 

Row Redundancy [organization] agent x organization 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the node(s) to analyze. You can use the Attribute 
Filter tab to select nodes with only certain attributes. When finished click 
[ Next > ]. 
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Output :  
Single Meta-Network, multiple meta-network comparison. 

 

 

Rules of Engagement 

NOTE : This report only available in the full version. 

Why Use This Report 
This report is used to aid individuals in understanding rules of 
engagement. A rule of engagement (ROE) is a document describing how 
to behave in an engagement situation. This ROE report can operate on a 
law document as well as an ROE. 
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Analyzes the Rules of Engagement network and gives high level statistics 
on its structure. 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select 
an attribute and value to further refine you analysis. 
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Select from one of the options for the type of analysis 

Select a type of analysis :  

Search for a matching article by term :  

Compare all articles :  

Mission analysis : Analyze the difference between an historic body of law, 
mission rules of engagement, and current applicable laws of the sea. 

Output :  
Single Meta-Network, multiple Meta-Network comparison 

 

 

Semantic Network 

Why Use This Report 
The report outputs the nodes and edges in the intersection, offset, and 
union. Performing map comparison can help to answer questions such as: 

This report analyzes one or more semantic networks, computing central 
networks and key concepts and links. It assesses the connection among 
concepts. Will derive networks from email content, texts, or documents of 
any sort. 

The semantics networks report analyzes one or more semantic networks, 
computes the central graphs, and key concepts and links. This is a 
comparison of two or more semantic networks. Each node in the network 
is considered a concept, and each link connects two concepts. Link 
weights are interpreted as the number of times it occurred in the 
underlying input text. 

The report includes tests whether the two semantic networks are 
statistically different using four different T-tests, based on the number of 
nodes, the number of links, betweenness centrality, and degree centrality. 
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The symmetric distance of network A to network B is the number of 
concepts and links in A that are not in B. In set theoretic terms, this is the 
set difference (A - B). 

This report also provides communicative power analysis. Concepts are 
classified according to whether they have high and low values for the 
measures : 

Total Degree Centrality 

Betweenness Centrality 

Consensus 

The semantic network report will perform analysis on a semantic network 
of concept colocations in a sentence generated by AutoMap. It will 
characterize the usage of words, such as a buzzword which is used but not 
described such as is often found in law documents. There are other word 
types based on how they exist within the semantic network. 

Ordinary (low degree, low betweenness, low consensus) 

Factoids (low degree, low betweenness, high consensus) 

Buzzwords (low degree, high betweenness, low consensus) 

Emblems (low degree, high betweenness, high consensus) 

Allusions (high degree, low betweenness, low consensus) 

Stereotypes (high degree, low betweenness, high consensus) 

Placeholders (high degree, high betweenness, low consensus) 

Symbols (high degree, high betweenness, high consensus) 

The report also creates new networks that represent different levels of 
agreement between the loaded networks. The set-theoretic intersection 
on the 25, 50, 75% percent level is considered for this comparison. More 
precisely, the following outputs are computed: 

The union of compared links. 

The consensus between networks as it is represented by the intersection of 
links. 
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The dissension between networks as it is represented as the difference. 

Do different people use the same words and themes in the same way? 

Do different people link concepts and themes in the same way? 

Do different people share the same knowledge? 

How similar or different are the analyzed texts? 

Input :  
Set the percentage of maps a link must be in in order to be included in the 
central network. 

Output :  
Single Meta-Network, side-by-side comparison. 

Select whether to generate hamming distances between Meta-Networks. 

[1] Carley, K.M., Network text analysis: The network position of concepts, in 
Text Analysis for the Social Sciences: Methods for Drawing Statistical 
Inferences from Texts and Transcripts, C.W. Roberts, Editor. 1997, 
Lawrence Erlbaum Associates, Inc.: Mahwah, NJ, USA. p. 79-100. 

 
 

 

Shortest Path 

Why Use This Report 
Computes the shortest path between two entities and general statistics on 
the paths. The sphere of influence of each entity is also computed. 

Input :  

Organizational Level Measures agent x agent 

Ranked Centralizty Measures agent x agent 
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Task, Knowledge, Resource Networks   

Silo Analysis agent x agent 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select a Start and End node. 
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In the bottom section place a check mark next to all Nodesets that can be 
used when computing the shortest path. 

Output :  
Single Meta-Network. 

 

 

Sphere of Influence 

Why Use This Report 
The Sphere of Influence report will provide information relative to one 
particular node in the network. This report is used when the impact of an 
individual (person, organization, location, etc.) and what the individual is 
directly connected to. 

For each individual, identifies the set of actors, groups, knowledge, 
resources, etc. that influence, and are influenced, by that actor. 

Any network. But it's most interpretable if you have an agent by agent 
and also have another network such as agent by knowledge or agent by 
resources or agent by location. 

Input : 

Cognitive Demand agent x agent 

Centrality, Total Degree agent x agent 

Clique Count agent x agent 

Centrality, Row Degree agent x knowledge 

Centrality, Row Degree agent x resource 

Centrality, Eigenvector agent x agent 

Centrality, Hub agent x agent 

Centrality, Authority agent x agent 

Centrality, Betweenness agent x agent 
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Boundary Spanner, Potential agent x agent 

Exclusivity agent x knowledge 

Exclusivity, Complete agent x knowledge 

Exclusivity agent x resource 

Exclusivity, Complete agent x resource 

Exclusivity agent x task 

Exclusivity, Complete agent x task 

Exclusivity agent x event 

Exclusivity, Complete agent x event 

Exclusivity agent x location 

Exclusivity, Complete agent x location 

Actual Workload agent x knowledge 

Shared Situation Awareness agent x agent 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select a Start and End node. 

Place a check mark next to all Networks to analyze. 
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Select all, some, or none of the following options:  

Output :  
Single Meta-Network. 

 

 

Standard Network Analysis 

Why Use This Report 
This report calculates the standard network analysis subset of all the 
measures possible for a network. This report is often used for convenience 
of calculating the measures that may be reported separately from the 
report, such as when writing a journal paper. Unlike many of the other 
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reports that put the measure into the context of the need, this report 
produces measures suitable only for people who understand social 
network analysis. 

Calculates the standard network analysis measures (Degree Centrality, 
Betweenness, etc). 

This report calculates the standard network analysis measures such as 
Degree Centrality, Betweeness Centrality, etc. This report can be used on 
any "square network" where all the nodes are of one type; e.g., a people 
x people or resource x resource network. The standard network analysis 
measures typically provide an analyst with a broad overall picture of the 
structure of the network. If the user selects two or more networks, this 
report will compare the results. 

Input :  
A Single Meta-Network with any number of Nodesets and Networks. All 
applicable measures will be run on these networks. 

Measure Level 
Authority centrality Node 

Betweenness centrality Node 

Betweenness centrality Network 

Characteristic path length Network 

Clique count Network 

Clique membership count Node 

Closeness centrality Network 

Closeness centralization Network 

Clustering coefficient Node 

Column count Network 

Component count Network 

Connectedness Network 

Degree centralization Network 

Density Network 

Efficiency Network 
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Eigenvector centrality Node 

Hierarchy Network 

Hub centrality Node 

In-degree centrality Network 

Information centrality Node 

Isolate count Network 

Link count Network 

Network levels (diameter) Network 

Network fragmentation Network 

Out-degree centrality Network 

Reciprocity Network 

Row count Network 

Simmelian ties Node 

Total degree centrality Node 

Upper Boundedness Network 

Output :  
Single Meta-Network, side-by-side comparison. The report will be split 
into individual pages for each Network and how the results of the 
measures on each. 

 

 

Statistical Change Detection 

Why Use This Report 
Analyzes the changes in network-level measures over time using a 
Statistical Process Monitoring (SPM) control chart. Control limits are 
determined based on a user defined level of risk. 
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Statistical 
Change 
Detection 

The entire Meta-Network 
OR 
agent x agent -or- task x task 

Input : 
At least three Networks. 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select an algorithm: Shewhart X-Bar Chart or 
Cumulative Sum (CUSUM) Chart. 

 

Dialog Box 3 : Next set the Number of Networks and the Risk Probability 
of False Alarm. 
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Choose whether to use the entire Meta-Network of one individual 
Network. 

Finally select all, some, or none of the following measures to run: 
Betweenness Centrality, Closeness Centrality, or Density. 

Output :  
Single Meta-Network, multiple Meta-Networks. 

 

 

Statistical Distribution 

Why Use This Report 
Fits statistical distributions to a network based on measure values. 

When characterizing network topologies, it is important to consider the 
role of errors and incomplete data in the network. The Statistical Context 
and Communicators reports will provide additional analysis on network 



1168 
 

topologies and actors, respectively. For additional work on this subject, 
please refer to: 
  

Method of Least Square Error [LSE], Method 
of Maximum Likelihood Estimation [MLE], 
Method of Moments [MOM] 

Centrality 
Authority 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select a Input Network and an Input Measure. 

 

Select all, some, or none of the following distributions: 

Normal (Gaussian) :  

Uniform :  
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Exponential :  

Gamma :  

Beta :  

ChiSquare :  

Output :  
Single Meta-Network. 

References 
"Relating Network Topology to the Robustness of Centrality Measures", 

CASOS Technical Report, Terrill L. Frantz, Kathleen M. Carley May 
2005. 

"On the robustness of centrality measures under conditions of imperfect 
data", Borgatti, Carley, Krackhardt. /Social Networks/ 28 (2006) 124-
136. 

 

 

Tactical Insight 

NOTE : This report only available in the full version. 

Why Use This Report 
Use this to identify the important agents, locations and time periods in 
scenario data where you have geospatially located agents communicating 
over time. 

Analyzes the top agent nodes across time periods, tracking locations and 
measure values. 

Top Agenet, Common Locations, 
Final Location 

Total egree Centrality, Betweenness 
Centrality 

Input :  
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At least three networks. 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Output :  
Single Meta-Network, Multiple Meta-Network comparison. 

 

 

Topic Analysis 

Why Use This Report 
Finds topic clusters in a collection of text meta-networks using the LDA 
and LSA algorithms. 

Concept vs. Frequency, Topic 
Membership, Latent Semantic 
Analysis 

Concept(s) with Maximum Value, 
Concepts with Top-Ranked 
Membership Values 

Input 
Every node is included and considered as a concept. The frequency of 
each concept is determined by the value of its frequency attribute. 

NOTE : Requires an attribute Frequency to exist in the Meta-Network 

Parameters 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
Dialog Box also gives you Transformation options for the final results. 
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Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select Latent Semantic Analysis [LSA] or Latent Dirichlet 
Allocation [LDA]. LSA request the number of topics. LDA adds to this he 
Number of Iteratins, Step Size, anbd Beta. 

 

Output :  
Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 

 

Trails 

Why Use This Report 
Analyzes the trails that an entity class makes through another entity 
class, for example, how vessels pass through ports. 
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Input :  
At least two networks. Also requires data in trails format so the report can 
show who or what was where or when. Could also be who or what 
interacted with who or what when. 

Output :  
Single Meta-Network. 

 

 

Trails Analysis 

Why Use This Report 
Good for tracking and visualizing individual actors' geographic movements 
across a discrete space set over discrete time steps. Good for identifying 
trends like 1) is there any resemblence between different actors' moves? 
2) are some locations more popular than others? 3) Is there a certain time 
range during which a big movement was triggered? 

Analyzes the trails that are found in the Trails Viewer. It does this by 
analyzing the trails of one Nodeset as it makes its way through another 
Nodeset (e.g. how vessels pass through ports). 
  

Betweenness Centrality, Clique Count, Co-Exit Analysis, Co-Location 
Analysis, Co-Movement Analysis, Co-Occurrance Analysis, Eigenvector 
Centrality, Presence, Total Degree Centrality, Transitions, Unique Links 

Parameters : 
Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first 
panel also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Nodesets and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new 
Meta-Network. 

Dialog Box 3 : Select the number of nodes to display. 
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The bottom section allows you to refine your analysis. Place a check mark 
next to each option desired. 

Co-Entry : Nodes entering another node together. 

Co-Exit : Nodes leaving a node together. 

Co-Handoff : One node enters when another node exits. 

Co-Occurrance : Nodes at the same location. 

Presence : Nodes at the same location but not at the same time. 

Transtitions : Nodes traveling along the same link route but not at the 
same time. 

From the drop down menu choose the Network to analyze. 

Finally, place a check mark in the bottom box to add this new pattern 
network to the Meta-Network. 
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Output :  
Single Meta-Network with multiple Meta-Network comparison. 

 

 

Twitter 

Why Use This Report 
Finds tweeters of influence. 

Input :  
Identifies key tweeters and tweets in a meta-network derived from twitter 
data. 

Parameters : 
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Dialog Box 1 : Select the Meta-Networks to use in the analysis. For 
Dynamic Networks, click [ Select All ] underneath the Meat-Network then 
click [ Next > ] 
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Dialog Box 2 : Select the Nodesets and the Networks to analyze. Place 
a check mark in the box at the bottom will create a new Meta-Network. 
Click [ Next > ] 
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Dialog Box 3 : Select the number of nodes to display. You can create a 
GeoSpatial Visualization by placing check marks in the to boxes then 
click [ Browse ]. This allows you to select a ShapeFile for the GeoSpatial 
Visualizer. click [ Next > ] 

Select the format types for the reports, set the folder to save them in and 
enter a report prefix. click [ Finish ] 

Output :  
Single Meta-Network with side-by-side comparisons. 

The report lists an analysis of: Tweeters, Hashtags, Locations, and 
Tweets. 

AboutThe Twitter Report 
It identifies key influencers, their target audience, and the connection of key 
influencers to the target audience 

We need in the report a list of key influencers and then for each a separate 
page for each actor (each key influencer) listing number of direct followers, 
secondary followers (followers of followers) number of direct retweeters, 
secondary retweeters (number of those retweet the retweet) 
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Where is the influencer : The city and country or just country 

Their region of influence : What geographic region they and their 
retweeters and followers are in - i.e. show a shape file with the region 
colored shaded over in a polygon or the snake circles 

What topics/hashtags do they tweet about : Show their hashtag 
network and the hashtags in the retweets. Plus the connections among the 
hashtags in their messages [in one color] and the connections to other 
hashtags in the retweets [in another color]. 

Fraction pf follower/retweet : Of all tweeters on those hashtags, what 
fraction is in the follower/retweet network of the high influence individual 

Trend of Influence : Trend line with change in that person's influence 
(number of retweeters, number of followers) by day 

Trend of Hashtags : Trend line with change in number of hashtags that 
person tweets by day 

Power Brokers : Who are the power brokers in the networks and social 
networks. List top tweeters in k-betweenness (k=3), degree centrality, and 
k-closeness (k=3). 

Sub-Networks : Find sub-networks that are consistent through time i.e. a 
group of tweeters and retweeters that are connected in multiple time periods 
-- note this is less critical than the other things 

Wants to be an Influencer (high outdegree) : These sites tend to 
retweet frequently. However, they may not actually influence others as their 
follower circles or likelihood of being retweeted may be small. Those sites 
that are verified are likely to be more influential. Top n individuals in 
outdegree (show rank, absolute value, normalized for all, just verified, and 
just unverified) 

Use : AA : "Retweets" - link(i,j) is the number of times that agent i 
retweeted agent j. Out-degree therefore measures the degree that an 
agent retweets (is a retweeter). Then use those i that retweet the most j - 
not weighted => link count only. 

Actual Influencer (high weighted out-degree) : These sites send 
messages which are reaching a large number of others either directly due to 
their followership or indirectly due to the followership of those that retweet 
or mention them. 
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Use : AA : "Retweets" - link(i,j) is the number of times that agent i 
retweeted agent j PLUS AA : "Mentions" - link (i,j) is the number of times 
that agent i mentions agent j in his tweets. then use the top n j such that 
sum of number of followers of j, number of i who retweet j multiplied by 
followers of i sum of number of mentions of j multiplied by followers of i 

Directly Influential (high degree in followers) : These sites have the 
most followers. Top n sites with the most followers 

Trusted or Interesting Source (high in-degree) : These sites tend to be 
retweeted frequently. This suggests widespread trust or interest in what 
they say. Those sites that are verified are likely to be very trusted sites; 
whereas, frequently retweeted unverified sites may be emergent or locally 
trusted sites. Top n individuals in outdegree (show rank, absolute value, 
normalized for all, just verified, and just unverified) 

Use : AA : "Retweets" - link(i,j) is the number of times that agent i 
retweeted agent j then identify those j that have the most i 

Potential Reach (K-closeness using weighted data) : These sites have 
disproportionate influence as they are relatively close to a large audience 
and can reach them quickly. These sites on average frequently tweet, 
retweet or mention others in their tweets, and their tweets are frequently 
retweeted or mentioned and then those retweets are frequently retweeted 
and so on. Top n individuals in k-closeness using weighted data (show rank, 
absolute value, normalized for all, just verified, and just unverified) 

Use the union of these networks : AA : "Retweets" - link(i,j) is the 
number of times that agent i retweeted agent j - multiplied by followers of 
i PLUS AA : "Mentions" - link (i,j) is the number of times that agent i 
mentions agent j in his tweets - multiplied by followers of i and find k-
closeness in that. 

Potential Connectors (high k-betweenness) : These sites are 
disproportionately active in disseminating information. These sites on 
average frequently retweet or mention messages and are are then 
frequently retweeted or mentioned. Top n individuals in k-betweenness 
using weighted data and k= 4 (show rank, absolute value, normalized for all, 
just verified, and just unverified) 

Use the union of these networks : AA : "Retweets" - link(i,j) is the 
number of times that agent i retweeted agent j - multiplied by followers of 
i PLUS AA : "Mentions" - link (i,j) is the number of times that agent i 
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mentions agent j in his tweets - multiplied by followers of i and find k-
betweenness in that 

Most Mentioned (high in-degree in mentions network) : These sites 
are mentioned the most. This may indicate a dialogue, strong agreement or 
strong disagreement. 

Use : AA : "Mentions" - link (i,j) is the number of times that agent i 
mentions agent j in his tweets provide those j that are mentioned in the 
most tweets 

Potential Consensus Leaders (high total degree in common hashtag 
network) : These are the sites that tweet about the most items also 
tweeted about by others. 

Use : AA : "Common HashTags" - link(i,j) number of common hashtags 
that agents i and j used 

Weighted Potential Consensus leaders : These are the sites that tweet 
about the most items also tweeted about by others s.t. those topics directly 
reach the largest audience. 
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Lessons 

Below are links to lessons on how to perform many common dynamic 
network analysis tasks as well as using ORA in general: 

An Overview of the ORA GUI panels 

Meta-Networks: From the beginning 

Running a Key Entity Report 

Using The Over-Time Viewer 

Working with The Network Converter 

Change Detection 

Working With Attributes 

 

 

ORA Overview 
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The Main Menu runs across the top of the window, and the rest of the 
screen is divided into three panels. 

Below the menu is the Toolbar. ORA starts with buttons to add and remove 
Meta-Networks, Nodesets and Networks. Using the inverted triangle you can 
add or delete buttons from this strip. 

The Meta-Network Pane displays a list of the Meta-Networks that has 
been loaded into ORA, its components and sub-networks. To view 
information about a particular meta-network or sub-network, single-click on 
it. 

The Editor Pane displays information about the meta-network or sub-
network highlighted in Panel 1. 

The Report Pane displays information about the results of analyses run on 
your meta-network. 

 

 



1183 
 

Loading a meta-network into ORA 
You have three options for opening your meta-network in ORA: 

• From the main menu select File ⇒ Open Meta-Network. A small 
window titled Help: Opening meta-network pops up. Your data 
should already be in the correct format, so click [OK]. 

• Next, a file chooser titled Open pops up. Browse to the location of 
your dataset, single-click on it, and click the Open button in the 
bottom right corner. 

• Click the first icon in the row directly below the menu bar. It looks like 
a half-open file folder. A window titled Import Data into ORA will pop 
up. Click the Select Files button. A file chooser titled Open pops up. 
Browse to the location of your dataset, single-click on it, and click the 
Open button in the bottom right corner. You will be returned to the 
Import Data into ORA window. Click the Finish button in the bottom 
right corner. 

• In panel 2, click the Load button on the far right. A window titled 
Import Data into ORA pops up. Click the Select Files button. A file 
chooser titled Open pops up. Browse to the location of your dataset, 
single-click on it, and click the Open button in the bottom right corner. 
You will be returned to the Import Data into ORA window. Click the 
Finish button in the bottom right corner. 

A list of your meta-network and sub-categories in Panel 1, as well as the 
location and basic statistics of your meta-network in Panel 2 will appear. 
ORA is ready to begin analyzing the meta-network. 

The Visualizer  
To visualize a meta-network, first make sure the meta-network you wish to 
visualize is highlighted in Panel 1. If it is not highlighted, single-click on it. 

In Panel 2, click the Visualize this Meta-Network button. A new window will 
pop up displaying your meta-network graphically. A small legend also 
appears. 

Below is a screen capture showing the visualization of the agent x event 
graph from the Stargate Summit Meta-Network. 
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The visualization displays the connections between all items in the Stargate 
Summit Meta-Network. The red circles represent the agents, the green 
circles represent individual events in the scenario, and the lines represent 
the connections between the agents and the events. 

You'll notice there are agents with no connections to any events. They 
represent nodes that were connected to the scenario but not to the 
particular events of the Summit timeline. 
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Creating a New Meta-Network 

These lessons will give you the information in order to create a Meta-
Network from data you have on-hand. 

Lesson - 101 
This section describes the process of looking over your data and deciding 
what is relevant for inclusion into a Meta-Network. It takes the examples I 
used for the Stargate dataset. 

lessons - 201-207 
A step by step run through of creating the Meta-Network from working with 
Excel, exporting data to csv files and finally building a complete Meta-
Network. 

 

 

Examine Your Data 

General Thoughts 
When you first open up ORA you need to construct a Meta-Network. But the 
question is, how do you go about this task?  

First, you need to understand what constitutes a Meta-Network. The basic 
building blocks of all Meta-Networks is a Node*. Similar nodes are combined 
to build Nodesets*. Nodesets are combined to make Networks*. Multiple 
networks are combined to create a Meta-Network.*.  

It is up to you on HOW to construct the individual Nodesets and Networks 
and how to combine the Networks into a Meta-Network. This means you 
need to gather as much information regarding the scenario as possible 
(who, what, when, where, and how) 

Knowing as much about the scenario as possible is important. Information 
about the people involved, where these people were seen, what items they 
had available and used, what they knew, what tasks they performed, what 
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resources are needed to perform those tasks, etc. The more relevant 
information you collect the better your final Meta-Network. will be. 

NOTE : For this lesson I will be using the Foundation Trilogy-1 dataset. 

I found that for the help file using a set of data where you know all the 
answers helps. But that won't always be the case. If you already know 
what the results are supposed to be then it's easy to build a correct Meta-
Network. 

But the most important part of this is it helps you to learn what to look for. 
You'll initially make mistakes but if you instantly jump into creation mode 
then, well, since you're not sure how to build this in the first place then how 
can you be sure your Meta-Networks are built correctly in the first place? 

What's a Nodeset Class 
There are ten Nodeset Classes used in Foundation: Agent, Resource, 
Knowledge, Task, Organization,, Location, Event, Action, Belief, and 
Role. ORA contains the ability to create new Nodeset Classes but in most 
cases that's entirely unnecessary because most of ORA measures are 
designed to work with most common eight classes mentioned above. 

With Foundation the agents were easy - find the important characters in 
the story. The locations were also easy using scenes form the story. It was 
the events, knowledge, resources, and tasks which became slightly harder to 
discern. I'll admit there were multiple false starts (missing some events, 
unnecessary locations, misplaced knowledge/resources) before I came to a 
proper conclusions. 

Nodesets can be either binary (0 or 1) or numbered (negative #, 0 or 
positive #). A Meta-Network. can contain a combination of the two types. 

When building Nodesets and Networks (and then onward to Meta-Networks) 
you'll discover that many networks are are very apparent while others were 
almost invisible. You'll have some large networks while others may be 
extremely small. But all networks are necessary to produce the complete 
Meta-Network. 

And the depth of the Nodesets can be extended by affixing attributes* to 
them. 
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Foundation uses attributes to give extra information such as an agent's 
gender or job title. Any addition information can be placed into an 
attribute. 

Agents (Who) 
It's usually best to start out by constructing the Agent Nodeset. This helps 
reveal many facets of the rest of the Meta-Network. Gather all possible 
information about the Agents involved. If a new piece of information 
appears for an Agent then fill in the blanks for the rest of the Agents. 

The Foundation Agent Nodeset contains a mere 10 agents. The 
information I deemed important for attributes were gender, home world, 
and Job Title. 

After you've collected all the agents involved you can proceed to creating 
your first network. Figure out which agents had any contact with each other 
and place a 1 in the corresponding cell. Depending on the particular 
circumstances you will have to establish criteria for an association. An 
Agent x Agent network creates a Square Network meaning the names in 
the rows are identical to the columns. 

The Foundation Meta-Network was fairly easy to construct the agent 
Nodeset and Agent by Agent Network. But Remember, real life data doesn't 
always come with such an easy to see diagram. After a Meta-Network is 
constructed it very likely that new information will surface which will change 
the face of the current Meta-Network. and, thusly, the results of any reports. 

There are three modes of thought in creating connections. 1) The most 
common would be to say if one agent knows another agent then place a 1 in 
the cell. 2) Next would be to use the preceding criteria but to weight the ties 
where one person could have a higher regard for a person more than there 
are reciprocal feelings. 3) The third would be to use a hierarchical style 
showing who reports to who in a organizational tree situation. It's important 
that the person creating the Meta-Network makes a call whether there is and 
and how strong a tie will be. Multiple variations were gone through in the 
creation of the Foundation Meta-Network. 

As you learn more about Meta-Networks it becomes easier to see which 
mode you need to use. 

You might not create a Meta-Network. correctly the first time (or the 
second or the third time) if you rush into it. Best to take a little time and 
review the information before heading straight into the creation process. 
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Sometimes too much information will find it's way into your Meta-
Network. 

A little time spent on reviewing the data and any reports will greatly improve 
your chances of getting it somewhat right in the first place. It will also help 
in your deciding the best way to build your Networks. 

NOTE : Remember, you'll always find something that you think needs 
tweaked as more and more information is uncovered. 

Events (When) 
Creating an Events Nodeset is a little more difficult than for either agents 
or locations. Agents and locations are tangible items whereas events are 
intangible. They also depend on the interpretation of the individual creating 
the Nodeset. Events can include items like Foundation's Hari Seldon 
meeting Gaal Dornick and The trial of Hari Seldon. 

Many of the events in first part of Foundation were easy (the meetings, 
the trial, the funeral). You may find events in your dataset a little more 
difficult to discern.  

When plotting events it may be necessary to show what order they 
occurred. What happened first, second, third, and so on. This helps discern 
which agents are needed in which parts of the scenario. One method would 
be to give it an attribute with a numbering system. 

Another would be to link one event to the next event in line. To create an 
ordered event x event network start with the row of earliest event. Place a 
check mark in the column for the next event. Find the row for the column 
you just check marked. Follow that to the column with the next event. 
Proceed in this manner till you have all your events. You may, as happened 
in the Stargate Network, that two events sprout from a single event. They 
may, or may not. converge back to an ending. 

Knowledge (What) 
Many times more than one person knows the same thing. And other times 
there is a single person who has some vital knowledge. This is a way to help 
find out if one person is completely indispensable or whether there are other 
pathways to accomplishing the goal. 
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In Foundation the knowledge mathematics is known by Hari Seldon, 
Gaal Dornick, and Wanda Seldon. But only Hari Seldon and Wanda 
Seldon have the knowledge psychohistory. But only Bor Alurin knows 
Psychology. 

Locations (Where) 
Next create a Nodeset of all the locations involved in the scenario. 
Locations are places like Foundation's Streeling University and the 
Imperial Palace 

For the Foundation Meta-Network it was a simple matter of following the 
book and marking down who was in what scene. Not quite a simple when 
you've got less than perfect data. 

Create a list of all possible locations and use your best guess as to whether 
that location is important. Remember, just because people are seen in a 
location doesn't mean it's important to the Meta-Network. You may have a 
location you think is important initially but come to find that nothing 
happened of interest there (or visa versa). 

For the Foundation Meta-Network. it was difficult to focus in on the exact 
locations necessary. The first time only the major locations were used, but 
it was difficult defining specific tasks. Then all locations were added but it 
ended up have many isolates and pendants that became unnecessary. I 
finally settled five important locations. 

Organization 
Organizations usually consist of groups of people banded together for a 
common goal. This can range from a large political group [ Republicans or 
Democrats ] to The Three Musketeers [ Athos, Porthos, and Aramis ] 

In Foundation these organizations were mostly specialty groups like The 
First and Second Foundations and the Empire. 

Profession 
Professions can define any activity an agent partakes in i.e. Federal Judge, 
Fireman, or Crack Dealer. 

For Foundation I had mostly normal professions like Attorney, Judge, 
and Psychologist but also the story contained some special ones like 
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Psychohistorian and Aristocrat. You list whatever jobs the agents are 
doing. 

Resources (What) 
Resources can be very similar to knowledge and many times these two 
overlap. It's not necessary to always have both. 

You may find that it is necessary for a node to have a certain knowledge 
before they can use a certain resource. In Foundation it is necessary to 
have knowledge of mathematics before you can use the resource prime 
radiant. There is no special knowledge necessary to listen to the Seldon 
Psychohistory recordings. 

Tasks (How) 
Tasks are things that are done by the agents such as Foundation's preside 
over Seldon's trial or force exile of encyclopedians. 

A task network can be set up to show the order that tasks need to be done 
in order for the scenario to be played out. For example, procuring materials 
to build something is always necessary before building something but not 
necessarily before planning. This is usually done with a directed graph (i.e. 
a link from procuring to building but not the other way around). 

As in the example of Events above certain tasks need to be completed 
before others can be started. Foundation uses a binary, directed network 
showing a pathway of which tasks are required to be completed before the 
next task can be started. spy on Gaal Dornick for emperor and deliver 
message for Seldon lead to preside over Seldon's trial which then 
leads to force exile of encyclopdians. Other networks can be much more 
complicated than this. 

Tasks are exclusively attached to agents. You can't have a location, event, 
etc. performing a task. But this is not to say that you can't have a task 
attached to a location as it might necessarily need to be done at a certain 
location or a resource necessary to complete a task. 

Linge Chen could only preside over Seldon's trial at the Imperial 
Palace. Nor could Gaal Dornick do the task seal Seldon recordings in 
Vault anywhere but on Terminus. 

Networks 
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After creating all your Nodesets you then move on to creating Networks. 
Every Meta-Network. will require a slightly different set of Nodesets and 
Networks. Below are the Foundation Nodesets. 

The Foundation Nodesets consist of: agent x agent, agent x event, agent 
x knowledge, agent x location, agent x organization, agent x profession, 
agent x task, event x event, event x location, knowledge x knowledge, 
knowledge x profession, knowledge x resource, knowledge x task, 
organization x event, organization x resource, organization x task, 
profession s knowledge, resource x event, resource x location, resource x 
organization, resource x profession, resource x resource, resource x task, 
task x event, task x location, task x profession, and task x task. 

 

 

Excel and CSV 

You learned from Meta-Network 101 about how to survey your data, the 
different forms it can take, and how to make it a fit for ORA. In this lesson 
we'll go through the procedure of creating a Meta-Network using the 
Foundation dataset in some practical examples. 

Your first Nodeset 
Your first Nodeset will more than likely be an Agent Nodeset since all other 
Nodesets are either referred to/or by the Agent Nodeset Review you data 
and make a list of the people involved. 

After reading The Foundation Trilogy I decided to break it up into 9 
sections. In the first section I came up with 10 important Agent nodes. 

What program should be used to create the information?  

You need a program that can create .csv files that your system can read. 
Microsoft Excel is an excellent choice as it has good copy/paste features, 
multiple spreadsheets in one files, and known compatibility with ORA.  

The Agent Nodeset was created with names of the characters which were 
used for both the Node ID and the Node Title. Some people use 
anoynomous Node IDs like A1, A2, A3.... The order of the Agents is 
unimportant as long as you keep the relationship between IDs and Agents 
consistent throughout your work. The IDs are what allows ORA to match 
information in various files. 
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NOTE: If using IDs like A1 I've found prefixing 0 or 00 to the number helps 
when sorting. i.e. A01-A99 for up to 100 Agents. 

 

Your first Network 
Now that the Agent Nodeset is done the next item is to create an Agent x 
Agent Network. As described in Meta-Network 101 just how your Agents 
interact with one another is subjective to the type of Network you have. 

Create a new spreadsheet in Excel and copy the Agent IDs in column A 
starting with row 2. Then paste the same IDs in row one, starting at column 
2, using the Transpose function. In Excel 2010 Copy the information; 
Click the Home tab; click the downward triangle under the Paste 
icon; select Transpose.. The same set of Agent IDs will be placed in row 1. 
Now you can begin constructing your links by placing your values for the 
Agent by Agent connexions in this matrix. 

The Foundation made a connection whenever any two Agents met face-to-
face. This is often the way networks are constructed but there are other 
ways to make connections i.e. hierarchical command structure or 
weighted importance of the connection. 
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The rest of the Nodesets and Networks 
Next you have to decide what other Nodesets you need... 

I created Foundation Nodesets for Events : important Events during the 
course of the story, Knowledge : important information known by individual 
Agents, Location : where particular Events took place, Organization : 
larger bodies which the individual Agents belonged to, Profession : jobs the 
individual Agents were placed in, Resource : material objects important to 
the story, and Task: specific jobs Agents accomplished, or tried to 
accomplish. 

Then I had to decide how these Nodesets interacted with each other. Also, 
how important any particular Network was to the overall story. 

For Foundation I decided I created a wide range of Networks. Many of these 
were created for specific display purposes and may not be entirely necessary 
in your particular ciscumstance. 
 
Agent x Agent, Agent x Event, Agent x Knowledge, Agent x Location, 
Agent x Organization, Agent x Profession, Agent x Resource, Agent x 
Task, Event x Event, Event x Location, Knowledge x Knowledge, 
Knowledge x Profession, Knowledge x Resource, Knowledge x Task, 
Organization x Event, Organization x Resource, Organization x Task, 
Profession x Knowledge, Resource x Event, Resource x Location, 
Resource x Organization, Resource x Profession, Resource x Task, 
Task x Event, Task x Location, Task x Profession and Task x Task. 
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Each Meta-Network will require different handling and may require more or 
less networks. 

Then, as done in the Agent x Agent network, decide how the various nodes 
interact with each other for each Network. When finished you will have 
spreadsheets from which you can create all your .csv files. 

NOTE: You can keep these as separate spreadsheets or combine them in a 
single spreadsheet. This is a personnal preference. 

Saving as .CSV files 
The next step is to convert these Excel file to a format that ORA can import, 
namely the .csv format. This is easily done with Excel's Save As function. 
Select the Excel spreadsheet you want to convert to CSV. From the Excel 
main menu select Save As; scroll down to Other Formats; Navigate to the 
directory to save your file; from the Save as type select CSV (Comma-
delimited) (*.csv) and click Save.  

 

You can now convert all your Excel spreadsheets to CSV files in preparation 
for importing into ORA. 

 



1195 
 

 

Import into ORA 

NOTE : If you are visiting this page from the help section on the Data 
Import Wizard, what follows is a series of lessons using the Data Import 
tool with the Foundation sample data set. You can start from the very 
beginning of this lesson by going to the preceding Meta-Networks 101 
lesson)  

Now that we've got the Excel spreadsheets created and converted to .csv 
files it's time to learn about importing a CSV file into ORA. 

The Datasets 
Below is the file we will be importing. It denotes who has met who in the 
first Foundation section. 

 

Starting a new Meta-Network 
From the main menu of ORA, select File > Data Import Wizard or hit Ctrl-
W. The Data Import dialog asks What would you like to do?. For this 
example we will be importing a network comprised of links so select 
Rectangle of link weights (a matrix). Then click [ Next > ]. 
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In the next dialog box you will want to select Create a meta-network with 
ID:. This allows you to import a .csv file in the form of a matrix with labels 
on the X and Y axis (i.e. an Agent by Agent graph or Resource by Event 
and link data in the body). Give your new meta-network a name. I named 
mine Foundation Trilogy-1 specifying it is the first of nine parts. When you 
are done, click [ Next > ]. 

 

Click the [Browse] button and navigate to the directory where the data is 
located. For this example select the sg1_agent_x_agent.csv file. In the 
Source type and Target type drop down menus select the types of nodes you 



1197 
 

are using. In this case both will be agent. In the Network ID: field, name 
the network (typically for this it would be agent x agent). When done 
click [ Finish ]. 

 

Looking in the Meta-Network panel you'll see the Foundation Meta-Network. 
Clicking the [+] will expand it to reveal the Nodeset and Network created. 
The Nodeset or Network can be examine by highlighting either to show its 
information in the Editor and Info tabs. 

Adding to the new Meta-Network 

 

You could, if you had multiple networks, import them all in at the same time. 
For each new Network file to import, click the [ Click to import from 
another file ] button and repeat the above procedure. 

NOTE: If at any time you want to remove a Network from the list select the 
[ X ] next to the Browse button 



1198 
 

 

 

Attributes 

NOTE : If you are visiting this page from the Data Import Wizard, what 
follows is a lesson on adding attributes to the Foundation sample data 
set provided with ORA. To begin the lesson from the very beginning go to 
Meta-Networks 101. 

The Foundation Nodeset has been created when the network was 
imported. But even though the nodes have names, there are no attributes. 
The next step will be to import those from a original file. 

The Datasets 
Foundation Trilogy-1-nodeclass-Agent.csv contains the attributes for 
gender, home world, and job title. As you can see the ID and Title names 
are the same as in the Foundation Trilogy-1-network-Agent x 
Agent.csv file. 

Adding Attributes 
Find the Foundation Trilogy-1-nodeclass-Agent.csv. This contains all the 
attributes for all the nodes. Highlight the Foundation Meta-Network. Then 
click Import existing data? > Table data from Excel or text delimited 
formats > Simple Table > Node Attributes. The click [ Next > ] 
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With the basic Foundation Nodeset and Network already loaded we will now 
add attributes to the Nodeset. Place a check mark next to the sg1 dataset. 
Then click the [Next] button. 

 

Below is the main dialog box to inform ORA what and how to import the 
new attributes. After the image is a description of each of the numbered 
steps. 
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• 1 With the [Browse] button you load the file containing the attributes 
to add. 

• 2 Selects how to identify the nodes. If your file contains a column with 
node IDs use the top selection. Then select the column from the drop 
down menu. If your attribute file contains information in the same 
order as the nodes are already in then you can use the second option. 

NOTE : If you select the second option, and your nodes are in a differnt 
order than your attributes, the ORA will place the attributes in sequential 
order regardless of whether the IDs match or not. 

• 3 For each column a box will appear allowing you to chose which 
attributes to import. Place a check mark next to each attribute you 
want and give it a Type: Text Category, Text, URI, Number 
Category, Number, or Date. An attribute without a check mark will 
not be imported. 
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• 4 In this example leave this unchecked as we only want attributes for 
the first five nodes. This is used if the file contains additional nodes to 
import which were not in the original Nodeset. 

• 5 Select the Nodeset to add the attributes. Place a check mark next to 
all Nodeset to add attributes to. In this example we have only one. 

When finished entering information on this screen, click the [ Finish ] 
button. The Nodeset now contains names that match up to the IDs from the 
imported file. 

 

The remaining Nodesets and Networks 
With any remaining Nodesets and Networks for your dataset you can repeat 
the previous two lessons: first importing a Network of links then importing 
the attributes for that nodeset that isn't already in the Meta-Network. Below 
is an example when importing attributes into a single Nodeset with multiple 
Nodesets in the Meta-Network 
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Modifying a Meta-Network 

At this point the Meta-Network has been created and it contains the 
Nodesets and Networks. And each of the Nodesets contains titles and 
attributes in which to better define the Nodesets and Networks. But as with 
any dataset there will always be changes. 

Most certainly, as time goes on, Nodesets will require extra attributes or 
even new nodes. Possibly even new Nodesets will need to be created and 
worked into the Meta-Network. Or maybe a current set of attributes needs to 
be changed. What follows are the procedures to accomplish those tasks.  
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Adding a New Node to a Meta-Network 
In this section we'll add a new node to the agent Nodeset using the Create 
new nodes from unrecognized IDs checkbox. It's for the situation that 
the data being imported contains nodes that are not in the current Nodeset. 

The new .csv file we're using contains one new set of information, the 17th 
agent to add to the agent Nodeset. Upon importing the new node we will 
have a 17th node with the title attribute. 

id,title,position,symbiote,host,dies_when,dies,ally,group,servitude,gender,ra
ce,race-2 

A17,zipacna,,zipacna,unknown,,,no,anubis,anubis,male,gou'ald,human 

It was created in Excel (the same way the other Nodesets and Networks 
were) and exported out to a new .csv file called stargate_zipacna.csv. 

The easiest way to bring in a new node is to use the Attribute Import 
button.  
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1. Use the Browse button to navigate to the directory containing the 
new .csv file. It will show up in the textbox to the left. 

2. Check the proper column to use for the node ID and from the drop 
down menu select the type of node. 

3. Select the Attribute(s) you want to import. 

4. And most importantly, make sure the box Create new nodes for 
unrecognized IDs contains a checkmark in order to allow ORA to 
create new nodes. Without this checkmark ORA will ignore any 
nodeIDs that aren't already in the Nodeset. 

When you review your agent Nodeset in the editor you will see a new entry 
at the bottom, the 17th node with zipacna in the Entity Title attribute. 

 

The new node, and all their attributes, have been imported into the Meta-
Network. 
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Working with SubSets 

There will be times when you have a SubSet of a larger Meta-Network and 
you'll want to import data from a larger, main dataset. And you want to do 
this without creating new nodes. What follows are the procedures for 
accomplishing those goals.  

We start off with the SubSet of Foundation, a Meta-Network of three 
agents. Highlight the Foundation Meta-Network. Select the Agent Nodeset. 
Place a check mark in all nodes except hari_seldon, gaal_dornick, and 
wanda_seldon. Click the Delete button. 

 

Next, under Attributes, click the [ Delete ] button on the right side of the 
Editor. This brings up a dialog box with the attributes in the Nodeset. A 
check mark indicates to ORA to delete that attribute. For our purposes we 
need to delete them all. CLick the [ Delete ] button. 

 

You now have a Meta-Network with a SubSet of the original Foundation 
Dataset with no attributes. 

For importing we will use the original file Foundation Trilogy-1-
nodeclass-Agent.csv for the attributes 

Now, as before, open the Data Import Wizard. Navigate to Node 
Attributes and click [ Next > ]. Select the newly created Meta-Network by 
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placing a check mark next to the name then click [ Next > ]. Make sure 
Step 1 contains your Nodeset file. If not, click [ Browse ] and navigate to 
the correct directory. Next make sure Step 4 only has the Agent Nodeset 
selected. When read click [ Finish ] 

The most important item for this to work is to make sure that the Create 
new nodes for unrecognized nod IDs remains UNCHECKED. This will 
prevent ORA from creating new nodes for the other data it finds in the file. 

 

The result is maintaining a Nodeset with three nodes but attribute data from 
the Agent Nodeset file imported only for the attributes for the three nodes. 
No new nodes will be created in this process. 
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Attribute Columns 

There are four functions that can done with Attributes. All four are 
accomplished by Right-Clicking on the downward arrown next to the 
Attribute Name. This prings up a dialog box with two tabs. 

 
Filter Values Edit Attribute 

  

Filter Values 
Clear all filters : Clears an previous filter parameters you have set. 

Value check boxes : Select or Deselect values to display. 

Define a custom filter : Type in specifics to use as a filter and whether or 
not they match the values. 
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Edit Attribute 
Set the Attribute Name : Used for renaming an existing Attribute column. 

Set the Attribute Type : Attributes can be tagged with two types: 
Categorical or Continuous. 

Replacing an Attribute Column 
NOTE: This method is suggested as ORA has the capability of retaining 
multiple values. If you want to completely replace the values then deletion 
and replacement of the column is suggested. 

For most small changes you can type in a new attribute value or two 
directly into the Editor. But say your Nodeset contained quite a few nodes, 
and the majority of the values needed changed. If might be easier to create 
a new .csv file and import the values in just as in the previous lesson. In the 
example below it was decided to completely replace all the skill_needed 
with a new set of values. 

Go to the ORA main interface and under select the Nodeset. Under the 
Attributes section click Delete. Remove all the check marks from any 
attributes you want to keep. All attributes with check marks will be removed. 

After deleting a column then use the procedure for importing Attributes from 
Lesson-203 to import a new attribute information. Remember, you'll want 
to import into an Existing Meta-Network as in the example above. 

The skill_needed attribute has been imported into the Nodeset with the 
revised values. 

 
 

 

Updating Your Data Files 

After importing data from the .csv files into ORA and then altering the data 
in ORA this somewhat makes your original data files out-of-date. What 
follows are the procedures to update your original .csv and Excel files with 
any changes that have been made recently. 

 



1209 
 

Saving Your Network Data 

 

From the main interface highlight the Network you want to save and Right-
Click. This will bring up a contextual menu. Select Save Network. This will 
bring up a Save dialog box. First, navigate to the directory you want to save 
your new Network file. Next, select the format (DyNetML, UCINET, DL, or 
CSV) to save the file. Give it a filename and select [Save]. 

 

Usually files are saved to the csv format and can be opening in a Excel or a 
text editor. 
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REMEMBER: The UCINET uses both .##d and .##h extensions and both are 
needed to build a Meta-Network. 

NOTE: Since this Save box does not display the files present in the directory 
it is Highly Suggested that you save to a new directory and verify which 
previous file you want to replace. More information on these file formats can 
be found HERE 

Saving A Meta-Network 
You can an entire Meta-Network to individual files using File > Data 
Export. This will write out one file for each Nodeset and Network. Type in a 
prefix name which will be ayyaced to each file, select the Files of type, and 
then click [ Save ] 

Saving Your Attribute Data 
The above mentioned procedure works well for saving Networks but there 
are also the attributes in the Nodesets to think about. All the data is can be 
saved from File ⇒ Save Meta-Network and the File ⇒ Save Meta-
Network…. But this saves the data into one xml file. What if you what to 
save the data into individual files, the same as when you imported it. 

The quickest way is using the Copy / Paste method. Values copied directly 
from the Main Interface Editor can be pasted into a Excel spreadsheet. 

In the ORA editor, highlight the cells you need to copy. Use either Ctrl-C or 
Edit > Copy. 
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Then switch to your Excel spreadsheet. Highlight the cell that corresponds 
to the top/left cell you started with in ORA and use either Ctrl-V or Edit > 
Paste. Entire Nodesets can be done in this fashion. 

IMPORTANT NOTE: Before you Copy/Paste in this manner make sure 
your columns are in the same order. This operation will NOT match up data 
as it's a blind copy/paste operation. 

You can then backup all of your Nodesets in the procedure and then re-save 
it to your .csv files. 
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Key Entity Report 

The Reports 
A Key Entity Report creates the following reports: central actors, 
organizations, central knowledge, resources, central events, tasks, central 
locations, and performance indicators.  

The Key Entity Report can either run its measures over the entire network or 
be refined or filtered to run them over only a select portion of the network. 

More detailed information regarding the basic workings of the Key Entity 
Report screens can be found Reports Section.  

Running a Key Entity Report: 
We'll be using the network Stargate: Summit contains all the agents 
involved in the scenario, friend and foe. The first report run will contain all 
the agents, friend and foe. 

• From the main menu select Analysis ⇒ Generate Reports which 
brings up the Generate Reports dialog box. 

• At the top of the window is a dropdown menu titled Select a Report. 
Pull down the menu by clicking the small inverted arrow icon to its 
right, and select Key Entity. 

• In the box titled Select one or more meta matrices: select the 
network to run the report on. 

• At the bottom of the box is the Transform options. 

o General Mathematical Transformation : Contains various 
formulas for manipulating a network. 

o Remove Entities : Remove node(s) from a network before 
running the measures. 

o Partition entities into separate meta matrices by attribute 
value : Create new networks based on your choice of nodes and 
attributes. 
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Select the [Next >] button at the bottom of the dialog box. 

 

The next dialog box is for selecting the number of ranked nodes, critical 
attribute and values and also for selecting which reports you want to 
view. I am only interested in the top five nodes in the network and place a 5 
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in the top box. I don't want to point out any particular nodes, only the 
friends, so I'll leave the textbox blank. I want all the reports run so I place a 
checkmark in all four boxes. 

Click the [Next >] button. 

 

The last dialog box is for selecting what type of format for the final reports 
and the directory to place them. Text will create reports that will appear in 
Panel 3 of the interface, HTML* creates reports that will open up your 
browser, and CSV* creates files that are usable in ORA. The bottom section 
allows you to navigate to a directory where you want to save your files. 

Remove Nodes from a Key Entity Report: 
Next we'll look at removing nodes from the report. The network Stargate: 
Summit contains both the friends and foes in the scenario. But say you only 
want to see only how the friendly agents interacted. Being that there's an 
ally attribute this will make it simple to eliminate the foe agents. 

Follow the same procedure as above except click in the Remove entities 
radio button. 
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In this example we're going to eliminate a portion of the network before we 
run the measures. Select the Remove entities button. Then select the 
[Next >] button at the bottom of the dialog box. 

In this dialog box you can select exactly which nodes to remove. 
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The top section, Filter Commands, allows you to create a single filter or 
compound them and force it to Match all filters. 

The bottom sections contains tabs which further allow you to refine your 
filter. There is a tab for each Nodeset in your network. 

I only want to run the measures on the Allies so I select the agent tab, 
scroll over to the ally tab, and in the dropdown menu I select no. This will 
call up all the non-ally agents. I then click the [Select All] button which 
places a checkmark in each box effectively removing them from the 
network. 

Click the [Next >] button. 
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The next dialog box is for selecting the number of ranked nodes, critical 
attribute and values and also for selecting which reports you want to 
view. I am only interested in the top five nodes in the network and place a 5 
in the top box. I don't want to point out any particular attributes so I'll leave 
the textbox blank. 

Click the [Next >] button. 
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The last dialog box is for selecting what type of format for the final reports 
and the directory to place them. Text will create reports that will appear in 
Panel 3 of the interface, HTML* creates reports that will open up your 
browser, and CSV* creates files that are usable in ORA. The bottom section 
allows you to navigate to a directory where you want to save all your files. 

Comparison of the two reports 
As the reports are rather large, let's compare a small portion of cognitive 
effort from the reports. 

      All agents Allies-only 

Rank Value Agent Rank Value Agent 

1 0.340911 jacob_carter_selmak 1 0.354626 jacob_carter_selmak 

2 0.257479 ren'al 2 0.284762 daniel_jackson 

3 0.248333 daniel_jackson 3 0.284218 ren'al 

4 0.205698 olokun 4 0.166667 maj_samantha_carter 

5 0.205698 morrigan 5 0.164218 teal'c 

The left-hand column shows all nodes, including the non-allies olokun and 
morrigan. But after eliminating the non-allies two friendly agents take their 
place. You'll also notice that daniel_jackson and ren'al swapped places. 
With various links removed, after eliminating the non-allies, the order of the 
remaining nodes can shift. It should also be noticed that the rating for 
jacob_carter_selmak has increased elevating his position as Emergent 
Leader. 

 

 

Over-Time Analysis 

Performing a View Network Over-Time 
Analysis 
What follows are procedures to perform a View Network Over Time and 
View Measures Over Time Analysis.  
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To either requires multiple network datasets representative of your network 
over different time periods. The goal is to analyze how a network changes 
across multiple time periods. The time period is determined by the intervals 
of collected network data and presented as multiple Meta-Networks, which 
are loaded into ORA in sequential order. The steps below provide detailed 
instruction on how type of analysis. 

To perform a View Network Over-Time Analysis, you must load Meta-
Networks that relate to different time captures of your network data, which 
need to be in the form of multiple Meta-Networks. 

In the following example, we will use network time captures of the 1998 
Embassy Bombing in Tanzania Meta-Network data set and compare the 
same data set as we knew it in 1997 and 1996 and 1998. We will then 
compare all the Meta-Networks in the Network Over-Time Viewer to gain a 
visual representation of how this network changed between 1996 and 1998. 

Note : For our purposes, we have changed data in this example and have 
renamed the Meta-Network for three different years. This will denote 
different network variables that have changed over time. 

You will see in the left window pane under input dataset three Meta-
Networks, 1998, 1997, and 1996, have been loaded. From the menu bar 
select File > Open Meta Network 
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Click the [ Select Files ] button 
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You will see all of our example data sets, which will load simultaneously into 
ORA, buy highlighting and selected all the files. Next highlight all files you 
analyze in Over-Time Viewer and click [ Enter ]. 

 

The import data window will appear (below). This will confirm the files you 
wish to analyze. 

 

Click [ Finish ]. 

All three Meta-Networks should display in Panel 1. 
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Performing the Over-Time Analysis 
Now that we have time captures of our network data represented and loaded 
into ORA in the form of three Meta-Networks relating to 1996, 1997 and 
1998, we can perform the Over-Time Analysis. From the Menu Bar select 
Data Visualization > View Network Over-Time 

 

The ORA Visualizer will render all of the loaded Meta-Networks. 

Please take special note of the Time Viewer pop-up Window. This window 
displays a slider, which will allow you to quickly change from the first Meta-
Network time capture of 1996, to 1997 and 1998 respectively. 
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By moving the slider from one Meta-Network to the next, you will gain a 
visual perspective on how the network has changed over Time. 

The series of screen shots below display how the visualized data changes 
from one slider to position to the next. This allows you a picture of how the 
network changes Over-Time. 

Note : Depending on the complexity of the network and the extent to which 
relationships (ties) have changed, the visualization of those changes may be 
subtle. 

The screen shots below, however, will emphasize the extent to which the 
role of the WTC Event entity has changed from 1996 to 1998 in relation to 
the network of which it is part of namely the Tanzania data set. Below these 
screen captures, are a series of detail screen captures focusing on the WTC 
Event node. 

Example Slider Position 1 
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Example Slider Position 2 

 

Example Slider Position 3 

 



1225 
 

Detail of WTC Event Node when visualized in the Over-Time Viewer as part 
of the 1996, 1997 and 1998 Tanzania Data Sets. 

WTC Event Node: Detail 1 - 1996 

 

WTC Event Node: Detail 2 - 1997 
Notice who how the relationships of this node to the rest of the network has 
changed from 1996 to 1997. 
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Notice that the connections (links) have changed from 1996 to 1997. 

 

As you can see, as we progress through the data sets pertaining to 1996, 
1997 and 1998, the event node WTC lost direct ties to other parts of the 
network. In the 1996 data set, WTC had 3 ties to other entities in the 
Tanzania Embassy network; In 1997, only 2; Finally, in 1998, the 
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WTC event node had only 1 link to Tanzania Network. This may 
indicate that the WTC node may have lost importance from one year to the 
next. 

Performing the View Measures Over-Time 
Analysis 
ORA provides an alternative method to analyzing your network data (in the 
form of Meta-Networks captured over time) than the only in the 
Visualizer.  

By running a View Measures Over Time analysis you can visualize how 
your network changes in relation to any given measure in the form of charts, 
which take you from one time point to the next.  

Below is a series of screen captures and instruction on how to access the 
View Measures Over Time feature: 

From the main menu bar select Data Visualization > View Measures 
Over Time 

 

Select View Measures Over Time. 

 

Click [ OK ] 
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The View Measure Over Time Window will appear. You will see that this 
window is primarily organized into three sections. 

Area 1: is a slider where you can control various inputs that affect the 
aggregation level of your Meta-Networks. 

Area 2: is a tabbed index allowing you to select the graph level you desire 
and the individual entity sets you are interested in analyzing.  

Area 3: displays the actual chart based on the measures you selected in the 
tabbed index and the position of the aggregation slider. 

 

Interpreting The Results After Performing View 
Measures Over-Time Analysis 
In the example above, we have loaded all three of our network time 
captures into the View Measures Over Time Analysis tool. The result of our 
analysis, as we have indicated before, will be displayed as a chart in the 
bottom section of the ORA interface in Panel 3. But, what does this tell us? 
To find out, we will examine the Graph Level measure Knowledge Waste. 
From the tabbed measures window: 
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Graph tab > Congruence, Organization 
Measure, Knowledge Waste. 
The result is displayed below. 

 

We can see the chart displays an axis scale correlating to our networks over 
time. The graph level measure of Knowledge Waste was selected using the 
View Measures Over Time tool and the result is displayed in the chart 
area of the window. 

We can see that the graph level measure of Knowledge Waste held a value 
slightly above 40 in the first Meta-Network, 1996, displayed with 1 on the 
Time axis. We can deduce from the chart that in 1997 something affected 
our measure of Knowledge Waste to increase the value to nearly 60. This 
corresponds to the time scale axis of 2, which represents 1997, our second 
year of network data. In the final year, 1998, our measure of Knowledge 
Waste declined to the value in 1996. This should be visually evident with its 
relative line graph position. 

It is clear that the value for the Knowledge Waste Measure increased from 
the first Meta-Network (1996) to the second (1997) and then retreated 
back to its original (1996) level. It would be up to you to determine what 
may have affected that measure for it to undergo this progression and 
regression. 
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Summary of Lesson 
At this point, you should be able to complete the following tasks to perform 
a View Measures Over-Time Analysis: 

• Load multiple data files into ORA (in the form of Meta-Networks) 
representative of your network across certain periods of time. 

• Select an aggregation level and choose a graph level or entity entity 
set to analyze. 

• Analyze the data output in the charting tool located in the bottom 
section of the View Measures Over Time window. 

• See how your network may have changed from one time capture to 
the next for any given graph level or entity node measure. 

• Use this visual comprehension to draw conclusions about how your 
network changed across multiple time periods. 
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Working with Attributes 

What is an attribute? 
An attribute is a quality, an added description, a differentiation of some 
sort, of a Who, What, Where, How and When and Whatever. It also indicates 
the presences, absence or strength of a particular connection. As an 
example, you might create a network of people (Whos) who work at certain 
buildings (Locations). The attributes of those people could range anywhere 
from their first and last name, their employee identification number, their 
job grade in the corporation, their salary, their home phone number, 
education, political affiliation and the list goes on. Moreover, we might say 
that you have a connection to both your friend and father. However, we 
might give the connection to your father the attribute of family whereas 
your friend might be attributed personal. The key is to know that attributes 
can be both differentiate nodes or ties or both.  

It follows that it would be helpful to view a network of Whos (and or any of 
the other Nodesets) and see how those Whos are grouped according to any 
particular attribute you are interested in analyzing. ORA has the capability to 
do just that and provides several ways of doing so. We will explore several 
methods of locating groups namely by using ORA's report tool and in the 
Visualizer.  

>> Go to Using attributes to find groups in ORA Reports 

>> Go to using attributes to find groups in the ORA Visualizer 

 

 

Using Attributes to find groups in ORA 
Reports 

To create and assess groups by attribute use the Locate Subgroups 
report accessible in ORA Reports at the following path: 

From the Main Menu select Analysis > Generate Reports > Characterize 
Groups and Networks > Locate SubGroups. In the dialog box place a 
check mark next to the Meta-Network to analyze and click [ Next > ]. 
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By default all Nodesets and Networks are check marked. Remove the check 
mark for any you do not wanted included in the analysis. Then click [ Next 
> ]. 
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Click the side tab Attribute. Be sure to place a check mark next to the 
algorithm's name. From the dropdown menu select an attribute to use. Then 
click [ Next > ]. 

In Select the networks transformation to apply:you can specify removal 
of isolates and pendants, symmetirize method, and selecting only the largest 
component. 

In Select one or more grouping algorithms:you select one or more 
analytic methods. Place a check mark next to the name and fill in the 
parameters. 
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Place a check mark next to any output parameters to need. Then click 
[ Next > ]. 
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On the final screen click the [ Browse ] button and navigate to a directory 
to save the results. Give it a unique prefix in the second box. Then click 
[ Finish ]. 

A new Meta-Network will be created that contains the networks used in the 
grouping. This new Meta-Network will contain a new Nodeset, attribute 
groups and new Networks, Nodeset x attribute groups is created that 
contains the group nodes. Also two block model group x group networks 
are created. 

============================  

In Select the algorithm outout: you can select the specific grouping 
algorithm parameters. Each of these parameters will give additional output 
in the report.  
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Using Attributes to find groups in the 
Visualizer 

What follows are instructions for finding various groups that may exist in 
your Meta-Network by using attributes and the ORA Visualizer too. To follow 
along with this lesson, please load the SG1 data set included with your 
installation.  

Step 1: Open the Stargate Meta-Network.  

 

Step 2: Select [ Visualizer ] button. 
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Step 3: In The Visualization, select "Attribute / Measure" Layout. 
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Step 4: Next (screen shot below) you will see the "Attribute / Measure" 
Layout Dialog box appear. In this box, select the attribute for an X and Y 
coordinate. You can use the save button to come back to these settings 
later. After choosing your attributes, click "Run Layout." 
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Step 5: You can experiment with the X and Y values by using either 
attributes or measures. In the final result shown below, we choose to use 
the X value as an attribute and the Y values as a measure. 
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Working with Loom Clustering 

Loom allows you to view nodes over time and which locations these nodes 
visited. 

NOTE : This does require a dataset with a time attribute. 

 

Loading the Star Wars dataset 
 
For this example we will be using the 
Star Wars dataset included in the 
sample folder. You can find it in the 
following folder: ORA > sample data 
> Loom data > Star Wars. There will 
be 24 xml files. From the main menu 
select File > Open Meta-Network.... 
Navigate to the folder specified above. 
Select the first file then Shift-Click the 
last file to select them all. Then select 
[Open]. This will display them in the 
Meta-Network panel. 
 
Trail pattern depth determines which 
clusters will be shown. 
 
To open this data in Loom make sure 
all Meta-Networks are selected. From 
the drop down menu select 
Visualizations > View Trails. You 
will be asked to chose a network. For 
this dataset chose Characters x 
Location. On the left will be two 
panes. On top is a list of Characters 
and below that is a list of locations. 

After opening the dataset in Loom all the characters will appear in the 
left/top pane and will start with no nodes checked. Below are the locations 
and the colors which will signify them on the Loom. 
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Trail pattern depth 

Trail pattern depth displays clusters of nodes which have the same general 
trail. The number is the minimum number of points they all need to have in 
common. 

Example 
Uncle Owen and Aunt Beru are in [4] timeslices. They will continue to be 
clustered until the Trail pattern depth reaches [5]. At that point they no 
longer meet the conditions and are no longer clustered. 
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Cluster Quality 

  



1244 
 

 

Running ORA in Batch Mode 

January, 2010 
ORA Batch Mode XML 
Version 2.0.0 

I. Command Line Arguments 
The program ora.exe (henceforth called ORA) takes one or more of the 
following command line arguments as input: (1) Measures File to be used, 
(2) the Script File to use, and (3) the Log File to use.  

If you installed the front-end of ORA, then the executable can be found as:  
[ORA installation directory] \include\OraFiles\bin\ora.exe 

Likewise, the Measures file can be found as: 
[ORA installation directory] \include\OraFiles\xml\ora_xml_measures.xml 

Measures File 

The Measures File is distributed with ORA and contains an XML encoded 
description of all the measures available to ORA. This is distributed with ORA 
and is usually called ora_xml_measures.xml. The following command line 
parameter specifies the filename: 

-measures <filename> 

Script File 

The Script File is an XML file created by the user and tells ORA where to load 
the input network data and which reports to generate. Section II - ORA 
Script XML Specification - describes in detail the format of this XML script. 
The following command line argument specifies the filename: 

-script <filename> 

Log File 

The Log File is generated by ORA to record the progress and problems of 
ORA in processing the Script File. The log file is a text file, and the following 
command line argument specifies its filename: 
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-log <filename> 

Help 

A listing of the above parameters is available by using the following 
command line parameter: 

-help 

Version 

The ORA version can be obtained by the following command line parameter: 

-version 

II. XML Script 
The batch mode script is a user supplied XML document that is input to ORA 
(see the -script command line parameter above). It tells ORA what network 
data to load and what reports to generate. 

Please note the following general guidelines for the script: 

1. camel case capitalization is used for element names: therefore element 
names begin lower case and the first letter of each word is capitalized. For 
example, Meta-Network is metaNetwork. 

2. default values are used: therefore a short, simple script can initially be 
used to run ORA. Advanced users can change the default values. 

The root n is <ora>, which has two child elements <input> and <output>. 
The input element describes the network data to load, and the output 
section describes the reports to generate.  

Example: an empty script 
<ora> 
<input/> 
<output/> 
</ora> 

A. Input Section 
The main unit of input to ORA is the Meta-Network, and therefore the input 
section of the XML script tells ORA how to load one or more Meta-Networks. 
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A Meta-Network is simply an organization modeled as a collection of 
matrices. The entire Meta-Network can be loaded from a single data file, or 
each matrix can be loaded from separate data files with possibly different 
data formats.  

1. Meta-Network Specification 
A Meta-Network is specified by the <Meta-Network> element. It accepts a 
single attribute called id which must be unique across all the Meta-Network 
elements.  

The child elements describe the location and format of its matrix data. There 
are two cases: (1) all data for the Meta-Network is stored in a single file, (2) 
the data for matrices of the Meta-Network are located in separate files. 

1.1 Meta-Network data in a single file 
The first case is only possible for a data file in the DyNetML format. In this 
case, the <filename> and <format> children are required, and the 
<properties> child is optional. The child elements are described below:  

filename : location of the data 
format : must by dynetml 
properties : [optional] Describes how ORA should interpret the data read 
from the file, but does not cause ORA to modify the input data in any way. 
Each graph in the Meta-Network is given the property.  

Properties are specified with the attributes below, each of which takes 
values: yes or no 

1. sparse: indicates whether the data is sparse 

2. binary: indicates whether the data should be treated as binary (i.e. 
ignore edge weights) 

3. symmetric: indicates whether the unimodal graphs should be 
considered symmetric 

4. diagonal: indicates whether the diagonal values of unimodal graphs 
should be used 

Example: 
<Meta-Network id="Organization"> 
<filename>data/organization.xml</filename> 
<format>dynetml</format> 
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<properties binary="yes"/> 
</Meta-Network> 

1.2 Meta-Network data in multiple matrix files 
The second case has the Meta-Network data located in multiple files. In this 
case, the script must describe how to assemble the Meta-Network from 
different data files.  

Matrix data describes a relationship between two sets of nodes, called the 
source and target Nodesets. Therefore, in specifying a matrix, these 
nodesets must be specified. A unique id for the matrix is also specified. This 
id must be unique across all matrices in the Meta-Network. 

The <matrix> element defines a matrix and has the following case-
insensitive attributes: 

sourceType : type of the source Nodeset  
source : [optional] unique identifier of the source Nodeset  
targetType : type of the target Nodeset 
target : [optional] unique identifier of the target Nodeset  
id : [optional] id of the matrix 

The above attributes can be any string.  

The sourceType and targetType attributes specify the class or general 
category of the Nodesets. By convention, these are taken from Agent, 
Knowledge, Resource, Task, Location, or Organization, but any string can be 
used. 

The source and target attributes uniquely identify the source and target 
Nodesets, and if they are not specified the sourceType and targetType are 
used. To have more than one Nodeset of a given type (e.g. "blue" agents 
and "red" agents), the source attribute must be used. 

The id uniquely identifies the matrix within the collection of matrices that is 
the Meta-Network. By default, the id is constructed from the source and 
target types. 

Examples: 
<matrix sourceType="agent" targetType="agent" id="reports to"/> 
<matrix sourceType="agent" source="employee" targetType="agent" 
target="employee" id="works with"/> 
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As in the first case, the <matrix> element must have the child elements 
<filename> and <format> that describe the location and format of the 
matrix data. The <properties> element is optional, and pertains only to the 
matrix. 

The <format> element takes one of the following values: 

dynetml : DyNetML specified data 
ucinet : UCINET binary format (refer to UCINET documentation) 
dl : UCINET text format (refer to UCINET DL documentation) 
csv : CSV (Comma Separated Values) allows row and/or column labels 
raw : space, comma, or semi-colon separated data (no labels allowed) 

Example: 
<Meta-Network id="SampleOrganization"> 
<matrix sourceType="agent" targetType="agent" id="communication"> 
<filename>data/organization_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
</Meta-Network> 

Multiple <matrix> elements are used to define the constituent matrices of 
the Meta-Network. Note that <Meta-Network> has no immediate 
<filename> and <format> children since the data is described under the 
<matrix> child elements. 
 
Example: 
<ora> 
<input> 
<Meta-Network id="SampleOrganization"> 
<matrix sourceType="agent" targetType="agent" id="social"> 
<filename>data/organization_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/organization_agent_knowledge.dl</filename> 
<format>dl</format> 
</matrix> 
</Meta-Network> 
</input> 
</ora> 

In the example, the Meta-Network contains two matrices: the first of type 
Agent x Agent and named social, and it is populated with data from the 
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specified file of the specified format. The second has type Agent x 
Knowledge, and no name is specified. 

1.3 Multiple Meta-Networks 
Multiple Meta-Networks can be specified in the <input> section using unique 
id attributes. 

Example: multiple Meta-Networks differentiated by id attribute 
<ora> 
<input> 
<Meta-Network id="SampleOrganization1"> 
<matrix sourceType="agent" targetType="agent" id="social"> 
<filename>data/organization_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
<matrix sourceType="agent" targetType="agent" id="friendship"> 
<filename>data/organization_agent_agent_friend.csv</filename> 
<format>csv</format> 
</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/organization_agent_knowledge</filename> 
<format>ucinet</format> 
</matrix> 
</Meta-Network> 
<Meta-Network id="SampleOrganization2"> 
<filename>data/organization2.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 
</input> 
</ora> 

1.3 Meta-Network Directories 
If there are multiple DyNetML files in a single directory, then one can specify 
the directory and ORA will create a Meta-Network from each file. The <Meta-
NetworkDirectory> element is used, whose only attribute is name that 
specifies the path of the directory. Each file must have .xml extension. A 
<transform> element can be used within the element to apply to each Meta-
Network. The id for each Meta-Network is its filename. 

Example: load all Meta-Networks from a directory 
<ora> 
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<input> 
<Meta-NetworkDirectory name="data/sample/"> 
<transform> 
<conform method="union"/> 
</transform> 
</Meta-NetworkDirectory> 
</input> 
</ora> 

B. Output Section 

The second section of the script file is the <output> element, and it 
describes which reports to generate. The reports available in ORA and how 
to specify them in the ora-script is documented in the file ORA-batch-mode-
parameters.xml, which is an XML specification in Relax-NG. 

Ora-Script Report Generation 
To tell ORA to create a report, the <reports> child element is used in the 
ora-script. The <reports> child element contains a collection of <report> 
elements. Each report element specifies any input parameters, the output 
filename, and the output file type/format. Each <report> is uniquely 
identified by its id attribute. 

The <filename> child specifies the name of the output file to create. The 
filename should NOT have an extension. The <formats> child contains one 
or more <format> children which specify the format of the report output. 

For each report, the possible formats are: text, html, csv, dynetml 

Example: generating a report in multiple output formats 
<report id="intelligence"> 
<filename>reports/intelligence</filename> 
<formats> 
<format>text</format> 
<format>csv</csv> 
</formats> 
</report> 

Any report specific parameters are designated within the <parameters> 
child. The parameters for each report are documented in the file: 
ora_xml_measures.xml 

Example: specifying report parameters 
<report id="intelligence"> 
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<parameters> 
<numberOfKeyEntities>10</numberOfKeyEntities > 
</parameters> 
<filename>reports/intelligence</filename> 
<formats> 
<format>html</format> 
<format>csv</format> 
</formats> 
</report> 

Example: shorter script if only one output format is specified 
<report id="intelligence" filename="reports/intelligence" format="text"> 
<parameters> 
<numberOfKeyEntities>10</numberOfKeyEntities > 
</parameters> 
</report> 

3. Saving Meta-Networks 
The input Meta-Networks can themselves be saved to files. This allows for 
converting between matrix formats and for saving transformed or conformed 
input data. 

Example: saving a specific Meta-Network 
<ora> 
<output> 
<Meta-Networks> 
<Meta-Network id="sample"> 
<filename>data/output/sample.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 
</Meta-Networks> 
</output> 
</ora> 

Only the specified Meta-Networks will be saved. Individual matrices can be 
saved using the syntax identical to that of the <matrix> element in the input 
section. The following, for example, saves the agent x agent matrix: 

Example: saving a specific matrix from a Meta-Network 
<ora> 
<output> 
<Meta-Networks> 
<Meta-Network id="sample"> 
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<matrix sourceType="agent" targetType="agent"> 
<filename>data/output/sample_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 
</Meta-Network> 
</Meta-Networks> 
</output> 
</ora> 

In addition, network set operations (union, intersection, difference) can be 
performed on the input networks and then saved. The sample below 
assumes that there were two Meta-Networks specified in the <input> 
section, namely, A and B, and the set operations all pertain to them. Union 
and Intersect operate on one or more input Meta-Networks, and the 
parameter method indicates how to handle common edges. The method 
attribute takes on one of the following values: binary, sum, maximum, or 
minimum. The difference between two Meta-Networks is taken with respect 
to edges only, and thus no nodes are removed. 

Example: saving union of multiple input Meta-Networks 
<output> 
<Meta-Networks> 
<!--Union--> 
<Meta-Network id="A Union B"> 
<filename>data/output/A-union-B.xml</filename> 
<format>dynetml</format> 
<union method="sum"> 
<Meta-Network id="A"/> 
<Meta-Network id="B"/> 
</union> 
</Meta-Network> 
<!--Intersect--> 
<Meta-Network id="A Intersect B"> 
<filename>data/output/A-intersect-B.xml</filename> 
<format>dynetml</format> 
<intersect method="minimum"> 
<Meta-Network id="A"/> 
<Meta-Network id="B"/> 
</intersect> 
</Meta-Network> 
<!--Difference (edges only)--> 
<Meta-Network id="A Minus B"> 
<filename>data/output/A-minus-B.xml</filename> 
<format>dynetml</format> 
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<difference> 
<Meta-Network id="A"/> 
<Meta-Network id="B"/> 
</difference> 
</Meta-Network> 
</Meta-Networks> 
</output> 
</ora> 

4. Transform Element 
The transform element is used to pre-process a Meta-Network or an 
individual matrix of a Meta-Network before generating reports. It transforms 
its parent element. For example, if the <transform> element is a child of a 
<matrix> then it applies to that matrix. If it is a child of <Meta-Network>, 
then it transforms the entire Meta-Network: for Nodeset modifications 
(removeNodes, subsetNodes, conform), these apply to the Meta-Network as 
a whole, but transformations of edges (symmetrizing, dichotomizing) are 
applied to each matrix independently. 
 
The <transform> element has the following child elements that define the 
transformation: 

<transpose> : transpose the graph 

<removeIsolates> : remove isolate nodes  
 
<removePendants> : remove pendant nodes  

<symmetrize method=””> : symmetrize using one of two methods 
“union” : symmetrize using the union/maximum method 
“intersect” : symmetrize using the intersect/minimum method 
Default is “union”. 

<subsetNodes> : defines a subset of nodes to create a subgraph 
contains one or more of the following child elements: 
<nodeSet type=””/> : adds all nodes in the specified Nodeset to the subset.  
 
The type attribute can have values: agent, knowledge, resource, task, 
organization 

<node type=”” id=”” radius=””/> : adds the specified node to the subset 
The type attribute is identical to that of the <nodeSet> element.  
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The id attribute is the node’s unique id within the Nodeset. 
 
The radius attribute is optional (by default it is zero), and includes all nodes 
within a distance <= radius of the node. This is useful for defining ego 
Nodesets. 

<removeNodes> : defines a subset of nodes to remove 
contains the same <nodeSet> and <node> child elements as subsetNodes 

<conform method=""/> : creates an identical set of nodes across Meta-
Networks. This is useful for time-series data to give each Meta-Network the 
same Nodesets. The union method adds isolates to achieve identical sets, 
and the intersect method removes nodes. 

The method attribute can have one of two values: 
union: create union of Nodesets  
intersect: create intersection of Nodesets 
Default is "union". 

By default the agent, knowledge, resource, task, and organization Nodesets 
are conformed. This can be customized by adding <nodeSet> child elements 
to specify specific Nodesets, as in subsetNodes above. 

<dichotomize criteria="" cutoff=""/> : creates a binary graph according to 
the criteria and cutoff. Any edges whose value does not satisfy the criteria 
and cutoff are given a value of 0, otherwise a value of 1. 
 
The criteria attribute takes one of the following values: 
lessThan, lessThanEquals, equals, greaterThanEquals, greaterThan 
 
The cutoff attribute can be any numerical value. 

Precedence 
The order (i.e. precedence) in which the transformations occur is as follows: 
(1) individual matrices, (2) Meta-Networks, (3) across Meta-Networks. Each 
of these usages is in the examples below. 

The precedence of operations within a transform (for example, is the graph 
symmetrized before dichotomizing, etc.) is defined to be the same as they 
are specified in the <transform> element. Thus, if the <symmetrize> child 
is before the <dichotomize> child, then the transformation first symmetrizes 
and then dichotomizes. 
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Example: remove all agent nodes and the specified knowledge nodes from 
the Meta-Network 
<Meta-Network id="test"> 
<transform> 
<removeNodes> 
<nodeset id="agent"/> 
<node nodesetId="knowledge" id="physics"/> 
<node nodesetId="knowledge" id="mathematics "/> 
</removeNodes> 
</transform> 
<filename>data/sample.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 

Example: symmetrize a single matrix of the Meta-Network 
<Meta-Network id="test"> 
<matrix sourceType="agent" targetType="agent"> 
<filename>data/aa.csv</filename> 
<format>csv</format> 
<transform> 
<symmetrize method="union"/> 
</transform> 
</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/ak.csv</filename> 
<format>csv</format> 
</matrix> 
</Meta-Network> 

This example creates a sub-Meta-Network as follows: a set of nodes is 
defined, and then the Meta-Network induced by the nodes (that is, all the 
edges incident upon those nodes). The set of nodes consists of all nodes 
within distance 2 of agent Andy and within distance one of Sam. Because the 
transform is part of the Meta-Network, knowledge, task, or organization 
nodes can be connected to these agents, and would therefore be part of the 
set. 

Example: define a subset of nodes 
<Meta-Network id="test"> 
<transform> 
<subsetNodes> 
<node nodesetId="agent" id="Andy" radius="2"/> 
<node nodesetId="agent" id="Sam" radius="1"/> 
</subsetNodes> 
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</transform> 
<filename>/data/myorg.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 

 
This example makes the agent nodes in the Meta-Networks conformable by 
creating the union of all the agent Nodesets across the Meta-Networks. 
Currently, only agent nodes can be made conformable. 

Example: conform nodesets across Meta-Networks 
<input> 
<transform> 
<conform method="union"/> 
</transform> 
<Meta-Network id="org1"> 
<filename>data/org1.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 
<Meta-Network id="org2"> 
<filename>data/org2.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 
<Meta-Network id="org3"> 
<filename>data/org3.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 
</input> 
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Java Licenses 

Library Name / Website / License 

activation  
JavaBeans Activation Framework 
http://java.sun.com/products/archive/javabeans/jaf102.ht  
Sun Microsystems, Inc. Binary Code License Agreement  

ant-launcher  
Ant Laucher 
http://ant.apache.org 
The Apache Software License, Version 2.0  

ant-optional-
1.5.1  

Ant Optional 
http://ant.apache.org 
The Apache Software License, Version 1.1  

batik-awt-util-1.6  
Batik AWT Utilities 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-bridge-1.6  
Batik Bridge 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-css-1.6  
Batik CSS 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-dom-1.6  
Batik DOM Implementation 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-ext-1.6  
Batik Extension 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-gvt-1.6  
Batik Graphics Vector Tree 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-parser-1.6  
Batik Parser 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-script-1.6  
Batik Script 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  
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batik-svg-dom-
1.6  

Batik SVG DOM 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-svggen-1.6  
Batik SVG Generator 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-transcoder-
1.6  

Batik Transcoder 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-util-1.6  
Batik Utilities 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

>batik-xml-1.6  
Batik XML 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

casosparser  
CASOS Parser 
http://www.casos.cs.cmu.edu/projects/ora/ 
   

colt  
Colt 
http://acs.lbl.gov/software/colt/ 
CERN, 1999  

common-2.1.0  
Commons 
http://commons.apache.org/ 
The Apache Software License, Version 2.0  

commons-
beanutils-1.4  

Commons BeanUtils 
http://commons.apache.org/ 
The Apache Software License, Version 2.0  

commons-cli-1.2  
Commons CLI - Command Line Interface 
http://commons.apache.org/ 
The Apache Software License, Version 2.0  

commons-cli-2.0-
gt2-pre1  

Commons CLI - Command Line Interface 
http://commons.apache.org/ 
The Apache Software License, Version 2.0  

commons-codec-
1.4  

Commons Codec 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons- Commons Collections 
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collections-3.1  http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-
httpclient-3.1  

Commons HttpClient 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-io-1.2  
Commons I/O Utilities 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-jxpath-
1.2  

Commons JXPath 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-lang-
2.1  

Commons Lang 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-
logging-1.1.1  

Commons Logging 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-
logging-api-1.1.1  

Commons Logging API 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-math-
1.2  

Commons Math 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-pool-
1.3  

Commons Pool 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

concurrent-1.3.4  

Java Concurrency 
http://download.oracle.com/javase/1.5.0/docs/ 
api/java/util/concurrent/package-summary.html 
Java 2 Platform SE 5.0  

db2jcc_dummy-
8.2.1  

DB2 Spatial Data 
http://geotools.org/ 
Lesser General Public License (LGPL)  

dnsjava-2.0.8  
DNS in Java 
http://www.xbill.org/dnsjava/ 
BSD license  

dom4j-1.6.1    
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ecore-2.1.0  
Ecore 
http://java2ecore.blogspot.com/ 
Lesser General Public License (LGPL)  

facebook-java-
api-1.8-final  

Facebook Java API 
http://mrepo.happyfern.com/sites/facebook-java-api/ 
MIT License  

facebook-util-
1.8-final  

Facebook Companion Utility 
http://mrepo.happyfern.com/sites/facebook-java-api/ 
MIT License  

freehep-
graphics2d-2.0  

FreeHEP 2D Graphics 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-
graphicsio-2.0  

FreeHEP GraphicsIO 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-
graphicsio-pdf-
2.0  

FreeHEP GraphicsIO PDF 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-
graphicsio-svg-
2.0  

FreeHEP GraphicsIO SVG 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-io-2.0.1  
FreeHEP IO 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-util-2.0.1  
FreeHEP Utilities 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-xml-
2.0.1  

FreeHEP XML 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

geoapi-
nogenerics-2.1-
M2  

GeoAPI 
http://www.geoapi.org/ 
GNU Lesser General Public License (LGPL)  

geowidgets-1.0-
M1  

GeoWidgets 
http://geowidgets.sourceforge.net/ 
GNU Lesser General Public License (LGPL)  
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geronimo-stax-
api_1.0_spec-1.0  

  
  

gluegen-rt  
GlueGen 
http://jogamp.org/gluegen/www/ 
BSD license  

gt2-api-2.3.3  
GeoTools API 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-arcgrid-2.3.3  
GeoTools ArcGrid 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-arcsde-2.3.3  
GeoTools ArcSDE 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-brewer-2.3.3  
GeoTools Brewer 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-coverage-
2.3.3  

GeoTools Coverage 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-
coveragetools-
2.3.3  

GeoTools Coverage Tools 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-cql-2.3.3  
GeoTools CQL 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-db2-2.3.3  
GeoTools DB2 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-demo-data-
2.3.3  

GeoTools Data Demo 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-demo-
mappane-2.3.3  

GeoTools MapPane 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-demo-
property-2.3.3  

GeoTools Property Demo 
http://geotools.org/ 
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Lesser General Public License (LGPL)  

gt2-directory-
2.3.3  

GeoTools Directory 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-epsg-access-
2.3.3  

GeoTools EPSG Access 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-epsg-hsql-
2.3.3  

GeoTools EPSG-HSQL 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-epsg-
postgresql-2.3.3  

GeoTools ESPG PostreSQL 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-epsg-wkt-
2.3.3  

GeoTools ESPF-WKT 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-geomedia-
2.3.3  

GeoTools Geomedia 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-geotiff-2.3.3  
GeoTools GeoTIFF 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-gml-2.3.3  
GeoTools GML 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-go-2.3.3  
GeoTools Geospatial Object 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-graph-2.3.3  
GeoTools Graph 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-gtopo30-
2.3.3  

GeoTools GTopo30 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-hsql-2.3.3  
GeoTools HQSL 
http://geotools.org/ 
Lesser General Public License (LGPL)  
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gt2-image-2.3.3  
GeoTools Image 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-
imagemosaic-
2.3.3  

GeoTools ImageMosaic 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-
imagepyramid-
2.3.3  

GeoTools ImagePyramid 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-indexed-
shapefile-2.3.3  

GeoTools Indexed Shapefile 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-main-2.3.3  
GeoTools Main 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-mappane-
2.3.3  

GeoTools MapPane 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-mif-2.3.3  
GeoTools MIFFile 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-mysql-2.3.3  
GeoTools MySQL 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-openoffice-
2.3.3  

GeoTools OpenOffice 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-oracle-
spatial-2.3.3  

GeoTools Oracle Spatial 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-postgis-2.3.3  
GeoTools PostGIS 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-referencing-
2.3.3  

GeoTools Referencing 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2- GeoTools Referencing 3D 
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referencing3D-
2.3.3  

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-render-2.3.3  
GeoTools Render 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-sde-dummy-
2.3.3  

GeoTools SDE Dummy 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-shapefile-
2.3.3  

GeoTools Shapefile 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-shapefile-
renderer-2.3.3  

GeoTools Shapefile Renderer 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-svgsupport-
2.3.3  

GeoTools SVG Support 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-tiger-2.3.3  
GeoTools Tiger 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-validation-
2.3.3  

GeoTools Validation 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-vpf-2.3.3  
GeoTools Vector Product Format 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-wfs-2.3.3  
GeoTools Website Feature Server 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-widgets-
swing-2.3.3  

GeoTools Swing Widgets 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-wms-2.3.3  
GeoTools Web Map Service 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-xml-2.3.3  GeoTools XML 
http://geotools.org/> 



1265 
 

Lesser General Public License (LGPL)  

gt2-xml-filter-
2.3.3  

GeoTools XML Filter 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-xml-gml2-
2.3.3  

GeoTools XML GML 2 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-xml-gml3-
2.3.3  

GeoTools XML GML 3 
http://geotools.org/ 
Lesser General Public License (LGPL)  

hsqldb-1.8.0.1  
HyperSQL DataBase 
http://hsqldb.org/ 
BSD license  

htmlparser  
HTML Parser 
http://htmlparser.sourceforge.net/ 
Common Public License Version 1.0  

httpclient-4.0-
beta2  

HttpClient 
http://hc.apache.org/httpcomponents-client-ga/ 
Apache License, Version 2.0  

httpcore-4.0-
beta3  

HttpCore 
http://hc.apache.org/httpcomponents-core-ga/ 
index.html 
Apache License, Version 2.0  

httpcore-nio-4.0-
beta3  

HttpCore Non-Blocking IO 
http://hc.apache.org/httpcomponents-core-ga/ 
httpcore-nio/index.html 
Apache License, Version 2.0"  

httpmime-4.0-
beta2  

HttpMime 
http://hc.apache.org/httpcomponents-client-ga/ 
httpmime/index.html 
Apache License, Version 2.0"  

idw  
IntelliDraw Vector Graphic 
  
Adobe License  

imageioext-
asciigrid-1.0-rc1  

Image IO Extentions ASCII Grid 
http://java.net/projects/imageio-ext/ 
Lesser General Public License (LGPL)  
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imageioext-
customstreams-
1.0-rc1  

Image IO Extensions Custom Streams 
http://java.net/projects/imageio-ext/ 
Lesser General Public License (LGPL)  

iText-2.1.0  
iText 
http://itextpdf.com/ 
Affero General Public License  

j3dcore  
Java3D Core 
http://www.j3d.org/ 
Java Distribution License  

j3dutils  
Java3D Utilities 
http://www.j3d.org/ 
Java Distribution License  

j3d-vrml97  
Java3D VRML 
http://www.j3d.org/ 
Java Distribution License  

jai_codec  
Java Advanced Imaging Codec 
http://java.net/projects/jai/ 
Sun Microsystems, Inc. Binary Code License Agreement  

jai_core  
Java Advanced Imaging Core 
http://java.net/projects/jai/ 
Sun Microsystems, Inc. Binary Code License Agreement  

Jama-1.0.1  
Java Matrix Package 
http://math.nist.gov/javanumerics/jama/ 
GNU Lesser General Public License  

java-getopt-
1.0.13  

Java GetOpt 
http://javagetopt.sourceforge.net/ 
Lesser General Public License (LGPL)  

javaml-0.0.12  
Java Machine Learning Library 
http://java-ml.sourceforge.net/ 
GNU Lesser General Public License  

jaxb-api-1.3  
Java Architecture for XML Binding API 
http://jaxb.java.net/ 
GNU Lesser General Public License  

jaxb-impl-1.3  
Java Architecture for XML Binding Implementation 
http://jaxb.java.net/ 
GNU Lesser General Public License  

jaxb-libs-1.3  Java Architecture for XML Binding Libraries 
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http://jaxb.java.net/ 
GNU Lesser General Public License  

JAXWS2.1.3-
20071218  

Java API for XML Web Services 
http://jax-ws.java.net/ 
GNU Lesser General Public License  

jcalendar  
JCalendar 
http://www.toedter.com/en/jcalendar/index.html 
GNU Lesser General Public License  

jcommon-1.0.9  
JCommon 
http://www.jfree.org/jcommon/ 
GNU Lesser General Public License  

jdbc-stdext-2.0  

Java Database Connectivity 
http://www.oracle.com/technetwork/java/ 
javase/tech/index-jsp-136101.html 
Java 2 Platform SE 5.0  

jdom-1.1  
JDOM 
http://www.jdom.org/ 
JDOM License  

jfreechart-1.0.13  
JFreeChart 
http://www.jfree.org/jfreechart/ 
GNU Lesser General Public License  

jfreechart-
1.0.13-swt  

JFreeChart SWT 
http://www.jfree.org/jfreechart/ 
GNU Lesser General Public License  

jgraphlayout  
Java Graph Layout 
http://www.jgraph.com/jgraph.html 
BSD license  

jhall  
JavaHelp 
http://javahelp.java.net/ 
Sun Binary Code License Agreement  

jide-oss-3.0.2  
JIDE Common Layer 
http://www.jidesoft.com/products/oss.htm 
GNU Lesser General Public License  

jlfgr-1.0  
Java Look and Feel Graphics Repository 
http://java.sun.com/developer/techDocs/hi/repository/ 
Java 2 Platform SE 5.0  

jogl  Java OpenGL 
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http://java.net/projects/jogl/ 
BSD license  

jsi-generics  
Java Spatial Index 
http://jsi.sourceforge.net/ 
GNU Lesser General Public License  

json-1.0  
JSON in Java 
http://www.json.org/java/ 
The JSON License  

jsr108-0.01  
Java Specification Request 
http://www.jcp.org/en/jsr/detail?id=108 
Apache License, Version 2.0  

jta-1.0.1B  
Java Transaction API 
http://java.sun.com/products/jta/ 
Java 2 Platform SE 5.0  

jts-1.7-generics  
Java Topology Suite Generics 
http://www.vividsolutions.com/jts/JTSHome.htm 
Lesser General Public License (LGPL)  

jung  
Java Universal Network/Graph Framework 
http://jung.sourceforge.net 
The JUNG License  

junit  
JUnit Testing Framework 
http://junit.org 
JUnit Common Public License - v 1.0  

junit-3.8.1  
JUnit Testing Framework 
http://junit.org 
JUnit Common Public License - v 1.0  

kxml2-2.3.0 
kXML 2 
http://kxml.sourceforge.net/kxml2/ 
BSD license  

linkedin-j-
android  

LinkedIn for Android Java Wrapper 
http://m.linkedin.com/android 
The Apache Software License, Version 2.0  

log4j-1.2.6  
Log4j 
http://logging.apache.org/log4j/1.2/ 
The Apache Software License, Version 2.0  

mail  JavaMail 
http://www.oracle.com/technetwork/java/ 
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javamail/index.html 
JavaMail API  

MDateSelector14-
00347  

MDate Selector 
http://web.ukonline.co.uk/mseries 
GNU Library or Lesser General Public License (LGPL)  

omcorba  
OpenMap CORBA Classes 
http://openmap.bbn.com/ 
OpenMap Software License  

omj3d  
Java 3D Classes 
http://www.j3d.org/ 
Java Distribution License  

omsvg  
  
http://openmap.bbn.com/ 
OpenMap Software License  

opencsv-1.7  
Open Source CSV Parser 
http://opencsv.sourceforge.net/ 
The Apache Software License, Version 2.0"  

openmap-4.6.5  
OpenMap 
http://openmap.bbn.com/ 
OpenMap Software License  

picocontainer-1.2  
PicoContainer 
http://picocontainer.org/ 
BSD License  

poi-3.7-
20101029  

Apache POI 
http://poi.apache.org/ 
The Apache Software License, Version 2.0  

poi-ooxml-3.7-
20101029  

Apache POI 
http://poi.apache.org/ 
The Apache Software License, Version 2.0  

poi-ooxml-
schemas-3.7-
20101029  

Apache POI 
http://poi.apache.org/ 
The Apache Software License, Version 2.0  

poi-scratchpad-
3.7.20101029  

Apache POI Scratchpad 
http://poi.apache.org/ 
The Apache Software License, Version 2.0"  

postgis-driver-
1.0  

PostGIS 
http://postgis.refractions.net/ 



1270 
 

GNU General Public License  

postgresql-8.1-
407.jdbc3  

PostgreSQL JDBC Driver 
http://jdbc.postgresql.org/ 
BSD License  

relaxngDatatype-
X  

Oracle Containers for Java 
http://www.oracle.com/technetwork/middleware/ias/ 
downloads/utilsoft-090603.html 
Java 2 Platform SE 5.0  

rome-1.0  
Rome 
http://java.net/projects/rome/ 
Apache Software License Version 1.1  

rssutils  

RSS Utilities 
http://java.sun.com/developer/technicalArticles/ 
javaserverpages/rss_utilities/ 
Java 2 Platform SE 5.0  

signpost-core-
1.2.1.1  

Signpost 
http://code.google.com/p/oauth-signpost/ 
The Apache Software License, Version 2.0"  

spatialdb-0.1  
  
  
   

svgSalamander-
tiny  

SVG Salamander 
http://svgsalamander.java.net/ 
Lesser General Public License (LGPL)  

swingx-1.0  
SwingX 1.0 
http://www.swinglabs.org/ 
Lesser General Public License (LGPL)  

TableLayout  
TableLayout 
http://java.sun.com/products/jfc/tsc/articles/tablelayout/ 
Java 2 Platform SE 5.0  

toolkits_1-2-0  
  
  
   

trove-2.0.4  
Trove 
http://trove.starlight-systems.com/ 
Lesser GNU Public License (LGPL)  

twitter4j-1.1.7  Twitter4J 
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http://twitter4j.org/en/index.html 
The Apache Software License, Version 2.0  

vecmath-1.3.1  
Java 3D Vecmath 
http://java.sun.com/products/java-media/3D/ 
Java 2 Platform SE 5.0  

velocity-1.4  
Velocity 
http://velocity.apache.org/,"Th 
Apache Software License, Version 2.0"  

worldwind-
0.6.430.13251  

NASA World Wind 
http://worldwind.arc.nasa.gov/java/ 
NASA OPEN SOURCE AGREEMENT VERSION 1.3  

velocity-dep-1.4  
Velocity 
http://velocity.apache.org/ 
The Apache Software License, Version 2.0"  

xercesImpl-2.7.1  
Xerces Implementation 
http://xerces.apache.org/xerces2-j/ 
The Apache Software License, Version 2.0"  

xml-apis-1.0.b2  
XML APIs 
http://xml.apache.org/commons/ 
The Apache Software License, Version 2.0"  

xml-apis-xerces-
2.7.1  

Xerces XML APIs 
http://xerces.apache.org/xerces2-j/install.html 
The Apache Software License, Version 2.0"  

xml-beans-2.3.0  
XML APIs 
http://xml.apache.org/commons/ 
The Apache Software License, Version 2.0"  

xml-writer  

XML Writer 
http://download.oracle.com/javase/1.5.0/docs/ 
api/javax/sql/rowset/spi/XmlWriter.html 
Java 2 Platform SE 5.0  

xsd-2.1.1  

XML Schema Definition 
http://vmgump.apache.org/gump/public/msv/ 
xsdlib/index.html 
JAVA WEB SERVICES DEVELOPER PACK, VERSION 1.5  

xsdlib-20050614  

XML Schema Definition Library 
http://vmgump.apache.org/gump/public/ 
msv/xsdlib/index.html 
JAVA WEB SERVICES DEVELOPER PACK, VERSION 1.5"  
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	Importing deltakey frame data
	Does data have to be in deltakeyframe to run Loom
	Can you show only some time periods or some locations
	Danger of Creating Many Meta-Networks
	Why Link Attributes Exist
	Link Status Dialog
	Coloring
	Labels
	Selecting a Set of Nodes
	NOTE : This function works well when selecting a small part of your overall Meta-Network and magnifying it to fill the visualizer screen.
	NOTE : Use this feature in conjunction with the magnifying glass function to work your visualization into largest size possible.
	NOTE : This also affects the size of the nodes in the Legend.
	NOTE : Only one set of nodes can be selected at a time. Creating a second selection negates the first nodes selected.
	NOTE : Buttons without graphic images are placed on the toolbar using words. When placing a toolbar vertically it will expand to the width of the largest button.
	NOTE : The buttons appear in the order you select them. You can not re-arrange buttons once they are placed on the toolbar.
	NOTE : The Hyperbolic function, when selected, converts the slider to this feature. This is also true of using the zoom and rotate functions. Use all three in conjunction to get your visualization just the way you want it. Scroll down below this scree...
	NOTE : It is useful to use this tool in conjunction with the Rotate and Magnify tools to obtain just the view you desire.
	NOTE : If you pan the visualization, the paint drawing will remain stationery on the screen. It does not move with the visualization.
	NOTE : Use the rotate feature in tandem with the magnifying glass to find a visualization's maximum screen size.

	Hide Single Nodeset Label
	NOTE : Clicking on the Magnifying glass in the Visualizer tool bar will set the view to include all visible nodes.

	Save Special :
	Selecting Image Resolution on Save
	NOTE : Values less than 1.0 are ignored when scaling images.

	Save Selected Sub-Network
	Notes on Display of Multiple Edges : If your Meta-Network contains graphs with multiple edges between two nodes ORA will display the edges as curved lines so as to allow visualization of overlapping Edges. This is to say that if there is represented t...
	Please note that Tool tips are currently handled by math looking at the edge as if it were a straight line. Since our line is not straight anymore, it will only be highlighted if the cursor's in the middle - nowhere near the edge. But otherwise, you s...
	WARNING : These actions DELETE the nodes from the Meta-Network. Saving the Meta-Network will permanently remove the nodes.

	Show Motifs
	NOTE : Cycles is the only motif that really looks at link direction.

	Isolates
	IMPORTANT NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use either the File > Save Meta-Network As... (to save the entire Meta-Network with additions) or File > Add Meta-Network to Ora (to create a new Meta-Network us...
	NOTE : If the Number to Create is larger than 1 then the text placed in section 3 for Node ID will be used as a prefix for all new nodes crated.

	Adding Multiple Nodes
	NOTE : You can only use a prefix ONCE. ORA will not accept any previously used prefixes a second time.
	NOTE : Now either save the altered Meta-Network using the File > Save Meta-Network As... to a new filename or continue with Add Link(s).
	NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use either the File > Save Meta-Network As... (to save the entire Meta-Network with additions) or File > Add Meta-Network to Ora (to create a new Meta-Network using only t...
	NOTE : Since this function creates directed links a second link would need created for reciprocal action.

	Adding a Missed Link
	NOTE : this created a directional link from janet_frazier to gen_hammond but not the other way. To make it go both ways, a second link from gen_hammond to janet_frazier would need to be created.

	Periphery
	Hide Isolate Nodes
	Combine into Meta-Node
	Move into Column
	NOTE : The original dataset was changed in order to create the isolates.
	NOTE : If the names are not viewable and off the screen, change the position of the labels

	The DataSet
	NOTE : Sizing nodes by attributes only works with attributes of numerical content. Alpha content will have no affect on the size of the nodes.
	NOTE : The numerals are not displayed in ORA and are shown only for display purposes.
	Cognitive Measure for daniel_jackson
	Cognitive Measure for teal'c
	Interface
	Example
	Visualization Example of a Network.
	Drill Down Wizard Example
	Drill Down Wizard Explained
	Save Color Scheme
	NOTE : This color change is in effect for as long as the Visualizer is open. If you close and re-open the Visualizer the colors will revert to their default colors.

	Node Formatter
	NOTE : The Node Formatter works only with the node(s) originally selected. To change the parameters for another node(s) you must close the Node Formatter dialog box, select another node(s), then perform your changes.

	Link Formatter
	NOTE : If after you hide a link and close the Link Formatter dialog box the only way to bring that link back a link you have hidden is to use the menu item Actions > Show All Nodes. But remember, this will also undo any other hidden nodes and links yo...

	The Original Network
	NOTE : For these examples I changed the color of the location nodes to light blue for better visibility during changes. See Node Color for procedure
	Example : I select the node Greedo and place checkmark in both boxes. Under the tab Appearance I select [Choose a Custom Color] from the drop down menu. A distinctive dark blue color is selected then I click [Apply].

	Two Nodes
	NOTE : You can also revert these changes by using the drop down menu to select Color by Source Node or Color by Target Node which will remove any custom color. Clicking [Make Link(s) Continuous Lines] will revert any selected links back to one solid l...

	ORA Micro-Simultation Overview
	General Thoughts on MicroSims
	Diffusion of Ideas
	NOTE : Negative weight links are ignored.
	NOTE : Once a new meta network is created, it takes all the links and normalizes them between zero and one. The link weight then corresponds to the probability that a transmission will occur down that link. This obviously means that both Link Directio...

	Two main controls
	Ideas
	Diffusion of Disease
	Information for disease simulation.
	Dispersion of Money
	Adoption of Technology
	NOTE : Data that is not dated will be loaded in the order it was selected, not the order it is in the tree and not the order it was loaded in. This only happens when the data has no dates associated with it.

	Summit-1
	Summit-2
	Summit-3
	Summit-3
	NOTE : Measures and reports run on these multi-Meta-Neworks are for all connexions, not the individual Meta-Networks.

	Time Clustering
	Note : A slightly different version of this tool is available in the ORA Main Menu interface (i.e., non-Visualizer tool).

	Node Selector
	Visibility
	Node Location
	Node Appearance
	Other
	Node Selector Examples
	Move Left/Right
	Tabs
	Attribute Button
	Show This Window check box
	The interface contains four sections:
	Using only Agent nodes (tolerance = 0)
	NOTE : For this example the values in the Network have been altered from the regular values.
	Tolerance of "1", nothing else checked.
	Shortest path: 1
	There is the direct link from gen_hammond to col_jack_o'neill and the secondary pathway with teal'c in the middle.

	Use link direction
	Shortest path: 2
	The link from gen_hammond to col-jack-o'neill is removed as it's a directional link in the wrong direction. The shortest link is "2".

	Use link weight (Remove links with negative values)
	Shortest path: 6

	Use link weights finds the shortest path from A to B using minimal weights as opposed to minimal number of links. Also the shortest path is the total of the link weights — not the number of links total.
	The shortest path is from col_jack_o'neill to teal'c (5) then from teal'c to gen_hammond (1) for a total of "6".

	Use link weight (Convert negative links to positive values)
	Shortest path: 3

	Use link direction and link weight with absolute values
	Shortest path: 3

	Select a sphere of influence radius
	What are node rings in the visualizer?
	NOTE : Now you're probably asking "if this new algorithm is so good, why not keep it on all the time?" Reason: If you pick up and drag a node, and as such drag an entire meta-network, the display will look jittery and confusing. So, whenever you load ...
	NOTE : This layout typically works well with non-circular networks. i.e. networks were links have links going only one direction. Using circular layouts can create problematic displays.

	Automatic
	Automatic - Ignore Link Direction
	Automatic - by Attribute
	NOTE : You must have Meta-Nodes > Meta-Nodes Appearance > Show Component Nodes by Membership for this to display correctly.

	Procedure
	Placement of Nodes
	Node Color
	NOTE : In less new versions, the same functions are stored under Node Appearance > Node Color > Save Node Color to Attributes and Node Appearance > Node Color > Load Node Color from Attributes.

	Full Image
	NOTE : Early Prototype Version

	Meta-Nodes
	Menu
	Display Meta-Node in Own Window
	View Meta-Node Information
	Meta-Nodes Dialog
	Base Meta-Network Display
	Create By Attribute
	Show Nodes By Meta-Nodes
	Reset
	Funnel Nodes Without Attribute
	Multiple Attributes
	NOTE : For easier viewing I made only the three Meta-Node names visible. Then I double-clicked on them and used the Node Status box to rename them.

	Start by visualizing a Meta-Network.
	Create Meta-Nodes by Node Class
	Create Meta-Nodes by Node Association
	Create Meta-Nodes by Grouping
	Node Status Example
	Meta-Nodes by Component Nodes
	Meta-Nodes by Bounding Box
	Meta-Nodes by Bounding Polygon
	Other View Srtles
	Description
	Newman with 4 groups
	Newman with 10 groups
	Newman with 4 groups - Colored
	Description
	Girvan Newman with 4 groups
	Examining a Meta-Node
	Parameters
	Example
	Use out-links
	Use in-links
	Use both in-links and out-links
	Johnson - Similarity, Single Links
	Johnson - Similarity, Complete Links
	Johnson - Similarity, Average Links
	REMEMBER : Groups produce tasks - people participate in tasks.

	One-Mode
	Multi-Mode
	Links
	Node Appearance
	NOTE : Meta-Network must be saved in the Editor in order for colors to be reloaded the next time the Meta-Network is loaded.  The Nodesets retain their default color in the Legend dialog. i.e. all agent NodeClasses will default to red.
	NOTE : Primarily used to resetting size after using Size Nodes by Attribute or Measure. The size set on the toolbar is the default size.
	NOTE : For this example all the nodes are colored black so as to decrease the color confusion.
	NOTE : For this example the link weights have been drastically altered from the original values to assist in display purposes.
	NOTE : Below is a warning for the placement of the Min and Max sliders. When the sliders are set to the absolute left and right positions this causes all the colors to be set to red. Move the sliders in to prevent this.

	Default Colors

	The ORA Visualizer
	Legend Edit Menu
	Legend Control Menu
	Node Color
	Legend Contextual Menu
	Link Selector-One Node
	Link Selector-Two Nodes
	Micro Simulation-Ideas
	Micro Simulation-Disease
	Micro Simulation-Money
	Micro Simulation-Technology
	Sphere of Influence
	Rings
	How The Node Shaper Changes The Nodeset
	Node Shaper Examples

	Even Distribution
	Scale to Weight
	Link Values
	NOTE : When a link is bi-directional and the weights of the links are not the same the Visualizer will color the link that was drawn last. Sometimes it makes it difficult to tell the actual link color.

	Change link Color
	Original agent x agent Network
	Changing a few nodes
	Select Nodes to Re-Shape
	Scaling Nodes
	NOTE : If you do not reset the node color and size they will remain the same size as before but only change their color.

	Coloring Nodes
	Color By Attribute
	Link Appearance
	Comments
	Title
	Background Color
	NOTE : Some of the possible background colors can make it difficult to view the visualizer. Your best choice is black (although white is used in the examples for easier printing).

	Background Image
	NOTE : Some pictures may make viewing the network somewhat difficult.
	NOTE : These comments are not saved when exiting the Visualizer.
	NOTE : The main use of these comments would be in creating screen shots for display in order to add commentary for a report.


	Adding a Comment
	Adding Multiple Comments
	NOTE: These comments are not saved when exiting the Visualizer.

	Deleting a Comment
	NOTE : To access the contextual menu the option must be checked. Go to Display >  Show Mouse Overs and make sure the option is check marked.
	Mouseover Display Limit
	Setting a Image Folder
	Set Picture
	Custom
	NOTE : Remember to reduce the picture size BEFORE importing it into ORA.

	Node Menu
	Pin SubMenu :
	URL SubMenu :
	Appearance Submenu :
	Visibility Submenu :
	NOTE : This does not delete the node from the Meta-Network.

	Other :
	NOTE : If additions or deletions of Nodesets needs done expand the Meta-Node before proceeding.
	NOTE : This deletion is permanent once the Meta-Network is saved. If there is any question regarding the deletion then remove the Meta-Network from ORA before saving and reload the Meta-Network.

	Link Menu
	Empty Space
	Node Formatter
	NOTE : The Node Formatter works only with the node(s) originally selected. To change the parameters for another node(s) you must close the Node Formatter dialog box, select another node(s), then perform your changes.

	Link Formatter
	NOTE : If after you hide a link and close the Link Formatter dialog box the only way to bring that link back a link you have hidden is to use the menu item Actions > Show All Nodes. But remember, this will also undo any other hidden nodes and links yo...
	NOTE : This example uses only standard icons found in ORA.

	Your Own Icon Set
	NOTE : Be aware that very large icons will make viewing the display difficult. Small distinct icons work better. If using pictures of individuals it's advised to resize them to 50 x 50 pixels.

	Controls
	Three Button Mouse
	Using a Trackpad or a Two-Button Mouse
	2D display
	3D display
	Pinning Nodes
	Nodes Hidden From View
	File
	View
	Actions
	Tools
	Layouts
	Meta-Nodes
	Node Appearance
	Link Appearance
	Display
	Right-Click a Node
	NOTE : Hidden nodes can only be recalled using the Action > Show All Nodes function.
	Show Details... :


	Right-Click a Link
	Delete : Seletes selected link
	Hide : Hides selected link
	Radius... : Changes selected link to new radius
	Weight... : Changes weight of the selected link.
	NOTE : Weight of link can be set between 0 and1.0
	Set Colour... : Calls up colour selector and sets link to that colour.
	Reverse Direction : Reverses the direction of the link.

	NOTE : To show the current direction of the links click the Show Links button on the toolbar.
	NOTE : If after reversing the direction of a link the direction does not change, toggle the Show Links button off and of
	Show Details... :

	NOTE : Other maps, or layers, can be added and loaded into the GIS Visualizer. The GIS Visualizer generally can load geospatial maps based on the Shapefile format.


	GeoSpatial Network
	Layer Manager
	Network Aggregator
	ShapeFiles
	Load ShapeFile
	Color A ShapeFile
	Add GIS Data To Meta-Network
	Trail Cluster Creation
	Trail Cluster Analysis

	Geospatial Networks attributes
	NOTE : The columns which are necessary to build a Location Node Class are highlighted in Blue. In this example below, COUNTRY, POP, and CAP are not necessary, though they can be added, as additional attributes. Further below this chart, we will displa...
	Location data example

	Standard Toolbar
	NOTE : Right-Click on the map to center view on that area.
	Add GIS Data… :
	Save Map… :
	Current GIS Layers
	Current Meta-Network Locations Configurations
	Layer Manager Menus
	NOTE : If you have more than one map layer loaded you can arrange how they are stacked.

	Keeping Separate Agents In The Same Location
	NOTE : You need to remember that in aggregation, ORA is plotting locations, not agents. If two agents have the same latitude/longitude, then ORA will plot then as one point on the map.
	NOTE : And there is also the ability to view this in the 2D or 3D Visualizaer which will display all nodes regardless of the similar lat/long attributes.

	Example
	NOTE : Geospatial Distance does calculate distances taking the curvature of the Earth into consideration.

	Finding ShapeFiles
	General Suggestions
	Load Meta-Network Into GeoSpatial
	Load ShapeFile Into GeoSpatial
	Color Shapes by Links...
	Color Shapes by Node Count
	Color by Attribute/Measure
	NOTE : When adding attributes to use in this manner you need to make sure they are created as numeric. Text attributes will not work.
	NOTE : How can ORA tell whether location data exists? It looks in the attributes for names which contain the substrings lat or lon. If so it will post those as possible geospatial attributes.
	NOTE : For this example my Meta-Network contained information on the population of states. The ERSI file I used contained the latitude/longitude for the U.S. states. Make sure that the ERSI file you use contained the lat/lon data for your Meta-Network.

	Things To Be Aware Of
	NOTE : For those so inclined this data is retrieved from the ShapeFile's DBF file which can be opened with Excel.

	Description
	NOTE : Loom can also display things like persons through beliefs showing how a person make change their mindset over time.
	Caveat : Loom works best when Agents or whatever occupy a single location at a time. It can handle multiple locations, it just gets messy.

	Before you Start
	NOTE : The dotted line denotes a node which disappeared from all locations then reappeared later on.

	What Trail Clustering can do:
	The Clustering Tool
	Trail Pattern Depth
	Cluster Quality
	Minimum Similarity
	The Loom Dataset
	NOTE : Loom works best when Agents, or nodes, occupy a single location at a time. It can handle multiple locations, but you may encounter problems reading the display.
	NOTE : The Loom lists characters in alphabetical order which may, or may not, correspond to the order of the characters in a dataset.
	NOTE : In this example Uncle_Owen = character_5, Aunt_Beru = character_6, Han_Solo = character_9, and Chewbacca = character_10.


	Trail Clustering using Symbolic Time Series Analysis
	Cluster Quality
	References
	Pre-Requisites
	NOTE : Every Nodeset needs to contain identical nodes in every Nodeset. No exceptions.

	Creating a DataSet
	Creates Meta-Network with Clock
	NOTE : In terms of Priorities, GIS looks for Lat/Lon data first, then attempts to find MGRS.

	Example
	NOTE : Common mnemonics include in the house, up the stairs, left-to-right, bottom-to-top and Read Right Up.
	Image Licensing : Image map of Hawaii licensed under the Creative Commons Attribution-Share Alike 3.0 Unported license.
	NOTE : Use the menu item not the dropdown in the button. This allows you to open up a Met-Network that does not contain lat/long data.
	NOTE : The DBF file can be opened in Excel and examined if you are curious.  NOTE : If it finds no appropriate attribute ORA will prompt you to select one or you can skip and go to the next step.
	NOTE : This only works if you have an attribute(s) in the correct numeric format. If you have no attributes that can be used keep the selection at <Select Coordinate type>
	NOTE : How can ORA tell whether location data exists? It looks in the attributes for names which contain the substrings lat or lon. If so it will post those as possible geospatial attributes.
	NOTE : For this example my Meta-Network contained information on the population of states. The ERSI file I used contained the latitude/longitude for the U.S. states. Make sure that the ERSI file you use contained the lat/lon data for your Meta-Network.

	Things To Be Aware Of
	NOTE : For those so inclined this data is retrieved from the ShapeFile's DBF file which can be opened with Excel.

	What is a Measure
	ORA Measures Manager
	Entity Level Measure is one that is defined for, and gives a value for, each entity in a network. If there are x nodes in a network, then the metric is calculated x once each for each node.
	Graph Level Measure is one that is defined for, and gives a value for, the network as a whole. The metric is calculated once for the network.
	Examples are Centralization, Graph Hierarchy, and the maximum or average Betweenness
	Some reports use a predefined set of measures, and these are not affected by the Measure Manager selections (for example, the Intel, Context, Located SubGroups, Sphere of Influence, and Immediate Impact reports). The Risk Report, however, uses only th...
	The following sets of entities (with their abbreviated symbol) are used throughout the document: Agent (A), Knowledge (K), Resource (R), and Task (T). The following networks defined on these entity sets are used throughout the documentation.


	Input:
	This lists each of the Networks that are required as input to the measure. If a measure takes as input a specific network from the Meta-Network, such as the Agent x Knowledge (AK) matrix, then it is listed. If the measure runs on any square (unimodal)...
	1. Each input matrix can have one or more of the following requirements:
	a. square: the matrix must have the same number of rows as columns
	b. binary: it must be binary data (i.e. any links in the network are assumed to have a weight of one)
	c. symmetric: the network must be undirected
	2. ORA does the following when a network does not meet one or more of the above requirements:
	a. square: measure is not computed
	b. binary: measure is computed, and edge weights are ignored (all edges are given value one)
	c. symmetric: measure is computed, and the matrix is first symmetrized using the union method
	A complete list of all measures available in ORA, along with references, input and output specifications, can be found in the following ORA Measures sections.


	Significant digits
	By default ORA shows only three significant digits after the decimal place. With very large networks it is not uncommon for various measures, e.g. closeness to be quite small. As such, with only three significant digits after the decimal place they wi...
	You can change the number of decimal places reported by setting your ORA preferences. From the main menu select Preferences > All preferences.... In the Ora Preferences dialogue box that opens: Select Reports in tree on the left then select the Format...

	Significant Digits
	Link Weight as Distance vs. Strength
	Network vs. Node Level Results
	2-Mode Measures
	Multi-Mode Measures
	Measure Speeds
	Description
	NOTE : This measure works on the Agent x Resource matrix and needs to be in the binary format [ 0 or 1 ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Resource, Agent x Task, Knowledge x Task, Resource x Task and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Resource, and Agent x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task matrix.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works Square Matrices [i.e. Agent x Agent, Location x Location, etc.] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : If G is not symmetric, then between is normalized by (n-1)(n-2).

	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : If beta is 0, then c is simply equal to the row degree of each entity.

	Informal Name
	Citation
	Minimum and Maximum Values
	Description
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The matrix Z is the adjacency matrix representation of the network N.

	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : For the most connected entity, this value tends to 1.0, for the least connected node it tends to 0, and for the average connected entity it tends to 0.5.

	Description
	Example
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and N ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure uses both link weights and link direction in its calculations.
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	Example
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The CD output matrix is symmetric.

	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The CD output matrix is NOT-symmetric.

	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The CR output matrix is symmetric.

	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].

	Example
	With an organization where Bob has the knowledge of X, Y and Z and Sally has the knowledge of Q, R and Z. The Cognitive Similarity mesure would compute a value for Bob and Sally's overlapping knowledge of Z.
	The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The CS output matrix is symmetric.

	Description
	NOTE : This measure works on all Networks and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : Row breadth is identical, except that d is defined using the row degree, rather than the column degree.

	Description
	NOTE : This measure works on a Network and needs to be in the binary format [ 0 or 1 ].  The result will be a integer between [ 0 and the total number of columns ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Informal Name
	Description
	NOTE : This measure works on Any Matrix and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and the number of redundant columns ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent, Agent x Task, Agent x Resource, Resource x Task, and Task x Task matrices and needs to be in the binary format [ 0 or 1 ].

	Example :
	In a given organization Bob is assigned a task which is dependant upon his social links to other individuals in the network. The measure would compute a value for how dependent Bob is on the links to the other individuals to complete the task. A highe...
	The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The transpose of H and N is used to make the communication reciprocal.

	Description
	NOTE : Co-Assignment is always symmetric, but Handoff and Negogiation are not necessarily symmetric.
	NOTE : This measure works on the Agent x Agent, Agent x Task, Agent x Resource, Resource x Task, and Task x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent and Agent x Location matrices and needs to be [ any number ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.
	NOTE : There can not be any self-loops in any of the matrices

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and Total Number of Nodes ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent matrix and can be in [ any number ]. The result will be a number between [ 0 and 1 ], inclusive.  NOTE : When a network has multiple components the Eigenvector Centrality measure is known to behave at tim...

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : Eigenvector centrality and Eigenvector Centrality Per Component both operate on a symmetric network with no self-loops, and all values are output in the range [0,1].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Agent and Agent x Location matrices and can be [ Any Number ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output

	ORA Measures
	Access Redundancy
	Actual Workload
	Agent Knowledge Needs Congruence
	Agent Knowledge Waste Congruence
	Agent Resource Needs Congruence
	Agent Resource Waste Congruence
	Agent Socio Economic Power
	Assignment Redundancy
	Authority Centrality
	Average Communication Speed
	Betweenness Centrality
	Betweenness Network Centralization
	Biological Diversity Index
	Bonacich Power Centrality
	Boundary Spanner
	Burt Constraint
	Capability
	Characteristic Path Length
	Closeness Centrality
	Closeness Network Centralization
	Clustering Coefficient
	Cognitive Demand
	Cognitive Distinctiveness
	Cognitive Expertise
	Cognitive Resemblance
	Cognitive Similarity
	Column Breadth
	Column Count
	Column Degree Centrality
	Column Degree Network Centralization
	Column Rendundancy
	Communication
	Communication Congruence
	Communicative Need
	Complexity
	Connectedness
	Distinctive Correlation
	Degree Centrality Spatial
	Density
	Density Classic SNA
	Diameter
	Diffusion
	Distinctive Correlation
	Edge Betweenness Centrality
	Efficiency
	Eigenvector Centrality
	Eigenvector Centrality Per Component
	Eigenvector Centrality Spatial
	Exclusivity
	Exclusivity Complete
	Expertise Correlation
	Fragmentation
	Geodesic Distance
	Hierarchy
	Hub Centrality
	In Degree Centrality
	In Degree Network Centralization
	Information Centrality
	Interdependence
	Interlockers
	Inverse Closeness Centrality
	Isolate Count
	Knowledge Actual Workload
	Knowledge Based Access Index
	Knowledge Task Completion
	Knowledge Diversity
	Knowledge Exclusivity
	Knowledge Load
	Knowledge Negotiation
	Knowledge Omega
	Knowledge Potential Workload
	Knowledge Rendundancy
	Knowledge Under Supply
	Lateral Link Count
	Local Efficiency
	Location Relevance
	Minimum Speed
	Network Levels
	Node Count
	Node Levels
	Organization Agent Knowledge Needs Congruence
	Organization Agent Knowledge Waste Congruence
	Organization Agent Resource Needs Congruence
	Organization Agent Resource Waste Congruence
	Organization Task Knowledge Needs Congruence
	Organization Task Knowledge Waste Congruence
	Organization Task Resource Needs Congruence
	Organization Task Resource Waste Congruence
	Organizational Availability
	Out Degree Centrality
	Out Degree Network Centralization
	Overall Role Based Availability
	Overall Task Completion
	Performance as Accuracy
	Personnel Cost
	Potential Boundary Spanner
	Potential Workload
	Radials
	Reciprocal Link Count
	Relative Cognitive Distinctiveness
	Relative Cognitive Expertise
	Relative Cognitive Resemblance
	Relative Cognitive Similarity
	Relative Expertise
	Relative Similarity
	Resource Actual Workload
	Resource Based Access Index
	Resource Based Task Completion
	Resource Diversity
	Resource Exclusivity
	Resource Negotiation
	Resource Omega
	Resource Potential Workload
	Resource Rendundancy
	Resource Under Supply
	Role Based Knowledge Availability
	Role Based Resource Availability
	Role Based Knowledge
	Role Resource Availability
	Row Breadth
	Row Count
	Row Degree Centrality
	Row Degree Network Centralization
	Row Redundancy
	Sequential Link Count
	Shared Situation Awareness
	Similarity Correlation
	Simmelian Ties
	Skip Link Count
	Social Technical Congruence
	Span of Control
	Strict Knowledge Congruence
	Strict Resource Congruence
	Strong Component Count
	Task Exclusivity
	Task Knowledge Needs Congruence
	Task Knowledge Waste Congruence
	Task Resource Needs Congruence
	Task Resource Waste Congruence
	Total Degree Centrality
	Total Degree Network Centralization
	Triad Count
	Transitivity
	Upper Boundedness
	Weak Boundary Spanner
	Weak Component Count
	Weak Component Members

	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	Example
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number a between [ 0 and the number of columns - 1 ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent matrix and can be [ Any Number ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : This measure is also called Column Degree Centrality.

	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be in the binary format [ 0 or 1 ].

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be [ the total number of isolates ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Knowledge x Task, and Agent x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent and Agent x Knowledge matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a binary number [ 0 or 1 ].

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	NOTE : Task Completion Overall is a combination of the Task Completion Knowledge and the Task Completion Resource.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	Example
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task, Agent x Knowledge, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task, Knowledge x Task, and Task x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task, Agent x Knowledge, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent, and Agent x Location matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	NOTE : Minimum Speed = 1 / (Levels for the Network)

	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and the number of node levels - 1 ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and the number of nodes in the Network ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and the number of nodes - 1 ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Organization, Agent x Task, Organization x Resource, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : This measure is also called Row Degree Centrality.

	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Resource, Knowledge x Role, Resource x Role, and Task x Role matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : Task Completion Overall is a combination of the Task Completion Knowledge and the Task Completion Resource.
	NOTE : This measure works on the Agent x Knowledge, Agent x Resource, Agent x Task, Knowledge x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, Agent x Resource, Knowledge x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent, Agent Knowledge, Agent x Resource, and Agent x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Resource, Knowledge x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be in the binary format [ 0 or 1 ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : Note that the CD output matrix is symmetric.

	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : Note that the CD output matrix is NOT-symmetric.

	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The CR output matrix is symmetric.

	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The CS output matrix is symmetric.

	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Resource x Task, and Agent x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent and Agent x Resource matrices and needs to be in the binary format [ 0 or 1 ].  The result will be in the binary format [ 0 or 1 ].

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	NOTE : Task Completion Overall is a combination of the Task Completion Knowledge and the Task Completion Resource.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task, Agent x Resource, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task, Resource x Task, and Task x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task, Agent x Resource, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge and Knowledge x Role matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource and Resource x Role matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Knowledge x Role, and Task x Role matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource and Resource x Role matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : Column breadth is identical, except that d is defined using the column degree, rather than the row degree.

	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be [ The number of rows in a matrix ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Informal Name
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be [ the average of links ].

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number of [ shared assets with other nodes ].
	Example

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Any Matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Agent, Agent x Task, and Task x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be the [ average number of out links for all non isolate nodes ].

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Task matrix and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Knowledge, Agent x Task, and Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on the Agent x Resource, Agent x Task, and Resource x Task matrices and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	NOTE : The diagonal values are ignored.

	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and can be any number.  The result will be a number between [ 0 and 1 ], inclusive.

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and the number of triads ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and 1 ], inclusive.

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be in the binary format [ 0 or 1 ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and the number weakly connected nodes ].

	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Description
	NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x Location, etc] and needs to be in the binary format [ 0 or 1 ].  The result will be a number between [ 0 and the number of weak components ].

	Example
	Informal Name
	Citation
	Minimum and Maximum Values
	Computational Time
	Input and Output
	Measures by Report

	Reports and Measures Tables
	Assessing Change in Plan
	Belief Propagation
	Capabilities
	Change In Key Entities
	Communications Network Assessment
	Communicative Power
	Communicators
	Context
	Core Network
	CPOF
	Critical Sets
	Custom
	Detect Spatial Patterns
	Drill Down
	Geospatial Assessment
	Group Talk
	Hot Topics
	Immediate Impact
	Influence Net
	Key Entity
	K-Centrality
	Large Scale
	Local Patterns
	Locate SubGroups
	Management
	MedHealth
	Merchant Marine
	Missing Links
	Network Distribution
	Optimizer
	Part of Speech
	Potential Errors
	Public Health
	QAP/MRQAP Analysis
	Role View
	Rules of Engagement
	Semantic Network
	Shortest Path
	Sphere of Influence
	Standard Network Analysis
	Statistical Change Detection
	Statistical Distribution
	Tactical Insight
	Topic Analysis
	Trails
	Trails Analysis
	Twitter

	Reports by Measure
	Example

	In-the-Know (total degree centrality)
	NOTE : Red shaded reports are available only in the full version.
	Description :
	Why Use This Report
	Input :
	Parameters
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Input
	Parameters
	Output :
	Why Use This Report
	NOTE : This report requires the Meta-Network to analyze contains a Belief Node Class.

	Input
	Parameters
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	Input
	Parameters
	Output :
	Why Use This Report
	NOTE : This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure valu...

	Parameters
	Output :
	Why Use This Report :
	NOTE : Also see Cube Analysis in General Content section.

	Parameters
	Output :
	Why Use This Report
	Parameters
	Output :
	References
	Why Use This Report
	NOTE : This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure valu...

	Input
	NOTE : Works on Square Networks Only

	Parameters
	Output :
	Why Use This Report
	NOTE : This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure valu...

	Parameters
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Parameters
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	Input
	NOTE : Requires a Location Node Class with Latitude and Longitude attributes.

	Parameters
	Output :
	Why Use This Report
	Input
	Parameters
	Output :
	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	Parameters
	Output :
	Entropy:
	NOTE : It only applies to measures with non-negative values.

	References:
	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	NOTE : This report uses the Context function as a comparison of the user's input network with that of a random network of the same number of nodes and density. This is an attempt to address a frequent user question, "Well, okay, I see the measure valu...

	Input
	Parameters
	IMPORTANT : If your Network consists of more than one Nodeset and one Network you must place a check mark in the Transform the input network into an inference network before proceeding.

	Output :
	Why Use This Report
	Input
	Parameters
	Output :
	Why Use This Report
	Input
	Parameters
	Output :
	Why Use This Report
	Input
	Parameters
	Output :
	Why Use This Report
	Input
	Parameters
	Output :
	Why Use This Report
	Input
	Parameters
	Group Sub-Network Measures
	Cluster Analysis Metrics
	Output :
	Why Use This Report
	Input
	Parameters :
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Input
	Parameters
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Parameters
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	Input :
	Parameters
	Output :
	Why Use This Report
	Input :
	Parameters :
	Output :
	Why Use This Report
	Input :
	NOTE : The Nodeset to analyze needs an attribute which contains the parts of speech. This is usually titles pos.

	Parameters :
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Input :
	Parameters :
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Input :
	Parameters :
	Output :
	Why Use This Report
	Input :
	NOTE : QAP can use either directed or undirected data.  NOTE : When comparing Networks both Networks seend to be the same size.

	Parameters :
	Output :
	See Also
	Why Use This Report
	Input
	Parameters
	Output :
	NOTE : This report only available in the full version.

	Why Use This Report
	Parameters
	Output :
	Why Use This Report
	Input :
	Output :
	Why Use This Report
	Input :
	Parameters :
	Output :
	Why Use This Report
	Input :
	Parameters :
	Output :
	Why Use This Report
	Input :
	Output :
	Why Use This Report
	Input :
	Parameters :
	Output :
	Why Use This Report
	Parameters :
	Output :
	References
	NOTE : This report only available in the full version.

	Why Use This Report
	Input :
	Parameters :
	Output :
	Why Use This Report
	Input
	NOTE : Requires an attribute Frequency to exist in the Meta-Network

	Parameters
	Output :
	Why Use This Report
	Input :
	Output :
	Why Use This Report
	Parameters :
	Output :
	Why Use This Report
	Input :
	Parameters :
	Output :
	AboutThe Twitter Report
	Loading a meta-network into ORA
	The Visualizer
	Lesson - 101
	lessons - 201-207
	General Thoughts
	NOTE : For this lesson I will be using the Foundation Trilogy-1 dataset.

	What's a Nodeset Class
	With Foundation the agents were easy - find the important characters in the story. The locations were also easy using scenes form the story. It was the events, knowledge, resources, and tasks which became slightly harder to discern. I'll admit there w...
	Foundation uses attributes to give extra information such as an agent's gender or job title. Any addition information can be placed into an attribute.

	Agents (Who)
	The Foundation Agent Nodeset contains a mere 10 agents. The information I deemed important for attributes were gender, home world, and Job Title.
	The Foundation Meta-Network was fairly easy to construct the agent Nodeset and Agent by Agent Network. But Remember, real life data doesn't always come with such an easy to see diagram. After a Meta-Network is constructed it very likely that new infor...
	NOTE : Remember, you'll always find something that you think needs tweaked as more and more information is uncovered.

	Events (When)
	Many of the events in first part of Foundation were easy (the meetings, the trial, the funeral). You may find events in your dataset a little more difficult to discern.

	Knowledge (What)
	In Foundation the knowledge mathematics is known by Hari Seldon, Gaal Dornick, and Wanda Seldon. But only Hari Seldon and Wanda Seldon have the knowledge psychohistory. But only Bor Alurin knows Psychology.

	Locations (Where)
	For the Foundation Meta-Network it was a simple matter of following the book and marking down who was in what scene. Not quite a simple when you've got less than perfect data.
	For the Foundation Meta-Network. it was difficult to focus in on the exact locations necessary. The first time only the major locations were used, but it was difficult defining specific tasks. Then all locations were added but it ended up have many is...

	Organization
	In Foundation these organizations were mostly specialty groups like The First and Second Foundations and the Empire.

	Profession
	For Foundation I had mostly normal professions like Attorney, Judge, and Psychologist but also the story contained some special ones like Psychohistorian and Aristocrat. You list whatever jobs the agents are doing.

	Resources (What)
	You may find that it is necessary for a node to have a certain knowledge before they can use a certain resource. In Foundation it is necessary to have knowledge of mathematics before you can use the resource prime radiant. There is no special knowledg...

	Tasks (How)
	As in the example of Events above certain tasks need to be completed before others can be started. Foundation uses a binary, directed network showing a pathway of which tasks are required to be completed before the next task can be started. spy on Gaa...
	Linge Chen could only preside over Seldon's trial at the Imperial Palace. Nor could Gaal Dornick do the task seal Seldon recordings in Vault anywhere but on Terminus.

	Networks
	The Foundation Nodesets consist of: agent x agent, agent x event, agent x knowledge, agent x location, agent x organization, agent x profession, agent x task, event x event, event x location, knowledge x knowledge, knowledge x profession, knowledge x ...

	Your first Nodeset
	After reading The Foundation Trilogy I decided to break it up into 9 sections. In the first section I came up with 10 important Agent nodes.
	NOTE: If using IDs like A1 I've found prefixing 0 or 00 to the number helps when sorting. i.e. A01-A99 for up to 100 Agents.

	Your first Network
	The Foundation made a connection whenever any two Agents met face-to-face. This is often the way networks are constructed but there are other ways to make connections i.e. hierarchical command structure or weighted importance of the connection.

	The rest of the Nodesets and Networks
	I created Foundation Nodesets for Events : important Events during the course of the story, Knowledge : important information known by individual Agents, Location : where particular Events took place, Organization : larger bodies which the individual ...
	For Foundation I decided I created a wide range of Networks. Many of these were created for specific display purposes and may not be entirely necessary in your particular ciscumstance.  Agent x Agent, Agent x Event, Agent x Knowledge, Agent x Location...
	NOTE: You can keep these as separate spreadsheets or combine them in a single spreadsheet. This is a personnal preference.

	Saving as .CSV files
	NOTE : If you are visiting this page from the help section on the Data Import Wizard, what follows is a series of lessons using the Data Import tool with the Foundation sample data set. You can start from the very beginning of this lesson by going to ...

	The Datasets
	Starting a new Meta-Network
	Adding to the new Meta-Network
	NOTE: If at any time you want to remove a Network from the list select the [ X ] next to the Browse button
	NOTE : If you are visiting this page from the Data Import Wizard, what follows is a lesson on adding attributes to the Foundation sample data set provided with ORA. To begin the lesson from the very beginning go to Meta-Networks 101.

	The Datasets
	Adding Attributes
	NOTE : If you select the second option, and your nodes are in a differnt order than your attributes, the ORA will place the attributes in sequential order regardless of whether the IDs match or not.

	The remaining Nodesets and Networks
	Adding a New Node to a Meta-Network
	Filter Values
	Edit Attribute
	Replacing an Attribute Column
	NOTE: This method is suggested as ORA has the capability of retaining multiple values. If you want to completely replace the values then deletion and replacement of the column is suggested.

	Saving Your Network Data
	REMEMBER: The UCINET uses both .##d and .##h extensions and both are needed to build a Meta-Network.
	NOTE: Since this Save box does not display the files present in the directory it is Highly Suggested that you save to a new directory and verify which previous file you want to replace. More information on these file formats can be found HERE

	Saving A Meta-Network
	Saving Your Attribute Data
	IMPORTANT NOTE: Before you Copy/Paste in this manner make sure your columns are in the same order. This operation will NOT match up data as it's a blind copy/paste operation.

	The Reports
	Running a Key Entity Report:
	Remove Nodes from a Key Entity Report:
	Comparison of the two reports
	Performing a View Network Over-Time Analysis
	Note : For our purposes, we have changed data in this example and have renamed the Meta-Network for three different years. This will denote different network variables that have changed over time.

	Performing the Over-Time Analysis
	Note : Depending on the complexity of the network and the extent to which relationships (ties) have changed, the visualization of those changes may be subtle.

	Example Slider Position 1
	Example Slider Position 2
	Example Slider Position 3
	WTC Event Node: Detail 1 - 1996
	WTC Event Node: Detail 2 - 1997
	Performing the View Measures Over-Time Analysis
	Interpreting The Results After Performing View Measures Over-Time Analysis
	Graph tab > Congruence, Organization Measure, Knowledge Waste.

	Summary of Lesson
	What is an attribute?
	NOTE : This does require a dataset with a time attribute.

	Example
	I. Command Line Arguments
	II. XML Script
	A. Input Section
	1. Meta-Network Specification
	1.1 Meta-Network data in a single file
	1.2 Meta-Network data in multiple matrix files
	1.3 Multiple Meta-Networks
	1.3 Meta-Network Directories
	3. Saving Meta-Networks
	4. Transform Element
	Mixture of Topological Forms
	Circle / Wheel
	Matrix
	Hierarchy
	Core-Periphery
	Random
	Small-World
	Bow-Tie
	Cellular
	Scale-Free
	Complex Networks (Statistical Mechanics)
	Network Processes
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